# Table of Contents

## Chapter 1: Introduction

1.1 Features and Licence levels ................................................................. 11

## Chapter 2: General Information

2.1 Units and sign conventions ................................................................. 13
  2.1.1 Units ......................................................................................... 13
  2.1.2 Sign convention ....................................................................... 16
2.2 File handling .................................................................................... 16
2.3 Help facilities ................................................................................... 17

## Chapter 3: Input program - General overview

3.1 Starting the Input program ................................................................. 18
  3.1.1 New project ........................................................................... 20
  3.1.2 Existing project ...................................................................... 27
3.2 Layout of the Input program ............................................................... 28
3.3 Menus in the Menu bar .................................................................... 30
  3.3.1 File menu ................................................................................ 30
  3.3.2 Edit menu ............................................................................... 31
  3.3.3 Soil menu .............................................................................. 32
  3.3.4 Structures menu ..................................................................... 32
  3.3.5 Mesh menu ............................................................................ 33
  3.3.6 Flow conditions menu .............................................................. 33
  3.3.7 Phases menu .......................................................................... 33
  3.3.8 Options menu ......................................................................... 34
  3.3.9 Expert menu [GSE] ................................................................. 34
  3.3.10 Help menu ........................................................................... 35
3.4 Input program structure - Modes ....................................................... 35
3.5 Model in the drawing area ................................................................. 37
  3.5.1 Supporting tools .................................................................... 37
  3.5.2 Model view - Zooming ............................................................. 38
  3.5.3 Selecting geometry components ............................................. 38
3.6 Explorers ......................................................................................... 39
  3.6.1 Model explorer ..................................................................... 39
  3.6.2 Selection explorer ................................................................. 44
  3.6.3 Phases explorer .................................................................... 44
3.7 General information on command line ............................................. 45
  3.7.1 Indexing in commands ............................................................ 47
  3.7.2 Accessing Output commands in Input command line ............... 47

## Chapter 4: Ground modelling - Soil mode

4.1 Adjustment of the soil contour .......................................................... 49
4.2 Creating boreholes ........................................................................... 49
  4.2.1 Creating new boreholes ......................................................... 50
  4.2.2 Editing boreholes ................................................................... 51
4.3 Soil layers ....................................................................................... 51
Chapter 5: Modelling loads and structures - Structures mode ................................................. 68

5.1 Assisting tools ...................................................................................................................... 68
5.1.1 Selecting geometry components .................................................................................. 68
5.1.2 Move object ................................................................................................................... 69
5.1.3 Copy object - Array ...................................................................................................... 69
5.1.4 Check geometry .......................................................................................................... 70

5.2 Geometric entities .............................................................................................................. 71
5.2.1 Create point ................................................................................................................ 71
5.2.2 Create line .................................................................................................................. 72
5.2.3 Create polygon .......................................................................................................... 72
5.2.4 Advanced geometric modelling options ..................................................................... 73

5.3 Loads .................................................................................................................................. 77
5.3.1 Point load ................................................................................................................... 78
5.3.2 Distributed load ........................................................................................................ 79

5.4 Prescribed Displacements .................................................................................................. 79
5.4.3 Point prescribed displacement .................................................................................. 81
5.4.4 Distributed prescribed displacement ......................................................................... 81
5.4.5 Line contraction ......................................................................................................... 81

5.5 Dynamic loading [ULT] .................................................................................................... 82
5.5.1 Definition of multipliers ......................................................................................... 83
5.5.2 Harmonic signal ....................................................................................................... 83
5.5.3 Signal from table ..................................................................................................... 84
5.5.4 Input accelerograms ............................................................................................... 87
5.5.5 Added mass ............................................................................................................... 91

5.6 Structural elements .......................................................................................................... 94
5.6.1 Fixed-end anchors ................................................................................................. 95
5.6.2 Node-to-node anchors ........................................................................................... 96
5.6.3 Embedded Beams .................................................................................................... 97
5.6.4 Plates ....................................................................................................................... 101
5.6.5 Geogrids ................................................................................................................ 103
5.6.6 Interfaces .............................................................................................................. 104
5.6.7 Cables .................................................................................................................... 109
5.6.8 Discontinuities ....................................................................................................... 115
5.6.9 Connections .......................................................................................................... 118

5.7 Tunnels [GSE] .................................................................................................................... 119
5.7.1 Tunnel designer ....................................................................................................... 120
5.7.2 Definition of tunnel cross section geometry ......................................................... 121
5.7.3 Import tunnel geometry ......................................................................................... 125
5.7.4 Properties .............................................................................................................. 127

5.8 Design approaches [ADV] ................................................................................................ 135
5.8.1 Definition of design approaches ........................................................................... 136
5.8.2 Definition of partial factors for loads .................................................................... 138
5.8.3 Definition of partial factors for materials ............................................................. 138
Chapter 6: Material properties and material database .................................................................169

6.1 Modelling soil and interface behaviour ....................................................................................172
   6.1.1 General tabsheet .................................................................................................................172
   6.1.2 Mechanical tabsheet .............................................................................................................180
   6.1.3 Hoek-Brown pre-processing tool .........................................................................................214
   6.1.4 Cyclic accumulation and optimisation tool [ADV] ............................................................220
   6.1.5 Groundwater tabsheet .........................................................................................................236
   6.1.6 Interfaces tabsheet ...............................................................................................................254
   6.1.8 Initial tabsheet .......................................................................................................................263

6.2 Modelling undrained behaviour ...............................................................................................267
   6.2.1 Undrained A ..........................................................................................................................269
   6.2.2 Undrained B ..........................................................................................................................269
   6.2.3 Undrained C ..........................................................................................................................269
   6.2.4 Undrained behaviour for unsaturated soil .......................................................................270

6.3 Material data sets for discontinuities .......................................................................................271
   6.3.1 General properties ...............................................................................................................271
   6.3.2 Mechanical properties .........................................................................................................272
   6.3.3 Groundwater properties ......................................................................................................275
   6.3.4 Thermal properties [ADV] ..................................................................................................276

6.4 Material data sets for plates ......................................................................................................276
   6.4.1 General properties ...............................................................................................................277
   6.4.2 Mechanical properties .........................................................................................................278
   6.4.3 Thermal properties [ADV] ..................................................................................................282

6.5 Material data sets for geogrids .................................................................................................282
   6.5.1 General properties ...............................................................................................................282
   6.5.2 Mechanical properties .........................................................................................................283
   6.5.3 Thermal properties [ADV] ..................................................................................................287

6.6 Material data sets for embedded beams ..................................................................................287
   6.6.1 General properties ...............................................................................................................288
   6.6.2 Mechanical properties .........................................................................................................290
   6.6.3 Interaction properties: bearing capacity ............................................................................293
   6.6.4 Interface stiffness factor .......................................................................................................296

6.7 Material data sets for cables ....................................................................................................298
   6.7.1 General properties ...............................................................................................................298
   6.7.2 Mechanical properties .........................................................................................................299

6.8 Material data sets for anchors ..................................................................................................303
   6.8.1 General properties ...............................................................................................................303
   6.8.2 Mechanical properties .........................................................................................................304
   6.8.3 Thermal properties [ADV] ..................................................................................................306

6.9 Assigning material data sets to geometry components ............................................................307

Chapter 7: Meshing and calculation ...............................................................................................308
7.1 Mesh generation - Mesh mode ..........................................................................................................................................................308
  7.1.1 Elements ................................................................................................................................................................................309
  7.1.2 Global settings ........................................................................................................................................................................309
  7.1.3 Local refinement .......................................................................................................................................................................310
  7.1.4 Enhanced mesh refinements (EMR) ........................................................................................................................................311
7.2 Visualize mesh warnings .........................................................................................................................................................312
7.3 Defining calculation phases .......................................................................................................................................................313
  7.3.1 Phases explorer .........................................................................................................................................................................313
  7.3.2 Order of calculation phases ...................................................................................................................................................316
  7.3.3 Phases window .........................................................................................................................................................................316
7.4 Types of analysis .......................................................................................................................................................................317
  7.4.1 Initial stress generation ..........................................................................................................................................................318
  7.4.2 Plastic calculation ...................................................................................................................................................................323
  7.4.3 Consolidation calculation [ADV] ........................................................................................................................................324
  7.4.4 Fully coupled flow-deformation analysis [ULT] ..................................................................................................................325
  7.4.5 Safety calculation (phi/c reduction) ......................................................................................................................................326
  7.4.6 Dynamics calculation [ULT] ................................................................................................................................................330
  7.4.7 Dynamics with consolidation calculation [ULT] .................................................................................................................331
  7.4.8 Plastic nil-phase .....................................................................................................................................................................332
  7.4.9 Updated mesh analysis .........................................................................................................................................................333
7.5 Loading type ........................................................................................................................................................................335
  7.5.1 Staged construction .........................................................................................................................................................335
  7.5.2 Minimum excess pore pressure [ADV] ..............................................................................................................................338
  7.5.3 Degree of consolidation [ADV] ........................................................................................................................................339
  7.5.4 Target ΣMsf ...........................................................................................................................................................................339
  7.5.5 Incremental multipliers ......................................................................................................................................................339
7.6 Water pressure calculation .........................................................................................................................................................340
  7.6.1 Calculation type ...................................................................................................................................................................340
  7.6.2 Global water level ..............................................................................................................................................................342
7.7 Temperature calculation [ADV] ...............................................................................................................................................342
  7.7.1 Calculation type ...................................................................................................................................................................342
  7.7.2 Coupled analysis [ULT] ......................................................................................................................................................343
  7.7.3 Non-linearity during Phase-changes [ADV] .....................................................................................................................345
7.8 Load stepping procedures ............................................................................................................................................................345
  7.8.1 Automatic step size procedure ........................................................................................................................................346
  7.8.2 Load advancement - Ultimate level ..................................................................................................................................347
  7.8.3 Load advancement - Number of steps ................................................................................................................................348
  7.8.4 Automatic time stepping (consolidation [ADV] and fully coupled analysis [ULT]) ................................................................349
  7.8.5 Automatic time stepping (Dynamics) [ULT] .......................................................................................................................349
7.9 Calculation control parameters ...............................................................................................................................................350
  7.9.1 General phase parameters ..................................................................................................................................................350
  7.9.2 Deformation control parameters .......................................................................................................................................352
  7.9.3 Numerical control parameters ...........................................................................................................................................356
  7.9.4 Flow control parameters [ADV] ......................................................................................................................................367
  7.9.5 Dynamics control parameters [ULT] ................................................................................................................................368
  7.9.6 Reached values ..................................................................................................................................................................369
7.10 Flow conditions .....................................................................................................................................................................370
  7.10.1 Water levels .........................................................................................................................................................................371
  7.10.2 Assigning water conditions to soil polygons ................................................................................................................373
  7.10.3 Water pressure generation and previewing ....................................................................................................................375
# Chapter 8: Output program - General overview

8.1 Layout of the Output program ........................................................................................................ 406
8.2 Menus in the Menu bar ....................................................................................................................... 407
  8.2.1 File menu ........................................................................................................................................ 407
  8.2.2 View menu ..................................................................................................................................... 408
  8.2.3 Project menu .................................................................................................................................. 410
  8.2.4 Geometry menu ............................................................................................................................. 411
  8.2.5 Mesh menu ................................................................................................................................... 411
  8.2.6 Deformations menu ....................................................................................................................... 412
  8.2.7 Stresses menu ............................................................................................................................... 412
  8.2.8 Forces menu .................................................................................................................................. 412
  8.2.9 Interface stresses menu .................................................................................................................. 413
  8.2.10 Discontinuity stresses menu ......................................................................................................... 413
  8.2.11 Tools menu .................................................................................................................................. 413
  8.2.12 Options ......................................................................................................................................... 414
  8.2.13 Expert menu [GSE] ..................................................................................................................... 414
  8.2.14 Window menu ............................................................................................................................. 415
  8.2.15 Help menu .................................................................................................................................... 415
8.3 General information on command line ............................................................................................... 416
  8.3.1 Indexing in commands ................................................................................................................... 416
8.4 Tools in the Output program ............................................................................................................... 416
  8.4.1 Accessing the Output program ..................................................................................................... 416
  8.4.2 Exporting output data .................................................................................................................... 417
  8.4.3 Curves manager ............................................................................................................................ 419
  8.4.4 Store the view for reports .............................................................................................................. 419
  8.4.5 Zooming the plot .......................................................................................................................... 420
  8.4.6 Relocation of the plot ..................................................................................................................... 420
  8.4.7 Scaling the displayed results ........................................................................................................ 420

---

## 7.11 Geometry configuration - Staged Construction mode

7.11.1 Changing geometry configuration ............................................................................................... 379
7.11.2 Staged construction procedure in calculations ............................................................................... 380
7.11.3 Changing loads ............................................................................................................................... 381
7.11.4 Connections in Staged construction ............................................................................................... 381
7.11.5 Reassigning material data sets ........................................................................................................ 381
7.11.6 Applying volumetric strains in clusters .......................................................................................... 382
7.11.7 Prestressing of anchors and cable ................................................................................................... 383
7.11.8 Model conditions ............................................................................................................................ 383

## 7.12 Special option for User Defined Soil Models [ADV]

7.12.1 Starting a calculation ....................................................................................................................... 394
  7.12.2 Previewing a construction stage ..................................................................................................... 394
  7.12.3 Selecting points for curves .............................................................................................................. 395
  7.12.4 Execution of the calculation process ............................................................................................... 395
  7.12.5 Aborting a calculation .................................................................................................................... 395
  7.12.6 Output during calculations ............................................................................................................ 396
  7.12.7 Adjustment to input data in between calculations ......................................................................... 401
  7.12.8 Automatic error checks ................................................................................................................ 401

## 8.4.4 Tools in the Output program

8.4.4.1 Accessing the Output program ..................................................................................................... 416
8.4.4.2 Exporting output data .................................................................................................................... 417
8.4.4.3 Curves manager ............................................................................................................................ 419
8.4.4.4 Store the view for reports .............................................................................................................. 419
8.4.4.5 Zooming the plot .......................................................................................................................... 420
8.4.4.6 Relocation of the plot ..................................................................................................................... 420
8.4.4.7 Scaling the displayed results ........................................................................................................ 420

---

## References

- 7.10.4 Flow boundary conditions [ADV] .............................................................................................. 376
- 7.10.5 Precipitation [ADV] ................................................................................................................... 376
- 7.10.6 Climate [ADV] ............................................................................................................................ 378
- 8.1 Layout of the Output program ........................................................................................................ 406
- 8.2 Menus in the Menu bar ....................................................................................................................... 407
- 8.3 General information on command line ............................................................................................... 416
- 8.4 Tools in the Output program ............................................................................................................... 416

---

**PLAXIS**

6  

Reference Manual 2D
Chapter 9: Results available in Output program

9.1 Connectivity plot
9.2 Deformations
  9.2.1 Deformed mesh
  9.2.2 Total displacements
  9.2.3 Phase displacements
  9.2.4 Sum phase displacements
  9.2.5 Incremental displacements
  9.2.6 Extreme total displacements
  9.2.7 Velocities [ULT]
  9.2.8 Accelerations [ULT]
  9.2.9 Accelerations in 'g' [ULT]
  9.2.10 Total cartesian strains
  9.2.11 Phase cartesian strains
  9.2.12 Incremental cartesian strains
  9.2.13 Total strains
  9.2.14 Phase strains
  9.2.15 Incremental strains
9.3 Stresses
  9.3.1 Cartesian effective stresses
  9.3.2 Cartesian total stresses
  9.3.3 Principal effective stresses
  9.3.4 Principal total stresses
  9.3.5 Initial conditions
  9.3.6 State parameters
  9.3.7 Pore pressures
  9.3.8 Groundwater flow [ADV]
  9.3.9 Heat flow [ADV]
  9.3.10 Plastic points
  9.3.11 Fixed end anchors
  9.3.12 Node to node anchors
  9.3.13 Wells [ADV]
  9.3.14 Drains [ADV]
9.4 Structures and interfaces
<table>
<thead>
<tr>
<th>Chapter 10: Curves</th>
<th>474</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.1 Selecting points for curves</td>
<td>474</td>
</tr>
<tr>
<td>10.1.1 Mesh point selection</td>
<td>474</td>
</tr>
<tr>
<td>10.1.2 Pre-calculation points</td>
<td>475</td>
</tr>
<tr>
<td>10.1.3 Post-calculation points</td>
<td>476</td>
</tr>
<tr>
<td>10.2 Generating curves</td>
<td>476</td>
</tr>
<tr>
<td>10.2.1 Load-displacement curves</td>
<td>478</td>
</tr>
<tr>
<td>10.2.2 Force-displacement curves</td>
<td>479</td>
</tr>
<tr>
<td>10.2.3 Displacement-time or force-time curves</td>
<td>479</td>
</tr>
<tr>
<td>10.2.4 Stress and strain diagrams</td>
<td>480</td>
</tr>
<tr>
<td>10.2.5 Curves in Dynamics calculations [ULT]</td>
<td>480</td>
</tr>
<tr>
<td>10.3 Formatting curves</td>
<td>492</td>
</tr>
<tr>
<td>10.3.1 Menus for curves</td>
<td>493</td>
</tr>
<tr>
<td>10.3.2 Editing curve data in table</td>
<td>494</td>
</tr>
<tr>
<td>10.3.3 Value indication</td>
<td>496</td>
</tr>
<tr>
<td>10.4 Formatting options</td>
<td>496</td>
</tr>
<tr>
<td>10.4.1 Chart settings</td>
<td>497</td>
</tr>
<tr>
<td>10.4.2 Curve settings</td>
<td>498</td>
</tr>
<tr>
<td>10.5 Regeneration of curves</td>
<td>500</td>
</tr>
<tr>
<td>10.6 Multiple curves in one chart</td>
<td>500</td>
</tr>
<tr>
<td>Chapter 11: PLAXIS Advanced Tools</td>
<td>502</td>
</tr>
<tr>
<td>11.1 Bentley Cloud Services [GSE]</td>
<td>502</td>
</tr>
<tr>
<td>11.2 ProjectWise Integration Commands [GSE]</td>
<td>502</td>
</tr>
<tr>
<td>11.2.1 Add File to ProjectWise</td>
<td>503</td>
</tr>
<tr>
<td>11.2.2 Open File stored in ProjectWise</td>
<td>505</td>
</tr>
<tr>
<td>11.2.3 Save to ProjectWise</td>
<td>506</td>
</tr>
<tr>
<td>11.2.4 To View ProjectWise properties</td>
<td>507</td>
</tr>
<tr>
<td>11.3 Packing a project</td>
<td>509</td>
</tr>
<tr>
<td>11.4 Exporting geometry [GSE]</td>
<td>510</td>
</tr>
<tr>
<td>11.5 PLAXIS 2D to 3D Converter [GSE]</td>
<td>511</td>
</tr>
<tr>
<td>11.5.1 Remote scripting server configuration [GSE]</td>
<td>511</td>
</tr>
<tr>
<td>11.5.2 Running the PLAXIS 2D to 3D converter tool</td>
<td>513</td>
</tr>
<tr>
<td>11.5.3 PLAXIS 3D model outcome</td>
<td>517</td>
</tr>
<tr>
<td>11.6 Model Importer/Exporter</td>
<td>518</td>
</tr>
<tr>
<td>11.7 Importing geometry [GSE]</td>
<td>524</td>
</tr>
<tr>
<td>11.7.1 Advanced options</td>
<td>526</td>
</tr>
<tr>
<td>11.7.2 Visualization options</td>
<td>532</td>
</tr>
<tr>
<td>11.8 Central Importer [GSE]</td>
<td>533</td>
</tr>
</tbody>
</table>
Chapter 12: Engineering Applications ................................................................. 581

12.1 Modelling ground anchors ............................................................................ 581
12.1.1 Geometric modelling of ground anchors .................................................... 581
12.1.2 Properties of ground anchors ..................................................................... 581
12.1.3 Activation and pre-stressing of ground anchors ......................................... 582

12.2 Transverse forces in embedded beams .............................................................. 582
12.2.1 Abutment pile ............................................................................................. 583
12.2.2 Quay wall with relieving platform ............................................................... 583

12.3 Modelling vacuum consolidation [ADV] .......................................................... 584
12.3.1 Vacuum consolidation in a one-dimensional soil column ......................... 584
12.3.2 Vacuum consolidation in a 2D or 3D model ................................................. 584
12.3.3 Other requirements ...................................................................................... 584
12.3.4 Calculation options .................................................................................... 585
12.3.5 Switching-off vacuum ................................................................................ 585

Chapter 13: References .......................................................................................... 586

Appendices ............................................................................................................. 589

Appendix A: Import CPT data: required file format [GSE] .................................... 590
Appendix B: Cyclic accumulation Tool - Contour File Formats [ADV] .................... 592
Appendix C: Summary of the creation of General Water Levels .............................. 597
PLAXIS 2D is a special purpose two-dimensional finite element program used to perform deformation, stability and flow analysis for various types of geotechnical applications.

Real situations may be modelled either by a plane strain or an axisymmetric model. The program uses a convenient graphical user interface that enables users to quickly generate a geometry model and finite element mesh based on a representative vertical cross section of the situation at hand.

Users need to be familiar with the Windows environment. To obtain a quick working knowledge of the main features of PLAXIS, users should work through the example problems contained in the Tutorial Manual.

The Reference Manual is intended for users who want more detailed information about program features. The manual covers topics that are not covered exhaustively in the Tutorial Manual. It also contains practical details on how to use the PLAXIS program for a wide variety of problem types. The user interface consists of two sub-programs (Input and Output).

The Input program is a pre-processor, which is used to define the problem geometry, to create the finite element mesh and to define calculation phases.

The Output program is a post-processor, which is used to inspect the results of calculations in a two-dimensional view or in cross sections, and to plot graphs (curves) of output quantities of selected geometry points.

The contents of this Reference Manual are arranged according to the sub-programs and their respective options as listed in the corresponding modes and menus. This manual does not contain detailed information about the constitutive models, the finite element formulations or the non-linear solution algorithms used in the program. For detailed information on these and other related subjects, users are referred to the various chapters and papers listed in the Scientific Manual and the Material Models Manual. Additional information can be found in Bentley Communities (Bentley Communities).
1.1 Features and Licence levels

Features of PLAXIS are offered under certain licence levels (See General Information Manual). In this manual, features falling under each licence level can be identified as follows:

- Features with no identification - generally available for PLAXIS 2D licence.
- [ADV] - features available only for users with PLAXIS 2D Advanced licence.
- [ULT] - features available only for users with PLAXIS 2D Ultimate licence.
- [GSE] - features available only for users with Geotechnical SELECT subscription.

An abbreviated list of features and corresponding licence level can be explored in Overview Features and Licence levels - (on page 672).

Note:

- Symbol for features offered as a Technology Preview.
- Features (subsections in the manual) with no identification but that are within a bigger capability (identified with [ADV] or [ULT]) inherit the licencing of the later (e.g Added mass (on page 91) inherits [ULT] since it is under Dynamic loading [ULT] (on page 82)).
- Features using consolidation, steady-state ground water or steady-state thermal flow analysis require minimum an [ADV] licence. Features using dynamics, transient flow or fully coupled analysis require minimum an [ULT] licence.
Before describing the specific features in the different parts of the PLAXIS 2D user interface, the information given in this chapter applies to all parts of the program.

2.1 Units and sign conventions

2.1.1 Units

It is important in any analysis to adopt a consistent system of units. At the start of the input of a geometry, a suitable set of basic units should be selected. The basic units comprise a unit for length, force, time, temperature, energy and mass. These basic units are defined in the project properties inside the Input program (go to File menu > Project Properties > Model; see Input program - General overview (on page 18)).

The default units are meters [m] for length, kilonewtons [kN] for force, days [day] for time, seconds [s] for dynamics time, kelvins [K] for temperature, kilojoules [kJ] for energy, kilowatts [kW] for power and tonnes [t] for mass.

Given below an overview of all available units, the [default] settings and conversion factors to the default units. All subsequent input data should conform to the selected unit system and the output data should be interpreted in terms of the same unit system.

From the basic set of units, as defined by the user, the appropriate unit for the input of a particular parameter is generally listed directly behind the edit box or, when using input tables, above the input column. In all of the examples given in the PLAXIS manuals, the standard units are used.

<table>
<thead>
<tr>
<th>Units</th>
<th>Value</th>
<th>Conversion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>1 mm</td>
<td>0.001 m</td>
</tr>
<tr>
<td></td>
<td>1 cm</td>
<td>0.01 m</td>
</tr>
<tr>
<td></td>
<td>1 m</td>
<td>1 m</td>
</tr>
<tr>
<td></td>
<td>1 km</td>
<td>1000 m</td>
</tr>
<tr>
<td></td>
<td>1 in (inch)</td>
<td>0.0254 m</td>
</tr>
</tbody>
</table>
### General Information

#### Units and sign conventions

<table>
<thead>
<tr>
<th>Units</th>
<th>Value</th>
<th>Conversion</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Length</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 ft (feet)</td>
<td></td>
<td>0.3048 m</td>
</tr>
<tr>
<td>1 yd (yard)</td>
<td></td>
<td>0.9144 m</td>
</tr>
<tr>
<td><strong>Force</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 N</td>
<td></td>
<td>0.001 kN</td>
</tr>
<tr>
<td>1 kN</td>
<td></td>
<td>1 kN</td>
</tr>
<tr>
<td>1 MN</td>
<td></td>
<td>1000 kN</td>
</tr>
<tr>
<td>1 lbf (pounds force)</td>
<td></td>
<td>0.004448 kN</td>
</tr>
<tr>
<td>1 kip (kilo pound)</td>
<td></td>
<td>4.4482 kN</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 s (sec)</td>
<td></td>
<td>1/86400 day</td>
</tr>
<tr>
<td>1 min</td>
<td></td>
<td>1/1440 day</td>
</tr>
<tr>
<td>1 h</td>
<td></td>
<td>1/24 day</td>
</tr>
<tr>
<td>1 day</td>
<td></td>
<td>1 day</td>
</tr>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 [K]</td>
<td></td>
<td>1 K</td>
</tr>
<tr>
<td>0 °C</td>
<td></td>
<td>273.15 K</td>
</tr>
<tr>
<td>0 °F</td>
<td></td>
<td>255.37 K</td>
</tr>
<tr>
<td>1 °C</td>
<td></td>
<td>274.15 K</td>
</tr>
<tr>
<td>1 °F</td>
<td></td>
<td>255.93 K</td>
</tr>
<tr>
<td>100 °C</td>
<td></td>
<td>373.15 K</td>
</tr>
<tr>
<td>212 °F</td>
<td></td>
<td>373.15 K</td>
</tr>
<tr>
<td><strong>Energy</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 J</td>
<td></td>
<td>0.001 kJ</td>
</tr>
<tr>
<td>1 kJ</td>
<td></td>
<td>1 kJ</td>
</tr>
<tr>
<td>1 MJ</td>
<td></td>
<td>1000 kJ</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 W</td>
<td></td>
<td>0.001 kW</td>
</tr>
<tr>
<td>1 kW</td>
<td></td>
<td>1 kW</td>
</tr>
<tr>
<td>1 MW</td>
<td></td>
<td>1000 kW</td>
</tr>
<tr>
<td><strong>Mass</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 kg</td>
<td></td>
<td>0.001 t</td>
</tr>
<tr>
<td>1 t (tonne)</td>
<td></td>
<td>1 t</td>
</tr>
</tbody>
</table>
General Information
Units and sign conventions

**Note:** Note that for calculations involving thermal effects, it is strongly recommended to use the default units.

For convenience, the units of commonly used quantities in two different sets of units are listed below:

<table>
<thead>
<tr>
<th></th>
<th>International system</th>
<th>Imperial system</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic units</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>[m]</td>
<td>[in] or [ft]</td>
</tr>
<tr>
<td>Force</td>
<td>[N]</td>
<td>[lbf] or [kip]</td>
</tr>
<tr>
<td>Time</td>
<td>[day]</td>
<td>[day]</td>
</tr>
<tr>
<td><strong>Geometry</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coordinates</td>
<td>[m]</td>
<td>[in] or [ft]</td>
</tr>
<tr>
<td>Displacements</td>
<td>[m]</td>
<td>[in] or [ft]</td>
</tr>
<tr>
<td><strong>Material properties</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Young’s modulus</td>
<td>[kN/m²]=[kPa]</td>
<td>[psi]=[lbf/in²] or [ksf]=[kip/ft²]</td>
</tr>
<tr>
<td>Cohesion</td>
<td>[kN/m²]</td>
<td>[psi] or [ksf]</td>
</tr>
<tr>
<td>Friction angle</td>
<td>[deg. ]</td>
<td>[deg. ]</td>
</tr>
<tr>
<td>Dilatancy angle</td>
<td>[deg. ]</td>
<td>[deg. ]</td>
</tr>
<tr>
<td>Unit weight</td>
<td>[kN/m³]</td>
<td>[lbf/cu in] or [kip/ft]</td>
</tr>
<tr>
<td>Permeability</td>
<td>[m/day]</td>
<td>[in/day] or [ft/day]</td>
</tr>
<tr>
<td><strong>Forces &amp; stresses</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Point loads</td>
<td>[kN]</td>
<td>[lbf] or [kip]</td>
</tr>
<tr>
<td>Line loads</td>
<td>[kN/m]</td>
<td>[lbf/in] or [kip/ft]</td>
</tr>
<tr>
<td>Distributed loads</td>
<td>[kN/m²]</td>
<td>[psi] or [kip/ft²]</td>
</tr>
<tr>
<td>Stresses</td>
<td>[kN/m²]</td>
<td>[psi] or [kip/ft²]</td>
</tr>
</tbody>
</table>

**Note:**
- The user can change the default PLAXIS units in the Project properties window. This will automatically convert, in the input program, the defined input values (e.g. geometry data, loads, and prescribed displacements).
- PLAXIS supports the combination of model properties with different units systems (e.g Forces in [kN] while Length in [ft]). Therefore, the user needs to ensure the consistent selection of these unit systems.

In a plane strain analysis, the calculated forces resulting from prescribed displacements represent forces per unit length in the out-of-plane direction (z-direction; see Figure 1 on page 16)). In an axisymmetric analysis, the calculated forces (Force-X, Force-Y) are those that act on the boundary of a circle subtending an angle of 1 radian. In order to obtain the forces corresponding to the complete problem therefore, these forces should be multiplied by a factor $2\pi$. All other output for axisymmetric problems is given per unit width and not per radian.
The generation of a 2D finite element model in PLAXIS 2D is based on the creation of a geometry model. The geometry model involves a composition of areas, lines and points. Multiple vertical boreholes can be defined to determine the soil stratigraphy at different locations. In between the boreholes the soil layer positions are interpolated. Soil layers and ground surfaces may be non-horizontal.

2.1.2 Sign convention

The generation of a two-dimensional (2D) finite element model in PLAXIS 2D is based on the creation of a geometry model. This geometry model is created in the $x$-$y$ plane of the global coordinate system (Figure 1 (on page 16)), whereas the $z$-direction is the out-of-plane direction. In the global coordinate system the positive $z$-direction is pointing towards the user.

In all of the output data, compressive stresses and forces, including pore pressures, are taken to be negative, whereas tensile stresses and forces are taken to be positive. Figure 1 (on page 16) shows the positive stress directions.

![Coordinate system and indication of positive stress components](image)

Although PLAXIS 2D is a 2D program, stresses are based on the 3D Cartesian coordinate system. In a plane strain analysis $\sigma_{zz}$ is the out-of-plane stress. In an axisymmetric analysis, $x$ represents the radial coordinate, $y$ represents the axial coordinate and $z$ represents the tangential direction. In this case, $\sigma_{xx}$ represents the radial stress and $\sigma_{zz}$ represents the hoop stress.

2.2 File handling

All file handling in PLAXIS 2D is done using a modified version of the general Windows® file requester (Figure 2 (on page 17)).
With the file requester, it is possible to search for files in any admissible folder of the computer (and network) environment. The main file used to store information for a PLAXIS 2D project has a structured format and is named `<project>.p2dx`, where `<project>` is the project title. Besides this file, additional data is stored in multiple files in the sub-folder `<project>.p2dxdat`. It is generally not necessary to enter such a folder because it is not possible to read individual files in this folder.

If a PLAXIS 2D project file (*.p2dx) is selected, a small bitmap of the corresponding project geometry is shown in the file requester to enable a quick and easy recognition of a project.

### 2.3 Help facilities

To inform the user about the various program options and features, PLAXIS 2D provides a link in the Help menu to a digital version of the Manuals. A link is provided to the reference document of the commands used in the program as well. Moreover, the Help menu may be used to view and configure licences. A more detailed description of the Help menu of the Input and Output program is given in Help menu (on page 35) and Help menu (on page 415) respectively.

Many features are available as buttons in a toolbar. When the mouse pointer is positioned on a button for more than a second, a short description ('Note') appears, indicating the function of the button. For some input parameters side panels appear to help the user decide which value to select.
To carry out a finite element analysis using the PLAXIS 2D program, the user has to create a 2D geometry model composed of points, lines and other components, in the xy-plane and specify the material properties and boundary conditions. This is done in the first two tabsheets (Soil and Structures) of the Input program (see Figure 11 (on page 28)). The mesh generation and the definition of the calculation phases is done in the last three tabsheets (Mesh, Flow conditions and Staged construction) of the Input program (see Figure 11 (on page 28)).

**Note:**

1. The Soil and Structures tabsheets are known as **Geometry** modes.
2. The Mesh, Flow conditions and Staged construction tabsheets are known as **Calculation** modes.

### 3.1 Starting the Input program

![This icon represents the Input program.](image)

Start PLAXIS 2D by double clicking the shortcut on your desktop or clicking the entry in the Windows > Bentley Geotechnical menu.

PLAXIS 2D will first check if you are entitled to use the software and present you with the available options, see Figure 3 (on page 18).

![Figure 3: Licence check](image)

If you need to change the licence configuration, e.g. if you have to add some modules, click **Configure licences**.
In the configuration dialog, see Figure 4 (on page 19), you may select the modules that you want to use.

**Note:**

1. The licence configuration is also available from the menu **Windows > Programs** and from the menu **Help > Licence configuration**.
2. If you change the licence configuration while PLAXIS 2D is open, you have to restart PLAXIS 2D for the changes to take effect.

The licence administrator grants access to software licences. If you miss licences in this list, contact the licence administrator of your company.

For more information on the Product activation wizard and the Licence management tool, see this info on Bentley communities: [Info on Product Activation/Licence Management](#).

When you have chosen the licences to use, click **Continue** to start using PLAXIS 2D.

At the start of the Input program the **Quick select** window appears in which a choice must be made between the selection of an existing project and the creation of a new project (Figure 5 (on page 20)).
3.1.1 **New project**

When the **Start a new project** option is selected, the **Project properties** window appears in which the basic model parameters of the new project can be defined. The **Project properties** window contains the **Project** and the **Model** tabsheets. The **Project** tabsheet (Figure 6 (on page 21)) contains the project name and description and offers the possibility to select a company logo.

The **Model** tabsheet (Figure 7 (on page 22)) contains the type of the model, the basic units for length, force and time (see **Units** (on page 13)), the unit weight of water and the initial dimensions of the model. The default values can be replaced by the current values when selecting **Set as default** and clicking the **OK** button. A more detailed description of all these options is given below.
3.1.1.1 Project properties

![Project properties window (Project tabsheet)](image)

**Figure 6: Project properties window (Project tabsheet)**

1. **Project**

   The title, folder and the file name of the project are available in the *Project* group box available in the *Project* tabsheet.

<table>
<thead>
<tr>
<th><strong>Title</strong></th>
<th>The defined title appears as a default name for the file of the project when it is saved.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Company</strong></td>
<td>The company that holds the licence for this software.</td>
</tr>
<tr>
<td><strong>Directory</strong></td>
<td>The address to the folder where the project is saved is displayed. For a new project, there is no information shown.</td>
</tr>
<tr>
<td><strong>File name</strong></td>
<td>The name of the project file is displayed. For a new project, no information is shown.</td>
</tr>
</tbody>
</table>

2. **Comments**

   The *Comments* box in the *Project* tabsheet gives the possibility to add some extra comments about the project.
3. Company logo

Clicking the *Company logo* box in the *Project* tabsheet will open a file requester from which the desired file can be selected. This logo can be included in the output plots.

3.1.1.2 General model properties

The general options of the project are available in the *Model* tabsheet of the *Project properties* window.

![Project properties window (Model tabsheet)](image)

Figure 7: Project properties window (Model tabsheet)

1. Model

ProductName may be used to carry out two-dimensional finite element analysis. The finite element model is defined by selecting the corresponding option in the *Model* drop down-menu in the *Project* tabsheet.
**Plane strain**

A *Plane strain* model is used for geometries with a (more or less) uniform cross section and corresponding stress state and loading scheme over a certain length perpendicular to the cross section ($z$-direction). Displacements and strains in $z$-direction are assumed to be zero. However, normal stresses in $z$-direction are fully taken into account.

In earthquake problems the dynamic loading source is usually applied along the bottom of the model resulting in shear waves that propagate upwards. This type of problem is generally simulated using a plane strain model.

**Axisymmetric**

A *Axisymmetric* model is used for circular structures with a (more or less) uniform radial cross section and loading scheme around the central axis, where the deformation and stress state are assumed to be identical in any radial direction. Note that for axisymmetric problems the $x$-coordinate represents the radius and the $y$-axis corresponds to the axial line of symmetry. Negative $x$-coordinates cannot be used.

Single-source vibration problems are often modelled with axisymmetric models. This is because waves in an axisymmetric system radiate in a manner similar to that in a three dimensional system. In this case, the energy disperses leading to wave attenuations with distance. Such effect can be attributed to the geometric damping (or radiation damping), which is by definition included in the axisymmetric model.

The selection of *Plane strain* or *Axisymmetric* results in a two dimensional finite element model with only two translational degrees of freedom per node ($x$- and $y$-direction).

![Figure 8: Example of a plane strain (left) and axisymmetrical problem (right)](image)

2. Elements

The user may select either 6-node or 15-node triangular elements to model soil layers and other volume clusters.
The 15-node triangle is the default element. It provides a fourth order interpolation for displacements and the numerical integration involves twelve Gauss points (stress points). The type of element for structural elements and interfaces is automatically taken to be compatible with the soil element type as selected here.

The 15-node triangle is a very accurate element that has produced high quality stress results for difficult problems, as for example in collapse calculations for incompressible soils Sloan, (1981) (on page 588); Sloan & Randolph, 1982 (on page 588); Nagtegaal, Parks & Rice, 1974 (on page 587). The 15-node triangle is particularly recommended to be used in axi-symmetric analysis. The use of 15-node triangles leads to more memory consumption and slower calculation and operation performance. Therefore a more simple type of elements is also available.

The 6-node triangle provides a second order interpolation for displacements and the numerical integration involves three Gauss points. The type of element for structural elements and interfaces is automatically taken to be compatible with the soil element type as selected here.

The 6-node triangle is a fairly accurate element that gives good results in standard deformation analyses, provided that a sufficient number of elements are used. However, care should be taken with axi-symmetric models or in situations where (possible) failure plays a role, such as a bearing capacity calculation or a safety analysis by means of phi-c reduction. Failure loads or safety factors are generally overpredicted using 6-noded elements. In those cases the use of 15-node elements is preferred.

One 15-node element can be thought of a composition of four 6-node elements, since the total number of nodes and stress points is equal. Nevertheless, one 15-node element is more powerful than four 6-node elements.

In addition to the soil elements, compatible plate elements are used to simulate the behaviour of walls, plates and shells (Plates (on page 101)) and geogrid elements are used to simulate the behaviour of geogrids and wovens (Geogrids (on page 103)). Moreover, compatible interface elements are used to simulate soil-structure interaction (Interfaces (on page 104)). Finally, the geometry creation mode allows for the input of
embedded beam rows, fixed-end anchors and node-to-node anchors (Fixed-end anchors (on page 95), Node-to-node anchors (on page 96)).

3. Units

Units for length, force, time, temperature, energy, power and mass to be used in the analysis need to be specified. These basic units are entered in the Model tabsheet of the Project properties window.

The default units, as suggested by the program, are m (metre) for length, kN (kilonewton) for force, day for time, K (kelvin) for temperature, kJ (kilojoule) for energy, kW (kilowatt) for power and t (tonne) for mass. The corresponding units for stress and unit weights are listed in the box below the basic units.

In a dynamics analysis, the time is usually measured in [seconds] rather than the default unit [days]. In PLAXIS 2D Time and Dynamics time are different parameters. The time interval in a dynamics analysis is always the dynamics time and PLAXIS 2D always uses seconds [s] as the unit of Dynamics time.

Note: Note that for calculations involving thermal effects, it is strongly recommended to use the default units.

4. Contour

At the start of a new project the user needs to specify the contours of the geometry model. The initial setting of the \(x_{\text{min}}, x_{\text{max}}, y_{\text{min}}, y_{\text{max}}\) parameters set the outer boundaries of the geometry model. The initial view of the drawing area is such that the model dimensions are fully visible within the drawing area. The aforementioned parameters are entered in the Model tabsheet of the Project properties window.

5. Constants [ADV]

In thermal calculations, pore water may appear in different states, i.e. in liquid state (water), solid state (ice) and gas state (vapour). Thermal properties of soils highly depend on the state of water in the pores. Rather than specifying these properties in material data sets, the thermal properties of pore water are specified for the project as a whole in the Constants tab sheet of the Project properties window.
By default, the earth gravity acceleration, $g$, is set to 9.810 m/s$^2$, assuming the default basic length unit is [m]. The direction of gravity coincides with the negative $y$-axis. Gravity is implicitly included in the unit weights given by the user (Material properties and material database (on page 169)). In this way, the gravity is controlled by the total load multiplier for weights of materials, $\Sigma M_{weight}$ (General phase parameters (on page 350)).

In dynamics calculations, the value of the gravity acceleration, $g$, is used to calculate the material density, $\rho$, from the unit of weight, $\gamma$ ($\rho=\gamma/g$).

In projects that involve temperature, the input of reference temperature is required. The reference temperature is the temperature at the ground surface in the case that no specific thermal conditions are given here. The reference temperature ($T_{ref}$) can be entered in the Constants tabsheet of the Project properties window. By default, the reference temperature is set to 293.1 K (= 20 °C).

In projects that involve pore pressures, the input of a unit weight of water is required to determine the effective stresses and pore pressures. The water weight ($\gamma_{water}$) can be entered in the Constants tabsheet of the Project properties window. By default, the unit weight of water is set to 10.00, assuming the default basic units of [kN] and [m] are used.
**Input program - General overview**

**Starting the Input program**

### Specific heat capacity

The specific heat capacity of water, \( c_{\text{water}} \), is a parameter that describes the amount of energy (heat) that can be stored in the pore water per unit of mass. It is specified in the unit of energy per unit of mass per unit of temperature (Material properties and material database on page 169). Similarly, specific heat capacity can be given for given for ice and vapour.

### Thermal conductivity

The thermal conductivity of water, \( \lambda_{\text{water}} \), is a parameter that describes the rate of energy (heat) that can be transported in the pore water. It is specified in the unit of energy per unit length per unit of temperature. Similarly, thermal conductivity can be given for ice and vapour.

### Latent heat of water

The latent heat of water is the amount of energy that is required to change the state of water from liquid state to solid state and vice versa. It is specified in the unit of energy per unit of mass.

### Thermal expansion coefficient

The thermal expansion coefficient, \( \alpha \), is the (change of) volumetric strain per unit of temperature. The thermal expansion coefficient can be given for water and ice. However, thermal expansion of vapour is generally suppressed and therefore ignored. Note that the thermal expansion for ice starts to increase from the freeze temperature downward.

### Water temperature

In the case that water is entering into the soil (by means of inflow boundary conditions or infiltration wells), this water is assumed to have a temperature equal to the specified water temperature, \( T_{\text{water}} \).

### Specific gas constant for vapour

The specific gas constant for vapour, \( R \), is a parameter that is used in the equation of relative humidity (see Scientific Manual). It is recommended to use the default value.

### Temperature-dependent pore fluid flow

To enable Temperature-dependent pore fluid properties, click on the Use temperature-dependent table checkbox. A table is displayed and the values are visualised in small graphs. The table contains five columns: Temperature (\( T \)), Density (\( \rho \)), Thermal conductivity (\( \lambda \)), Specific head capacity (\( c \)) and Dynamic viscosity (\( \mu \)). The table is pre-filled with default values for water and its phase transition to ice. If this option is selected, the constant parameters for liquid water and ice are not editable to emphasise that the Temperature-dependent water properties are taken into account. The table editor allows you to edit the table directly, or to import and export tables from and to a text file.

**Note:** Note that the viscosity below 273.15 K is not relevant in the case of the default properties. It is set to a constant value to ease visualisation and allow for modifications if needed, in the case of brines for example, where the freeze point is low.

### 3.1.2 Existing project

When the Input program is started, a list of the recent projects appears in the Quick select window. In the case when a project other than the listed recent ones is required, the Open an existing project option should be selected. As this selection is made, the Windows® file requester Figure 2 (on page 17) pops up. It enables the
user to browse through all available folders and to select the desired PLAXIS 2D project file (*.p2dx). After the selection of an existing project, the corresponding geometry is presented in the main window.

An existing PLAXIS 2D AE project can also be read by selecting the *Open project* option in the *File* menu. In the file requester, the type of the file is, by default, set to 'PLAXIS 2D AE files *.p2dx'.

3.2 Layout of the Input program

The general layout of the Input program for a new project is shown in Figure 11 (on page 28). The main window of the Input program contains the following items:

![Figure 11: Layout of the Input program](image)

1. **Title bar**
   
The name of the program and the title of the project is displayed in the title bar. Unsaved modifications in the project are indicated by a '*' in the project name.

2. **Menu bar**
   
The menu bar contains drop-down menus covering the options available in the Input program.

3. **Mode tabs**
   
The mode tabs are used to separate different workflow steps. The following tabs are available:
### Input program - General overview

**Layout of the Input program**

<table>
<thead>
<tr>
<th>Soil</th>
<th>To define the soil stratigraphy.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structures</td>
<td>To defined the structural components of the model.</td>
</tr>
<tr>
<td>Mesh</td>
<td>To define the mesh properties and generation of the finite element mesh from the geometry model.</td>
</tr>
<tr>
<td>Flow conditions</td>
<td>To define water- and thermal conditions through for instance water levels and boundary conditions.</td>
</tr>
<tr>
<td>Staged construction</td>
<td>To define the construction phases of the project and calculate the project.</td>
</tr>
</tbody>
</table>

**Note:** The first two modes (Soil and Structures) are referred to as the **Geometry** modes, whereas the latter three modes (Mesh, Flow conditions and Staged construction) are referred to as the **Calculation** modes.

For a more detailed description of the modes in the Input program see [Input program structure - Modes](on page 35).

#### 4. General toolbar

The general toolbar contains buttons for general actions such as file operations and model display arrangement. It also contains a button to start the Output program.

**Note:** If the mouse is moved over a button in a toolbar, a hint about the function of this button is displayed.

#### 5. Explorers

Information about the model and the project is given in the explorers. The availability and the functionality of the explorers depend on the active mode.

The explorers available in the input program are:

<table>
<thead>
<tr>
<th>Selection explorer</th>
<th>Displays the properties of the selected geometry objects and the features assigned to them. Additionally it gives the possibility to hide/show, activate/deactivate these objects ([Selection explorer](on page 44)).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model explorer</td>
<td>Displays the properties of all the geometry objects and the features assigned to them in the entire model. Additionally it gives the possibility to hide/show, activate/deactivate these objects ([Model explorer](on page 39)).</td>
</tr>
<tr>
<td>Phases explorer</td>
<td>Displays the list of the calculation phases, allowing to add, insert, delete and modify a calculation phase as well as the dependencies of all calculation phases ([Phases explorer](on page 44)).</td>
</tr>
</tbody>
</table>

**Note:** Selection explorer and Model explorer are referred as **Object explorer**

#### 6. Side toolbar

The buttons of the features available in the active mode are located in the side toolbar. A hint on the function of the button is displayed when the pointer is hovered over it for a few seconds. The side toolbar also contains options to select one or more objects in the drawing area.
7. Command line

PLAXIS 2D enables to carry out actions using keyboard input by typing the corresponding commands in the command line. On the other hand, most of the actions carried out using the mouse are translated into commands. All the commands executed in the project are displayed when the Model history tab is clicked, whereas only the commands executed in the active session together with the program's feedback are displayed when the Session tab is clicked.

Information about the available commands is provided when the Command reference option of the Help menu is selected.

8. Drawing area

The drawing area is the workspace on which the geometry model is created and modified. The geometry model can be created by means of the mouse and using the buttons available in the side toolbar. The buttons in the side toolbar vary according to the active mode. A more detailed description on the drawing area is given in Model in the drawing area (on page 37).

9. Status bar

The status bar displays information about the location of the mouse cursor in the drawing area. The display of rulers, origin, crosshair, grid and the snapping to grid or objects can be switched on/off by clicking the corresponding buttons in the status bar.

3.3 Menus in the Menu bar

The menu bar of the Input program contains drop-down menus covering most options for handling files, transferring data, viewing graphs, creating a geometry model, generating finite element meshes and entering data in general.

The availability of the menus depends on the active mode (Input program structure - Modes (on page 35)). The menus available in the Input program are:

<table>
<thead>
<tr>
<th>3.3.1 File menu</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New project</strong></td>
</tr>
<tr>
<td><strong>Open project</strong></td>
</tr>
<tr>
<td><strong>Recent projects</strong></td>
</tr>
<tr>
<td><strong>Save project</strong></td>
</tr>
<tr>
<td><strong>Save project as</strong></td>
</tr>
</tbody>
</table>
### Packing a project
*on page 509*
To compress the current project.

### Close project
To close the current project.

### Bentley Cloud Services [GSE] *on page 502*
To access to the different cloud services.

### ProjectWise Integration Commands [GSE] *on page 502*
To integrate PLAXIS projects with ProjectWise for infrastructure design collaboration.

### Import GeoStudio 2D (Tech. Preview)
To import geometry and assigned rock or soil material from Geostudio 2D analysis to PLAXIS 2D. For details refer to [Model Importer/Exporter] on page 518.

### Export GeoStudio 2D (Tech. Preview)
To export one of the defined construction stages in PLAXIS 2D, select the intended slip surface direction and export that as a single GeoStudio 2D *.gsz file*. This option is available only in the [Staged construction] mode. For details refer to [Model Importer/Exporter] on page 518.

### Import PLAXIS 2D LE (Tech. Preview)
To open the PLAXIS 2D LE model importer allowing the transfer of PLAXIS 2D LE projects into PLAXIS 2D. For details refer to [Model Importer/Exporter] on page 518.

### Export geometry
To export the current project. Available in [Soil] and [Structures] modes only. For details refer to [Exporting geometry [GSE]] on page 510.

### Project properties
To activate the [Project properties] window ([Project properties] on page 20).

### Print
To print the geometry model on a selected printer.

### Exit
To leave the Input program.

---

### 3.3.2 Edit menu

### Undo
To restore a previous status of the geometry model (after an input error).

### Redo
To redo an action that was undone.

### Copy screen image
To quickly open one of the most recent projects. To copy the model image to the Windows clipboard.
### 3.3.3 Soil menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Modify soil layers</strong></td>
<td>To modify the soil layers in the model using the borehole facility.</td>
</tr>
<tr>
<td><strong>Import soil [GSE]</strong></td>
<td>To import predefined soil volumes.</td>
</tr>
<tr>
<td><strong>Import soil from Central</strong></td>
<td>To import soil from Central (Seequent geoscience data management platform) to PLAXIS.</td>
</tr>
<tr>
<td><strong>Show material</strong></td>
<td>To open the material data base with material data sets.</td>
</tr>
<tr>
<td><strong>Design approaches [ADV]</strong></td>
<td>To open the Design approaches window.</td>
</tr>
</tbody>
</table>

The **Soil** menu is available only in the **Soil** mode.

### 3.3.4 Structures menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Import geometry [GSE]</strong></td>
<td>To import predefined geometry.</td>
</tr>
<tr>
<td><strong>Import geometry from Central</strong></td>
<td>To import geometry from Central (Seequent geoscience data management platform) into PLAXIS 2D.</td>
</tr>
<tr>
<td><strong>Show dynamics multipliers [ULT]</strong></td>
<td>To open the Dynamics multipliers window.</td>
</tr>
<tr>
<td><strong>Show materials</strong></td>
<td>To open the material data base with material data sets.</td>
</tr>
<tr>
<td><strong>Check geometry</strong></td>
<td>To check for geometric inconsistencies in the model.</td>
</tr>
<tr>
<td><strong>Show flow functions [ULT]</strong></td>
<td>To open the Flow functions window.</td>
</tr>
<tr>
<td><strong>Show thermal functions [ULT]</strong></td>
<td>To open the Thermal functions window.</td>
</tr>
</tbody>
</table>
Design approaches
[ADV]  To open the Design approaches window.

The Structures menu is available only in the Structures mode.

3.3.5 Mesh menu

<table>
<thead>
<tr>
<th>Check geometry</th>
<th>To check the geometry consistency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate mesh</td>
<td>To generate the mesh for the defined geometry.</td>
</tr>
</tbody>
</table>

The Mesh menu is available only in the Mesh mode.

3.3.6 Flow conditions menu

<table>
<thead>
<tr>
<th>Import water levels [GSE]</th>
<th>To import predefined water levels. More information on importing geometry is available in Importing geometry [GSE] (on page 524).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show materials</td>
<td>To open the material data base with material data sets.</td>
</tr>
<tr>
<td>Show flow functions [ULT]</td>
<td>To open the Flow functions window.</td>
</tr>
<tr>
<td>Show thermal functions [ULT]</td>
<td>To open the Thermal functions window.</td>
</tr>
</tbody>
</table>

The Flow conditions menu is available only in the Flow conditions mode.

3.3.7 Phases menu

<table>
<thead>
<tr>
<th>Edit phases</th>
<th>To open the Phases dialog window.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show materials</td>
<td>To open the material data base with material data sets.</td>
</tr>
<tr>
<td>Show dynamics multipliers [ULT]</td>
<td>To open the Dynamics multipliers window.</td>
</tr>
<tr>
<td>Show flow functions [ULT]</td>
<td>To open the Flow functions window.</td>
</tr>
</tbody>
</table>
# Menus in the Menu bar

<table>
<thead>
<tr>
<th>Show thermal functions [ULT]</th>
<th>To open the <em>Thermal functions</em> window.</th>
</tr>
</thead>
</table>

The *Phases* menu is available only in the *Flow conditions* and *Staged construction* modes.

## 3.3.8 Options menu

<table>
<thead>
<tr>
<th>Display numbers using</th>
<th>To select the <em>Significant digits</em> for the project.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autocomplete [GSE]</td>
<td>To activate or deactivate the autocomplete function in the command line.</td>
</tr>
<tr>
<td>Licencing information</td>
<td>To switch on or off showing the licence information at startup.</td>
</tr>
</tbody>
</table>

## 3.3.9 Expert menu [GSE]

<table>
<thead>
<tr>
<th>Examine commands</th>
<th>To display the commands executed in the project and to enable their examination.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run commands</td>
<td>To open the <em>Commands runner</em> window.</td>
</tr>
<tr>
<td>Macro library</td>
<td>To modify and run macros. Macros can be defined and indexed in the <em>Macro library</em> window, displayed as the corresponding option is selected in the sub-menu. To run a macro click the corresponding option in the sub-menu.</td>
</tr>
<tr>
<td>Run Python script</td>
<td>To configure remote scripting server and open python script to run them (Appendices <em>Python HTTP REST API wrapper [GSE]</em> (on page 615) and <em>HTTP REST API [GSE]</em> (on page 642)). Visit <em>Plaxis Remote Scripting Interface [GSE]</em> (on page 577) for more information.</td>
</tr>
<tr>
<td>Run Python tool</td>
<td>To configure remote scripting server and run python scripts (Appendices <em>Python HTTP REST API wrapper [GSE]</em> (on page 615) and <em>HTTP REST API [GSE]</em> (on page 642)).</td>
</tr>
<tr>
<td>Python</td>
<td>To <em>Configure Python Interpreter</em>, open and use <em>Interpreter</em>, <em>Editor</em>, <em>Command prompt</em>, <em>Jupyter notebook</em> and to run python scripts (Appendices <em>Python HTTP REST API wrapper [GSE]</em> (on page 615) and <em>HTTP REST API [GSE]</em> (on page 642)).</td>
</tr>
<tr>
<td>Configure remote scripting server</td>
<td>To specify an available port and open it for connections by local or remote clients (Appendices <em>Python HTTP REST API wrapper [GSE]</em> (on page 615) and <em>HTTP REST API [GSE]</em> (on page 642)).</td>
</tr>
</tbody>
</table>
**Sensitivity Analysis and Parameter variation [GSE] (on page 548)**

To evaluate the influence of model parameter on calculation results.

**Plaxis 2D to 3D Converter**

To automatically convert the geometry and soil materials of a PLAXIS 2D model into a PLAXIS 3D model.

**Calculation manager**

To easily queue up PLAXIS 2D PLAXIS 3D calculations run unattended calculations on projects (Typically less than 10 projects), or use manual control to run calculations manipulating them with the command line or python scripting. For more information visit [Bentley communities](https://www.bentley.com/).

**View files**

To display the contents of the (binary) files used in the current project.

---

### 3.3.10 Help menu

<table>
<thead>
<tr>
<th>Manuals</th>
<th>To display the manuals.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command reference</td>
<td>To display information about commands in the program.</td>
</tr>
<tr>
<td>Scripting reference</td>
<td>To open a Jupyter notebook with examples of PLAXIS commands using the Python scripting capabilities</td>
</tr>
<tr>
<td>Instruction movies</td>
<td>To reach the Bentley communities website where instruction movies are displayed.</td>
</tr>
<tr>
<td>Request support</td>
<td>To send a request for support.</td>
</tr>
<tr>
<td>Licence configuration...</td>
<td>To view, configure and update licences.</td>
</tr>
<tr>
<td>Visit website</td>
<td>To reach the PLAXIS 2D product page.</td>
</tr>
<tr>
<td>News Feed</td>
<td>To launch the PLAXIS 2D latest news</td>
</tr>
<tr>
<td>Disclaimer</td>
<td>The complete disclaimer text is displayed.</td>
</tr>
<tr>
<td>About</td>
<td>Information about the program version and licence are displayed.</td>
</tr>
</tbody>
</table>
3.4 Input program structure - Modes

The modelling process is completed in five modes. The mode tabs are shown in the mode bar. The modes are separated into Geometry and Calculation modes.

3.4.1 Geometry modes

The geometric configuration of the project is defined in the Geometry modes which are indicated by blue coloured tabs in the Input program. All the changes of geometry (such as creation, relocation, modification or removal of entities) are only possible in the Geometry modes. Features, such as structures (plates, beams), interfaces or loads, can be assigned to geometric entities only in the Structures mode.

The Geometry modes are:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Soil</td>
<td>The soil stratigraphy, the general water levels and the initial conditions of the soil layers are defined in the Soil mode. The features required to define the soil material and stratigraphy in the geometry are available. A detailed description on modelling soil stratigraphy is given in Material properties and material database (on page 169). Note that the soil stratigraphy can only be edited in this mode.</td>
</tr>
<tr>
<td>Structures</td>
<td>The geometric entities as well as the structural elements and forces in the project are defined in the Structures mode. Note that features, such as structures (plates), interfaces or loads, can be assigned to geometric entities only in the Structures mode.</td>
</tr>
</tbody>
</table>

3.4.2 Calculation modes

The calculation process is defined in the Calculation modes which are indicated by green coloured tabs in the Input program. In these modes entities cannot be created and new features cannot be assigned to existing geometry entities. However, the properties of the defined features (material dataset, load values) can be modified.

The Calculation modes are:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Mesh</td>
<td>The geometry model is discretised and a finite element mesh is generated in the Mesh mode. The geometric configuration cannot be modified in this mode. The mesh should be regenerated whenever the geometry of the project is modified.</td>
</tr>
<tr>
<td>Flow conditions</td>
<td>Water levels for a simple hydrostatic pore pressure distribution as well as boundary conditions for a groundwater flow analysis can be defined. Furthermore, boundary conditions for a thermal flow analysis can be defined in the Flow conditions mode.</td>
</tr>
<tr>
<td>Staged construction</td>
<td>Parts of the geometry model can be activated/deactivated and properties can be modified. The project is calculated in the Staged construction mode.</td>
</tr>
</tbody>
</table>

Note: The Flow conditions and Staged Construction modes are known as Phase definition modes.
3.5 Model in the drawing area

The drawing area displays the physical model and is automatically updated after any change in the geometry. The buttons in the toolbar located at the left side of the drawing area (side toolbar) can be used to create and modify the model. The availability of the tools depends on the active mode. These features are described in the following chapters depending on their function.

3.5.1 Supporting tools

Supporting tools such as Rulers, Coordinate axes, Snapping and Grid can be used to simplify the definition of the model geometry. The buttons under the drawing area can be used to switch on/off these tools.

Rulers

At both the left and the top of the drawing area, rulers indicate the physical x- and y-coordinates of the geometry model. This enables a direct view of the geometry dimensions. The rulers can be switched off by clicking the corresponding button under the drawing area.

Origin and global axes

The physical origin of the model is indicated by the intersection of the x- and y-axes. Each axis is displayed in a different colour and their positive directions are indicated by arrows. The axes and the origin can be switched off by clicking the corresponding button under the drawing area.

Crosshair

A pair of fine lines, representing the x- and y-axes can be displayed at the cursor location in the drawing area when the corresponding button is clicked under the drawing area.

Grid and snapping

To facilitate the creation of the geometry model, the user may define a grid for the drawing area. This grid may be used to snap the pointer into certain ‘regular’ positions. The grid and snapping, either to the grid or to objects in the model, can be activated by clicking the corresponding buttons under the drawing area. To define the grid and the snapping options:

- Click the Snapping options button in the bottom toolbar. The Snapping window pops up (Figure 12 (on page 38)). The options available are:
  - Snap to object: To switch on/off snapping to nearby objects.
  - Snap to grid: To switch on/off snapping to grid points defined by the Spacing and Snap interval settings.
  - Spacing: To set up the size of the grid cells, indicated by crossing perpendicular lines on the drawing area.
  - Number of snap intervals: To set intermediate snapping points inside the grid.
3.5.2 Model view - Zooming

To zoom in and out of the view, scroll the middle button (wheel) of the mouse. The location of the mouse cursor is the centre of the zoom.

- To define a local zooming rectangle, click the Zoom in button. The zoom area must be indicated using the mouse. Click the left mouse button at a corner of the zoom area; hold the mouse button down and move the mouse to the opposite corner of the zoom area; then release the button. The program will zoom into the selected area. The zoom option may be used repetitively.

- To restore the original view, click the Reset zoom button or select the corresponding option in the View menu.

3.5.3 Selecting geometry components

- When the Selection tool is active, a geometry component may be selected by clicking once on that component in the geometry model. Multiple selection is possible by holding down the Shift key on the keyboard while selecting the desired components.

- In addition to selecting geometry components one by one by using the Selection tool, several geometry components can be selected at once by using the Select multiple objects tool. A rectangle can be drawn in the drawing area by clicking on the first corner of the desired rectangle and moving the cursor while holding down the mouse button. After release of the mouse button, all visible geometry components in this rectangle will be selected.

The order in which the rectangle is created influences the selection type. Drawing from the upper left corner to the lower right corner selects all components that fall completely inside the rectangle. Drawing from the lower right corner to the upper left corner selects all components of which parts fall inside the rectangle.

It is also possible to select multiple geometry components of one type (for example points, lines or surfaces) or multiple structural elements of one type (for example node-to-node anchors or plates) at once by selecting the desired sub-tool from the Select rectangle menu.
Note: Right-clicking can be used to select entities in the model. After right-clicking an entity or a multiple selections of entities either in the drawing area or explorers, a menu appears displaying the name of the selection and different options depending on the selection. Clicking the name of the object in the menu copies it to clipboard. The copied name can be used in the command line (General information on command line (on page 45)).

### 3.6 Explorers

Explorers display information about the physical model, the calculation phases and their configuration.

<table>
<thead>
<tr>
<th>Explorer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model explorer</td>
<td>Information related to all the objects in the physical model is given.</td>
</tr>
<tr>
<td>Selection explorer</td>
<td>Information related to the object (or group of objects) selected in the drawing area is given. From a group selection, only the information valid for all the objects in the group.</td>
</tr>
<tr>
<td>Phases explorer</td>
<td>A list of the calculation phases defined in the project is displayed. The Phases explorer is available only in Calculation modes (on page 36). However, as phases are defined only in the Phase definition modes (see notes of Calculation modes (on page 36)), it is greyed out in the Mesh mode.</td>
</tr>
</tbody>
</table>

Note: The Model explorer and the Selection explorer are referred to as Object explorer.

#### 3.6.1 Model explorer

Model explorer displays information related to the physical entities composing the model. It is automatically updated as the model is modified (Figure 13 (on page 39)).

![Model explorer](image)

*Figure 13: Layout of the Model explorer in different modes: Structures Mode*
The information displayed in the Object explorers varies according to the active mode. Information related to geometry, such as location coordinates, is given in all modes, however it can only be edited in Geometry modes.

The visibility of the model components is indicated and can be modified in the Object explorers in all the modes of the program. However, activation/deactivation is possible only in the Staged construction mode.

The information displayed in the Object explorers depends on the active mode. The information is grouped under different categories.

**Attributes library:** The Attributes library contains global attributes that have been defined and that have been (can be) assigned to individual objects. An example of such an attribute is a material data set with properties. Other types of attributes are functions that describe time-dependent conditions, such as Dynamics multipliers or Flow functions. These functions can be assigned to dynamic loads and hydraulic boundary conditions, respectively, in order to describe the variation of a condition with time. Finally, the Attributes library contains the set of water levels that have been created from the information in the boreholes, the soil clusters and the user-defined water levels.

<table>
<thead>
<tr>
<th>Attribute Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamics multipliers [ULT]</td>
<td>All the displacement and load dynamics multipliers defined in the project are listed under Dynamics multipliers.</td>
</tr>
<tr>
<td>Flow functions [ULT]</td>
<td>All the flow functions (Head functions and Discharge functions) defined in the project are listed under Flow functions.</td>
</tr>
<tr>
<td>Thermal functions 2D [ULT]</td>
<td>All the thermal functions (Temperature functions, Heat flux functions and Heat total functions) defined in the project are listed under Thermal functions.</td>
</tr>
<tr>
<td>Materials</td>
<td>All the material sets assigned to the entities in the model are listed under Materials. The identification and the colour representing the material data set are displayed.</td>
</tr>
<tr>
<td>Design approaches 2D [ADV]</td>
<td>All the design approaches defined in the project are listed under Design approaches.</td>
</tr>
</tbody>
</table>
All the water levels created in the model are listed.

- **Borehole water levels**: The water levels generated according to the water conditions defined in the boreholes are listed.
- **User water levels**: The water levels created in the *Flow conditions* mode are listed.

Note that the *Water levels* subtree is available only in the *Calculation* (green) modes.

Since these attributes are *Global*, any change in such an attribute will affect the model as a whole. If it is the intention to change an attribute only in a particular calculation phase, it is advised to duplicate the attribute using the corresponding option in the right-hand mouse menu, and make the change in the copy.

**Stratigraphy**: The soil layers and boreholes created in the model are listed under *Stratigraphy*. This section displays Borehole information such as coordinates, head, pore pressure values, etc. and the associated soil layers, information that is especially beneficial for remote scripting in PLAXIS 2D. The user can view the data stored in an entity by right-clicking on the same and clicking on the tabulate option. Stratigraphy information consists of *Soil layer* and *Boreholes* information that provide the following details:

<table>
<thead>
<tr>
<th>Zones</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zones are the vertical positions of layer boundaries in the boreholes. For every zone the top and bottom of the layer is given as well as the thickness and the borehole corresponding to this zone.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pore pressure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Includes information about pore pressure per layer and borehole.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Boreholes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Includes all boreholes information: coordinates, head and field data.</td>
</tr>
</tbody>
</table>

**Geometry**: All the geometric entities created in the model are listed under *Geometry*. Note that when a geometric entity is created, its sub-entities are automatically created by the program. When a line is created, the first (start) point and the second (end) point are automatically created. New geometric entities are also automatically created when a geometric entity is decomposed.

The available sub-groups:

<table>
<thead>
<tr>
<th>Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>The points created in the model are listed. For each point, the coordinates of its location, the features assigned and their properties are given. Features such as <em>Point load</em>, <em>Point prescribed displacement</em> and <em>Fixed-end anchor</em> can be assigned to points. More information on points is given in [Create point](on page 71).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>The lines created in the model are listed. For each line the coordinates of its first and second points, the features assigned and their properties are given. Features such as beam, embedded beam, line load, line prescribed displacement and node-to-node anchor can be assigned to lines. More information on lines is given in [Create line](on page 72).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Polygons</th>
</tr>
</thead>
<tbody>
<tr>
<td>The polygons created or imported in the <em>Structures</em> mode are listed. For each polygon the coordinates of its reference point and the material data set assigned to it is given. More information on polygons is given in [Create polygon](on page 72).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Soil polygons</th>
</tr>
</thead>
<tbody>
<tr>
<td>The soil polygons generated according to the soil layers in boreholes or imported in the <em>Soil</em> mode ([Material properties and material database](on page 169)) and the material data sets assigned are given.</td>
</tr>
</tbody>
</table>
**Note:** In the *Geometry* modes, coordinates indicating the location of geometric entities are in the *Model explorer*. It is possible to relocate the points by changing these coordinates. Note that this is not possible in the *Calculation* modes, where geometry modifications are impossible ([Input program structure - Modes](on page 35)).

**Note:** In the *Calculation* modes, the *Coarseness factor* is given indicating the local refinement of the mesh at the geometric entity. The mesh can be refined or coarsened locally by modifying this value.

**Connections:** All the connections created explicitly by the user are listed.

**Embedded beam rows:** All the embedded beam rows created in the model are listed. Information about the assigned material and the connection type is given for each embedded beam row.

**Soils:** All the soils created in the model are listed. Information about the assigned material, volumetric strain and water conditions is given for each soil.

**Plates:** All the plates created in the model are listed. Information about the assigned material is given for each plate.

**Geogrids:** All the geogrids created in the model are listed. Information about the assigned material is given for each geogrid.

**Tunnels** [GSE]: All the tunnel cross sections created in the model are listed. Information about the segments composing the cross section as well as the insertion point of the cross section is given.

**Line (distributed) loads:** All the line (distributed) loads created in the model are listed. The distribution and the values of the load components can be defined.

**Prescribed displacement:** All the line prescribed displacements created in the model are listed. The distribution and the values of the prescribed displacement components can be defined.

**Point loads:** All the point loads created in the model are listed. The values of the load components can be defined.

**Point prescribed displacement:** All the point prescribed displacements created in the model are listed. The values of the prescribed displacement components can be defined.

**Interfaces:** All the positive and negative interfaces created in the project are listed. Either the material of the adjacent soil or a new material can be assigned. Permeability condition can be specified.

**Node-to-node anchors:** All the node-to-node anchors created in the model are listed. Information about the assigned material is given for each node-to-node anchor.

**Fixed-end anchors:** All the fixed-end anchors created in the model are listed. Information about the assigned material is given for each fixed-end anchor. The components and the equivalent length can be defined for each fixed-end anchor.

**Groundwater flow BC's** [ADV]: All the groundwater flow boundary conditions created in the model are listed. Information about the assigned behaviour (*Seepage, Closed or Head*), is given for each boundary condition. The assigned behaviour can be changed by selecting the option in the *Behaviour* drop-down menu.

**Thermal flow BC's** [ADV]: All the thermal flow boundary conditions created in the model are listed. Information about the assigned behaviour (*Closed, Temperature, Inflow, Outflow or Convection*), is given for each boundary condition. The assigned behaviour can be changed by selecting the option in the *Behaviour* drop-down menu.

**Wells** [ADV]: All the wells created in the model are listed. The behaviour (*Extraction, Infiltration*), the discharge (*|qwell|*) and the minimum head (*h_{min}* can be defined for each well.

**Drains** [ADV]: All the drains created in the model are listed. The head can be defined for each line drain.
**Model conditions**: The general boundary conditions of the model as a whole for each calculation phase can be specified in the *Model conditions* subtree in *Model explorer*. The conditions at the extremities of the model are considered. This makes it possible to make a quick selection of general boundary conditions that apply to the model as a whole. The *Model conditions* subtree is available in the *Calculation* modes in the Input program. Modification of the information given in the *Model conditions* subtree is possible only in the *Flow conditions* and *Staged construction* modes. Note that any change in the model boundaries is applied only to the phase selected in Phases explorer.

The options available are:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Climate</strong> [ADV]</td>
<td>This option can be used for thermal calculations to specify a general thermal convective condition due to weather conditions to all boundaries that represent the ground surface. Other types of thermal boundary conditions can be defined using the corresponding feature in the Structures mode ([Thermal conditions [ADV] (on page 155)).</td>
</tr>
<tr>
<td><strong>Deformations</strong></td>
<td>A set of general fixities is automatically applied to the boundaries of the geometry model for the selected calculation phase. More information on default fixities is given in [Model conditions](on page 383). The default general fixities are removed when the corresponding option is set to <em>False</em>. In that case it is required to set the appropriate boundary conditions manually.</td>
</tr>
<tr>
<td><strong>Dynamics</strong> [ULT]</td>
<td>The model conditions for a dynamics analysis can be defined at the extreme boundaries of the model. The options available are <em>None</em>, <em>Viscous</em>, <em>free-field</em>, <em>compliant base</em>, and <em>tied degrees of freedom</em>. Besides the boundary conditions, the relaxation coefficients ($C_1$ and $C_2$) can be defined for each phase. For more information on boundary conditions for <em>Dynamics</em> calculations see [Model conditions](on page 383).</td>
</tr>
<tr>
<td><strong>Groundwater Flow - steady state</strong> [ADV]</td>
<td>The model conditions for a steady state groundwater flow calculation or a consolidation analysis can be defined at the extreme boundaries of the model. The options available are <em>Open</em> and <em>Closed</em>.</td>
</tr>
<tr>
<td><strong>Groundwater Flow - transient</strong> [ULT]</td>
<td>The model conditions for a transient groundwater flow calculation or fully coupled flow-deformation analysis can be defined at the extreme boundaries of the model. The options available are <em>Open</em> and <em>Closed</em>.</td>
</tr>
<tr>
<td><strong>Precipitation</strong> [ADV]</td>
<td>This option can be used to specify a general vertical recharge or infiltration ($q$) due to weather conditions to all boundaries that represent the ground surface. Other types of flow boundary conditions can be defined using the corresponding feature in the Structures mode ([Hydraulic conditions [ADV] (on page 140)).</td>
</tr>
</tbody>
</table>
This option can be used to specify a global acceleration to model dynamic forces in a pseudo-static way. The input values of the x- and y-acceleration components are expressed in terms of the normal gravity acceleration $g$

![Diagram](image)

*Figure 15: Resulting force direction $r$ due to combinations of gravity and pseudo-static acceleration*

This option can be used for thermal calculations for which the Thermal calculation type in the Phases window is set to Earth gradient, to specify an (initial) temperature distribution in the ground. The temperature distribution is defined by means of a reference temperature, $T_{ref}$, a reference level, $h_{ref}$, and an earth gradient (increase of temperature per unit of depth). This temperature distribution which is used in each soil cluster in which the thermal conditions parameter is set to None.

The global water level for a selected calculation phase can be assigned in the Water subtree under Model conditions in Model explorer. More information of the usage of the global water level is given in Global water level (on page 342).

**Note:** The reference level, $h_{ref}$, is likely to coincide with the ground surface, but may also be taken above or below the ground surface. In case $h_{ref}$ is below the ground surface, the temperature at the ground surface is set equal to the reference temperature, as defined in the Constants tabsheet of the Project properties window (Project properties (on page 20)). The temperature distribution from the ground surface to $h_{ref}$ is then obtained from a steady-state thermal flow calculation, whereas the temperature distribution below $h_{ref}$ is obtained from $T_{ref}$ and the earth gradient.

### 3.6.2 Selection explorer

The Selection explorer displays information about the selection made in the drawing area. For multiple objects, the common information is displayed. The structure of the Selection explorer is the same as the one of the Model explorer.

### 3.6.3 Phases explorer

The Phases explorer is available in the Calculation modes in the Input program. It visualises the order of the calculation phases and it provides information for each calculation phase (e.g. calculation status, calculation type, loading type, etc.). Modification of the information given in the Phases explorer is possible only in the Flow
conditions and Staged construction modes. More information on the Phases explorer is given in Figure 16 (on page 45).

Figure 16: Phases explorer

3.7 General information on command line

At the bottom of the input application, a command line panel is available. The command line provides an alternative way of executing operations, by entering text commands. In fact, all operations in the input application generate a command as text, that is sent to an interpreter, before being processed. It is possible to make the command line panel into a new window, by right clicking in the command window and choosing the option Pop out.

It is also possible to copy All commands, Successful commands or Successful responses, by selecting the desired commands in the command line panel and right clicking the selected commands for menu options.

A feedback panel is situated above the command line panel. Here, the executed commands are shown, together with the feedback of the command. Successful commands return green coloured feedback, consisting of details on newly generated geometry or elements. Erroneous commands return red coloured feedback, containing an error report.

A command consists of a command name, followed by a number of parameters. Together, they constitute the signature of the command. The number and type of parameters depends on the particular command, and can be zero or larger.

Commands can be divided into two types:

<table>
<thead>
<tr>
<th>Global commands</th>
<th>Have a global scope (like the project or the geometry) that are not necessarily named in the command, and may or may not have parameters. An example is the undo command.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target commands</td>
<td>Have a local scope restricted to the selected (target) objects, such as geometric entities and materials. An example of such command is the set command.</td>
</tr>
</tbody>
</table>

Command names consist of a simple string. Many commands have a short name in addition to the standard, explicit long name (for example point and pt). Any command name can be prefixed with one underscore in order to distinguish it from any objects bearing the same name (the commands undo and _undo are identical). The application will always generate the commands with an underscore prefix. It is safe to omit the prefix in
hand written code. There are also commands that start with two underscores. These are mostly intended for debugging, troubleshooting or advanced automation purposes. The underscores in those cases are not optional.

Command parameters can be of two different types:

<table>
<thead>
<tr>
<th>References to objects</th>
<th>Represented by strings containing the name of an object. The names of such objects may not start with an underscore (_).</th>
</tr>
</thead>
</table>
| Value                 | Can be of many data types, such as strings, integers, floating point numbers, enumerations and booleans. String value parameters must be between single (') or double (") quotes, and may start and end with either one, two or three of these quotes. Examples of valid string value parameters are: "hello", "hello 'world'!", "Young's "modulus"". Floating point numbers must always use the dot decimal notation, even on systems that normally use comma as decimal separator. Enumerations may be represented either by a string value, or by the corresponding integer index of that value. Booleans are represented as True or False. In most cases where a value is expected, a property of that type is also allowed - this is indicated by a trailing single quote. For example when trying to set the x coordinate of a point, this can be done as `set point_1.x 5.2` or as `set point_1.x point_2.x`.

In some cases it is allowed to place parameters between parentheses, which is indicated by a trailing single quote in the parameter signature of a command. For example a point can be made with the command `point (1 2)` or as `point (1 2)`. The parentheses are optional and are mostly useful for legibility, but may in some cases be necessary in order to distinguish between different types of calls to a given method.

In PLAXIS 2D, a global command is included that shows information on the commands that can be executed: `cms`. This command lists the signatures of all commands available in PLAXIS 2D.

As an example, the signature for the `delete` command is shown here:

```plaintext
delete (del)
  Material'
  <1,...: Feature>'
  <1,...: Point' |Line' |GeoPolygon'>'
  <1,...: Borehole'>'
  Soillayer
```

In the first line, the command name and its abbreviation are shown. Each of the following lines shows a different set of parameters that can be used with this command. In this example there are five different signatures for the `delete` command. The `delete` command can be either used to delete a single material (referenced by its name), a set of features, a set of geometric elements, a set of boreholes, or a single soil layer. Note that the signatures do not allow a feature, a geometric element or a borehole to be deleted in one single call of `delete`.

Below are several examples of the `delete` command:

- `delete SoilMat_1`
- `delete Polygon_1 Polygon_2`
- `delete (Polygon_1 Polygon_2)`
3.7.1  Indexing in commands

Array indexing syntax can be used in the command line. This consists of square brackets behind an object name, followed by either an integer or a string and a matching closing bracket. Integer indexing is zero-based and works on any listable object, i.e. any object on which you can use a filter or tabulate command. Both positive and negative numbering is used in indexing. The positive numbering begins at the start of the list, in which 0 is the first item from the list, while negative numbering starts from the end and goes backwards through the list. As an example:

```plaintext
>line (1 2)(5 1)(5 3)(4 7)  #Create points with coordinates specified in the brackets and lines connecting them
	Object x y
	Point_1 1 2
	Point_2 5 1
	Point_3 5 3
	Point_4 4 7

>move points[0] -1 -2  #Relocate point_1 to (0 0)
>move points[-1] -1 -2  #Relocate the last added point, point_4 to (3 5)
>move points[-4] 1 2  #Relocate the first added point, point_1 to (1 2)
```

Note that the program indexes the entities in the order they are created. The indexing of features such as soil, structural elements, loads or prescribed displacements, is NOT done according to the order of their assignment to geometry but according to the order of creation of the geometric entities they are assigned to.

3.7.2  Accessing Output commands in Input command line

The prefix /output allows redirecting commands to Output when they are entered in Input. This may be useful for generating one-file scripts that also call Output, for example, selection of nodes for curves. Examples:

```plaintext
/>output addcurvepoint "Node" (-2.5 25)  #Adds curve point (-2.5 25 5) before starting calculations in Input.
/>output update  #List the created points and their coordinates
```
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>!/output getresults InitialPhase &quot;UTOT___R&quot;</code></td>
<td>Displays the minimum and maximum or uniform value of the calculation results of block 'UTOT___R' in the initial phase.</td>
</tr>
</tbody>
</table>
Ground modelling - Soil mode

The soil stratigraphy is defined in the soil mode using the Borehole feature of the program. When a new project is created, the soil contour defined in the Project properties window is displayed in the drawing area.

![Image of a new project in the Soil mode]

Figure 17: View of a new project in the Soil mode

4.1 Adjustment of the soil contour

The extension of the model can be specified in the Model tab sheet of the Project properties window. The Project properties window can be activated by selecting the corresponding option in the File menu.

4.2 Creating boreholes

Boreholes are locations in the drawing area at which the information on the position of soil layers and the water table is given. If multiple boreholes are defined, PLAXIS 2D will automatically interpolate between boreholes, and derive the position of the soil layers from the borehole information. Each defined soil layer is used...
throughout the whole model contour. In other words, all soil layers appear in all boreholes. The top and the bottom boundaries of the layers may vary through boreholes, making it possible to define non-horizontal soil layers of non-uniform thickness as well as layers that locally have a zero thickness.

4.2.1 Creating new boreholes

To create a borehole click Create borehole and click on its location in the drawing area. The Modify soil layers window pops up (Figure 18 (on page 50)). Boreholes and soil layers can be modified in this window.

To add new boreholes in the Modify soil layers window:

- Click Boreholes (lower button) and select the Add option. The Add window pops up (Figure 19 (on page 50)).
- In the Add window define the position of the new borehole (x coordinate).
- Define the source borehole to copy initial layer boundaries from. By default, the source borehole is the nearest one.

Figure 18: Modify soil layers window

Figure 19: Add borehole window
4.2.2 Editing boreholes

Boreholes are named consecutively by the program. Boreholes can be renamed in the Model explorer and in its soil column in the Modify soil layers window. When changing the name, use just letters, digits, and the only allowed special character (underscore '_'). The location of a borehole can be changed by specifying the coordinates of the new location in its soil column in the Modify soil layers window.

To relocate a borehole in the Drawing area:

- Click the Move borehole button in the side toolbar.
- In the drawing area select the borehole and drag and drop it to the new location.

The interpolation of layer boundaries is automatically adapted according to the new borehole position.

The display of the boreholes in the Modify soil layers window is managed using the options in the menu appearing as the Boreholes button is clicked.

<table>
<thead>
<tr>
<th>Add...</th>
<th>To create a new borehole.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add array...</td>
<td>To create multiple boreholes organised in a rectangular pattern.</td>
</tr>
<tr>
<td>Select</td>
<td>The boreholes to be displayed in the Modify soil layers window are selected.</td>
</tr>
<tr>
<td>Show all</td>
<td>All the created boreholes are shown.</td>
</tr>
<tr>
<td>Hide all</td>
<td>All the created boreholes are hidden.</td>
</tr>
<tr>
<td>Invert visibility</td>
<td>The view of the Modify soil layers can be inverted to selected or unselected boreholes.</td>
</tr>
<tr>
<td>Sort by</td>
<td>The appearance order of the boreholes in the Modify soil layers window can be arranged according to the Creation order, Name and Position.</td>
</tr>
</tbody>
</table>

4.3 Soil layers

The first borehole, created at the start of a new project, contains no soil layers. Soil layers in boreholes are defined in the Modify soil layers window.

The Modify soil layers window contains the following items (Figure 18 (on page 50)):

<table>
<thead>
<tr>
<th>Soil column</th>
<th>Graphs of all boreholes with indication of their locations, water head, layer boundary levels and soil material.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upper buttons</td>
<td>Buttons to add, insert or delete soil layers.</td>
</tr>
</tbody>
</table>
### 4.3.1 Creating soil layers in boreholes

Soil layers are created using the top buttons in the **Soil layers** tabsheet.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>To add a new layer below the lowest layer in the model.</td>
</tr>
<tr>
<td>Insert</td>
<td>To insert a new layer above the selected one.</td>
</tr>
</tbody>
</table>

The thickness of the new layers is zero length units by default. The thickness of the top soil layer in a borehole can be changed by modifying its **Top** and **Bottom** boundaries. The top boundary of an underlying layer is defined by the lower boundary of the overlying layer. To change the thickness of such a layer, the user can alter the **Thickness** option in the **Zones** of the soil layer under **Stratigraphy** tree in the **Model explorer** or simply by changing the bottom boundary of this soil layer.

If a new borehole should contain a layer that does not exist yet, this additional soil layer may be added using the **Add or Insert** buttons. In principle, this action creates a new soil layer in all existing boreholes, but the new layer has a zero thickness in all the boreholes that have been defined earlier to ensure that existing layer distributions are not influenced by this action. In the current borehole the layer thickness can be modified according to the description given in the previous paragraph.

An existing layer may be removed by right-clicking it, either in the tabsheet or in the **Soil column**, and select the option **Delete** in the appearing menu. It should be noted that the layer will be deleted in all the boreholes of the project. If a layer is selected and the **Delete** button is clicked, the **Delete soil layer** window will appear (Figure 20 (on page 53)).
4.3.1.1 Assigning soil properties

If a certain soil layer does not exist at the position indicated by a model borehole, it should be assigned a zero thickness (bottom level equal to top level) in the relevant borehole of the model.

Different soil layers will have different properties. Individual layer properties can be defined in material data sets. Material data sets are contained in the material database. There are several ways to assign material properties to a soil layer in the Modify soil layers window. You can:

- Click the Materials button. The Material sets window pops up. Drag and drop the material to the corresponding layer either in the tabsheet or in the soil column.
- Click the material either in the Soil layers tabsheet or in the Initial conditions tabsheet. Select the material from the drop-down menu of defined material sets.
- Right-click the soil layer in the tabsheet, point to Set material and then click the material you want to assign.

The colour of the layer in the geometry indicates the material set assigned. The procedure of assigning material datasets to soil layers should be repeated until each layer has its appropriate data set. The names and colours of the material data sets for all layers are shown in the Soil layers tabsheet. If the material data set of a layer is changed in a borehole, the same change will be applied to the same layer in all other boreholes.

To assign material to soil layers in the drawing area in the Soil mode:

- Click the Show materials button in the side toolbar. The Material sets window pops up.
- Drag and drop the material to the corresponding layer.

4.3.2 Defining water conditions

Groundwater and pore pressures play an important role in the soil behaviour. PLAXIS 2D is based on effective stress principles, in which total soil stresses are divided into effective stresses (in the grain skeleton) and pore pressures (in the pores of the soil). This requires a proper definition of water conditions. In many cases groundwater flow can be neglected and the (steady-state) pore pressure distribution in the ground is more or
less known from in-situ soil investigation data. In this case the definition of water conditions can be conveniently related to the creation of boreholes, which forms the basis for a direct generation of pore pressures. In situations where groundwater flow occurs, the pore pressure distribution is not necessarily a priori known, and it may be required to perform a groundwater flow calculation in order to generate the pore pressures in the soil. More details on groundwater flow calculations and the definition of hydraulic boundary conditions are given in Hydraulic conditions [ADV] (on page 140). The current section deals with the definition of water conditions in boreholes for a direct generation of pore pressures.

The water conditions of the soil layers can be defined for each borehole in the Water tabsheet by selecting one of the options available in the drop-down menu for each soil layer. There are two columns for each borehole showing the values of the pore pressure distribution at the top \( p_{\text{top}} \), and the bottom \( p_{\text{bottom}} \) of each soil layer. Note that pressure is considered to be negative.

![Figure 21: Water tabsheet of the Modify soil layers window](image)

The options for water conditions are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Head</strong></td>
<td>The pore pressures are generated according to the specified head (phreatic level or water level) in each borehole. The generated pore pressure distribution is visualised in the soil column of the borehole. A head level lower than the top level of the layer, is indicated by a positive value (suction) at the top ( p_{\text{top}} ). However, positive pore stresses are not shown.</td>
</tr>
<tr>
<td><strong>Hydrostatic</strong></td>
<td>The pressure value at the top boundary of the soil layer is to be defined. The program will calculate the pore pressure distribution in the soil layer accordingly, taking into account the unit weight of water.</td>
</tr>
<tr>
<td><strong>Interpolate</strong></td>
<td>It enables linear vertical interpolation of the pore pressure distribution of the layer from the pressure at the boundary with the layer above to the pressure at the boundary with the layer below the current layer.</td>
</tr>
</tbody>
</table>
To remove water pressures from a soil layer select the *Dry* option. The value of pore pressure at the upper level of the layer \( (p_{\text{top}}) \) and the value of the pore pressure at the bottom level of the layer \( (p_{\text{bottom}}) \) will be zero and no pressure will be generated in the layer.

Positive and negative values can be assigned to the top and bottom levels of the soil layer. The pore pressure distribution in the soil layer is interpolated linearly from these values. However, in the borehole only negative pressure values will be visualised. Note that PLAXIS 2D can deal with positive pore water stresses (suction) in calculations. Defining a positive value at the top of the layer and a negative value at the bottom means that there is a phreatic level in the layer.

The program generates water levels according to the information provided in the *Water* tabsheet. Water levels can represent external water levels as well as phreatic levels in the soil. The water level created according to the Head levels in the boreholes is automatically assigned as *Global water level* in the calculation phases. A more detailed description is given in *Flow conditions* (on page 370).

By default, positive pore water stress (suction) in the unsaturated zone above the phreatic level is ignored. However, PLAXIS 2D can deal with suction in calculations. This requires the selection of an appropriate soil water retention curve in the material data set (*Groundwater tabsheet* (on page 236)). It also requires that suction is allowed during the calculations (*Flow control parameters [ADV]* (on page 367)).

### 4.3.3 Initial Conditions of Soil

The *Initial conditions* tabsheet in the *Modify soil layers* window offers (Figure 22 (on page 55)) shows the soil model and the parameters. Double clicking one of these values in the *Initial conditions* tabsheet opens the corresponding material dataset in the material database.

![Figure 22: Initial conditions tabsheet of the Modify soil layers window](image-url)
The initial stresses in a soil body are influenced by the weight of the soil, the water conditions and the history of its formation. This stress state can be generated using either the K0 procedure or Gravity loading. The generation of initial state stresses is described in Initial stress generation (on page 318).

If the K0 procedure is used, a proper $K_0$ value i.e. the initial ratio between horizontal effective stress and vertical effective stress needs to be specified for all layers.

4.3.4 Preconsolidation

The way to generate initial preconsolidation stress is defined in the Preconsolidation tab in the Modify soil layers window. It is on the POP or OCR data provided in the Initial tab in the material data set (Figure 23 (on page 56) and Initial tabsheet (on page 263)). Preconsolidation is most relevant when using advanced constitutive models that include preconsolidation pressure as a state parameter to distinguish between primary loading behaviour and unloading or reloading behaviour. In addition, preconsolidation may also be used to initialise a state parameter $\sigma_{1,max}'$ that is later used to account for the stress history to (re)initialise other (state) parameters. This is, for example, the case with SHANSEP type models, which are available as user-defined soil models in PLAXIS.

![Figure 23: Initial tabsheet in the Soil window](image)

The POP values for each stress point are used for the initialisation of the preconsolidation stress ($\sigma_{1,max}'$), which is initialised in the initial phase and kept updated over all calculation phases as a general state parameter). In the SHANSEP NGI-ADP and the SHANSEP MC models, the undrained shear strength is calculated according to the preconsolidation stress. In the Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model and Sekiguchi-Ohta model, the yield surface is defined consistently with the defined stress history of the soil. The POP (or OCR) is used to calculate the $\sigma_{1,max}'$ at the end of the Initial phase calculation. In the subsequent calculation phases, $\sigma_{1,max}'$ is compared to the current $\sigma_{1,max}'$ and updated if exceeded.
Currently, the only option available to define preconsolidation is *From material* and *From boreholes* (Figure 24 (on page 57)).

**Figure 24: The Preconsolidation tabsheet of the Modify soil layers window**

**From material:** The preconsolidation stress is calculated based on the information (OCR or POP) as defined in the material data sets.

**From boreholes:** In case the definition of the preconsolidation stress requires a spatial distribution of the pre-overburden pressure POP, such distribution may be defined by selecting the *From boreholes*. In the **Preconsolidation** tabsheet, there are two columns for each borehole showing the values of the POP distribution at the top (POP\textsubscript{top}), and the bottom (POP\textsubscript{bottom}) of each soil layer (Figure 24 (on page 57)). The spatial variation is linearly interpolated between the defined values and between the boreholes (in case of multiple boreholes).

**Note:**
- All soil layers defining POP\textsubscript{top} and POP\textsubscript{bottom} for one borehole result in a POP variation only in vertical direction.
- All soil layers defining different POP\textsubscript{top} and POP\textsubscript{bottom} for multiple boreholes result in a POP variation both vertically and horizontally.

**4.3.5 Generating soil stratigraphy from CPT logs [GSE]**

Cone Penetration Tests (CPT) are commonly used in geotechnical engineering practice to determine the stratigraphy and the type of materials, to estimate geotechnical parameters and to provide results for direct geotechnical design.

The test offers continuous measurements of the cone resistance ($q_c$) and the sleeve friction ($f_s$) along the depth. In the case of Cone Penetration Test with pore pressure measurement ($CPT_u$) also the pore pressure (usually behind the cone, $u_2$) is measured.
In PLAXIS 2D, it is possible to load the data of a CPT test and use the Robertson method for the interpretation of the soil stratigraphy or the CUR 3 layers system for data interpretation. The CPT-based chart (Robertson et al., 1986 (on page 588)) is predictive of the soil behaviour type (SBT) and not directly of the soil classification criteria based on grading and plasticity (USCS, Unified Soil Classification System) but there is often good agreement between the two types of classification.

Note: The soil stratigraphy in a borehole can be specified using available CPT logs that can be loaded in PLAXIS 2D. More information on the required format is given in Import CPT data: required file format [GSE] (on page 590).

4.3.5.1 Robertson Method

The Robertson classification is based on the non-normalised cone resistance which allows to identify 9 different areas with different behaviour. A simplified approach to assign the SBT to each measurement point consists of calculation of the index $I_{SBT}$. This index allows to identify only the soil layers with SBT from 2 to 7 (Figure 25 (on page 59)).

To simplify the application of the CPT charts, the cone resistance and the friction ratio can be used to calculate the $SBT$ index, $I_{SBT}$, where the index is the radius of the concentric circles that represent the boundaries between the zones. Based on predefined ranges, it is possible to determine the $SBT$ zone for each point.

The index $I_{SBT}$ is given by the following equation:

$$I_{SBT} = \left[ \left( 3.47 \cdot \log \left( \frac{q_c}{p_a} \right) \right)^2 + \left( \log \left( R_f \right) + 1.22 \right)^2 \right]^{0.5} \quad \text{Eq. [1]}$$

where

- $q_c$ = Cone resistance
- $R_f$ = Friction ratio ($=f_s/q_c$)
- $f_s$ = CPT sleeve friction
- $p_a$ = Atmospheric pressure.
Figure 25: SBT chart based on cone resistance \( \frac{q_c}{p_a} \) and friction ratio \( R_f \) showing contours of \( I_{SBT} \) (after Robertson et al., 1986)

Note:

- CPT data can be loaded in PLAXIS 2D in the form of simple text files. These files need to be constructed following the format (e.g. header and units) illustrated in Import CPT data: required file format [GSE] (on page 590).

The soil layers can be subdivided considering the following intervals:

<table>
<thead>
<tr>
<th>( I_{SBT} )</th>
<th>Soil type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( I_{SBT} &gt; 3.60 )</td>
<td>2</td>
<td>Organic soil - peat</td>
</tr>
<tr>
<td>( 2.95 &lt; I_{SBT} &lt; 3.60 )</td>
<td>3</td>
<td>Clays: clay to silty clay</td>
</tr>
</tbody>
</table>
## Soil layers

<table>
<thead>
<tr>
<th>$I_{SBT}$</th>
<th>Soil type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.60 &lt; $I_{SBT}$ &lt; 2.95</td>
<td>4</td>
<td>Silt mixture: clayey silt and silty clay</td>
</tr>
<tr>
<td>2.05 &lt; $I_{SBT}$ &lt; 2.60</td>
<td>5</td>
<td>Sand mixtures: silty sand to sandy silt</td>
</tr>
<tr>
<td>1.31 &lt; $I_{SBT}$ &lt; 2.05</td>
<td>6</td>
<td>Sands: clean sand to silty sands</td>
</tr>
<tr>
<td>$I_{SBT}$ &lt; 1.31</td>
<td>7</td>
<td>Dense sand to gravelly sand</td>
</tr>
</tbody>
</table>

**Figure 26:** Colour scheme adopted in PLAXIS 2D representing different layers for different $I_{SBT}$

### 4.3.5.2 Importing CPT data

To import CPT data:

- Create a borehole in the model corresponding to the location at which CPT data are available.
- Proceed to the **Field data** tabsheet by clicking the corresponding tab in the **Modify soil layers** window.
- Add field data by clicking the green plus button and select the file containing the data in the **Open Field data** window. The available logs are listed in the **Field data** tabsheet.
- Click the expansion button next to the borehole.
- Select the data to be considered from the **Field data** drop-down menu.
- Select the **Interpretation** method, either the **Robertson** option or the **CUR 3 layers** method. The **CUR 3 layers** criteria are shown in **Figure 26** (on page 60).
- Enter the minimal layer thickness (*Minimal thickness* option) to be considered in layer generation to avoid multiple thin layers. The expanded **Modify soil layers** window is shown in **Figure 28** (on page 61).
- Click **Apply layers** to subdivide the soil cluster into the layers shown in the borehole.
When soil stratigraphy is generated from CPT logs the created layers will be applied to the whole model. Boreholes can be used to modify the layer thicknesses at their location. However only one CPT log can be used in a project. Generation of layers resulting from a new CPT log will overwrite the existing ones. For more information about the importing process of CPT data please visit Bentley Communities.
4.4 Importing soil layers [GSE]

**Note:** The *importing soil layers* is a particular functionality of the [Importing geometry [GSE]](on page 524) (PLAXIS Advanced tools).

In the *Soil* mode, the geometry of the soil can be imported by clicking the *Import soil* button available in the side toolbar or by selecting the *Import soil* option available in the *Soil* menu. When importing a geometry file, a list of possible file extensions are shown in [table](on page 62).

<table>
<thead>
<tr>
<th>File extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.dxf</td>
<td>AutoCAD interchange files.</td>
</tr>
</tbody>
</table>
| *.csv          | Comma-separated value files. An example for csv files is given:  
                     Points  
                     0 , 0.00 , 0.00  
                     1 , 20.0 , 00.0  
                     2 , 20.0 , 10.0  
                     3 , 0.00 , 10.0  
                     Lines  
                     0 , 0 , 1  
                     1 , 1 , 2  
                     2 , 2 , 3  
                     3 , 3 , 0 |
| *.geo, *.sti   | D-series files. |
| *.txt          | Tab-separated txt files. An example for txt files is given:  
                     Points  
                     0 0.00 0.00  
                     1 20.0 00.0  
                     2 20.0 10.0  
                     3 0.00 10.0  
                     Lines  
                     0 0 1  
                     1 1 2  
                     2 2 3  
                     3 3 0 |
| *.brep         | OpenCascade shape files. |
| *.step         | STEP files. |
| *.stp          | STP files. |
Before importing *.dxf files, the INSUNIT global variable should be set to the desired unit Table 1 (on page 63).

Table 1: Default drawing units for AutoCAD blocks

<table>
<thead>
<tr>
<th>Unit</th>
<th>INSUNIT value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unitless</td>
<td>0</td>
</tr>
<tr>
<td>Inches</td>
<td>1</td>
</tr>
<tr>
<td>Feet</td>
<td>2</td>
</tr>
<tr>
<td>Miles</td>
<td>3</td>
</tr>
<tr>
<td>Millimeters</td>
<td>4</td>
</tr>
<tr>
<td>Centimeters</td>
<td>5</td>
</tr>
<tr>
<td>Meters</td>
<td>6</td>
</tr>
<tr>
<td>Kilometers</td>
<td>7</td>
</tr>
<tr>
<td>Micronches</td>
<td>8</td>
</tr>
<tr>
<td>Mils</td>
<td>9</td>
</tr>
<tr>
<td>Yards</td>
<td>10</td>
</tr>
<tr>
<td>Angstroms</td>
<td>11</td>
</tr>
</tbody>
</table>
After selecting the file, the **Import geometry** window pops up (Figure 29 (on page 63)), where the geometry can be modified. It is possible to import only some of the geometry entity types by keeping the corresponding option(s) checked in the **Import geometry** window.

**Note:**
- It is recommended that users check the external file units before starting the importing process. For file formats such as DXF and STEP, PLAXIS takes into consideration the units defined there. In the case units are not defined in the file, or the file format doesn't support any units (e.g. BRep), PLAXIS will consider that the geometry is defined in the current PLAXIS project length units.
- Material properties of polygons are not imported and need to be created in the material data base.
- A description of the feature and an instructional movie is given in ([Bentley Communities](#)).

### 4.4.1 Scaling

The imported geometry can be scaled by defining a factor for scaling in all directions.

### 4.4.2 Offset to global coordinates

When a geometric object is imported, its reference point can be chosen in three different ways:

<table>
<thead>
<tr>
<th>Minimum of imported model boundaries</th>
<th>The insertion point is automatically chosen as the minimum value of the model boundaries.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum of imported model boundaries</td>
<td>The insertion point is automatically chosen as the maximum value of the model boundaries.</td>
</tr>
<tr>
<td>Custom</td>
<td>The user can enter a specific value for the insertion point.</td>
</tr>
</tbody>
</table>

Redefining the location of the insertion point will relocate the reference point.
4.4.3 **Bounding box**

The coordinates of the box bounding the imported geometry are shown.

4.5 **Site response analysis [ULT] + [GSE]**

The *Site response* facility in PLAXIS can be used to perform a 1-Dimensional Site Response Analysis prior to a dynamics calculation. The site response analysis of a soil deposit can be considered as a necessary preliminary study for the dynamics analysis of a structure since its seismic response is influenced by the geotechnical properties of the supporting soil. The Site response facility works for any soil model, both standard and user-defined models. Only soil layers defined in the borehole window are considered for the analysis.

![Figure 30: 1D Site Response Analysis Option in Modify Soil Layers window](image)

The *Site response* option is available from the **Modify soil layers** window for any defined borehole (**Figure 30** (on page 65)). The analysis will be based on the soils and rocks as defined in a single selected borehole. The user should conduct the analysis multiple times if it is required to perform an analysis for multiple boreholes. The prerequisites for 1D site response analysis are defining a borehole with corresponding head level, soil layers, soil parameters, and at least one accelerogram. It must be noted that only material models which are added to the borehole tab are adopted in the analysis and material models which are changed or modified in staged construction mode are not taken into account. Edit displacement multipliers can be used to define displacement multipliers easily. Any number of multipliers can be added for the calculation under a single project. Users can also toggle drift correction, if necessary for accelerations defined. Additionally, a bottom cut-off value can be defined for the model. The idea is that, in principle, a 1D site response analysis shall consider the entire soil profile all the way down to the bedrock, whereas the intended 2D (or 3D) dynamics analysis may be cut at a particular depth in the soil (for example 30 m depth). The 1D site response analysis may then provide the required input signal at the base of the 2D (or 3D) model. The program will automatically extract an
Ground modelling - Soil mode
Site response analysis [ULT] + [GSE]

Accelerogram of total motion at this cut-off level. If a bottom cut-off value is specified, the model will be restricted to that particular cut-off level for the project. However, in the 1D site response analysis, all clusters defined for the selected borehole will be considered.

Upon triggering the calculate button, the tool requests to configure the remote scripting server. The user is prompted to set a password and configure an available port. The script will extract all material models assigned for the borehole and all the displacement multipliers. In effect, the script will obtain all necessary data to recreate one borehole with all materials. The present model will be saved and closed. A new project will be automatically created for conducting the site response analysis. The new project is saved in a newly created subdirectory of the original project. The horizontal dimension of the model is chosen as 1 m. The vertical element size is critical for proper shear wave propagation which depends upon the minimum shear wave velocity in the soil layer defined and the higher frequency of interest. Mesh elements must be refined manually if the user expects especially low shear wave velocities or earthquake signals of a higher frequency of interest.

The soil column generated is a 2D plane strain model composed of 6-noded elements. Coordinates defined for the borehole are the same as that of the original model. The units are also copied from the original project. Soil layers, material models as well as the phreatic level are replicated from the original model. A prescribed line displacement is assigned at the base of the model, and an interface is created for assigning a compliant boundary condition. A dummy plate is assigned at the base of the model to retrieve the input signal after calculation. A medium mesh is generated with no local refinements. A K0 calculation will be performed followed by a plastic nil phase with default boundary conditions. For each input signal provided, a dynamic phase is created from the plastic nil phase (Figure 31 (on page 66)). Tied degrees of freedom are assigned for XMin and XMax boundaries, and a compliant base boundary condition is assigned for the base. Prescribed line displacements are set to 0.5 units for the base since only the upward propagating motion is considered for the compliant base. Dynamic calculation time depends upon the duration of the signal. The number of dynamic steps is determined based on the shortest time step available in the signal and the duration of the signal. The number of substeps is set to one and max-cores for dynamics calculation is also set to one to increase the efficiency in the case of multiple signals (they will run in parallel; each of them using a single core). Nodes are selected for every one meter of the soil column, and at the cut-off level, however, the results are extracted only for the midpoint of each soil cluster.

Before calculation, a pop-up window is displayed allowing the user to make manual modifications to the project. More information on ground response and liquefaction analysis in PLAXIS 2D can be found in Brinkgreve & Laera (2015) (on page 586). After the analysis, acceleration time histories are extracted for middle points of each cluster as well as at the cut-off level. They are stored with the file name in the following syntax - OriginalMultiplierNamedepth.txt as a text file. The extracted multipliers are total motions at a point and should not be interpreted as an upward propagating motion for a compliant base. The original input signal is also extracted at the base using a point selected at the dummy plate. All files are stored along with the project in the subfolder created inside the original project folder.
Finally, the original project is reopened with a pop-up window mentioning the location in which the project is saved. Now, the Edit displacement multipliers option may be used to import the generated multipliers at the cut-off level from the 1D site response analysis.

**Note:** The tool cannot distinguish between horizontal and vertical multipliers. It interprets multipliers as horizontal multipliers and conducts the analysis.

**Note:** For more information about Site response analysis in PLAXIS please visit Bentley Communities.
Modelling loads and structures - Structures mode

Geometric entities, structural elements and Soil boundary conditions are defined in the Structures mode. Click the Structures tab to switch to this mode. Boreholes cannot be modified in the Structures mode.

5.1 Assisting tools
The assisting tools enable modifying the geometry by changing the location of the object in the model or by creating higher objects with a higher dimension (from lines to surfaces or from surfaces to volumes).

5.1.1 Selecting geometry components

When the Selection tool is active, a geometry component may be selected by clicking once on that component in the geometry model. Multiple selection is possible by holding down the Shift key on the keyboard while selecting the desired components.

In addition to selecting geometry components one by one by using the Selection tool, several geometry components can be selected at once by using the Select multiple objects tool. A rectangle can be drawn in the drawing area by clicking on the first corner of the desired rectangle and moving the cursor while holding down the mouse button. After release of the mouse button, all visible geometry components in this rectangle will be selected.

The order in which the rectangle is created influences the selection type. When you select from left to right, it selects items completely within the box. When you select from right to left, it selects every item crossing the box boundaries.

It is also possible to select multiple geometry components of one type (for example points or lines) or multiple structural elements of one type (for example node-to-node anchors or plates) at once by selecting the desired sub-tool from the menu that appears when the Select rectangle button is clicked.

Note:
Right-clicking can be used to select entities in the model. After right-clicking an entity or a multiple selections of entities either in the drawing area or explorers, a menu appears displaying the name of the selection and different options depending on the selection. Clicking the name of the object in the menu copies it to clipboard. The copied name can be used in the command line (General information on command line (on page 45)).
5.1.2  Move object

A selection can be moved in the model. To move a selection:

- Select the objects to be relocated in the model (Selecting geometry components (on page 68))
- Click the Move object button and drag the selection to the new location.

5.1.3  Copy object - Array

Multiple copies of a selection, arranged in a rectangular or rotated pattern, can be created in the Structures mode.

- Select the source object(s) in the model. Multiple selections can be copied.
- Click the Create array button. Note that the Create array button is active only after the selection is made. The Create array window pops up where the pattern of the array can be defined.
- It is possible to choose a Rectangular or a Polar array pattern.
- For Rectangular array pattern, select the necessary option in the Shape drop-down menu. Enter the total number of rows (or columns) after copying and define accordingly the distances between adjoining copies.
- For Polar array pattern, select the necessary option in the Plane drop-down menu. Enter the coordinates for the center point, total number of items after copying, total angle over which the items are distributed equally and whether the objects are to be rotated.

![Create array window, Rectangular array pattern](image)
Note: Note that when Array is used to create copies, besides the geometry entity itself, the assigned features and properties are copied as well. Hence, it is advised to first assign the features and properties before copying geometric entities.

5.1.4 Check geometry

The Check geometry tool checks the adjacency between points, lines, and parametric objects. This check is performed based on:

1. A tolerance value defined as 0.005 times the diagonal of the model.
2. User-defined tolerance value, set through the command line.

If geometries are adjacent or overlap within the tolerance limit, the check geometry tool then returns the objects with the distance between them.

The Check geometry tool is available in the Structures and Mesh modes.

Note:

- The command for Check geometry can be used in all the modes.
- For more information on the PLAXIS command line please check General information on command line (on page 45).
- For information on specific PLAXIS Commands & Objects please go to the PLAXIS interface and select Help > Command Reference.
5.2 Geometric entities

The geometric entities are the basic components of the physical model. Features such as structures, loads etc., can be assigned to geometric entities or a geometric entity with a feature assigned to it can be created by selecting the corresponding option available in the expanded menu of the geometric entity. The created entities in the model are automatically named by the program. They can be renamed in the Object explorers.

![Figure 34: The expanded menus for Create geometric entities](image)

A geometric entity can be relocated by selecting it first using the Move tool in the toolbar or by changing the coordinates location can be changed in the Object explorers.

There are two options of deleting entities in the model. To delete a geometric entity and all the features assigned to it, right-click it and select the Delete option from the appearing menu. To delete only features assigned, right-click it, click on the feature you want to delete in the appearing menu and click Delete.

**Note:** Note that using the Delete key, deletes the geometric entity and all the features assigned to it.

5.2.1 Create point

One of the basic input items for the creation of a geometry is a point. To create a point click the Create point button in the side toolbar and then click at the location of the point. A Point load, Point prescribed displacement and Fixed-end anchor feature can be assigned to a point.
5.2.2 Create line

Another basic input item for the creation of a geometry is a line. To create a line click the Create line button in the side toolbar and then click at the location of the first and the second point of the line in the drawing area. Optionally, additional points may be created resulting in a chain of lines. After creating the last (end) point of the line, right-click or use the Esc key to stop drawing. When a line is created, its first and second points are also created.

A Distributed load, Prescribed displacement, Plate, Geogrid, Embedded beam row, Interface, Node-to-node anchor, Well, Drain and Groundwater flow boundary condition can be assigned to a line.

**Note:** A node-to-node anchor or an embedded beam row cannot be assigned to a line to which other features are assigned.

5.2.3 Create polygon

The Polygon feature can be used to create soil clusters in the Structures mode. The options available in the menu expanded when the Polygon button is clicked are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create soil polygon</td>
<td>To create a general polygon by specifying the points that define the polygon select the Create soil polygon option and click on the locations of the points in the drawing area.</td>
</tr>
<tr>
<td>Create soil rectangle</td>
<td>To quickly create rectangular soil clusters select the Create soil rectangle option and click on the points defining the diagonal of the rectangle or click on the first point, drag the rectangle while keeping the mouse button down and release the button of the appropriate point.</td>
</tr>
</tbody>
</table>
Follow contour

To create a polygon which sides are partly shared with the existing geometry select the *Follow contour* option and define the unshared boundary. The program will automatically consider the existing contour as the remaining boundary and a cluster will be created.

Cut polygon

To divide existing soil clusters into subclusters select the *Cut polygon* option and define the shared border of the subcluster in the drawing area.

Add polygon point

To add a point defining a soil polygon select the *Add polygon point* option and click on the location of the point in the drawing area. The program will update the geometry according to the new point configuration.

Delete polygon point

To delete a point defining a soil polygon select the *Delete polygon point* option and click on the point to be deleted in the drawing area. The program will update the geometry according to the new point configuration.

Move polygon point

To relocate a point defining a soil polygon select the *Move polygon point* option and drag the point to a new location. The program will update the geometry according to the new point configuration.

Move polygon line

To relocate a line defining a soil polygon select the *Move polygon line* option and drag the line to a new location. The program will update the geometry according to the new point/line configuration.

![Selection explorer](image)

*Figure 37: Polygons in the Selection explorer*

### 5.2.4 Advanced geometric modelling options

Advanced options for modifying geometric entities in the model are available in the menu appearing as the entity (or multiple entities) is (are) selected by right-clicking in the *Object explorer* or the drawing area.

**Note:** Multiple entities can be selected by keeping the *Ctrl* key pressed while clicking on the entities.

#### 5.2.4.1 Feature assignment to existing geometric entity

When the geometric entity is already available in the model (e.g. a line) it is advised to assign a feature to it (e.g. plate) without recreating the geometry in order to prevent the model from being unnecessarily large and complicated. An overview of the features assignable to geometric entities is given in *Table 2* (on page 74).
Table 2: Assignable features

<table>
<thead>
<tr>
<th>Loads</th>
<th>Point</th>
<th>Line</th>
<th>Polygon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prescribed displacement</td>
<td></td>
<td></td>
<td>Volume strain</td>
</tr>
</tbody>
</table>

Assignable structures and conditions

<table>
<thead>
<tr>
<th>Structure/Condition</th>
<th>Point</th>
<th>Line</th>
<th>Polygon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contraction</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plate</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Geogrid</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Embedded beam row</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interface (Positive/Negative)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node to node anchor</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Well</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drain</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Groundwater flow boundary condition</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thermal flow boundary condition</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To assign a feature to an existing geometric entity:

- Right click the geometric entity either in the Object explorer or in the drawing area.
- In the appearing menu select the option corresponding to the feature that is to be assigned.

**Note:**

- Note that Volume strain can be assigned to soil clusters only in the Phase definition modes.
- If an embedded beam row or a node-to-node anchor is assigned to a line in the model, no other features can be assigned to it.

### 5.2.4.2 Merge equivalent geometric objects

There are different options to create a feature:

- Using the buttons in the side toolbar.
- Assigning the feature to an existing geometric entity.
- Using the command line.

Consider the case when a geometric entity (e.g. a line) already exists in the model. If a node-to-node anchor is created at (nearly) the same position as the existing line, a new line will be added with the Node-to-node anchor feature. This means that, in principle, two lines will exist at that position; one with the Node-to-node anchor.
feature and one without. PLAXIS 2D allows for merging equivalent objects in order to remove unnecessary objects from the model. The way this works depends on which option has been selected to create the node-to-node anchor.

- If the above option 1 is used, the new line is automatically merged with the existing line into a single line having the Node-to-node anchor feature.
- If the above option 2 is used, no new line is created, and the Node-to-node anchor feature is directly assigned to the existing line.
- If the above option 3 is used, the existing line and the new line with the Node-to-node anchor feature will both exist in the Structures mode.

In the latter case it may be desired to already merge equivalent objects in the Structures mode (in order to manually remove unnecessary objects from the model). This can be done by right-clicking on Geometry, Points, Lines in the Model explorer and selecting Merge equivalent geometric objects from the appearing menu, or by using the corresponding command (see command reference), for example:

```
mergeequivalents geometry
```

The merge equivalent geometric objects command may also be used to merge objects that are not exactly located at the same position, but very close to each other. By default, the distance tolerance is 0.001 length units, equal to the standard snap distance (see below), but the user can include the distance tolerance in the command, for example:

```
mergeequivalents geometry 0.2
```

When similar geometric objects were created not exactly at the same position but less than 0.2 length units apart, they will be merged into a single object by this command. Any feature assigned to one of the original objects will be assigned to the remaining single object.

**Note:**

- Boreholes cannot be merged.
- If an embedded beam or a node-to-node anchor is assigned to a line in the model it cannot be merged to equivalent lines to which other features are assigned.

### 5.2.4.3 Snap

Drawing imperfections such as disconnected or overlapping geometric entities can lead to intersection or meshing difficulties. The Snap feature enables the correction of such imperfections in a range of 0.001 length units. The default value of snapping distance can be temporarily modified when snapping is performed using the corresponding command (see Command reference).

The Snap feature may be used in different ways:

- **When the Snap to grid option** (below the drawing area) is active, drawing of points is restricted to regular grid points. The grid spacing is generally large enough to avoid mispositioning of points and it also facilitates clicking on existing points.
- **When the Snap to grid option is inactive and the Snap to object option is active**, the drawing of points is not restricted to the grid points, but new points close to existing geometry entities will automatically be snapped to the existing objects, considering the defined snap distance. Since the snap distance is generally small, this allows for small distances between two separate points (or a point, a line or a polygon), and hence to the possibility that a point that is intended to be snapped to an existing geometric entity turns out to be a separate point.
• When both the *Snap to grid* and *Snap to object* options are NOT active, it is even more likely that two objects which are intended to coincide, are in fact separate.

• When both the *Snap to grid* and *Snap to object* options are active, new points will be snapped to the grid at intersections between grid and geometric entities, in other cases new points will be snapped to geometric entities.

Situations as described in 2 and 3 may be restored by using the *Snap* command in the command line with a larger value for the snap distance. For example:

```
snap geometry 0.1
snap lines 0.25
```

Points or lines that were supposed to coincide but turned out to be separate, may be merged by using the *Merge equivalent geometric objects* option (see above).

Another snapping option is available in the right mouse button menu enabling extension or trimming of lines. To utilise the feature:

• Multi-select the line and its end point that is to be extended.
• Add to the selection the extension target line (or trimming boundary line).
• Right-click and select the *Snap to object* option in the appearing menu. The geometry will be updated accordingly.

### 5.2.4.4 Combine

A multiple selection of geometric entities can be combined (merged/fused together) by selecting the corresponding option in the right-click mouse menu (RMB). The figure below displays two polygons before and after combining. After combining different entities into one new entity, the original entities do not exist anymore.

![Figure 38: Example of combination of surfaces](image)

**Note:** The material that will remain after the combination between entities will be determined by the material of the first geometric entity selected before the combine function is used.

### 5.2.4.5 Group

The *Group* option in the right mouse menu enables creating groups of entities in the model. The created group will be listed under the *Groups* subtree in the *Model explorer*. Grouping enables modification of the common properties of the group at the same time. After grouping different entities into a group, the original entities still exist. Utilisation of the *Group* feature is described in Chapter *Dry Excavation using a tie back wall of the 2D Tutorial Manual.*
5.3 Loads

Loads are features that can be assigned to geometric entities. Loads can be assigned to existing geometric entities by right-clicking the entity and selecting the corresponding option in the appearing menu.

A geometric entity can be created and a load can be assigned to it simultaneously using the options available in the menu displayed as the Create load button is selected in the side toolbar. This provides a faster definition of loads. Instead of creating the geometric entity and then assigning a load to it, the process is completed in one step. The process is similar to the creation of a geometric entity with the difference that the load is assigned to it as well.

![Create load menu](image)

*Figure 39: The Create load menu*

Although the input values of loads are specified in the Structures mode, the activation, deactivation or change of loads may be considered in the framework of Staged construction (Changing loads (on page 381)).

On a part of the geometry where both fixities and loads are applied and active, the fixities have priority over the loads during calculations. Hence, it is not useful to apply loads on a fixed geometric entity. However, it is possible to apply a load in the free direction if only one direction is fixed.

The Load subtree in the Object explorers consists of two parts where the static and the dynamic components of the load can be defined respectively.

1. Static load

   The distribution and the components of the static load are assigned in the first part of the Load subtree. Note that the Distribution option is not available for Point loads.

![Static point load](image)

*Figure 40: Static point load in the Object explorers*

2. Dynamic load [ULT]

   The distribution and the components of the dynamic load are assigned in the second part of the Load subtree. Note that the Distribution option is not available for Point loads. Besides the Distribution and the components of the load, Multipliers can be defined for each of the load components separately. One of the available multipliers defined in Attributes library (Definition of multipliers (on page 83)) can be selected from the drop-down menu. The view of the dynamic load in the Object explorers is given in figure below.
5.3.1 *Point load*

A point load can be created using the *Create point load* button. The input values of a point load are given in the unit of force per unit of width in the out-of-plane direction. The default value of point loads is one unit in negative. The x- and y-components of a point load as well as an optional bending moment can be defined or modified in the *Object explorers*. If a different magnitude value is assigned to the absolute load, the program calculates the individual components accordingly, assuming the initial load direction.

*Note:*

- Bending moments can only be applied to plates or embedded beam rows.
5.3.2 **Distributed load**

A distributed load can be created using the *Create distributed load* button. The input values of a distributed load is given in the unit of force per length per length of out-of-plane. The default value of a distributed load is one unit in negative y-direction. If a different magnitude value is assigned to the absolute load, the program calculates the individual components accordingly, assuming the initial load direction.

The distribution options for a line load are:

<table>
<thead>
<tr>
<th>Distribution</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Uniform</strong></td>
<td>To create a uniform line load.</td>
</tr>
<tr>
<td><strong>Linear</strong></td>
<td>A linearly varying distributed load is created by defining the components and the magnitude of the force at the start and at the end points of the line representing it.</td>
</tr>
<tr>
<td><strong>Perpendicular</strong></td>
<td>To create a uniformly distributed load perpendicular to the line.</td>
</tr>
<tr>
<td><strong>Perpendicular, vertical increment</strong></td>
<td>To create a load perpendicular to the line varying in the direction of gravity (-y) by defining the components and the magnitude of the load at the reference point and its increment in the negative y-direction.</td>
</tr>
</tbody>
</table>
5.4 Prescribed Displacements

Prescribed displacements are special conditions that can be imposed to the model to control the displacements at certain locations. Prescribed displacements can be assigned to existing geometric entities by right-clicking the entity and selecting the corresponding option in the appearing menu. To assign prescribed displacements to existing geometry entities:

- Select the button corresponding to the prescribed displacement from the menu appearing when the Create prescribed displacement button is selected.
- Drag the tool (keep the left mouse button down) and drop it on the geometric entity.

Although the input values of prescribed displacements are specified in the Structures mode, the activation, deactivation or change of values may be considered in the framework of Staged construction (Changing geometry configuration (on page 379)).

On a geometric entity where both prescribed displacements and loads are applied and active, the prescribed displacement has priority over the load during calculations. If both prescribed and fixed displacement are assigned to a line, the fixed displacement will be taken into consideration. However, when not all the displacement directions are fixed, it is possible to apply a load in the free directions.

**Note:** Prescribed displacements should be interpreted as specified total displacements at the end of the phase instead of additional (incremental) phase displacements. If no prescribed displacement increment should be applied in a phase, the value assigned to the prescribed displacement should be equal to the one in the previous phase. Assigning 0 to the value will implicitly apply an incremental prescribed displacement with the same value but in the opposite direction resulting in a zero displacement at the end of the phase.

The Prescribed displacement subtree in the Object explorers consists of two parts where the static and the dynamic components of the prescribed displacement can be defined respectively.

### 5.4.1 Static prescribed displacement

The distribution and the components of the static prescribed displacement are assigned in the first part of the Prescribed displacements subtree. Note that the Distribution option is not available for the Point prescribed displacements.

### 5.4.2 Dynamic prescribed displacement [ULT]

Dynamics Multipliers can be defined for each of the static prescribed displacement components, to apply the prescribed displacement as a function of (dynamics) time in a dynamics calculation. One of the available dynamics multipliers defined in Attributes library (Definition of multipliers (on page 83)) can be selected from...
the drop-down menu. The view of the dynamic prescribed displacement in the Object explorers is given in figure below.

![Image](image_url)

Figure 45: Dynamic prescribed displacement in the Object explorers

5.4.3 **Point prescribed displacement**

A point prescribed displacement can be created using the *Create point prescribed displacement* button. The input of point prescribed displacements in the geometry model is similar to the creation of points (on page 71). The default point prescribed displacement is free in x direction and it has a prescribed value of -1 unit in the y-direction. The options for the components of point prescribed displacements are *Free*, *Fixed* and *Prescribed*. These options can be selected and the displacement value can be defined if the *Prescribed* option is selected in the Object explorers. A rotational fixity can be assigned to a point by checking the corresponding box in the Object explorers.

5.4.4 **Distributed prescribed displacement**

In order to define prescribed displacements, the *Create distributed prescribed displacement* option should be selected from the menu appearing as the *Create prescribed displacement* button is clicked.

The default distributed prescribed displacement is free in x direction and it has a prescribed value of -1 in y-direction. The options for the components of line prescribed displacements are *Free*, *Fixed* and *Prescribed*. These options can be selected in the Model explorer. Either a uniform or a linearly varying prescribed displacement can be assigned to a line representing the distributed prescribed displacement. When the *Linear* option is selected in the Distribution drop-down menu, the displacement value at the start of the line (the first point) and at the end of the line (the second point) can be defined.

5.4.5 **Line contraction**

*Line contraction* can be used to simulate an area loss around a tunnel lining or to apply a contraction to a line in general. Contraction is specified as a strain without any unit associated.
The entered value of contraction is not always entirely applied, depending on the stiffness of the surrounding clusters and objects. The specified $C_{ref}$ is applied gradually during the calculation phase (via $\Sigma M_{stage}$) as a shrinkage strain. In principle, the shrinkage strain does not cause any stress changes by itself. However, due to any surrounding restraints, the applied strain may not be equal to the input contraction, resulting in stress variation.

In order to define a contraction option should be selected from the menu appearing when the Create prescribed displacement icon is clicked in the side toolbar. Line contraction may also be defined directly in the Tunnel designer.

Line contraction should be interpreted as specified total contraction at the end of the phase instead of additional (incremental) phase contraction. If no contraction increment should be applied in a phase, the value assigned to the contraction should be equal to the one in the previous phase. If a contraction was already applied in the previous phase, assigning 0 to the value will implicitly apply a contraction with the same value but in the opposite direction resulting in a zero contraction at the end of the current phase.

Note:
- For tunnels, the applied contraction is equal to the tunnel contraction to simulate small volume loss (≈3% volume contraction).
- When contraction is used to simulate the area loss around a tunnel, the value of contraction to be applied is equal to the area loss as a percentage of the tunnel area.
- In geogrid elements, a negative contraction can be used to simulate thermal expansion.

5.5 Dynamic loading [ULT]

In PLAXIS 2D, a dynamic load is specified by means of an input value and a multiplier. The actual dynamic load value at each time step equals to the input value times the multiplier. Dynamics multipliers can be assigned to the dynamics component of a load (Loads (on page 77)) or to a prescribed displacement (Prescribed Displacements (on page 79)). The dynamics multipliers to be applied in the model can be defined in the Dynamics multipliers subtree under the Attributes library in the Model explorer.

![Figure 46: Dynamics multipliers branch in the Model explorer](image)
5.5.1 Definition of multipliers

The multipliers can be defined in the Multipliers window that pops up when the Dynamics multipliers subtree under the Attributes library in the Model explorer is right-clicked and the Edit... option is selected in the appearing menu. The window consists of two tabsheets, i.e Displacement multipliers and Load multipliers where the multipliers applicable to the prescribed displacements and to the loads can be defined respectively.

The buttons available under the multipliers tabs can be used to add new multipliers or to delete the selected multiplier in the list. When a new multiplier is added, the options to define it are displayed.

<table>
<thead>
<tr>
<th>Name</th>
<th>The name of the multiplier can be defined.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>The type of the signal can be assigned. The options available are Harmonic and Table. More information on definition of a harmonic multiplier and definition of the multipliers in a table is given in Harmonic signal (on page 83) and Signal from table (on page 84) respectively.</td>
</tr>
<tr>
<td>Type</td>
<td>The options Displacements, Velocities and Accelerations are available. Note that the Type drop-down menu is available only for displacement multipliers. For Load multipliers the type does not need to be specified.</td>
</tr>
<tr>
<td>Drift correction</td>
<td>It is used to correct the displacement drift. Due to the integration of the accelerations and velocities, a drift might occur in the displacements. When selected, the displacement drift is corrected by applying a low frequency motion from the beginning of the calculation and by correcting the acceleration accordingly.</td>
</tr>
</tbody>
</table>

**Note:**
For a correct drift correction, the phase time interval should be the same as the input signal's time interval, otherwise the integration of the accelerations and velocities with the drift correction will not give a correct drift correction at the end of the phase.

5.5.2 Harmonic signal

In PLAXIS 2D harmonic loads are defined as:

\[ F = \hat{M} \hat{F} \sin (\omega t + \phi_0) \quad \text{Eq. [2]} \]

in which:

\( \hat{M} \): Amplitude multiplier

\( \hat{F} \): Input value of the load

\( \omega \): \( 2\pi f \) with \( f \) Frequency in Hz

\( \phi_0 \): Initial phase angle in degrees

(\( \hat{M} \hat{F} \) is the amplitude of the dynamic load).
**Note:** A dynamic load can also suddenly be applied in a single time step or sub step (block load). In case of a *Harmonic load multiplier*, a block load can be modelled by setting the *Amplitude multiplier* equal to the magnitude of the block load, the *Frequency* to 0 Hz and *Initial phase angle* to 90° giving the relation \( F = M \hat{F} \). In case of a *Load multiplier from data file*, a block load can directly be defined.

Figure below shows the **Multipliers** window where a *Harmonic* signal is defined and plotted.

![Multipliers window](image)

*Figure 47: Definition and display of a Harmonic signal in the **Dynamics multipliers** window*

### 5.5.3 Signal from table

Besides a harmonic signal there is also the possibility to define a signal by specifying the values in the table that appears when the corresponding option is selected in the *Signal* drop-down menu. It is possible to choose *Displacements*, *Velocities* or *Accelerations* from a drop down menu for the *Data type* of a signal. If *Accelerations* are chosen as the data type then the signal can be transformed using *Scaling type* options. For more information refer **Input accelerograms** (on page 87). The table consists of *Time* and *Multiplier* columns where *Time* relates to the *Dynamic time* in the project. The buttons in the toolbar can be used to modify the table.

- ![Add row](image) Click the *Add row* button in the toolbar to add a new row in the table.
- ![Insert](image) Click the *Insert* button to insert a new row before the selected row in the table.
- ![Delete](image) Click the *Delete* button to delete the selected row in the table.

The values can be defined by clicking the cell in the table and by typing the value.
5.5.3.1 Importing data for signals

Besides defining the signal in the table, there is also the possibility to read data from a file with a digitised load signal using the Open button in the toolbar. PLAXIS enables reading data from files in plain ASCII or in SMC format.

**Note:** PLAXIS assumes the data file is located in the current project directory when no directory is specified in the Dynamic loading window.

A signal, either defined in a table or received from a file and modified, can be saved using the Save button in the toolbar enabling the usage of the signal in other projects or validating the effect of the modifications in the current project.

A signal, either defined in a table or received from a file and modified, can be copied using the Copy button in the toolbar.

Copied data from other applications (using Ctrl+c) can be imported by using the Paste button. The Import data window appears as shown below. The starting row of the data to be imported can be defined in the From row cell. The data can be parsed as Plain text files or Strong motion CD-ROM files (SMC). The data and the plot is displayed in the Dynamic multipliers window after pressing OK.
ASCII file

An ASCII file can be created by the user with any text editor. In every line a pair of values (Dynamic time and corresponding multiplier) is defined, leaving at least one space between them. The time should increase in each new line. It is not necessary to use constant time intervals.

If the time steps in the dynamics analysis are such that they do not correspond with the time series given in the file, the multipliers at a given (Dynamic) time will be linearly interpolated from the data in the file. If the Dynamic time in the calculation is beyond the last time value in the file a constant value, equal to the last multiplier in the file, will be used in the calculations.

SMC file

In addition, it is possible to use earthquake records in SMC-format as input for earthquake loading. The SMC (Strong Motion CD-ROM) format is currently used by the U.S. Geological Survey National Strong-motion Program to record data of earthquakes and other strong vibrations. This format uses ASCII character codes and provides text headers, integer headers, real headers, and comments followed by either digitised time-series coordinates or response values. The header information is designed to provide the user with information about the earthquake and the recording instrument.

Most of the SMC files contain accelerations, but they may also contain velocity or displacement series and response spectra. It is strongly recommended to use corrected earthquake data records, i.e. time series, that are corrected for final drift and non-zero final velocities. SMC files should be used in combination with prescribed boundary displacements at the bottom of a geometry model.

The strong motion data are collected by the U.S. Geological Survey and are available from the National Geophysical Data Center (NGDC) of the National Oceanic and Atmospheric Administration. Information on NGDC products is available on the World-wide Web at http://www.ngdc.noaa.gov/hazard.
Note: The time value in dynamic multipliers always refers to the global dynamic time (in seconds) in the whole list of calculation phases, rather than to the time interval of an individual phase. This means that in series of continuing dynamics calculation phases each phase will only use its consecutive part of the dynamic multiplier.

5.5.4 Input accelerograms

If a signal has the data type as Accelerations, it is possible to scale the input accelerogram using the following options from the drop-down menu:

![Import data window for dynamic multipliers](image)

**Figure 50: Import data window for dynamic multipliers**

Note: Note that if the model is created using the Command line, the user must make sure to transform the multiplier, otherwise the transformed multiplier values will not be taken into account during calculation.

<table>
<thead>
<tr>
<th>Scaling factor</th>
<th>The input multipliers can be transformed by specifying a value. Click to get the newly transformed multipliers.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum multiplier</td>
<td>A desired maximum value of the multiplier can be specified. Click to get the newly transformed multipliers. The scaling factor is calculated as the ratio between the desired maximum value and the maximum value of the multiplier (in absolute value). All the multipliers are then multiplied by this resulting scaling factor.</td>
</tr>
</tbody>
</table>

A user should click on the Transform* button as shown below, after modifying a value for either the Scaling factor or Maximum multiplier. PLAXIS then computes the transformed multiplier, and a new column is generated Transformed multiplier.
In the table, the column *Transformed multiplier* contains the transformed multiplier values. If the table is modified, the multiplier should be transformed again, as the transformation is not updated automatically. The asterisk * after *Transform* indicates that the table was modified after the last transformation action.

**Note:** Note that the *Transformed* multiplier only contains the values obtained by applying the scaling factor and not the drift correction.

When the input data type is Accelerations, the signal can be viewed as Accelerations, Velocities or Displacements, by selecting the corresponding option in the drop-down list below the graph. The input accelerogram signal can be visualised in the lower panel in different representative charts: *Fourier spectra*, *Response spectra* and *Arias intensity*. The original multiplier is displayed in grey, and the transformed multiplier is displayed in blue. Both the original multiplier in grey and transformed multiplier in blue are displayed in the *Signal* tab.

**Fourier spectra**

In this tab, the input multiplier can be visualised as a *Fourier* amplitude spectrum (default) or a power spectrum using the drop-down menu. The spectra are created using the transformation in *Hz*, starting from the time - acceleration multiplier.
Response spectra

In this tab, the input multiplier can be visualised as a PSA (default) and Relative displacement response spectrum. More information is available in section PSA spectrum on page 481.

It is possible to set these parameters while using this tab:

- **Damping ratio** is expressed in %, has a default value of 5.000 % and a range of [0, 100].
- **Max. period** is expressed in s, has a default value of 10.00 s and a range of [0.1, 1000].

The signal can be viewed with a logarithmic x-axis by clicking on the check box.
Figure 53: Response spectra for input accelerograms

**Arias intensity**

In this tab, the Arias intensity of the input multiplier can be visualized. More information is available in [Arias intensity](on page 488).

It is possible to view it in percentage by clicking on the check box *Show Arias intensity in percentage.*
5.5.5 Added mass

**Note:**

⚠️ This feature is provided as a Technology Preview.

If a project contains a large body of water, for instance a reservoir or a lake, this body of water may also be subjected to the dynamic load. The movement of the body of water due to the dynamic load may then by itself cause a hydrodynamic load on the soil surface. A good example of this is the behaviour of a dam under a seismic load, where the earthquake will cause the water in the reservoir to move. As a consequence, the water pressure of the reservoir acting on the dam will no longer be hydrostatic, but hydrodynamic as shown in Figure 55 (on page 92).
There are two possibilities in PLAXIS to model a body of water that can be subjected to seismic loads:

1. Model the body of water using finite elements and assign a constitutive (soil) model representing the water. In PLAXIS a special Fluid model is available to do so.
2. Model the effect of the body of water using a special Added mass boundary condition on the boundary between soil and water. The Added mass boundary condition used in PLAXIS is the so-called Zangar formulation, which is an improvement of the well-known Westergaard added mass formulation.

The Added mass boundary condition can be found under the Line option in the side bar (see Figure 56 on page 93). By selecting the option an Added mass boundary can be drawn where needed. The boundary allows for the use of added mass on either side of the line where it is applied. In order to distinguish on which of the line the mass is applied one side of the line is indicated as the "negative" side and the other side as the "positive" side similar to the naming as used for interface elements.
Both sides of the added mass conditions can be activated and deactivated independently. However, the added mass is only taken into account if no soil is present on the activated side of the boundary condition. Additionally, the bottom level of the water body must be specified. This bottom level is called the Water Base Level (WBL) and it is the y-coordinate of the lower level of the water to be taken into account for added mass. So in short, all water in between the WBL and the phreatic level is taken into account as added mass. Typically the WBL is chosen as the bottom of the reservoir or lake.

The figure below shows the simple geometry of a dam with the applied Added mass boundary on the left boundary. In the box on the right of the geometry the settings for the Added mass boundary are shown as can be seen in for instance the Selection explorer. The figure shows that the negative side, which is the reservoir side, is activated whereas the positive side, the soil side, is deactivated. As the bottom of the dam and thus the bottom of the lake is situated at y=10m the WBL specified is 10m.
5.6 Structural elements

The creation of a structure is similar to the creation of the corresponding geometric entities. To create structures:

- Select the button corresponding to the structure from the menu appearing when the Create structure button is selected.
- Define the structure in the same way the corresponding geometric entity is defined.

Note that the assignment of structures to existing geometric entities is possible by right-clicking the geometric entity either in the drawing area or in the Object explorers, pointing on Create and selecting the corresponding option in the appearing menu. Assignment of materials to structures is described in Assigning material data sets to geometry components (on page 307).

Structures can be activated, de-activated or the assigned material data sets can be modified in calculation phases.
5.6.1 Fixed-end anchors

A fixed-end anchor is a point element that is attached to a structure at one side and fixed 'to the world' at the other side. Fixed-end anchors can be used to simulate piles in a simplified way, i.e. without taking into account pile-soil interaction. Alternatively, fixed-end anchors can be used to simulate anchors or props to support retaining walls. A fixed-end anchor is visualised as a rotated T ( ─│ ). The length of the plotted T is arbitrary and does not have any particular physical meaning.

The creation of a fixed-end anchor is similar to the creation of a geometry point (Create point (on page 71)). By default, a fixed-end anchor is pointing in the positive x-direction, i.e. the angle in the xy-plane is zero. The user may enter the fixed-end anchor direction by specifying the individual x- and y-components. The length defined by the individual components is defined as the equivalent length of the fixed-end anchor.

The Equivalent length parameter of a fixed-end anchor is defined as the distance between the anchor connection point and the fictitious point in the longitudinal direction of the anchor where the displacement is assumed to be zero. For example: In the case of a symmetric excavation that is supported by a propped retaining wall, a fixed-end anchor may be used to stimulate the prop. In this case, the equivalent length of the fixed-end anchor is half the excavation width. The direction and equivalent length of a fixed-end anchor may be changed in the Object explorers. Changing the equivalent length will change the individual direction components while retaining the anchor direction.

Only one fixed-end anchor can be created at a single geometry point, which means that this point can only be supported in one direction. In the case that more support directions in a single point are required, the following options exist:

- If the point is to be supported in both horizontal and vertical direction, a fixed-end anchor (spring support) can be used in one direction whereas a point fixity can be applied at the same point to fix the other direction (while the anchor direction is set free). Disadvantage of this solution is that the anchor features (spring support, pre-stressing, resulting force, etc.) are not available for a point fixity.
- If the point is to be supported in two arbitrary directions, a node-to-node anchor may be used instead of a second fixed-end anchor, provided that the node-to-node anchor is at the other node connected to a model boundary that is fixed in the anchor direction. This may not necessarily lead to the right equivalent anchor length. Hence, the anchor stiffness $EA$ needs to be adjusted such that the ratio $EA/L$ gives the required value.

Example (see Figure 59 (on page 96)): The basement corner is to be supported by spring supports in x- and y-direction, considering fixed-end anchors, both with an equivalent length of 2m. Since only one fixed-end anchor can be used for a single geometry point, the vertical support is modelled by means of a node-to-node anchor that is connected to the bottom of the model (which is fully fixed). However, the length of the node-to-node anchor is 4m in this case, which is twice as large as the desired equivalent length of 2m. That means that a new anchor material data set needs to be created for the node-to-node anchor in which the anchor stiffness $EA$ is increased by a factor 2 in order to have the same $EA/L$ as for the fixed-end anchor.
Anchor material properties

The material properties of fixed-end anchors are contained in Anchors material data sets (Material data sets for anchors (on page 303)) and can be conveniently assigned using drag-and-drop, the Object explorers or the right hand mouse button menu in the drawing area (Assigning material data sets to geometry components (on page 307)).

5.6.2 Node-to-node anchors

A node-to-node anchor is a two-node elastic spring element with a constant spring stiffness (axial stiffness). This element can be subjected to tensile forces (for anchors) as well as compressive forces (for struts). Both the tensile force and the compressive force can be limited to allow for the simulation of anchor or strut failure. Optionally, a residual maximum force can be specified.

The creation of a node-to-node anchor is similar to the creation of a geometry line (Create line (on page 72)). Since a node-to-node anchor is a line-based entity rather than a point-based entity, different node-to-node anchors can be connected to the same geometry point, provided that they do not fully coincide.

Anchor material properties

The material properties of node-to-node anchors are contained in Anchors material data sets and can be conveniently assigned using drag-and-drop, using the Object explorers or the right hand mouse button menu in the drawing area (Assigning material data sets to geometry components (on page 307)).

Note: A node-to-node anchor cannot be assigned to a line to which other features are assigned.
5.6.3 Embedded Beams

An embedded beam is a structural element that can be utilised to model a row of long slender structural members (such as piles, rock bolts and grout bodies) used to transmit loads to the surrounding soil or rock by means of special interface elements. The interaction may involve a skin resistance as well as a foot resistance. The skin friction and the tip force are determined by the relative displacement between the soil and the embedded beam.

Since the stress state and deformation pattern around piles, rock bolts and ground anchors is fully three-dimensional, it is impossible to model such structures realistically in a 2D model. Hence, the 2D embedded beam element is only a simplified approach to deal with a row of piles, rock bolts or ground anchors in the out-of-plane direction in a 2D plane strain model.

The information required for an embedded beam consists of the properties of a single pile or rock bolt or grout body and their spacing in the out-of-plane direction.

**Note:**

The embedded beams are suitable for pile types that cause a limited disturbance of the surrounding soil during installation. This may include some types of bored piles (e.g. displacement screw piles), but not most of the technologies for replacement piles or displacement piles. The installation effect has a significant influence on the soil stress ratio \( k_0 \) and the pile skin resistance \( T_{\text{skin}} \). In such a case, it is necessary to properly evaluate these factors in order to simulate the pile installation effect.

5.6.3.1 Embedded beam element

The idea behind the 2D embedded beam is that the pile (or rock bolt or grout body of a ground anchor), represented by a Mindlin beam element, is not 'in' the 2D mesh, but superimposed 'on' the mesh, while the underlying element mesh of the soil or rock is continuous (Figure 60 (on page 98), after Sluis [2012] (on page 588)). A special out-of-plane interface connects the beam with the underlying soil/rock elements. The beam is supposed to represent the movement of an out-of-plane row of individual piles or rock bolts or grout bodies, whereas displacements of the soil or rock elements are supposed to represent the 'average' soil/rock displacement in the out-of-plane direction. The interface stiffness should be chosen such that it accounts for the difference between the (average) soil/rock displacement and the pile/rock bolt/grout body displacement while transferring loads from the structures onto the soil/rock and vice versa. This requires at least the out-of-plane spacing of the structures to be taken into account in relation to their diameter. In the case of rock bolts, the interface should also account for the 'smearing' of the grout material connecting the rock bolt to the surrounding rock.
Embedded beams in the 2D finite element model are composed of line elements with three degrees of freedom per node: two translational degrees of freedom \( (u_x, u_y) \) and one rotational degree of freedom (rotation in the \( x\)-\( y \) plane: \( \phi_z \)). These elements are similar as plate elements. When 6-node soil elements are employed then each embedded beam element is defined by three nodes whereas 5-node embedded beam elements are used together with the 15-node soil elements (Figure 63 (on page 103)). The elements are based on Mindlin’s beam theory (Bathe, 1982 (on page 586)). This theory allows for deflections due to shearing as well as bending. In addition, the element can change length when an axial force is applied. Figure 63 (on page 103) shows a single 3-node and 5-node embedded beam element with an indication of the nodes and stress points.

Bending moments and axial forces are evaluated from the stresses at the stress points. A 3-node embedded beam element contains two pairs of Gaussian stress points whereas a 5-node embedded beam element contains four pairs of stress points. Within each pair, stress points are located at a distance \( \frac{1}{6\sqrt{3}d_{eq}} \) above and below the embedded beam centre-line.

The interaction between the pile or rock bolt and the surrounding soil or rock may involve a skin resistance as well as a foot resistance. Therefore, special out-of-plane interface elements (line-to-line interface along the shaft and point-to-point interface at the base) are used to connect the beam elements to the surrounding soil or rock elements. The interface elements involve springs in the longitudinal and transverse direction and a slider in the longitudinal direction.
Structural forces are evaluated at the embedded beam element integration points and extrapolated to the element nodes. These forces can be viewed graphically and tabulated in the Output program. Details about the embedded beam element formulations are given in the Material Models Manual.

5.6.3.2 Embedded beam creation

The creation of embedded beam in the geometry model is similar to the creation of a line (Create line (on page 72)). Note that one row in out-of-plane direction is indicated by one line in the model. When creating embedded beams, the corresponding geometry line is created simultaneously. Hence it is not necessary to create first a line at the position of a row of embedded beams. It is also not necessary to create interface elements around the embedded beam, since special interface elements are automatically created with the embedded beam elements.

A embedded beam can be created in the Input program inside the Structures mode using one of the following approaches:

1. **Using the side tool bar:**
   - On the side toolbar go to the icon option Create line > Create embedded beam.
   - On the side toolbar go to the icon option Create Structure > Create embedded beam.

2. **Using a line element:**
   - On the drawing area create a line, then on this new element Right-click and from the popup menu select Create > Create embedded beam.

5.6.3.3 Embedded beam behaviour

The behaviour options available for Embedded beam are:
### Behaviour and Description

<table>
<thead>
<tr>
<th>Behaviour</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pile</td>
<td>The <em>Embedded beam</em> is set to <em>Pile</em>.</td>
</tr>
<tr>
<td>Rock bolt</td>
<td>The <em>Embedded beam</em> is set to <em>Rock bolt</em>.</td>
</tr>
<tr>
<td>Grout body</td>
<td>The <em>Embedded beam</em> is set to <em>Grout body</em>.</td>
</tr>
</tbody>
</table>

Depending on the *Embedded beam* behaviour *Pile* and *Rock bolts*, the connection point may be indicated as:

<table>
<thead>
<tr>
<th>Connection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top/Bottom</td>
<td>In the case that the <em>Embedded beam</em> is a <em>Pile</em>, the connection point from</td>
</tr>
<tr>
<td></td>
<td>the drop-down menu can be specified in the <em>Selection explorer</em> as Top or</td>
</tr>
<tr>
<td></td>
<td>Bottom. Top refers to the point on the embedded beam that has the highest</td>
</tr>
<tr>
<td></td>
<td>y-coordinate in the model. In the rare case of an exactly horizontal</td>
</tr>
<tr>
<td></td>
<td>embedded beam defined as a <em>Pile</em>, Top refers to the point on the embedded</td>
</tr>
<tr>
<td></td>
<td>beam that has the lowest x-coordinate in the model.</td>
</tr>
<tr>
<td>First/Second</td>
<td>In the case that the <em>Embedded beam</em> is a <em>Rock bolt</em>, the connection point</td>
</tr>
<tr>
<td></td>
<td>from the drop-down menu can be specified in the <em>Selection explorer</em> as</td>
</tr>
<tr>
<td></td>
<td><em>First</em> or <em>Second</em>. First refers to the first point of the corresponding</td>
</tr>
<tr>
<td></td>
<td>geometry line, as listed in the <em>Selection explorer</em> when the embedded</td>
</tr>
<tr>
<td></td>
<td>beam is selected (typically the point on a tunnel contour), whereas second</td>
</tr>
<tr>
<td></td>
<td>refers to the second point of the corresponding geometry line (typically the</td>
</tr>
<tr>
<td></td>
<td>point somewhere in the surrounding rock).</td>
</tr>
</tbody>
</table>

For the first and second types of embedded beams, the connection options available are:

<table>
<thead>
<tr>
<th>Connection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rigid</td>
<td>The displacement and rotation at the beam top are both coupled with the</td>
</tr>
<tr>
<td></td>
<td>displacement and rotation of the element in which the beam connection point</td>
</tr>
<tr>
<td></td>
<td>is located, provided that this element has rotational degrees of freedom.</td>
</tr>
<tr>
<td></td>
<td>This option only applies if the beam connection point coincides with plates</td>
</tr>
<tr>
<td></td>
<td>elements.</td>
</tr>
<tr>
<td>Hinged</td>
<td>The displacement at the connection point of the beam is directly coupled</td>
</tr>
<tr>
<td></td>
<td>with the displacement of the element in which the connection point is</td>
</tr>
<tr>
<td></td>
<td>located, which means that they undergo exactly the same displacement, but</td>
</tr>
<tr>
<td></td>
<td>not necessarily in the same rotation.</td>
</tr>
<tr>
<td>Free</td>
<td>The connection point of the beam is not directly coupled with the soil</td>
</tr>
<tr>
<td></td>
<td>element in which the beam top is located, but the interaction through the</td>
</tr>
<tr>
<td></td>
<td>interface elements is still present. When a node-to-node anchor ends at the</td>
</tr>
<tr>
<td></td>
<td>same geometry point, this structural node is automatically connected to</td>
</tr>
<tr>
<td></td>
<td>the embedded beam connection point, but it will be separate from the</td>
</tr>
<tr>
<td></td>
<td>corresponding soil node.</td>
</tr>
</tbody>
</table>

**Note:** When embedded beams are located in a polygon cluster with linear elastic material behaviour, the specified values of the shaft resistance and spacing are ignored. The reason for this is that the linear elastic material is not considered to be soil, but part of the structure. The connection between the beam and the structure is supposed to be rigid to avoid, for example, punching of piles through a concrete deck.
To ensure a rigid behaviour between an embedded beam and a polygon cluster structure, the beam could be elongated into the structure for a certain length. To avoid mesh-dependent results for the internal forces of the embedded beam (linked to the elongation length), the user could insert an elastic plate at the polygon cluster side where the connection with the row of embedded beams take place. The beam can be now linked to the plate without elongating it in the cluster structure.

- When an embedded beams and a structure are both active and share the same geometry point, the node created at the connection point of the embedded beam is by default rigidly connected to the structure node. However, if the structure is not active, the embedded beam node is by default connected (hinged) to the soil node at that location.
- Note that when an interface is available, the embedded beam is NOT connected to the interface but to the structure or soil node at that location.
- It is possible to 'chain' embedded beams, which also enables connection to other structural elements (such as a node-to-node anchor) in the connection point.

When an anchor is present in the model at the position of the embedded beam connection point, the user can select the option *Grout body* for the behaviour of embedded beams. At the position of an embedded beam connection point, the anchor point will be automatically connected to the embedded beam connection point and not to the corresponding node in the soil element. The connection type is intrinsically set to *Free* (i.e. free from the surrounding soil polygon).

The material properties of embedded beam are contained in material data sets (*General properties* on page 288). Embedded beams can be activated or de-activated in calculation phases using *Staged construction* as *Loading input*.

### 5.6.3.4 Embedded beam properties

The material properties of embedded beams are contained in *Embedded beam* material data sets (*General properties* on page 288). In the material dataset geometric features of the pile/rock bolt, material properties, spacing of the piles/rock bolts in the out-of-plane direction, skin friction and bearing capacity of the pile/rock bolt as well as the interface stiffness factor can be defined.

### 5.6.4 Plates

Plates which are actually beam elements, are structural objects used to model slender structures in the ground with a significant bending stiffness and an axial stiffness. Plates can be used to simulate the influence of walls, plates, shells or linings extending in z-direction. Examples of geotechnical structures involving plates are shown in Figure 62 (on page 101).
Plates can be selected by clicking on the corresponding button in the side toolbar. The creation of plates in the geometry model is similar to the creation of geometry lines (Create line (on page 72)). When creating plates, the corresponding geometry lines are created simultaneously. Hence, it is not necessary to create first a geometry line at the position of a plate.

The material properties of plates are contained in material data sets (Modelling undrained behaviour (on page 267)). The most important parameters are the bending stiffness $EI$ and the axial stiffness $EA$.

From these two parameters an equivalent plate thickness $d_{eq}$ is calculated from the equation:

$$d_{eq} = \sqrt[3]{\frac{12EI}{EA}}$$

Plates can be activated or de-activated in calculation phases using Staged construction as Loading input.

**Note:** The connection between two connecting plates can be specified using the Create connection feature (Connections (on page 118))

### 5.6.4.1 Plate elements

Plates in the 2D finite element model are composed of beam elements (line elements) with three degrees of freedom per node: two translational degrees of freedom ($u_x$, $u_y$) and one rotational degree of freedom (rotation in the $x$-$y$ plane: $\phi_z$). When 6-node soil elements are employed then each beam element is defined by three nodes whereas 5-node beam elements are used together with the 15-node soil elements (Figure 63 (on page 103)). The beam elements are based on Mindlin's beam theory (Bathe, 1982 (on page 586)). This theory allows for beam deflections due to shearing as well as bending. In addition, the element can change length when an axial force is applied. Beam elements can become plastic if a prescribed maximum bending moment or maximum axial force is reached.

Bending moments and axial forces are evaluated from the stresses at the stress points and extrapolated to the element nodes. A 3-node plate element contains two pairs of Gaussian stress points whereas a 5-node plate element contains four pairs of stress points. Within each pair, stress points are located at a distance $\frac{1}{6}\sqrt{3}d_{eq}$ above and below the plate centre-line.

**Figure 63** (on page 103) shows a single 3-node and 5-node plate element with an indication of the nodes and stress points.
It is important to note that a change in the ratio $EI/EA$ will change the equivalent thickness $d_{eq}$ and thus the distance separating the stress points. If this is done when existing forces are present in the plate element, it would change the distribution of bending moments, which is unacceptable. For this reason, if material properties of a plate are changed during an analysis (for example in the framework of Staged Construction) it should be noted that the ratio $EI / EA$ must remain unchanged.

### 5.6.4.2 Plate properties

The material properties of plates are contained in *Plates* material data sets ([General properties](on page 277)) and can be conveniently assigned using drag-and-drop, the *Object explorers* or the right hand mouse button menu in the drawing area ([Assigning material data sets to geometry components](on page 307)).

Structural forces are evaluated at the plate element integration points ([Scientific Manual](on page 307)) and extrapolated to the element nodes. These forces can be viewed graphically and tabulated in the Output program. Details about the material properties are given in the [Material Models Manual - Structural behaviour - 2D Plates](Material Models Manual - Structural behaviour - 2D Plates).

### 5.6.5 Geogrids

Geogrids are slender structures with an axial stiffness but with no bending stiffness. Geogrids can only sustain tensile forces and no compression. These objects are generally used to model soil reinforcements. Examples of geotechnical structures involving geotextiles are presented in [Figure 64](on page 104) (on page 104).
In a geometry model geogrids without assigned material properties appear as 'light yellow lines', whereas geogrids with assigned properties appear in their material colour. When creating geogrids, corresponding geometry lines are created simultaneously. The only material property of a geogrid is an elastic axial stiffness $EA$, which can be specified in the material data base (General properties (on page 282)). Geogrids can be erased by selecting them in the geometry and pressing the Delete key. Geogrids can be activated or de-activated in calculation phases using Staged construction as Loading input.

5.6.5.1 Geogrid elements

Geogrids are composed of geogrid elements (line elements) with two translational degrees of freedom in each node $(u_x, u_y)$. When 15-node soil elements are employed then each geogrid element is defined by five nodes whereas 3-node geogrid elements are used in combination with 6-node soil elements. Axial forces are evaluated at the Newton-Cotes stress points. These stress points coincide with the nodes. The locations of the nodes and stress points in geogrid elements are indicated in Figure 65 (on page 104).

5.6.5.2 Geogrid elements

The basic material parameter is the axial stiffness $EA$. In addition the tension force can be limited to allow for the simulation of tension failure. Axial forces can be viewed graphically and tabulated in the Output program. Details about the material properties are given in General properties (on page 282) and Reference Manual.

When using geogrid elements in PLAXIS 2D for modelling of true geogrids, note that most such applications require the use of updated mesh calculations to take membrane effects into account. Most applications also require the use of anisotropic properties to avoid unrealistic shear deformations.

5.6.6 Interfaces

Interfaces are joint elements to be added to plates or geogrids to allow for a proper modelling of soil-structure interaction. Interfaces may be used to simulate, for example, the thin zone of intensely shearing material at the contact between a plate and the surrounding soil. Interfaces can be created next to plate or geogrid elements or between two soil polygons.
An interface can be created using the Create interface option available in the menu displayed when the Create structure button in the side toolbar is clicked. The creation of an interface is similar to the creation of a line (Create line (on page 72)). In this case a line with an interface assigned to it will be created. When the geometric entity (line) is already available in the model it is advised to assign an interface to it without recreating the geometry in order to prevent the model from being unnecessarily large and unwieldy. Assignment of features to existing geometric entities is described in Advanced geometric modelling options (on page 73).

The interface appears as a line at the side of the geometry line the interaction with the soil takes place. The side at which the interface will appear is also indicated by the arrow in the cursor pointing in the direction of drawing. To place an interface at the other side, it should be drawn in the opposite direction. Note that interfaces can be placed at both sides of a geometry line. This enables a full interaction between structural objects (walls, plates, geogrids, etc.) and the surrounding soil. To be able to distinguish between the two possible interfaces along a geometry line, the interfaces are indicated by a plus-sign (+) or a minus sign (-).

**Note:** The sign of an interface is only used to enable distinguishing interfaces at either side of a line, but it does not affect its behaviour.

Interfaces can be activated or de-activated in calculation phases using Staged construction as Loading input.

[ULT] Note that interfaces should be created at the boundaries of the model if Free-field or Compliant base boundary conditions are to be used in a Dynamic calculation. To create interfaces at the boundaries of the model click the corresponding button in the side toolbar. The interfaces are automatically created.

### 5.6.6.1 Interface properties

The interfaces created in the model are listed in the Interfaces subtree in the Object explorers. Properties such as Material mode, permeability condition and Virtual thickness factor, available for each interface in the Object explorers can be assigned to an interface in the model (Figure 66 (on page 105)).

![Selection explorer](image)

*Figure 66: Interfaces in the Selection Explorer*

**Material mode**

The material properties of an interface can be assigned according to the mode specified in the selected interface subtree in the Object explorers. As an example, consider a typical application of interfaces such as the interaction between a diaphragm wall and the soil, which is intermediate between smooth and fully rough. The options available are:
From adjacent soil | The roughness of the interaction is modelled by choosing a suitable value for the strength reduction factor \( R_{\text{inter}} \) specified in the Interface tabsheet of the material set assigned to the surrounding material. Optionally, a residual strength \( R_{\text{inter, residual}} \) can be specified if the interface strength is reached. This factor relates the interface strength (wall friction and adhesion) to the soil strength (friction angle and cohesion). Note that by default the From adjacent soil option is selected for the Material mode parameter. For detailed information on the material properties of interfaces see Interfaces tabsheet (on page 254).

Custom | A material dataset can be assigned directly to an interface when the Custom option is selected. Note that the strength reduction factor of the selected material is by default set to one.

### Permeability

By default structural elements such as Plates and Geogrids are fully permeable. A certain permeability can be introduced by assigning an interface geometric entity to the soil besides the structural element.

In principle the permeability types of interfaces (Cross permeability and Drainage conductivity explained in Groundwater flow through interfaces (on page 259)) are defined in the corresponding material data set (See Interfaces tabsheet (on page 254)> Groundwater). However, notice that by selecting the interface geometric entity, in the Selection Explorer a checkbox is available to make the interface either Active in flow or Inactive in flow (see Figure 67 (on page 106)). This has consequences for the actual interface permeability being used in a selected calculation phase (Table 3 (on page 107)).

![Selection Explorer](image.png)

**Figure 67:** Active in flow option for permeability in phases

**Note:** For more information about permeability on interfaces please visit Groundwater flow through interfaces (on page 259) or Bentley Communities.
Table 3: Resulting settings for permeabilities in Interfaces

<table>
<thead>
<tr>
<th>Permeability type</th>
<th>Hydraulic conductivity direction</th>
<th>Drainage type</th>
<th>Active in flow</th>
<th>Inactive in flow</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross permeability</td>
<td>Through the interface</td>
<td>Impermeable</td>
<td>Infinite cross resistance (or zero permeability)</td>
<td>No input value - Infinite cross permeability (or zero resistance)</td>
<td>No output of flow $q_\alpha$ available.</td>
</tr>
<tr>
<td>Drainage conductivity</td>
<td>Longitudinal to the interface (acting as a drain)</td>
<td>Permeable - Input value: Drainage conductivity</td>
<td>Depending on drainage conductivity assigned</td>
<td>Infinite cross permeability (or zero resistance)</td>
<td>Output of flow $q_1$ available when active.</td>
</tr>
</tbody>
</table>

**Note:** In *Flow only* calculations no structural element needs to be assigned to the geometric entity as deformations will not be taken into account. Thus, it is sufficient to use only interfaces to block the flow. Note that the end points of an interface are always permeable.

**Virtual interface thickness**

Each interface has assigned to it a 'virtual thickness' which is an imaginary dimension used to define the material properties of the interface. The higher the virtual thickness is, the more elastic deformations are generated. In general, interface elements are supposed to generate very little elastic deformations and therefore the virtual thickness should be small. On the other hand, if the virtual thickness is too small, numerical ill-conditioning may occur. The virtual thickness is calculated as the Virtual thickness factor times the global element size. The global element size is determined by the global coarseness setting for the mesh generation (Global settings (on page 309)). The default value of the Virtual thickness factor is 0.1. This value can be changed in the Object explorers. In general, be careful when changing the default factor. However, if interface elements are subjected to very large normal stresses, it may be required to reduce the Virtual thickness factor. Further details of the significance of the virtual thickness are given in Interfaces tabsheet (on page 254).

5.6.6.2 Interface elements

Interfaces are composed of interface elements. Figure 68 (on page 108) shows how interface elements are connected to soil elements. When using 15-node elements, the corresponding interface elements are defined by five pairs of nodes, whereas for 6-node soil elements the corresponding interface elements are defined by three
pairs of nodes. In the figure, the interface elements are shown to have a finite thickness, but in the finite element formulation the coordinates of each node pair are identical, which means that the element has a zero thickness.

![Node and Stress Point Distribution](image)

*Figure 68: Distribution of nodes and stress points in interface elements and their connection to soil elements*

The stiffness matrix for interface elements is obtained by means of Newton Cotes integration. The position of the Newton Cotes stress points coincides with the node pairs. Hence, five stress points are used for a 10-node interface elements whereas three stress points are used for a 6-node interface element.

At interface ends interface element node pairs are 'degenerated' to single nodes. Also when structural elements are connected perpendicular to each other (for example, a plate is connected to another plate), interface element node pairs are locally 'degenerated' to single nodes to avoid a disconnection between both structural elements.

### 5.6.6.3 Interfaces around corner points

*Figure 69* (on page 108) and *Figure 70* (on page 109) show that problems of soil-structure interaction may involve points that require special attention. Corners in stiff structures and an abrupt change in boundary condition may lead to high peaks in the stresses and strains. Volume elements are not capable of reproducing these sharp peaks and will, as a result, produce non-physical stress oscillations. This problem can be solved by making use of interface elements as shown in *Figure 70* (on page 109).

![Inflexible Corner Point](image)

*Figure 69: Inflexible corner point, causing poor quality stress results*
Figure 70 (on page 109) shows that the problem of stress oscillation may be prevented by specifying additional interface elements inside the soil body. These elements will enhance the flexibility of the finite element mesh and will then prevent non-physical stress results. However, these elements should not introduce an unrealistic weakness in the soil. Therefore special attention should be made to the properties of these interface elements (Interfaces tabsheet (on page 254)).

At interface ends, interface element node pairs are 'degenerated' to single nodes. When an interface exists on only one side of a structure, the interface end node is collapsed to the corresponding structure node. As a result, there exists only one node at that location. When interfaces are assigned on both sides of a structure the end nodes of the interfaces are collapsed, however the collapsed node is not the corresponding structure node. As a result, there exist two nodes at that specific location, the structure node and the node shared by both interfaces. The interactions between the structure and the surrounding soil at that node is controlled by a combined effect of both interfaces. Additional theoretical details on this special use of interface elements is provided by Goodman, Taylor & Brekke (1968) (on page 587) and Langen & Vermeer (1991) (on page 588).

### 5.6.7 Cables

Cables are PLAXIS structural elements used for simulating the reinforcement of the rock mass (i.e., preservation/improvement of the overall rock properties) in applications such as underground excavations, mining, slope stability among others. Cable elements allow the increase of the shear resistance and the tensile strength of the rock mass, preventing/reducing block movement by mobilizing axial forces (tension and compression). This behaviour makes the cable elements suitable not only to model grouted cables but also frictional/grouted bolts and rebars when the effect of bending is negligible. Similarly to Embedded Beams (on page 97) in PLAXIS 2D, since the stress state and deformation pattern around the cable element is fully three-dimensional, it is impossible to model such structures completely in a 2D model. Hence, the 2D cable elements are only a simplified approach to deal with rows of cables in the out-of-plane direction, in a 2D plane strain model.

Although rock reinforcement can be modelled using Embedded Beams (on page 97) elements, cables expand the capabilities of PLAXIS for rock engineering practitioners allowing them to have a more robust, efficient and easily calibrated modelling. Some of these expanded capabilities comprise:

- Pre-stressing of cable elements.
- Confining stress-dependency.
- Material definition of bond stiffness and bond strength.
5.6.7.1 Cable element

A cable element is a structural element that interacts with the PLAXIS mesh through an interface (or bond). This interaction with the rock mass can evolve during the development of a project in a discrete (e.g., during rock bolt/cable element pretensioning) or continuous (e.g., after being grouted) manner.

The idea behind the cable element is similar to the one presented in Embedded Beams (on page 97) in the sense that cable elements are not 'in' the mesh, but superimposed 'on' the mesh, while the underlying element mesh of the rock or soil is continuous (Figure 71 (on page 110), modified after Sluis [2012] (on page 588)). A special out-of-plane interface connects the cable element with the underlying rock/soil elements. The cable element is supposed to represent the movement of an out-of-plane row of individual cable element, whereas displacements of the rock or soil elements are supposed to represent the 'average' rock/soil displacement.

![Figure 71: Schematic representation of the cable element](image)

**Note:** Differently to embedded beams cable elements only work under axial forces, therefore, bending moments and shearing resistance are not part of the basic behaviour of cable elements.

5.6.7.2 Cable creation

The creation of cables in the geometry model is similar to the creation of a line (Create line (on page 72)).
Note: It is not necessary to create interface elements around the cables separately.

Cables can be created in the Input program in the **Structures mode** using one of the following approaches:

1. **Using the side tool bar:**
   - On the side toolbar go to the icon option corresponding to **Create line > Create cable** (see fig).

   ![Side tool bar: Create line> Create cable](image)

   *Figure 72: Side tool bar: Create line> Create cable*

   - On the side toolbar go to the icon option corresponding to **Create Structure > Create cable**.
Modelling loads and structures - Structures mode

Structural elements

![Side tool bar: Create structure> Create cable](image)

**Figure 73: Side tool bar: Create structure> Create cable**

2. **Using a line element:**
   - On the drawing area create a line element on the rock mass, then on this new element **Right-click** and from the popup menu select **Create > Create cable**.

Once drawn, the cables are displayed as shown in **Figure 74** (on page 113).
5.6.7.3 Cable properties

By selecting a cable in the model its properties are displayed on the **Selection explorer > Cable**. These properties are: Material model, Apply strength reduction, Connection point and Connection behaviour (see Figure 75 (on page 113)).

1. Material:

The material properties used in PLAXIS for cable elements include the spacing in the out-of-plane direction in a 2D plane strain model of the structural element, the definition of the geometric characteristics of the cables,
and the strength/stiffness properties of the cable element and the bond, which, as mentioned earlier, represents the interaction between the cable element and surrounding rock/soil.

For more information on the Materials and property definition for this structural element please visit the section Material data sets for cables (on page 298)

2. **Apply strength reduction:**

   Enables the reduction of the strength parameters of cable element in a Safety calculation (phi/c reduction) (on page 326).

3. **Connection point [only in Structures mode]**

<table>
<thead>
<tr>
<th>Connection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>It refers to the first point of the corresponding geometry line, as listed in the Selection explorer when the cable is selected (typically the point on a tunnel/excavation/slope contour).</td>
</tr>
<tr>
<td>Second</td>
<td>It refers to the second point of the corresponding geometry line (typically the point somewhere in the surrounding rock).</td>
</tr>
</tbody>
</table>

4. **Connection [only in Structures mode]**

<table>
<thead>
<tr>
<th>Connection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connected</td>
<td>The displacement at the connection point of the cable is directly coupled with the displacement of the rock/soil element in which the connection point is located, which means that they undergo exactly the same displacement.</td>
</tr>
<tr>
<td>Free</td>
<td>The connection point of the cable is not coupled with the rock/soil element in which the cable top is located, but the interaction through the bond elements along the cable length is still present. When a node-to-node anchor ends at the same geometry point, this structural node is automatically connected to the cable connection point, but it will not be tied to the corresponding rock/soil node.</td>
</tr>
</tbody>
</table>

5. **Prestressing [available only in the Staged construction mode]**

   Cables can be prestressed to provide an active force support to the rock material. As seen in Figure 76 (on page 115) by activating the Adjust prestress check box the prestress force becomes available.
When the *Adjust prestress* box is selected, a prestress force (per cable, force unit) is applied to the cable, while bond shear force is assumed to be zero [State: **Unbonded**]. When the *Adjust prestress* box is unselected, in a subsequent phase, it is assumed that bond interaction with the surrounding rock is developed [State: **Bonded**].

The prestressing procedure will be explained in more detail in [Prestressing of anchors and cable](#) (on page 383).

### 5.6.8 Discontinuities

Rock mass consists of a rock material matrix and fractures of different types and scales that represent breaks in the mechanical continuum. These fractures commonly known as *Discontinuities* describe any separation in the rock mass having zero or low tensile strength. In this way, *Discontinuities* are the collective term for the majority of joints, weak bedding planes, weak schistocity planes, weakness zones, shear zones and faults found in the rock mass ([ISRM, 1978](#) (on page 587) and [Priest, 1993](#) (on page 587)).

*Discontinuities* can be modelled using discrete elements when the discontinuities play a major role in the overall rock mass behaviour and thus the assumption of purely equivalent continuum approach cannot be assumed.

The simulation of *Discontinuities* as discrete elements can be performed using [Interfaces](#) (on page 104). However, to address more efficiently this simulation the *Create discontinuity* feature is introduced inside the **Structures mode**.

#### 5.6.8.1 Discontinuity element

Discontinuities are composed of discontinuity elements that are embedded in the rock mass ([see Figure 77](#) (on page 116)a)) which is different from soil-structure interaction that represents a disturbance at the separation between 2 different materials. Similar to interfaces, discontinuities are defined by five pairs of nodes when using 15-node elements, and three pairs of nodes when using 6-node soil elements ([Figure 77](#) (on page 116)b)).

Discontinuity elements are generally used to simulate rock joints, fractures or faults, while Interface elements are commonly used for soil structure interaction.

Note that in [Figure 77](#) (on page 116) b) discontinuities are represented as if they have a finite thickness, however in the finite element formulation the coordinates of each node pair are identical, which means that the element has a zero thickness.
Discontinuity elements also have the characteristic that they work as independent features acting as separate cluster with their own material and water condition.

The use of discontinuity elements have the following restrictions:

- Other structures, loads, displacements and groundwater boundary conditions are not allowed in the discontinuity.
- Discontinuities cannot be activated on an active boundary (e.g discontinuity at the boundary of an excavation).

### 5.6.8.2 Creating a Discontinuity

A discontinuity can be created in the Input program inside the Structures mode using one of the following approaches:

- On the side toolbar go to the icon option **Create line > Create discontinuity**.
- On the side toolbar go to the icon option **Create Structure > Create discontinuity**.

Once the Create discontinuity option is selected, a line can be drawn on the rock mass (that needs to be previously defined in the Soil mode).

**Note:**

Alternatively, in PLAXIS 2D a discontinuity can be created by drawing a line in the rock mass, then on the new element **Right-click** and from the popup menu select **Create > Discontinuity**.

Once drawn, the discontinuities are displayed using orange lines as shown in Figure 78 (on page 117).
5.6.8.3 Discontinuity properties

By choosing a discontinuity in the model, its properties are displayed on Selection explorer > Discontinuities. Properties such as the Material model, Apply strength reduction and Active in flow can be adjusted (Figure 79 (on page 117)).

1. Material:

The material properties of a discontinuity involve both the strength and the deformability parameters of the rock fracture. When this option is selected a window opens to create the discontinuity material and to define
its properties. Once the material has been created, it is automatically assigned to the selected discontinuity elements.

**Note:** For more information in the creation of Discontinuity Materials and Property definition please see Material data sets for discontinuities (on page 271)

2. **Apply strength reduction:**

Enables the reduction of the strength parameters of the discontinuity element in a Safety Analysis.

3. **Active in flow:**

Discontinuities always have infinite cross permeability, except when the material **Drainage type** is non-porous. When **Active in Flow** option is deselected, longitudinal flow (flow along the discontinuity) is blocked (zero permeability) whereas when this option is selected, the longitudinal flow is governed by the **Transmissivity** parameter (see Groundwater properties (on page 275)).

### 5.6.9 Connections

When two plates are connected, by default they share all the degrees of freedom (rotations and translation degrees of freedom) in the connected node, which implies that the connection is rigid. The connection between two plates can be customised by explicitly defining a **Connection**.

A connection consists of:

<table>
<thead>
<tr>
<th>Reference part (or the 'parent object')</th>
<th>The object to which another object (a 'child object') is connected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom part (or the 'child object')</td>
<td>The object connected to the 'parent object'.</td>
</tr>
</tbody>
</table>

To define a connection:

- **Click** the **Create connection** button in the side toolbar.
- **Specify** the **Custom part** by clicking on it in the drawing area.
- **Specify** the **Reference part** by clicking on it in the drawing area. The connection will be indicated by a yellow circle located on the **Custom part** next to the intersection point (**Figure 80** (on page 119)).
Note that a connection can be created only if one of the end points of the custom part lies on the reference part. A connection is active when both parts are active in a calculation phase.

The properties of a connection can be specified in the Object explorers. The options available for the rotation are shown in (Figure 81 (on page 119)). If the Fixed option is selected, the connection is rigid (as if no connection was defined). If the Free option is selected, the connection is a hinge. If the Elastic spring option is selected, the rotation stiffness of the spring should be specified. If the Elastoplastic spring option is selected the maximum bending moment (|\(M_y\)|) should be specified besides the stiffness.

![Image of connection properties](image)

Figure 81: Properties of a connection in the Selection explorer

## 5.7 Tunnels [GSE]

The Create tunnel in the side (vertical) toolbar can be used to create arbitrary shaped tunnels which are to be included in the geometry model. A tunnel shape consists of a tunnel cross section, composed of arcs and lines,
optionally supplied with features such as lining (plates), interfaces, loads, prescribed displacements, contractions, groundwater flow boundary conditions, etc.

The tunnels available in the model are listed in the Tunnels subtree in the Model explorer. The geometry and the properties of a tunnel can be defined in the Tunnel explorer window.

**Note:**
- Note that it is not possible to undo/redo actions carried out to define a tunnel cross-section when the Tunnel designer window is closed.
- The Tunnel designer window can be reopened by right-clicking on one of the available tunnels in the Object explorers and selecting the Edit option in the appearing menu.

**Warning:** The Tunnels feature in PLAXIS 2D licence allows users to create a tunnel geometry. However, to generate the tunnel in the model a GSE entitlement needs to be active.

### 5.7.1 Tunnel designer

Once the Create tunnel button is clicked in the side toolbar, the user needs to select the tunnel insertion point in the geometry. After that, the Tunnel designer window appears.

![Tunnel designer window](image)

*Figure 82: The General tabsheet of the Cross-section mode*
The **Tunnel designer** contains the following items:

<table>
<thead>
<tr>
<th><strong>Tunnel menu</strong></th>
<th>It contains the <em>File</em> menu that enables loading predefined tunnels as well as saving newly created ones.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main toolbar</strong></td>
<td>It contains buttons that enable loading predefined tunnels, saving new tunnels and arranging the view in the display area.</td>
</tr>
<tr>
<td><strong>Mode bar</strong></td>
<td>It contains two separate modes where the cross-section is defined and properties are assigned to its components.</td>
</tr>
<tr>
<td><strong>Display area</strong></td>
<td>It displays the defined geometry and it indicates the assigned properties. The slice is automatically updated after any change done in the modes in the left side. The supporting tools under the display area can be used to simplify the definitions and modification of the slice.</td>
</tr>
<tr>
<td><strong>Feedback panel</strong></td>
<td>It provides feedback on the quality of the defined cross section.</td>
</tr>
</tbody>
</table>

The design of a tunnel cross section is done in two separate modes, *Cross-section* and *Properties*. The geometric shape of the tunnel cross-sections can be defined in the **Cross-section** mode, whereas in the **Properties** mode features can be assigned to existing cross-section elements.

### 5.7.2 Definition of tunnel cross section geometry

The tunnel cross section is a collection of lines and arcs. Each line and arc composing the cross-section is defined as a segment.

1. **General**

   The general shape settings of a tunnel are defined in the **General** tabsheet.

   **Shape**: The available types for the shape of a tunnel are:

<table>
<thead>
<tr>
<th><strong>Shape</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free</td>
<td>Allows to create a tunnel cross section composed of lines and arc segments.</td>
</tr>
<tr>
<td>Circular</td>
<td>Allows to create a circular tunnel.</td>
</tr>
<tr>
<td>Template</td>
<td>Allows to split tunnels into separate tunnels.</td>
</tr>
<tr>
<td>Whole or half tunnel</td>
<td>Allows to create a whole tunnel or a half one.</td>
</tr>
</tbody>
</table>

**Layout of the tunnel in the model**: The general properties of a tunnel in the model are defined using the options in the **General** tabsheet.

- The coordinates of the insertion point can be defined in the *Object explorers*. By default the coordinates of the location clicked in the model before the **Tunnel designer** window is displayed are shown. As the coordinates are changed, the tunnel will be relocated.
- By default the insertion point is the starting point of the first segment of the tunnel cross section. The *Offset to begin point* group can be used to specify offset distances from the orientation axis when the
insertion point (origin of the orientation axis) and the starting point of the first segment of the cross section do not coincide.

- The *Orientation axis 1* and the *Orientation axis 2* define the orientation of the tunnel in the model.

2. **Definition of segments**

The segments of a cross section can be defined in the **Segments** tab sheet of the **Tunnel designer** window (Figure 83 (on page 122)).

![Figure 83: The Segments tab sheet of the Cross-section mode](image)

- A new segment is added to the last segment in a tunnel cross-section by clicking the *Add segment* button available in the side toolbar. The last point of the last segment is the first point of the newly added segment. The newly created segment is displayed in the segment list Figure 83 (on page 122).

**Note:** A segment can be selected by clicking it either in the list or in the display area. A selected segment is highlighted in the list and in the display area.

- A new segment is inserted before a selected segment in a tunnel cross-section when the *Insert segment* button is clicked. The last point of the newly inserted segment becomes the first point of the previously selected segment. The indices of the segments are updated according to their position in the list.

- A selected segment in a cross-section is deleted when the *Delete segment* button is clicked. The indices of the segments are updated according to their position in the list.

In the **Subsections** tab sheet, the points and segments can be right-clicked and the suitable option to create a subsection turns on in the side bar. This feature allows to create a new subsection starting from the end point and angle of the selected elements.
When a point is selected, it generates an horizontal straight line. When a point is selected, the option *Add subsection from point* is also available right-clicking in the *Slice* drawing area.

When a point and a segment are selected, it generates a straight line with a start angle equal to the tangent of the selected segment in the selected point. When a point and a segment are selected, the option *Add directed subsection from point* is also available right-clicking in the *Slice* drawing area.

When two points are selected, it generates a straight line connecting the chosen points. When two points are selected, the option *Add subsection between points* is also available right-clicking in the *Slice* drawing area.

## Editable segments properties

<table>
<thead>
<tr>
<th>Segment type</th>
<th>The options available are <em>Line</em> and <em>Arc</em>. For a <em>Line</em> segment the length of the segment should be specified. For an <em>Arc</em> segment the radius and the segment angle should be specified ([Figure 84](on page 124)).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative start angle</td>
<td>The value of the angle between the start tangent of the next segment and the end tangent of the previous segment ([Figure 85](on page 124)).</td>
</tr>
<tr>
<td>Radius</td>
<td>Arc only. The value of the radius for an arc segment.</td>
</tr>
<tr>
<td>Length</td>
<td>Line only. The value of the line segment length.</td>
</tr>
<tr>
<td>Segment angle</td>
<td>The value of the arc length expressed in degrees.</td>
</tr>
<tr>
<td>Start angle</td>
<td>The value of the angle between the start tangent of the segment and the global tangent.</td>
</tr>
<tr>
<td>Δ1</td>
<td>The horizontal increment of the line formed by the start and end point of the segment. Δ1 is in local polycurve space (defined by the orientation axes), not global model space.</td>
</tr>
<tr>
<td>Δ2</td>
<td>The vertical increment of the line of formed by the start and end point of the segment. Δ2 is in local polycurve space (defined by the orientation axes), not global model space.</td>
</tr>
</tbody>
</table>

The rest of parameters are read-only and cannot be edited.

**Note:** When modelling arcs using derived parameters Δ1 and Δ2, there will often be two solutions for the same absolute x or y value. In those situations, PLAXIS will always take the shortest segment. To design those ambiguous cases correctly, use the remaining parameters.
When specifying a negative radius for an Arc segment, the arc will be mirrored in the line described by the tangent vector. Note that when the Circular shape option is selected, the created cross-section consists only of one Arc segment with a Segment angle value of 360° or 180°, depending on whether the whole tunnel or only half of it is being defined.

3. Definition of tunnel sub-clusters

The subdivision of a tunnel cross-section into different subsections can be subdivided in the Subsections tabsheet. In this way the various subsections for a NATM tunnel or a sequential excavation tunnelling process
can be defined (e.g. top heading, bench, invert, side drift). Essentially the geometric properties of the lines and arcs as well as the buttons in the side toolbar are the same as in the Segments tabsheet. There is no closure requirement for the geometry defined in the Subsections tabsheet. A sub-section may conveniently start from an existing geometry point, but sub-sections may also be defined independently.

To intersect the defined geometry:

- Select the geometric entities to be intersected.
- Click the Intersect button.
- Delete the redundant parts after the intersection.

To define thick tunnel lining:

- Click the Generate thick lining button in the side toolbar in the Subsections tabsheet. The Generate thick lining window pops up.
- Specify the thickness of the lining in the appearing window. A positive value will give an extra line outside of the current geometry contour. The reverse is true for a negative thickness value. Note that when the tunnel is included in the geometry model, a subcluster will be created for the thick lining. A proper material should be assigned to it, as it is done for the soil clusters.

![Figure 86: The Generate thick lining window](image)

5.7.3 Import tunnel geometry

Existing tunnel geometry can be imported in the Segments tabsheet in the Cross section mode of the Tunnel designer window. The program supports *.dxf, *.step, *.stp and *.brep files. The geometry to be imported must meet the following criteria:

- It must contain a polycurve (consisting of lines and arcs), or circle, defining the outer boundary of the tunnel (called the segment path). This may consist of segments of both line and arc types. The components of the outer boundary will be listed as segments.
- The geometry objects should be defined parallel to the XY plane.

**Note:** Entities of incompatible types are omitted from the import.

On selecting the file to be imported, the imported cross section geometry appears in the Import tunnel cross section preview window (Figure 87 (on page 126)).
In the imported geometry, possible segments and subsections are automatically detected and indicated by blue and black lines respectively.

The side toolbar has the following buttons:

- **Select** button can be used to select any segments and subsections in the preview pane.

  **Note:** To delete a segment or subsection, use the **Select** button to select the desired segment(s) or subsection(s), right click anywhere on the Preview pane, and click on the delete option that appears. Alternatively, the delete key on a keyboard can also be used.

- **Add or remove path segment** button can be used to add or remove individual parts to the main segment of the cross section.

- **Detect path** button can be used to select the longest path of the segments.

- **Select path start point** can be used to indicate the start point of the segments path.

General Tab sheet has the following options:

- **Merge points tolerance:**
  The segments are merged based on Merge points tolerance that can be specified in the General tab sheet panel. Gaps are eliminated based on simple geometrical translation of lines/arcs. The last line/arc is modified if it is necessary to close the selected segment path.

- **Dimensions:**
Dimensions shows the width and the height of the bounding box of the imported model. Note that the absolute coordinates of the bounding box are not relevant in the tunnel designer import.

- **Automatically intersect segments and subsections during import:**

  If the Automatically intersect segments and subsections during import checkbox is checked (which is the Default setting), the imported segments/subsections will be automatically intersected during import into the tunnel designer.

### 5.7.4 Properties

Features can be assigned to the tunnel segments and subsections in the **Properties mode** by right-clicking the segment and selecting the corresponding option in the appearing menu.

The features available in the Slice panel are:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create line load</td>
<td>To assign a line load to the selected segment (or subsection).</td>
</tr>
<tr>
<td>Create line contraction</td>
<td>To assign a line contraction to the selected segment (or subsection).</td>
</tr>
<tr>
<td>Create line prescribed displacement</td>
<td>To assign a line prescribed displacement to the selected segment (or subsection).</td>
</tr>
<tr>
<td>Create plate</td>
<td>To model a tunnel shield or a shotcrete lining using the <em>Plate</em> feature.</td>
</tr>
<tr>
<td>Create geogrid</td>
<td>To model a temporary support or a shotcrete lining using the <em>Geogrid</em> feature.</td>
</tr>
<tr>
<td>Interfaces</td>
<td>To model the interaction of the tunnel lining with the surrounding soil (rock) in the selected segment.</td>
</tr>
<tr>
<td>Groundwater flow boundary conditions</td>
<td>To assign boundary conditions for flow to the selected segment (or subsection). [ADV]</td>
</tr>
<tr>
<td>Thermal flow boundary conditions [ADV]</td>
<td>To assign boundary conditions for thermal to the selected segment (or subsection). [ADV]</td>
</tr>
<tr>
<td>Create reinforcement</td>
<td>To create reinforcement for the selected segment (or subsection).</td>
</tr>
</tbody>
</table>

### 5.7.4.1 Load options for tunnel segments

Loads can be added to individual tunnel segments in the Properties tabsheet of the tunnel designer. To do so, right-click the corresponding tunnel segment in the right drawing area and select *Create line load* from the appearing menu.
The information required to define a load assigned to a segment in the tunnel consists of load distribution, load value and the point of reference (in case of linear loads).

The distribution options for loads are:

<table>
<thead>
<tr>
<th>Distribution</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Uniform</strong></td>
<td>To create a uniform distributed load.</td>
</tr>
<tr>
<td><strong>Linear</strong></td>
<td>A linearly varying distributed load is created by defining the components and the magnitude of the force at the start and at the end points of the tunnel segment (or subsection). The start and end points are determined by their order of definition.</td>
</tr>
<tr>
<td><strong>Perpendicular</strong></td>
<td>To create a uniformly distributed load perpendicular to the selected segment (or subsection). The value of the load ($\sigma_n$) needs to be specified.</td>
</tr>
<tr>
<td><strong>Perpendicular, vertical increment</strong></td>
<td>To create a load perpendicular to the selected segment varying with depth by defining the components and the magnitude of the load at the reference point with respect to the global system of axes (y-axis) and its increment with depth. The values of the reference load ($\sigma_{n,ref}$) and the load increment ($\sigma_{n,inc}$) as well as the reference vertical coordinate need to be specified.</td>
</tr>
</tbody>
</table>

5.7.4.2 Reinforcements

*Reinforcements* can be added to tunnels in the *Properties* tabsheet of the tunnel designer. The available reinforcements are:

1. Rock bolts
2. Cables

**Rock bolts**

Rock bolts are implemented using *Embedded Beams* (on page 97) elements which are capable to support bending moments and shear forces. They can be modelled by following these steps:

1. Click on *Properties > Reinforcements*.
2. In the drawing area, (multi) select the required tunnel segments and click on the *Define reinforcement* icon on the left panel to add a reinforcement. Alternatively, **right-click** on the chosen segments and select *Create > Create reinforcement* (see *Figure 85*). By default, a *Rock bolt* element will be generated as displayed in *Figure 89* (on page 130).
3. Select the created element. Then automatically the Selection explorer (lower left panel) with the different available Rock bolt properties (see Figure 89 (on page 130)).
4. Define the rest of the reinforcement properties, these are briefly described below:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reversed</strong></td>
<td>Defines the drawing direction of rock bolts. By default <em>Rock bolts</em> are drawn in a counter clockwise direction from the starting point at the beginning of the segment (or subsection).</td>
</tr>
<tr>
<td><strong>Length of rock bolt</strong></td>
<td>Length of the rock bolt perpendicular to the tunnel contour.</td>
</tr>
<tr>
<td><strong>Offset from segments</strong></td>
<td>Each rock bolt can have an offset from the tunnel contour. This is particularly useful when the tunnel has a thick lining.</td>
</tr>
<tr>
<td><strong>Material</strong></td>
<td>Material definition for the structural element. For more information please [General properties](on page 288) of embedded beams.</td>
</tr>
<tr>
<td><strong>Apply strength reduction</strong></td>
<td>Enables the reduction of the strength parameters of rock bolt element in a [Safety calculation (phi/c reduction)](on page 326)</td>
</tr>
<tr>
<td><strong>Distribution</strong></td>
<td>Rock bolts can be added in both breadth and depth of a tunnel trajectory. The distribution of these rock bolts is possible by choosing [Number, Spacing or Custom](from a drop down menu. When the option Custom is selected, both spacing and offset parameters can be specified.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Number</td>
<td>Number of rock bolts in breadth or depth of a tunnel trajectory.</td>
</tr>
<tr>
<td>Offset</td>
<td>Distance from the first tunnel point to the first rock bolt along the tunnel contour.</td>
</tr>
</tbody>
</table>

**Note:**
- Be aware that if Rock bolts are reversed, the Offset and Spacing are also reversed accordingly.

5. It is also possible to delete a reinforcement, by clicking on the **Delete** button in the drawing area.
6. When the design of the reinforcements is finished (as shown in **Figure 90** (on page 131)) and the rest of the tunnel properties are defined, the tunnel can be created by pressing the **Generate** button.

![Figure 90: Rock bolt definition in the Tunnel Designer](image)

**Figure 90** (on page 131) displays the created tunnel and the created Rock bolts in the **Structures mode**.
**Cables**

Cables (on page 109) are structural elements designed to work under axial forces. They can be modelled by following these steps:

1. Click on Properties > Reinforcements.
2. In the drawing area, (multi) select the required tunnel segments and click on the Define reinforcement icon on the left side panel to add a reinforcement. Alternatively, right-click on the chosen segments and select Create > Create reinforcement (Figure 85). By default a rock bolt element will be generated.
3. To transform the default Rock bolt into a Cable, in the drawing area select the newly created element, then go to the appearing Selection explorer and select Element type > Cable. Once this is done, the cable element will be displayed in the drawing area as shown in Figure 92 (on page 133).
4. Define the rest of the reinforcement properties in the Selection Explorer. These are briefly described below:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reversed</td>
<td>Defines the drawing direction of cable. By default Cable are drawn in a counter clockwise direction from the starting point at the beginning of the segment (or subsection).</td>
</tr>
<tr>
<td>Length of Cable</td>
<td>Length of the cable perpendicular to the tunnel contour.</td>
</tr>
<tr>
<td>Offset from segments</td>
<td>Each cable can have an offset from the tunnel contour. This is particularly useful when the tunnel has a thick lining.</td>
</tr>
<tr>
<td>Material</td>
<td>Material definition for the structural element. For more information please refer to the Material data sets for cables (on page 298) of Cable.</td>
</tr>
<tr>
<td>Apply strength reduction</td>
<td>Enables the reduction of the strength parameters of cable element in a Safety calculation (phi/c reduction) (on page 326)</td>
</tr>
<tr>
<td>Distribution</td>
<td>Cable can be added in both breadth and depth of a tunnel trajectory. The distribution of these cables is possible by choosing Number, Spacing or Custom from a drop down menu. When the option Custom is selected, both spacing and offset parameters can be specified.</td>
</tr>
</tbody>
</table>
### Property Description

**Number**  
Number of Cables in breadth or depth of a tunnel trajectory.

**Offset**  
Distance from the first tunnel point to the first rock bolt along the tunnel contour.

**Note:**
- Be aware that if Cable gets reversed, the Offset and Spacing are also reversed accordingly.

5. It is also possible to delete reinforcements, by clicking on the **Delete** button in the drawing area.

6. When the design of the Cable is finished (as shown in Figure 93 (on page 134)) and rest of the tunnel properties are defined, the tunnel can be created by pressing the **Generate** button.

---

*Figure 93: Cable creation in the Tunnel Designer*

*Figure 94* (on page 135) displays the created tunnel and the created Rock bolts in the **Structures mode**.
5.8 Design approaches [ADV]

PLAXIS 2D has a facility to deal with partial factors for loads and model parameters (Brinkgreve & Post, 2013 (on page 586)). This facility is called 'Design approaches' and enables PLAXIS 2D to be used for design calculations in the framework of the Eurocode, LRFD or other design methods based on partial factors.

The main idea is that a project is first analysed for a Serviceability Limit State (SLS) situation, without using Design approaches. The input values of the loads and the model parameters are supposed to be representative or characteristic values. The result would be a cautious estimate of deformations, stresses and structural forces.

If satisfactory results have been obtained for the serviceability state, one may consider using Design approaches to deal with Ultimate Limit State (ULS) design. In order to perform design calculations, new phases need to be defined in addition to the serviceability state calculations. There are two main schemes to perform design calculations in relation to serviceability calculations (Bauduin, Vos & Simpson, 2000 (on page 586)).

Scheme 1:

0. Initial phase

\[
\begin{align*}
&\downarrow \\
1. & \text{Phase 1}(\text{SLS}) \rightarrow 4. \text{Phase 4}(\text{ULS}) \\
&\downarrow \\
2. & \text{Phase 2}(\text{SLS}) \rightarrow 5. \text{Phase 5}(\text{ULS}) \\
&\downarrow \\
3. & \text{Phase 3}(\text{SLS}) \rightarrow 6. \text{Phase 6}(\text{ULS})
\end{align*}
\]
In this scheme, the design calculations (ULS) are performed for each serviceability state calculation separately. This means that Phase 4 starts from Phase 1, Phase 5 starts from Phase 2, etc. Note that in this case a partial factor on a stiffness parameter is only used to calculate additional displacements as a result of stress redistribution due to the factored (higher) loads and the factored (reduced) strength parameters.

Scheme 2:

0. Initial phase → 4. Phase 4(ULS)
↓
1. Phase 1(SLS) → 5. Phase 5(ULS)
↓
2. Phase 2(SLS) → 6. Phase 6(ULS)
↓
3. Phase 3(SLS)

In this scheme, the design calculations (ULS) start from the initial situation and are performed subsequently. This means that Phase 4 starts from the Initial phase, Phase 5 starts from Phase 4, etc.

It is the responsibility of the geotechnical engineer to consider all the different conditions that effect the design. Engineering judgment plays a vital role in the determination of different combinations to be considered in the design.

5.8.1 Definition of design approaches

Different design approaches, i.e. coherent sets of partial factors, can be defined for loads and model parameters according to the applicable design methods (for example: Eurocode 7 - DA 3). After defining such a coherent set of partial factors by the user, it may then be exported (stored) under an appropriate name in a global data base, after which it can be imported and re-used in other projects. Hence, once complete sets of partial factors have been defined and stored, it is a relatively small effort to make design calculations in addition to serviceability calculations.

The design approaches are global attributes and are listed in the corresponding subtree under the Attributes library in the Model explorer.

- To activate the Design approaches window (Figure 95 on page 137), right-click the corresponding subtree under the Attributes library in the Model explorer. Note that the Design approaches option available in the Soil, Structures, Water conditions and Staged construction modes.
The **Design approaches** window consists of two parts. In the *Identification* part a list of the defined design approaches as well as options to *Add*, *Delete*, *Copy* and *Import/Export* design approaches are available.

- To add a new design approach click the corresponding option. A new design approach will be added in the list. Note that the name of a design approach can be changed by clicking it in the list and typing the new name.
- To delete a design approach from the list select the design in the list and click the corresponding button.
- To create a copy of a predefined design approach select the design approach in the list and click the *Copy* button. The name of a design approach can be changed by clicking it in the list and typing the new name.
- To import design approaches from other projects or from the global repository of design approaches. Click the corresponding button under the list. As a result, the **Import/Export to global repository** window appears ([Figure 96](#) on page 137)). The global repository is a database of the design approaches contained in other projects, simplifying their reuse. The address to the location of the global repository is given under the list of the global design approaches. A different repository can be selected by clicking the *Select* button and selecting the new repository. Global design approaches can be removed from the repository by selecting them first in the list and by clicking *Delete* button.

---

**Figure 95: The Design approaches window**

**Figure 96: Import design approach window**
5.8.2 Definition of partial factors for loads

Loads to be considered in the design approaches for a geotechnical project are:

- Distributed loads
- Point loads
- Prescribed displacements

Different partial factors may apply to different loads or groups of loads. This can be arranged by assigning *Labels* to individual loads or groups of loads. Considering partial factors for loads, distinction can be made between different load cases as shown in Figure 97 (on page 138).

To change a label, double click it and type the new label. Up to 10 labels and their corresponding partial factors can be defined. The partial factors for loads are used as a multiplication factor to the reference values of the loads.

![Partial factors for loads tabsheet](image)

*Figure 97: Partial factors for loads tabsheet*

**Note:** The partial factors for loads are defined such that the design value of a parameter is the reference value multiplied with the partial factor.

Labels can be assigned to loads in the corresponding subtree in the *Model explorer* in the **Phase definition modes**, as part of the definition of a calculation phase. However, the partial factors corresponding to the load labels are only applied when the calculation is performed according to the selected design approach (see **Calculation using design approaches [ADV]** (on page 541)); otherwise reference values of loads are used.
5.8.3  **Definition of partial factors for materials**

The partial factors for materials for a selected design approach in the list can be defined in the corresponding tabsheet in the lower part of the **Design approaches** window. A list of all the available partial factors is displayed below.

![Partial factors for material tabsheet](image)

**Figure 98: Partial factors for material tabsheet**

**Note:**

- The partial factors for materials are defined such that the design value of a parameter is the reference value divided by the partial factor. This also applies to the partial factor on the unit weight. If the partial factor is intended to ‘increase’ the weight, it should be less than unity (1.0).
- In the case of a partial factor on the friction angle $\phi$ or the dilatancy angle $\psi$, the partial factor is applied to $\tan(\phi)$ and $\tan(\psi)$ respectively.
- In addition to partial factors for soil model parameters, partial factors for structural model parameters may be defined as well.

To assign the specified factor to the material parameters:

- Click the **Materials** button. The **Material sets** window pops up.
- Open the material data set. Note that the view has changed. In the current view it is possible to assign factors to different soil parameters, as well as to see the effect of these factors on the soil parameters.
- Click the **Mechanical** tab. In the **Mechanical** tabsheet select the corresponding labels for the material parameters (i.e. $c'_{\text{ref}}$ and $\phi'$ - see **Figure 99** (on page 140)).
To complete the definition of a design calculation it is necessary to proceed to the **Stage definition modes** where the design approach to be used for a specific phase is selected and the loads in the model are labelled (Calculation using design approaches [ADV] on page 541). Make sure that the required load labels with corresponding partial factors are properly assigned to the external loads in the model.

When using Design approaches in combination with advanced soil models, these models will continue to behave as advanced models, maintaining all their features, such as stress-dependent stiffness behaviour and hardening effects. This is different than when using a Safety analysis with advanced models (Safety calculation (\(\phi/c\) reduction) on page 326), since in the latter case advanced models lose their advanced features and basically switch to Mohr-Coulomb. When comparing a Safety analysis to a target value of \(\Sigma M_{sf}\) with a Design approaches analysis using the same partial factor for \(c\) and \(\tan(\phi)\), it should be realised that the results could be different because of this reason.

**5.9 Hydraulic conditions [ADV]**

As an alternative to a direct generation of pore pressures based on the water conditions in the boreholes and the soil clusters, the pore pressure distribution may be calculated on the basis of a groundwater flow calculation or a fully coupled flow-deformation analysis. This requires the definition of groundwater flow boundary conditions, which are termed **Hydraulic conditions**. Hydraulic conditions may also include special conditions that can be
imposed to the model to control the pore pressure at certain locations in the case of groundwater flow calculations or fully coupled flow-deformation analysis.

The creation of a hydraulic condition is similar to the creation of a geometric entity. The options available in the menu displayed as the Create hydraulic conditions button is selected in the side toolbar (Figure 100 (on page 141)), provide a faster definition of conditions.

Figure 100: The Create hydraulic conditions menu

Instead of creating the geometric entity and then assigning a hydraulic condition to it, the whole process is completed in one step. To assign hydraulic conditions to existing geometry entities:

- Right-click the geometric entity either in the drawing area or in the Object explorers.
- In the appearing menu point to Create and select the hydraulic condition by clicking on the corresponding option.

Note that the assignment of hydraulic conditions is also possible by right-clicking the geometric entity either in the drawing area or in the Object explorers and selecting the corresponding option in the appearing menu.

Although the input values of hydraulic conditions are specified in the geometry model, the activation, deactivation or change of values may be considered in the framework of Staged construction (Changing geometry configuration (on page 379)).

In addition to the specific boundary conditions as considered here, global model conditions for the model as a whole in terms of 'open' and 'closed' boundaries as well as precipitation conditions can be defined for each calculation phase in the Model conditions subtree in the Model explorer (Model conditions (on page 383)). Note that specific hydraulic conditions have priority over global model conditions.

Note: For transient groundwater flow and fully coupled flow-deformation analysis, hydraulic conditions can be defined as a function of time using so-called Flow functions (Flow functions [ULT] (on page 150)) which are available with an Ultimate licence.

5.9.1 Well

In order to define a well, the Create well option should be selected from the menu appearing as the Create hydraulic conditions button is clicked. The creation of a well in the geometry model is similar to the creation of a line (Create line (on page 72)). Wells are used to prescribe lines inside the geometry model where a specific flux (discharge) is extracted from or infiltrated into the soil. The properties of a well can be modified in the Selection explorer (Figure 101 (on page 142)).
Figure 101: Well definition in the Selection explorer

The required properties of a well are:

<table>
<thead>
<tr>
<th>Behaviour</th>
<th>The behaviour of the well needs to be specified. The available options are Extraction (taking water from the ground) and Infiltration (bringing water into the ground).</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>Q_{well}</td>
</tr>
<tr>
<td>$h_{min}$</td>
<td>The minimum possible head in the well. When the groundwater head reduces below the $h_{min}$ level no further extraction will occur. As a habit, $h_{min}$ may be set equal to the bottom level of the well in the ground.</td>
</tr>
</tbody>
</table>

This option is only relevant for groundwater flow calculations and fully coupled flow-deformation analysis. Wells can be activated or de-activated in calculation phases.

**Note:**
- When a well intersects multiple soil layers the prescribed flux for each soil layer is a function of the saturated permeability and the intersected depth.
- Note that the saturated permeability is specified in the **Groundwater** tabsheet of the material dataset.

### 5.9.2 Drain

In order to define a drain, the *Create drain* option should be selected from the menu appearing as the *Create hydraulic conditions* button is clicked. The creation of a drain in the geometry model is similar to the creation of a geometry line (*Create line* (on page 72)). Drains are used to prescribe lines inside the geometry model where (excess) pore pressures are reduced.

Together with the creation of a drain, the input of the properties of the drain is required. This option is only relevant for consolidation analysis, groundwater flow calculations or fully coupled analysis. In such calculations, the pore pressure in all nodes of the drain is reduced such that it is equivalent to the given head. If the drain is a Normal drain, pore pressures lower than the equivalent to the given head are not affected by the drain. If the
drain is a *Vacuum* drain, the *Head* parameter can be used to define an 'underpressure' in the ground, equivalent to the process of vacuum consolidation. Drains can be activated or de-activated in calculation phases. The properties of a drain can be modified in the *Object explorers* (Figure 102 (on page 143)).

The input required for a drain depends on the option selected in the *Behaviour* drop-down menu. The options available are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>When the <em>Normal</em> option is selected for the drain behaviour, the input of a groundwater head (h) is required. This option is only relevant for groundwater flow calculations or fully coupled analysis. In such calculations, the pore pressure in all nodes of the drain is reduced such that it is equivalent to the given head. Pore pressures lower than the equivalent to the given head are not affected by the drain. In consolidation analysis, drains reduce the excess pore pressure to zero and the specified head is ignored.</td>
</tr>
<tr>
<td>Vacuum</td>
<td>When the <em>Vacuum</em> option is selected for the drain behaviour, the input of a groundwater head (h) is required. The <em>Head</em> should be used to define the 'underpressure' in the ground due to the process of vacuum consolidation. This option is only relevant for consolidation analysis, groundwater flow calculations or fully coupled analysis. In such calculations, the pore pressure in all nodes of the drain is reduced such that it is equivalent to the given head. Note that in contrast to <em>Normal</em> drains, pore pressures lower than the equivalent to the given head ARE affected by the <em>Vacuum</em> drain.</td>
</tr>
</tbody>
</table>

![Figure 102: Normal drain definition in the Selection explorer](image)

Drains can be activated or de-activated in calculation phases. The properties of a drain can be modified in the *Object explorers*.

### 5.9.3 Groundwater flow boundary conditions

In order to define a flow boundary condition, the *Create groundwater flow bc* option should be selected from the menu appearing as the *Create hydraulic conditions* button is clicked. The creation of a flow boundary condition in the geometry model is similar to the creation of a line (Create line (on page 72)).
The behaviour of the flow boundary conditions can be specified by selecting the corresponding option in the *Selection explorer* (Figure 103 (on page 144)).

![Selection explorer (Figure 103) Options for the behaviour of Groundwater flow boundary conditions](image)

*Figure 103: Options for the behaviour of Groundwater flow boundary conditions*

**Note:**

- The boundary conditions at the extremities of the model can be conveniently specified in the *Model conditions* subtree in the *Model explorer*. By default the bottom of the model is set to *Closed*, preventing flow across it, whereas the three remaining boundaries are set to *Open* (*Seepage*).
- In a calculation phase the hydraulic conditions defined using the *Flow boundary conditions* feature always prevail over the *Model conditions*. As an example, if a flow boundary conditions is placed on the top boundary and precipitation is specified in *Model conditions* only the behaviour specified for the flow boundary condition will be considered, ignoring the precipitation.
- In a fully coupled analysis the water conditions assigned in any internal geometry are taken into account at the calculation step 0 (i.e beginning of the calculation). In the subsequent calculation steps, PLAXIS ignores the specified water conditions settings and performs the flow calculation based on the outcome of the previous step.
- The *Closed* condition is always applicable only on the external boundaries of the model. If a *Closed* condition is applied on an internal geometry, PLAXIS 2D ignores it.

### 5.9.3.1 Seepage

A *Seepage* boundary is a boundary where water can flow in or out freely. It is generally used at the ground surface above the phreatic level or above the external water level (in the case of an inclined line, such as a dam or a dike).

If a flow boundary is set to *Seepage* and is completely above the (external) water level, then the seepage condition applies to this boundary. This means that water inside the geometry may flow freely out of this boundary.
If a boundary is *Seepage* and completely below the (external) water level, the free boundary condition automatically turns into a groundwater head condition. In that case the magnitude of the groundwater head in each boundary node is determined by the vertical distance between the boundary node and the water level.

The pore pressure is zero where a (external) water level crosses a geometry boundary line. The part of the geometry above the transition line is treated as a boundary above the water level, whereas the part of the geometry below the transition line is treated as a boundary below the water level. Hence, different conditions can apply to such a geometry boundary. This is possible because, in general, a geometry boundary consists of many nodes and the actual information on boundary conditions as used by the calculation program is contained in the boundary nodes rather than in geometry lines.

**Note:** Note that a boundary that is explicitly set to *Seepage* will NOT automatically turn into an *Infiltration* boundary when precipitation is specified.

### 5.9.3.2 Closed

When the *Closed* option is assigned to a boundary, no flow can occur across it. Flow, in this case, refers to groundwater flow (in groundwater flow calculations and fully coupled flow-deformation analysis) as well as dissipation of excess pore pressure (in consolidation calculations).

**Note:** The *Closed* condition is always applicable only on the external boundaries of the model. In case it’s required an impermeable line inside the soil (e.g. the cut-off of a dam), an appropriate interface element should be inserted.

### 5.9.3.3 Head

In addition to the automatic setting of hydraulic conditions based on the general phreatic level in *Model conditions* (*Flow boundary conditions* [ADV] (on page 376)), a prescribed groundwater head may be entered manually to the *Groundwater flow boundary conditions* defined by the user in the model. If a groundwater head is prescribed at an outer geometry boundary, external water pressures will be generated for that boundary. The deformation analysis program will treat external water pressures as traction loads and they are taken into account together with the soil weight and the pore pressures. Figure 104 (on page 146) shows the options available for the definition of head in *Object explorers*.

The options available for variation of head along the boundary are:

<table>
<thead>
<tr>
<th>Uniform</th>
<th>A uniform value of the head ((h_{ref})) is specified along the boundary.</th>
</tr>
</thead>
</table>
| Vertical increment | A vertical increment of the head along the boundary is specified. The parameters required to specify a vertical increment variation are:  
  - \(h_{ref}\): The reference head value at the specified reference level.  
  - \(h_{inc,y}\): Increment value specifying the change of the head with depth.  
  - \(y_{ref}\): The reference value for which the reference head value is specified. If this value is lower than the top of the boundary, the head value below this level is changed according to the \(h_{inc,y}\) value \((h = h_{ref} + y_{ref} \cdot y \cdot h_{inc,y})\). |
### Horizontal Increment

A horizontal increment of the head along the boundary is specified. The parameters required to specify a horizontal increment variation are:

- $h_{ref}$: The reference head value at the specified reference level.
- $h_{inc,x}$: Increment value specifying the change of the head with depth.
- $x_{ref}$: The reference value for which the reference head value is specified. If this value is lower than the leftmost point of the boundary, the head value right from this level is changed according to the $h_{inc,x}$ value.

### Start/End Values

A specific start and end value is given along the boundary. The parameters required to specify such a variation are:

- $h_{ref,start}$: The start value for the boundary condition.
- $h_{ref,end}$: The end value for the boundary condition.

![Selection explorer](image)

*Figure 104: Head definition in the Selection explorer*

The options available for *Time dependency of Head* assigned to a line flow boundary condition are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Constant</strong></td>
<td>The head in the boundary does not change with time.</td>
</tr>
<tr>
<td><strong>Time dependent</strong></td>
<td>The head in the boundary varies with time. This option is only available for transient flow and fully coupled flow-deformation analysis. The flow function representing the time dependency can be selected from the drop-down menu. Information on Flow functions is available in Flow functions [ULT] (on page 150).</td>
</tr>
</tbody>
</table>

#### 5.9.3.4 Inflow

Inflow to the model through a boundary can be specified by selecting the corresponding Behaviour option in the Selection explorer. *Figure 105* (on page 147) shows the options available for the definition of inflow.

The options available for the distribution of the inflow discharge along the boundary are:
Uniform

A uniform value of the discharge (|q_{ref}|) is specified along the boundary.

Vertical increment

A vertical increment of the discharge along the boundary is specified. The parameters required to specify a vertical increment variation are:

- |q_{ref}|: The reference discharge value at the specified reference level in the unit of volume per unit of time per unit of width in the out-of-plane direction.
- q_{inc,y}: Increment value specifying the rate of variation of discharge along the boundary.
- y_{ref}: The reference value for which the reference discharge value is specified. If this value is lower than the top of the boundary, the discharge value below this level is changed according to the |q_{inc,y}| value.

Horizontal increment

A horizontal increment of the head along the boundary is specified. The parameters required to specify a horizontal increment variation are:

- |q_{ref}|: The reference discharge value at the specified reference level in the unit of volume per unit of time per unit of width in the out-of-plane direction.
- q_{inc,x}: Increment value specifying the rate of variation of discharge along the boundary.
- x_{ref}: The reference value for which the reference discharge value is specified. If this value is lower than the leftmost point of the boundary, the discharge value right from this level is changed according to the |q_{inc,x}| value.

Start/end values

A specific start and end value is given along the boundary. The parameters required to specify such a variation are:

- q_{ref,start}: The start value for the boundary condition.
- q_{ref,end}: The end value for the boundary condition.

---

Figure 105: Inflow definition in the Selection explorer
The options available for *Time dependency* of the discharge are:

<table>
<thead>
<tr>
<th>Constant</th>
<th>The discharge does not change with time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time dependent [ULT]</td>
<td>The discharge in the boundary varies with time. This option is only available for transient flow and fully coupled flow-deformation analysis. The flow function representing the time dependency can be selected from the drop-down menu. Information on <em>Flow functions</em> is available in <em>Flow functions [ULT]</em> (on page 150).</td>
</tr>
</tbody>
</table>

### 5.9.3.5 Outflow

Outflow from the model through a boundary can be specified by selecting the corresponding option for *Behaviour* in the *Selection explorer* [Figure 106](on page 149).

The options available for the distribution of the outflow discharge along the boundary are:

| Uniform | A uniform value of the discharge is specified along the boundary. The value is assigned to the \( |q_{\text{ref}}| \) parameter. |
|----------|-------------------------------------------------|
| Vertical increment | A vertical increment of the discharge along the boundary is specified. The parameters required to specify a vertical increment variation are:
  * \( |q_{\text{ref}}| \): The reference discharge value at the specified reference level in the unit of volume per unit of time per unit of width in the out-of-plane direction.
  * \( q_{\text{inc,y}} \): Increment value specifying the rate of variation of discharge along the boundary.
  * \( y_{\text{ref}} \): The reference value for which the reference discharge value is specified. If this value is lower than the top of the boundary, the discharge value below this level is changed according to the \( |q_{\text{inc,y}}| \) value. |
| Horizontal increment | A horizontal increment of the head along the boundary is specified. The parameters required to specify a horizontal increment variation are:
  * \( |q_{\text{ref}}| \): The reference discharge value at the specified reference level in the unit of volume per unit of time per unit of width in the out-of-plane direction.
  * \( q_{\text{inc,x}} \): Increment value specifying the rate of variation of discharge along the boundary.
  * \( x_{\text{ref}} \): The reference value for which the reference discharge value is specified. If this value is lower than the leftmost point of the boundary, the discharge value right from this level is changed according to the \( |q_{\text{inc,x}}| \) value. |
| Start/end values | A specific start and end value is given along the boundary. The parameters required to specify such a variation are:
  * \( q_{\text{ref,start}} \): The start value for the boundary condition.
  * \( q_{\text{ref,end}} \): The end value for the boundary condition. |
5.9.3.6 Infiltration

Apart from the automatic generation of infiltration boundary conditions from precipitation ([Flow boundary conditions [ADV] (on page 376)), infiltration conditions may also be specified manually for geometry boundaries above the water level. Infiltration boundary condition is a conditional inflow. The parameters required for an infiltration boundary are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$q$</td>
<td>Recharge (infiltration), specified in the unit of length per unit of time. Negative values can be used to model evapotranspiration (evaporation + transpiration).</td>
</tr>
<tr>
<td>$\psi_{\text{max}}$</td>
<td>Maximum pore pressure head, relative to the elevation of the boundary, specified in the unit of length (default 0.1 length units).</td>
</tr>
<tr>
<td>$\psi_{\text{min}}$</td>
<td>Minimum pore pressure head, relative to the elevation of the boundary, specified in the unit of length (default -1.0 length units).</td>
</tr>
</tbody>
</table>

The options available for variation of discharge with time ($Time dependency$) are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>The head in the boundary does not change with time</td>
</tr>
</tbody>
</table>

[Flow functions [ULT] (on page 150).]
Time dependent
[ULT]

The discharge in the boundary varies with time. This option is only available for transient flow and fully coupled flow-deformation analysis. The flow function representing the time dependency can be selected from the drop-down menu. Information on Flow functions is available in Flow functions [ULT] (on page 150).

Note: Note that a negative value of infiltration represents Evaporation.

5.10 Flow functions [ULT]

Flow functions describing the variation with time of quantities such as Head and Discharge can be defined in the corresponding subtree under the Attributes library in the Model explorer (see Figure 108 (on page 150)).

Flow functions can be assigned to Water levels or Groundwater flow boundary conditions. Note that time-dependent conditions can be defined for all behaviour options except for Seepage and Closed.
Flow functions cannot be assigned to non-horizontal water levels.

Functions can be defined in the corresponding window that pops up when the Flow functions subtree is right-clicked and the Edit option is selected in the appearing menu. The window consists of two tabsheets, i.e Head functions and Discharge functions, where the functions applicable to head and discharge can be defined respectively as shown in Figure 109 (on page 151).

![Flow functions window](image)

Figure 109: Flow functions window

The buttons available under the function tabs can be used to add new functions or to delete the function selected in the list. When a new function is added, the options to define it are displayed.

<table>
<thead>
<tr>
<th>Name</th>
<th>The name of the flow function can be defined.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>The type of the signal can be assigned, The options available are Linear, Harmonic and Table.</td>
</tr>
</tbody>
</table>

The options available in the Signal drop-down menu are described in the following sections.

### 5.10.1 Harmonic

This option can be used when a condition varies harmonically in time. The harmonic variation of the water level is generally described as:

\[
y(t) = y_0 + A \sin(\omega_0 t + \phi_0) \quad \text{with} \quad \omega_0 = \frac{2\pi}{T} \quad \text{Eq. [3]}
\]

in which \(A\) is the amplitude (in unit of length), \(T\) is the wave period (in unit of time) and \(\phi_0\) is the initial phase angle. \(y_0\) is the centre of the harmonic variation, not necessarily equal to the water level at the end of the previous phase \((y'_0)\). In fact the later is equal to:
\[ y' = y_0 + A \sin (\omega t) \quad \text{Eq. [4]} \]

Figure 110 (on page 152) shows the Flow functions window where a Harmonic signal is defined and plotted.

![Figure 110: Definition and display of a Harmonic signal in the Flow functions window](image)

5.10.2 Signal from table

Besides a harmonic signal there is also the possibility to define a signal by specifying the values in the table that appears when the corresponding option is selected in the Signal drop-down menu. The table consists of Time and Head columns. The buttons in the toolbar can be used to modify the table.

- Click the Add row button in the toolbar to add a new row in the table.
- Click the Insert button to insert a new row before the selected row in the table.
- Click the Delete button to delete the selected row in the table.

The values can be defined by clicking the cell in the table and by typing the value.

Importing data for signals

Besides defining the signal in the table, there is also the possibility to read data from a file with a digitised signal using the Open button in the toolbar.

Note: PLAXIS 2D assumes the data file is located in the current project directory when no directory is specified.
A signal, either defined in a table or received from a file and modified, can be saved using the Save button in the toolbar enabling the usage of the signal in other projects or validating the effect of the modifications in the current project.

A signal, either defined in a table or received from a file and modified, can be copied using the Copy button in the toolbar.

Copied data from other applications (using Ctrl+c) can be imported by using the Paste button. The Import data window appears (Figure 111 (on page 153)). The starting row of the data to be imported can be defined in the From row cell. The data and the plot is displayed in the Flow functions window after pressing OK.

![Import data window](image)

**Figure 111: Import data window for flow functions**

Clicking the Open .txt file button on the right hand side of the window will open the Open window where the file can be selected. The file must be an ASCII file that can be created with any text editor. For every line a pair of values (actual time and corresponding water level value) must be defined, leaving at least one space between them. Note that PLAXIS 2D only supports the English notation of decimal numbers using a dot. The resulting graph of the input data is shown in the Graph tabsheet of the Time dependent condition window.

### 5.10.3 Linear

This option can be used to describe the increase or decrease of a condition linearly in time. For a linear variation of groundwater head, the input of the following parameters are required:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\Delta\text{Head}$</td>
<td>This parameter, specified in unit of length, represents the increase or decrease of the water level in the time interval for the current calculation phase. Hence, together with the time interval this parameter determines the rate of the water level increase or decrease.</td>
</tr>
<tr>
<td>$t$</td>
<td>This parameter represents the time interval for the calculation phase, expressed in units of time. Note that the time interval specified for a function does not effect the duration of a phase as defined in the Phases window.</td>
</tr>
</tbody>
</table>

For a linear variation of discharge infiltration, inflow or outflow the input of the following parameters are required for the discharge in the corresponding tabsheet:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\Delta\text{Discharge}$</td>
<td>This parameter, specified in unit of volume per unit of time, per unit of width in the out-of-plane direction represents the increase or decrease of the specific discharge in the time interval of the current calculation phase.</td>
</tr>
</tbody>
</table>
Note: The time value in flow functions always refers to the global time in the whole list of calculation phases rather than to the time interval of an individual phase. This means that in a series of consecutive flow calculations each phase will only use its corresponding part of the flow function.

5.10.4 Flow functions in consecutive phases

A flow function can be assigned as an attribute to Groundwater flow boundaries or to Water levels. PLAXIS 2D ensures the continuity of the flow functions in consecutive phases when the corresponding options are selected in the Phase definition modes.

5.10.5 Function continuity for boundaries

Besides the options described in Groundwater flow boundary conditions (on page 143), two new options are added for boundary conditions in the Phase definition mode (Figure 112 (on page 154)). These options are:

<table>
<thead>
<tr>
<th>Constant value from previous phase</th>
<th>The condition of the boundary in the current phase is a continuation of the state reached at the end of the previous phase and it will not change during the calculation of the phase.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain function from the previous phase</td>
<td>The condition of the boundary in the current phase is equal to the state reached in the previous phase. PLAXIS 2D enables continuity of the state at the boundary according to the flow function assigned to the boundary in the previous phase. The accumulated time from the previous phases is used as an offset to enter the flow function for the current phase.</td>
</tr>
</tbody>
</table>

Figure 112: Options for boundary condition behaviour in Phase definition modes

5.10.6 Function continuity for water levels

The continuity of the flow functions assigned to water levels in consecutive phases can be maintained by using the options available in the pop up menu displayed when the water level is right-clicked. These options are:
5.11 Thermal conditions [ADV]

In case temperature (or actually a change in temperature) is of influence on the behaviour of soils or structures (for example thermal expansion or soil freezing), PLAXIS 2D offers the possibility to take thermal effects into account. The calculation of a temperature distribution in the ground is based on thermal calculations (Temperature calculation [ADV] (on page 342)). Since groundwater flow plays an essential role in the transport of heat in the ground, thermal calculations are generally coupled with groundwater flow calculations (thermo-hydraulic (TH) coupling). Moreover, results of coupled steady-state TH calculations may be used to analyse the effects of (changes of) temperature on stress and deformation (semi-coupled TH-M analysis). More generally, PLAXIS 2D allows for fully coupled transient thermo-hydro-mechanical (THM) calculations of problems in which the time-dependent effect of changes of temperature on stress, deformation and groundwater flow are to be taken into account simultaneously.

Thermal calculations require a set of thermal (boundary) conditions to be specified, which can be imposed on the model to define the temperature distribution in the geometry. Thermal conditions may involve cluster-related thermal conditions as well as line-based thermal flow boundary conditions (Thermal flow boundary conditions [ADV] (on page 156)).

The following cluster-related thermal conditions may be defined in terms of Temperature conditions:

<table>
<thead>
<tr>
<th>None</th>
<th>This option shall be used if the temperature distribution in the selected cluster must be obtained from the global temperature distribution (using a reference temperature and an earth gradient) as defined under Thermal Flow in the Model conditions subtree of the Model explorer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-defined</td>
<td>The temperature in the cluster is directly defined on the basis of a reference temperature ( T_{ref} ) at a reference level ( y_{ref} ), and an increment per unit of depth ( T_{inc,y} ).</td>
</tr>
</tbody>
</table>

In addition to the above Temperature conditions, energy conditions may be defined for clusters that act as heat sources. In this case the Energy conditions parameter under Thermal conditions must be set to Source (i.e. a cluster producing energy) or Sink (i.e. a cluster absorbing energy). This allows the heat total flux, \( Q \), to be specified in the unit of power per unit of volume. Optionally, the source can be made time-dependent by setting the Time dependency parameter to Time-dependent. The latter requires a Heat total flux function to be assigned, defined as a Thermal function in the Attributes library of the Model explorer (Thermal functions [ULT] (on page 163)).
Although the input values of thermal conditions are specified in the geometry model, the activation, deactivation or change of values may be considered in the framework of Staged construction (Changing geometry configuration) (on page 379).

**Note:**

- Cluster-related thermal conditions are only taken into account if the Thermal calculation type in the Phases window is set to Steady state thermal flow orTransient thermal flow.
- For calculations that use Steady state thermal flow an Advanced entitlement [ADV] is required, for Transient thermal or fully coupled transient thermo-hydro-mechanical (THM) calculations an Ultimate entitlement [ULT] is necessary.

### 5.11.1 Thermal flow boundary conditions [ADV]

In addition to groundwater flow boundary conditions (which are also required for thermal calculations, because of TH coupling), the creation of thermal flow boundary conditions is similar to the creation of a geometry line. Note that the assignment of thermal conditions is also possible by right-clicking an existing geometry line either in the drawing area or in the Object explorers and selecting the corresponding option in the appearing menu.

For transient thermal flow and fully coupled THM analysis, thermal conditions can be defined as a function of time by setting the Time-dependency parameter to Time-dependent and assigning a thermal function as defined under Thermal function in the Attributes library of the Model explorer (Thermal functions [ULT] (on page 163)).

For line-based thermal flow boundary conditions, the following options are available:

**Closed**

When the Closed option is assigned to a boundary, no heat flux can occur across it. In other words, the boundary is perfectly insulated. This boundary condition is similar to the 'natural' boundary condition. This means that if no thermal boundary condition is applied at a model boundary, or the thermal boundary condition is inactive, then the boundary is a closed thermal boundary. A closed thermal boundary is only taken into account at external model boundaries or at 'internal' boundaries between active and inactive clusters.

**Temperature**

A prescribed Temperature distribution may be entered for the thermal flow boundary in the unit of temperature. The options available for variation of temperature along the boundary are:

<table>
<thead>
<tr>
<th>Uniform</th>
<th>A uniform value of the temperature (T_{\text{ref}}) is specified along the boundary.</th>
</tr>
</thead>
</table>
| **Vertical increment** | A vertical increment of the temperature along the boundary is specified. The parameters required to specify a vertical increment variation are:  
  - \(T_{\text{ref}}\): The reference temperature value at the specified reference level.  
  - \(T_{\text{incy}}\): Increment value specifying the rate of variation of temperature along the boundary.  
  - \(y_{\text{ref}}\): The reference value for which the reference temperature value is specified. If this value is lower than the top of the boundary, the temperature value below this level is changed according to \(T(y) = T_{\text{ref}} + (y-y_{\text{ref}}) T_{\text{incy}}\). |
A horizontal increment of the temperature along the boundary is specified. The parameters required to specify a horizontal increment variation are:

- $T_{\text{ref}}$: The reference temperature value at the specified reference level.
- $T_{\text{inc},x}$: Increment value specifying the rate of variation of temperature along the boundary.
- $x_{\text{ref}}$: The reference value for which the reference temperature value is specified. If this value is lower than the top of the boundary, the temperature value below this level is changed according to $T(x) = T_{\text{ref}} + (x-x_{\text{ref}}) T_{\text{inc},x}$.

A specific start and end value is given along the boundary. The parameters required to specify such a variation are:

- $T_{\text{ref,start}}$: The start value for the boundary condition.
- $T_{\text{ref,end}}$: The end value for the boundary condition.

**Figure 113: Temperature definition in the Selection explorer**

The options available forry dependency of Temperature assigned to a thermal flow boundary condition are:

<table>
<thead>
<tr>
<th>Constant</th>
<th>The temperature in the thermal boundary does not change with time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time dependent [ULT]</td>
<td>The temperature in the thermal boundary varies with time. This option is only available for transient flow and fully coupled flow-deformation analysis. The thermal flow function representing the time dependency can be selected from the drop-down menu.</td>
</tr>
</tbody>
</table>

**Inflow**

A prescribed heat flux into the model may be entered in the unit of power per unit of length per unit of width in the out-of-plane direction. An Inflow boundary may be used as a heater (line source), adding energy to the model.

The options available are:
Modelling loads and structures - Structures mode
Thermal conditions [ADV]

| Uniform | A uniform value of the heat flux ($|q_{ref}|$) is specified along the boundary. |
| --- | --- |
| Vertical increment | A vertical increment of the heat flux along the boundary is specified. The parameters required to specify a vertical increment variation are: |
| • $|q_{ref}|$: The reference heat flux value at the specified reference level in the unit of power per unit of time per unit of width in the out-of-plane direction. |
| • $q_{inc,y}$: Increment value specifying the rate of variation of discharge along the boundary. |
| • $y_{ref}$: The reference value for which the reference temperature value is specified. If this value is lower than the top of the boundary, the heat flux value below this level is changed according to $q(y) = q_{ref} + (y-y_{ref}) q_{inc,y}$. Note that negative values of $q(y)$ are set to zero. |
| Horizontal increment | A horizontal increment of the heat flux along the boundary is specified. The parameters required to specify a horizontal increment variation are: |
| • $|q_{ref}|$: The reference heat flux value at the specified reference level in the unit of power per unit of time per unit of width in the out-of-plane direction. |
| • $q_{inc,x}$: Increment value specifying the rate of variation of heat flux along the boundary. |
| • $x_{ref}$: The reference value for which the reference temperature value is specified. If this value is lower than the top of the boundary, the heat flux value below this level is changed according to $q(x) = q_{ref} + (x-x_{ref}) q_{inc,x}$. Note that negative values of $q(x)$ are set to zero. |
| Start/end values | A specific start and end value is given along the boundary. The parameters required to specify such a variation are: |
| • $q_{ref,start}$: The heat flux start value for the boundary condition. |
| • $q_{ref,end}$: The heat flux end value for the boundary condition. |

![Figure 114: Inflow definition in the Selection explorer](image)

Two options are available for the Time dependency of the heat flux:
**Modelling loads and structures - Structures mode**

**Thermal conditions [ADV]**

<table>
<thead>
<tr>
<th>Constant</th>
<th>The temperature in the thermal boundary does not change with time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time dependent [ULT]</td>
<td>The temperature in the thermal boundary varies with time. This option is only available for transient flow and fully coupled flow-deformation analysis. The thermal flow function representing the time dependency can be selected from the drop-down menu.</td>
</tr>
</tbody>
</table>

**Outflow**

A prescribed heat flux out of the model may be entered in the unit of power per unit of length per unit of width in the out-of-plane direction. An *Outflow* boundary may be used as a cooler (line sink), absorbing energy from the model. The options available are:

| Uniform          | A uniform value of the heat flux (|q_{ref}|) is specified along the boundary. |
|------------------|-----------------------------------------------------------------------------------|
| Vertical increment | A vertical increment of the heat flux along the boundary is specified. The parameters required to specify a vertical increment variation are:  
  • |q_{ref}|: The reference heat flux value at the specified reference level in the unit of power per unit of time per unit of width in the out-of-plane direction.  
  • q_{inc,y}: Increment value specifying the rate of variation of discharge along the boundary.  
  • y_{ref}: The reference value for which the reference temperature value is specified. If this value is lower than the top of the boundary, the heat flux value below this level is changed according to \( q(y) = q_{ref} + (y-y_{ref}) q_{inc,y} \). Note that negative values of \( q(y) \) are set to zero. |
| Horizontal increment | A horizontal increment of the heat flux along the boundary is specified. The parameters required to specify a horizontal increment variation are:  
  • |q_{ref}|: The reference heat flux value at the specified reference level in the unit of power per unit of time per unit of width in the out-of-plane direction.  
  • q_{inc,x}: Increment value specifying the rate of variation of heat flux along the boundary.  
  • x_{ref}: The reference value for which the reference temperature value is specified. If this value is lower than the top of the boundary, the heat flux value below this level is changed according to \( q(x) = q_{ref} + (x-x_{ref}) q_{inc,x} \). Note that negative values of \( q(x) \) are set to zero. |
| Start/end values | A specific start and end value is given along the boundary. The parameters required to specify such a variation are:  
  • q_{ref,start}: The heat flux start value for the boundary condition.  
  • q_{ref,end}: The heat flux end value for the boundary condition. |
Two options are available for the *Time dependency* of the heat flux:

<table>
<thead>
<tr>
<th><strong>Constant</strong></th>
<th>The outflow in the thermal boundary does not change with time.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time dependent [ULT]</strong></td>
<td>The outflow in the thermal boundary varies with time. This option is only available for transient flow and fully coupled flow-deformation analysis. The thermal flow function representing the time dependency can be selected from the drop-down menu.</td>
</tr>
</tbody>
</table>

**Convection**

A *Convection* thermal boundary is a convective boundary at which a medium (denoted as a ‘fluid’) with a certain temperature, $T_{\text{fluid}}$, is present, whilst the medium transfers its temperature on to that boundary (i.e. the adjacent material).

Examples where *Convection* boundaries may be applied are:

- At the ground surface, the air temperature influences the temperature of the ground, but the ground surface temperature is not necessarily equal to the air temperature. This situation may be conveniently modelled using the *Climate* condition in the *Model conditions* tree in the *Model explorer*, but the actual boundary condition at the ground surface in this case is a *Convection* boundary condition.
- Another example is a freeze pipe or a borehole heat exchanger in which a refrigerant fluid transfers its temperature on to the surrounding soil. In such cases the ‘boundary’ is inside the model. Hence, a *Convection* boundary may be applied at a ‘real’ geometry boundary as well as at a geometry line inside the model.

In addition to the temperature of the medium, $T_{\text{fluid}}$ (expressed in the unit of temperature), a heat transfer coefficient (the inverse of thermal resistance) is required. The transfer coefficient is entered in the unit of power per unit of length per unit of width in the out-of-plane direction per unit of temperature. The higher the transfer coefficient, the more heat is transferred from the medium at the boundary on to that boundary. If the transfer coefficient is zero, no heat is transferred on to the boundary, which means that the boundary condition is inactive. If the transfer coefficient would be infinite, the *Convection* boundary condition would be equivalent to a *Temperature* boundary condition.
Two options are available for the Time dependency of $T_{\text{fluid}}$.

<table>
<thead>
<tr>
<th>Constant</th>
<th>The convection in the thermal boundary does not change with time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time dependent [ULT]</td>
<td>The convection in the thermal boundary varies with time. This option is only available for transient flow and fully coupled flow-deformation analysis. The thermal flow function representing the time dependency can be selected from the drop-down menu.</td>
</tr>
</tbody>
</table>

**Thermosyphons**

Thermosyphons boundary condition, like Convection boundary condition, requires a heat transfer coefficient and the temperature of the medium, $T_{\text{fluid}}$ (which is the air temperature for Thermosyphons). Unlike Convection boundary condition, Thermosyphons stops working and becomes a closed boundary when:

- The air temperature is higher than a limit $T_{\text{fluid,max}}$.
- The difference between the air temperature and ground temperature is smaller than the threshold value $\Delta T$.

Thermosyphons may be applied to model the irreversible heat exchange between ground and thermosyphon systems at their boundary. Thermosyphon systems are passive refrigeration devices helping to maintain frozen ground states (permafrost) to support buildings, pipelines, railroad embankments and highways. They are charged with a working fluid circulating due to the natural convection. In the winter, the ground temperature is higher than the air temperature, so the fluid at the base of thermosyphons is heated, vaporises and moves upward to a radiator. There, the fluid is cooled down by the colder air, condenses and moves downward. This loop transfers heat from the ground to the air as long as appropriate temperature difference prevails; otherwise, the system stops working. Therefore, the cycling ceases in the summer and the permafrost is preserved.
Two options are available for the *Time dependency* of $T_{\text{fluid,max}}$ and the heat transfer coefficient:

<table>
<thead>
<tr>
<th><strong>Constant</strong></th>
<th>The convection in the thermal boundary does not change with time.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time dependent [ULT]</strong></td>
<td>The convection in the thermal boundary varies with time. This option is only available for transient flow and fully coupled flow-deformation analysis. The thermal flow function representing the time dependency can be selected from the drop-down menu.</td>
</tr>
</tbody>
</table>

**Note:** The thermal flow boundary conditions are visualised in the *Flow conditions* mode. Before starting a thermal calculation it is good practice to visually check the applied conditions by selecting the *Flow conditions* mode.

**Constant value from previous phase**

Although this option is always available, it may be selected particularly in the case that the previous calculation phase (parent phase) was a transient heat flow calculation or a fully coupled THM calculation, and the condition at the boundary to be considered was defined using a *Thermal function*. When selected, the heat flow boundary condition is defined as a constant (time independent) condition based on the conditions at the *end of the parent phase* (considering the assigned *Thermal function* and the time interval of the parent phase). If the previous phase was time independent (time interval of 0) or the boundary condition was constant, it will simply adopt the boundary condition from the previous phase. If the boundary condition was inactive in the previous phase, it remains inactive in the current phase, which means that the boundary is closed (zero flux across the boundary).
Maintain function from previous phase

Although this option is always available, it may be selected particularly in the case that the previous calculation phase (parent phase) was a transient heat flow calculation or a fully coupled THM calculation, and the condition at the boundary to be considered was defined using a Thermal function. When selected, the heat flow boundary condition is defined as a time-dependent condition, following the Thermal function (Temperature function, Heat flux function, or Heat total flux function) as defined in the parent phase. In this case, the Thermal function is entered at the start time of the current phase (= reached end time of parent phase).

If the previous phase was time independent (time interval of 0) or the boundary condition was constant, it will simply adopt the boundary condition from the previous phase. If the boundary condition was inactive in the previous phase, it remains inactive in the current phase, which means that the boundary is closed (zero flux across the boundary).

5.12 Thermal functions [ULT]

Thermal functions describing the variation with time of quantities such as Temperature and Heat flux can be defined in the corresponding subtree under the Attributes library in the Model explorer (Figure 120 (on page 164)).
Thermal functions can be assigned to Thermal flow boundary conditions or Soil clusters. Note that time-dependent conditions can be defined for Temperature, Inflow, Outflow and Convection. In the latter case, the time-dependency is applied on the medium that causes the thermal convection (fluid, air) (Thermal flow boundary conditions [ADV] (on page 156)). Functions can be defined in the corresponding window that pops up when the Thermal functions subtree is right-clicked and the Edit option is selected in the appearing menu. The window consists of three tabsheets: i.e. Temperature functions, Heat flux functions and Heat total flux functions. Here, the functions applicable to temperature, heat flux and total heat flux can be defined, respectively (Figure 121 (on page 164)).
A Temperature function can be assigned to thermal flow boundary conditions as well as to the air temperature as defined in the Climate model condition under the Model conditions subtree. Temperature is defined in the unit of Temperature.

A Heat flux function can be assigned to line-based thermal flow boundary conditions. Heat flux is defined in the unit of power per unit of length (along the boundary line) per unit of width in the out-of-plane direction. A Heat total flux function can be assigned to soil clusters in which the energy condition under Thermal condition is set to Source or Sink. Heat total flux is defined in the unit of power per unit of volume. The definition of Thermal functions is similar as the definition of Flow functions (Flow functions [ULT] (on page 150)).

5.12.1 Harmonic

This option can be used when a condition varies harmonically in time. The harmonic variation of the water level is generally described as:

\[ y(t) = y_0 + A \sin(\omega_0 t + \phi_0) \quad \text{with} \quad \omega_0 = \frac{2\pi}{T} \quad \text{Eq. [5]} \]

in which \( A \) is the amplitude (in unit of length), \( T \) is the wave period (in unit of time) and \( \phi_0 \) is the initial phase angle. \( y_0 \) is the centre of the harmonic variation, not necessarily equal to the water level at the end of the previous phase (\( y'_0 \)). In fact the later is equal to:

\[ y'_0 = y_0 + A \sin(\omega_0) \quad \text{Eq. [6]} \]

Figure 122 (on page 165) shows the Thermal functions window where a Harmonic signal is defined and plotted.
Besides a harmonic signal there is also the possibility to define a signal by specifying the values in the table that appears when the corresponding option is selected in the Signal drop-down menu. The table consists of Time and Temperature columns. The buttons in the toolbar can be used to modify the table.

- Click the Add row button in the toolbar to add a new row in the table.
- Click the Insert button to insert a new row before the selected row in the table.
- Click the Delete button to delete the selected row in the table.

The values can be defined by clicking the cell in the table and by typing the value.

### 5.12.2 Importing data for signals

Besides defining the signal in the table, there is also the possibility to read data from a file with a digitised signal using the Open button in the toolbar.

**Note:** PLAXIS 2D assumes the data file is located in the current project directory when no directory is specified.

A signal, either defined in a table or received from a file and modified, can be saved using the Save button in the toolbar enabling the usage of the signal in other projects or validating the effect of the modifications in the current project.

A signal, either defined in a table or received from a file and modified, can be copied using the Copy button in the toolbar.

Copied data from other applications (using Ctrl+c) can be imported by using the Paste button. The Import data window appears (Figure 123 (on page 167)). The starting row of the data to be imported can be defined in the From row cell. The data and the plot is displayed in the Thermal functions window after pressing OK.
Figure 123: **Import data** window for Thermal functions

Clicking the *Open .txt file* button on the right hand side of the window will open the *Open* window where the file can be selected. The file must be an ASCII file that can be created with any text editor. For every line a pair of values (actual time and corresponding water level value) must be defined, leaving at least one space between them. Note that PLAXIS 2D only supports the English notation of decimal numbers using a dot. The resulting graph of the input data is shown in the *Graph* tabsheet of the *Time dependent condition* window.

### 5.12.3 Linear

This option can be used to describe the increase or decrease of a condition linearly in time. For a linear variation of groundwater Temperature, the input of the following parameters are required:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Δ Temperature</td>
<td>This parameter, specified in unit of temperature, represents the increase or decrease of the temperature in the time interval for the current calculation phase. Hence, together with the time interval this parameter determines the rate of the temperature increase or decrease.</td>
</tr>
<tr>
<td>Time</td>
<td>This parameter represents the time interval for the calculation phase, expressed in unit of time. Note that the time interval specified for a function does not effect the duration of a phase as defined in the <em>Phases</em> window.</td>
</tr>
</tbody>
</table>
For a linear variation of inflow or outflow the input of the following parameters are required for the heat flux and total heat flux in the corresponding tabsheet:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\Delta \text{HeatFlux}$</td>
<td>This parameter, specified in unit of power per unit of area. It represents the increase or decrease of the flux in the time.</td>
</tr>
<tr>
<td>$\Delta \text{HeatTotalFlux}$</td>
<td>This parameter, specified in unit of power per unit of volume. It represents the increase or decrease of the flux with time.</td>
</tr>
</tbody>
</table>

**Note:** The time value in thermal functions always refers to the local time interval of each phase. This means that the time in these functions is always reset to zero at the beginning of each phase which is using them.
6

Material properties and material database

In PLAXIS 2D, soil properties and material properties of structures are stored in material data sets. There are seven different types of material sets grouped as data sets for:

- Soil and interfaces
- Discontinuities
- Plates
- Geogrids
- Embedded beams
- Cables
- Anchors

All data sets are stored in the material database. From the database, the data sets can be assigned to the soil clusters or to the corresponding structural objects in the geometry model.

The material database can be opened by:

1. Selecting the option *Show materials* in the *Soil* menu of the *Soil mode* or in the *Structures* menu of the *Structures mode*.
2. Clicking on the *Show materials* button available in the *Soil, Structures* and *Staged construction* modes.

As a result, the *Material sets* window appears showing:

1. The contents of the *Project materials* database.
2. The window can be expanded to show the *Global materials* database by clicking the *Show global* button in the upper part of the window.

The *Material sets* window displaying the material defined in the current project and the ones available in a selected global database is shown in *Figure 124* (on page 170).
The database of a new project is empty. The global database can be used to store material data sets in a global folder and to exchange data sets between different projects.

At both sides of the window (Project materials and Global materials) there are two drop-down menus and a tree view. The Set type can be selected from the drop-down menu on the left hand side. The Set type parameter determines which type of material data set is displayed in the tree view (Soil and interfaces, Discontinuities, Plates, Geogrids, Embedded beams, Cables and Anchors).

The data sets in the tree view are identified by a user-defined name. The data sets for Soil and interfaces can be ordered in groups according to the material model, the material type or the name of the data set by selecting this order in the Group order drop-down menu. The None option can be used to discard the group ordering.

The small buttons between the two tree views can be used to copy individual data sets from the project database to the selected global database or vice versa.

- To copy the selected project material set to the global database.
- To copy all the project material sets of the specified type to the global database.
- To copy the selected global material set to the project database.

The location of the selected global database is shown below its tree view. The buttons below the tree view of the global database enable actions in the global database.

Figure 124: Material sets window showing the project and the global database
Material properties and material database

<table>
<thead>
<tr>
<th>Select</th>
<th>To select an existing global database.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>To delete a selected material data set from the selected global database.</td>
</tr>
</tbody>
</table>

By default, created data sets in the **Global databases** materials are stored in a location that can be defined by the user and in different files as follows:

- **Soil and interface** materials will be contained in a file named by default as `Soil.matXdb'`. This file is compatible with other PLAXIS 2D database files for Soil and interface.
- Material data sets for structural elements such as **Discontinuities**, **Plates**, **Geogrids**, **Embedded beams**, **Cables** and **Anchors** will be contained in separate files. Respectively, the default name for these materials will be 'Discontinuity.matXdb', 'Plate.matXdb', 'Geogrid.matXdb', 'EmbeddedBeam.matXdb', 'Cable.matXdb', and 'Anchor.matXdb'.

**Note:**
- A new global database can be created by clicking the **Select** button, defining the name of the new global database and clicking **Open**.

The project data base can be managed using the buttons below the tree view of the project database.

<table>
<thead>
<tr>
<th>New</th>
<th>To create a new data set in the project. As a result, a new window appears in which the material properties or model parameters can be entered. The first item to be entered is always the <strong>Identification</strong>, which is the user-defined name of the data set. After completing a data set, it will appear in the tree view, indicated by its name as defined by the <strong>Identification</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>To modify the selected data set in the project material database.</td>
</tr>
<tr>
<td>SoilTest</td>
<td>To perform standard soil lab tests. A separate window will open where several basic soil tests can be simulated and the behaviour of the selected soil material model with the given material parameters can be checked (Simulation of soil lab tests [GSE] on page 553)).</td>
</tr>
<tr>
<td>Copy</td>
<td>To create a copy of a selected data set in the project material database.</td>
</tr>
<tr>
<td>Delete</td>
<td>To delete a selected material data set from the project material database.</td>
</tr>
<tr>
<td>Discard</td>
<td>To revert the changes and fire a command when clicked.</td>
</tr>
</tbody>
</table>

**Note:**
In a **Material dataset** window (Material properties and material database (on page 169)) it is possible to go through the options with arrows and/or Enter. When a property such as **Material model** or **Drainage type**, is reached, the drop-down menu can be activated by pressing the **Space** key. Arrows and/or letters can be used to make a selection, that is finalised by pressing Enter.

Each Soil and structural element material of the database contains the parameters characterizing the material. To prevent an invalid definition of the material properties a **Feedback side panel** is included as displayed in Figure 125 (on page 172). Three types of feedback messages are possible:
Errors: the parameter value or combination of parameter values must be changed, otherwise the material set could be invalid and calculation of the project will be blocked.

Warnings: the parameter value seems to deviate from a recommended parameter value or parameter range. Generally the material set will not be considered invalid and calculating the project will not be blocked. The chosen parameter could however cause unexpected results.

Hints: the entered parameter can be defined under certain circumstances or options.

6.1 Modelling soil and interface behaviour

The material properties and model parameters for soil clusters are entered in material data sets Figure 126 (on page 173). The properties in the data sets are divided into six tabsheets: General, Mechanical, Groundwater, Thermal, Interfaces and Initial.

6.1.1 General tabsheet

The General tabsheet contains the type of soil model, the drainage type and the general soil properties such as unit weights. Several data sets may be created to distinguish between different soil layers. A user may specify
any identification title for a data set in the **General** tabsheet of the **Soil** window. It is advisable to use a meaningful name since the data set will appear in the database tree view by its identification.

For easy recognition in the model, a colour is given to a certain data set. This colour also appears in the database tree view. PLAXIS 2D selects a unique default colour for a data set, but this colour may be changed by the user. Changing the colour can be done by clicking on the colour box in the **General** tabsheet.

![General tabsheet of the Soil window](image)

**Figure 126: General tabsheet of the Soil window**

### 6.1.1.1 Material model

Soil and rock tend to behave in a highly non-linear way under load. This non-linear stress-strain behaviour can be modelled at several levels of sophistication. Clearly, the number of model parameters increases with the level of sophistication. PLAXIS 2D supports different models to simulate the behaviour of soil and other continua. The models and their parameters are described in detail in the Material Models Manual. A short discussion of the available models is given below:

**Linear elastic model:** This model represents Hooke's law of isotropic linear elasticity. The linear elastic model is too limited for the simulation of soil behaviour. It is primarily used for stiff structures in the soil.

**Mohr-Coulomb model (MC):** This well-known linear elastic perfectly-plastic model is used as a first approximation of soil behaviour in general. It is recommended to use this model for a first analysis of the problem considered. A constant average stiffness is estimated for the soil layer. Due to this constant stiffness, computations tend to be relatively fast and a first estimate of deformations can be obtained.

**Hardening Soil model (HS):** This is an advanced model for the simulation of soil behaviour. The Hardening Soil model is an elastoplastic type of hyperbolic model, formulated in the framework of shear hardening plasticity. Moreover, the model involves compression hardening to simulate irreversible compaction of soil under primary
compression. This second-order model can be used to simulate the behaviour of sands and gravel as well as softer types of soil such as clays and silts.

**Hardening Soil model with small-strain stiffness (HSsmall):** This is an elastoplastic type of hyperbolic model, similar to the Hardening Soil model. Moreover, this model incorporates strain dependent stiffness moduli, simulating the different reaction of soils from small strains (for example vibrations with strain levels below $10^{-5}$) to large strains (engineering strain levels above $10^{-3}$).

**Modified Cam-Clay model (MCC):** This well-known critical state model can be used to simulate the behaviour of normally consolidated soft soils. The model assumes a logarithmic relationship between the void ratio and the mean effective stress.

**Hoek-Brown model (HB):** This well-known elastic perfectly-plastic model is used to simulate the isotropic behaviour of rock. A constant stiffness is used for the rock mass. Shear failure and tension failure are described by a non-linear strength curve.

**Jointed Rock model (JR):** This is an anisotropic elastic-perfectly plastic model where plastic shearing can only occur in a limited number of shearing directions. This model can be used to simulate the anisotropic behaviour of stratified or jointed rock.

**NGI-ADP model (NGI-ADP):** The NGI-ADP model may be used for capacity, deformation and soil-structure interaction analysis involving undrained loading of clay-type materials. Distinct anisotropic shear strengths may be defined for different stress paths.

**Soft soil model (SS):** This is a Cam-Clay type model that can be used to simulate the behaviour of soft soils like normally consolidated clays and peat. The model performs best in situations of primary compression.

**Soft Soil Creep model (SSC):** This is a second order model formulated in the framework of viscoplasticity. The model can be used to simulate the time-dependent behaviour of soft soils like normally consolidated clays and peat. The model includes logarithmic primary and secondary compression.

**UDCAM-S:** The UDCAM-S model is a derived NGI-ADP model to deal with undrained soil behaviour and degradation of the strength and stiffness in cyclic loading of clay or very low permeable silty soils. It implements a pre-processing procedure called *Cyclic accumulation and optimisation tool* ([Cyclic accumulation and optimisation tool](#)) to obtain the degraded parameter set based on the type of analysis.

**Sekiguchi-Ohta model (Inviscid):** The Sekiguchi-Ohta model (Inviscid) is a Cam-Clay type effective stress model for time-independent behaviour of clay-type soils.

**Sekiguchi-Ohta model (Viscid):** The Sekiguchi-Ohta model (Viscid) is a Cam-Clay type effective stress model for time-independent behaviour of clay-type soils.

**Concrete model:** The Concrete model is an advanced elastoplastic model for concrete and shotcrete structures. It simulates the time-dependent strength and stiffness of concrete, strain hardening-softening in compression and tension as well as creep and shrinkage. The failure criterion involves a Mohr-Coulomb yield surface for deviatoric loading, which is combined with a Rankine yield surface in the tensile regime.

**UBC3D-PLM:** This is an advanced model for the simulation of liquefaction behaviour in dynamics applications. The model includes accumulation of irreversible strains during cyclic loading. In combination with undrained behaviour it accumulates pore pressures, which may eventually lead to liquefaction.

**User-defined Soil Models (UDSM):** With this option it is possible to use other constitutive models than the standard PLAXIS 2D models. For a detailed description of this facility, reference is made to the Material Models Manual. Links to existing UDSM as well as all models are available on the PLAXIS Knowledge Base.
6.1.1.2 Drainage type

In principle, all model parameters in PLAXIS 2D are meant to represent the effective soil response, i.e. the relationship between the stresses and the strains associated with the soil skeleton. An important feature of soil is the presence of pore water. Pore pressures significantly influence the (time-dependent) soil response. PLAXIS 2D offers several options to enable incorporation of the water-skeleton interaction in the soil response. The most advanced option is a Fully coupled flow-deformation analysis. However, in many cases it is sufficient to analyse either the long-term (drained) response or the short-term (undrained) response without considering the time-dependent development of pore pressures. In the latter case (undrained), excess pore pressures are generated as a result of stress changes (loading or unloading). The dissipation of these excess pore pressures with time can be analysed in a Consolidation calculation.

The simplified water-skeleton interaction, as considered in a Plastic calculation, a Safety analysis or a Dynamics analysis, is defined by the Drainage type parameter. PLAXIS 2D offers a choice of different types of drainage:

**Drained behaviour:** Using this setting no excess pore pressures are generated. This is clearly the case for dry soils and also for full drainage due to a high permeability (sands) and/or a low rate of loading. This option may also be used to simulate long-term soil behaviour without the need to model the precise history of undrained loading and consolidation.

**Undrained behaviour:** This setting is used for saturated soils in cases where pore water cannot freely flow through the soil skeleton. Flow of pore water can sometimes be neglected due to a low permeability (clays) and/or a high rate of loading. All clusters that are specified as undrained will indeed behave undrained, even if the cluster or a part of the cluster is located above the phreatic level.

Distinction is made between three different methods of modelling undrained soil behaviour. Method A is an undrained effective stress analysis with effective stiffness as well as effective strength parameters. This method will give a prediction of the pore pressures and the analysis can be followed by a consolidation analysis. The undrained shear strength ($s_u$) is a consequence of the model rather than an input parameter. It is recommended to check this shear strength with known data. To consider this type of analysis, the Undrained A option should be selected in the Drainage type drop-down menu.

Method B is an undrained effective stress analysis with effective stiffness parameters and undrained strength parameters. The undrained shear strength $s_u$ is an input parameter. This method will give a prediction of pore pressures. However, when followed by a consolidation analysis, the undrained shear strength ($s_u$) is not updated, since this is an input parameter. To consider this type of analysis, the Undrained B option should be selected in the Drainage type drop-down menu.

Method C is an undrained total stress analysis with all parameters undrained. This method will not give a prediction of pore pressures. Therefore it is not useful to perform a consolidation analysis. The undrained shear strength ($s_u$) is an input parameter. To consider this type of analysis, the Undrained C option should be selected in the Drainage type drop-down menu.

More information about modelling undrained behaviour can be found in Modelling undrained behaviour (on page 267) and the Material Models Manual.

**Non-porous behaviour:** Using this setting neither initial nor excess pore pressures will be taken into account in clusters of this type. Applications may be found in the modelling of concrete or structural behaviour. Non-porous behaviour is often used in combination with the Linear elastic model. The input of a saturated weight is not relevant for non-porous materials or intact rock.

In a consolidation analysis or a fully coupled flow-deformation analysis it is the permeability parameter in the Flow tabsheet that determines the drainage capacity of a layer rather than the drainage type. Still, the drainage type has influence on the applied compressibility of water in a consolidation analysis or a fully coupled flow-deformation analysis. For more information see Appendix C.
Material properties and material database
Modelling soil and interface behaviour

Note:
The Drainage type setting is only considered in a Plastic calculation, a Safety analysis or a Dynamics analysis. When a Consolidation analysis, a Fully coupled flow-deformation analysis or a Dynamics with Consolidation analysis is performed, the Drainage type is ignored and the soil response is determined by the Permeability of the material.

6.1.1.3 Unsaturated and saturated weight ($\gamma_{\text{unsat}}$ and $\gamma_{\text{sat}}$)
The unsaturated and the saturated weights, entered as a force per unit volume, refer to the total unit weight of the soil skeleton including the fluid in the pores. The unsaturated weight $\gamma_{\text{unsat}}$ applies to all material above the phreatic level and the saturated unit weight $\gamma_{\text{sat}}$ applies to all material below the phreatic level, where the phreatic level itself is generally defined as the level where the steady-state pore pressure is zero ($p_{\text{steady}} = 0$). Only in the case of a fully coupled flow-deformation analysis, the phreatic level is defined as the level where the current pore water pressure is zero ($p_{\text{water}} = 0$). This means that during a fully coupled flow-deformation analysis the position of the phreatic level and hence the material weight can change.

For non-porous material only the unsaturated weight is relevant, which is just the total unit weight. For porous soils the unsaturated weight is obviously smaller than the saturated weight. For sands, for example, the saturated weight is generally around 20 kN/m$^3$ whereas the unsaturated weight can be significantly lower, depending on the degree of saturation.

Note that soils in practical situations are never completely dry. Hence, it is advisable not to enter the fully dry unit weight for $\gamma_{\text{unsat}}$. For example, clays above the phreatic level may be almost fully saturated due to capillary action. Other zones above the phreatic level may be partially saturated. PLAXIS 2D can deal with partially saturated soil behaviour above the phreatic level. However, the unit weight of soil is always defined here by $\gamma_{\text{unsat}}$ irrespective of the degree-of-saturation.

Weights are activated by means of Gravity loading or $K_0$ procedure in the Calculation mode, which is always the first calculation phase (Initial phase) (see Initial stress generation (on page 318)).

6.1.1.4 Void ratio and porosity
The void ratio, $e$, is related to the porosity, $n$ ($e = n / (1-n)$). This quantity is used in some special options. The initial value $e_{\text{init}}$ is the value in the initial situation. The actual void ratio is calculated in each calculation step from the initial value and the volumetric strain $\Delta\varepsilon_v$. These parameters are used to calculate the change of permeability when input is given for the $c_k$ value (in the Flow tabsheet).

6.1.1.5 Rayleigh damping [ULT]
Material damping in dynamics calculations is caused by the viscous properties of soil, friction and the development of irreversible strains. All plasticity models in PLAXIS 2D can generate irreversible (plastic) strains, and may cause material damping. However, this damping is generally not enough to model the damping characteristics of real soils. For example, most soil models show pure elastic behaviour upon unloading and reloading which does not lead to damping at all. Some models in PLAXIS 2D include viscous behaviour, for instance the Soft Soil Creep model. Using this model in dynamics calculations may lead to viscous damping, but also the Soft Soil Creep model hardly shows any creep strain in load / reload cycles. There are also models in PLAXIS 2D that include hysteretic behaviour in loading / reload cycles, like the Hardening Soil model with small-strain stiffness (Material Models Manual - The Hardening Soil model with small-strain). When using this model, the amount of damping that is obtained depends on the amplitude of the strain cycles. Considering very small
vibrations, even the Hardening Soil model with small-strain stiffness does not show material damping as well as numerical damping, whereas real soils still show a bit of viscous damping. Hence, additional damping is needed to model realistic damping characteristics of soils in dynamics calculations. This can be done by means of Rayleigh damping.

Rayleigh damping is a numerical feature in which a damping matrix $C$ is composed by adding a portion of the mass matrix $M$ and a portion of the stiffness matrix $K$:

$$[C] = \alpha[M] + \beta[K] \quad \text{Eq. [7]}$$

The parameters $\alpha$ and $\beta$ are the Rayleigh coefficients and can be specified in the corresponding cells in the General tabsheet of the Soil window shown in Figure 125 (on page 172).

$\alpha$ is the parameter that determines the influence of mass in the damping of the system. The higher $\alpha$ is, the more the lower frequencies are damped. $\beta$ is the parameter that determines the influence of stiffness in the damping of the system. The higher $\beta$ is, the more the higher frequencies are damped. In PLAXIS 2D, these parameters can be specified for each material data set for soil and interfaces as well as for material data sets for plates. In this way, the (viscous) damping characteristics can be specified for each individual material in the finite element model.

Despite the considerable amount of research work in the field of dynamics, little has been achieved yet for the development of a commonly accepted procedure for damping parameter identification. Instead, for engineering purposes, some measures are made to account for material damping. A commonly used engineering parameter is the damping ratio $\xi$. The damping ratio is defined as $\xi = 1$ for critical damping, i.e. exactly the amount of damping needed to let a single degree-of-freedom system that is released from an initial excitation $u_0$, smoothly stop without rebouncing.

Considering Rayleigh damping, a relationship can be established between the damping ratio $\xi$ and the Rayleigh damping parameters $\alpha$ and $\beta$:

$$\alpha + \beta \omega^2 = 2 \omega \xi \quad \text{and} \quad \omega = 2 \pi f \quad \text{Eq. [8]}$$

where $\omega$ is the angular frequency in rad/s and $f$ is the frequency in Hz (1/s).

$$\alpha = 2 \omega_1 \omega_2 \frac{\omega_1^2 \xi_1 - \omega_2^2 \xi_2}{\omega_1^2 - \omega_2^2} \quad \text{and} \quad \beta = 2 \frac{\omega_1^2 \xi_2 - \omega_2^2 \xi_1}{\omega_1^2 - \omega_2^2} \quad \text{Eq. [9]}$$
For example, when it is desired to have a target damping of 8% at the target frequencies $f = 1.5$ Hz and $8.0$ Hz, the corresponding Rayleigh damping ratios are $\alpha = 1.2698$ and $\beta = 0.002681$. From Figure 128 (on page 178) it can be seen that within the range of frequencies as defined by the target frequencies the damping is less than the target damping, whereas outside this range the damping is more than the target damping.

![Figure 128: Rayleigh damping parameter influence](image)

In order to calibrate the frequencies corresponding to Target 1 ($f_1$) and Target 2 ($f_2$), it is important to maintain an approximately constant damping ratio over a range of relevant frequencies for the geotechnical problem being studied. The damping ratio affects the response of the system to dynamic loading and plays a crucial role in capturing the behaviour of the soil deposit accurately.

To achieve this, the ratio of the two frequencies, $\omega_2/\omega_1$ ($f_2/f_1$), should be in the order of 3 (or less than 3 eventually). This criterion ensures that the damping remains reasonably consistent across the range of frequencies relevant to the problem. If the ratio largely exceeds 3, it could result in a significantly under-damped response in the frequency interval where site effects are more pronounced.

The natural frequency of the soil deposit, $f_1$, can be determined based on its geometry and stiffness. It is related to the shear wave velocity, $v_s$, in the soil deposit through the equation of thickness $H$ is related to its geometry and stiffness according to the following Eq. [10]:

$$f_1 = \frac{v_s}{4H} \quad \text{Eq. [10]}$$

where

$$H = \text{Thickness of the soil deposit.}$$

The shear wave velocity, $v_s$, is a function of the shear stiffness modulus, $G$.

On the other hand, the predominant frequency of the input motion, $f_2$, can be determined from the Fourier spectrum of the input accelerogram. The input motion consists of various frequency components, and the predominant frequency is influenced by both the input frequencies and the natural modes of the system as shown in Figure 129 (on page 179).
If the ratio \( f_2/f_1 \) becomes significantly larger than 3, it implies a large discrepancy between the input frequency and the natural frequency of the soil deposit. This situation can lead to a significant under-damped response in the frequency range where the site effects are more relevant. This becomes especially problematic if Rayleigh damping is the only source of damping considered in the model, without accounting for hysteretic damping (e.g., when using the HS small model).

In such cases, Amorosi, Boldini & Ellia (2010) (on page 586) suggest an alternative procedure. They propose considering the frequency interval characterized by the highest energy content, which can be evaluated by examining the Fourier spectrum at different depths of the soil deposit and the amplification function between the surface and the base level. This procedure helps overcome errors that may arise due to excessively large values of the ratio \( f_2/f_1 \) and provides a more accurate representation of the system's response.

Ultimately, the frequency-domain solution should be available for the 1D site response analysis, one can always identify the two frequencies through an iterative procedure.

It is suggested not to use the simplified Rayleigh formulation, i.e. the small strain viscous damping effects are assumed to be proportional only to the stiffness of the soil deposit:

\[
[C] = \beta[K] \quad (\text{not recommended}) \quad \text{Eq. [11]}
\]

where \( \beta = 2 \xi/\omega_1 \) and \( \omega_1 \) is the angular frequency of the first natural mode of the soil column. It has been noticed that the simplified Rayleigh formulation may lead to an underestimation of the site response, especially when the natural frequency of the soil deposit and the predominant frequency of the input motion are far from each other, resulting in overestimation of damping in the high-frequency range.

When the Rayleigh damping Input method is set to SDOF equivalent, the damping parameters (\( a \) and \( \beta \)) will be automatically calculated by the program when the target damping ratio (\( \xi \)) and the target frequencies (\( f \)) are specified. The panel displayed in the General tabsheet when one of the cells corresponding to the damping parameters is clicked. Figure 130 (on page 180) shows the damping ratio as a function of the frequency.

Alternatively, if the Input method is set to Direct the damping parameters \( a \) and \( \beta \) can be directly specified by the user.
6.1.2 Mechanical tabsheet

The Mechanical tabsheet contains the stiffness and strength parameters of the selected soil model. These parameters depend on the selected soil model as well as on the selected drainage type.

6.1.2.1 Linear Elastic model (LE)

The Mechanical tabsheet for the Linear Elastic model (drained behaviour) is shown in Figure 131 (on page 181).

The model involves two elastic stiffness parameters, namely the effective Young’s modulus $E'$ and the effective Poisson’s ratio $\nu'$.

<table>
<thead>
<tr>
<th>$E'_\text{ref}$</th>
<th>Effective Young’s modulus</th>
<th>[kN/m$^2$]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\nu'$</td>
<td>Effective Poisson’s ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>
During the input for the Linear Elastic model the values of the shear modulus $G$ and the oedometer modulus $E_{oed}$ are presented as auxiliary parameters (alternatives).

<table>
<thead>
<tr>
<th>$G_{ref}$</th>
<th>Shear modulus, where $G = E'/(2(1 + \nu')$ )</th>
<th>[kN/m$^2$]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E_{oed}$</td>
<td>Oedometer modulus, where $E_{oed} = E'(1-\nu')/((1+\nu')(1 - 2\nu'))$</td>
<td>[kN/m$^2$]</td>
</tr>
</tbody>
</table>

**Note:**

- Optional drainage types when the Linear Elastic model is selected are: *Drained, Undrained A, Undrained C,* and *Non-porous.*
- In the case of *Undrained A* or *Non-porous* drainage types, the same parameters are used as for drained behaviour.
- In the case of *Undrained C* drainage type, an undrained Young's modulus ($E_u$) and undrained Poisson's ratio ($\nu_u$) are used.

---

**Figure 131: Mechanical tabsheet for the Linear Elastic model (drained behaviour)**

Note that the alternatives are influenced by the input values of $E'$ and $\nu'$. Entering a particular value for one of the alternatives $G_{ref}$ or $E_{oed}$ results in a change of the Young's modulus $E'_{ref}$.

It is possible for the Linear Elastic model to specify a stiffness that varies linearly with depth. Therefore, the increment of stiffness per unit of depth, $E'_{inc}$, can be defined. Together with the input of $E'_{inc}$ the input of $y_{ref}$ becomes relevant. For any $y$-coordinate above $y_{ref}$ the stiffness is equal to $E'_{ref}$. For any $y$-coordinate below $y_{ref}$ the stiffness is given by:

$$E'(y) = E'_{ref} + (y_{ref} - y)E'_{inc}; \quad y < y_{ref} \quad \text{Eq. \{12\}}$$
The Linear Elastic model is usually inappropriate to model the highly non-linear behaviour of soil, but it is of interest to simulate structural behaviour, such as thick concrete walls or plates, for which strength properties are usually very high compared with those of soil. For these applications, the Linear Elastic model will often be selected together with *Non-porous* type of material behaviour in order to exclude pore pressures from these structural elements.

**Note:**

When embedded beams penetrate a polygon cluster with linear elastic material behaviour, the specified value of the shaft resistance is ignored. The reason for this is that the linear elastic material is not supposed to be soil, but part of the structure. The connection between the pile and the structure is supposed to be rigid to avoid, for example, punching of piles through a concrete deck.

As a second alternative for the stiffness parameters of the soil, the velocities of wave propagation in soil can be defined in the *Mechanical* tabsheet of the *Soil* window when the Dynamics module of the program is available. These velocities are:

<table>
<thead>
<tr>
<th>$V_s$</th>
<th>Shear wave velocity, where $V_s = \sqrt{G_0 / \rho}$</th>
<th>[m/s]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_p$</td>
<td>Compression wave velocity, where $V_p = \sqrt{E / \rho}$</td>
<td>[m/s]</td>
</tr>
</tbody>
</table>

where $\rho = \gamma / g$.

As the wave velocities are influenced by the input values of $E'$ and $\nu'$, entering a particular value for one of the wave velocities results in a change of the Young’s modulus.

**Note:**

- Velocities of wave propagation in soil can be defined only for models with stress independent stiffness.

6.1.2.2 Mohr-Coulomb model (MC)

The linear-elastic perfectly-plastic model with Mohr-Coulomb failure contour (in short the Mohr-Coulomb model) requires a total of five parameters (two stiffness parameters and three strength parameters), which are generally familiar to most geotechnical engineers and which can be obtained from basic tests on soil samples.
The stiffness parameters of the Mohr-Coulomb model (drained behaviour) are:

<table>
<thead>
<tr>
<th>$E'_{\text{ref}}$</th>
<th>Effective Young’s modulus</th>
<th>[kN/m$^2$]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\nu$</td>
<td>Effective Poisson's ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>

**Note:**

- Optional drainage types when Mohr-Coulomb model is selected are: Drained, Undrained A, Undrained B, Undrained C, and Non-porous.
- In the case of Undrained A or Non-porous drainage types, the same parameters are used as for drained behaviour.
- In the case of Undrained B drainage type, $\phi = \phi_u = 0$, $\psi = 0$ and the undrained shear strength $s_u$ is used instead of the effective cohesion ($c'$).
In the case of Undrained C drainage type all parameters are undrained. i.e. $E_u$, $\nu_u$ and $s_u$ as undrained Young’s modulus, undrained Poisson’s ratio and undrained shear strength respectively, and $\phi = \psi = 0$.

Instead of using the Young’s modulus as a stiffness parameter, alternative stiffness parameters can be entered. These parameters, the relations and their standard units are listed below:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$G_{ref}$</td>
<td>Shear modulus, where $G_{ref} = E_{ref}’/(2(1 + \nu’))$</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$E_{oed}$</td>
<td>Oedometer modulus, where $E_{oed} = E_{ref}’(1-\nu’)/((1+\nu’)(1 - 2\nu’))$</td>
<td>[kN/m$^2$]</td>
</tr>
</tbody>
</table>

Note that the alternatives are influenced by the input values of $E_{ref}’$ and $\nu’$. Entering a particular value for one of the alternatives $G_{ref}$ or $E_{oed}$ results in a change of the Young’s modulus $E_{ref}’$.

Stiffness varying with depth can be defined in Mohr-Coulomb model by entering a value for $E_{inc}’$, which is the increment of stiffness per unit of depth. Together with the input of $E_{inc}’$, the input of $y_{ref}$ becomes relevant. For any $y$-coordinate above $y_{ref}$ the stiffness is equal to $E_{ref}’$. For any $y$-coordinate below $y_{ref}$ the stiffness is given by:

$$E’(y) = E_{ref}’ + (y_{ref} - y)E_{inc}’; \quad y < y_{ref} \quad Eq. [13]$$

The strength parameters for the Mohr-Coulomb model are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c’_{ref}$</td>
<td>Effective cohesion</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$\phi’$</td>
<td>Effective friction angle</td>
<td>[°]</td>
</tr>
<tr>
<td>$\psi$</td>
<td>Dilatancy angle</td>
<td>[°]</td>
</tr>
</tbody>
</table>

A cohesion varying with depth can be defined in Mohr-Coulomb model by entering a value for $c’_{inc}$, which is the increment of effective cohesion per unit of depth. Together with the input of $c’_{inc}$, the input of $y_{ref}$ becomes relevant. For any $y$-coordinate above $y_{ref}$, the cohesion is equal to $c’_{ref}$. For any $y$-coordinate below $y_{ref}$, the cohesion is given by:

$$c'(y) = c’_{ref} + (y_{ref} - y)c’_{inc}; \quad y < y_{ref} \quad Eq. [14]$$

In some practical problems an area with tensile stresses may develop. This is allowed when the shear stress is sufficiently small. However, the soil surface near a trench in clay sometimes shows tensile cracks. This indicates that soil may also fail in tension instead of in shear. Such behaviour can be included in a PLAXIS 2D analysis by selecting the Tension cut-off option. When selecting the Tension cut-off option, the allowable tensile strength may be entered. The default value of the tensile strength is zero.

[ULT] As a second alternative for the stiffness parameters, the velocities of wave propagation in soil can be defined in the Mechanical tabsheet of the Soil window. These velocities are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$V_s$</td>
<td>Shear wave velocity, where $V_s = \sqrt{G/\rho}$</td>
<td>[m/s]</td>
</tr>
<tr>
<td>$V_p$</td>
<td>Compression wave velocity, where $V_p = \sqrt{E/\rho}$</td>
<td>[m/s]</td>
</tr>
</tbody>
</table>

where $\rho = \nu / g$.

The wave velocities are influenced by the input values of $E’$ and $\nu’$, hence entering a particular value for one of the wave velocities results in a change of the Young’s modulus.
Note:

- Velocities of wave propagation in soil can be defined only for models with stress independent stiffness.

6.1.2.3 Hoek-Brown model (HB)

The Mechanical tabsheet for the Hoek-Brown model is shown in Figure 133 (on page 185). The Hoek-Brown parameters can be obtained from the tools available in the right-hand panel.

Note:

- Optional drainage types when Hoek-Brown model is selected are: Drained and Non-porous.
- The same parameters are used for both Non-porous drainage type and for drained behaviour.

The stiffness parameters of the Hoek-Brown model are:
Material properties and material database

Modelling soil and interface behaviour

| $E_{rm}$ | Rock mass Young's modulus | [kN/m$^2$] |
| $\nu$ | Poisson's ratio | [-] |
| $G_{ref}$ | Rock mass shear modulus, $G_{ref} = E_{rm}/(2(1+\nu))$ | [kN/m$^2$] |

Where $G_{ref}$ is an alternative input for the rock mass Young's modulus $E_{rm}$.

The strength parameters have been divided in 4 subcategories: the Uniaxial compressive strength, the Hoek-Brown parameters, the Rock mass parameters and the Dilatancy.

| $|\sigma_{ci}|$ | Uni-axial compressive strength of the intact rock (>0) | [kN/m$^2$] |

For the Hoek-Brown and Rock mass parameters the user has the choice how to enter them by setting the Determination option. When this option is set to Derived, the user is asked to specify these well-known engineering parameters:

| $m_i$ | Material constant for the intact rock | [-] |
| $GSI$ | Geological Strength Index | [-] |
| $D$ | Disturbance factor which depends on the degree of disturbance to which the rock mass has been subjected | [-] |

When any of these parameters is selected, a side panel opens to supports the selection of the parameters.

However, when Determination is set to Direct it becomes possible to specify the Hoek-Brown parameters directly:

| $m_b$ | Reduced intact rock parameter | [-] |
| $s$ | Hoek-Brown material parameter | [-] |
| $a$ | Hoek-Brown power parameter | [-] |
| $\sigma_t$ | Tensile strength of the rock mass | [kN/m$^2$] |
| $\sigma_c$ | Compressive strength of the rock mass | [kN/m$^2$] |

The Hoek-Brown model simulates the Tensile strength of the rock mass via the $|\sigma_{ci}|$ parameter, calculated from rock properties $\sigma_o$, $s$ and $m_b$ (see Material Models Manual for more information on model parameters). To enhance modelling capabilities and flexibility, PLAXIS 2D allows to calibrate separately the rock tensile strength using tension cut-off facility. By default the tension cut-off option is disabled. When enabled, users can put a tensile strength value, and if that value is lower than $\sigma_t$, the tensile capacity will be cut-off at that value. This feature can be helpful in some situations, for instance in Safety analysis where this tension cut-off value (but not the $\sigma_t$ parameter) is reduced with the safety factor.

Finally, the dilatancy can be specified through the following parameters:

| $\psi_{max}$ | Dilatancy at zero stress level | [°] |
Material properties and material database
Modelling soil and interface behaviour

| $\sigma_\psi$ | Stress level at which dilatancy is fully suppressed | [kN/m$^2$] |

6.1.2.4 Jointed Rock model (JR)

The **Mechanical** tabsheet for the Jointed Rock model is shown in **Figure 134** (on page 187).

**Note:**
- Optional drainage types when Jointed Rock model is selected are: Drained and Non-porous.
- The same parameters are use for both the Non-porous drainage type and drained behaviour.

![Mechanical tabsheet for the Jointed Rock model](image.png)

**Figure 134:** **Mechanical** tabsheet for the Jointed Rock model

Parameters for stiffness:

<table>
<thead>
<tr>
<th>$E_t$</th>
<th>Young's modulus for rock as a continuum, i.e. in 'Plane 1' direction</th>
<th>[kN/m$^2$]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\nu_{nt}$</td>
<td>Poisson's ratio for rock as a continuum, i.e. in 'Plane 1' direction</td>
<td>[-]</td>
</tr>
</tbody>
</table>
Material properties and material database
Modelling soil and interface behaviour

Anisotropic elastic parameters 'Plane 1' direction (e.g. stratification direction):

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E_n$</td>
<td>Young's modulus perpendicular to 'Plane 1' direction</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$\nu_{ns}$</td>
<td>Poisson's ratio perpendicular to 'Plane 1' direction</td>
<td>[-]</td>
</tr>
<tr>
<td>$G_{nt}$</td>
<td>Shear modulus perpendicular to 'Plane 1' direction</td>
<td>[kN/m$^2$]</td>
</tr>
</tbody>
</table>

Parameters for strength:

Strength parameters in joint directions (Plane i=1, 2, 3):

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c_i$</td>
<td>Cohesion</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$\phi_i$</td>
<td>Friction angle</td>
<td>[°]</td>
</tr>
<tr>
<td>$\psi_i$</td>
<td>Dilatancy angle</td>
<td>[°]</td>
</tr>
<tr>
<td>$\sigma_{t,i}$</td>
<td>Tensile strength</td>
<td>[kN/m$^2$]</td>
</tr>
</tbody>
</table>

Definition of joint directions (Plane i=1, 2, 3):

<table>
<thead>
<tr>
<th>Number of planes</th>
<th>Number of joint directions ($1 \leq n \leq 3$)</th>
<th>-</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\alpha_{1,i}$</td>
<td>Dip angle (visualized in the side panel)</td>
<td>[°]</td>
</tr>
<tr>
<td>$\alpha_{2,i}$</td>
<td>Dip direction</td>
<td>[°]</td>
</tr>
</tbody>
</table>

Weak planes (joints) may fail in shear (modeled by Coulomb strength parameters cohesion and friction angle) or in tension. The latter can be included in a PLAXIS 2D analysis by selecting the Tension cut-off option. When selecting the Tension cut-off option the allowable tensile strength may be entered. The default value of the tensile strength is zero.

6.1.2.5 Hardening Soil model (HS)

The Mechanical tabsheet for the Hardening Soil model is shown in Figure 135 (on page 189).

**Note:**
- Optional drainage types when Hardening Soil model is selected are: Drained, Undrained A, and Undrained B.
- In the case of Undrained A drainage type, the same parameters are used as for drained behaviour.
- In the case of Undrained B drainage type, $\phi = \phi_u = 0$, $\psi = 0$ and the undrained shear strength $s_u$ is used instead of the effective cohesion ($c'$).
The stiffness parameters of the Hardening Soil model are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E_{50}^{\text{ref}}$</td>
<td>Secant stiffness in standard drained triaxial test</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$E_{\text{sed}}^{\text{ref}}$</td>
<td>Tangent stiffness for primary oedometer loading</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$E_{\text{ur}}^{\text{ref}}$</td>
<td>Unloading / reloading stiffness (default $E_{\text{ur}}^{\text{ref}} = 3E_{50}^{\text{ref}}$)</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$\nu_{\text{ur}}$</td>
<td>Poisson’s ratio for unloading-reloading (default $\nu = 0.2$)</td>
<td>[-]</td>
</tr>
</tbody>
</table>

Instead of entering the basic parameters for soil stiffness, alternative parameters can be entered. These parameters are listed below:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$C_C$</td>
<td>Compression index</td>
</tr>
<tr>
<td>$C_s$</td>
<td>Swelling index or reloading index</td>
</tr>
<tr>
<td>$e_{\text{init}}$</td>
<td>Initial void ratio</td>
</tr>
</tbody>
</table>
In addition, stress dependent stiffness can be defined through a power law with the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$m$</td>
<td>Power for stress-level dependency of stiffness</td>
<td>[-]</td>
</tr>
<tr>
<td>$p^{\text{ref}}$</td>
<td>Reference stress for stiffnesses (default $p^{\text{ref}} = 100 \text{ kN/m}^2$)</td>
<td>[kN/m$^2$]</td>
</tr>
</tbody>
</table>

The strength parameters of the Hardening Soil model coincide with those of the Mohr-Coulomb model:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c^{\text{ref}}$</td>
<td>Effective cohesion</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$\phi^{\text{ref}}$</td>
<td>Effective friction angle</td>
<td>[°]</td>
</tr>
<tr>
<td>$\psi$</td>
<td>Dilatancy angle</td>
<td>[°]</td>
</tr>
</tbody>
</table>

In addition, a depth dependent cohesion can be defined:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c^{\text{inc}}$</td>
<td>As in the Mohr-Coulomb model (default $c^{\text{inc}} = 0$)</td>
<td>[kN/m$^3$]</td>
</tr>
<tr>
<td>$y^{\text{ref}}$</td>
<td>Reference level</td>
<td>[m]</td>
</tr>
</tbody>
</table>

Dilatancy is generally dependent on the density of the soil: a loose soil shows less dilatancy than a dense soil. In a shearing test it can be observed that if a dense material is sheared the effective dilatancy angle reduces with the increase of volume strain, hence with reducing void ratio. On the other hand, in case of negative dilatancy, the soil can only continue to reduce volume until the maximum density, hence the minimum void ratio, is reached. PLAXIS 2D does not offer the possibility to take into account full void ratio dependent dilatancy, but it does have the option to only calculate dilatancy if the void ratio is between certain limits while the dilatancy is considered zero outside these limit values of the void ratio.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dilatancy cut-off</td>
<td>To be selected when dilatancy should only be considered within the void ratio range between $e^{\text{min}}$ and $e^{\text{max}}$</td>
<td>[-]</td>
</tr>
<tr>
<td>$e^{\text{min}}$</td>
<td>Minimum void ratio</td>
<td>[-]</td>
</tr>
<tr>
<td>$e^{\text{max}}$</td>
<td>Maximum void ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>

In some practical problems an area with tensile stresses may develop. This is allowed when the shear stress is sufficiently small. However, the soil surface near a trench in clay sometimes shows tensile cracks. This indicates that soil may also fail in tension instead of in shear. Such behaviour can be included in a PLAXIS 2D analysis by selecting the Tension cut-off option. When selecting the Tension cut-off option the allowable tensile strength may be entered. The default value of the tensile strength is zero.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tension cut-off</td>
<td>To be selected when tension cut-off should be considered</td>
<td>[-]</td>
</tr>
<tr>
<td>Tensile strength</td>
<td>The allowable tensile strength</td>
<td>[kN/m$^2$]</td>
</tr>
</tbody>
</table>

Finally, there are some Miscellaneous parameters to be defined that are not directly related to either stiffness or strength. It is recommended to leave these values to their default values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$K_0^{\text{nc}}$</td>
<td>$K_0$-value for normal consolidation (default $K_0^{\text{nc}} = 1 - \sin(\phi)$)</td>
<td>[-]</td>
</tr>
</tbody>
</table>

---

**Ref:** PLAXIS 2D Reference Manual 2D
6.1.2.6 Hardening Soil model with small-strain stiffness (HSsmall)

Compared to the standard HS model, the Hardening Soil model with small-strain stiffness requires two additional stiffness parameters as input: \( \gamma_0.7 \) and \( G_0^{ref} \). The Mechanical tabsheet for the Hardening Soil model with small-strain stiffness is shown in Figure 136 (on page 192).

**Note:**

- Optional drainage types when Hardening Soil model with small-strain stiffness is selected are: Drained, Undrained A, and Undrained B.
- In the case of Undrained A drainage type, the same parameters are used as for drained behaviour.
- In the case of Undrained B drainage type, \( \varphi = \varphi_u = 0, \psi = 0 \) and the undrained shear strength \( s_u \) is used instead of the effective cohesion (\( c' \)).
All other parameters, including the alternative stiffness parameters, remain the same as in the standard Hardening Soil model. In summary, the input stiffness parameters of the Hardening Soil model with small-strain stiffness are listed below:

Parameters for stiffness:
### Material properties and material database

**Modelling soil and interface behaviour**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E_s^{\text{ref}}$</td>
<td>Secant stiffness in standard drained triaxial test</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$E_{oed}^{\text{ref}}$</td>
<td>Tangent stiffness for primary oedometer loading</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$E_{ur}^{\text{ref}}$</td>
<td>Unloading / reloading stiffness (default $E_{ur}^{\text{ref}} = 3E_s^{\text{ref}}$)</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$m$</td>
<td>Power for stress-level dependency of stiffness</td>
<td>[-]</td>
</tr>
</tbody>
</table>

**Alternative parameters for stiffness:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$C_C$</td>
<td>Compression index</td>
<td>[-]</td>
</tr>
<tr>
<td>$C_s$</td>
<td>Swelling index or reloading index</td>
<td>[-]</td>
</tr>
<tr>
<td>$e_{\text{init}}$</td>
<td>Initial void ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>

**Parameters for stress-dependent stiffness:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\nu_{ur}$</td>
<td>Poisson's ratio for unloading-reloading (default $\nu = 0.2$)</td>
<td>[-]</td>
</tr>
<tr>
<td>$p^{\text{ref}}$</td>
<td>Reference stress for stiffnesses (default $p^{\text{ref}} = 100$ kN/m$^2$)</td>
<td>[kN/m$^2$]</td>
</tr>
</tbody>
</table>

**Parameters for small strain stiffness:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\gamma_{0.7}$</td>
<td>Shear strain at which $G_s = 0.722 G_0$</td>
<td>[-]</td>
</tr>
<tr>
<td>$G_0^{\text{ref}}$</td>
<td>Reference shear modulus at very small strains ($\varepsilon &lt; 10^{-6}$)</td>
<td>[kN/m$^2$]</td>
</tr>
</tbody>
</table>

**General parameters for strength:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c^{\text{ref}}$</td>
<td>Effective cohesion</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$\varphi'$</td>
<td>Effective friction angle</td>
<td>[$^\circ$]</td>
</tr>
<tr>
<td>$\psi$</td>
<td>Dilatancy angle</td>
<td>[$^\circ$]</td>
</tr>
</tbody>
</table>

**Parameters for depth-dependent strength:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c_{\text{inc}}$</td>
<td>As in Mohr-Coulomb model (default $c_{\text{inc}} = 0$)</td>
<td>[kN/m$^2$/m]</td>
</tr>
<tr>
<td>$y^{\text{ref}}$</td>
<td>Reference level</td>
<td>[m]</td>
</tr>
</tbody>
</table>

**Parameters to limit the dilatancy:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dilatancy cut-off</td>
<td>To be selected if a zero dilatancy angle should be used when the void ratio falls outside the limits defined by $e_{\text{min}}$ and $e_{\text{max}}$</td>
<td>[-]</td>
</tr>
<tr>
<td>$e_{\text{min}}$</td>
<td>Minimum void ratio</td>
<td>[-]</td>
</tr>
<tr>
<td>$e_{\text{max}}$</td>
<td>Maximum void ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>
### Parameters for tensile strength:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tension cut-off</td>
<td>To be selected when tension cut-off is considered</td>
<td>[-]</td>
</tr>
<tr>
<td>Tensile strength</td>
<td>The allowable tensile strength</td>
<td>[kN/m²]</td>
</tr>
</tbody>
</table>

### Miscellaneous parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>K₀nc</td>
<td>K₀-value for normal consolidation (default ( K_{0}^{nc} = 1 - \sin(\varphi) ))</td>
<td>[-]</td>
</tr>
<tr>
<td>R_f</td>
<td>Failure ratio ( q_f / q_a ) (default ( R_f = 0.9 ))</td>
<td>[-]</td>
</tr>
</tbody>
</table>

In some practical problems an area with tensile stresses may develop. This is allowed when the shear stress is sufficiently small. However, the soil surface near a trench in clay sometimes shows tensile cracks. This indicates that soil may also fail in tension instead of in shear. Such behaviour can be included in a PLAXIS 2D analysis by selecting the **Tension cut-off** option. When selecting the **Tension cut-off** option the allowable tensile strength may be entered. The default value of the tensile strength is zero.

**Hysteretic damping**

The elastic modulus ratio is plotted as a function of the shear strain \( \gamma \) in a side pane when specifying the small-strain stiffness parameters (**Modulus reduction curve**). The Hardening Soil model shows typical hysteretic behaviour when subjected to cyclic shear loading. In dynamics calculations this leads to hysteretic damping. The damping ratio is plotted as a function of the cyclic shear strain \( \gamma^C \). Details are given in Brinkgreve, Kappert & Bonnier (2007) (on page 586).
Note:

Note that the Modulus reduction curve and the Damping curve are based on fully elastic behaviour. Plastic strains as a result of hardening or local failure may lead to significant lower stiffness and higher damping.

6.1.2.7 Modified Cam-Clay model (MCC)

This is a critical state model that can be used to simulate the behaviour of normally consolidated soft soils. The model assumes a logarithmic relationship between the void ratio and the mean effective stress. The Mechanical tabsheet for the Modified Cam-Clay model is shown in Figure 138 (on page 196).

Note:

- Optional drainage types when Modified Cam-Clay model is selected are: Drained and Undrained A.
- In the case of Undrained A drainage type, the same parameters are used as for drained behaviour.
**Material properties and material database**

Modelling soil and interface behaviour

![Image](image.png)

*Figure 138: Mechanical tabsheet for the Modified Cam-Clay model (drained behaviour)*

Parameters for stiffness:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\lambda$</td>
<td>Cam-Clay compression index</td>
<td>[-]</td>
</tr>
<tr>
<td>$\kappa$</td>
<td>Cam-Clay swelling index</td>
<td>[-]</td>
</tr>
<tr>
<td>$\nu_{ur}$</td>
<td>Poisson's ratio for unloading/reloading</td>
<td>[-]</td>
</tr>
</tbody>
</table>

Parameter for strength:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$M_{CSL}$</td>
<td>Tangent of the Critical State Line</td>
<td>[-]</td>
</tr>
</tbody>
</table>

The Modified Cam-Clay model has an implicit relation between the ratio of horizontal and vertical stresses in primary loading, $K_0^{NC}$, and the strength and stiffness parameters. Therefore in the Miscellaneous block the value of $K_0^{NC}$ resulting from the given stiffness and strength parameters is shown, but cannot be changed directly. If independent control over the strength and stiffness parameters as well as $K_0^{NC}$ is required, it is recommended to use the Soft Soil model [SS] [ADV] (on page 198) instead of the Modified Cam-Clay model.
6.1.2.8 NGI-ADP model

The NGI-ADP model may be used for capacity, deformation and soil-structure interaction analysis involving undrained loading of clay-type materials. The **Mechanical** tabsheet for the NGI-ADP model is shown in Figure 139 (on page 197).

**Note:**
The only drainage type available when the NGI-ADP model is selected is Undrained C.

![Mechanical tabsheet for the NGI-ADP model](image)

**Figure 139: Mechanical tabsheet for the NGI-ADP model**

Parameters for stiffness:

<table>
<thead>
<tr>
<th>$G_{ur}/s_{u,inc}^A$</th>
<th>Ratio unloading/reloading shear modulus over the (plane strain) active shear strength</th>
<th>[-]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\nu_\text{u}$</td>
<td>Undrained Poisson's ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>

**Material properties and material database**

Modelling soil and interface behaviour
## Material properties and material database

Modelling soil and interface behaviour

Parameters for strength

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$s_u^A, \text{ref}$</td>
<td>Reference (plane strain) active shear strength</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$s_{u,\text{inc}}^A$</td>
<td>Increase of (plane strain) active shear strength with depth</td>
<td>[kN/m$^2$/m]</td>
</tr>
<tr>
<td>$y_{\text{ref}}$</td>
<td>Reference level for active, passive and DSS shear strength</td>
<td>[m]</td>
</tr>
<tr>
<td>$s_u^{\text{TX}}/s_u^A$</td>
<td>Ratio triaxial compressive shear strength over (plane strain) active shear strength (fixed at 0.99)</td>
<td>[-]</td>
</tr>
<tr>
<td>$s_u^P/s_u^A$</td>
<td>Ratio of (plane strain) passive shear strength over (plane strain) active shear strength</td>
<td>[-]</td>
</tr>
<tr>
<td>$s_u^{\text{DSS}}/s_u^A$</td>
<td>Ratio of direct simple shear strength over (plane strain) active shear strength</td>
<td>[-]</td>
</tr>
<tr>
<td>$\gamma_f^C$</td>
<td>Shear strain at failure in triaxial compression ($</td>
<td>\gamma_f^C</td>
</tr>
<tr>
<td>$\gamma_f^E$</td>
<td>Shear strain at failure in triaxial extension</td>
<td>[-]</td>
</tr>
<tr>
<td>$\gamma_f^{\text{DSS}}$</td>
<td>Shear strain at failure in direct simple shear</td>
<td>[-]</td>
</tr>
</tbody>
</table>

Miscellaneous parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\tau_0/s_u^A$</td>
<td>Ratio initial mobilized shear over (plane strain) active shear strength (default = 0.7)</td>
<td>[-]</td>
</tr>
</tbody>
</table>

### 6.1.2.9 Soft Soil model (SS) [ADV]

The Mechanical tabsheet for the Soft Soil model is shown in Figure 140 (on page 199).

**Note:**
- Optional drainage types when Soft Soil model is selected are: Drained and Undrained A.
- For both Drained and Undrained A drainage type the same parameters are used.
Material properties and material database
Modelling soil and interface behaviour

Figure 140: Mechanical tabsheet for the Soft Soil model (drained behaviour)

The parameters for stiffness are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \lambda^\ast )</td>
<td>Modified compression index</td>
<td>[-]</td>
</tr>
<tr>
<td>( \kappa^\ast )</td>
<td>Modified swelling index</td>
<td>[-]</td>
</tr>
<tr>
<td>( \nu_{ur} )</td>
<td>Poisson’s ratio for unloading-reloading (default ( \nu = 0.15 ))</td>
<td>[-]</td>
</tr>
</tbody>
</table>

Alternative parameters can be used to define stiffness:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>( C_C )</td>
<td>Compression index</td>
<td>[-]</td>
</tr>
<tr>
<td>( C_s )</td>
<td>Swelling index or reloading index</td>
<td>[-]</td>
</tr>
<tr>
<td>( e_{init} )</td>
<td>Initial void ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>

The parameters for strength are:
In some practical problems an area with tensile stresses may develop. This is allowed when the shear stress is sufficiently small. However, the soil surface near a trench in clay sometimes shows tensile cracks. This indicates that soil may also fail in tension instead of in shear. Such behaviour can be included in a PLAXIS 2D analysis by selecting the Tension cut-off option. When selecting the Tension cut-off option the allowable tensile strength may be entered. The default value of the tensile strength is zero.

Miscellaneous parameters (use default settings):

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c_{\text{ref}}'$</td>
<td>Effective cohesion</td>
<td>[kN/m²]</td>
</tr>
<tr>
<td>$\varphi'$</td>
<td>Effective friction angle</td>
<td>[°]</td>
</tr>
<tr>
<td>$\psi$</td>
<td>Dilatancy angle</td>
<td>[°]</td>
</tr>
<tr>
<td>Tension cut-off</td>
<td>To be selected when tension cut-off is considered</td>
<td>[-]</td>
</tr>
<tr>
<td>Tensile strength</td>
<td>The allowable tensile strength</td>
<td>[kN/m²]</td>
</tr>
</tbody>
</table>

The parameter $M$ is the inclination of the line passing through both the leftmost and topmost points of the ellipse forming the hardening cap of the Soft Soil model. The value of $M$ is derived from the value of $K_0^{nc}$ and is given here for comparison with the value $M_{\text{CSL}}$ of for instance the Modified Cam-Clay model (MCC) (on page 195).

6.1.2.10 Soft Soil Creep model (SSC) [ADV]

The Mechanical tabsheet for the Soft Soil Creep model is shown in Figure 141 (on page 201).

Note:

- Optional drainage types when Soft Soil Creep model is selected are: Drained and Undrained A.
- For both Drained and Undrained A drainage type, the same parameters are used.
**Material properties and material database**

Modelling soil and interface behaviour

---

**Figure 141:** Mechanical tabsheet for the Soft Soil Creep model (drained behaviour)

The parameters for stiffness are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\lambda^*$</td>
<td>Modified compression index</td>
<td>[-]</td>
</tr>
<tr>
<td>$\kappa^*$</td>
<td>Modified swelling index</td>
<td>[-]</td>
</tr>
<tr>
<td>$\mu^*$</td>
<td>Modified creep index</td>
<td>[-]</td>
</tr>
<tr>
<td>$\nu_{ur}$</td>
<td>Poisson's ratio for unloading-reloading (default $\nu = 0.15$)</td>
<td>[-]</td>
</tr>
</tbody>
</table>

Alternative parameters can be used to define stiffness:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$C_C$</td>
<td>Compression index</td>
<td>[-]</td>
</tr>
</tbody>
</table>
Material properties and material database
Modelling soil and interface behaviour

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$C_s$</td>
<td>Swelling index or reloading index</td>
<td>[-]</td>
</tr>
<tr>
<td>$C_a$</td>
<td>Secondary compression index</td>
<td>[-]</td>
</tr>
<tr>
<td>$e_{init}$</td>
<td>Initial void ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>

The parameters for strength are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c'_{ref}$</td>
<td>Effective cohesion</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$\varphi'$</td>
<td>Effective friction angle</td>
<td>[°]</td>
</tr>
<tr>
<td>$\psi$</td>
<td>Dilatancy angle</td>
<td>[°]</td>
</tr>
<tr>
<td>Tension cut-off</td>
<td>To be selected when tension cut-off is considered</td>
<td>[-]</td>
</tr>
<tr>
<td>Tensile strength</td>
<td>The allowable tensile strength</td>
<td>[kN/m$^2$]</td>
</tr>
</tbody>
</table>

In some practical problems an area with tensile stresses may develop. This is allowed when the shear stress is sufficiently small. However, the soil surface near a trench in clay sometimes shows tensile cracks. This indicates that soil may also fail in tension instead of in shear. Such behaviour can be included in a PLAXIS 2D analysis by selecting the Tension cut-off option. When selecting the Tension cut-off option the allowable tensile strength may be entered. The default value of the tensile strength is zero.

Miscellaneous parameters (use default settings):

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$K_0^{nc}$</td>
<td>$K_0$-value for normal consolidation (default $K_0^{nc} = 1 \cdot \sin(\varphi)$)</td>
<td>[-]</td>
</tr>
<tr>
<td>$M$</td>
<td>$K_0^{nc}$-related parameter (no direct input possible)</td>
<td>[-]</td>
</tr>
</tbody>
</table>

The parameter $M$ is the inclination of the line passing through both the leftmost and topmost points of the ellipse forming the hardening cap of the Soft Soil Creep model. The value of $M$ is derived from the value of $K_0^{nc}$ and is given here for comparison with the value $M_{CSL}$ of for instance the Modified Cam-Clay model (MCC) (on page 195).

6.1.2.11 Sekiguchi-Ohta model (Inviscid) [ADV]

The Mechanical tabsheet for the Sekiguchi-Ohta model (Inviscid) is shown in Figure 142 (on page 203).

Note:
- Optional drainage types when Sekiguchi-Ohta model (Inviscid) is selected are: Drained and Undrained A.
- For both the Drained and Undrained A drainage type the same parameters are used.
Material properties and material database
Modelling soil and interface behaviour

![Mechanical tabsheet for the Sekiguchi-Ohta model (drained behaviour)](image)

**Figure 142:** Mechanical tabsheet for the Sekiguchi-Ohta model (drained behaviour)

Parameters for stiffness:

<table>
<thead>
<tr>
<th>$\lambda^*$</th>
<th>Modified compression index</th>
<th>[-]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\kappa^*$</td>
<td>Modified swelling index</td>
<td>[-]</td>
</tr>
<tr>
<td>$\nu_{ur}$</td>
<td>Poisson's ratio for unloading-reloading</td>
<td>[-]</td>
</tr>
</tbody>
</table>

Alternative parameters can be used to define soil stiffness:

<table>
<thead>
<tr>
<th>$C_C$</th>
<th>Compression index</th>
<th>[-]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$C_s$</td>
<td>Swelling index or reloading index</td>
<td>[-]</td>
</tr>
<tr>
<td>$e_{init}$</td>
<td>Initial void ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>

The Sekiguchi-Ohta Inviscid model has a single strength parameter:

| $M_{CSL}$ | Tangent of critical state line | [-] |
### Miscellaneous parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$K_0^{nc}$</td>
<td>Coefficient of lateral stress in normal consolidation</td>
<td>[-]</td>
</tr>
</tbody>
</table>

#### 6.1.2.12 Sekiguchi-Ohta model (Viscid) [ADV]

The **Mechanical** tabsheet for the Sekiguchi-Ohta model (Viscid) is shown in Figure 143 (on page 204).

**Note:**
- Optional drainage types when Sekiguchi-Ohta model (Viscid) is selected are: *Drained* and *Undrained A*.
- For both the *Drained* and *Undrained A* drainage type the same parameters are used.

*Figure 143: Mechanical tabsheet for the Sekiguchi-Ohta model (Viscid) (drained behaviour)*

The stiffness parameters of the Sekiguchi-Ohta model (Viscid) are:
### Material properties and material database

#### Modelling soil and interface behaviour

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\lambda^*$</td>
<td>Modified compression index</td>
<td>[-]</td>
</tr>
<tr>
<td>$\kappa^*$</td>
<td>Modified swelling index</td>
<td>[-]</td>
</tr>
<tr>
<td>$\nu_{ur}$</td>
<td>Poisson's ratio for unloading-reloading</td>
<td>[-]</td>
</tr>
</tbody>
</table>

Alternative parameters can be used to define soil stiffness:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$C_C$</td>
<td>Compression index</td>
<td>[-]</td>
</tr>
<tr>
<td>$C_s$</td>
<td>Swelling index or reloading index</td>
<td>[-]</td>
</tr>
<tr>
<td>$C_{ar^*}$</td>
<td>Secondary compression index</td>
<td>[-]</td>
</tr>
<tr>
<td>$e_{init}$</td>
<td>Initial void ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>

The model has a single parameter for soil strength:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$M_{CSL}$</td>
<td>Tangent of the critical state line</td>
<td>[-]</td>
</tr>
</tbody>
</table>

Parameters for creep deformation:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\alpha^*$</td>
<td>Coefficient of secondary compression</td>
<td>[-]</td>
</tr>
<tr>
<td>$\dot{v}_0$</td>
<td>Initial volumetric strain rate</td>
<td>[day$^{-1}$]</td>
</tr>
</tbody>
</table>

Miscellaneous parameters (using default is recommended):

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$K_{0}^{nc}$</td>
<td>Coefficient of lateral stress in normal consolidation</td>
<td>[-]</td>
</tr>
</tbody>
</table>

#### 6.1.2.13 UDCAM-S model [ADV]

The UDCAM-S model can be used for capacity, deformation and soil-structure interaction analysis involving undrained loading of clay-type materials for the design of offshore structures. The Mechanical tabsheet for the UDCAM-S model is shown in Figure 144 (on page 206). The parameters are obtained from the Cyclic accumulation and optimisation tool, which can be accessed by clicking on the corresponding button in the right-hand panel.

**Note:**
The UDCAM-S model can only be used with the drainage type Undrained C.
### Material properties and material database

- Modelling soil and interface behaviour

---

**Figure 144: Mechanical tabsheet for the UDCAM-S model**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>(G_{\text{max}}/\tau^C)</td>
<td>Ratio unloading/reloading shear modulus over (plane strain) active shear strength</td>
<td>[-]</td>
</tr>
<tr>
<td>(\nu_u)</td>
<td>Undrained Poisson’s ratio</td>
<td>[-]</td>
</tr>
<tr>
<td>(\tau_{\text{ref}}^C)</td>
<td>Degraded reference cyclic shear strength in triaxial compression</td>
<td>[kN/m²]</td>
</tr>
<tr>
<td>(\tau_{\text{inc}}^C)</td>
<td>Increase of degraded cyclic shear strength in triaxial compression with depth</td>
<td>[kN/m²/m]</td>
</tr>
<tr>
<td>(y_{\text{ref}})</td>
<td>Reference level for depth-dependent shear strength</td>
<td>[m]</td>
</tr>
<tr>
<td>(\tau^E/\tau^C)</td>
<td>Ratio of degraded cyclic triaxial extension shear strength over degraded cyclic triaxial compression shear strength</td>
<td></td>
</tr>
</tbody>
</table>
6.1.2.14 Concrete model [ADV]

The Mechanical tabsheet for the Concrete model are shown in Figure 145 (on page 208).

**Note:**
Available drainage types when Concrete model is selected are: Drained, in case of semi-permeable walls, and Non-porous, which is the general approach for concrete structural elements.
### Material properties and material database

Modelling soil and interface behaviour

**Figure 145: Mechanical tabsheet for the Concrete model**

<table>
<thead>
<tr>
<th>Property</th>
<th>Unit</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stiffness</td>
<td>kN/m²</td>
<td>0.000</td>
</tr>
<tr>
<td>Strength</td>
<td>kN/m²</td>
<td>0.000</td>
</tr>
<tr>
<td>Ductility</td>
<td></td>
<td>0.000</td>
</tr>
<tr>
<td>Time dependency</td>
<td></td>
<td>1.100</td>
</tr>
</tbody>
</table>

**Compression**
- $f_{c28}$: 0.000
- $f_{ch}$: 0.0500
- $f_{cm}$: 0.0500
- $G_{c28}$: 0.000
- $e_{max}$: 0.000
- $w$: 0.000
- $Y_{ce}$: 1.000

**Tension**
- $f_{t28}$: 0.000
- $f_{lim}$: 1.000E-3
- $G_{t28}$: 0.000
- $Y_{ti}$: 1.000

**Stiffness**
- $E/E_{c28}$: 1.000

**Strength**
- Strength function: CEB-FIP
- $f_{c28}$: 1.000

**Ductility**
- $\varepsilon_{F_{m,sh}}$: 0.000
- $\varepsilon_{F_{m,sh}}$: 0.000
- $\varepsilon_{F_{m,sh}}$: 0.000

**Shrinkage**
- Include shrinkage: 0.000
- $e_{sh}$: 0.000

**Creep**
- Include creep: 0.000
Material properties and material database
Modelling soil and interface behaviour

Parameters for stiffness

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$E_{28}$</td>
<td>Young's modulus of cured concrete at $t_{hydr}$</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$\nu$</td>
<td>Poisson's ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>

Parameters for strength:

### Compression

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f_{c28}$</td>
<td>Uniaxial compressive strength of cured concrete at $t_{hydr}$</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$f_{0n}$</td>
<td>Normalised failure strength</td>
<td>[-]</td>
</tr>
<tr>
<td>$f_{cfn}$</td>
<td>Normalised initially mobilised strength</td>
<td>[-]</td>
</tr>
<tr>
<td>$f_{un}$</td>
<td>Normalised residual strength</td>
<td>[-]</td>
</tr>
<tr>
<td>$G_{c28}$</td>
<td>Compressive fracture energy of cured concrete at $t_{hydr}$</td>
<td>[kN/m]</td>
</tr>
<tr>
<td>$\varphi_{max}$</td>
<td>Maximum friction angle</td>
<td>[°]</td>
</tr>
<tr>
<td>$\psi$</td>
<td>Dilatancy angle</td>
<td>[°]</td>
</tr>
<tr>
<td>$\gamma_{fc}$</td>
<td>Safety factor for compressive strength</td>
<td>[-]</td>
</tr>
</tbody>
</table>

### Tension

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$f_{t28}$</td>
<td>Uniaxial tensile strength of cured concrete at $t_{hydr}$</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$f_{un}$</td>
<td>Ratio of residual vs. peak tensile strength</td>
<td>[-]</td>
</tr>
<tr>
<td>$G_{t28}$</td>
<td>Tensile fracture energy of cured concrete at $t_{hydr}$</td>
<td>[kN/m]</td>
</tr>
<tr>
<td>$\gamma_{ft}$</td>
<td>Safety factor for tensile strength</td>
<td>[-]</td>
</tr>
</tbody>
</table>

The model has a single parameter for ductility:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$a_{duct}$</td>
<td>Increase of peak strain $\varepsilon_{cp}$ with the increase of mean effective stress $p$</td>
<td>[-]</td>
</tr>
</tbody>
</table>

Parameters for time-dependent behaviour:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$t_{hydr}$</td>
<td>Time for full hydration</td>
<td>[day]</td>
</tr>
</tbody>
</table>

Stiffness

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>$E_{1} / E_{28}$</td>
<td>Ratio of the Young's modulus after 1 day curing over the Young's modulus at full hydration</td>
<td></td>
</tr>
</tbody>
</table>

Strength
### Strength function

Strength development function for the first 24 hours of curing

### $f_{c,1} / f_{c,28}$

Ratio of the compressive strength after 1 day curing over the compressive strength at full hydration

- \([-\text{-}]\)

### Ductility

- $\varepsilon_{\text{pcp},1h}$: Uniaxial plastic failure strain at 1h (negative value)
- $\varepsilon_{\text{pcp},8h}$: Uniaxial plastic failure strain at 8h (negative value)
- $\varepsilon_{\text{pcp},24h}$: Uniaxial plastic failure strain at 24h (negative value)

### Shrinkage

- Include shrinkage: To be selected if shrinkage should be taken into account
- $\varepsilon_{\infty}^{s}$: Final shrinkage strain
- $t_{50}^{cr}$: Time for 50% of shrinkage strains

### Creep

- Include creep: To be selected if creep should be taken into account
- $\phi_{cr}$: Ratio between creep and elastic strains
- $t_{50}^{cr}$: Time for 50% of creep strains

### Note:

- When simulating shotcrete the tensile strength is essential for tunnel stability. Neglecting or considering low values for tensile strength could result in unrealistic failure.
- The creep history is adjusted for the stress state at first activation of the concrete cluster, such that no creep strains are produced by initial stresses. The state variables are taken over if the previous material was also defined with the Concrete model, in which case creep will also continue. If a reset of state variables is desired, a nil step with a different material (e.g. linear elastic) is required.

### 6.1.2.15 User-defined soil model (UDSM) [ADV] + [GSE]

The **Mechanica** tabsheet shows two drop-down menus; the top combo box lists all the DLLs that contain valid User-defined Soil Model and the next combo box shows the models defined in the selected DLL. Each UD model has its own set of model parameters, defined in the same DLL that contains the model definition.
When an available model is chosen PLAXIS 2D will automatically read its parameter names and units from the DLL and fill the parameter table below. For a detailed description of this facility, reference is made to the Material Models Manual.

**Note:**
Available drainage types when user-defined soil model is selected are: *Drained, Undrained A* and *Non-porous*.

### 6.1.2.16 UBC3D-PLM model [ULT]

The **Mechanical** tabsheet for the UBC3D-PLM model is shown in [Figure 146](on page 212).

**Note:**
Available drainage types when UBC3D-PLM model is selected are: *Drained* and *Undrained A*.
Material properties and material database

Modelling soil and interface behaviour

Figure 146: Mechanical tabsheet for the UBC3D-PLM model

The stiffness parameters of the UBC3D-PLM model are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$k_B^{*e}$</td>
<td>Elastic bulk modulus factor</td>
<td>[-]</td>
</tr>
<tr>
<td>$k_G^{*e}$</td>
<td>Elastic shear modulus factor</td>
<td>[-]</td>
</tr>
<tr>
<td>$k_G^{*p}$</td>
<td>Plastic shear modulus factor</td>
<td>[-]</td>
</tr>
</tbody>
</table>
Parameters for stress dependent elastic bulk modulus

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>me</td>
<td>Power for stress dependent elastic bulk modulus</td>
<td>[-]</td>
</tr>
<tr>
<td>ne</td>
<td>Power for stress dependent elastic shear modulus</td>
<td>[-]</td>
</tr>
<tr>
<td>np</td>
<td>Power for stress dependent plastic shear modulus</td>
<td>[-]</td>
</tr>
<tr>
<td>( \rho_{\text{ref}} )</td>
<td>Reference pressure for stress dependent stiffness</td>
<td>[kN/m²]</td>
</tr>
</tbody>
</table>

**Note:**
The implicit Poisson's ratio that is defined based on \( k_e^B \) and \( k_e^G \) is suitable for dynamics calculation, but it does not generate a proper initial stress state if the initial stress condition is established by gravity loading procedure. In such a case the user should define another material set for the stress initialization step with proper characteristics.

Parameters for strength:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td>Cohesion</td>
<td>[kN/m²]</td>
</tr>
<tr>
<td>( \varphi_{cv} )</td>
<td>Constant volume friction angle</td>
<td>[°]</td>
</tr>
<tr>
<td>( \varphi_p )</td>
<td>Peak friction angle</td>
<td>[°]</td>
</tr>
<tr>
<td>( \sigma_t )</td>
<td>Tensile strength</td>
<td>[kN/m²]</td>
</tr>
</tbody>
</table>

The model requires a single parameter from field data in order to model the effects of densification:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>( (N_1)_{60} )</td>
<td>Corrected SPT blow count</td>
<td>[-]</td>
</tr>
</tbody>
</table>

Advanced parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>f_{\text{dens}}</td>
<td>Densification factor</td>
<td>[-]</td>
</tr>
<tr>
<td>f_{E\text{post}}</td>
<td>Post-liquefaction stiffness factor</td>
<td>[-]</td>
</tr>
<tr>
<td>R_f</td>
<td>Failure ratio</td>
<td>[-]</td>
</tr>
</tbody>
</table>

6.1.2.17 Parameters for Excess pore pressure calculation

The excess pore pressure calculation parameters available in the **Mechanical** tabsheet can be used to model the generation of excess pore pressures in a calculation that involves the Undrained behaviour of soils or a coupled analysis. For the calculation of excess pore pressures in an effective stress calculation, the calculation will add a bulk modulus of water to the stiffness matrix. This bulk modulus can be obtained in 2 different ways (Figure 147 on page 214), namely using the options *v-undrained definition* and *Biot effective stress concept*. When the first option is chosen the user should decide whether to enter the \( \nu_{\text{equivalent}} \) either directly or through the Skempton B value. Note that we refer here to the equivalent undrained Poisson’s ratio as it is not directly used as parameter to calculate excess pore pressures, but merely to determine the bulk modulus of water that is then used to calculate excess pore pressures.
By default, the solid material of the soil (i.e., the grains) is supposed to be incompressible \( \alpha_{\text{Biot}} = 1 \) and the equivalent undrained Poisson's ratio is taken as 0.495. This is the default behaviour. Alternatively, one can select to define the equivalent undrained Poisson's ratio through the Skempton's B-parameter and \( K_{w,\text{ref}}/n \) is calculated accordingly. In the most advanced option, *Biot effective stress concept*, the compressibility of the solid material is considered and one can select \( \alpha_{\text{Biot}} \) together with \( K_w \) after which \( \nu_{u,\text{equivalent}}, \text{Skempton B} \) and \( K_{w,\text{ref}}/n \) are calculated accordingly.

<table>
<thead>
<tr>
<th>( \alpha_{\text{Biot}} )</th>
<th>Biot alpha pore pressure coefficient</th>
<th>[-]</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \nu_{u,\text{equivalent}} )</td>
<td>Equivalent undrained Poisson's ratio</td>
<td>[-]</td>
</tr>
<tr>
<td><em>Skempton-B</em></td>
<td>A parameter that determines which portion of a change in mean stress is carried by the pore water</td>
<td>[-]</td>
</tr>
<tr>
<td>( K_{w,\text{ref}}/n )</td>
<td>The corresponding reference bulk stiffness of the pore fluid</td>
<td>[kN/m(^2)]</td>
</tr>
<tr>
<td>( K_w )</td>
<td>Bulk modulus of water</td>
<td>[-]</td>
</tr>
</tbody>
</table>

More detailed information is available in the Material Models Manual.

![Parameters for the Excess pore pressure calculation](image1)

### 6.1.3 Hoek-Brown pre-processing tool

The Hoek-Brown model is the most used failure criterion for rock masses, nevertheless there are some uncertainties regarding the input parameters that require a consolidated experience (Hoek, Carranza-Torres & Corkum (2002); Hoek (2007)). For this reason, PLAXIS 2D implements in the *Mechanical* tabsheet of the Hoek-Brown model a pre-processing tool to guide the user in the determination of the rock mass strength and stiffness parameters. PLAXIS 2D sign convention is adopted, i.e. compressive stresses are considered to be negative. The pane contains the following tabsheets:
Analysis: shows the Hoek-Brown failure envelope in the plane of principal effective stresses $\sigma'_3 - \sigma'_1$, in order to visualise the effects of changing of rock mass parameters on the failure envelope. For more information about the Hoek-Brown model and its formulation, refer Material Models Manual.

The second tabsheet is specific to determine the selected parameter.

### 6.1.3.1 Uni-axial compressive strength of intact rock $|\sigma_{ci}|$

The uni-axial compressive strength of intact rock $|\sigma_{ci}|$ can be checked based on the estimation methods generally executed in the field. Alternatively, a range can be selected and PLAXIS 2D automatically set the parameter to the middle value of the range. In case the upper bound limit of 250 MPa is selected, the parameter is set to 250 MPa.

Table 4 (on page 215) reports the range of compressive strength for each category with a qualitative description of the strength behaviour to field test.

<table>
<thead>
<tr>
<th>Field estimate</th>
<th>Examples</th>
<th>Strength [MPa]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only chipping is possible with a geological hammer</td>
<td>Chert, diabase, fresh basalt, gneiss, granite, quartzite</td>
<td>$</td>
</tr>
<tr>
<td>Fracturing requires many blows of a geological hammer</td>
<td>Amphibolite, basalt, gabbro, gneiss, granodiorite, limestone, marble, rhyolite, sandstone, tuff</td>
<td>$100 \leq</td>
</tr>
<tr>
<td>Fracturing requires more than one blow of a geological hammer</td>
<td>Limestone, marble, phyllite, sandstone, schist, shale</td>
<td>$50 \leq</td>
</tr>
<tr>
<td>Fracturing is possible with a single blow from a geological hammer, but cannot be scraped or peeled with a pocket knife</td>
<td>Claystone, coal, concrete, schist, shale, siltstone</td>
<td>$25 \leq</td>
</tr>
<tr>
<td>Firm blow with the point of a geological hammer leaves shallow indentation; peeling with a pocket knife is possible, but difficult</td>
<td>Chalk, potash, rocksalt</td>
<td>$5 \leq</td>
</tr>
<tr>
<td>Firm blow with the point of geological hammer leads to crumbling; peeling with a pocket knife is possible</td>
<td>Highly weathered or altered rock</td>
<td>$1 \leq</td>
</tr>
<tr>
<td>Thumbnail leaves indentation</td>
<td>Stiff fault gouge</td>
<td>$0.25 \leq</td>
</tr>
</tbody>
</table>

### 6.1.3.2 Intact rock parameter $m_i$

The intact rock parameter $m_i$ can be estimated based on the rock type.
<table>
<thead>
<tr>
<th>Name</th>
<th>Rock type</th>
<th>Texture</th>
<th>$m_i$</th>
<th>$m_i \pm \mu m$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agglomerate</td>
<td>Igneous</td>
<td>Coarse</td>
<td>19</td>
<td>3</td>
</tr>
<tr>
<td>Amphibolites</td>
<td>Metamorphic</td>
<td>Medium</td>
<td>26</td>
<td>6</td>
</tr>
<tr>
<td>Andesite</td>
<td>Igneous</td>
<td>Medium</td>
<td>25</td>
<td>5</td>
</tr>
<tr>
<td>Anhydrite</td>
<td>Sedimentary</td>
<td>Fine</td>
<td>12</td>
<td>2</td>
</tr>
<tr>
<td>Basalt</td>
<td>Igneous</td>
<td>Fine</td>
<td>25</td>
<td>5</td>
</tr>
<tr>
<td>Breccia</td>
<td>Igneous</td>
<td>Medium</td>
<td>19</td>
<td>5</td>
</tr>
<tr>
<td>Breccia</td>
<td>Sedimentary</td>
<td>Coarse</td>
<td>19</td>
<td>5</td>
</tr>
<tr>
<td>Chalk</td>
<td>Sedimentary</td>
<td>Veryfine</td>
<td>7</td>
<td>2</td>
</tr>
<tr>
<td>Claystones</td>
<td>Sedimentary</td>
<td>Veryfine</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>Conglomerates</td>
<td>Sedimentary</td>
<td>Coarse</td>
<td>21</td>
<td>3</td>
</tr>
<tr>
<td>Crystallinelimestone</td>
<td>Sedimentary</td>
<td>Coarse</td>
<td>12</td>
<td>3</td>
</tr>
<tr>
<td>Dacite</td>
<td>Igneous</td>
<td>Fine</td>
<td>25</td>
<td>3</td>
</tr>
<tr>
<td>Diabase</td>
<td>Igneous</td>
<td>Fine</td>
<td>15</td>
<td>5</td>
</tr>
<tr>
<td>Diorite</td>
<td>Igneous</td>
<td>Medium</td>
<td>25</td>
<td>5</td>
</tr>
<tr>
<td>Dolerite</td>
<td>Igneous</td>
<td>Medium</td>
<td>16</td>
<td>5</td>
</tr>
<tr>
<td>Dolomites</td>
<td>Sedimentary</td>
<td>Veryfine</td>
<td>9</td>
<td>3</td>
</tr>
<tr>
<td>Gabbro</td>
<td>Igneous</td>
<td>Coarse</td>
<td>27</td>
<td>3</td>
</tr>
<tr>
<td>Gneiss</td>
<td>Metamorphic</td>
<td>Fine</td>
<td>28</td>
<td>5</td>
</tr>
<tr>
<td>Granite</td>
<td>Igneous</td>
<td>Coarse</td>
<td>32</td>
<td>3</td>
</tr>
<tr>
<td>Granodiorite</td>
<td>Igneous</td>
<td>Coarse,Medium</td>
<td>29</td>
<td>3</td>
</tr>
<tr>
<td>Greywackes</td>
<td>Sedimentary</td>
<td>Fine</td>
<td>18</td>
<td>3</td>
</tr>
<tr>
<td>Gypsum</td>
<td>Sedimentary</td>
<td>Medium</td>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>Hornfels</td>
<td>Metamorphic</td>
<td>Medium</td>
<td>19</td>
<td>4</td>
</tr>
<tr>
<td>Marble</td>
<td>Metamorphic</td>
<td>Coarse</td>
<td>9</td>
<td>3</td>
</tr>
<tr>
<td>Marls</td>
<td>Sedimentary</td>
<td>Veryfine</td>
<td>7</td>
<td>2</td>
</tr>
</tbody>
</table>
### Material properties and material database

**Modelling soil and interface behaviour**

<table>
<thead>
<tr>
<th>Name</th>
<th>Rock type</th>
<th>Texture</th>
<th>$m_i$</th>
<th>$m_i \pm m$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metasandstone</td>
<td>Metamorphic</td>
<td>Medium</td>
<td>19</td>
<td>3</td>
</tr>
<tr>
<td>Micriticlimestones</td>
<td>Sedimentary</td>
<td>Fine</td>
<td>9</td>
<td>2</td>
</tr>
<tr>
<td>Migmatite</td>
<td>Metamorphic</td>
<td>Coarse</td>
<td>29</td>
<td>3</td>
</tr>
<tr>
<td>Norite</td>
<td>Igneous</td>
<td>Coarse, Medium</td>
<td>20</td>
<td>5</td>
</tr>
<tr>
<td>Obsidian</td>
<td>Igneous</td>
<td>Veryfine</td>
<td>19</td>
<td>3</td>
</tr>
<tr>
<td>Peridotite</td>
<td>Igneous</td>
<td>Veryfine</td>
<td>25</td>
<td>5</td>
</tr>
<tr>
<td>Phyllites</td>
<td>Metamorphic</td>
<td>Fine</td>
<td>7</td>
<td>3</td>
</tr>
<tr>
<td>Porphyries</td>
<td>Igneous</td>
<td>Coarse, Medium</td>
<td>20</td>
<td>5</td>
</tr>
<tr>
<td>Quartzites</td>
<td>Metamorphic</td>
<td>Fine</td>
<td>20</td>
<td>3</td>
</tr>
<tr>
<td>Rhyolite</td>
<td>Igneous</td>
<td>Medium</td>
<td>25</td>
<td>5</td>
</tr>
<tr>
<td>Sandstones</td>
<td>Sedimentary</td>
<td>Medium</td>
<td>17</td>
<td>4</td>
</tr>
<tr>
<td>Schists</td>
<td>Metamorphic</td>
<td>Medium</td>
<td>12</td>
<td>3</td>
</tr>
<tr>
<td>Shales</td>
<td>Sedimentary</td>
<td>Veryfine</td>
<td>6</td>
<td>2</td>
</tr>
<tr>
<td>Siltstones</td>
<td>Sedimentary</td>
<td>Fine</td>
<td>7</td>
<td>2</td>
</tr>
<tr>
<td>Slates</td>
<td>Metamorphic</td>
<td>Veryfine</td>
<td>7</td>
<td>4</td>
</tr>
<tr>
<td>Spariticlimestones</td>
<td>Sedimentary</td>
<td>Medium</td>
<td>10</td>
<td>2</td>
</tr>
<tr>
<td>Tuff</td>
<td>Igneous</td>
<td>Fine</td>
<td>13</td>
<td>5</td>
</tr>
</tbody>
</table>

#### 6.1.3.3 Geological Strength Index $GSI$

The $GSI$ tabsheet allows to choose between two rock types: *General Figure 148* (on page 218) and *Flysch Figure 149* (on page 219). An intact rock is equivalent to $GSI = 100$, whereas a soil structure is in proximity to $GSI = 0$. Based on the selected rock type, the $GSI$ can be chosen taking the structure and the surface conditions of the rock mass into account. An hint box at the bottom of the chart displays the rock characteristics for the selected $GSI$.

**Note:**

The $GSI$ charts allows only integer values. If a higher accuracy is required, a decimal value can be manually put in the *Input* tabsheet of the material set.
## Material properties and material database

Modelling soil and interface behaviour

<table>
<thead>
<tr>
<th>STRUCTURE</th>
<th>SURFACE CONDITIONS</th>
<th>VERY GOOD</th>
<th>GOOD</th>
<th>FAIR</th>
<th>POOR</th>
<th>VERY POOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTACT OR MASSIVE</td>
<td>Very rough, fresh, unweathered surfaces.</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>BLOCKY</td>
<td>Rough, slightly weathered, iron stained surfaces.</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>VERY BLOCKY</td>
<td>Smooth, moderately weathered and altered surfaces.</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>BLOCKY DISTURBED/SEAMY</td>
<td>Smoothly weathered, slickensided, highly weathered surfaces with smooth or rough, angular or rounded rock fragments.</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>DISINTEGRATED</td>
<td>Poorly interlocked, heavily broken rock mass with mixture of angular and rounded rock pieces.</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>LAMINATED/SHEARED</td>
<td>Lack of blockiness due to close spacing of weak schistosity or shear planes.</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td></td>
</tr>
</tbody>
</table>

Figure 148: GSI chart for General rock type
6.1.3.4 Disturbance factor ($D$)

The disturbance factor $D$ depends on the amount of disturbance of the rock as a result of mechanical processes in open excavations, tunnels or mines, such as blasting, tunnel boring, machine driven or manual excavation. No disturbance is equivalent to $D = 0$, whereas severe disturbance is equivalent to $D = 1$. The $D$ tabsheet allows a direct estimation of the disturbance factor for tunnel Table 6 (on page 220) and slopes Table 7 (on page 220).

In blast damaged rock, there are two main issues when applying the disturbance factor $D$:

- Choose a suitable value: a large number of factors can influence the degree of disturbance (quality of the rock mass and the excavation/blasting, loading sequence, lateral confinement produced by different radii of curvature of slopes as compared with their height, the level of strain in the failure zone, etc.). For this reason, the disturbance factor $D$ is inferred on the basis of engineering experience and research Table 6 (on page 220)Table 7 (on page 220).

- Define the extent of the damaged zone: the disturbance factor $D$ should only be applied to the actual zone of damaged rock in order to avoid underestimation of the strength and stability of the overall rock mass greatly. The thickness $T$ of the blast damaged zone depends upon the design of the blast (Hoek & Karzulovic, 2000). In the case of bench blasting in open pit mines and civil engineering slopes, Table 8 (on page 220) contains suggested values, where $H$ is the height of the slope. In the case of tunnels excavated by drill and blast methods, for very high quality controlled blasting the damage to the tunnel wall is negligible due to a well-designed blasting pattern, detonation sequence and accurate drilling control. In contrast, the lack of a good blast design and absence of any control on the drilling can result in significant damage.
Table 6: Disturbance factor $D$, guidelines for tunnels

<table>
<thead>
<tr>
<th>Description</th>
<th>$D$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tunnel excavation by TBM or blasting of excellent quality</td>
<td>0.0</td>
</tr>
<tr>
<td>Tunnel excavation by hand or using a mechanical process rather than blasting, in poor quality rock. There are no squeezing problems leading to floor heave, or these are mitigated using a temporary invert</td>
<td>0.0</td>
</tr>
<tr>
<td>Tunnel excavation by hand or using a mechanical process rather than blasting, in poor quality rock. There are unmitigated squeezing problems leading to floor heave</td>
<td>0.5</td>
</tr>
<tr>
<td>Tunnel excavation using blasting of very poor quality, leading to severe local damage</td>
<td>0.8</td>
</tr>
</tbody>
</table>

Table 7: Disturbance factor $D$, guidelines for slopes

<table>
<thead>
<tr>
<th>Description</th>
<th>$D$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slope created using controlled, small scale blasting of good quality</td>
<td>0.7</td>
</tr>
<tr>
<td>Slope created using small scale blasting of poor quality</td>
<td>1.0</td>
</tr>
<tr>
<td>Slope in very large open pit mine, created using mechanical excavation in softer rocks</td>
<td>0.7</td>
</tr>
<tr>
<td>Slope in very large open pit mine, created using heavy production blasting</td>
<td>1.0</td>
</tr>
</tbody>
</table>

Table 8: Damaged thickness $T$, guidelines for bench blasting in open pit mines and civil engineering slopes

<table>
<thead>
<tr>
<th>Description</th>
<th>$T$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large production blast, confined and with little or no control</td>
<td>2.0 to 2.5 H</td>
</tr>
<tr>
<td>Production blast with no control but blasting to a free face</td>
<td>1.0 to 1.5 H</td>
</tr>
<tr>
<td>Production blast, confined but with some control, e.g. one or more buffer rows</td>
<td>1.0 to 1.2 H</td>
</tr>
<tr>
<td>Production blast with some control, e.g. one or more buffer rows, and blasting to a free face</td>
<td>0.5 to 1.0 H</td>
</tr>
<tr>
<td>Carefully controlled production blast with a free face</td>
<td>0.3 to 0.5 H</td>
</tr>
</tbody>
</table>

6.1.4  Cyclic accumulation and optimisation tool [ADV]

The Cyclic accumulation and optimisation tool is used to determine the UDCAM-S model parameters. The model is especially suited for the foundation design of offshore structures subjected to a design storm (i.e. a combination of a wave, wind loading, and current). The stiffness and strength of saturated soils under cyclic loading are different from the static case: they may increase due to strain rate effects or reduce due to degradation processes, as pore pressure build up and destructuration. The soil beneath structures subjected to
cyclic loading experiences different behaviour following different stress paths. For a general stress path, the behaviour may be interpolated between triaxial compression (TxC), triaxial extension (TxE) and direct simple shear (DSS) conditions.

The *Cyclic accumulation and optimisation tool* offers the possibility to check the effect of a specified input load history for a specific soil type and, through an accumulation and interpolation procedure, it provides stress-strain curves for the different characteristic stress paths. The UDCAM-S model parameters are optimised in order to match the stress-strain curves.

The tool is suitable only for clay and low permeable silts in undrained condition since the effect of drainage is not taken into account. The accumulation procedure is based on the cyclic shear strains.

**Note:**

In addition to the cyclic shear strain accumulation procedure, the pore pressure accumulation and average shear strain accumulation procedures can be found in literature. The reason for using different procedures is that the development of one of these parameters may be more prominent than the others, depending on soil type, static and cyclic shear stresses, etc. ([Andersen, 1991](#) on page 586). The cyclic shear strain accumulation procedure has been extensively used for clays, while the pore pressure accumulation procedure has been used for sands since drainage is likely to occur during the complete load history (even though not within each cycle) in this type of soils. In principle, the pore pressure accumulation procedure could also be used for clays. In practice, however, accurate laboratory measurement of pore pressure is harder to perform in clays than in sand. Since drainage is not likely to occur during the cyclic load history in clays, it is preferable to use the cyclic strain accumulation procedure ([Andersen, 2004](#) on page 586).

### 6.1.4.1 Starting the tool

To start the tool, the *Cyclic accumulation and optimisation tool* is clicked from the side panel in the Mechanical tabsheet of the UDCAM-S model. The window consists of two blue tabs and one orange tab, see [Figure 150](#) (on page 222) for an overview.
The first blue tabsheet, *Cyclic accumulation*, gives information regarding the input load history and the soil type. The second blue tabsheet, *Stress-strain curves*, gives information about the stress-strain curves for different stress paths. The orange tabsheet *Parameter optimisation*, allows the user to optimise the UDCAM-S model parameters.

Above the tabsheets there are *Load* and *Save* buttons (see Figure 151) to load or save the app state. Saving and loading the app state is useful when running the same or similar calculations again, after the project has been closed and reopened. Also, similar calculations in different projects can be done more easily by loading a previously saved state.

The state is saved in the JSON file format with the .json extension. All the settings and data on the tabsheet, like table values and graph data are saved and can be loaded back into the tool.
6.1.4.2 Cyclic accumulation

In the design process of offshore structures, the design load is often a storm which can be transformed or idealised into packages or parcels. Each parcel corresponds to a number of cycles at a load constant amplitude. The maximum cyclic load and the number of cycles at each load level are determined from a time record of loads. The counting procedure to obtain the number of cycles can be done following different methods (e.g. the rainflow-counting algorithm (Matsuishi & Endo (1968)) or the recently developed method, for more information see Noren, Cosgriff, Josatd & Madshus (2015)).

The effect of the design storm on the soil deposit can be described through the equivalent number of cycles \( N_{eq} \) associated to the last applied normalised load amplitude \( F/F_{max} \) and the soil cyclic contour diagram. The equivalent number of cycles \( N_{eq} \) is calculated at failure for capacity calculations. If it is found to be conservative, the same value may also be used in stiffness calculations.

Note:

It is assumed here that \( N_{eq} \) is representative for all the elements in the selected soil polygon. Even though this assumption may underestimate the effect of the stress redistribution and progressive failure, it has been shown that the results are in good agreement with the ones from the model tests (Andersen, Puech & Jardine, 2013) and can certainly be used for stiff shallow foundations like offshore structures, while for monopiles and piles this is generally not correct.

The cyclic contours (Figure 152) are a set of curves where each of them represents the locus of points characterised by the same cyclic shear strain. They can be visualized in a chart with the number of cycles on the x-axis (in a logarithmic scale) and \( \tau_c/\sigma_u \) on the y-axis. Each point of the contour is then characterised by a certain number of cycles and a normalised shear stress that induce a defined cyclic shear deformation in the soil. The contours are defined for DSS tests with the average stress \( \tau_u \) equals to 0 (for Drammen clay).
Four lines limit the contours:

- Each contour line starts with a point at N equal to 1 and an ending point at N equal to the number of cycles above which all the contours are assumed to become horizontal (i.e. $\tau_{\text{cyc}}$ is constant). This leads to two vertical boundaries, $N = 1$ and $N = N_{\text{max}}$.
- The first contour is always defined at zero stress level, i.e. the contour line at the base where $\tau_{\text{cyc}}/s_u$ is equal to zero and $\gamma_{\text{cyc}} = 0\%$.
- The last contour represents the locus of points corresponding to $\gamma$ equal to the cyclic shear strain at failure (typically 15\%).

**Contour diagram data**

The cyclic behaviour of clays depends on OCR, as well as the other index properties such as Plasticity Index, clay content, water content, etc. NGI has extensively studied the cyclic behaviour of Drammen clays, realizing contour diagrams from DSS tests. These contour data for Drammen clay with OCR equal to 1, 2, 4, 10, 20 and 40 are available in the tool and can be selected from the drop-down menu.

In the case of other clays, it is possible to upload custom contours. In general, the contours can be determined by different tests at different average shear stress levels, $\tau_a$. For Drammen clay, $N_{\text{eq}}$ was found to be relatively independent of $\tau_a$ and the type of test (Andersen, Kleven & Heien, 1988 (on page 586)) and the shear strain at failure was taken as 15\%.

**Note:** When uploading custom contours, a specific data format has to be used. For more information, see Cyclic accumulation Tool - Contour File Formats [ADV] (on page 592).
By moving the mouse over any line in the contour chart, a hint box appears showing the value of $\gamma_{\text{cyc}}$ that describes that contour and the corresponding $N_{\text{cycles}}$ and $\tau_{\text{cyc}}/s_u$ values.

**Note:**

- The shear strain at a given degree of shear strength mobilisation, $\tau / s_u$, increases with increasing OCR, meaning that the normalised secant modulus, $G/s_u$, decreases with increasing OCR for a given degree of strength mobilisation. However, the absolute value of the stiffness will increase with increasing OCR for given consolidation stress and strength mobilisation but significantly less than the increase in shear strength (Andersen, 2015 (on page 586)).
- Even though in most cases the strength of the soil under cyclic loading may be reduced compared to the static value, because of the degradation process, the cyclic shear strength can also be higher than the static shear strength (i.e. $\tau_{\text{cy}} / s_u > 1$) for a low number of cycles in some cases. The reason for this is that the clay strength is rate dependent. Since the cyclic tests are typically run with a load period of 10 seconds and the monotonic tests are brought to failure in about 2 hours, the cyclic strength may thus be higher than the static shear strength (Andersen, 2007 (on page 586)).

**Load ratio ($F/F_{\text{max}}$)**

The idealised load history, described by a series of parcels, is specified in a table that consists of four columns. The first one indicates the number of the load parcel, the second one represents the load ratio value $F / F_{\text{max}}$ for each parcel, the third one shows the corresponding number of cycles and the last one is the output of the calculation performed in this tabsheet (i.e. the stress ratio). The load ratio $F/F_{\text{max}}$ refer to pure cyclic loading condition (horizontal force, vertical force or bending moment). The user should define which load direction is more crucial for the model and calculate consequently $F/F_{\text{max}}$. For capacity analysis, when $F$ is equal to $F_{\text{max}}$ (i.e. the load ratio is equal to 1), failure has been reached and the shear strain is equal to its failure value $\gamma_f$. The normalized shear strength $\tau/s_u$ at $\gamma_f$ corresponds to its maximum value. A linear relationship between the load and the shear stress is assumed, so that:

$$\left(\frac{\tau}{s_u}\right)_{\text{max}} = \chi \frac{F}{F_{\text{max}}} \quad \text{Eq. \{15\}}$$

where $\chi$ is the scaling factor automatically calculated during the strain accumulation procedure. At the end of the accumulation procedure, the maximum stress ratio $\tau/s_u$ is displayed in the corresponding column in the Figure 153 (on page 226).

The buttons in the toolbar can be used to modify the Figure 153 (on page 226).
Material properties and material database
Modelling soil and interface behaviour

![Input table for load parcels of the cyclic accumulation and optimisation tool](image)

**Figure 153: Input table for load parcels of the cyclic accumulation and optimisation tool**

- Click the *Add row* button in the toolbar to add a new row in the table.
- Click the *Insert* button to insert a new row before the selected row in the table.
- Click the *Delete* button to delete the selected row in the table.

The values can be defined by clicking the cell in the table and by typing the value. A maximum of 100 load parcels can be entered. The load ratio can be defined as any positive value larger than zero; its maximum value is 1. The number of cycles is a positive integer larger than zero.

As soon as a parcel is specified in the table, the graph "Load ratio vs N cycles" at the bottom of the same tab will be updated. There is an option to choose for a logarithmic representation on the y-axis. See an example of where a series of parcels were defined in *Figure 154* (on page 227).

- If the data for the load parcels exists in a file, it can be loaded by clicking the *Open file*. Any delimited tabular text file or an excel spreadsheet file can be loaded. When the selected file is opened, a window pops up where the user can choose the columns to extract the data from, see *Figure 153* (on page 226). Also, the field separator (delimiter) and start row can be defined. A preview of what is going to be imported is shown.

- A load history, defined in the table, can be copied using the *Copy* button in the toolbar.

- Copied data from other applications (using Ctrl+c) can be imported by using the *Paste* button.
Material properties and material database
Modelling soil and interface behaviour

Figure 154: Automatic update of Load ratio graph when specifying parcels

Note:
If a load parcel is characterized by a number of cycles larger than the maximum value represented in the contours diagram, it is advised to decompose it into two or more load parcels with slightly different load ratios and lower number of cycles such that their sum is equal to the initial total $N_{cycles}$.

Figure 155: Import load parcels settings dialog
To start the strain accumulation procedure, click the *Calculate* button. Prior to the calculation, the tool performs some consistency checks on the input data to ensure that both the load parcel table and the contour diagram are defined.

At the end of the calculation, the box of the equivalent number of cycles $N_{eq}$ is updated with the value resulting from the strain accumulation procedure. The last accumulation up to failure is now visible in the contour diagrams together with the locus of the end points for each accumulation (i.e. for all scaling factors used in the process).

**Cyclic accumulation tab possible errors**

The errors that may occur in the *Cyclic accumulation* tab are listed in *Calculation warning and errors in PLAXIS* (on page 662).

### 6.1.4.3 Stress-strain curves

The *Stress-strain curves* tabsheet allows to determine the stress-strain curves for different stress paths. The curves are determined based on contour diagrams for different laboratory test types at a given equivalent number of cycles. It is possible to choose among several Drammen clay contours (for OCR = 1, 2, 4, 10, 20 and 40) or to upload custom diagrams.

**Note:** When uploading custom contour diagrams, a specific data format has to be used. Please see *Cyclic accumulation* (on page 592) for more information.

The Drammen clay contours have been built as result of a large DSS and triaxial cycling testing programme (*Andersen et al., 1988* (on page 586)). Each point in the diagram is described by the average and cyclic shear stresses, $\tau_a$ and $\tau_{cyc}$, under which the tests were run, normalised with respect to the static undrained shear strength in triaxial compression $s_{u,c}$, together with the number of cycles and the corresponding value of the average and cyclic shear strain at failure. For Drammen clay, failure is considered to be reached when either $\gamma_a$ or $\gamma_{cyc}$ is equal to 15%. The total maximum shear stress $\tau_{f,cyc}$ that can be mobilized is given by the sum of the average and the cyclic shear stress. In each diagram, the cyclic shear strength is determined for a case with a constant cyclic shear stress during the cyclic load history. In reality, during a storm, the cyclic shear stress varies from one cycle to the next one. The value of $N_{eq}$ is therefore essential to use these diagrams. By grouping the test results for selected number of cycles, it has been established contour diagrams for $N = 1, 10, 100, 1000$. The *Stress-strain curves* tabsheet automatically interpolates the contours for the desired $N_{eq}$, representative of the real cyclic load history.
By default, the equivalent number of cycles is copied from the *Cyclic accumulation* tabsheet. The contour diagrams for DSS and triaxial tests are selected to be consistent with the chosen ones to perform the strain accumulation procedure. If a custom contour has been chosen, it is necessary to upload a custom contour for the strain interpolation procedure (describe format of the file). This can be done by setting $N_{eq}$ *determination > Manual*. Then the option *Contour diagrams* will enable to Select contour diagrams by selecting *Custom contours* from the drop-down list.

**Note:**

For an advanced use of the tool, it is possible to select the *Manual* option from the $N_{eq}$ *determination* drop-down menu. This allows to manually enter a value for $N_{eq}$ or to modify the existing one, as well as selecting another contour diagram from the list in the corresponding drop-down menu.

If the *Soil behaviour* is *Anisotropic*, i.e. the stress-strain curves are determined both for DSS and for triaxial tests, it is generally expected that the anisotropy ratios $\tau_{DSS}/\tau^C$ and $\tau_{TX}/\tau^C$ are different from 1. On the contrary, when choosing the *Isotropic* option in the corresponding drop-down menu, the strain interpolation is performed for the DSS test only and the anisotropy ratios are all equal to 1.

Two different scaling factors can be used to scale the y-axis of the DSS and triaxial diagrams, respectively.

The stress-strain curves are determined by specifying the ratio of the cyclic shear stress to the average shear stress for each test condition (DSS, TXC, TXE) according to the desired failure mode and loading condition. When a stress ratio different from zero is defined, the path line is automatically updated in the corresponding chart.

Note that the starting point of the path line is always on the x-axis ($\tau_{cyc}/s_u^C$ and $\gamma_{cyc}$ equal to zero) but it does not always coincide with the origin of the diagram: it is represented by the intersection point between the x-axis and the contour line that corresponds to $\gamma_a = 0\%$. For the DSS test, when the average strain is equal to zero also
\( \tau_a/s_u^c \) is equal to zero, while for the triaxial tests, the intersection generally occurs at \( \tau_a/s_u^c \) different from zero. In fact, it corresponds to the initial in situ mobilization \( \tau_0/s_u^c \).

**Note:**
The contour diagram shows that the maximum cyclic shear strength is mobilized when large cyclic shear strains occur and when the average shear stress is small. On the contrary, the maximum average shear strength is mobilized when the average shear stress approaches the static shear strength and large average shear strains occur. For average shear stresses between zero and the static shear strength, the failure mode is a combination of average and cyclic shear strains.

The stress ratios should be defined such that \( (\Delta \tau_{cyc}/\Delta \tau_a)^{DSS} \) is representative of the failure mode or, in case of difference between the application direction of the cyclic and average load (e.g. one acts mostly in the horizontal direction and the other one mainly in the vertical), it is advised to calculate \( \tau_{cyc}/\tau_a \) as the ratio between stresses representative for the boundary value problem. The stress ratios for the triaxial stress may be chosen in order to have strain compatibility with the DSS test, i.e. similar average and cyclic shear strains must be reached. As shown in the chart, since each stress ratio represents the inclination of the corresponding stress path line, a negative value must be entered for \( (\Delta \tau_{cyc}/\Delta \tau_a)^{TXE} \) and a positive one for the others.

For establishing stress-strain curves, it is possible to choose among three load types:

- **Cyclic load:** the calculation follows the actual ratio between \( \tau_{cyc} \) and \( \tau_a \) (inclined path), but only the relationship between \( \tau_{cyc} \) and \( \gamma_{cyc} \) is considered.
- **Average load:** the calculation follows the actual ratio between \( \tau_{cyc} \) and \( \tau_a \) (inclined path), but only the relationship between \( \tau_a \) and \( \gamma_a \) is considered.
- **Total load:** the calculation considers the total strength, \( (\tau_{cyc} + \tau_a) \) and the total shear strain, \( (\gamma_{cyc} + \gamma_a) \).

To start generating stress-strain curves, click the **Calculate** button. Prior to the calculation, the tool performs some consistency checks on the input data to ensure that both a valid equivalent number of cycles (larger than 0) and a contour diagram have been selected.
Figure 157: Stress-strain curves tabsheet displaying results after calculation

The Target curves chart shows the stress-strain curves for all tests (e.g. only DSS if the isotropic behaviour has been chosen) and for the selected load type. On the x-axis the shear strain $\gamma$ is plotted in percentage, while the y-axis corresponds to the normalised shear strength $\tau / s_C$. The curves are used as input to the third and last tabsheet Parameter optimisation.

6.1.4.4 Parameter optimisation

In the Parameter optimisation tabsheet (Figure 158 (on page 232)) the UDCAM-S model optimised parameters can be determined by simulating undrained DSS, TxC, and TxE tests on one material point. The optimisation procedure is based on the Particle Swarm Algorithm that allows to find the parameter values resulting in a stress-strain curve that matches the target one. The laboratory test conditions are determined based on the Static properties table.
The parameters with their standard units are listed below.

**Static properties:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$s_{u,\text{ref}}^C$</td>
<td>Reference undrained triaxial compression TxC shear strength</td>
<td>[kN/m²]</td>
</tr>
<tr>
<td>$y_{\text{ref}}$</td>
<td>Reference depth</td>
<td>[m]</td>
</tr>
<tr>
<td>$s_{u,\text{inc}}^C$</td>
<td>Increase of TxC shear strength with depth</td>
<td>[kN/m²/m]</td>
</tr>
<tr>
<td>$\tau_0/s_u^C$</td>
<td>Initial mobilization</td>
<td>[-]</td>
</tr>
<tr>
<td>$s_u^C/\sigma_{yy}'$</td>
<td>Ratio of the undrained compression shear strength over the current vertical effective stress</td>
<td>[-]</td>
</tr>
<tr>
<td>$K_0$</td>
<td>Lateral earth pressure coefficient at rest</td>
<td>[-]</td>
</tr>
</tbody>
</table>

The initial mobilization is determined based on the contour diagrams in the *Stress-strain curves* tabsheet: it corresponds to the value of $\tau_0/s_u^C$ at the intersection point between the x-axis ($y_{\text{cyc}} = 0\%$) and the contour line for $y_a$ equal to 0%.

The $K_0$ determination option is set by default to automatic. This means that the value of $K_0$ used to determine the initial stress condition of the test is determined based on the following equation:

$$K_0 = 1 - \left( \frac{\frac{\tau_0}{s_u^C}}{\frac{s_u^C}{\sigma_{yy}'}} \right) \quad \text{Eq. [16]}$$
Note:

If in the Stress-strain curves tabsheet the user has selected the Cyclic load type, the initial mobilisation and the undrained shear strength normalised by the vertical effective stress cannot be modified and are equal to 0 and 1, respectively.

In the Parameter ranges table it is required to define the minimum and maximum value that should be considered for each parameter during the optimisation procedure. The ranges can be estimated based on the target charts.

Double-clicking on one of the graphs opens the selected chart in a bigger window (Figure 159 (on page 233)). This window shows the selected diagram, the table of the data points that are used to plot it as well as the tangent and the secant values of the plot. Note that the point to be taken into consideration for the calculation of the tangent and the secant values can be determined by clicking on the plot. The secant and the tangent are useful for the back-calculation of stiffness parameters from stress-strain diagrams. The corresponding secant and tangent values are indicated below the table. The graph or the data can be copied to the clipboard by selecting the corresponding option in the drop-down menu displayed when the Copy button is clicked. The diagram can be zoomed in or out using the mouse by first clicking and holding the left mouse button in the diagram area and then moving the mouse to a second location and releasing the mouse button. Moving the mouse from the left upper corner to the right lower corner zooms the diagram to the selected area, whereas moving the mouse from the right lower corner to the left upper corner resets the view. The zoom action can also be undone using the Zoom out option on the toolbar. The wheel button of the mouse can be used for panning: click and hold the mouse wheel down and move the diagram to the desired position.

Figure 159: Chart displaying target, optimised, secant and tangent curves, and corresponding table of values.

Parameter ranges:
### Material properties and material database

#### Modelling soil and interface behaviour

<table>
<thead>
<tr>
<th>$G_{\text{max}}/\tau^C$</th>
<th>Ratio of the initial shear modulus to the cyclic compression shear strength</th>
<th>[-]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\gamma_f^C$</td>
<td>Shear strain at failure in triaxial compression</td>
<td>[%]</td>
</tr>
<tr>
<td>$\gamma_f^E$</td>
<td>Shear strain at failure in triaxial extension</td>
<td>[%]</td>
</tr>
<tr>
<td>$\gamma_f^{\text{DSS}}$</td>
<td>Shear strain at failure in direct simple shear</td>
<td>[%]</td>
</tr>
<tr>
<td>$\tau^C/s_u^C$</td>
<td>Ratio of the cyclic compression shear strength over the undrained static compression shear strength</td>
<td>[-]</td>
</tr>
<tr>
<td>$\tau^E/s_u^C$</td>
<td>Ratio of the cyclic extension shear strength over the undrained static compression shear strength</td>
<td>[-]</td>
</tr>
</tbody>
</table>

The initial shear modulus defines the tangent value of the stress strain curves at the initial shear stress ([Anderson, 2004](#) on page 586)). For high loading levels, the area where $G$ is equal to $G_{\text{max}}$ is very limited and therefore not governing. For most problems, $G_{\text{max}}/s_u^C$ has to be chosen to fit the stress-strain curve in the actual strain range of interest. In the case of isotropic behaviour, $\gamma_f^C$ and $\gamma_f^E$ are set equal to the optimised $\gamma_f^{\text{DSS}}$, while the ratios $\tau^{\text{DSS}}/\tau^C$ and $\tau^E/\tau^C$ are equal to 1.

To run the optimisation procedure, click the *Calculate* button.

The results are shown both in the *Parameter ranges* table and in the charts. The optimum values of the parameters used to obtain the best fit to the test data are shown in the *Optimal value* column of the table. If the optimum value is equal to the minimum or maximum value, it might be that the best value lies outside the specified range. The last column of the table shows the sensitivity of each parameter. A sensitivity of 100% means that the parameter has a high influence on the simulated test results, whereas a low sensitivity values means that the parameter has a low influence on the simulated test results.

The optimised curves are shown in the corresponding test graph. As explained above, each chart can be opened in a larger window by double-clicking it. Also for the optimised curve the table with the data points and the possibility to draw the secant and tangent lines are available.

The optimal values are used to determine the optimised parameters used in the UDCAM-S model and shown in the *Optimised parameters* table ([Figure 158](#) on page 232)).
Figure 160: Optimised Parameters for Cyclic accumulation and optimisation tool

The parameters with their standard units are listed below.

**Derived parameters:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$G_{\text{max}} / \tau^C$</td>
<td>Ratio of the initial shear modulus to the cyclic compression shear strength</td>
<td>[-]</td>
</tr>
<tr>
<td>$\gamma_f^C$</td>
<td>Shear strain at failure in triaxial compression</td>
<td>[%]</td>
</tr>
<tr>
<td>$\gamma_f^E$</td>
<td>Shear strain at failure in triaxial extension</td>
<td>[%]</td>
</tr>
<tr>
<td>$\gamma_f^{\text{DSS}}$</td>
<td>Shear strain at failure in direct simple shear</td>
<td>[%]</td>
</tr>
<tr>
<td>$\tau_{\text{ref}}^C$</td>
<td>Cyclic compression shear strength</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$y_{\text{ref}}$</td>
<td>Reference depth</td>
<td>[m]</td>
</tr>
<tr>
<td>$\tau_{\text{inc}}^C$</td>
<td>Increase of the cyclic shear strength with depth</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$\tau^E / \tau^C$</td>
<td>Ratio of the cyclic extension shear strength over the cyclic compression shear strength</td>
<td>[-]</td>
</tr>
<tr>
<td>$\tau_0 / \tau^C$</td>
<td>Cyclic mobilization</td>
<td>[-]</td>
</tr>
<tr>
<td>$\tau^{\text{DSS}} / \tau^C$</td>
<td>Ratio of the cyclic DSS shear strength over the cyclic compression shear strength</td>
<td>[-]</td>
</tr>
</tbody>
</table>

For more information about the parameters of the UDCAM-S model, reference is made to Material Models Manual - *UDCAM-S*.

To copy the *Optimised parameters* table to the material database, click the *Copy parameters*.
Possible errors of Parameter optimisation tab

For more information on the errors that may occur in the Parameter optimisation tab, refer to Table 27 (on page 670).

6.1.5  **Groundwater tabsheet**

Flow parameters are required when dealing with problems that involve flow of pore water in saturated or unsaturated soils, i.e. when using *Groundwater flow, Consolidation or Fully coupled flow-deformation* types of calculation. When considering steady-state groundwater flow or consolidation of fully saturated soil layers, only the soil's (saturated) permeability is a relevant parameter. However, when considering unconfined flow, seepage, transient (time-dependent) flow or fully coupled flow-deformation analysis, partially saturated soil behaviour becomes an issue and needs to be described in more detail. This requires, amongst other things, the selection of a so-called soil-water retention curve relating the suction (positive pore water stress) in the unsaturated zone to the degree of saturation.

PLAXIS 2D incorporates functions to describe the flow behaviour in the unsaturated zone, among which the famous Mualem-Van Genuchten functions. In order to enable an easy selection of the unsaturated flow parameters in these functions, predefined data sets are available for common types of soil. These data sets can be selected based on standardised soil classification systems.

**Note:**

Although the predefined data sets have been created for the convenience of the user, the users remain at all times responsible for the model parameters that they use. Note that these predefined data sets have limited accuracy.

6.1.5.1  **Hydraulic data sets and models**

The program provides different data sets and models to model the flow in the saturated zone in soil. The data sets available in the program are:

1. **Standard:**

   This option allows for a simplified selection of the most common soil types (*Coarse, Medium, Medium fine, Fine* and *Very fine* non-organic materials and *Organic* material) and is based on the Hypres topsoil classification series ([Wosten, Lilly, Nemmes & Bas, 1999](#)) (on page 588)). The only model available for this data set is *Van Genuchten* (see Material Models Manual - *Hydraulic Models*).

   When one of the soil type options is selected, the particle fractions are automatically defined and the soil type is indicated in the soil texture triangle (Figure 161 (on page 237)). The particle fractions can also be defined by clicking on the corresponding location in the soil texture triangle or by directly typing the values.
2. Hypres:

The Hypres series is an international soil classification system (Wosten, Lilly, Nemmes & Bas, 1999 (on page 588)). The hydraulic models available for Hypres data set are the Van Genuchten model and the Approximate Van Genuchten (see Material Models Manual - Hydraulic Models).

A distinction can be made between Topsoil and Subsoil. In general, soils are considered to be subsoils. The Type drop-down menu for the Hypres data set includes Coarse, Medium, Medium fine, Fine, Very fine and Organic soils.

Note:
Only soil layers that are located not more than 1 m below the ground surface are considered to be Top soils.

The selected soil type and grading (particle fractions) is indicated in the soil texture triangle. As an alternative, the user can also select the type of soil by clicking one of the sections in the triangle or by manually specifying the particle fraction values (Figure 162 (on page 238)).
Figure 162: Groundwater parameters for Hypres data set (Wösten, Lilly, Nemmes & Bas, 1999)

The predefined parameters for both the Van Genuchten model as well as the Approximate Van Genuchten model are shown in Table 9 (on page 238) and Table 10 (on page 239).

**Table 9: Hypres series with Van Genuchten parameters (Wösten, Lilly, Nemmes & Bas, 1999)**

<table>
<thead>
<tr>
<th>Soil class</th>
<th>$\theta_r$ (-)</th>
<th>$\theta_s$ (-)</th>
<th>$k_{sat}$ (m/day)</th>
<th>$g_a$ (1/m)</th>
<th>$g_I$ (-)</th>
<th>$g_a$ (-)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Topsoil</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>coarse</td>
<td>0.025</td>
<td>0.403</td>
<td>0.600</td>
<td>3.83</td>
<td>1.2500</td>
<td>1.3774</td>
</tr>
<tr>
<td>medium</td>
<td>0.010</td>
<td>0.439</td>
<td>0.121</td>
<td>3.14</td>
<td>-2.3421</td>
<td>1.1804</td>
</tr>
<tr>
<td>medium fine</td>
<td>0.010</td>
<td>0.430</td>
<td>0.023</td>
<td>0.83</td>
<td>-0.5884</td>
<td>1.2539</td>
</tr>
<tr>
<td>fine</td>
<td>0.010</td>
<td>0.520</td>
<td>0.248</td>
<td>3.67</td>
<td>-1.9772</td>
<td>1.1012</td>
</tr>
<tr>
<td>very fine</td>
<td>0.010</td>
<td>0.614</td>
<td>0.150</td>
<td>2.65</td>
<td>2.5000</td>
<td>1.1033</td>
</tr>
<tr>
<td><strong>Subsoil</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>coarse</td>
<td>0.025</td>
<td>0.366</td>
<td>0.700</td>
<td>4.30</td>
<td>1.2500</td>
<td>1.5206</td>
</tr>
<tr>
<td>medium</td>
<td>0.010</td>
<td>0.392</td>
<td>0.108</td>
<td>2.49</td>
<td>-0.7437</td>
<td>1.1689</td>
</tr>
</tbody>
</table>
### Table 10: Hypres series with Approximate Van Genuchten parameters

<table>
<thead>
<tr>
<th>Soil Class</th>
<th>( \psi_s (m) )</th>
<th>( \psi_k (m) )</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Topsoil</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>coarse</td>
<td>-2.37</td>
<td>-1.06</td>
</tr>
<tr>
<td>medium</td>
<td>-4.66</td>
<td>-0.50</td>
</tr>
<tr>
<td>medium fine</td>
<td>-8.98</td>
<td>-1.20</td>
</tr>
<tr>
<td>fine</td>
<td>-7.12</td>
<td>-0.50</td>
</tr>
<tr>
<td>very fine</td>
<td>-8.31</td>
<td>-0.73</td>
</tr>
<tr>
<td><strong>Subsoil</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>coarse</td>
<td>-1.82</td>
<td>-1.00</td>
</tr>
<tr>
<td>medium</td>
<td>-5.60</td>
<td>-0.50</td>
</tr>
<tr>
<td>medium fine</td>
<td>-10.15</td>
<td>-1.73</td>
</tr>
<tr>
<td>fine</td>
<td>-11.66</td>
<td>-0.50</td>
</tr>
<tr>
<td>very fine</td>
<td>-15.06</td>
<td>-0.50</td>
</tr>
<tr>
<td>organic</td>
<td>-7.35</td>
<td>-0.97</td>
</tr>
</tbody>
</table>

### 3. USDA:

The USDA series is another international soil classification system ([Carsel & Parrish, 1988](https://example.com)) (on page 587). The hydraulic models available for USDA data set are the Van Genuchten model and the Approximate Van Genuchten (see Material Models Manual).

The Type drop-down menu for the USDA date set includes Sand, Loamy sand, Sandy loam, Loam, Silt, Silt loam, Sandy clay loam, Clay loam, Silty clay loam, Sandy clay, Silty clay and Clay. The selected soil type and grading (particle fractions) are different from the Hypres data sets and can be visualised in the soil texture triangle. As an alternative, the user can also select the type of soil by clicking one of the sections in the triangle or by manually specifying the particle fraction values ([Figure 163](https://example.com)) (on page 240)).
Figure 163: Groundwater parameters for USDA data set (Carsel & Parrish, 1988)

The parameters for the Van Genuchten and the Approximate Van Genuchten models are shown in Table 11 (on page 240) and Table 12 (on page 241).

Table 11: USDA series with Van Genuchten parameters, $g_{f} = 0.5$ (Carsel & Parrish, 1988)

<table>
<thead>
<tr>
<th>Soil texture</th>
<th>$\theta_{r}$ (-)</th>
<th>$\theta_{s}$ (-)</th>
<th>$k_{sat}$ (m/day)</th>
<th>$g_{a}$ (1/m)</th>
<th>$g_{n}$ (-)</th>
</tr>
</thead>
<tbody>
<tr>
<td>sand</td>
<td>0.045</td>
<td>0.43</td>
<td>7.13</td>
<td>14.5</td>
<td>2.68</td>
</tr>
<tr>
<td>loamy sand</td>
<td>0.057</td>
<td>0.41</td>
<td>3.50</td>
<td>12.4</td>
<td>2.28</td>
</tr>
<tr>
<td>sandy loam</td>
<td>0.065</td>
<td>0.41</td>
<td>1.06</td>
<td>7.5</td>
<td>1.89</td>
</tr>
<tr>
<td>loam</td>
<td>0.078</td>
<td>0.43</td>
<td>0.25</td>
<td>3.6</td>
<td>1.56</td>
</tr>
<tr>
<td>silt</td>
<td>0.034</td>
<td>0.46</td>
<td>0.60</td>
<td>1.6</td>
<td>1.37</td>
</tr>
<tr>
<td>silty loam</td>
<td>0.067</td>
<td>0.45</td>
<td>0.108</td>
<td>2.0</td>
<td>1.41</td>
</tr>
<tr>
<td>sandy clay loam</td>
<td>0.100</td>
<td>0.39</td>
<td>0.314</td>
<td>5.9</td>
<td>1.48</td>
</tr>
<tr>
<td>clayey loam</td>
<td>0.095</td>
<td>0.41</td>
<td>0.624</td>
<td>1.9</td>
<td>1.31</td>
</tr>
<tr>
<td>silty clayey loam</td>
<td>0.089</td>
<td>0.43</td>
<td>0.168</td>
<td>1.0</td>
<td>1.23</td>
</tr>
<tr>
<td>sandy clay</td>
<td>0.100</td>
<td>0.38</td>
<td>0.288</td>
<td>2.7</td>
<td>1.23</td>
</tr>
</tbody>
</table>
Soil texture | \( \theta_r \) (-) | \( \theta_s \) (-) | \( k_{sat} \) (m/day) | \( g_a \) (1/m) | \( g_n \) (-)
--- | --- | --- | --- | --- | ---
silty clay | 0.070 | 0.36 | 0.00475 | 0.5 | 1.09
clay | 0.068 | 0.38 | 0.00475 | 0.8 | 1.09

Table 12: USDA series with Approximate Van Genuchten parameters

| Soil texture | \( \psi_s \) (m) | \( \psi_k \) (m) |
--- | --- | ---
sand | -1.01 | -0.50
loamy sand | -1.04 | -0.50
sandy loam | -1.20 | -0.50
loam | -1.87 | -0.60
silt | -4.00 | -1.22
silty loam | -3.18 | -1.02
sandy clay loam | -1.72 | -0.50
clayey loam | -4.05 | -0.95
silty clay loam | -8.23 | -1.48
sandy clay | -4.14 | -0.55
silty clay | -31.95 | -0.95
clay | -21.42 | -0.60

Note:
In Table 9 (on page 238) to Table 11 (on page 240) the symbols \( \theta_r \) and \( \theta_s \) stand for the residual and the saturated water content correspondingly. Based on van Genuchten (1980) (on page 588), the effective degree of saturation is calculated as \( S_{eff} = (\theta - \theta_r)/(\theta_s - \theta_r) \), in which \( \theta \) is the water content.

In PLAXIS 2D, the effective degree of saturation is calculated as \( S_{eff} = (S - S_r)/(S_s - S_r) \) (see Conventional and unsaturated soil behaviour in PLAXIS (on page 599)), in which \( S \) is the degree of saturation, \( S_r \) the residual degree of saturation and \( S_s \) the saturated degree of saturation. Considering that \( S = \theta / n \) and under the assumption that \( S_s = \theta_s / n = 1 \), \( S_r \) could be derived from Table 9 (on page 238) to Table 11 (on page 240) as \( S_r = \theta_r / \theta_s \).

4. Staring:
The Staring series is a soil classification system which is mainly used in The Netherlands (Wosten, Veerman, DeGroot & Stolte, 2001 (on page 588)). The hydraulic models available for Staring data set are the Van Genuchten model and the Approximate Van Genuchten (see the Material Models Manual - Hydraulic Models).
A distinction can be made between **Topsoil** and **Subsoil**. In general, soils are considered to be subsoils. The **Type** drop-down menu for the **Staring** series (Figure 164 (on page 242)) contains the following subsoils (Wosten, Veerman, DeGroot & Stolte, 2001 (on page 588)):

- Non-loamy sand (O1)
- Loamy sand (O2)
- Very loamy sand (O3)
- Extremely loamy sand (O4)
- Coarse sand (O5)
- Boulder clay (O6)
- River loam (O7)
- Sandy loam (O8)
- Silt loam (O9)
- Clayey loam (O10)
- Light clay (O11)
- Heavy clay (O12)
- Very heavy clay (O13)
- Loam (O14)
- Heavy loam (O15)
- Oligotrophic peat (O16)
- Eutrophic peat (O17)
- Peaty layer (O18)

The selected soil type and grading (particle fractions) are different from the Hypres and the USDA data sets. The parameters of the hydraulic model for the selected soil type are displayed in the **Soil** tab at the right side of the **Groundwater** tabsheet and are summed up in the tables below.

### Note:

Only soil layers that are located not more than 1 m below the ground surface are considered to be **Topsoils**. In the tables below the notation "B" corresponds to **Topsoils**; and the notation "O" indicates **Subsoil**.

#### Table 13: **Staring** series with Van Genuchten parameters (Heinen, Bakker & Wösten, 2001)

<table>
<thead>
<tr>
<th>Soil class</th>
<th>( \theta_s ) (-)</th>
<th>( \theta_r ) (-)</th>
<th>( k_{sat} ) (m/day)</th>
<th>( g_a ) (1/m)</th>
<th>( g_l ) (-)</th>
<th>( g_n ) (-)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sand</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B1</td>
<td>0.02</td>
<td>0.43</td>
<td>0.234</td>
<td>2.34</td>
<td>0.000</td>
<td>1.801</td>
</tr>
</tbody>
</table>
### Material properties and material database

#### Modelling soil and interface behaviour

<table>
<thead>
<tr>
<th>Soil class</th>
<th>( \theta_r (-) )</th>
<th>( \theta_s (-) )</th>
<th>( k_{\text{sat}} ) (m/day)</th>
<th>( g_a ) (1/m)</th>
<th>( g_f (-) )</th>
<th>( g_n (-) )</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sand</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B2</td>
<td>0.02</td>
<td>0.42</td>
<td>0.125</td>
<td>2.76</td>
<td>-1.060</td>
<td>1.491</td>
</tr>
<tr>
<td>B3</td>
<td>0.02</td>
<td>0.46</td>
<td>0.154</td>
<td>1.44</td>
<td>-0.215</td>
<td>1.534</td>
</tr>
<tr>
<td>B4</td>
<td>0.02</td>
<td>0.46</td>
<td>0.292</td>
<td>1.56</td>
<td>0.000</td>
<td>1.406</td>
</tr>
<tr>
<td>B5</td>
<td>0.01</td>
<td>0.36</td>
<td>0.529</td>
<td>4.52</td>
<td>-0.359</td>
<td>1.933</td>
</tr>
<tr>
<td>B6</td>
<td>0.01</td>
<td>0.38</td>
<td>1.01</td>
<td>2.22</td>
<td>-1.747</td>
<td>1.238</td>
</tr>
<tr>
<td>O1</td>
<td>0.01</td>
<td>0.36</td>
<td>0.152</td>
<td>2.24</td>
<td>0.000</td>
<td>2.286</td>
</tr>
<tr>
<td>O2</td>
<td>0.02</td>
<td>0.38</td>
<td>0.127</td>
<td>2.13</td>
<td>0.168</td>
<td>1.951</td>
</tr>
<tr>
<td>O3</td>
<td>0.01</td>
<td>0.34</td>
<td>0.109</td>
<td>1.70</td>
<td>0.000</td>
<td>1.717</td>
</tr>
<tr>
<td>O4</td>
<td>0.01</td>
<td>0.35</td>
<td>0.0985</td>
<td>1.55</td>
<td>0.000</td>
<td>1.525</td>
</tr>
<tr>
<td>O5</td>
<td>0.01</td>
<td>0.32</td>
<td>0.250</td>
<td>5.21</td>
<td>0.000</td>
<td>2.374</td>
</tr>
<tr>
<td>O6</td>
<td>0.01</td>
<td>0.33</td>
<td>0.340</td>
<td>1.62</td>
<td>-1.330</td>
<td>1.311</td>
</tr>
<tr>
<td>O7</td>
<td>0.01</td>
<td>0.51</td>
<td>0.391</td>
<td>1.23</td>
<td>-2.023</td>
<td>1.152</td>
</tr>
<tr>
<td><strong>Silt</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B7</td>
<td>0.00</td>
<td>0.40</td>
<td>0.141</td>
<td>1.94</td>
<td>-0.802</td>
<td>1.250</td>
</tr>
<tr>
<td>B8</td>
<td>0.01</td>
<td>0.43</td>
<td>0.0236</td>
<td>0.99</td>
<td>-2.244</td>
<td>1.288</td>
</tr>
<tr>
<td>B9</td>
<td>0.00</td>
<td>0.43</td>
<td>0.0154</td>
<td>0.65</td>
<td>-2.161</td>
<td>1.325</td>
</tr>
<tr>
<td>O8</td>
<td>0.00</td>
<td>0.47</td>
<td>0.0907</td>
<td>1.36</td>
<td>-0.803</td>
<td>1.342</td>
</tr>
<tr>
<td>O9</td>
<td>0.00</td>
<td>0.46</td>
<td>0.0223</td>
<td>0.94</td>
<td>-1.382</td>
<td>1.400</td>
</tr>
<tr>
<td>O10</td>
<td>0.01</td>
<td>0.48</td>
<td>0.0212</td>
<td>0.97</td>
<td>-1.879</td>
<td>1.257</td>
</tr>
<tr>
<td><strong>Clay</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B10</td>
<td>0.01</td>
<td>0.43</td>
<td>0.007</td>
<td>0.64</td>
<td>-3.884</td>
<td>1.210</td>
</tr>
<tr>
<td>B11</td>
<td>0.01</td>
<td>0.59</td>
<td>0.0453</td>
<td>1.95</td>
<td>-5.901</td>
<td>1.109</td>
</tr>
<tr>
<td>B12</td>
<td>0.01</td>
<td>0.54</td>
<td>0.0537</td>
<td>2.39</td>
<td>-5.681</td>
<td>1.094</td>
</tr>
<tr>
<td>O11</td>
<td>0.00</td>
<td>0.42</td>
<td>0.138</td>
<td>1.91</td>
<td>-1.384</td>
<td>1.152</td>
</tr>
<tr>
<td>Clay</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
</tr>
<tr>
<td>O12</td>
<td>0.01</td>
<td>0.56</td>
<td>0.0102</td>
<td>0.95</td>
<td>-4.295</td>
<td>1.158</td>
</tr>
<tr>
<td>O13</td>
<td>0.01</td>
<td>0.57</td>
<td>0.0437</td>
<td>1.94</td>
<td>-5.955</td>
<td>1.089</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Loam</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B13</td>
<td>0.01</td>
<td>0.42</td>
<td>0.130</td>
<td>0.84</td>
</tr>
<tr>
<td>B14</td>
<td>0.01</td>
<td>0.42</td>
<td>0.008</td>
<td>0.51</td>
</tr>
<tr>
<td>O14</td>
<td>0.01</td>
<td>0.38</td>
<td>0.0151</td>
<td>0.30</td>
</tr>
<tr>
<td>O15</td>
<td>0.01</td>
<td>0.41</td>
<td>0.037</td>
<td>0.71</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Peat</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B15</td>
<td>0.01</td>
<td>0.53</td>
<td>0.813</td>
<td>2.42</td>
</tr>
<tr>
<td>B16</td>
<td>0.01</td>
<td>0.80</td>
<td>0.0679</td>
<td>1.76</td>
</tr>
<tr>
<td>B17</td>
<td>0.00</td>
<td>0.72</td>
<td>0.0446</td>
<td>1.80</td>
</tr>
<tr>
<td>B18</td>
<td>0.00</td>
<td>0.77</td>
<td>0.0667</td>
<td>1.97</td>
</tr>
<tr>
<td>O16</td>
<td>0.00</td>
<td>0.89</td>
<td>0.0107</td>
<td>1.03</td>
</tr>
<tr>
<td>O17</td>
<td>0.01</td>
<td>0.86</td>
<td>0.0293</td>
<td>1.23</td>
</tr>
<tr>
<td>O18</td>
<td>0.01</td>
<td>0.57</td>
<td>0.0345</td>
<td>1.38</td>
</tr>
</tbody>
</table>

Table 14: *Staring* series with Approximate Van Genuchten parameters

<table>
<thead>
<tr>
<th>Class</th>
<th>(\psi_s(m))</th>
<th>(\psi_k(m))</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sand</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B1</td>
<td>-1.87</td>
<td>-1.35</td>
</tr>
<tr>
<td>B2</td>
<td>-2.32</td>
<td>-0.79</td>
</tr>
<tr>
<td>B3</td>
<td>-3.37</td>
<td>-2.18</td>
</tr>
<tr>
<td>B4</td>
<td>-3.81</td>
<td>-2.36</td>
</tr>
<tr>
<td>B5</td>
<td>-1.31</td>
<td>-0.56</td>
</tr>
<tr>
<td>B6</td>
<td>-4.51</td>
<td>0.70</td>
</tr>
</tbody>
</table>
Material properties and material database
Modelling soil and interface behaviour

<table>
<thead>
<tr>
<th>Class</th>
<th>$\psi_s$ (m)</th>
<th>$\psi_k$ (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sand</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>-1.48</td>
<td>-1.15</td>
</tr>
<tr>
<td>02</td>
<td>-1.79</td>
<td>-1.51</td>
</tr>
<tr>
<td>03</td>
<td>-2.46</td>
<td>-1.93</td>
</tr>
<tr>
<td>04</td>
<td>-3.22</td>
<td>-2.30</td>
</tr>
<tr>
<td>05</td>
<td>-1.11</td>
<td>-0.48</td>
</tr>
<tr>
<td>06</td>
<td>-4.50</td>
<td>-1.18</td>
</tr>
<tr>
<td>07</td>
<td>-9.76</td>
<td>-0.98</td>
</tr>
<tr>
<td><strong>Silt</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B7</td>
<td>-4.72</td>
<td>-1.14</td>
</tr>
<tr>
<td>B8</td>
<td>-7.03</td>
<td>-1.46</td>
</tr>
<tr>
<td>B9</td>
<td>-9.61</td>
<td>-2.33</td>
</tr>
<tr>
<td>08</td>
<td>-4.78</td>
<td>-1.74</td>
</tr>
<tr>
<td>09</td>
<td>-5.89</td>
<td>-2.07</td>
</tr>
<tr>
<td>010</td>
<td>-7.77</td>
<td>-1.59</td>
</tr>
<tr>
<td><strong>Clay</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B10</td>
<td>-13.06</td>
<td>-1.47</td>
</tr>
<tr>
<td>B11</td>
<td>-9.51</td>
<td>-0.27</td>
</tr>
<tr>
<td>B12</td>
<td>-9.61</td>
<td>-0.21</td>
</tr>
<tr>
<td>011</td>
<td>-7.20</td>
<td>-0.76</td>
</tr>
<tr>
<td>012</td>
<td>-11.55</td>
<td>-0.82</td>
</tr>
<tr>
<td>013</td>
<td>-11.45</td>
<td>-0.24</td>
</tr>
<tr>
<td><strong>Loam</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B13</td>
<td>-6.19</td>
<td>-2.25</td>
</tr>
<tr>
<td>B14</td>
<td>-12.82</td>
<td>-7.09</td>
</tr>
</tbody>
</table>
Material properties and material database
Modelling soil and interface behaviour

<table>
<thead>
<tr>
<th></th>
<th>Loam</th>
<th></th>
<th>Peat</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>B12</td>
<td>-9.61</td>
<td>-0.21</td>
<td></td>
</tr>
<tr>
<td></td>
<td>O14</td>
<td>-20.68</td>
<td>-9.37</td>
<td></td>
</tr>
<tr>
<td></td>
<td>O15</td>
<td>-9.30</td>
<td>-14.08</td>
<td></td>
</tr>
</tbody>
</table>

5. User-defined:

The user-defined option enables the user to define both saturated and unsaturated properties manually. Please note that this option requires adequate experience with unsaturated groundwater flow modelling. The hydraulic models available are:

**Van Genuchten**

This well-known and widely accepted model requires direct input of the residual saturation $S_{\text{res}}$, the saturation at $p = 0, S_{\text{sat}}$ and the three fitting parameters $g_{\text{r}}$, $g_{\text{a}}$ and $g_{\text{l}}$ (see Material Models Manual - Hydraulic models).

**Spline**

The Spline function requires direct input of the capillary height $\psi$ (in unit of length), the relative permeability $K_r (-)$, and the degree of saturation $S_r (-)$. Data for the Spline function can be entered by clicking the Table tab. The degree of saturation at saturated conditions $S_{\text{sat}}$ equals the value assigned to $S_r$ at $\psi_{\text{max}}$ (e.g. $-\psi = 0$ m) and the residual degree of saturation $S_{\text{res}}$ equals the minimum value assigned to $S_r$ at $\psi_{\text{min}}$ (e.g. $-\psi = 20$ m). During the calculations, the flow calculation kernel employs 'smooth' relationships based on a spline function between $K_r \cdot \psi$ and $S_r \cdot \psi$.

**Saturated**

When the Saturated option is selected, no extra data input is required. During the calculations, PLAXIS 2D will continuously use the saturated permeabilities for soil layers where a Saturated data set was assigned.
6.1.5.2 Saturated permeabilities \((k_x \text{ and } k_y)\)

Coefficients of permeability (hydraulic conductivity) have the dimension of velocity (unit of length per unit of time). The input of permeability parameters is required for groundwater flow and consolidation calculations. In such calculations, it is necessary to specify the coefficient of permeability for all soil materials with drainage type Drained, Undrained A and Undrained B, including almost impermeable layers, except for fully impervious layers with a Non-porous drainage type and layers using a total stress analysis (Undrained C). PLAXIS 2D allows for the anisotropic permeability of soils where the anisotropy directions coincide with the principal axes \(x\) and \(y\).

Users can choose to either enter the values for the permeabilities directly, or choose default values. When opting for default values there are 2 available options:

<table>
<thead>
<tr>
<th>From data set</th>
<th>The values of (k_x) and (k_y) are obtained from the selected data set.</th>
</tr>
</thead>
<tbody>
<tr>
<td>From grain size distribution</td>
<td>The values for (k_x) and (k_y) are obtained from particle size distribution as explained above. The value for (\theta_{sat}) is calculated internally using the equation, (\theta_{sat} = e / (1+e)).</td>
</tr>
</tbody>
</table>

In real soils, the difference in permeabilities between the various layers can be quite large. However, care should be taken when very high and very low permeabilities occur simultaneously in a finite element model, as this could lead to ill-conditioning of the flow matrix. In order to obtain accurate results, the ratio between the highest and lowest permeability value in the geometry should not exceed \(10^5\).

Note that the input field for permeabilities are greyed out when the drainage type of the material is either Non-porous or Undrained C.
In case of a Standard, Hypres or USDA data set, values for the permeability can be automatically set by either selecting the From data set option or From grain size distribution.

When a predefined soil data set is chosen or the user specifies the individual particle fractions manually, assuming the soil has a log-normal function of particle size distribution, then the geometric mean particle diameter $d_g$ and a geometric standard deviation $\sigma_g$ can be calculated as:

$$d_g = \exp \left( m_{cl} \ln (d_{cl}) + m_{si} \ln (d_{si}) + m_{sa} \ln (d_{sa}) \right) \quad \text{Eq. [17]}$$

$$\sigma_g = \exp \left( \frac{3}{2} \sum_{i=1}^{3} m_i \ln (d_i)^2 - \left( \frac{3}{2} \sum_{i=1}^{3} m_i \ln (d_i) \right)^2 \right)^{1/2} \quad \text{Eq. [18]}$$

where $m_{cl}$, $m_{si}$ and $m_{sa}$ are particle fractions for clay, silt and sand; $d_{cl}$, $d_{si}$ and $d_{sa}$ are the particle size means for clay, silt and sand respectively (i.e. $d_{cl} = 1\mu m$, $d_{si} = 26\mu m$, $d_{sa} = 1.025\text{mm}$).

According to Aukenthaler, Brinkgreve & Haxaire (2016) (on page 586) The Specific surface area (SSA) can be approximated using the geometric mean particle diameter in mm:

$$SSA = 3.89 d_g^{-0.905}$$

From the above, the hydraulic conductivity of saturated soils (permeabilities) can be obtained from the soil texture and porosity of the soil using the following relation:

$$k_x = k_y = K_{sat}$$

$$K_{sat} = 4 \times 10^{-5} \left( \frac{0.5}{1 - \theta_{sat}} \right)^{1.3b} \times \exp \left( -6.88m_{cl} - 3.63m_{si} - 0.025 \right)$$

$$b = d_g^{-0.5} + 0.2\sigma_g \quad \text{Eq. [19]}$$

where

- $\theta_{sat}$ = volumetric water content of saturated soil which is equal to the porosity of the soil ($n(n = e / (1 + e))$).
- $d_g$ = the geometric mean particle diameter.
- $\sigma_g$ = the geometric standard deviation.

### 6.1.5.3 Void ratio dependency

This advanced feature is to account for the change of permeability with void ratio during a consolidation analysis. This can be applied by entering a proper value for the $c_k$ parameter and the initial void ratio $e_{init}$. On entering a real value, the permeability will change according to the formula:

$$\log \left( \frac{k}{k_0} \right) = \frac{\Delta e}{c_k} \quad \text{Eq. [20]}$$

where $\Delta e$ is the change in void ratio, $k$ is the permeability in the calculation and $k_0$ is the input value of the permeability in the data set ($= k_x$ and $k_y$). Note that a proper input of the initial void ratio $e_{init}$ in the General tabsheet is required. It is recommended to use a changing permeability only in combination with the Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model or the Soft Soil Creep model. In that case the $c_k$-value is generally in the order of the compression index $C_c$. For all other models the $c_k$-value should be left to its default value of $10^{15}$.
6.1.5.4 Unsaturated zone ($\psi_{\text{unsat}}$)

$\psi_{\text{unsat}}$ (in unit of length relative to the phreatic level) sets the maximum pressure head until which the Mualem-Van Genuchten functions are used for calculation of relative permeability and degree of saturation. The negative sign indicates suction. Above the level of $\psi_{\text{unsat}}$, the value of $K_r$ and $S$ remains constant. In this way a minimum degree of saturation ($S_{\text{min}}$) is guaranteed (Figure 166 (on page 249)). It is used to limit the relative permeability $K_r$ and degree of saturation for high unsaturated zones.

![Relative permeability vs. Degree of saturation](image)

*Figure 166: Relative permeability vs. Degree of saturation*

By default a very large value is assigned to $\psi_{\text{unsat}}$ ($\approx 10^4$). This value is only an indication that the unsaturated zone is by default unlimited.

6.1.6 Thermal tabsheet [ADV]

The Thermal tabsheet (Figure 167 (on page 250)) contains thermal parameters that are required when dealing with problems involving (a change of) temperature and the influence on the stress, deformation or groundwater flow. The meaning of these parameters is described below.
6.1.6.1 Thermal diffusion parameters

The first parameters that are required in order to do a thermal flow analysis are the parameters for the thermal flow or thermal diffusion itself.

The Specific heat capacity of the solid material, \( c_s \), is a parameter that describes the amount of energy (heat) that can be stored in the solid material (i.e. the soil particles) per unit of mass. It is specified in the unit of energy per unit of mass per unit of temperature. The larger the specific heat, the more energy it takes to increase the temperature of the material.

The total heat storage in a solid material is the product of the density, \( \rho_s \), and the specific heat capacity, \( c_s \).

For non-porous material

\[ (pC)_{\text{soil}} = \rho_s c_s \]

For dry material

\[ (pC)_{\text{soil}} = (1-n) \rho_s c_s \]

For phase transition (e.g. frozen soil)

\[ (pC)_{\text{soil}} = (1-n) \rho_s c_s + n S [(1-w_u)\rho_i c_i + w_u \rho_w c_w] + n (1-S) \rho_v c_v \]

In other cases

\[ (pC)_{\text{soil}} = (1-n) \rho_s c_s + n S \rho_w c_w + n (1-S) \rho_v c_v \]

where

\[ n = \text{porosity} = \frac{e}{(1+e)} \] (where \( e \) = void ratio)
**Material properties and material database**

Modelling soil and interface behaviour

$S$ = degree of saturation

$w_u$ = property of ice (water in solid state)

index $i$ = unfrozen water content

index $w$ = property of water (water in liquid state)

index $v$ = property of vapour (water in gas state)

**Note:**

Note that the properties of water in the three different phases are contained in the **Constants** tabsheet of the **Project properties** window (Project properties (on page 20)).

The **Thermal conductivity** of the solid material, $\lambda_s$, is a parameter that describes the rate of energy (heat) that can be transported in the solid material (i.e. the soil particles). It is specified in the unit of power per unit of length per unit of temperature. The larger the conductivity, the more energy is transported, resulting in a faster propagation of a change of temperature in the material.

Considering soil as a porous medium, the total heat conductivity of the soil is composed of the heat conductivity in the soil particles and the heat conductivity in the pore fluid. The following situations are considered:

<table>
<thead>
<tr>
<th>For non-porous material</th>
<th>$\lambda_{soil} = \lambda_s$</th>
</tr>
</thead>
<tbody>
<tr>
<td>For dry material</td>
<td>$\lambda_{soil} = (1-n) \lambda_s$</td>
</tr>
<tr>
<td>For phase transition</td>
<td>$\lambda_{soil} = (1-n) \lambda_s + n S [(1-w_u) \lambda_i + w_u \lambda_w] + n (1-S) \lambda_v$</td>
</tr>
<tr>
<td>In other cases</td>
<td>$\lambda_{soil} = (1-n) \lambda_s + n S \lambda_w + n (1-S) \lambda_v$</td>
</tr>
</tbody>
</table>

where

- $\lambda_i$ = thermal conductivity of ice (water in solid state)
- $\lambda_w$ = thermal conductivity of water (water in liquid state)
- $\lambda_v$ = thermal conductivity of vapour (water in gas state)

The **Density** of the solid material, $\rho_s$, is the parameter that describes the density of the soil particles, material expressed in the unit of mass per unit of volume. For example, the density of quartz is 2.65 t/m$^3$. The density relates to the unit weight of the material (see Project properties (on page 20)), and it contributes to the total heat storage.

**Note:**

Note that PLAXIS 2D does NOT check the consistency between the unit weight and the density.

### 6.1.6.2 Thermal strain parameters

In addition to parameters related to the thermal diffusion, a parameter describing the mechanical effects of a change of thermal conditions is required.

The **Thermal expansion coefficients**, $\alpha$, describe how much the material expands (or elongates) when the temperature increases. In other words, the thermal expansion coefficient is the (change of) strain per unit of temperature. If the thermal expansion is isotropic, all coefficients are equal and a single value can be specified for isotropic expansion, but PLAXIS 2D can also handle anisotropic thermal expansion in x-, y- and z-direction through the input of 3 linear thermal expansion coefficients.
6.1.6.3 Freezing / thawing parameters

The use of the *Phase change* option may be relevant in the case of permafrost soil, ground freezing and other situations of frozen soil. In frozen soils, part of the pore water is present in solid state and part of the water may still be present in liquid state. By activating the phase change option the part of the water in liquid state as a function of temperature can be defined by means of the *Unfrozen water saturation method*.

The available options for *Unfrozen water saturation method* from the drop-down menu are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-defined</td>
<td>When this option is selected, the user should provide details of the unfrozen water content, ( w_u ) as a function of temperature (described below).</td>
</tr>
<tr>
<td>From grain size</td>
<td>When this option is selected, the unfrozen water content is automatically calculated using the <em>Specific surface area (SSA)</em>.</td>
</tr>
<tr>
<td>distribution</td>
<td></td>
</tr>
</tbody>
</table>

**user-defined water saturation method:** After selection of this option, a table should be created in the right-hand panel, in which the ratio of unfrozen water content over total water content, \( w_u/W_0 \), is defined as a function of temperature.

- Click the *Add row* button in the toolbar to add a new row in the table.
- Click the *Insert* button to insert a new row before the selected row in the table.
- Click the *Delete* button to delete the selected row in the table.

The values can be defined by clicking the cell in the table and by typing the value. A plot of the unfrozen water content as a function of temperature is shown below the table ([Figure 169](on page 253)).

- Besides defining the values in the table, there is also the possibility to read data from a file using the *Open* button in the toolbar.
- The current table can be saved using the *Save* button in the toolbar enabling the usage in other projects or validating the effect of the modifications in the current project.
- The current table can be using the *Copy* button in the toolbar.
- Copied data from other applications (using Ctrl+c) can be imported by using the *Paste* button. The *Import data* window appears ([Figure 168](on page 253)). The starting row of the data to be imported can be defined in the *From row* cell. The data and the plot is displayed in the *Unfrozen water content* window after pressing OK.

**Note:**

PLAXIS 2D assumes the data file is located in the current project directory when no directory is specified.
Clicking the Open .txt file button on the right hand side of the window will open the Open window where the file can be selected. The file must be an ASCII file that can be created with any text editor. For every line a pair of
values (temperature and corresponding unfrozen water content value) must be defined, leaving at least one space between them. Note that PLAXIS 2D only supports the English notation of decimal numbers using a dot.

In thermal calculations of saturated soils, in which phase transition of the pore water (from water to ice) is considered, the unfrozen water content is used to identify the amount of water and ice in the pores. This is important since the different phases of the pore fluid have different thermal and hydraulic properties.

**From grain size distribution:** When this option is selected, the *Unfrozen water content* is automatically calculated using the *Specific surface area (SSA)* (refer to Eq. [17]).

\[
SSA = 3.89d_g^{-0.905} \quad \text{Eq. [21]}
\]

The temperature dependent unfrozen water content \( w_{un} \) can now be determined as follows (Aukenthaler, Brinkgreve & Haxaire, 2016 (on page 586)):

\[
w_{un} = \exp \left( 0.2618 + 0.5519 \ln (SSA) - 1.4495SSA^{-0.2640} \ln (\Delta T) \right) \quad \text{Eq. [22]}
\]

The unfrozen water saturation can now be determined as (Aukenthaler, Brinkgreve & Haxaire, 2016 (on page 586)):

\[
\frac{w_{un}}{w_0} = \frac{\rho_s}{100\rho_w} e^{-w_{un}} \quad \text{Eq. [23]}
\]

where \( \rho_w \) is the density of pure free water, \( \rho_s \) is the density of solids and \( e \) is the void ratio; \( \Delta T \) is the temperature difference (positive value) between the bulk freezing point temperature (= 273.16K) and the temperature below the freezing point and SSA is the specific surface area.

6.1.6.4 Vapour diffusion coefficient

The *Vapour diffusion coefficient*, \( D_v \), governs the diffusion of vapour in the material. A value of zero disables the mass flux of vapour in the material.

6.1.6.5 Thermal diffusion enhancement factor

The *Thermal diffusion enhancement factor*, \( f_{TV} \), influences the dependence of the temperature on the mass flux of vapour. A value of zero means that the mass flux of vapour is governed only by the variations of pore pressure.

**Note:**

By default, vapour is not considered, i.e. the *Vapour diffusion coefficient* and the *Thermal diffusion enhancement factor* are set to zero.

6.1.7 Interfaces tabsheet

The properties of interface elements are related to the soil model parameters of the surrounding soil. The required parameters to derive the interface properties are defined in the *Interfaces* tabsheet of the *Soil* window. These parameters depend on the material model selected to represent the behaviour of the surrounding soil. In case the Linear Elastic model, the Mohr-Coulomb model, the Hardening Soil model, the Hardening Soil model with small-strain stiffness, the UBC3D-PLM model, the Soft Soil model, the Soft Soil Creep model, the Jointed Rock model, the Hoek-Brown model, the NGI-ADP model or the UDCAM-S model has been
selected as the Material model, the strength reduction factor $R_{\text{inter}}$ is the main interface parameter (see Figure 170 (on page 255)). In case of the Modified Cam-Clay model, the interface parameters required are the effective cohesion $c'_{\text{ref}}$, the effective friction angle $\phi'$ and the dilatancy angle $\psi$. In case of the User-defined Soil Model, the tangent stiffness for primary oedometer loading $E_{\text{oed,ref}}$, the effective cohesion $c'_{\text{ref}}$, the effective friction angle $\phi'$, the dilatancy angle $\psi$ and the parameters UD-Power and UD-Pref are required as interface parameters. For more information on the interface parameters required for the User-defined Soil Model (see the Material Models Manual - Input of UD model parameters via user-defined.

![Figure 170: Interfaces tabsheet of the Soil window](image)

6.1.7.1 Stiffness

With the option Stiffness determination the user can choose to either have the interface stiffness Derived from the soil parameters, or to have a Direct input of the interface stiffness.

**Derived:** by default, stiffness is set to Derived. The shear and compression moduli are related by the expressions:

$$ E_{\text{oed,ref}} = 2G_i \frac{1 - \nu_i}{1 - 2\nu_i} $$

$$ G_i = R_{\text{inter}}^2 G_{\text{soil}} \leq G_{\text{soil}} \quad \text{Eq. [24]} $$

$$ \nu_i = 0.45 $$

For the internal constitutive soil models of PLAXIS the stiffness $G_{\text{soil}}$ is automatically determined depending on the soil model. For instance, for the Mohr-Coulomb model $G_{\text{soil}}$ is directly determined from the Young’s modulus.
$E_{\text{ref}}$ whereas for the Hardening Soil model $G_{\text{soil}}$ is related to $E_{50}$ as slipping (shearing) is considered the most important behaviour for interfaces.

When using user-defined material model, the user inserts the interface stiffness in the form of a power law formulation with $E_{\text{oed,ref}}$ along with UD-$p^{\text{ref}}$ and UD-$\text{Power}$.

**Direct:** this option allows to directly specify the $k_n$ and $k_s$ values.

<table>
<thead>
<tr>
<th>$k_n$</th>
<th>Elastic interface normal stiffness</th>
<th>kN/m$^3$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$k_s$</td>
<td>Elastic interface shear stiffness</td>
<td>kN/m$^3$</td>
</tr>
</tbody>
</table>

### 6.1.7.2 Strength

In case of the Linear Elastic model, the Mohr-Coulomb model, the Hardening Soil model, the Hardening Soil model with small-strain stiffness, the UBC3D-PLM model, the Soft Soil model, the Soft Soil Creep model, the Jointed Rock model, the Hoek-Brown model, the NGI-ADP model or the UDCAM-S model, the interface strength is defined by the parameter $R_{\text{inter}}$. The interface strength can be set using the following options:

**Rigid:** This option is used when the interface should not have a reduced strength with respect to the strength in the surrounding soil. For example, extended interfaces around corners of structural objects (Figure 69 (on page 108)) are not intended for soil-structure interaction and should not have reduced strength properties. The strength of these interfaces should be assigned as Rigid (which corresponds to $R_{\text{inter}} = 1.0$). As a result, the interface properties, including the dilatancy angle $\psi$, are the same as the soil properties in the data set, except for Poisson’s ratio $\nu$ (see further).

**Manual:** The value of $R_{\text{inter}}$ can be entered manually if the interface strength is set to Manual. In general, for real soil-structure interaction the interface is weaker and more flexible than the surrounding soil, which means that the value of $R_{\text{inter}}$ should be less than 1. Suitable values for $R_{\text{inter}}$ for the case of the interaction between various types of soil and structures in the soil can be found in the literature. In the absence of detailed information it may be assumed that $R_{\text{inter}}$ is of the order of 2/3. A value of $R_{\text{inter}}$ greater than 1 cannot be used.

When the interface is elastic then both slipping (relative movement parallel to the interface) and gapping or overlapping (i.e. relative displacements perpendicular to the interface) could be expected to occur.

The magnitudes of the interface displacements are:

\[
\text{Elastic gap displacement} = \frac{\sigma_n}{k_n} = \frac{\sigma_n t_i}{E_{\text{oed,i}}} \quad \text{Eq. [25]}
\]

\[
\text{Elastic slip displacement} = \frac{\tau}{k_s} = \frac{\tau t_i}{G_i} \quad \text{Eq. [26]}
\]

where $G_i$ is the shear modulus of the interface, $E_{\text{oed,i}}$ is the one-dimensional compression modulus of the interface, $t_i$ is the virtual thickness of the interface generated during the creation of interfaces in the geometry model (Interfaces (on page 104)), $k_n$ is the elastic interface normal stiffness and $k_s$ is the elastic interface shear stiffness.

**Note:**

Note that a reduced value of $R_{\text{inter}}$ not only reduces the interface strength, but also the interface stiffness.

It is clear from these equations that, if the elastic parameters are set to low values, the elastic displacements may be excessively large. If the values of the elastic parameters are too large, however, this can result in numerical ill-conditioning of the stiffness matrix. The key factor in the stiffness is the virtual thickness. This value is
automatically chosen such that an adequate stiffness is obtained. The user may change the virtual thickness. This can be done in the Interface window that appears after double clicking an interface in the geometry model (Interfaces (on page 104)).

**Manual with residual strength:** When the limit value of the interface strength as defined by $R_{inter}$ is reached, the interface strength may soften down to a reduced value as defined by $R_{inter, residual}$. Definition of the $R_{inter, residual}$ is possible when the Manual with residual strength option is selected for the interface strength.

**Interface reduction factor ($R_{inter}$):** An elastic-plastic model is used to describe the behaviour of interfaces for the modelling of soil-structure interaction. The Coulomb criterion is used to distinguish between elastic behaviour, where small displacements can occur within the interface, and plastic interface behaviour when permanent slip may occur. For the interface to remain elastic the shear stress $\tau$ is given by:

$$| \tau | < - \sigma_n \tan (\varphi_i) + c_i \quad Eq. [27]$$

where $\sigma_n$ is the effective normal stress.

For plastic behaviour $\tau$ is given by:

$$| \tau | = - \sigma_n \tan (\varphi_i) + c_i \quad Eq. [28]$$

where $\varphi_i$ and $c_i$ are the friction angle and cohesion (adhesion) of the interface. The strength properties of interfaces are linked to the strength properties of a soil layer. Each data set has an associated reduction factor for interfaces $R_{inter}$. The interface properties are calculated from the soil properties in the associated data set and the strength reduction factor by applying the following rules:

$$c_i = R_{inter} c_{soil} \quad Eq. [29]$$

$$\tan (\varphi_i) = R_{inter} \tan (\varphi_{soil}) \leq \tan (\varphi_{soil}) \quad Eq. [29]$$

$$\psi_i = 0 \text{ for } R_{inter} < 1, \text{ otherwise } \psi_i = \psi_{soil} \quad Eq. [30]$$

In the Hardening Soil model, the Hardening Soil model with small-strain stiffness and the UBC3D-PLM model, $\varphi_{soil}$ is always referred to the failure-peak value of $\varphi$ chosen as input parameter.

In addition to Mohr-Coulomb’s shear stress criterion, the tension cut-off criterion, as described before (see Mechanical tabsheet (on page 180)), also applies to interfaces (if not deactivated):

$$\sigma_n < \sigma_{t,i} = R_{inter} \sigma_{t,soil} \quad Eq. [31]$$

where $\sigma_{t,soil}$ is the tensile strength of the soil.

**Interface strength in undrained condition:** When the drainage condition is Undrained B or Undrained C, the calculation is performed with undrained strength parameters. For the interface to remain elastic the shear stress $\tau$ is given by:

$$| \tau | < s_u \quad Eq. [32]$$

where $s_u$ is the undrained shear strength.

For plastic behaviour $\tau$ is given by:

$$| \tau | = s_u \quad Eq. [33]$$

The interface property is calculated from the soil property in the associated data set and the strength reduction factor $R_{inter}$ by applying the following rule:

$$s_{u,i} = R_{inter} s_{u,soil} \quad Eq. [34]$$

when $s_{u,i}$ is the undrained shear strength of the interface and $s_{u,soil}$ is the undrained shear strength of the soil.
The tension cut-off criterion applies as in calculation with effective parameters for strength.

In the NGI-ADP model, $s_{us_{\text{soil}}}$ is computed accordingly to what is reported in the Material Models Manual.

**Residual interface strength** $(R_{\text{inter, residual}})$: When the **Manual with residual strength option** is selected the parameter $R_{\text{inter, residual}}$ can be specified. The interface strength will reduce to the residual strength as defined by $(R_{\text{inter, residual}})$ and the strength properties of the soil, as soon as the interface strength is reached.

**Note:**
- Note that the same values of partial factors in *Design approaches* are applied to both interface strength $R_{\text{inter}}$ and residual interface strength $R_{\text{inter, residual}}$.
- A reduced residual strength is not recommended to be used in *Safety* calculations.

**Consider gap closure:** When the interface tensile strength is reached a gap may occur between the structure and the soil. When the load is reversed, the contact between the structure and the soil needs to be restored before a compressive stress can developed. This is achieved by selecting the **Consider gap closure** option in the *Interfaces* tabsheet of the *Soil* window. If the option is NOT selected, contact stresses will immediately develop upon load reversal, which may not be realistic.

**Interfaces using the Hoek & Brown model:** When using the Hoek-Brown model as a continuum model to describe the behaviour of a rock section in which interface elements are used, equivalent interface strength properties $\phi_i$, $c_i$ and $\sigma_{t,i}$ are derived from this model. The general shear strength criterion for interfaces as well as the tensile strength criterion are still used in this case:

\[
|\tau| \leq -\sigma_n \tan(\phi_i) + c_i \quad \text{Eq. [35]}
\]
\[
\sigma_n \leq \sigma_{t,i} \quad \text{Eq. [36]}
\]

Starting point for the calculation of the interface strength properties is the minor principal effective stress $\sigma_3'$ in the adjacent continuum element. At this value of confining stress the tangent to the Hoek-Brown contour is calculated and expressed in terms of $\phi$ and $c$:

\[
\sin(\phi) = \frac{\bar{f}}{2 + \bar{f}}
\]
\[
c = \frac{1 - \sin(\phi)}{2 \cos(\phi)} \left( \frac{2a'}{\bar{f} + \frac{2a'}{1 - \sin(\phi)}} \right) \quad \text{Eq. [37]}
\]

where

\[
\bar{f} = a_{\phi_i} \left( m_b \frac{-\sigma_3'}{a_{ci}} + s \right)^a
\]
\[
\bar{f} = a_{\phi_i} \left( m_b \frac{-\sigma_3'}{a_{ci}} + s \right)^{a-1} \quad \text{Eq. [38]}
\]

and $a$, $m_b$, $s$ and $a_{ci}$ are the Hoek-Brown model parameters in the corresponding material data set. The interface friction angle $\phi_{i,i}$ and adhesion $c_{i,i}$ as well as the interface tensile strength $\sigma_{t,i}$ are now calculated using the interface strength reduction factor $R_{\text{inter}}$:

\[
\tan(\phi_{i,i}) = R_{\text{inter}} \tan(\phi)
\]
\[
c_{i,i} = R_{\text{inter}} c
\]
\[
\sigma_{t,i} = R_{\text{inter}} \sigma_t = R_{\text{inter}} \frac{s a_{ci}}{m_b} \quad \text{Eq. [39]}
\]
For more information about the Hoek-Brown model and an explanation of its parameters, reference is made to the Material Models Manual.

**Interfaces using the Modified Cam-Clay model** If the Modified Cam-Clay model is selected in the General tabsheet to describe the behaviour of the surrounding soil, the following parameters are required to model the interface behaviour:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c_{\text{ref}}$</td>
<td>Cohesion of the interface</td>
<td>[kN/m$^2$]</td>
</tr>
<tr>
<td>$\phi'_{i}$</td>
<td>Internal friction angle of the interface</td>
<td>[$^\circ$]</td>
</tr>
<tr>
<td>$\psi_{i}$</td>
<td>Dilatancy angle of the interface</td>
<td>[$^\circ$]</td>
</tr>
</tbody>
</table>

When the interface is elastic then both slipping (relative movement parallel to the interface) and gapping or overlapping (i.e. relative displacements perpendicular to the interface) could be expected to occur.

The magnitudes of these displacements are:

\[
\text{Elastic gap displacement} = \frac{a_n}{k_n} = \frac{a_n t_i}{E_{oed,i}} \quad \text{Eq. [40]}
\]

\[
\text{Elastic slip displacement} = \frac{\tau}{k_s} = \frac{\tau t_i}{G_i} \quad \text{Eq. [41]}
\]

where $G_i$ is the shear modulus of the interface, $E_{oed,i}$ is the one-dimensional compression modulus of the interface and $t_i$ is the virtual thickness of the interface, generated during the creation of interfaces in the geometry model ([Interfaces](on page 104)), $k_n$ is the elastic interface normal stiffness and $k_s$ is the elastic interface shear stiffness. The shear and compression moduli are related by the expressions:

\[
E_{oed,i} = \frac{3}{2} \left(1 - 2\nu_i\right) \frac{a_n}{\lambda(1+\nu_i)(1+\epsilon_0)}
\]

\[
G_i = \frac{3(1-2\nu_i)}{2(1+\nu_i)} \frac{a_n}{\lambda(1+\epsilon_0)} \quad \text{Eq. [42]}
\]

\[
\nu_i = 0.45
\]

**6.1.7.3 Real interface thickness ($\delta_{\text{inter}}$)**

The real interface thickness $\delta_{\text{inter}}$ is a parameter that represents the real thickness of a shear zone between a structure and the soil. The value of $\delta_{\text{inter}}$ is only of importance when interfaces are used in combination with the Hardening Soil model or the Hardening Soil model with small-strain stiffness. The real interface thickness is expressed in the unit of length and is generally of the order of a few times the average grain size. This parameter is used to calculate the change in void ratio in interfaces for the dilatancy cut-off option. The dilatancy cut-off in interfaces can be of importance, for example, to calculate the correct bearing capacity of tension piles.

**6.1.7.4 Groundwater flow through interfaces**

In situations involving groundwater flow, consolidation or fully coupled flow-deformation analysis, interface elements can contribute to the flow of groundwater and thereby influence the pore pressure distribution. Therefore, interface permeabilities are relevant in such situations. It is also important for the modelling of flow through a system of joints or faults in low permeable rocks when analysing groundwater flow, pore pressures and seepage for applications in rock.
Flow in interface elements may involve flow through the element, as well as, flow in the longitudinal direction of the element (see Figure 172 on page 262). Therefore, the following distinction is made:

1. **Cross permeability**, defined by means of the Hydraulic resistance, where water can flow through the interface.

   The cross permeability can be set using the following options (see Figure 171 on page 261):
   - **Impermeable** [No user input required]: This is the default option. This option sets the interface to have a zero cross permeability (infinite cross resistance), provided the interface is active in flow as defined by the interface settings in the Selection explorer (see Table 3 on page 107). Note that there is no output of groundwater flow $q_n$ available.
   - **Semi-permeable**: In this case the interface has a specific non-zero hydraulic resistance, expressed in the unit of time (hydraulic delay), provided the interface is active in flow as defined by the interface settings in the Selection explorer (see Table 3 on page 107). The output program will show the amount of groundwater flow $q_n$ crossing the interface.

   **Hydraulic resistance ($d/k$)**: The hydraulic resistance defines the permeability through the interface (perpendicular to the interface longitudinal direction). Considering a semi-permeable wall with a thickness $d$ and permeability (or hydraulic conductivity) $k$, the hydraulic resistance is defined by $d/k$, expressed in the unit of time. To determine $d/k$, one needs to measure the average discharge $q$ through a wall (per unit of area) for a given head difference $\Delta h$, so $d/k = \Delta h/q$.

   - **Fully permeable** [No user input required]: In this case the interface has an infinite cross permeability (zero cross resistance), irrespective whether it is active in flow as defined by the interface settings in the Selection explorer (see Table 3 on page 107). Note that there is no output of groundwater flow available when choosing this option.
Figure 171: Cross permeability options for interfaces
2. **Drainage conductivity \([dk]\)**, where the interface acts as an additional flow “channel”. The drainage conductivity defines the permeability in the interface longitudinal direction parallel to the local axes (drainage capacity), provided the interface is active in flow as defined by the interface settings in the Selection explorer (see Table 3 on page 107). The drainage conductivity is expressed in the unit of volume (water volume that is transported in the interface longitudinal direction) per unit of time per unit of width in the out-of-plane direction. The default value is zero, which means that there is no drainage capacity in the interface.

Considering a semi-permeable gap with a thickness \(d\) and permeability \(k\) between two impermeable media, the drainage conductivity is defined by the product of \(d\) and \(k\) \((dk)\), expressed in the unit of volume per unit of time per unit of width in the out-of-plane direction. This quantity defines the total amount of water that is transported through the gap (drain) per unit of time per unit width. In order to determine \(dk\), one needs to measure the total discharge \(Q/b\) through the gap (per unit of width in the out-of-plane direction) for a given head difference \(\Delta h\) and a given length of the gap \(L\), such that \(dk = (Q/b) (L/\Delta h)\).

![Figure 172: Cross permeability(left) and Drainage conductivity (right)](image)

**Note:** Notice that, neither for the hydraulic resistance nor for the drainage conductivity, the actual thickness \(d\) and permeability \(k\) really matter.

**Practical remarks:** The interface elements are generally at both sides of a wall: for example, in the case of an excavation where the wall is to some extent permeable. In such a case it is suggested to assign the appropriate interface permeability to the ‘outside’ (soil side) of the wall, whereas the interface at the ‘inside’ (side that is excavated) is made fully permeable, even along the embedded part of the wall below the excavation. Similarly for a semi-permeable tunnel lining: the appropriate interface permeability should be given to the interface at the outside of the tunnel lining, whereas the interface at the inside (which will be excavated) should be fully permeable. Hence, this requires an additional material data set to be defined which should be assigned directly to the interface.

6.1.7.5 **[ADV] Thermal resistance**

In Thermal calculations, interface elements can act as insulators, separating the temperature at either side of the interface. As interfaces behave in groundwater flow calculations (where they block the flow completely, behaving as semi-permeable or do not form any resistance at all), interfaces, also, transfer some heat in thermal calculations. The Thermal resistance, \(R_{thermal}\), is used to control the heat transfer across the interface. Thermal resistance is defined as the ratio of the interface thickness, \(d\), and the thermal conductivity of the interface material, \(\lambda\):

\[
R_{thermal} = \frac{d}{\lambda} \quad \text{Eq. [43]}
\]
Thermal resistance values are generally provided by manufacturers of insulating materials that are produced as plates or blankets (foams, wools). Otherwise, the thermal resistance can easily be calculated from the above equation by considering the material's thermal conductivity and a characteristic thickness of the interface layer.

### 6.1.7.6 Interfaces below or around corners of structures

When interfaces are extended below or around corners of structures to avoid stress oscillations ([Interfaces](on page 104)), these extended interfaces are not meant to model soil-structure interaction behaviour, but just to allow for sufficient flexibility. Hence, when using $R_{\text{inter}} < 1$ for these interface elements an unrealistic strength reduction is introduced in the ground, which may lead to unrealistic soil behaviour or even failure. Therefore it is advised to create a separate data set with $R_{\text{inter}} = 1$ and to assign this data set only to these particular interface elements. This can be assigned by dropping the appropriate data set on the individual interfaces rather than dropping it on the associated soil cluster (the interface lines should blink red; the associated soil cluster may not change colour). Alternatively, you can click the right-hand mouse button on these particular interface elements and select Properties and subsequently Positive interface element or Negative interface element. In the Interface window, select the appropriate material set in the Material set drop-down menu and click the OK button.

### 6.1.7.7 Interface permeability

The permeability of the interfaces can be specified by checking the corresponding check box Active in flow in the Interface subtree. Impermeable interfaces may be used to block the flow perpendicular to the interface (cross-permeability) in a consolidation analysis or a groundwater flow calculation, for example to simulate the presence of an impermeable wall. This is achieved by a full separation of the pore pressure degrees-of-freedom of the interface node pairs. On the other hand, if interfaces are present in the mesh it may be the user's intention to explicitly avoid any influence of the interface on the flow and the distribution of (excess) pore pressures, for example in interfaces around corner points of structures ([Interfaces](on page 104)). In such a case the interface should be semi-permeable or fully permeable. For fully permeable interfaces the pore pressure degrees-of-freedom of the interface node pairs are fully coupled.

### 6.1.8 Initial tabsheet

The Initial tabsheet contains parameters to generate the initial stresses by means of the K0 procedure ([Figure 173](on page 264)).
The $K_0$-values can be defined automatically by selecting the option **Automatic** in the $K_0$ determination drop-down box or manually by selecting the option **Manual**.

### 6.1.8.1 $K_0$-values

In general, two $K_0$-values can be specified, one for the $x$-direction (in-plane) and one for the $z$-direction (out-of-plane):

$$K_{0,x} = \frac{\sigma'_{xx}}{\sigma'_{yy}} \quad K_{0,z} = \frac{\sigma'_{zz}}{\sigma'_{yy}} \quad \text{Eq. [44]}$$

The checkbox can be used to set the $K_{0,z}$ value equal to the $K_{0,x}$ value.

The default $K_0$-values are then in principle based on Jaky’s formula:

$$K_0 = 1 - \sin(\varphi) \quad \text{Eq. [45]}$$

For advanced models (Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model) the default value is based on the $K_0^{nc}$ model parameter and is also influenced by the OCR-value and POP-value in the following way:

$$K_{0,x} = K_{0,z} = K_0^{nc} \cdot \frac{\nu_{ur}}{1 - \nu_{ur}} \cdot \left(OCR - 1\right) + \frac{K_0^{nc} \cdot \text{POP} - \frac{\nu_{ur}}{1 - \nu_{ur}} \cdot \text{POP}}{\sigma'_{yy}} \quad \text{Eq. [46]}$$

The POP-value will result in a stress-dependent $K_0$ value within the layers and thus the $K_0$-values are hidden when automatic $K_0$ determination is chosen (e.g. Figure 174 (on page 265)).
Be careful with very low or very high $K_0$-values, since these values might bring the initial stress in a state of failure. For a cohesionless material it can easily be shown that to avoid failure, the value of $K_0$ is bounded by:

$$\frac{1 - \sin(\phi)}{1 + \sin(\phi)} < K_0 < \frac{1 + \sin(\phi)}{1 - \sin(\phi)} \quad \text{Eq. [47]}$$

### 6.1.8.2 OCR and POP

When using advanced models (Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model, Sekiguchi-Ohta model) an initial preconsolidation stress has to be determined. In the engineering practice it is common to use a vertical preconsolidation stress, $\sigma_p$, but PLAXIS 2D needs an equivalent isotropic preconsolidation stress, $p_{eq}$, to determine the initial position of a cap-type yield surface. If a material is overconsolidated, information is required about the overconsolidation Ratio (OCR), i.e. the ratio of the greatest effective vertical stress previously reached, $\sigma_p$ (see Figure 175 (on page 266)), and the in-situ effective vertical stress, $\sigma'_{yy}$.

$$\text{OCR} = \frac{\sigma_p}{\sigma'_{yy}} \quad \text{Eq. [48]}$$
It is also possible to specify the initial stress state using the Pre-Overburden Pressure (POP) as an alternative to prescribing the overconsolidation ratio. The Pre-Overburden Pressure is defined by:

$$\text{POP} = \left| \sigma_p - \sigma_{yy}^0 \right| \quad \text{Eq. [49]}$$

These two ways of specifying the vertical preconsolidation stress are illustrated in Figure 175 (on page 266).

The preconsolidation stress $\sigma_p$ is used to compute the equivalent preconsolidation pressure $p_{\text{eq}}$ which determines the initial position of a cap-type yield surface in the advanced soil models. The calculation of $p_{\text{eq}}$ is based on the principal stress history ($\sigma_{1,max}', \sigma_2', \sigma_3'$). The actual determination of $p_{\text{eq}}$ depends on the constitutive model being used.

The principal stress history is initialised in the Initial phase (K$_0$-procedure or Gravity loading) based on the Cartesian effective stress components and the pre-overburden pressure (POP) or overconsolidation ratio (OCR) defined in the boreholes or data set. From this, Cartesian preconsolidation stress levels are calculated based on the following equations:

$$\sigma_{xx,c}' = K_{0nc}^{ocr} \sigma_{yy}'$$
$$\sigma_{yy,c}' = \sigma_{yy}'$$
$$\sigma_{zz,c}' = K_{0nc}^{ocr} \sigma_{yy}'$$
$$\sigma_{xy,c}' = \sigma_{xy}'$$

where $K_{0nc}^{ocr}$ is the $K_0$-value associated with normally consolidated states of stress. $K_{0nc}^{ocr}$ is a model parameter in advanced constitutive models and estimated in simple models ($K_{0nc}^{ocr} = 1 - \sin \phi$). Models that do not have $\phi$ as input parameter use $K_{0nc}^{ocr} = 0.5$ ($\phi = 30^\circ$).

The Cartesian stress components ($\sigma_{xx,c}', \sigma_{yy,c}', \sigma_{zz,c}'$) are transformed to principal stress components ($\sigma_{1,max}', \sigma_2', \sigma_3'$) and the maximum major principal stress, $\sigma_{1,max}'$, is kept as a general state parameter which is available for succeeding phases. In subsequent phases, $\sigma_{1,max}'$ is updated if the major principal stress is larger than the current one.

If, in later calculation phases, the soil behaviour is changed to an(other) advanced material model, the equivalent preconsolidation pressure $p_{\text{eq}}$ is initialised according to the current (updated) principal stress history ($\sigma_{1,max}', \sigma_2', \sigma_3'$).
### Table 15: $K_0$ behaviour

<table>
<thead>
<tr>
<th>Material Model</th>
<th>$K_0$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear Elastic model</td>
<td>0.5</td>
</tr>
<tr>
<td>Mohr-Coulomb model</td>
<td>$1 - \sin \varphi$</td>
</tr>
<tr>
<td>Hardening Soil model</td>
<td></td>
</tr>
<tr>
<td>Hardening Soil model with small-strain stiffness</td>
<td>$K_0^n c OCR - \frac{\gamma_{ur}}{1 - \gamma_{ur}}(OCR - 1)$</td>
</tr>
<tr>
<td>UBC3D-PLM model</td>
<td>$1 - \sin \varphi_p$</td>
</tr>
<tr>
<td>Soft Soil model</td>
<td>$K_0^n c OCR - \frac{\gamma_{ur}}{1 - \gamma_{ur}}(OCR - 1)$</td>
</tr>
<tr>
<td>Soft Soil Creep model</td>
<td>$K_0^n c OCR - \frac{\gamma_{ur}}{1 - \gamma_{ur}}(OCR - 1)$</td>
</tr>
<tr>
<td>Jointed Rock model</td>
<td>0.5</td>
</tr>
<tr>
<td>Modified Cam-Clay model</td>
<td>$K_0^n c OCR - \frac{\gamma_{ur}}{1 - \gamma_{ur}}(OCR - 1)$</td>
</tr>
<tr>
<td>NGI-ADP model</td>
<td>Calculated by the kernel</td>
</tr>
<tr>
<td>UDCAM-S model</td>
<td>Calculated by the kernel</td>
</tr>
<tr>
<td>Hoek-Brown model</td>
<td>0.5</td>
</tr>
<tr>
<td>Sekiguchi-Ohta model (Inviscid)</td>
<td>$K_0^n c OCR - \frac{\gamma_{ur}}{1 - \gamma_{ur}}(OCR - 1)$</td>
</tr>
<tr>
<td>Sekiguchi-Ohta model (Viscid)</td>
<td>$K_0^n c OCR - \frac{\gamma_{ur}}{1 - \gamma_{ur}}(OCR - 1)$</td>
</tr>
<tr>
<td>Concrete model</td>
<td>$1 - \sin \varphi_{max}$</td>
</tr>
<tr>
<td>User-defined Soil Model</td>
<td>0.5</td>
</tr>
</tbody>
</table>
6.2 Modelling undrained behaviour

In undrained conditions, no water movement takes place. As a result, excess pore pressures are built up. Undrained analysis is appropriate when:

- Permeability is low or rate of loading is high.
- Short term behaviour has to be assessed.

Different modelling schemes are possible in PLAXIS 2D to model undrained soil response in a Plastic calculation, a Safety analysis or a Dynamic analysis. The modelling scheme depends on the selection of the Drainage type parameter (General tabsheet (on page 172)). More details about these methods are in the Material Models Manual - Preliminaries on material modelling.

Note:
The Drainage type setting is only considered in a Plastic calculation, a Safety analysis or a Dynamic analysis. When a Consolidation analysis, a Fully coupled flow-deformation analysis or a Dynamic with consolidation analysis is performed, the Drainage type is ignored and the soil response is determined by the saturated permeability of the material that is specified in the Groundwater tabsheet of the material database.

Note:
The modelling of undrained soil behaviour is even more complicated than the modelling of drained behaviour. Therefore, the user is advised to take the utmost care with the modelling of undrained soil behaviour.

Before considering the consequences of a particular selection of the drainage type parameter for undrained soil behaviour, first a general description is given of the various modelling possibilities:

1. Undrained effective stress analysis with effective stiffness parameters

   A change in total mean stress in an undrained material during a Plastic calculation phase gives rise to excess pore pressures. PLAXIS 2D differentiates between steady-state pore pressures and excess pore pressures, the latter generated due to small volumetric strain occurring during plastic calculations and assuming a low (but non-zero) compressibility of the pore water. This enables the determination of effective stresses during undrained plastic calculations and allows undrained calculations to be performed with effective stiffness parameters. This option to model undrained material behaviour based on effective stiffness parameters is available for all material models in the PLAXIS 2D. The undrained calculations can be executed with effective stiffness parameters, with explicit distinction between effective stresses and (excess) pore pressures.

2. Undrained effective stress analysis with effective strength parameters

   Undrained effective stress analysis can be used in combination with effective strength parameters \( \varphi' \) and \( c' \) to model the material's undrained shear strength. In this case, the development of the pore pressure plays a crucial role in providing the right effective stress path that leads to failure at a realistic value of undrained shear strength \( (c_u \text{ or } s_u) \). However, note that most soil models are not capable of providing the right effective stress path in undrained loading. As a result, they will produce the wrong undrained shear strength if the material strength has been specified on the basis of effective strength parameters. Another problem is that for undrained materials effective strength parameters are usually not available from soil investigation data.

   The advantage of using effective strength parameters in undrained loading conditions is that after consolidation a qualitatively increased shear strength is obtained, although this increased shear strength could also be quantitatively wrong, for the same reason as explained before.

3. Undrained effective stress analysis with undrained strength parameters
Especially for soft soils, effective strength parameters are not always available, and one has to deal with measured undrained shear strength ($c_u$ or $s_u$) as obtained from undrained tests. Undrained shear strength, however, cannot easily be used to determine the effective strength parameters $\phi'$ and $c'$. Moreover, even if one would have proper effective strength parameters, care has to be taken as to whether these effective strength parameters will provide the correct undrained shear strength in the analysis. This is because the effective stress path that is followed in an undrained analysis may not be the same as in reality, due to the limitations of the applied soil model.

In order to enable a direct control on the shear strength, PLAXIS 2D allows for an undrained effective stress analysis with direct input of the undrained shear strength ($Undrained B$).

### 6.2.1 Undrained A

The *Drainage type Undrained A* enables modelling undrained behaviour using effective parameters for stiffness and strength. The characteristic features of method *Undrained A* are:

- The undrained calculation is performed as an effective stress analysis. Effective stiffness and effective strength parameters are used.
- Pore pressures are generated, but may be inaccurate, depending on the selected model and parameters.
- Undrained shear strength $s_u$ is not an input parameter but an outcome of the constitutive model. The resulting mobilised shear strength must be checked against known data.
- Consolidation analysis can be performed after the undrained calculation, which affect the shear strength.

*Undrained A* drainage type is available for the following models: Linear Elastic model, Mohr-Coulomb model, Hardening Soil model, Hardening Soil model with small-strain stiffness, UBC3D-PLM model, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model and UDSM.

### 6.2.2 Undrained B

The *Drainage type Undrained B* enables modelling undrained behaviour using effective parameters for stiffness and undrained strength parameters. The characteristic features of method *Undrained B* are:

- The undrained calculation is performed as an effective stress analysis.
- Effective stiffness parameters and undrained strength parameters are used.
- Pore pressures are generated, but may be highly inaccurate.
- Undrained shear strength $s_u$ is an input parameter.
- Consolidation analysis should not be performed after the undrained calculation. If consolidation analysis is performed anyway, $s_u$ must be updated.

*Undrained B* drainage type is available for the following models: Mohr-Coulomb model, Hardening Soil model, Hardening Soil model with small-strain stiffness, and UDCAM-S model. Note that when using *Undrained B* in the Hardening Soil model or Hardening Soil model with small-strain stiffness, the stiffness moduli in the model are no longer stress-dependent and the model exhibits no compression hardening.
6.2.3 Undrained C

The Drainage type Undrained C enables simulation of undrained behaviour using a total stress analysis with undrained parameters. In that case, stiffness is modelled using an undrained Young's modulus $E_u$ and an undrained Poisson ratio $\nu_u$, and strength is modelled using an undrained shear strength $c_u(s_u)$ and $\phi = \phi_u = 0^\circ$. Typically, for the undrained Poisson ratio a value close to 0.5 is selected (between 0.495 and 0.499). A value of exactly 0.5 is not possible, since this would lead to singularity of the stiffness matrix. The disadvantage of this approach is that no distinction is made between effective stresses and pore pressures. Hence, all output referring to effective stresses should now be interpreted as total stresses and all pore pressures are equal to zero. Note that a direct input of undrained shear strength does not automatically give the increase of shear strength with consolidation. The characteristic features of method Undrained C are:

- The undrained calculation is performed as a total stress analysis.
- Undrained stiffness parameters and undrained strength parameters are used.
- Pore pressures are not generated.
- Undrained shear strength $s_u$ is an input parameter.
- Consolidation analysis should not be performed after the undrained calculation. If consolidation analysis is performed anyway, $s_u$ must be updated.

Undrained C drainage type is available for the following models: Linear Elastic model, Mohr-Coulomb model, NGI-ADP model and UDCAM-S model.

**Note:**

For Undrained B and Undrained C an increased shear strength with depth can be modelled using the advanced parameter $s_{u,inc}$.

6.2.4 Undrained behaviour for unsaturated soil

As aforementioned, the build-up of pore pressures plays a crucial role in undrained analyses, especially Undrained A and Undrained B. Excess pore pressures are generated assuming very low compressibility of pore fluids. This is only valid for fully saturated soils where voids are filled by water. In unsaturated soils, the porous space is filled by both water and air. It is thus expected that the compressibility of pore fluid is much higher compared to saturated soils, and thereby a lower excess pore pressure.

On physical grounds, water in unsaturated soils co-exists with air under the form of water meniscus due to the capillary effect (surface tension). The excess pore pressure is governed by three factors: the compressibility of water, compressibility of air and surface tension (suction) effect. The latter is related to the Soil-Water retention curve (defined in Groundwater tabsheet (on page 236)).

In PLAXIS, we assume that the air pressure is always constant, namely excess air pressure and air compressibility are not considered (see Appendix Definition of stresses and related quantities (on page 599) ).

With this in mind, the undrained analysis only means that the water phase is undrained, while air phase is always drained. Excess pore pressure in undrained behaviour for an unsaturated zone is generated following two cases:

- If Ignore suction (on page 600) is not chosen, the suction effect is considered. Excess pore pressure is governed by an "unsaturated bulk modulus of pore fluid" which takes into account both the compressibility
of water and Soil-Water retention curve (see Table 22 on page 607). This fluid bulk modulus usually is much smaller than the water bulk modulus of water.

- If Ignore suction is chosen, the suction effect is neglected, and soil behaves like a saturated soil. Excess pore pressure is only governed by the compressibility of water in a similar way as saturated soil and is generally much higher than the case of considering suction. This might probably result in a stiffer undrained volume change behaviour, but a lower shear strength due to a higher pore pressure build-up. This is certainly dependent on the constitutive model used.

Note:
The behaviour of unsaturated soil is more realistic but also more complicated than saturated soil. The user is advised to take the utmost care with the modelling as well as Soil-Water retention curve input parameters.

6.3 Material data sets for discontinuities

As mentioned in the chapter Modelling loads and structures - Structures mode - Discontinuities (on page 115), the material properties for this element can be entered in the material data set window.

6.3.1 General properties

Several data sets may be created to distinguish different discontinuities. As displayed in Figure 176 (on page 272), the material data set includes the following options:
### Material properties and material database

#### Material data sets for discontinuities

**Figure 176: General tabsheet - Material properties of discontinuities**

<table>
<thead>
<tr>
<th><strong>Identification</strong></th>
<th>A user may specify any identification title for a discontinuity data set. It is advisable to use a meaningful name since the data set will appear in the database tree view by its identification.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Material Model(^1)</strong></td>
<td>Material model to be considered in the discontinuity.</td>
</tr>
<tr>
<td><strong>Drainage type</strong></td>
<td>Two options allowed <em>Drained</em> and <em>Non-porous</em>. Discontinuities can be open or filled with certain porous materials (for instance quartz, calcite or sand) which can be considered as <em>Drained</em>. However, if the infill is considered non-porous (for instance rock grouting for impermeabilisation techniques), the discontinuity element can also be considered <em>Non-porous</em>.</td>
</tr>
<tr>
<td><strong>Colour</strong></td>
<td>Colour can be used as a distinction tool in the model. The default color for a discontinuity is orange.</td>
</tr>
<tr>
<td><strong>Comments</strong></td>
<td>A user may write down comments related to the material data set.</td>
</tr>
</tbody>
</table>

**Note:**

- \(^1\)Currently only the Mohr-Coulomb material model is available for the modelling of discontinuity elements.

#### 6.3.2 Mechanical properties
Material properties and material database
Material data sets for discontinuities

The required parameters for the strength and stiffness of discontinuity are defined in the Mechanical tabsheet of the material properties definition as shown in Figure 177 (on page 273).

Figure 177: Mechanical properties of discontinuities with peak strength

6.3.2.1 Stiffness
Two distinct material stiffness can be assigned to discontinuities $k_n$ and $k_s$.

<table>
<thead>
<tr>
<th>$k_n$</th>
<th>Normal stiffness</th>
<th>kN/m$^3$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$k_s$</td>
<td>Shear stiffness</td>
<td>kN/m$^3$</td>
</tr>
</tbody>
</table>

6.3.2.2 Strength
Defines the strength parameters of the material in the discontinuity according the material model available (see General properties (on page 271)). Two strength methods are available: Peak and Peak and Residual.

Peak
This is the default method. The strength parameters represent the peak strength and no material softening occurs when the peak strength is reached.

| $c_e$ | Effective cohesion of the material in the discontinuity | kN/m$^2$ |
| $\varphi'$ | Effective Internal friction angle of the material in the discontinuity | ° |
Consider gap closure
When tensile stresses are applied to a discontinuity, the discontinuity will open, creating a gap in the element. When the load is reversed, the contact between either sides of the discontinuities needs to be restored before a compressive stress can develop.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\psi_i$</td>
<td>Dilatancy angle of the material in the discontinuity</td>
<td>°</td>
</tr>
<tr>
<td>RSF</td>
<td>Residual Strength Factor</td>
<td>-</td>
</tr>
</tbody>
</table>

**Peak and Residual**

When this *Strength method* is selected, the RSF (Residual Strength Factor) can be specified for the discontinuity (as shown in Figure 178 (on page 274)). Once the peak strength is reached, the discontinuity material strength will reduce to its residual strength as defined by RSF, as follows:

If $RSF < 1$:

- $c_{res} = RSF \cdot c_{ini}$
- $\tan(\phi_{res}) = RSF \cdot \tan(\phi_{ini})$

**Figure 178: Mechanical properties of discontinuities with peak and residual strength**
6.3.3 **Groundwater properties**

Groundwater flow parameters are required when dealing with the hydraulic conditions of discontinuities specifically when drained behaviour is addressed. For this reason, to enable the use of groundwater hydraulic parameters the Drainage type of material needs to be set as Drained (see General properties (on page 271)). When drained conditions are selected, the **Groundwater** tabsheet is displayed as in Figure 179 (on page 275).

![Figure 179: Groundwater properties of discontinuities](image)

The groundwater parameter available is listed below:

<table>
<thead>
<tr>
<th>$T_i$</th>
<th>Transmissivity in the local direction 1 of a discontinuity: volumetric flow rate though the discontinuity in this local direction per unit width (perpendicular to the flow direction) under unit hydraulic gradient</th>
<th>m³/day/m</th>
</tr>
</thead>
</table>

It is important to mention that under drained conditions the discontinuity behaves as Fully permeable (the discontinuity has an infinite cross permeability or zero cross resistance), and the Transmissivity represents the drainage conductivity in the longitudinal direction of the fracture.

**Note:** If Drainage type defined in General properties (on page 271) is set as Non-porous the Transmissivity (T) is disabled.
6.3.4  **Thermal properties [ADV]**

The Thermal tabsheet (see Figure 180 (on page 276)) contains discontinuity properties for problems involving (a change of) temperature and the influence on stress, deformation or groundwater.

![Discontinuity - <NoName>](image)

*Figure 180: Thermal tabsheet - Discontinuity element*

The thermal parameter available for discontinuities is listed below:

<table>
<thead>
<tr>
<th>$R$</th>
<th>Thermal Resistance</th>
<th>m²K/kW</th>
</tr>
</thead>
</table>

The thermal resistance $R$ is used to control the heat transfer across the discontinuity. $R$ is defined as the ratio between the aperture of the discontinuity, $d$, and the thermal conductivity, $\lambda$, of the discontinuity material.

$$R = \frac{d}{\lambda} \quad \text{Eq. [51]}$$
6.4 Material data sets for plates

In addition to material data sets for soil and interfaces, the material properties and model parameters for plates are also entered in separate material data sets. Plates are used to model the behaviour of slender walls, plates or thin shells. Distinction can be made between elastic, elastoplastic and elastoplastic ($M$-$\kappa$) behaviour. A data set for plates generally represents a certain type of plate material, and can be assigned to the corresponding (group of) plate elements in the geometry model.

6.4.1 General properties

In the General tabsheet properties with respect to the material behaviour, weight and also damping in a Dynamics analysis must be specified. Figure 181 (on page 277) shows the General tabsheet of the Plate window.

![Figure 181: General tabsheet of the Plate window](image)

6.4.1.1 Material set

The material data set is defined by:

| Identification | A user may specify any identification title for a data set. It is advisable to use a meaningful name since the data set will appear in the database tree view by its identification. |
Material properties and material database
Material data sets for plates

<table>
<thead>
<tr>
<th>Material type</th>
<th>There are three available options, describing the material type of a plate. These options are Elastic, Elastoplastic and Elastoplastic ($M$-$\kappa$). The availability of the parameters defined at the Mechanical tabsheet depends on the selected material type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td>A user may write down comments related to the material data set.</td>
</tr>
<tr>
<td>Colour</td>
<td>Colour can be used as a distinction tool in the model.</td>
</tr>
</tbody>
</table>

6.4.1.2 Unit weight
Additionally, the unit weight of the plate must be specified:

<table>
<thead>
<tr>
<th>$w$</th>
<th>In a material set for plates a specific weight can be specified.</th>
<th>[kN/m/m]</th>
</tr>
</thead>
</table>

6.4.1.3 Rayleigh damping[ULT]
For dynamic behaviour, the Rayleigh $\alpha$ and Rayleigh $\beta$ damping parameters can be specified either directly or through Single Degree of Freedom (SDOF) equivalent parameters.

For more information on Rayleigh damping and how to specify the parameters, see Rayleigh damping [ULT] (on page 176).

6.4.1.4 Advanced

Prevent punching: In reality vertical loads on walls for example, as a result of vertical components of anchor forces are sustained by the shaft friction and the tip resistance. A certain amount of resistance is offered by the soil under the tip, depending on the thickness or the cross section area of the tip.

Slender walls are often modelled as plates. Due to the zero thickness of the plate elements vertical plates (walls) have no end bearing. The effects of end bearing can still be considered in the calculation when the Prevent punching option is selected in the material data set. In order to consider end bearing at the bottom of plates, a zone in the soil volume elements surrounding the bottom of the plate is identified where any kind of soil plasticity is excluded (elastic zone). The size of this zone is determined as $D = \sqrt{\frac{2EI}{EA}}$.

It is not the idea that this end bearing represents the true end bearing capacity of the wall. It just prevents unrealistic vertical movement of penetration of the wall into deeper layers. The value of end bearing cannot be prescribed by the user, and it is neither theoretically determined by PLAXIS 2D.

Note:
Note that sheet pile walls have very little end bearing, considering that the thickness of the steel is much less than $D_{eq}$, when modelling them as plates. Hence, the Prevent punching option shall not be used for sheet pile walls.
6.4.2  Mechanical properties

The mechanical properties required for plates can be grouped into stiffness properties and strength properties (in case of elastoplastic behaviour).

6.4.2.1  Stiffness properties

For elastic behaviour, several parameters should be specified as material properties. PLAXIS 2D allows for orthotropic material behaviour in plates where the in-plane stiffness and out-of-plane stiffness are different. This is most relevant for axisymmetric models when modelling sheet pile profiles (which have a low stiffness in the out-of-plane direction).

<table>
<thead>
<tr>
<th>Isotropic</th>
<th>If selected, the in-plane stiffness and out-of-plane stiffness will be equal.</th>
<th>[-]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$EA_1$</td>
<td>In-plane elastic axial stiffness.</td>
<td>[kN/m]</td>
</tr>
<tr>
<td>$EA_2$</td>
<td>Out-of-plane elastic axial stiffness.</td>
<td>[kN/m]</td>
</tr>
<tr>
<td>$EI$</td>
<td>Elastic bending stiffness. Note that in the case of Elastoplastic ($M$-$\kappa$) behaviour, $EI$ is automatically determined based on the first line segment in the $M$-$\kappa$ diagram.</td>
<td>[kN/m$^2$/m]</td>
</tr>
<tr>
<td>$\nu$</td>
<td>Poisson’s ratio.</td>
<td>[-]</td>
</tr>
</tbody>
</table>

From the ratio of $EI$ and $EA_1$ an equivalent thickness for an equivalent plate ($d$) is automatically calculated from the equation:

$$d = \sqrt{\frac{12EI}{EA_1}} \quad \text{Eq. [52]}$$

For the modelling of plates, PLAXIS 2D uses the Mindlin beam theory as described in Bathe (1982) (on page 586). This means that, in addition to bending, shear deformation is taken into account. The shear stiffness of the plate is determined from:

$$\text{Shear stiffness} = \frac{5EA}{12(1+\nu)} = \frac{5E(d \cdot 1m)}{12(1+\nu)} \quad \text{Eq. [53]}$$

This implies that the shear stiffness is determined from the assumption that the plate has a rectangular cross section. In the case of modelling a solid wall, this will give the correct shear deformation. However, in the case of steel profile elements, like sheet-pile walls, the computed shear deformation may be too large. You can check this by judging the value of $d_{eq}$. For steel profile elements, $d_{eq}$ should be at least of the order of a factor 10 times smaller than the length of the plate to ensure negligible shear deformations.

More information about the behaviour and structural forces in plates can be found in the Material Models Manual - Structural elements - 2D Plates.

In addition to the above stiffness parameters, a Poisson’s ratio, $\nu$, is required. For thin structures with a certain profile or structures that are relatively flexible in the out-of-plane direction (like sheet-pile walls), it is advisable to set Poisson’s ratio to zero. For real massive structures (like concrete walls) it is more realistic to enter a true Poisson’s ratio of the order of 0.15.
Since PLAXIS 2D considers plates (extending in the out-of-plane direction) rather than beams (one-dimensional structures), the value of Poisson's ratio will influence the bending stiffness of the isotropic plate in plane strain applications as follows:

- Input value of bending stiffness: $EI$
- Observed value of bending stiffness: $EI/(1 - \nu^2)$

The stiffening effect of Poisson's ratio is caused by the stresses in the out-of-plane direction ($\sigma_{zz}$) and the fact that strains are prevented in this direction. Note that the Poisson's ratio ($\nu$) is assumed to be zero in anisotropic case.

### 6.4.2.2 Strength properties

#### Elastoplastic

Strength parameters are required in the case of elastoplastic behaviour:

<table>
<thead>
<tr>
<th>$M_p$</th>
<th>Maximum bending moment.</th>
<th>[kNm/m]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$N_{p,1}$</td>
<td>The maximum axial force in 1-direction.</td>
<td>[kN/m]</td>
</tr>
<tr>
<td>$N_{p,2}$</td>
<td>The maximum axial force in 2-direction (anisotropic behaviour).</td>
<td>[kN/m]</td>
</tr>
</tbody>
</table>

Plasticity may be taken into account by specifying a maximum bending moment, $M_p$. The maximum bending moment is given in units of force times length per unit width. In addition to the maximum bending moment, the axial force is limited to $N_p$. The maximum axial force, $N_p$, is specified in units of force per unit width. When the combination of a bending moment and an axial force occur in a plate, then the actual bending moment or axial force at which plasticity occurs is lower than respectively $M_p$ or $N_p$. More information is given in the Material Models Manual - Structural elements - 2D Plates.

The relationship between $M_p$ and $N_p$ is visualised in Figure 182 (on page 281). The diamond shape represents the ultimate combination of forces for which plasticity will occur. Force combinations inside the diamond will result in elastic deformations only. The Scientific Manual describes in more detail how PLAXIS 2D deals with plasticity in plates.

Bending moments and axial forces are calculated at the stress points of the plates elements (Figure 63 (on page 103)). If $M_p$ or $N_p$ is exceeded, stresses are redistributed according to the theory of plasticity, so that the maxima are complied with. This will result in irreversible deformations. Output of bending moments and axial forces is given in the nodes, which requires extrapolation of the values at the stress points. Due to the position of the stress points in a beam element, it is possible that the nodal values of the bending moment may slightly exceed $M_p$ if the Isotropic option is checked the input is limited to $N_{p,1}$ where as $N_{p,1} = N_{p,2}$. 

---

**PLAXIS 280**

Reference Manual 2D
Material properties and material database

Material data sets for plates

Figure 182: Combinations of maximum bending moment and axial force

**Elastoplastic (M-κ)**

In the case the Material type is set to Elastoplastic (M-κ), the bending behaviour of the plate is governed by a user-defined moment-curvature (M-κ) diagram. Input values of the κ diagram can be specified in the table that appears at the right hand panel when the M-κ diagram input field is selected. Here, a name can be given to the M-κ diagram to be defined. Adding rows to the table can be done by clicking the ‘+’ sign above the table. Only positive values can be specified for curvature κ (in the unit of 1/length) and moment M (in the unit of Force times length per unit of width in the out-of-plane direction), since the M-κ diagram is assumed to govern the plate’s behaviour in both positive and negative loading directions. A graphical representation of the M-κ diagram is presented below the table (only positive values).

The first row in the M-κ diagram determines the plate’s elastic bending stiffness $EI$:

$$EI = M(1)/κ(1) \quad Eq. [54]$$

This $EI$ value is included in the set of stiffness properties. Additional rows in the M-κ table define the plate’s nonlinear elastoplastic behaviour. The last M-value in the table is assumed to be the maximum bending moment, $M_p$, at which the plate fails. Elastic bending strains are calculated from the aforementioned $EI$ value, whereas additional bending (following the defined M-κ diagram) is assumed to be plastic, as long as the loading is in the same direction. Upon unloading from an elastoplastic state, the behaviour is initially elastic, but after significant unloading it may again generate plastic strains.

In the Elastoplastic (M-κ) plates, the axial force $N$ is considered elastic and independent from the bending moment $M$. The axial force influences the stresses and displacements of the element but without affecting the bending moment. The M-κ diagram is assumed to be the only one governing the plate’s flexural behaviour.

Figure 183: M-κ diagram
It is possible to change the material data set of a plate in the framework of staged construction. However, it is very important that the ratio of $EI/EA$ is not changed, since this will introduce an out-of-balance force (see Plates (on page 101)).

### 6.4.3 Thermal properties [ADV]

For thermal behaviour, additional constants are specified in the *Thermal* tabsheet.

<table>
<thead>
<tr>
<th>$c$</th>
<th>The specific heat capacity of the solid material. Describes the amount of energy (heat) that can be stored in the solid material per unit of mass.</th>
<th>[kJ/t/K]</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\lambda$</td>
<td>The thermal conductivity of the solid material. Describes the rate of energy (heat) that can be transported in the solid material.</td>
<td>[kW/m/K]</td>
</tr>
<tr>
<td>$\rho$</td>
<td>The density of the solid material. Describes the density of the solid particles.</td>
<td>[t/m$^3$]</td>
</tr>
<tr>
<td>$\alpha$</td>
<td>The thermal expansion coefficient. Describes how much the material expands (or elongates) when the temperature increases. In other words, it is the (change of) strain per unit of temperature.</td>
<td>[1/K]</td>
</tr>
<tr>
<td>$A_{eff,T}$</td>
<td>The effective area for thermal flux.</td>
<td>[m$^2$]</td>
</tr>
</tbody>
</table>

### 6.5 Material data sets for geogrids

In addition to material data sets for soil and interfaces, the material properties and model parameters for geogrids are also entered in separate material data sets. Geogrids are flexible elastic or elastoplastic elements that represent a grid or sheet of fabric. Geogrids can only sustain tensile forces, but not compressive forces. A data set for geogrids generally represents a certain type of geogrid material, and can be assigned to the corresponding (group of) geogrid elements in the geometry model.

#### 6.5.1 General properties

Several data sets may be created to distinguish between different types of geogrids or geosynthetics. Figure 184 (on page 283) shows the *General* tabsheet of the *Geogrid* window. The general properties of a geogrid are:

<table>
<thead>
<tr>
<th>Identification</th>
<th>A user may specify any identification title for a data set. It is advisable to use a meaningful name since the data set will appear in the database tree view by its identification.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td>A user may write down comments related to the material data set.</td>
</tr>
<tr>
<td>Colour</td>
<td>Colour can be used as a distinction tool in the model.</td>
</tr>
</tbody>
</table>
There are four available options, describing the material type of a plate. These options are Elastic, Elastoplastic, Elastoplastic ($N\varepsilon$) and Visco-elastic (time-dependent). The availability of the parameters defined at the Mechanical tabsheet depends on the selected material type.

---

**6.5.2 Mechanical properties**

The properties required for geogrids can be grouped into stiffness properties and strength properties in case of elastoplastic behaviour.

**6.5.2.1 Isotropic**

Different stiffness and strength in-plane and out-of-plane may be considered. If this is not the case, the Isotropic option may be selected to ensure that the stiffness in both directions is equal.

**6.5.2.2 Stiffness properties**

**Elastic**

For elastic behaviour, the axial stiffness $EA$ should be specified. PLAXIS 2D allows for orthotropic material behaviour in geogrids, which is defined by the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$EA_1$</td>
<td>The axis axial elastic stiffness in 1-direction (in-plane).</td>
<td>[kN/m]</td>
</tr>
<tr>
<td>$EA_2$</td>
<td>The axial elastic stiffness in 2-direction (out-of-plane, anisotropic behaviour).</td>
<td>[kN/m]</td>
</tr>
</tbody>
</table>
Material properties and material database

Material data sets for geogrids

The axial stiffness $EA$ is usually provided by the geogrid manufacturer and can be determined from diagrams in which the elongation of the geogrid is plotted against the applied force in a longitudinal direction. The axial stiffness is the ratio of the axial force $F$ per unit width and the axial strain ($\varepsilon = \Delta l/l$ where $\Delta l$ is the elongation and $l$ is the original length):

$$ EA = \frac{F}{\varepsilon} \quad \text{Eq. [55]} $$

If the *Isotropic* option is checked the input is limited to $EA_1$ where as $EA_2 = EA_1$.

**Visco-elastic (time-dependent)**

The parameters are based on a visco-elastic perfectly-plastic Kelvin-Voigt model in each direction, which allows for time-dependent behaviour.

![Figure 185: Force versus axial strain showing $EA_{short}$ and $EA_{long}$](image)

Considering one Kelvin-Voigt element (see Figure 186 (on page 284)),

![Figure 186: Kelvin-Voigt single element representation](image)

$$ EA_0 = EA_{short} \quad \text{Eq. [56]} $$

$$ \frac{1}{EA_0} + \frac{1}{EA_1} = \frac{1}{EA_{long}} $$

$$ EA_1 = \frac{1}{\left(\frac{1}{EA_{long}} - \frac{1}{EA_0}\right)} $$

$$ \eta = EA_1 \times \text{Retardation time} $$

where $\eta$ is viscous damping, $EA_0$ and $EA_1$ are internal stiffness used in the geogrid material model.
Material properties and material database

Material data sets for geogrids

Figure 187: Strain versus time in a Creep test

Retardation time can be obtained from a creep test in which a force \( F \) is applied, using the following equations (see Figure 187 (on page 285)):

\[
\begin{align*}
    t_{\text{retardation}} &= \frac{\eta_1}{E_1} \\
    EA_{\text{short}} &= \frac{F}{u_{\text{short}}} \\
    EA_{\text{long}} &= \frac{1}{EA_{\text{short}}} \\
    \varepsilon_{\text{short}} &= \frac{F}{EA_{\text{short}}} \\
    \varepsilon_{\text{long}} &= \frac{F}{EA_{\text{long}}}
\end{align*}
\]  

Eq. [57]

The short-term and long-term stiffnesses can be obtained from the same creep test by measuring the corresponding strain \( \varepsilon \) at the short and long time, respectively.

Parameters which are required for time dependent visco-elasticity are (Figure 188 (on page 286)):

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>( EA_{1,\text{short}} )</td>
<td>Elastic stiffness during initial (instantaneous) strain increment in 1-direction (in-plane).</td>
<td>[kN/m]</td>
</tr>
<tr>
<td>( EA_{2,\text{short}} )</td>
<td>Elastic stiffness during initial (instantaneous) strain increment in 2-direction (out-of-plane, anisotropic behaviour).</td>
<td>[kN/m]</td>
</tr>
<tr>
<td>( EA_{1,\text{long}} )</td>
<td>Elastic stiffness during (infinitely) long strain increment in 1-direction (in-plane).</td>
<td>[kN/m]</td>
</tr>
<tr>
<td>( EA_{2,\text{long}} )</td>
<td>Elastic stiffness during (infinitely) long strain increment in 1-direction (out-of-plane, anisotropic behaviour).</td>
<td>[kN/m]</td>
</tr>
<tr>
<td>Retardation time</td>
<td>The time where a linear extrapolation of the initial creep rate intersects the long-term displacement line.</td>
<td>[day]</td>
</tr>
</tbody>
</table>
6.5.2.3 Strength properties

**Elastoplastic**

Strength parameters are required in case of elastoplasticity:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$N_{p,1}$</td>
<td>The maximum force in 1-direction (in-plane).</td>
<td>[kN/m]</td>
</tr>
<tr>
<td>$N_{p,2}$</td>
<td>The maximum force in 2-direction (out-of-plane, anisotropic behaviour).</td>
<td>[kN/m]</td>
</tr>
</tbody>
</table>

The maximum axial tension force $N_p$ is specified in units of force per unit width. If $N_p$ is exceeded, stresses are redistributed according to the theory of plasticity, so that the maxima are complied with. This will result in irreversible deformations. Output of axial forces is given in the nodes, which requires extrapolation of the values at the stress points. Due to the position of the stress points in a geogrid element, it is possible that the nodal values of the axial force may slightly exceed $N_p$.

If the *Isotropic* option is checked the input is limited to $N_{p,1}$ where as $N_{p,2} = N_{p,1}$.

**Elastoplastic (N-ε)**

A non-linear $N$-$ε$ diagram may be specified in case of elastoplasticity ($N$-$ε$):

<table>
<thead>
<tr>
<th>Diagram</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$N_1$-$ε_1$ diagram</td>
<td>The $N$-$ε$ diagram in 1-direction (in-plane).</td>
</tr>
<tr>
<td>$N_2$-$ε_2$ diagram</td>
<td>The $N$-$ε$ diagram in 2-direction (out-of-plane, anisotropic behaviour).</td>
</tr>
</tbody>
</table>

The user can add both $N$-$ε$ diagrams, by specifying values as a table or importing a text file containing values (Figure 189 (on page 287)). The axial tension force is specified in units of force per unit width. The first part of the $N$-$ε$ diagram is used to calculate the $EA$ value.

If the *Isotropic* option is checked the input is limited to $N_1$-$eps_1$ where as $N_2$-$eps_2 = N_1$-$eps_1$. 

*Figure 188: Geogrid window*
6.5.3 *Thermal properties* [ADV]

For thermal behaviour, additional constants are specified in the *Thermal* tabsheet.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c$</td>
<td>The specific heat capacity of the solid material. Describes the amount of energy (heat) that can be stored in the solid material per unit of mass.</td>
<td>[kJ/(\text{t}/\text{K})]</td>
</tr>
<tr>
<td>$\lambda$</td>
<td>The thermal conductivity of the solid material. Describes the rate of energy (heat) that can be transported in the solid material.</td>
<td>[kW/(\text{m}/\text{K})]</td>
</tr>
<tr>
<td>$\rho$</td>
<td>The density of the solid material. Describes the density of the solid particles.</td>
<td>[t/(\text{m}^3)]</td>
</tr>
<tr>
<td>$\alpha$</td>
<td>The thermal expansion coefficient. Describes how much the material expands (or elongates) when the temperature increases. In other words, it is the (change of) strain per unit of temperature.</td>
<td>[1/(\text{K})]</td>
</tr>
<tr>
<td>$A_{\text{eff},T}$</td>
<td>The area in consideration for the thermal expansion.</td>
<td>[(\text{m}^2)]</td>
</tr>
</tbody>
</table>

*Note:* The creep properties of geogrids are very sensitive to the temperature. The visco-elastic perfectly-plastic model adopted for geogrids allows time-dependent behaviour but without temperature-dependency. Hence, the thermal expansion coefficient does not take the temperature effect on creep into account.
6.6 Material data sets for embedded beams

Properties and model parameters for embedded beam are entered in separate material data sets. Embedded beams can be used to model different types of slender structures that interact with the surrounding soil/rocks such as piles, ground anchors or rock bolts. A data set for embedded beams generally represents a certain type of embedded beam, including the pile/rock bolt material and geometric properties, the interaction properties with the surrounding soil or rock (bearing capacity) as well as the out-of-plane spacing of the piles/rock bolts.

Note that the embedded beam material data set does not contain so-called 'p-y curves', nor equivalent spring constants. In fact, the stiffness response of an embedded beam subjected to loading is the result of the specified embedded beam length, equivalent radius, spacing, stiffness, bearing capacity, the stiffness of the interface as well as the stiffness of the surrounding soil.

**Note:**
In contrast to what is common in the Finite Element Method, the bearing capacity of an embedded beam is considered to be an input parameter rather than the result of the finite element calculation. The user should realise the importance of this input parameter. Preferably, the input value of this parameter should be based on representative pile load test or pull out test data. Moreover, it is advised to perform a calibration in which the behaviour of the embedded beam is compared with the behaviour as measured from the test. When embedded beams are used in a row, the group action must be taken into account when defining their bearing capacity.

**Note:** Embedded beams can only be used in plane strain models and are not available in axisymmetry.

6.6.1 General properties

Several data sets may be created to distinguish between different types of embedded beams. Figure 190 (on page 289) shows the Embedded beam window.
6.6.1.1 Material set

The material data set is defined by:

<table>
<thead>
<tr>
<th>Identification</th>
<th>A user may specify any identification title for a data set. It is advisable to use a meaningful name since the data set will appear in the database tree view by its identification.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material type</td>
<td>There are three available options, describing the material type for embedded beams. These options are Elastic, Elastoplastic and Elastoplastic (M-κ). The availability of the parameters defined on the Mechanical tabsheet depends on the selected material type.</td>
</tr>
<tr>
<td>Colour</td>
<td>Colour can be used as a distinction tool in the model.</td>
</tr>
<tr>
<td>Comments</td>
<td>A user may write down comments related to the material data set.</td>
</tr>
</tbody>
</table>

6.6.1.2 Unit weight

Additionally, the unit weight of the embedded beam must be specified:

| $\gamma$ | The unit weight is the unit weight of the material from which the embedded beam is composed. | [kN/m$^3$] |
6.6.1.3 Rayleigh damping [ULT]

For dynamic behaviour, the Rayleigh $\alpha$ and Rayleigh $\beta$ damping parameters can be specified either directly or through Single Degree of Freedom (SDOF) equivalent parameters.

For more information on Rayleigh damping and how to specify the parameters, see Rayleigh damping [ULT] (on page 176).

6.6.2 Mechanical properties

The material properties are defined for a single beam, but the use of PLAXIS 2D implies that a row of piles or rock bolts in the out-of-plane direction is considered where properties are specified per unit width in out-of-plane direction.

Figure 191 (on page 291) shows the Mechanical tabsheet for an embedded beam in PLAXIS 2D.
Material properties and material database

Material data sets for embedded beams

![Embedded beam - <NoName>](image)

**Figure 191: Mechanical tabsheet of the Embedded beam window**

**Note:**

- In a finite element model, embedded beams are superimposed on a continuum and therefore 'overlap' the soil. Especially for Solid structures, to calculate accurately the total weight of soil and structures in the model, the unit weight of the soil should be subtracted from the unit weight of the embedded beam material.
- Please note that when reducing the unit weight, the axial forces in the embedded beams may not be realistic.

### 6.6.2.1 Cross section properties

An embedded beam requires several geometric parameters used to calculate additional properties. First of all, the out-of-plane spacing $L_{\text{spacing}}$ in [m] must be defined in order to calculate all parameters per meter width out-of-plane.
Either a predefined or a user-defined type can be selected.

### Predefined cross section type
A list of predefined types (*Solid circular beam, Circular tube, Solid square beam*). After entering the required data, the parameters \( A, I_3, I_2, W_3 \) and \( W_2 \) are filled automatically.

### Diameter
The embedded beam diameter is to be defined for *Solid circular beam* and *Circular tube* predefined embedded beam types. The embedded beam diameter determines the size of the elastic zone in the soil under the embedded beam in which plastic soil behaviour is excluded. It also influences the default values of the interface stiffness factors ([Interface stiffness factor](on page 296)).

### Width
The embedded beam width is to be defined for a *Solid square beam* predefined beam type. The embedded beam width is recalculated into an equivalent diameter, \( D_{eq} = \sqrt{2EI} / EA \). This diameter determines the size of the elastic zone in the soil under the embedded beam in which plastic soil behaviour is excluded. It also influences the default values of the interface stiffness factors.

### Thickness
The wall thickness needs to be defined for a *Circular tube* predefined beam type.

Alternatively, a user-defined type may be defined by means of the embedded beam cross section area, \( A \), and its respective moment of inertia \( I \):

\[
A \quad \text{The cross section area is the actual area (in the unit of length squared) perpendicular to the embedded beam axis where embedded beam material is present. For embedded beams that have a certain profile (such as steel beams), the cross section area can be found in tables that are provided by the manufacturer.} \quad [m^2]
\]

\[
l \quad \text{Moment of inertia against bending around the embedded beam axis.} \quad [m^4]
\]

\[
l = \frac{1}{64} \pi D^4 \quad \text{Solid circular embedded beam}
\]

\[
l = \frac{1}{4} \left( \left( \frac{D}{2} \right)^4 - \left( \frac{D}{2} - t \right)^4 \right) \quad \text{Circular tube} \quad \text{Eq. [58]}
\]

\[
l = \frac{1}{12} h^4 \quad \text{Solid square embedded beam}
\]

where \( D \) is the embedded beam diameter, \( t \) is the wall thickness and \( h \) is the embedded beam width.

#### 6.6.2.2 Stiffness
An embedded beam has only a single stiffness parameter:

\[
E \quad \text{Young’s modulus.} \quad [kN/m^2]
\]

#### 6.6.2.3 Strength
**Elastoplastic**
For elastoplastic behaviour of an embedded beam, the strength is defined by the plastic limits for bending moment and axial force:

| \( M_p \) | Maximum (plastic) bending moment | [kNm] |
| \( N_p \) | Maximum (plastic) axial force | [kN] |

**Elastoplastic (M-κ)**

In the case the *Material type* is set to *Elastoplastic (M-κ)*, the bending behaviour of the plate is governed by a user-defined moment-curvature \((M-κ)\) diagram. Input values of the \(κ\) diagram can be specified in the table that appears at the right hand panel when the \(M-κ\) diagram input field is selected.

For more information on elastoplastic behaviour see Strength properties (on page 280)

### 6.6.3 Interaction properties: bearing capacity

The interaction between the pile or rock bolt (embedded beam element) and the surrounding soil or rock (soil volume element) is modelled by means of a special interface element. An elastoplastic model is used to describe the behaviour of the interface. The elastic behaviour of the interface should account for the difference in pile/rock bolt displacements and average soil/rock displacements in the out-of-plane direction. This depends on the out-of-plane spacing in relation to the diameter. Regarding the plastic behaviour, distinction is made in the material data set between the *Skin resistance* (in the unit of force per unit embedded beam length) and the *Base resistance* (in the unit of force). In a plane strain analysis, these values are automatically recalculated per unit of width in the out-of-plane direction. For the skin resistance, as well as the base resistance, a failure criterion is used to distinguish between elastic interface behaviour and plastic interface behaviour. For elastic behaviour relatively small displacement differences occur within the interface (i.e. between the pile/rock bolt and the average soil/rock displacement), and for plastic behaviour permanent slip may occur.

For the interface, to remain elastic, the shear force \(t_s\) at a particular point is given by:

\[
| t_s | < T_{\text{max}} \quad \text{Eq. [59]}
\]

where \(T_{\text{max}}\) is the equivalent local skin resistance at that point.

For plastic behaviour the shear force \(t_s\) is given by:

\[
| t_s | = T_{\text{max}} \quad \text{Eq. [60]}
\]

The input for the shaft resistance is defined by means of the axial skin resistance \(F_{\text{skin}}\) and the base resistance \(F_{\text{max}}\). Using this approach the total pile bearing capacity, \(N_{\text{pile}}\), is given by:

\[
N_{\text{pile}} = F_{\text{max}} + F_{\text{skin}} \quad \text{Eq. [61]}
\]

The skin resistance \(F_{\text{skin}}\) can be defined in three ways: *Linear*, *Multi-linear* and *Layer dependent*. The base resistance \(F_{\text{max}}\) can be entered directly (in the unit of force) in the embedded beam material data set window.

**Note:**

The base resistance is only mobilised when the pile body moves in the direction of the base (example: with a load on top).

For rock bolts, the bearing capacity may be defined in a similar way, although rock bolts generally do not have an end bearing \((F_{\text{max}} = 0)\):
Materials properties and material database

Material data sets for embedded beams

\[ N_{\text{rockbolt}} = F_{\text{skin}} \quad \text{Eq. [62]} \]

In order to ensure that a realistic bearing capacity as specified can actually be reached, a zone in the soil elements surrounding the beam is identified where any kind of soil plasticity is excluded (elastic zone). The size of this zone is determined by the embedded beam’s diameter \( D \) or equivalent diameter \( D_{eq} \). The elastic zone makes the embedded beam almost behave like a volume element. Installation effects are not taken into account and the embedded beam-soil interaction is modelled at the centre rather than at the circumference.

The bearing capacity is automatically divided by the spacing in order to obtain the equivalent bearing capacity per unit of width in the out-of-plane direction.

In addition to displacement differences and shear forces in axial direction along the embedded beam element, the beam can undergo transverse forces, \( t_\perp \), due to lateral displacements. The lateral displacements can be induced by a transverse force applied at the top of the pile or as a consequence of the transverse distributed load induced by the lateral displacement field of the surrounding soil. In the first case, the overall behaviour may not show fully realistic results. In the second case, although embedded beam elements are not meant to be used as laterally loaded piles, they show reasonable results and the overall behaviour is quite realistic. For more information about the modelling techniques for embedded structures, see the Appendix of the Material Models Manual.

The user can limit the transverse forces using the Lateral resistance option. This can be done in three ways: Unlimited, Linear and Multi-linear lateral resistance.

More details about the way the shear and transverse forces are calculated on the basis of displacement differences between the embedded beam element and the surrounding soil element are described in the Material Models Manual.

6.6.3.1 Axial skin resistance

Linear

The Linear option is the easiest way to enter the skin resistance and lateral resistance profile. The input is defined by means of the skin resistance and lateral resistance at the beginning of the embedded beam, \( T_{\text{skin,start,max}} \) and \( T_{\text{lat,start,max}} \) (in force per unit beam length), and the skin resistance and lateral resistance at the end of the embedded beam, \( T_{\text{skin,end,max}} \) and \( T_{\text{lat,end,max}} \) (in force per unit beam length). This way of defining the skin resistance and lateral resistance is mostly applicable to piles in a homogeneous soil layer. Using this approach the total pile bearing capacity, \( N_{\text{pile}} \), is given by:

\[ N_{\text{pile}} = F_{\text{max}} + \frac{1}{2} L_{\text{pile}} (T_{\text{skin,start,max}} + T_{\text{skin,end,max}}) \quad \text{Eq. [63]} \]

where \( L_{\text{pile}} \) is the pile length. \( T_{\text{skin,start,max}} \) and \( T_{\text{skin,end,max}} \) are measured at the pile top and the bottom of the pile respectively.

For rock bolts, the bearing capacity may be defined as follows:

\[ N_{\text{rockbolt}} = \frac{1}{2} L_{\text{rockbolt}} (T_{\text{skin,start,max}} + T_{\text{skin,end,max}}) \quad \text{Eq. [64]} \]

where \( L_{\text{rockbolt}} \) is the rock bolt length. \( T_{\text{skin,start,max}} \) and \( T_{\text{skin,end,max}} \) are measured at the first point of the geometry line and the second one respectively.

Multi-linear

The Multi-linear option can be used to take into account inhomogeneous or multiple soil layers with different properties and, as a result, different resistances. The skin resistance, \( T_{\text{max}} \), is defined in a table at different
positions along the pile, $L$, where $L$ is measured from the pile top ($L=0$) to the bottom of the pile ($L=L_{pile}$). Using this approach the total pile bearing capacity, $N_{pile}$, is given by:

$$N_{pile} = F_{max} + \sum_{i=1}^{n-1} \frac{1}{2} (L_{i+1} - L_i)(T_i + T_{i+1})$$

Eq. [65]

where $i$ is the row number in the table and $n$ is the total number of rows.

For rock bolts, the bearing capacity is defined as follows:

$$N_{rockbolt} = \sum_{i=1}^{n-1} \frac{1}{2} (L_{i+1} - L_i)(T_i + T_{i+1})$$

Eq. [66]

where $L$ is measured from the first point of the corresponding geometry line ($L=0$) to the second one ($L=L_{rockbolt}$).

Layer dependent

The Layer dependent option can be used to relate the local skin resistance to the strength properties (cohesion $c$ and friction angle $\varphi$) and the interface strength reduction factor, $R_{inter}$, as defined in the material data set of the corresponding soil or rock layers ([Interfaces tabsheet](on page 254)) in which the pile or rock bolt is located:

$$\tau_i = c_i + \sigma'_n \tan \varphi_i$$

$$c_i = R_{inter} c_{soil}$$

$$\tan \varphi_i = R_{inter} \tan \varphi_{soil}$$

Eq. [67]

where $\tau_i$ is the local shear stress resistance of the interface, $\varphi_i$ and $c_i$ are the friction angle and the cohesion of the interface, $\varphi_{soil}$ and $c_{soil}$ are the friction angle and cohesion of the correspondent soil layer, $R_{inter}$ is the strength reduction factor associated to the soil layer, $\sigma'_n = (\sigma'_2 + \sigma'_3) / 2$ is the normal stress. Using this approach the pile/rock bolt bearing capacity is based on the stress state in the soil, and thus unknown at the start of a calculation. The special interface in the embedded beam behaves similar as an interface along a wall, except that it is a line interface rather than a sheet.

Note:

In case of advanced soil material models, the calculation of $\varphi_i$ and $c_i$ is as described in [Interfaces tabsheet](on page 254). For user-defined Soil Models, $\varphi_i$ and $c_i$ are based on direct input specified by the user.

The skin resistance, $T_i$, as a force per unit of depth, is defined as:

$$T_i = 2\pi R_{eq} \tau_i$$

Eq. [68]

where $R_{eq}$ is the embedded beam’s equivalent radius.

To avoid that the skin resistance could increase to undesired high values, an overall maximum resistance $T_{max}$ (constant value along the pile/rock bolt in force per unit pile/rock bolt length) can be specified in the embedded beam material data set, which acts as an overall cut-off value.

Note:

The embedded beam-soil interaction parameters in the embedded beam material data set involve only the bearing capacity (skin resistance and base resistance). Note that the material data set does NOT include the stiffness response of the pile in the soil (or $p$-$y$ curve). The stiffness response is the result of the pile length, equivalent radius, stiffness and bearing capacity as well as the stiffness of the soil layers in which the beam is located.
6.6.3.2 Lateral resistance

**Unlimited**
The value of the lateral resistance in this case is unlimited.

**Linear**
Similar to the linear axial skin resistance the start and end value, \( T_{\text{lat,start,max}} \) and \( T_{\text{lat,end,max}} \) must be defined.

**Multi-linear**
Again similar to the multi-linear axial skin resistance a table of lateral skin resistance as a function of the distance along the beam can be specified.

![Figure 192: Available options for Lateral resistance](image)

6.6.3.3 Base resistance

The base resistance \( F_{\text{max}} \) is the maximum foot force of the embedded beam, hence the end-bearing capacity. Note that the base of the embedded beam can only sustain a compressive force and no tensile force.

6.6.4 Interface stiffness factor

The interface stiffnesses are related to the shear stiffness of the surrounding soil \( G_{\text{soil}} \) according to:
Material properties and material database

Material data sets for embedded beams

\[ R_s = ISF_{RS} \frac{G_{soil}}{L_{spacing}} \]
\[ R_N = ISF_{RN} \frac{G_{soil}}{L_{spacing}} \quad \text{Eq. [69]} \]
\[ K_F = ISF_{KF} \frac{G_{soil} R_{eq}}{L_{spacing}} \]

\[ R_s = \text{stiffness axial direction} \]
\[ R_N = \text{stiffness lateral direction} \]
\[ K_F = \text{stiffness base} \]
\[ T_{S,max} = \text{maximum force axial direction} \]
\[ F_{bot:max} = \text{maximum base resistance} \]

**Figure 193: Modelling of soil-pile interaction**

The interface stiffness factors to be defined are:
- Axial skin stiffness factor, \( ISF_{RS} \)
- Lateral stiffness factor, \( ISF_{RN} \)
- Pile base stiffness factor, \( ISF_{KF} \)

where the default values of the interface stiffness are calculated according to:

\[ ISF_{RS} = 2.5 \left( \frac{L_{spacing}}{D} \right)^{-0.75} \]
\[ ISF_{RN} = 2.5 \left( \frac{L_{spacing}}{D} \right)^{-0.75} \quad \text{Eq. [70]} \]
\[ ISF_{KF} = 25 \left( \frac{L_{spacing}}{D} \right)^{-0.75} \]

where \( D \) is diameter in the case of a circular pile or width in the case of a square pile or equivalent width in the case the case of a user-defined pile.

In the case of an embedded beam as a pile a realistic pile bearing capacity as specified can actually be reached, a zone in the soil volume elements surrounding the bottom of the pile is identified where any kind of soil plasticity is excluded (elastic zone). The size of this zone is determined by the embedded beam’s diameter \( D_{eq} \) or equivalent radius \( R_{eq} (= D_{eq}/2) \) (Figure 194 on page 298)

where

\[ D_{eq} = \sqrt{\frac{12EI}{EA}} \quad \text{Eq. [71]} \]
In addition to displacement differences and shear forces in axial direction along the pile, the pile can undergo transverse forces, $t_{\perp}$, due to lateral displacements. These transverse forces are not limited in the special interface element that connects the pile with the soil, but, in general, they are limited due to failure conditions in the surrounding soil itself. However, embedded beams are not meant to be used as laterally loaded piles and will therefore not show accurate failure loads when subjected to transverse forces.

Note that the default values of the interface stiffness factors are valid for bored piles which are loaded statically in the axial direction and behavior of the surrounding soil is modelled using the Hardening Soil model with small-strain stiffness. The phreatic level is assumed to be located at the ground surface. These values should be modified if the conditions in the model are different from the ones assumed to derive the default values.

### 6.7 Material data sets for cables

As mentioned in the chapter Modelling loads and structures Structures mode - Cables (on page 109), the material properties for this element can be entered in the material data set window under 2 tab sheets: General and Mechanical.

#### 6.7.1 General properties

Several data sets may be created to distinguish the different cables. Figure 195 (on page 299) displays the General properties tab for a Cable.
Material properties and material database

Material data sets for cables

Identification

Users may specify any identification title for a cable data set. It is advised to use a meaningful name since the data set will appear in the database tree view by its identification.

Material Model

Users can specify the elastic behaviour of the cable as "Elastic" or as "Elastoplastic".

Color

Colour can be used as a distinction tool in the model. The default color for a cable is purple.

Comments

A user may write down comments related to the material data set.

**Note:** When a elastic behaviour is selected for the cable element, different parameters become available in the Mechanical properties (on page 299) tab.

6.7.2 Mechanical properties

The required parameters for the strength and stiffness of the cables are defined in the Mechanical tabsheet of the material set as shown in Figure 196 (on page 300).
Material properties and material database
Material data sets for cables

6.7.2.1 Cross Section properties
A cable requires several geometric parameters used to calculate additional properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Unit</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( L_{spacing} )</td>
<td>m</td>
<td>Refers to the out-of-plane spacing of a cable, it must be defined in order to calculate all parameters per unit of length in the out-of-plane.</td>
</tr>
<tr>
<td>Cross section type</td>
<td></td>
<td>Either a <em>Predefined</em> or a <em>user-defined</em> type can be selected.</td>
</tr>
</tbody>
</table>
Predefined cross section type

<table>
<thead>
<tr>
<th>Predefined cross section type</th>
<th>A list of predefined types:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Solid circular beam:</strong></td>
</tr>
<tr>
<td></td>
<td>Requires to fill the <em>Diameter</em> of the cable and the Area (<em>A</em>) is calculated automatically. The cable diameter determines the size of the elastic zone in the rock around the cable in which plastic rock behaviour is excluded. It also influences the default values of the interface stiffness factors.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Circular tube:</strong></td>
</tr>
<tr>
<td></td>
<td>Requires to fill the <em>Diameter</em> and the <em>Thickmess</em> of the tube to calculate the Area (<em>A</em>) of the cable.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><em>A</em></th>
<th>The cross section area is the actual area (in the unit of length squared) perpendicular to the cable axis where the cable material is present.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>m²</strong></td>
</tr>
</tbody>
</table>

6.7.2.2 Cable Stiffness

<table>
<thead>
<tr>
<th><em>E</em></th>
<th>Axial stiffness of the cable</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>kN/m²</strong></td>
</tr>
</tbody>
</table>

6.7.2.3 Cable Strength [only for elastoplastic cable]

<table>
<thead>
<tr>
<th><em>N&lt;sub&gt;p, comp&lt;/sub&gt;</em></th>
<th>Compression limit of the cable</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>kN</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><em>N&lt;sub&gt;p, tens&lt;/sub&gt;</em></th>
<th>Tension limit of the cable</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>kN</strong></td>
</tr>
</tbody>
</table>

6.7.2.4 Bond Stiffness

<table>
<thead>
<tr>
<th><em>K&lt;sub&gt;s&lt;/sub&gt;</em></th>
<th>Stress dependent shear stiffness of the bond</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>kN/m²</strong></td>
</tr>
</tbody>
</table>

6.7.2.5 Bond Strength

The bond strength capacity is calculated by:

\[ T_{s,\text{bond,max}} = c_{\text{bond}} + \sigma_n \tan(\phi_{\text{bond}}) \times \text{perimeter} \quad \text{Eq. [72]} \]

where

\[ \sigma_n = \text{Confining stress normal to the cable axis} \]

other strength parameters are defined as follows:

<table>
<thead>
<tr>
<th>Fully bonded</th>
<th>When activated no bond failure (plasticity) takes place. Also the strength distribution is set as Uniform by default with high value stiffness and strength parameters.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>-</strong></td>
</tr>
</tbody>
</table>

If the cable is NOT fully bonded the following properties are displayed:
Material properties and material database

Material data sets for cables

a) Strength distribution set as Uniform:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c_{bond}$</td>
<td>Bond cohesive strength.</td>
<td>kN/m</td>
</tr>
<tr>
<td>$\varphi_{bond}$</td>
<td>Bond friction angle to account for the bond confining pressure dependency.</td>
<td>°</td>
</tr>
</tbody>
</table>

- **Predefined**: The failure perimeter is calculated by default based on cable diameter, assuming that failure takes place at the cable circumference.
- **User-defined**: The users need to assign a value for the failure perimeter. To define the failure parameter take into account that bond failure takes place at the interface between the reinforcement element and medium. When frictional resistance and confining pressure effects are considered, the failure perimeter is needed to calculate the surface of that interface. Two approaches are possible to define the failure perimeter:
  - **Non-grouted bolt**: For non-grouted rock bolt, failure perimeter can be taken as the perimeter of the bolt cross section.
  - **Grouted bolt and cable**: For grouted bolt and cable, PLAXIS assumes, by default, that failure takes place at grout-bolt interface, so the predefined perimeter is also the perimeter of the bolt cross section.
  However, if other bond failure mechanism is assumed, user-defined perimeter option can be used, so that users can put their own failure perimeter value. For instance, if failure at rock-grout interface is assumed, the failure perimeter can be taken as the perimeter of the drilling hole, used to install the bolt/cable.

b) Strength distribution set as Multilinear:

Instead of having a uniform value, shear strength parameters (cohesive strength, friction angle) can vary along the cable length, starting from the first point of the cable geometry line (Cable properties on page 113).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-linear shear strength</td>
<td>Predefined as 2 rows.</td>
<td>kN</td>
</tr>
</tbody>
</table>
| Failure surface perimeter | • Predefined  
 | | • User-defined                                                             | m    |
**Note:** For the safety analysis a Phi/C reduction all strength parameters as part of the cable will be reduced, including the rock bolt interaction parameters \( N_{p, \text{comp}} \), \( N_{p, \text{tens}} \), Cohesive strength, \( \phi_{\text{bond}} \). But it is possible to exclude those parameters from the reduction domain.

### 6.8 Material data sets for anchors

In addition to material data sets for soil and interfaces, the material properties and model parameters for anchors are also entered in separate material data sets. A material data set for anchors may contain the properties of node-to-node anchors as well as fixed-end anchors. In both cases the anchor is just a spring element. A data set for anchors generally represents a certain type of anchor material, and can be assigned to the corresponding (group of) anchor elements in the geometry model.

Anchors can be prestressed in a *Staged construction* calculation. In such a calculation the prestress force for a certain calculation phase can directly be given in the *Object explorer*. The prestress force is not considered to be a material property and is therefore not included in an anchor data set.

#### 6.8.1 General properties

![Anchor window](image)

*Figure 197: Anchor window*

Several data sets may be created to distinguish between different types of anchors. Figure 197 (on page 303) shows the **General** tabsheet of the **Anchor** window. The material data set is defined by:
6.8.2 Mechanical properties

The properties required for anchors can be grouped into stiffness properties and strength properties in case of elastoplastic behaviour.

6.8.2.1 Stiffness

To calculate an equivalent stiffness per unit width, the out-of-plane spacing, \( L_s \), must be entered.

**Note:** For axisymmetric problems \( L_s \) is considered in radians and not in unit width.

An anchor requires only one stiffness parameter:

| \( EA \) | Axial stiffness of a single anchor. | [kN] |

6.8.2.2 Strength

**Elastoplastic**

If the material type is selected as *Elastoplastic*, two maximum anchor forces can be entered:

| \( F_{\text{max,tens}} \) | Maximum tension force of a single anchor | [kN] |
| \( F_{\text{max,comp}} \) | Maximum compression force of a single anchor | [kN] |

The Force-displacement diagram displaying the elastoplastic behaviour of the anchors is given in Figure 198 (on page 305).
In the same way as the stiffness, the maximum anchor forces are divided by the out-of-plane spacing in order to obtain the proper maximum force in a plane strain analysis.

**Elastoplastic with residual strength**

The *Elastoplastic with residual strength* option can be used to model anchor failure or softening behaviour (e.g. buckling of struts). When this option is selected two residual anchor forces can be specified:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>$F_{\text{max,tens}}$</td>
<td>Maximum tension force of a single anchor</td>
<td>[kN]</td>
</tr>
<tr>
<td>$F_{\text{max,comp}}$</td>
<td>Maximum compression force of a single anchor</td>
<td>[kN]</td>
</tr>
<tr>
<td>$F_{\text{residual,tens}}$</td>
<td>Residual tension force of a single anchor</td>
<td>[kN]</td>
</tr>
<tr>
<td>$F_{\text{residual,comp}}$</td>
<td>Residual compression force of a single anchor</td>
<td>[kN]</td>
</tr>
</tbody>
</table>

The Force-displacement diagram displaying the elastoplastic behaviour with residual strength of the anchors is given in *Figure 198* (on page 305).
If, during a calculation, the maximum anchor force is reached, the maximum force will immediately reduce to the residual force. From that point on the anchor force will not exceed the residual force anymore. Even if the anchor force would intermediately reduce to lower values, the defined residual force will be its maximum limit.

**Note:** If the anchor has failed (in tension, compression or both) the residual force will be valid in the following calculation phases where the anchor is active. If the anchor is deactivated in a phase and reactivated in the next phase, the maximum anchor force will be restored, assuming that the anchor has been replaced by a new anchor.

**Note:** Using reduced residual strength is not recommended in *Safety* calculations.

### 6.8.3 Thermal properties [ADV]

For thermal behaviour, additional constants are specified in the *Thermal* tabsheet.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>$c$</td>
<td>Specific heat capacity of the solid material. Describes the amount of energy (heat) that can be stored in the solid material per unit of mass.</td>
<td>[kJ/t/K]</td>
</tr>
<tr>
<td>$\lambda$</td>
<td>Thermal conductivity of the solid material. Describes the rate of energy (heat) that can be transported in the solid material.</td>
<td>[kW/m/K]</td>
</tr>
<tr>
<td>$\rho$</td>
<td>Density of the solid material.</td>
<td>[t/m$^3$]</td>
</tr>
<tr>
<td>$\alpha$</td>
<td>Thermal expansion coefficient. Describes how much the material expands (or elongates) when the temperature increases. In other words, it is the (change of) strain per unit of temperature.</td>
<td>[1/K]</td>
</tr>
<tr>
<td>$A_{eff,T}$</td>
<td>Cross sectional area of the anchor considered for thermal flux.</td>
<td>[m$^2$]</td>
</tr>
</tbody>
</table>
6.9 Assigning material data sets to geometry components

After creating material data sets, the data sets must be assigned to the corresponding geometry components (soil layers and structures). This can be done in different ways, which are explained below. The methods described below are primarily meant to assign properties to the initial geometry. For details on the change of properties during calculations in the framework of staged construction (Reassigning material data sets (on page 381)).

6.9.1 Soil layers

Regarding soil data, material data sets can be assigned to individual soil layers in the boreholes. Therefore a borehole should be double-clicked to open the corresponding Modify soil layers window. In the Modify soil layers click the plus button next to the soil layer. The Material dataset window pops up, where the properties of the new material can be defined.

Materials button at the lower right hand side of the window should be clicked to open the material database. To assign a data set to a particular soil layer, select the desired data set from the material database tree view (click on the data set and hold the left hand mouse button down), drag it to the soil column in the borehole window (hold the mouse button down while moving) and drop it on the desired layer (release the mouse button). The layer should now show the corresponding material data set colour. The drag and drop procedure should be repeated until all layers have their appropriate data set. Note that material sets cannot be dragged directly from the global database tree view and must be copied to the project database first.

When multiple boreholes are used it should be noted that assigning a data set to a layer in one particular borehole will also influence the other boreholes, since all layers appear in all boreholes, except for layers with a zero thickness.

6.9.2 Structures

Regarding structures (fixed-end anchors, node-to-node anchors, embedded beam rows, plates, geogrids and interfaces), there are three different methods of assigning material data sets.

- The first method is based on an open Material sets window, showing the created material sets in the project database tree view. The desired material set can be dragged (select it and keep the left mouse button down) to the drawing area and dropped on the desired component. It can be seen from the shape of the cursor whether or not it is valid to drop the material set.
- The second method is to select the desired structure in the drawing area or the Model explorer and select the desired material set from the Set material of the right hand mouse button menu.
- The third method is to select the desired structure in the drawing area or model explorer and use the Material drop-down menu in the explorer to define the material data set.
When the geometry modelling process is complete, one can proceed with the calculations. This consists of generation of mesh and definition of the construction stages.

Generating a proper Finite Element mesh is an important intermediate step between the definitions of the geometry and the construction stages. In order to have a smooth and accurate calculation the finite element mesh has to fulfill several criteria. For the numerical stability of the calculation, the mesh should have a good quality, that is to say, the elements should be regular without being excessively long and thin. For the accuracy of the calculation, the elements should be small enough, especially in those areas where significant changes in stress or strain can be expected during the analysis. But that does not mean one should just generate an entire mesh of very small elements as this will lead to a very large calculation time. Therefore proper care should be taken to find the right balance between accuracy and calculation time while supervising on the mesh quality.

In the engineering practice, a project is divided into project phases. Similarly, a calculation process in PLAXIS 2D is also divided into calculation phases. Examples of calculation phases are the activation of a particular loading at a certain time, the simulation of a construction stage, the introduction of a consolidation period, the calculation of a safety factor, etc. Each calculation phase is generally divided into a number of calculation steps. This is necessary because the non-linear behaviour of the soil requires loadings to be applied in small proportions (called load steps). In most cases, however, it is sufficient to specify the situation that has to be reached at the end of a calculation phase. Robust and automatic procedures in PLAXIS 2D will take care of the sub-division into appropriate load steps.

The construction stages can be defined in the Flow conditions and Staged construction modes. The first calculation phase (Initial phase) is always a calculation of the initial stress field for the initial geometry configuration by means of K0 procedure, Field stress or Gravity loading. Alternatively, it may be indicated that the calculations only involve groundwater flow. After this initial phase, subsequent calculation phases may be defined by the user. In each phase, the type of calculation must be selected.

For deformation calculations distinction is made between Plastic, Consolidation, Fully coupled flow-deformation, Dynamic, Dynamic with consolidation or Safety calculation. The different types of calculations are explained in Types of analysis (on page 317).

7.1 Mesh generation - Mesh mode

When the geometry model is fully defined the geometry has to be divided into finite elements in order to perform finite element calculations. A composition of finite elements is called a mesh. The mesh is created in the Mesh mode.

The mesh should be sufficiently fine to obtain accurate numerical results. On the other hand, very fine meshes should be avoided since this will lead to excessive calculation times. The PLAXIS 2D program uses fully automatic generation of finite element meshes. The generation of the mesh is based on a robust triangulation
procedure. The mesh generation process takes into account the soil stratigraphy as well as all structural objects, loads and boundary conditions.

### 7.1.1 Elements

The basic soil elements to model soil layers and other volume clusters as described in Project properties (on page 20) are either 15-Node or 6-Node triangular elements (Figure 9 (on page 24)). The user chooses the type of element.

In addition to the soil elements, there are special elements for structural behaviour (plates, embedded beam rows, geogrids and anchors), as described in Structural elements (on page 94). The type of element for structures and interfaces is automatically taken to be compatible with the basic type of soil element.

To generate the mesh, click the Generate mesh button in the side toolbar of the Mesh mode or select the corresponding option in the Mesh menu.

The Mesh options window pops up where the general mesh properties can be defined (Figure 200 (on page 309)). The options are explained in Global settings (on page 309), Local refinement (on page 310) and Enhanced mesh refinements (EMR) (on page 311).

![Figure 200: Mesh options window](image)

The mesh is generated by clicking on the OK button in the Mesh options window. After the mesh was generated, the number of generated elements is displayed in the Session tab of the Command line.

To view the generated mesh click the View mesh button in the side toolbar.

**Note:**

### 7.1.2 Global settings

The mesh generator requires a global meshing parameter \( l_e \) which represents the target element dimension. In PLAXIS 2D this parameter is calculated from the outer geometry dimensions \((x_{min}, x_{max}, y_{min}, y_{max})\) and the Element distribution selected in the Mesh options window. The target element dimension is calculated using the Eq. [73].

\[
l_e = r_e \times 0.06 \times \sqrt{(x_{max} - x_{min})^2 + (y_{max} - y_{min})^2} \quad \text{Eq. [73]}
\]
where the Relative element size factor \((r_e)\) is derived from the Element distribution. There are five global levels. By default, the Element distribution is set to Medium but the user may select one of the other levels to make the mesh globally finer or coarser.

The predefined values of the parameter \(r_e\) (Element distribution) are:

<table>
<thead>
<tr>
<th>Element distribution</th>
<th>(r_e)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very coarse</td>
<td>2.00 (30 - 70 elements)</td>
</tr>
<tr>
<td>Coarse</td>
<td>1.33 (50 - 200 elements)</td>
</tr>
<tr>
<td>Medium</td>
<td>1.00 (90 - 350 elements)</td>
</tr>
<tr>
<td>Fine</td>
<td>0.67 (250 - 700 elements)</td>
</tr>
<tr>
<td>Very fine</td>
<td>0.50 (500 - 1250 elements)</td>
</tr>
</tbody>
</table>

Note:
Note that the Relative element size \((r_e)\) does not correspond in value to the parameter value which is displayed in the command line. The value displayed is \(r_e \times 0.06\) (Eq. [79]).

The exact number of elements depends on the shape of the geometry and optional local refinement settings. The number of elements is not influenced by the Type of elements parameter, as set in the Project properties window. Note that a mesh composed of 15-node elements gives a much finer distribution of nodes and thus much more accurate results than a similar mesh composed of an equal number of 6-node elements. On the other hand, the use of 15-node elements is more time consuming than using 6-node elements.

As an alternative to the Element distribution, the mesh can be defined using Expert settings.

<table>
<thead>
<tr>
<th>Relative element size</th>
<th>The relative element size factor ((r_e)) as defined above. The default value is 1.0 (medium).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element dimension</td>
<td>The target element dimension ((l_e)) as defined above.</td>
</tr>
<tr>
<td>Max cores to use</td>
<td>The number of cores to be used in the meshing process.</td>
</tr>
</tbody>
</table>

The user specifies either the Relative element size or the Element dimension and the other one is then generated automatically as described above.

### 7.1.3 Local refinement

In areas where large stress concentrations or large deformation gradients are expected, it is desirable to have a more accurate (finer) finite element mesh, whereas other parts of the geometry might not require a fine mesh. Such a situation often occurs when the geometry model includes edges or corners or structural objects.

Local refinement is based on a local coarseness factor that can be specified for each geometry entity. This factor gives an indication of the relative element size with respect to the target element size as determined by the
Element distribution parameter. By default, the Coarseness factor value is set to 1.0 for most geometry entities whereas this value is 0.25 for structural objects and loads. A Coarseness factor value of 0.5 reduces the element size to half the target element size. The coarseness factor can be changed by selecting the geometry entity and clicking on the Coarseness factor in the Selection explorer. Values in the range from 0.03125 to 8.0 are acceptable. Using a value larger than 1.0 coarsens the mesh locally.

To locally refine the mesh either click the Refine mesh button and select the geometry entity (line or point) where a finer mesh is required or right-click the geometry entity and select the Finer mesh option from the appearing menu.

To locally coarsen the mesh by a factor of $\sqrt{2}$ click the Coarsen mesh button and select the geometry entity (line or point) where a coarser mesh is required or right click the geometry entity and select the Finer mesh option from the appearing menu.

To reset the local refinement in a geometry entity right click it either in the drawing area or in Selection explorer and select the corresponding option from the appearing menu.

Note:

- In the Mesh mode, the colours indicating the material data sets are turned off and the whole model is shown in gray. However, refined and coarsened objects are displayed in green and yellow respectively.
- The more the object is refined, the lighter the shade of green in which it is displayed.
- The more the object is coarsened, the lighter the shade of yellow in which it is displayed.

7.1.4 Enhanced mesh refinements (EMR)

To supply a good quality mesh for every geometry which also takes into account the necessary mesh refinement around structural elements, loads and prescribed displacements, PLAXIS 2D will apply automatic mesh refinements.

These automatic refinements in terms of an implicit local element size multiplication factor will be applied in case of:

- the distance between points and/or lines is rather close, which requires a smaller element size to avoid large aspect ratios.
- an angle between geometry lines other than a multiple of 90°, to allow for more accurate stresses around geometry discontinuities. The Local element size factor will be multiplied according to Figure 201 (on page 312).
Meshing and calculation

Visualize mesh warnings

Note:
The automatic refinement considered can be turned off by unchecking the Enhanced mesh refinements option in the Mesh options window (Figure 200 (on page 309)).

7.2 Visualize mesh warnings

It is possible to visualize the problematic locations found during the meshing process in the model. This option is available in Mesh mode under Options > Visualize mesh warnings and it is enabled by default. The Visualize mesh warnings resets to its default when a new project is opened. The problematic locations are displayed with yellow indicators in the model as shown in Figure 202 (on page 313) and the warning message can be seen in the command line feedback as displayed in Figure 203 (on page 313).
7.3 Defining calculation phases

Finite element calculations can be divided into several sequential calculation phases. Each calculation phase corresponds to a particular loading or construction stage. The construction stages can be defined in the Staged construction mode. The calculation phases are listed in the Phases explorer.

7.3.1 Phases explorer

The phases defined in a project are displayed in the Phases explorer. The Phases explorer is accessible in the Calculation modes. However, it is not editable in the Mesh mode. The general layout is shown in Figure 204 (on page 314).

Note:

- Irrespective of a mesh warning, the mesh is generated.
- For simplifying the visualization, the number of warnings in the interface is limited.
Meshing and calculation
Defining calculation phases

![Phases explorer](Figure 204: Phases explorer)

**Note:**
Note that for a new project the initial phase is automatically added. It cannot be deleted. More information on the initial phase is given in Initial stress generation (on page 318).

### 7.3.1.1 Toolbar

The buttons in the toolbar enable introducing new phases, removing phases and accessing the Phases window where the settings of phases are defined.

- To introduce a new calculation phase (a child phase), select a reference phase (parent phase) in the list and click the Add phase button. A new phase is added under the parent phase.

- To insert a new calculation phase before a selected one, click the Insert phase button. The inserted phase will be the new parent phase for the phase selected before the insertion, whereas the original parent phase will become the parent phase of the inserted phase.

The user has to define the new settings for the inserted phase in a similar way as defining a new phase at the end of the phase list. The phases have the settings of the parent phase unless they are defined differently. In this case it is required that the next phase is fully redefined, since the start conditions have changed. This may also have consequences for the phases thereafter.

- To delete a calculation phase, select it and click the Delete phase button. Before deleting a phase it should be checked which of the subsequent phases refer to the phase to be deleted. The parent of the deleted phase will be automatically the new parent phase. Nevertheless, it is required that the modified phases are redefined, since the start conditions have changed.

- To define the phase settings either select the phase and click the Edit phase button or double click the phase. The Phases window pops up (Phases window (on page 316)).

- The Copy button enables copying to clipboard general information about the phase.

Besides the buttons available in the Phases explorer, the right mouse button menu can be used to modify the phases in the model (Figure 205 (on page 315)).
7.3.1.2 Calculation state indication

The calculation state of a phase is indicated by the symbol at the beginning of each line in the Phases explorer.

- The phase is to be calculated.
- The phase is not to be calculated.
- The phase was calculated. No error occurred during calculation.
- The phase was calculated but an assumption is made by the program enabling the continuation of the calculation. Information is provided in the Log info for last calculation step box in the Phases window.
- The calculation failed. Information is provided in the Log info for last calculation step box in the Phases window.
- The calculation failed, but the calculation of the child phases is still possible. Information is provided in the Log info for last calculation box in the Phases window.

7.3.1.3 Phase identification

The ID of the phases is displayed in the Phases explorer. The ID of the phase consist of the caption and the name (part inside the square brackets). The name of the phases is determined consecutively by the program and it can not be modified by the user. The user may redefine the caption part of the ID of the phase in the Phases window (General phase parameters (on page 350)).

7.3.1.4 Calculation type indication

The Calculation type, the Loading type and the Pore pressure calculation type are indicated by the corresponding icons next to the phase ID in the Phases explorer. More information is given in Types of analysis (on page 317), Loading type (on page 335) and Water pressure calculation (on page 340) respectively.
7.3.2 Order of calculation phases

The order of calculation phases is defined either by selecting the reference phase (parent phase) first and then adding a phase, or selecting the reference phase in the Start from phase drop-down menu in the Phases window. By default, the previous phase is selected as parent phase. Note that a phase that appears later in the phase list cannot be selected.

7.3.2.1 Special cases

In some special cases, the order of calculation phases is not straightforward. Examples of such cases are:

- The Initial phase may be selected more than once as reference if different loadings or loading sequences are to be considered separately for the same project.
- For a certain situation, a load is increased until failure to determine the safety margin. When continuing the construction process, the next phase should start from the previous construction stage rather than from the failure situation.
- A third example where the phase ordering is not straightforward is in calculations where safety analysis for intermediate construction stages is considered. The calculation type in this case is Safety. In general, such a phase results in a state of failure. When continuing the construction process, the next stage should start from the previous phase rather than from the results of the safety analysis. Alternatively, safety analyses for the various construction stages can be performed at the end of the calculation process. In that case, the reference phase selected in the Start from phase drop-down menu should refer to the corresponding construction stage.

7.3.3 Phases window

Each calculation involves a number of parameters that control the calculation process. These parameters are listed and can be edited in the Phases window (Calculation control parameters (on page 350)). The Phases window can be opened by double clicking a phase in the Phases explorer or clicking the Edit phase button.

There are two possible views to display information in the Phases window. The view of the phases window can be selected by clicking the icon next to the Copy button in the Phases window. The icon will change according to the selected view.

The information in the Phases window is displayed in three separate panels (Figure 206 (on page 317)). In the left panel the Phases explorer is displayed giving an overview of all the phases in the model and the relation between them. The middle panel displays information regarding the selected phase in the Model explorer. The right panel displays log info for the last calculation of the selected phase and provides space to write comments.
Types of analysis

PLAXIS 2D provides convenient default values for most calculation control parameters, but the user can change these values. A description of the calculation types and control parameters is given in the next section.

7.4 Types of analysis

The first step in a PLAXIS 2D analysis is defining a calculation type of a phase in the Calculation type drop-down menu in the Phases window. The options available are K0 procedure, Field stress and Gravity loading for the initial phase to generate the initial stress state of soil. The Flow only option can be used if only groundwater flow analysis will be performed. For deformation analysis options such as Plastic, Consolidation, Safety, Dynamic, Dynamic with consolidation and Fully coupled flow-deformation are available.
7.4.1  Initial stress generation

Many analysis problems in geotechnical engineering require the specification of a set of initial stresses. The initial stresses in a soil body are influenced by the weight of the material and the history of its formation. This stress state is usually characterised by an initial vertical effective stress \( \sigma'_{v,0} \). The initial horizontal effective stress \( \sigma'_{h,0} \) is related to the initial vertical effective stress by the coefficient of lateral earth pressure \( K_0 \) \( \sigma'_{h,0} = K_0 \cdot \sigma'_{v,0} \).

In PLAXIS 2D, initial stresses may be generated by using the \textit{K0 procedure}, the \textit{Gravity loading} or the \textit{Field stress} option. Note that these options are available in the \textit{Calculation type} drop-down menu only for the Initial phase. It is recommended to generate and inspect results from initial stresses first before defining and executing other calculation phases.

\textbf{Note:}

The \textit{K0 procedure} differs from the \textit{Gravity loading} as stress field equilibrium is not checked at the end of the initial phase. The \textit{K0 procedure} is particularly suitable in cases with a horizontal surface and with all soil layers and phreatic levels parallel to the surface. In such a case, the equilibrium is systematically satisfied (vertical stresses = gravity weight, horizontal stresses = lateral reaction forces along the model boundaries). For all other cases, the use of the \textit{K0 procedure} may lead to out-of-balance forces.

The initial stress state may involve pre-loading or overconsolidation. In particular, advanced soil models may take the effects of overconsolidation into account. This requires information about the overconsolidation ratio (OCR) or the pre-overburden pressure (POP). Such information may be provided in boreholes or in the material data set of the corresponding soil layer.

As part of the initial stress generation, the principal stress history parameter \( \sigma'_{1,\text{max}} \) is initialised. The principal stress history \( (\sigma'_{1,\text{max}}, \sigma'_{2}, \sigma'_{3}) \) is used to calculate the equivalent preconsolidation pressure \( p_{eq} \), which is used in advanced soil models to initialise a cap-type yield surface.

For more information about the calculation of \( \sigma'_{1,\text{max}} \), see \textit{Initial tabsheet} (on page 263).

7.4.1.1  K0 procedure

\textit{K0 procedure} is a special calculation method available in PLAXIS 2D to define the initial stresses for the model, taking into account the loading history of the soil. The parameters required in the initial stresses development procedures are defined in the \textit{Initial} tabsheet of material data sets for soil and interfaces (\textit{Initial tabsheet} (on page 263)).

Only one \( K_0 \) value can be specified:

\[
K_{0,x} = \frac{\sigma'_{xx}}{\sigma'_{yy}} \quad K_{0,z} = \frac{\sigma'_{zz}}{\sigma'_{yy}} = K_{0,x} \quad \text{Eq. [74]}
\]

In practice, the value of \( K_0 \) for a normally consolidated soil is often assumed to be related to the friction angle by Jaky's empirical expression:

\[
K_0 = 1 - \sin \varphi \quad \text{Eq. [75]}
\]

In an overconsolidated soil, \( K_0 \) would be expected to be larger than the value given by this expression.
For the Mohr-Coulomb model, the default value $K_0$ value is based on Jaky’s formula. For the advanced models, (Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model, Sekiguchi-Ohta model), the default value is based on the $K_{0nc}$ parameter and is also influenced by the overconsolidation ratio (OCR) or the pre-overburden pressure (POP) (see Initial tabsheet (on page 263) and the Material Models Manual):

$$K_{0,x} = K_{0nc} OCR - \frac{\nu ur}{1 - \nu ur} (OCR - 1) + \frac{K_{0nc} POP - \frac{\nu ur}{1 - \nu ur} POP}{\sigma_{yy}}$$  \hspace{1cm} Eq. [76]

Using very low or very high $K_0$ values in the $K0$ procedure may lead to stresses that violate the Mohr-Coulomb failure condition. In this case PLAXIS 2D automatically reduces the lateral stresses such that the failure condition is obeyed. Hence, these stress points are in a plastic state and indicated as plastic points. Although the corrected stress state obeys the failure condition, it may result in a stress field which is not in equilibrium. It is generally preferable to generate an initial stress field that does not contain Mohr-Coulomb plastic points.

**Note:**
The plot of plastic points may be viewed after the presentation of the initial effective stresses in the Output program by selecting the Plastic points option from the Stresses menu (see Plastic points (on page 460)).

For a cohesionless material it can easily be shown that to avoid Mohr-Coulomb plasticity, the value of $K_0$ is bound by:

$$\frac{1 - \sin \phi}{1 + \sin \phi} < K_0 < \frac{1 + \sin \phi}{1 - \sin \phi}$$  \hspace{1cm} Eq. [77]

When the $K0$ procedure is adopted, PLAXIS 2D will generate vertical stresses that are in equilibrium with the self-weight of the soil. Horizontal stresses, however, are calculated from the specified value of $K_0$. Even if the value of $K_0$ is chosen such that plasticity does not occur, the $K0$ procedure does not ensure that the complete stress field is in equilibrium, since it does not generate shear stresses. Full equilibrium is only obtained for a horizontal soil surface with any soil layers parallel to this surface and a horizontal phreatic level. Therefore, the $K0$ procedure is not recommended when dealing with non-horizontal surfaces, which require shear stresses to form an equilibrium stress field. Examples of non-horizontal surfaces, and non-horizontal weight stratifications are:

If the stress field requires only small equilibrium corrections, then these may be carried out using the $K0$ procedure followed by a Plastic nil-phase (Plastic nil-phase (on page 323)). If the stresses are substantially out of equilibrium, then the $K0$ procedure should be abandoned in favor of the Gravity loading procedure.

At the end of the $K0$ procedure, the full soil weight is activated (when $\Sigma M weight = 1.0$).

### 7.4.1.2 Field stress

**Note:**
In addition to $K0$-procedure and Gravity loading there is another method to introduce an initial stress field in the model, which is called Field stress. This option is available only for the Initial phase and can be selected as a Calculation type in the phases window.
Field stress allows for setting up a homogeneous initial stress state in the model, taking into account a rotation of principal stresses. This might be relevant for applications in deep soil or rock layers where the formation of these layers in the geological history has caused a rotation of principal stresses (shearing).

In addition to the selection of Field stress as Calculation type for the initial phase, the user needs to define the magnitude of the three principal stresses $\sigma_1$, $\sigma_2$, $\sigma_3$, as well as the orientation of the principal stress directions (Axis 1), see Figure 208 (on page 320). $\sigma_1$ and $\sigma_2$ are the in-plane principal stresses and $\sigma_3$ is the out-of-plane stress.

Note: Compression is negative.

The principal stresses do not need to be ordered; for instance, the magnitude of $\sigma_1$ can be smaller (in absolute value) than the magnitude of $\sigma_2$ and/or $\sigma_3$, contrary to the conventional definition of principal stresses, where $\sigma_1$ has always the greatest magnitude (in absolute value). Moreover, the $(x, y)$ coefficients of the orientation axis do not need to form a vector of unit length.

![Figure 208: Field stress in Model explorer](image)

Note: Note that while visualising Principal stresses in Output, the values displayed for Min and Max indicate not only the visible in-plane stresses, but also the out-of-plane stress, which is not visible.

As an alternative to the global definition of the field stress in the Model conditions, the user may define local field stress conditions in each soil polygon (cluster). To do so, in Soil mode, right click on the soil polygon. From the context menu choose Soil $n$ > Create > Create field stress. Selecting this option displays ClusterFieldStress in
the selection explorer. Here the user needs to define the magnitude of the three principal stresses $\sigma_1, \sigma_2, \sigma_3$, as well as the orientation of the principal stress directions (Axis1) for the respective cluster. This option of defining different stress states to individual clusters might be relevant for applications in rock layers with disturbance zones where the weaker material may have a different initial stress state than the rock mass outside the disturbance zone.

Note that, after applying the Field stress initial calculation the user will still need to apply nil-phase in order to solve any unbalance in the model to get the correct initial stress state.

The calculation type Field stress does not consider the increase of stresses with depth due to gravity. Therefore, the $\Sigma Mweight$ multiplier is always set to zero in the case that the initial stress state is generated using the Field stress option. Still, nonzero unit weights may be defined in material data sets that are used in the soil/rock clusters. A proper unit weight may be required in order to generate the right mass and inertia in the case of dynamics calculations. Note that calculation phases that follow after a Field stress calculation should also have $\Sigma Mweight = 0$ in order to prevent a sudden unbalance from occurring.

Besides the input of field stresses, all model boundaries need to be fully fixed. Therefore, the user must manually set all global model boundaries ($BoundaryXMin$, $BoundaryXMax$, $BoundaryYMin$, $BoundaryYMax$, ) to Fully fixed in the Deformations section of the Model explorer. Note that the Field stress option may generate shear stresses, which cannot be supported by the default boundary conditions; this is why the model boundaries must be fixed.

The result of a field stress calculation is a stress state according to the predefined principal stresses and the orientation of the first principal stress direction according to the Axis1 parameter (Figure 209 (on page 321)). This stress state is not only generated in volume elements, but a corresponding stress state is also generated in interface elements, if applicable. Note that the Field stress option does not affect structural elements, and it will not take into account external loads and boundary conditions, just as the K0-procedure. Hence, structural elements and external loads should be inactive in the Initial phase.

Figure 209: Initial stress generation using Field stress calculation
7.4.1.3 Gravity loading

Gravity loading is a type of Plastic calculation (Plastic calculation (on page 323)), in which initial stresses are generated based on the volumetric weight of the soil. If Gravity loading is adopted, then the initial stresses are set up by applying the soil self-weight in the first calculation phase. This is achieved by setting $\Sigma \text{Mweight} = 1.0$. In this case, when using an elastic perfectly-plastic soil model such as the Mohr-Coulomb model, the ratio of horizontal effective stress over vertical effective stress, $K_0$, depends strongly on the assumed values of Poisson’s ratio. It is important to choose values of Poisson’s ratio that give realistic values of $K_0$. If necessary, separate material data sets may be used with Poisson’s ratio adjusted to provide the proper $K_0$-value during gravity loading. These sets may be changed by other material sets in subsequent calculations (Reassigning material data sets (on page 381)). For one-dimensional compression an elastic computation will give:

$$K_0 = \frac{\nu}{1 - \nu} \quad \text{Eq. [78]}$$

If a value of $K_0$ of 0.5 is required, for example, then it is necessary to specify a value of Poisson’s ratio of 0.333. As Poisson’s ratio must be lower than 0.5, it is not straightforward to generate $K_0$ values larger than 1 using Gravity loading. If $K_0$ values larger than 1 are desired, it is necessary to simulate the loading history and use different Poisson’s ratios for loading and unloading or use the $K_0$ procedure.

When advanced soil models are used, the resulting $K_0$-value after gravity loading corresponds to the $K_{0nc}$ parameter in the material data set.

**Note:**
- To make sure that Gravity loading results in initial effective stresses in situations where undrained materials are used, the parameter Ignore undrained behaviour should be selected.
- Once the initial stresses have been set up using Gravity loading, the displacements should be reset to zero at the start of the next calculation phase. This removes the effect of the initial stress generation procedure on the displacements developed during subsequent calculations, whereas the stresses remain.
- The OCR and POP parameters are ignored in Gravity loading.

In some cases plastic points will be generated during the Gravity loading procedure. For cohesionless soils in one-dimensional compression, for example, plastic Mohr-Coulomb points will be generated unless the following inequality is satisfied:

$$\frac{1 - \sin \phi}{1 + \sin \phi} < \frac{\nu}{1 - \nu} < 1 \quad \text{Eq. [79]}$$

7.4.1.4 Results of initial stress generation

After the generation of initial stresses the plot of the initial effective stresses can be inspected (Accessing the Output program (on page 416)). It is also useful to view the plot of plastic points.

Using $K_0$ values that differ substantially from unity may sometimes lead to an initial stress state that violates the Mohr-Coulomb criterion. If the plot of the plastic points shows many red plastic points (Mohr-Coulomb points), the value of $K_0$ should be chosen closer to 1.0.

If there are a small number of plastic points, it is advisable to perform a plastic nil-phase. When using the Hardening Soil model and defining a normally consolidated initial stress state ($OCR = 1.0$ and $POP = 0.0$), the plot
of plastic points shows many hardening points. Users need not be concerned about these plastic points as they just indicate a normally consolidated stress state.

7.4.1.5 Flow only [ULT]

This option allows pure groundwater flow calculations under saturated and unsaturated conditions. This option can only be selected for the Initial phase. Note that selection of this option effects the following phases as well. The calculation type for the following phases will be automatically set to Flow only. The Calculation type option is grayed out indicating that no change is possible. Note that it is not possible to define Flow only phases if the Calculation type of the initial phase is not specified as such.

When the Flow only option is selected for the initial phase only the Steady state groundwater flow option is available for Pore pressure calculation type.

7.4.1.6 Plastic nil-phase

If the K0 procedure generates an initial stress field that is not in equilibrium or where Mohr-Coulomb plastic points occur, then a plastic nil-phase should be adopted. A plastic nil-phase is a plastic calculation phase in which no additional load is applied (Plastic nil-phase (on page 332)). After this phase has been completed, the stress field will be in equilibrium and all stresses will obey the failure condition.

If the initial K0 procedure generates a stress field that is far from equilibrium, then the plastic nil-phase may fail to converge. This happens, for example, when the K0 procedure is applied to problems with very steep slopes. For these problems, the Gravity loading procedure should be adopted.

It is important to ensure that displacements calculated during a plastic nil-phase (if it is applied immediately after generating the initial stresses) do not affect later calculations. This is achieved by selecting the Reset displacements to zero parameter in the subsequent calculation phase (Deformation control parameters (on page 352)).

7.4.2 Plastic calculation

A Plastic calculation is used to carry out an elastic-plastic deformation analysis in which it is not necessary to take the change of pore pressure with time into account. If the Updated mesh parameter has not been selected, the calculation is performed according to the small deformation theory. The stiffness matrix in a normal plastic calculation is based on the original undeformed geometry. This type of calculation is appropriate in most practical geotechnical applications.

Although a time interval can be specified, a plastic calculation does not take time effects into account, except when the Soft Soil Creep model is used (see Material Models Manual). Considering the quick loading of saturated clay-type soils, a Plastic calculation may be used for the limiting case of fully undrained behaviour using the Undrained (A), Undrained (B) or Undrained (C) option in the material data sets. On the other hand, performing a fully drained analysis can assess the settlements on the long term. This will give a reasonably accurate prediction of the final situation, although the precise loading history is not followed and the process of consolidation is not dealt with explicitly.
An elastic-plastic deformation analysis where undrained behaviour (Undrained (A) or Undrained (B)) is temporarily ignored can be defined by checking the Ignore undr. behaviour (A, B) parameter. In this case the stiffness of water is not taken into account.

Note that Ignore undrained behaviour does not affect materials of which the drainage type is set to Undrained (C).

When changing the geometry configuration (Geometry configuration - Staged Construction mode (on page 379)) it is also possible (for each calculation phase) to redefine the water boundary conditions and recalculate the pore pressures (Flow conditions (on page 370)). For more details on theoretical formulations of a plastic calculation reference should be made to the Scientific Manual.

In a Plastic calculation loading can be defined in the sense of changing the load combination, stress state, weight, strength or stiffness of elements, activated by changing the load and geometry configuration or pore pressure distribution by means of Staged construction. In this case, the total load level that is to be reached at the end of the calculation phase is defined by specifying a new geometry and load configuration, and/or pore pressure distribution, in the Staged construction mode (Geometry configuration - Staged Construction mode (on page 379)).

The options for Pore pressure calculation type for a Plastic phase are:

- Phreatic
- Use pressures form previous phase
- Steady state groundwater flow

More information on Pore pressure calculation type is given in Water pressure calculation (on page 340).

### 7.4.3 Consolidation calculation [ADV]

A Consolidation calculation is usually conducted when it is necessary to analyse the development and dissipation of excess pore pressures in a saturated clay-type soil as a function of time. PLAXIS 2D allows for true elastic-plastic consolidation analysis. In general, consolidation analysis without additional loading is performed after an undrained plastic calculation. It is also possible to apply loads during a consolidation analysis. However, take care when a failure situation is approached, since the iteration process may not converge in such a situation.

A consolidation analysis requires additional boundary conditions on excess pore pressures (Flow conditions (on page 370)).

**Note:**

- In PLAXIS 2D, pore pressures are divided into steady-state pore pressures and excess pore pressures. Steady state pore pressures are generated according to the water conditions assigned to the soil layers for each phase, whereas excess pore pressures are calculated as a result of undrained soil behaviour (Undrained (A) or Undrained (B)) or consolidation. A Consolidation calculation in PLAXIS 2D only affects the excess pore pressures.
- Rather than considering the drainage type settings Drained, Undrained (A) or Undrained (B), a Consolidation calculation considers the corresponding permeabilities as defined in the Groundwater tab of the material data set instead.
- A Consolidation calculation does not affect Undrained (C) materials since such materials do not allow (excess) pore pressures to be generated.
In a **Consolidation** analysis, the following options are available:

- Consolidation and simultaneous loading in the sense of changing the load combination, stress state, weight, strength or stiffness of elements, activated by changing the load and geometry configuration by means of **Staged construction**. It is necessary to specify a value for the **Time interval** parameter, which has in this case the meaning of the total consolidation period applied in the current calculation phase. The load is linearly increased to the specified level within the time interval. The applied first time increment is based on the **First time step** parameter in the **Numerical control parameters** subtree. The **Staged construction** option should also be selected if it is desired to allow for a certain consolidation period without additional loading.

- Consolidation without additional loading, until all excess pore pressures have decreased below a certain minimum value, specified by the **Minimum excess pore pressures** parameter. By default, the **Minimum excess pore pressures** parameter is set to 1 stress unit, but this value may be changed by the user. Please note that the **Minimum excess pore pressures** parameter is an absolute value, which applies to pressure as well as tensile stress. The input of a **Time interval** is not applicable in this case, since it cannot be determined beforehand how much time is needed to fulfill the minimum excess pore pressure requirement. The applied first time increment is based on the **First time step** parameter in the **Numerical control parameters** subtree.

- Consolidation without additional loading, until a desired degree of consolidation, specified by the **Degree of consolidation** parameter, is reached. By default, **Degree of consolidation** parameter is set to 90.0 %, but this value may be changed by the user. Please note that the **Degree of consolidation** parameter is not applicable in this case, since it cannot be determined beforehand how much time is needed to fulfill the degree of consolidation requirement. The applied first time increment is based on the **First time step** parameter in the **Numerical control parameters** subtree.

**Note:**

Although the degree-of-consolidation is officially defined in terms of target settlement over final settlement, in PLAXIS 2D it is defined as the target minimum excess pore pressure over the maximum initial excess pore pressure $p_{\text{max}}/p_{\text{max,initial}}$.

### 7.4.4 Fully coupled flow-deformation analysis [ULT]

A **Fully coupled flow-deformation** analysis is conducted when it is necessary to analyse the simultaneous development of deformations and pore pressures in saturated and partially saturated soils as a result of time-dependent changes of the hydraulic boundary conditions. Examples where a fully coupled flow-deformation analysis may be required include draw down of the reservoir level behind a dam, embankment dams subjected to tidal waves and partially drained excavation and dewatering of a building site. In contrast to a consolidation analysis, which primarily affects the excess pore pressures, a fully coupled flow-deformation analysis directly operates on the total pore water pressures, i.e. the sum of steady-state and excess pore pressures. Still, in order to be consistent with other calculation types, steady-state pore pressures are calculated based on the hydraulic conditions at the end of the calculation phase, which enables the back-calculation of excess pore pressures from the total pore water pressures.

A fully coupled flow-deformation analysis takes into account unsaturated soil behaviour and suction in the unsaturated zone above the phreatic level. This is the most advanced and realistic type of analysis that considers a reduced permeability and degree of saturation in unsaturated zone. For this reason, the **Ignore suction** option is not available in **Fully coupled flow-deformation** analysis.
When fully coupled flow - deformation analysis is combined with temperature calculation, a fully coupled Thermo - Hydro - Mechanical (THM) analysis is obtained. More detailed explanation, refer section Coupled analysis [ULT] (on page 343).

**Note:**
It is not possible to use *Updated mesh* in a fully coupled flow-deformation analysis.

### 7.4.5 Safety calculation (phi/c reduction)

The *Safety* calculation type is an option available in PLAXIS 2D to compute global safety factors. This option can be selected as a separate *Calculation type* in the *General* tab sheet.

In the *Safety* approach the shear strength parameters \(\tan \varphi\) and \(c\) of the soil as well as the tensile strength are successively reduced until failure of the structure occurs. The dilatancy angle \(\psi\) is, in principle, not affected by the phi/c reduction procedure. However, the dilatancy angle can never be larger than the friction angle. When the friction angle \(\varphi\) has reduced so much that it becomes equal to the (given) dilatancy angle, any further reduction of the friction angle will lead to the same reduction of the dilatancy angle. The strength of interfaces, if used, is reduced in the same way. Optionally, the strength of structural objects like plates and anchors can also be reduced in a *Safety* calculation (Enhanced safety analysis (on page 328)).

The total multiplier \(\Sigma MSf\) is used to define the value of the soil strength parameters at a given stage in the analysis:

\[
\Sigma MSf = \frac{\tan \varphi_{input}}{\tan \varphi_{reduced}} = \frac{c_{input}}{c_{reduced}} = \frac{s_{u,input}}{s_{u,reduced}} = \frac{\text{Tensile strength}_{input}}{\text{Tensile strength}_{reduced}} \quad \text{Eq. [80]}
\]

where the strength parameters with the subscript 'input' refer to the properties entered in the material sets and parameters with the subscript 'reduced' refer to the reduced values used in the analysis. \(\Sigma MSf\) is set to 1.0 at the start of a calculation to set all material strengths to their input values.

A *Safety* calculation is performed using the Load advancement number of steps procedure (Load advancement - Number of steps (on page 348)). The incremental multiplier \(MSf\) is used to specify the increment of the strength reduction of the first calculation step. This increment is by default set to 0.1, which is generally found to be a good starting value. The strength parameters are successively reduced automatically until all Additional steps have been performed. By default, the number of steps is set to 100, but a larger value up to 10000 may be given here, if necessary. It must always be checked whether the final step has resulted in a fully developed failure mechanism. If that is the case, the factor of safety is given by:

\[
SF = \frac{\text{available strength}}{\text{strength at failure}} = \text{value of } \Sigma MSf \text{ at failure} \quad \text{Eq. [81]}
\]

The principal results of a *Safety* calculation are the failure mechanism and the corresponding \(\Sigma MSf\), which is the safety factor. The \(\Sigma MSf\)-value of a particular calculation step can be found in the *Calculation information* window displayed as the corresponding option is selected in the Project menu of the Output program. It is also recommended to view the development of \(\Sigma MSf\) for the whole calculation using the *Curves* option (Curves (on page 474)). In this way it can be checked whether a constant value is obtained while the deformation is continuing; in other words: whether a failure mechanism has fully developed. If a failure mechanism has not fully developed, then the calculation must be repeated with a larger number of steps.
Meshing and calculation

Types of analysis

Note:
The numerical parameters defined in the Numerical control parameters subtree are not supposed to have significant influence on the principal results of the Safety calculation. However, in Safety calculations involving safety factors close to 1, other outputs (e.g. internal forces of the structures) could be sensitive to the numerical parameters, especially to the Desired min number of iterations and the Desired max number of iterations.

To capture the failure of the structure accurately, the use of Arc-length control parameter is required. The use of a Tolerated error of no more than 1% is also required. Both requirements are complied with when using the default iteration parameters (Numerical control parameters (on page 356)).

Note:
• When performing Safety calculation without Arc-length control, the reduction factor $\Sigma M_{sf}$ cannot go down and an overestimation of safety factor can occur.
• To capture the failure of the structure accurately, a sufficiently fine mesh is required.

When using Safety calculation in combination with advanced soil models, these models will actually behave as a standard Mohr-Coulomb model, since stress-dependent stiffness behaviour and hardening effects are excluded from the analysis. In that case, the stiffness is calculated at the beginning of the calculation phase based on the starting stresses and kept constant until the calculation phase is complete.

Note:
• In case of the Jointed Rock model the strength on all the planes will be reduced by $\Sigma M_{sf}$.
• In the case of the NGI-ADP model and UDCAM-S model, all undrained strength parameters are reduced by $\Sigma M_{sf}$.
• Strength in the Modified Cam-Clay model and Sekiguchi-Ohta model is not reduced in Safety analysis.
• When using the Modified Cam-Clay model and Sekiguchi-Ohta model, the strength is not reduced at all since these models do not have a cohesion or friction angle as model parameter. In other the reduction of the parameter values need to be explicitly defined in their code.

The strength reduction method, as adopted in a Safety calculation, gives similar safety factors as obtained from conventional stability analysis based on the Limit Equilibrium Method (LEM) slip-circle analysis. For a more detailed description of the strength reduction method (formerly called phi-c reduction) you are referred to Brinkgreve & Bakker (1991) (on page 586).

Note:
A more realistic value of the safety factor will be obtained for a Fully coupled flow-deformation analysis when suction is considered. This value is generally higher than a conventional safety factor ignoring suction. Therefore, be careful when interpreting this value.

Note:
In general, it is not recommended to perform a Safety analysis in combination with structural elements in which a residual strength is used. During a safety analysis in which structural elements are present in the model, there is a redistribution of the stresses and forces, generally leading to an increase in structural forces. When the strength of a structure is reached, and the structure has a residual strength lower than the normal strength, the structural force will reduce to the residual strength. This may lead to an unstable situation and, as a result, an unrealistic reduction of the factor of safety.
In a *Safety* calculation the following options are available:

- A *Safety* analysis is performed by reducing the strength parameters incrementally. The default increment of the strength reduction of the first calculation step, $M_{sf}$ is 0.1 but this value may be changed by the user.
- A *Safety* analysis is performed by reducing the strength parameters until a target value of the total multiplier $\Sigma M_{sf}$ is reached. The program will first try to find a safe value (above the target value) then it will return to the last step before passing the target and will do a last step to reach the target.

### 7.4.5.1 Enhanced safety analysis

For a *Safety* calculation, all soil clusters and interfaces are taken into account automatically. *Enhanced safety analysis* makes it possible to apply strength reduction to soil clusters as well as structures. Moreover, *Enhanced safety analysis* enables to exclude particular soil clusters or structures from the strength reduction procedure.

Safety calculations are controlled by the multiplier for strength reduction, $\Sigma M_{sf}$. The purposes for the *Enhanced safety* can be the following:

- Surficial soil clusters along a slope can be excluded from the strength reduction procedure to avoid unrealistic shallow failure mechanisms.
- Along with the soil clusters, all structures can be selected for strength reduction, provided these structures behave as elasto-plastic and have a limit strength.
- Enhanced safety analysis can be performed for a deliberate manual selection of certain soil clusters or structures for different phases.

![Figure 210: Enhanced safety for soil clusters](image)

![Figure 211: Enhanced safety for structures](image)
Note:
Regarding structures, note that strength reduction can be applied only to Elastoplastic structures. Make sure that realistic mechanisms are not prevented in this way.

Soil clusters that have been excluded from the strength reduction procedure are indicated in grey in the Connectivity plot, provided that the Hide items without strength reduction in the View menu has been selected (Connectivity plot (on page 444)). Moreover, if this option has been selected, results are not shown in these clusters.

Note:
By performing a standard Safety calculation, unrealistic surficial mechanisms can be detected. An Enhanced safety calculation can be performed by de-selecting the surficial clusters.

7.4.5.2 Strength factorization in the Hoek-Brown model

When using the Hoek-Brown model to describe the behaviour of a rock section, the Safety calculation procedure is slightly modified, since the failure contour is not described by the Mohr-Coulomb criterion anymore. In order to have an equivalent definition of a safety factor as for the Mohr-Coulomb model, the Hoek-Brown yield function is reformulated to include the strength reduction factor $\Sigma M_{sf}$ for safety analyses:

$$f_{HB} = \sigma_1' - \sigma_3' + \bar{f}_{red}(\sigma_3')$$  Eq. [82]

with

$$\bar{f}_{red} = \frac{\bar{t}}{\eta} = \frac{\sigma_{ci}}{\eta} \left( m_b \frac{-\sigma_3'}{\sigma_{ci}} + s \right)^{a}$$  Eq. [83]

and

$$\eta = \frac{1}{2} (\Sigma M_{sf} (2 - \bar{t}')) \sqrt{1 + \frac{\left( \frac{1}{\Sigma M_{sf}^{2}} - 1 \right) \bar{t}'^{2}}{(2 - \bar{t}')^{2} + \bar{t}'^{2}}}$$  Eq. [84]

where

$$\bar{t}' = \frac{\partial \bar{f}}{\partial \sigma_3'} = -am_b \left( m_b \frac{-\sigma_3'}{\sigma_{ci}} + s \right)^{a-1}$$  Eq. [85]

More details and a derivation of the above equations can be found in Benz, Schwab, Vermeer & Kauther (2007) (on page 586).

Note:
Note that the safety factor obtained for Hoek-Brown material does not correspond to the safety factor obtained for Mohr-Coulomb material with equivalent strength properties.

7.4.5.3 Updated mesh

The geometry of the model considered in a Safety calculation depends on whether the Updated mesh option is selected or not. If Updated mesh is selected, the resulting safety factor will be from the deformed (updated) mesh.
Please note that during a safety calculation the mesh is not updated at the beginning of each load step even if the
updated mesh option is selected for the safety phase. Hence, the updated mesh mesh option in a safety analysis
only determines whether it starts from an updated mesh or not.

7.4.6 Dynamics calculation [ULT]

The dynamics option should be selected when it is necessary to consider stress waves and vibrations in the
soil. Dynamic loads can come in various types such as machine induced loads, impact loads, blast load, or as
earthquake loads. With PLAXIS 2D it is possible to perform a dynamics analysis for these types of loads after a
series of plastic calculations. It is possible to apply dynamic loads through displacement multipliers or load
multipliers. They can be defined as harmonic or as input table. The applied dynamic load is the product of the
input value of the defined dynamic load and the corresponding dynamic load multiplier. Besides the activation of
the dynamic load or dynamic prescribed displacement, special absorbent boundary conditions can be defined for
a dynamics calculation. For a more detailed description of the boundary conditions, see Model conditions (on
page 383). A Dynamics time interval can be defined to specify the calculation duration and an automatic time
stepping scheme (see Automatic time stepping (Dynamics) [ULT] (on page 349)) takes care of the best
combination of Max steps and Number of sub-steps, based on the estimated time steps.

7.4.6.1 Free vibration analysis

The possible vibrations of a system that occur when an existing static load is released can be analysed by
performing a free vibration analysis. A free vibration analysis can be performed in a dynamics calculation which
can be used to determine the natural frequencies of a soil block or structure. To perform a free vibration analysis
initially a plastic analysis is conducted with prescribed loads or displacements. This is followed by a dynamics
phase in which the active static external load in the previous calculation phase is released (deactivated). Natural
frequencies can be estimated by means of a power spectral density plot generated through output.

7.4.6.2 Earthquake Analysis

This section provides an overview of the Geotechnical earthquake modelling and analysis capabilities of PLAXIS.
A variety of nonlinear native and UDSM models for earthquake analysis are offered in PLAXIS. In general, all
native models offered in PLAXIS can be used in combination with Dynamics analysis. However, the user is
expected to know the limitations of each of the models being used. Here are some models which are often used
in combination with Seismic analysis. HSsmall and its UDSM version GHS can simulate strain dependency of
stiffness and hysteretic damping. UBC3D-PLM (native) and PM4Sand (UDSM) are liquefaction models available
in PLAXIS for which the parameters can be estimated from SPT or CPT data in the absence of lab tests.
Processing and modification of input accelerograms are a key component of earthquake analysis. Options are
available in the dynamics multiplier tab (Input accelerograms (on page 87)) to scale the signal to the required
PGA. Furthermore, the input accelerograms can be easily transformed and visualized as Fourier amplitude
spectrum, Power spectrum, PSA as well as Arias Intensity. A drift correction to correct the displacement drift
due to instrument noise or background noise can also be applied automatically during a dynamics calculation.
Special boundary conditions (Model conditions (on page 383)) are required for earthquake motion in order to
minimize wave reflection at model boundaries. The compliant base boundary condition for the bottom boundary
ensures that reflected waves from layers above are absorbed and allows direct application of an input (upward
propagating) accelerogram. Free field boundary conditions for lateral boundaries impose free-field motion at the
sides, additionally it absorbs the reflected secondary waves. Tied degrees of freedom connects the nodes on the
same elevation at left and right boundaries, which can be used to simulate one-dimensional wave propagation.
Energy dissipation due to vibrational or cyclic loading can be defined through Damping. PLAXIS offers both hysteretic and viscous material damping, as well as numerical damping. Hysteretic damping is inherent to the HS model, whereas, Rayleigh damping is a numerical feature to simulate viscous material damping, which can be applied in each individual material data set. Numerical damping can be imposed by changing the default Newmark alpha and beta parameters (Dynamics control parameters [ULT] on page 368). Dynamics calculations can be conducted as drained, undrained or as Dynamics with consolidation. Automatic time stepping (Automatic time stepping (Dynamics) [ULT] on page 349) scheme allows for a proper selection of the time step to accurately model wave propagation and reduce the numerical error due to integration of time history functions. The user can also control the number of steps using the semi-automatic or Manual option for accurate modelling.

Curves in Dynamics calculations [ULT] (on page 480) explains output curves generation options for dynamics analysis. It is possible to transform the generated curves from the time domain to the frequency domain automatically using Fast Fourier Transform (FFT). From FFT, Power Spectrum and Fourier Amplitude Spectrum (FAS) can be plotted for each acceleration component. From output curves it is possible to produce PSA spectrum to determine the predominant period as well as Relative displacement response spectrum, Amplification factor that displays the magnification of the response at a point with respect to the given excitation, and Arias intensity to determine the strength of a ground motion. Furthermore, plots can be generated for extreme accelerations, velocities and displacements for dynamics phases.

**Note:**

- Note that steady-state pore pressures in a Dynamics calculation are always taken from the steady-state pore pressures generated in the parent phase (see Calculation type (on page 340)).
- It is possible to calculate excess pore pressures in undrained soil layers in a dynamics analysis. However, the accuracy at which pore pressures are predicted depends on the capabilities of the soil models being used.
- A standard dynamics calculation may involve the generation of excess pore pressures, but not the dissipation of excess pore pressures. If the latter is required, a Dynamics with consolidation calculation should be performed.

### 7.4.6.3 Site response analysis

Wave propagation in the ground due to an earthquake can be analysed by means of a site response analysis. This can be performed in a Dynamic calculation on a narrow soil column using tied degrees-of-freedom and the earthquake signal applied at the base.

### 7.4.6.4 Updated mesh

During a dynamics calculation, large deformation effects and changes of the geometry can be taken into account by selecting the Updated mesh option. See Updated mesh analysis (on page 333) for more information about Updated mesh calculations.

In a Dynamics calculation loading can be defined in the sense of applying a predefined combination of external loads as dynamic forces using dynamics multipliers activated in the Staged construction mode.
### 7.4.7  Dynamics with consolidation calculation [ULT]

The Dynamics with consolidation option should be selected when the dynamic generation and subsequent dissipation of excess pore pressures in a short time domain is to be considered. This calculation type is based on the mixed $u$-$P$ formulation (where $u$ is displacement and $P$ is excess pore pressure and can be used when partially drained soil conditions are present during a dynamics calculation. The applied dynamic load is the product of the input value of the defined dynamic load and the corresponding dynamic load multiplier.

**Note:**

A Dynamics with consolidation calculation requires the input of soil permeabilities and appropriate flow boundary conditions.

Besides the activation of the dynamic load or dynamic prescribed displacement, absorbent (viscous) boundary conditions can be defined for a Dynamics with consolidation calculation. For a more detailed description of the boundary conditions see Model conditions (on page 383).

In a Dynamics with consolidation calculation loading can be defined in the sense of applying a predefined combination of external loads as dynamic forces using dynamics multipliers activated in the Staged construction mode.

### 7.4.8  Plastic nil-phase

A plastic calculation may also be used to carry out a so-called plastic nil-phase. A plastic nil-phase is a plastic calculation phase in which no additional loading is applied. Each new phase introduced in the Phases explorer is initially a plastic nil-phase, until the calculation type, geometry or load configuration is changed. It may sometimes be required to solve large out-of-balance forces and to restore equilibrium. Such a situation can occur after a calculation phase in which large loadings were activated (for example gravity loading) or if the $K_0$ procedure generates an initial stress field that is not in equilibrium or where plastic points occur. After this phase has been completed, the stress field will be in equilibrium and all stresses will obey the failure condition. In this case no changes should be made to the geometry configuration or to the water conditions. If necessary, such a calculation can be performed with a reduced Tolerated error to increase the accuracy of the equilibrium stress field.

If the original $K_0$ procedure generates a stress field that is far from equilibrium, then the plastic nil-phase may fail to converge. This happens, for example, when the $K_0$ procedure is applied to problems with very steep slopes. For these problems the Gravity loading procedure should be adopted instead.

It is important to ensure that displacements calculated during a plastic nil-phase (if it is applied immediately after generating the initial stresses) do not affect later calculations. This may be achieved by using the Reset displacements to zero option in the subsequent calculation phase (Deformation control parameters (on page 352)).

The Staged construction loading type is used to perform a plastic nil-phase to solve existing out-of-balance forces. No changes in the geometry, load level, load configuration and water pressure distribution should be made.
7.4.9 Updated mesh analysis

In conventional finite element analysis, the influence of the geometry change of the mesh on the equilibrium conditions is neglected. This is usually a good approximation when the deformations are relatively small as is the case for most engineering structures. However, there are circumstances under which it is necessary to take this influence into account. Typical applications where updated mesh analyses may be necessary include the analysis of reinforced soil structures, the analysis of large offshore footing collapse problems and the study of problems where soils are soft and large deformations occur.

Note:
By default the Updated mesh option in Phases window is unchecked.

When large deformation theory is included in a finite element program some special features need to be considered. Firstly it is necessary to include additional terms in the structure stiffness matrix to model the effects of large structural distortions on the finite element equations.

Secondly, it is necessary to include a procedure to model correctly the stress changes that occur when finite material rotations occur. This particular feature of large displacement theory is usually dealt with by adopting a definition of stress rate that includes rotation rate terms. Several stress rate definitions have been proposed by researchers working in this field although none of these are wholly satisfactory. In PLAXIS 2D the co-rotational rate of Kirchhoff stress (otherwise known as the Hill stress rate) is adopted. This stress rate would be expected to give accurate results provided that the shear strains do not become excessive.

Thirdly, it is necessary to update the finite element mesh as the calculation proceeds. This is done automatically within PLAXIS 2D when the Updated mesh option is selected.

It should be clear from the descriptions given above that the updated mesh procedures used in PLAXIS 2D involve considerably more than simply updating nodal coordinates as the calculation proceeds. These calculation procedures are in fact based on an approach known as an Updated Lagrangian formulation (Bathe, 1982 on page 586). Implementation of this formulation within PLAXIS 2D is based on the use of various advanced techniques that are beyond the scope of this manual. More details can be found in (van Langen, 1991 on page 588).

The three basic types of calculations (Plastic, Consolidation and Safety) can optionally be performed as an Updated mesh analysis, taking into account the effects of large deformations. Therefore, the Updated mesh parameter should be selected. It can also be selected whether water pressures should be continuously recalculated according to the updated position of the stress points. This option is termed Updated water pressures and is meant to take into account the effects of soil settling (partly) below a constant phreatic level. The Updated mesh option cannot be used in a fully coupled flow-deformation analysis.

Please note that an updated mesh calculation cannot be followed by a 'normal' calculation. Reversely, a normal calculation can be followed by an updated mesh calculation, provided that the option Reset displacements to zero is used (Deformation control parameters on page 352).

It should be noted that an updated mesh analysis takes more time and is less robust than a normal calculation. Hence, this option should only when really necessary.
7.4.9.1 Distributed loads
Distributed loads on deformed boundaries are taken into account as if those boundaries were not deformed. This is to ensure that the total force involved does not change when the boundary stretches or shrinks. This also applies to axisymmetric applications where the radius changes as a result of deformation.

7.4.9.2 Calculation procedures
In order to carry out an updated mesh analysis the Updated mesh checkbox in the Deformation control parameters subtree in the Phases window should be selected (Deformation control parameters (on page 352)).

Updated mesh calculations are carried out using iteration procedures similar to the conventional calculation options as described in preceding sections. Therefore an updated mesh analysis uses the same parameters. However, because of the large deformation effect, the stiffness matrix is always updated at the beginning of a load step. Due to this procedure and to the additional terms and more complex formulations, the iterative procedure in an updated mesh analysis is considerably slower than that for conventional calculations.

7.4.9.3 Safety calculations
The geometry of the model considered in a Safety calculation depends on whether the Updated mesh option is selected or not in the parent phase. If the mesh is updated, the resulting geometry at the end of the parent phase will be considered in the safety calculations.

During a safety calculation the mesh is not further updated at the beginning of each load step even if the Updated mesh option is selected for the Safety phase.

7.4.9.4 Practical considerations
Updated mesh analysis tends to require more computer time than an equivalent, conventional calculation. It is recommended, therefore, that when a new project is under study a conventional calculation is carried out before an updated mesh analysis is attempted.

It is not possible to give simple guidelines that may be used to indicate when an updated mesh analysis is necessary and where a conventional analysis is sufficient. One simple approach would be to inspect the deformed mesh at the end of a conventional calculation using the Deformed mesh option in the Output program. If the geometry changes are large (on a real scale) then significant importance of geometric effects might be suspected. In this case the calculation should be repeated using the updated mesh option. It cannot definitely be decided from the general magnitudes of the deformations obtained from a conventional plasticity calculation whether geometric effects are important or not. If the user is in any doubt about whether updated mesh analysis is necessary then the issue can only be resolved by carrying out the updated mesh analysis and comparing the results with the equivalent conventional analysis.

In general, it is not appropriate to use an updated mesh calculation for gravity loading to set up the initial stress field. Displacements resulting from gravity loading are physically meaningless and should therefore be reset to zero. Resetting displacements to zero is not possible after an updated mesh analysis. Hence, gravity loading should be applied in a normal plastic calculation.

Changing from a 'normal' plastic calculation or consolidation analysis to an updated mesh analysis is only valid when displacements are reset to zero, because a series of updated mesh analyses must start from an undeformed geometry. Changing from an updated mesh calculation to a 'normal' plastic calculation or
consolidation analysis is not valid, because then all large deformation effects will be disregarded, resulting in a large force unbalance.

7.4.9.5  Updated water pressures

When the *Updated water pressures* option is selected in the *Deformation control parameters* subtree in the *Phases* window, pore pressures in stress points and external water pressures at model boundaries are updated during the calculation according to the deformed model boundaries and the displaced position of stress points. Basis for the update of water pressures is the general phreatic level and the cluster phreatic levels. In this way, the buoyancy effect of soil that is submerged below the phreatic level is taken into account.

Note that the pore pressures in clusters that have user-defined pore pressures are not updated. Also, pore pressures that are calculated from groundwater flow calculations are not updated.

7.5  Loading type

The loading type is specified in the *Loading input* drop-down menu in the *Phases* window. Only one of the described loading types can be activated in any single calculation phase. The available loading types depend on the selected type of calculation.

**Note:**

Note that the *Loading type* drop-down menu is NOT available for *Flow only* calculation type.

7.5.1  Staged construction

The *Staged construction* loading type enables the user to specify a new state that is to be reached at the end of the calculation phase. The water pressure distribution, the geometry, the input values of loads and the load configuration in the *Flow conditions* and *Staged construction* mode can be modified. The *Staged construction* option may also be used to perform plastic nil-phases to solve existing out-of-balance forces. In this case, no changes in the geometry, load level, load configuration and water pressure distribution should be made.

Before specifying the construction stage, the *Time interval* of the calculation phase should be considered. The *Time interval* is expressed in the unit of time. A non-zero value is only relevant in the case of a *Consolidation* analysis, a *Fully coupled flow-deformation* analysis or if a time-dependent soil model (such as *Soft Soil Creep model*) is used.

Since staged construction is performed using the *Load advancement ultimate level* procedure (*Load advancement - Ultimate level* (on page 347)), it is controlled by a total multiplier (*ΣMstage*). This multiplier starts at zero and is expected to reach the ultimate level of 1.0 at the end of the calculation phase. Note that the maximum number of additional steps as defined by the *Max steps* parameter will not be reached if *ΣMstage* criterion is met before.

In some special situations, however, it might be necessary to split the staged construction process into more than one calculation phase and to specify an intermediate value of *ΣMstage*. This can be done by assigning a value lower than 1.0 to the *ΣMstage* parameter in the *General* subtree in the *Phases* window which is only available for a *Plastic* calculation. However, care must be taken with an ultimate level smaller than 1.0, since this
is associated with a resulting out-of-balance force. Such calculations must always be followed by another staged construction calculation. Without specifying a value for $\Sigma M_{\text{stage}}$, the program always assumes an ultimate level of $\Sigma M_{\text{stage}} = 1.0$. Before starting any other type of calculation the $\Sigma M_{\text{stage}}$ parameter must first have reached the value 1.0. This can be verified in the Reached values subtree in the Phases window (Reached values (on page 369)).

### 7.5.1.1 Staged construction with $\Sigma M_{\text{stage}} < 1$

In general, the total multiplier associated with the staged construction process, $\Sigma M_{\text{stage}}$, goes from zero to unity in each calculation phase where staged construction has been selected as the loading input. In some very special situations it may be useful to perform only a part of a construction stage. This can be done by specifying a value lower than 1.0 to the $\Sigma M_{\text{stage}}$.

### 7.5.1.2 Unfinished staged construction calculation

At the start of a staged construction calculation, the multiplier that controls the staged construction process, that is to say $\Sigma M_{\text{stage}}$, is zero and this multiplier is stepwise increased to the ultimate level (generally 1.0). When $\Sigma M_{\text{stage}}$ has reached the ultimate level, the current phase is finished. However, if a staged construction calculation has not properly finished, i.e. the multiplier $\Sigma M_{\text{stage}}$ is less than the desired ultimate level at the end of a staged construction analysis, then a warning appears in the Log info box. The reached value of the $\Sigma M_{\text{stage}}$ multiplier may be viewed in the Reached values subtree in the Phases window.

There are three possible reasons for an unfinished construction stage:

- An ultimate value of $\Sigma M_{\text{stage}}$ less than 1.0 is specified by the user. Note that the out-of-balance force is still partly unresolved. The remain out-of-balance forces must be solved in the next calculation phase.
- Failure of the soil body has occurred during the calculation. This means that it is not possible to finish the construction stage. Note that the out-of-balance force is still partly unsolved so that further calculations starting from the last calculation phase are meaningless.
- The maximum number of loading steps was insufficient. In this case the construction stage should be continued by performing another staged construction calculation that is directly started without changing the geometry configuration or water pressures. Alternatively, the phase may be recalculated using a larger number of Max steps. Note that it is advised against applying any other type of loading as long as the $\Sigma M_{\text{stage}}$ has not reached the value 1.0.

In the case of an unfinished staged construction calculation, the load that has actually been applied differs from the defined load configuration. The reached value of the $\Sigma M_{\text{stage}}$ multiplier may be used in the following way to estimate the load that has actually been applied:

$$f_{\text{applied}} = f_0 + \Sigma M_{\text{stage}}(f_{\text{defined}} - f_0) \quad \text{Eq. [86]}$$

where $f_{\text{applied}}$ is the load that has actually been applied, $f_0$ is the load at the beginning of the calculation phase (i.e. the load that has been reached at the end of the previous calculation phase) and $f_{\text{defined}}$ is the defined load configuration.

A reduced ultimate level of $\Sigma M_{\text{stage}}$ may be reduced repetitively. In the case of multiple subsequent phases with $\Sigma M_{\text{stage}} < 1$, it should be realised that $\Sigma M_{\text{stage}}$ starts at 0 in every phase. For example, if three phases are defined, where in phase 1 $\Sigma M_{\text{stage}} = 0.5$; in phase 2 $\Sigma M_{\text{stage}} = 0.5$ and phase 3 $\Sigma M_{\text{stage}} = 1.0$ (without additional changes), it means that:

- At the end of phase 1: 50% of the unbalance is solved.
- At the end of phase 2: 50% of the remaining unbalance (= 75% of the initial unbalance) is solved.
7.5.1.3 Deconfinement

In PLAXIS 2D it is possible to simulate the construction process of tunnels with a sprayed concrete lining (NATM). The major point in such an analysis is to account for the three-dimensional arching effect that occurs within the soil and the deformations that occur around the unsupported tunnel face. A method that takes these effects into account is described below.

There are various methods described in the literature for the analysis of tunnels constructed according to the New Austrian Tunnelling Method. One of these is the so-called Convergence confinement method or β-method ([Schikora & Fink, 1982](#)) but others have presented similar methods under different names. The idea is that the initial stresses $p_k$ acting around the location where the tunnel is to be constructed are divided into a part $(1 - \beta) p_k$ that is applied to the unsupported tunnel and a part $\beta p_k$ that is applied to the supported tunnel ([Figure 213](#)). The β-value is an 'experience value', which, among other things, depends on the ratio of the unsupported tunnel length and the equivalent tunnel diameter. Suggestions for this value can be found in literature ([Schikora & Fink, 1982](#)).

In PLAXIS 2D it is possible to enter a Deconfinement value during staged construction as $1 - \beta$ in the model explorer ([Figure 212](#)). This value is then taken into account during the calculation phases in Staged construction. The value of deconfinement is entered in percentage.

The way this works in PLAXIS 2D is that part of the stresses ($\beta$) in the soil cluster inside the tunnel are retained as a support pressure, while the cluster is de-activated. In subsequent phases, this support pressure can be further reduced (more deconfinement) until it is eventually zero ($\beta=0$ or 100% deconfinement).

![Selection explorer](#)

*Figure 212: Deconfinement option in Selection explorer*
The process is summarised below:

1. Generate the initial stress field and apply eventual external loads that are present before the tunnel is constructed.
2. De-activate the tunnel clusters without activation of the tunnel lining and apply a Deconfinement value of 1 - β. The value entered is in percentage.
3. Activate the tunnel lining to the soil clusters inside the tunnel and check that Deconfinement of the soil clusters inside the tunnel is set to 100%.

**Note:** The deconfinement value applies to change of effective stress only and is not affecting change of pore pressure that could result from modifying the water conditions or a groundwater flow analysis. So in that sense the deconfinement level method clearly differs from $\Sigma M_{\text{stage}} < 1$ method which applies to change of total stress and equally affects both changes of effective stress and pore pressure.

Deconfinement can be defined per soil cluster. That means that different clusters may have different levels of deconfinement. In the case of a single tunnel with different excavation sections, each excavation section may have a different level of deconfinement. In the case of multiple tunnels, each tunnel (or excavation section) may have a different level of deconfinement. Instead of only one intermediate level of deconfinement, the excavation process may involve different levels of deconfinement, divided over multiple calculation phases.

### 7.5.2 Minimum excess pore pressure [ADV]

The Minimum excess pore pressure option in the Loading input drop-down menu is a criterion for terminating a consolidation analysis. The calculation stops when the maximum absolute excess pore pressure is below the prescribed value of $|P_{\text{stop}}|$. Note that the maximum number of steps as defined by the $Max$ steps parameter will not be reached if the $|P_{\text{stop}}|$ criterion is met before. For example, when the maximum excess pore pressure has reached a certain value during the application of load, the user can make sure that the consolidation process is continued until all nodal values of excess pore pressure are less than $|P_{\text{stop}}|$, provided the value of $Max$ steps is sufficient.

**Note:**

The Minimum excess pore pressure loading type is available only for Consolidation calculations.
7.5.3  Degree of consolidation [ADV]

The option Degree of consolidation is an alternative criterion for terminating a consolidation analysis. The calculation stops when the degree of consolidation, as defines herein, is below the value of Degree of consolidation. The degree of consolidation is an important indication of the consolidation state. Strictly, the degree of consolidation, \( U \), is defined in terms of the proportion of the final settlement although the term is often used to describe the proportion of pore pressures that have dissipated to at least \((100-U)\%\) of their values immediately after loading. The Degree of consolidation option may be used to specify the final degree of consolidation in any analysis.

In this case the Minimum excess pore pressure parameter (see above) is set to a value as defined by the maximum excess pore pressure in the previous phase and the defined Degree of consolidation \( U \):

\[
\text{Minimum pore pressure} = (100 - U) P_{\text{max}} \quad \text{Eq. [87]}
\]

where \( P_{\text{max}} \) is the maximum excess pore pressure reached in the previous phase which can be found in the Reached values subtree in the Phases window (Reached values (on page 369)). The calculation stops when the maximum absolute excess pore pressure is below this calculated value of Minimum excess pore pressure. Note that the maximum number of steps as defined by the parameter Max steps will not be reached if the Minimum excess pore pressure criterion is met before.

**Note:**
The Degree of consolidation loading type is available only for Consolidation calculations.

7.5.4  Target \( \Sigma Msf \)

Reduction of the soil and interface strength towards a target value of the total multiplier \( \Sigma Msf \). The program first performs a full safety analysis until failure (Incremental multipliers (on page 339)) and then it recalculates the last step before the target value of \( \Sigma Msf \) in order to reach the target exactly.

**Note:**
The Target \( \Sigma Msf \) loading type is available only for Safety calculations.

7.5.5  Incremental multipliers

The Incremental multipliers loading type enables the user to perform a Safety analysis using the Load advancement number of steps procedure (Incremental multipliers (on page 339)). The incremental multiplier \( Msf \) is used to specify the increment of the strength reduction of the first calculation step. This increment is by default set to 0.1, which is generally found to be a good starting value. The strength parameters are successively reduced automatically until the value assigned to the Max number of steps parameter has been reached. By default, the maximum number of steps is set to 100, but a larger value up to 1000 may be given here, if
necessary. It must always be checked whether the final step has resulted in a fully developed failure mechanism. If that is the case, the factor of safety is given by:

$$ SF = \frac{\text{available strength}}{\text{strength at failure}} = \text{value of } \Sigma \text{Msf} \text{ at failure} \quad \text{ Eq. [88]} $$

The $\Sigma \text{Msf}$-value of a particular calculation step can be found in the Calculation Information window of the Output program. It is also recommended to view the development of $\Sigma \text{Msf}$ for the whole calculation using the Curves option (Curves (on page 474)). In this way it can be checked whether a constant value is obtained while the deformation is continuing; in other words: whether a failure mechanism has fully developed. If a failure mechanism has not fully developed, then the calculation must be repeated with a larger number of steps.

**Note:**

The Incremental multipliers loading type is only available for Safety calculations.

### 7.6 Water pressure calculation

Water pressure can be 'external' water pressure (i.e. 'water load' on model boundaries) or 'internal' water pressure, which is known as pore water pressure. Pore water pressure is included in what is denoted in PLAXIS 2D as active pore pressure. Active pore pressure is composed of steady-state pore pressure and excess pore pressure, and may also include suction (positive pore water stress). In general, the steady-state component of water pressure (both the 'external' and 'internal' part) is considered to be input data and supposed to be known at the beginning of a deformation analysis, whereas excess pore pressure is the result of undrained loading or consolidation. This section deals with the calculation of steady-state water pressure as input for a deformation analysis, which can be generated according to the options available in the Phases window.

#### 7.6.1 Calculation type

##### 7.6.1.1 Phreatic

The steady-state water pressure calculation by Phreatic is based on the input of a Global water level (Global water level (on page 342)) and the water conditions of the clusters (Defining water conditions (on page 53)). This generation is quick and straightforward. The following quantities are calculated as input for a deformation analysis:

- 'External' water pressures (i.e. 'water loads') on external model boundaries are calculated on the basis of the Global water level.
- Steady-state pore pressures in active clusters are calculated on the basis of the water conditions as defined for the corresponding clusters. If it is desired to exclude pore pressures from certain clusters, the Dry option should be used (Assigning water conditions to soil polygons (on page 373)) or the cluster should be Non-porous (General tabsheet (on page 172)).
- Steady-state pore pressures in inactive clusters are calculated on the basis of the water conditions as defined for the corresponding clusters, which forms the basis for the calculation of 'external' water pressures on boundaries between active and inactive clusters.
Steady-state pore pressure may include suction in the unsaturated zone above the phreatic surface. If it is desired to exclude suction from the steady-state pore pressure as input for a deformations analysis, the option *Ignore suction* may be used.

### 7.6.1.2 Groundwater flow (steady-state) [ADV]

The steady-state water pressure calculation by *Steady state groundwater flow* is based on the input of hydraulic boundary conditions ([Hydraulic conditions [ADV]](on page 140)) and *Water pressure generation and previewing* (on page 375)). It also requires the input of a non-zero permeability, in the material datasets for soil and interfaces. This generation is more time-consuming and the result is not always straightforward. The following quantities are calculated and are considered as input for a deformation analysis:

- The global water level. The 'internal' part of the global water level, is calculated as the level where the steady-state pore pressure is zero, whereas the 'external' part (if applicable) is calculated from the groundwater heads that are higher than the external model boundaries.
- 'External' water pressure (i.e. 'water load') on external model boundaries is calculated on the basis of the Global water level.
- Steady-state pore pressures in active clusters are calculated on the basis of the groundwater flow calculation. If it is desired to exclude pore pressures from certain clusters, the *Dry* option should be used ([Assigning water conditions to soil polygons](on page 373)) or the cluster should be *Non-porous* ([General tabsheet](on page 172)).
- Steady-state pore pressures in inactive clusters are interpolated (or extrapolated) on the basis of the water pressures at the boundaries between active and inactive clusters, as obtained from the groundwater flow calculation. These pressures also form the basis for the calculation of the ‘external’ water pressure on such boundaries.
- If the *Global water level* is used to define the hydraulic boundary conditions (groundwater head), the global water level will be replaced by the results of the groundwater flow calculation. In general, this will result in the same 'external' part of the global water level, but the 'internal (phreatic)' part will most likely change.

**Note:**

- If no groundwater flow boundary conditions are defined, the hydraulic boundary conditions for a steady-state groundwater flow calculation are taken from the *Global water level*, which means a prescribed hydraulic head below the water level and seepage above.
- The *Steady state groundwater flow* option is available for *K0 procedure*, *Gravity loading*, *Flow only*, *Plastic* and *Consolidation* calculation types.

Steady-state pore pressure may include suction in the unsaturated zone above the phreatic surface. If it is desired to exclude suction from the steady-state pore pressure, as input for a deformations analysis, the option *Ignore suction* may be used.

### 7.6.1.3 Groundwater flow (transient) [ULT]

This option is available if it is intended to perform ONLY groundwater flow calculations, to be indicated by selecting *Flow only* for the *Calculation type*. A transient groundwater flow calculation is based on the input of (time-dependent) hydraulic boundary conditions ([Groundwater flow boundary conditions](on page 143)) and water levels ([Water levels](on page 371)). A transient groundwater flow calculation requires a non-zero time interval. Moreover, it requires the input of a non-zero permeability in the material datasets for soils and interfaces and the selection of an appropriate flow model to describe the behaviour in the unsaturated zone ([Groundwater tabsheet](on page 236)).
Note:

Note that the Flow only option is available only for the initial phase. When this option is selected for the initial phase, it will be automatically assigned for the following (child) phases as well and it will be grayed out, indicating that no change is possible.

7.6.1.4 Use pressures from previous phase

If the steady-state water pressure does not change compared to its parent phase, the option Use pressures from previous phase can be used to indicate that the calculation kernel should use the water pressures of the previous step (phase) as input for the current deformation analysis. This option should NOT be used if clusters change from active to inactive or vice versa. In that case the water pressures need to be generated using one of the other options.

7.6.2 Global water level

The Global water level can be used to generate a simple hydrostatic pore pressure distribution (Phreatic calculation type) for the full geometry. The global water level is by default assigned to all clusters in the geometry.

The Global water level can also be used to create boundary conditions for the groundwater head in the case that pore pressures are calculated on the basis of a Groundwater flow calculation or Fully coupled flow-deformation analysis.

The Global water level for a selected phase can be specified in the Water subtree under the Model conditions in the Model explorer. The drop-down menu displays the available water levels in the model (Borehole water levels or User water levels). More information on water levels is given in Water levels (on page 371).

7.7 Temperature calculation [ADV]

In case temperature (or actually a change in temperature) is of influence on the behaviour of soils or structures (for example thermal expansion or soil freezing), PLAXIS 2D offers the possibility to take thermal effects into account. The calculation of a temperature distribution in the ground is based on thermal calculations. Defining whether and how the temperature distribution should be calculated can be done by means of the Thermal calculation type field in the General section of the Phases window.

Note:

Note that the Loading type drop-down menu is NOT available for Flow only calculation type.

7.7.1 Calculation type
7.7.1.1 Ignore temperature

In the *Ignore temperature* option, no temperature distribution is calculated and the temperature effects are ignored.

7.7.1.2 Earth gradient

In this option, the (initial) temperature is calculated on the basis of the *ThermalFlow* parameters as defined in the *Model conditions* subtree of the *Model explorer* (Model explorer (on page 39)). This is NOT a finite element calculation.

7.7.1.3 Use temperatures from previous phase

In this option, the (initial) temperature distribution in the current phase is assumed to be equal to the temperature distribution (at the end) of the parent phase. This option can be used to indicate that the calculation kernel should use the temperature distribution of the previous step (phase) as input for the current deformation analysis. This option should NOT be used if clusters change from active to inactive or vice versa. In that case the temperature needs to be generated using one of the other options.

**Note:**

In the case the *Calculation type* is set to *Fully coupled flow-deformation* analysis, this option must be selected in order to take temperature effects into account. In this case, the temperature from the previous phase is only used to initialize the temperature at the beginning of the current phase, but it may still change during the phase as a result of a time-dependent change in thermal flow boundary conditions.

7.7.1.4 Steady state thermal flow

The temperature distribution is calculated by means of a steady-state thermal flow finite element calculation. A steady-state thermal flow calculation is based on the input of *Thermal flow boundary conditions* (Thermal conditions [ADV] (on page 155)). It also requires appropriate thermal model parameters to be entered in the *Thermal* tabsheet of the *Materials* window (Thermal tabsheet [ADV] (on page 249)).

7.7.1.5 Transient thermal flow [ULT]

The temperature distribution is calculated by means of a transient thermal flow finite element calculation. A transient thermal flow calculation is based on the input of *Thermal flow boundary conditions* (Thermal conditions [ADV] (on page 155)). It also requires appropriate thermal model parameters to be entered in the *Thermal* tabsheet of the *Materials* window (Thermal tabsheet [ADV] (on page 249)) and a non zero time interval.
Since groundwater flow plays an essential role in the transport of heat in the ground, thermal calculations can be coupled with groundwater flow calculations (thermo-hydraulic (TH) coupling). This requires appropriate values for the thermal constants as defined in the Project properties window. Moreover, results of coupled steady-state TH calculations may be used to analyse the effects of (changes of) temperature on stress and deformation (semi-coupled TH-M analysis). More generally, PLAXIS 2D allows for fully coupled transient thermo-hydraulic-mechanical (THM) calculations of problems in which the time-dependent effect of changes of temperature on stress, deformation and groundwater flow are to be taken into account simultaneously. Table 16 (on page 344) gives an overview of all possible combinations of thermal calculations and to what extent the three processes (T, H and M) are coupled.

Table 16: Overview of combinations for thermal calculations

<table>
<thead>
<tr>
<th>Calculation type</th>
<th>Pore pressure calculation type</th>
<th>Thermal calculation type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow only</td>
<td>Phreatic</td>
<td>Earth gradient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steady-state thermal flow</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transient thermal flow</td>
</tr>
<tr>
<td>Flow only</td>
<td>Steady-state groundwater flow</td>
<td>Earth gradient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steady-state thermal flow</td>
</tr>
<tr>
<td>Plastic</td>
<td>Phreatic</td>
<td>Earth gradient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use temperatures from previous phase</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steady-state thermal flow</td>
</tr>
<tr>
<td>Plastic</td>
<td>Use pressures from previous phase</td>
<td>Earth gradient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use temperatures from previous phase</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steady-state thermal flow</td>
</tr>
<tr>
<td>Plastic</td>
<td>Steady-state groundwater flow</td>
<td>Earth gradient</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use temperatures from previous phase</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steady-state thermal flow</td>
</tr>
<tr>
<td>Consolidation</td>
<td>Various</td>
<td>N/A</td>
</tr>
<tr>
<td>Fully coupled flow-deformation</td>
<td>Transient groundwater flow (automatic)</td>
<td>Use temperatures from previous phase</td>
</tr>
<tr>
<td>Safety</td>
<td>Use pressures from previous phase</td>
<td>Use temperatures from previous phase</td>
</tr>
</tbody>
</table>
7.7.3 Non-linearity during Phase-changes [ADV]

The heat transfer behaviour becomes highly nonlinear when phase change (freezing/thawing) occurs. This is due to the latent heat effect, wherein a lot of energy must be added (or extracted) to change the phase of the material. This high non-linearity may create numerical instability, leading to divergence or very low convergence of the solution when using traditional iterative schemes such as Newton-Raphson or modified Newton-Raphson methods.

PLAXIS 2D addresses this non-linearity using several techniques. Firstly, a Trapezoidal Recursive Algorithm is used to compute the non-linear energy needed for phase change. Secondly, a Line Search algorithm is implemented to detect the optimally corrected solution increment after each iteration automatically. This helps to limit the instability of the solution and thereby speed up convergence and avoid divergence due to the non-linearity.

However, for highly non-linear problems, the line search algorithm may not ensure fast convergence. To achieve convergence, modifications can be made to the numerical parameters defined in the Numerical control parameters subtree. The default values of desired min number of iterations and desired max number of iterations can be increased (for instance to 20 and 60 iterations respectively), and the Max number of iterations should be increased accordingly (to 120 for example).

7.8 Load stepping procedures

When soil plasticity is involved in a finite element calculation the equations become non-linear, which means that the problem needs to be solved in a series of calculation steps. An important part of the non-linear solution procedure is the choice of step size and the solution algorithm to be used.

During each calculation step, the equilibrium errors in the solution are successively reduced using a series of iterations. The iteration procedure is based on an accelerated initial stress method. If the calculation step is of a suitable size then the number of iterations required for equilibrium will be relatively small, usually around ten.

If the step size is too small, then many steps are required to reach the desired load level and computing time will be excessive. On the other hand, if the step size is too large then the number of iterations required for equilibrium may become excessive or the solution procedure may even diverge.

PLAXIS 2D has an automatic load stepping procedure for the solution of non-linear plasticity problems. The following procedures are available: Load advancement ultimate level, Load advancement number of steps and Automatic time stepping. Users do not need to worry about the proper selection of these procedures, since PLAXIS 2D will automatically use the most appropriate procedure by itself to guarantee optimum performance. The parameters for the load stepping procedures are available in the Numerical control parameters subtree in the Phases window (Figure 214 (on page 346)).
The automatic load stepping procedure is controlled by a number of calculation control parameters (Numerical control parameters (on page 356)). There is a convenient default setting for most control parameters, which strikes a balance between robustness, accuracy and efficiency. For each calculation phase, the user can influence the automatic solution procedures by manually adjusting the control parameters in the Numerical control parameters subtree in the Phases window.

In this way it is possible to have a stricter control over step sizes and accuracy. Before proceeding to the description of the calculation control parameters, a detailed description is given of the solution procedures themselves.

### 7.8.1 Automatic step size procedure

For each calculation phase the user specifies the new state or the total load that is to be applied at the end of this phase. The calculation program will compare the new situation (at the end of this phase) with the previous situation (at the end of the phase where it starts from) and will solve the difference during the current calculation phase by applying multiple load steps. In fact, the program will try to reach equilibrium for the new situation in the final load step of the current phase.

The size of the first load step in a calculation phase is automatically determined by performing trial calculations, taking into account the Tolerated error (Numerical control parameters (on page 356)). When a new load step is
applied (first step or later steps), a series of iterations is carried out to reach equilibrium. There are three possible outcomes of this particular process. These outcomes are:

**Case 1:** The solution reaches equilibrium within a number of iterations that is less than the Desired minimum control parameter. By default, the Desired minimum number of iterations is 6, but this value may be changed in the Numerical control parameters subtree in the Phases window (Numerical control parameters (on page 356)). If fewer iterations than the desired minimum are required to reach the equilibrium state then the calculation step is assumed to be too small. In this case, the size of the load increment is multiplied by two and further iterations are applied to reach equilibrium.

**Case 2:** The solution fails to converge within a Desired maximum number of iterations. By default, the Desired maximum number of iterations is 15, but this value may be changed in the Numerical control parameters subtree in the Phases window (Numerical control parameters (on page 356)). If the solution fails to converge within the desired maximum number of iterations then the calculation step is assumed to be too large. In this case, the size of the load increment is reduced by a factor of two and the iteration procedure is continued.

**Case 3:** The number of required iterations lies between the Desired minimum number of iterations and the Desired maximum number of iterations in which case the size of the load increment is assumed to be satisfactory.

After the iterations are complete, the next calculation step begins. The initial size of this calculation step is made equal to the size of the previous successful step.

If the outcome corresponds to either case 1 or case 2 then the process of increasing or reducing the step size continues until case 3 is achieved.

### 7.8.2 Load advancement - Ultimate level

This automatic step size procedure is used for calculation phases where a certain 'state' or load level (the 'ultimate state' or 'ultimate level') has to be reached, as in the case for a Plastic calculation where a construction stage is defined. The procedure terminates the calculation when the specified state or load level is reached or when soil failure is detected. By default, the Max steps parameter is set to 1000, but this parameter does not play an important role, since in most cases the calculation stops before the maximum number of steps is reached.

An important property of this calculation procedure is that the user specifies the state or the values of the total load that is to be applied. The size of the first load step is obtained automatically using one of the two following methods:

- PLAXIS 2D performs a trial calculation step and determines a suitable step size on the basis of this trial.
- PLAXIS 2D sets the initial load step size to be equal to the final load step size of any previous calculation.

The first method is generally adopted. The second method would only be used if the loading applied during the current load step is similar to that applied during the previous load step, for example if the number of load steps applied in the previous calculation proved to be insufficient.

In subsequent steps, the automatic load stepping procedures are adopted (Automatic step size procedure (on page 346)). If at the end of the calculation, the defined state or load level has been reached, the calculation is considered to be successful. A successful calculation is indicated by a check mark in a green circle in the Phases explorer and the Phases window.

If the defined state or load level has NOT been reached, the calculation is considered to have failed. A failed calculation is indicated by a cross mark in a red circle in the Phases explorer or the Phases window. A message describing the error is given in the Log info for the last calculation box in the Phases window:

**Prescribed ultimate state not reached; Soil body collapses:** A collapse load has been reached. In this case, the total specified load has not been applied. Collapse is assumed when the applied load reduces in magnitude in X
successive calculation steps (where X is the maximum number of unloading steps; see Numerical control parameters (on page 356)) and the current stiffness parameter CSP is less than 0.015 (see Automatic error checks (on page 401) for the definition of CSP). It is also possible that the problem is failing but due to switched-off arc-length control, the program is not allowed to take negative step sizes. The user should check the output of the last step and judge whether the project is failing or not. In case of failure, recalculating the project with a higher Max steps parameter is useless.

Prescribed ultimate state not reached; load advancement procedure fails. Try manual control: The load advancement procedure is unable to further increase the applied load, but the current stiffness parameter CSP is larger than 0.015. In this case the total load specified has not been applied. The user can now attempt to rerun the calculation with slight changes to the iterative parameters in Numerical control parameters subtree in the Phases window, in particular turning off the Arc-length control type parameter.

Prescribed ultimate state not reached; Not enough load steps: The maximum specified number of load steps have been applied. In this case, it is likely that the calculation stops before the total specified load has been applied. It is advised to recalculate the phase with an increased value of Max steps or to add a similar subsequent calculation phase in which no changes in geometry configuration or water pressures are defined.

Cancelled by user: This occurs when the calculation process is terminated by clicking Stop in the Active tasks window.

Prescribed ultimate state not reached; Numerical error: A numerical error has occurred. In this case, the total specified load has not been applied. There may be different causes for a numerical error. Most likely, it is related to an input error. Careful inspection of the input data, the finite element mesh and the defined calculation phase is suggested.

Severe divergence: This is detected when the global error is increasing and has reached huge values. This error, for example, can be caused by very small time steps in a consolidation phase. The program scales down the step size when the tolerated error cannot be reached, resulting in small time steps. One of the reasons can be that a failure situation is reached. As for consolidation the arc-length procedure is not used, the program cannot really detect failure.

File xxxx not found: Such a message appears when a file that ought to exist does not exist.

Messages may indicate errors related to the iterative solution algorithm or the matrix condition. In the case of 'floating' elements (insufficient boundary conditions), one could get a message indicating that the matrix is nearly singular. Checking and improving the defined calculation phase usually solves the problem.

Note:

A list of warning and error messages appearing in PLAXIS 2D is available in Calculation warning and errors in PLAXIS (on page 662).

7.8.3 Load advancement - Number of steps

This automatic step size procedure always performs the number of steps specified in Max steps and is, in general, used for calculation phases where a complete failure mechanism should be developed during the analysis. This algorithm is therefore used in Safety analysis.

The size of the first step is determined by the incremental multiplier as defined for the particular calculation phase. For Safety calculations the Loading type parameter is Incremental multipliers and the default increment is $M_s f = 0.1$. This value may be changed in the General subtree of the Phases window. In subsequent steps, the automatic load stepping procedures are adopted (Automatic step size procedure (on page 346)).
If at the end of the calculation the value assigned to the Max steps parameter has been reached, the calculation is considered to be successful. A successful calculation is indicated by a tick mark in a green circle in the Phases explorer or the Phases window.

If the value assigned to the Max steps parameter has NOT been reached, the calculation is considered to have failed. A failed calculation is indicated by a cross mark in a red circle in the Phases explorer or the Phases window. A message describing the error is given in the Log info for last calculation box in the Phases window.

**Cancelled by user:** This occurs when the calculation process is terminated by clicking Stop in the Active tasks window.

Apart from cancellation by the user, a load advancement calculation will proceed until the number of steps defined in the Max steps parameter have been applied. In contrast to the Ultimate level procedure the calculation will not stop when failure is reached.

**Note:** A list of warning and error messages appearing in PLAXIS 2D is available in Appendix H.

### 7.8.4 Automatic time stepping (consolidation [ADV] and fully coupled analysis [ULT])

**Note:** For analysis involving consolidation an [ADV] licence level is required. For fully coupled analysis an [ULT] licence is necessary.

When the Calculation type is set to Consolidation, the Automatic time stepping procedure is used. This procedure will automatically choose appropriate time steps for a consolidation analysis. When the calculation runs smoothly, resulting in very few iterations per step, then the program will choose a larger time step. When the calculation uses many iterations due to an increasing amount of plasticity, then the program will take smaller time steps.

The first time step in a consolidation analysis or a fully coupled analysis is generally based on the First time step parameter. This parameter is, by default, based on the advised minimum time step (overall critical time step) as described in Numerical control parameters (on page 356). The First time step parameter can be changed in the Numerical control parameters subtree in the Phases window when the Use default iter parameters checkbox is not selected. However, be careful with time steps that are smaller than the advised minimum time step.

During a Consolidation calculation or a Fully coupled analysis, arc-length control is always inactive.

### 7.8.5 Automatic time stepping (Dynamics) [ULT]

When the Calculation type is set to Dynamics or Dynamics with consolidation, the Newmark time integration scheme is used in which the time step is constant and equal to the critical time step during the whole analysis (Scientific Manual- Bounds on the system response). The maximum recommended time step for dynamics analyses is estimated in order to accurately model wave propagation and reduce error due to integration of time history functions. First, the material properties and the element size are taken into account to estimate the time step and then the time step is adjusted based on the time history functions used in the calculation. If the Use default iteration parameters is selected, the best combination of Max steps and Number of sub-steps, based on the
estimated time step, will be calculated in the kernel. The user can always get and change these values by pressing the Retrieve button in the Phases window.

During a dynamics calculation, arc-length control is always inactive.

7.9 Calculation control parameters

The control parameters of a particular calculation phase and the corresponding solution procedure can be defined in the Phases window.

7.9.1 General phase parameters

The general properties of a phase can be defined in the General subtree in the Phases window (Figure 215 (on page 350)).

![General subtree in the Phases window](image)

Figure 215: General subtree in the Phases window

7.9.1.1 Phase identification

The ID of the phase consists of the caption and the name (in square brackets). The name of the phases is determined consecutively by the program and it can not be modified by the user. The user may redefine the caption of the phase in the Phases window.

7.9.1.2 Calculation type

The calculation type of the selected phase can be defined in the corresponding drop-down menu in the Phases window. The options available are:
Meshing and calculation
Calculation control parameters

- **K0 procedure**
- **Field stress**
- **Gravity loading**
- **Flow only**
- **Plastic**
- **Consolidation**
- **Safety**
- **Dynamic**
- **Fully coupled flow-deformation**
- **Dynamic with consolidation**

A description of the different analysis types available in PLAXIS 2D is given in [Types of analysis](on page 317).

### 7.9.1.3 Loading type

The options available for the *Loading type* parameter are:

- **Staged construction**
- **Incremental multipliers**
- **Target SumMsf**
- **Minimum excess pore pressure**
- **Degree of consolidation**

A description of the different loading types available in PLAXIS 2D is given in [Loading type](on page 335).

### 7.9.1.4 $\Sigma M_{stage}$

$\Sigma M_{stage}$ is the total multiplier that controls the staged construction process. It is associated with the reduction of the out-of-balance forces that are to be solved in a staged construction calculation. By default, its target value is 1.0. The lowest allowed input value is 0.001. If $\Sigma M_{stage}$ is lower than this value, the load is considered to be negligible and no calculations take place. A value larger than 1.0 is not possible. By entering the default value of 1.0, the staged construction procedure is performed in the normal way.

In general, care must be taken with an ultimate level of $\Sigma M_{stage}$ smaller than 1.0, since this leads to a resulting out-of-balance force at the end of the calculation phase. Such a calculation phase must always be followed by another staged construction calculation. If $\Sigma M_{stage}$ is not specified by the user, the default value of 1.0 is always adopted, even if a smaller value was entered in the previous calculation phase.
7.9.1.5  $\Sigma M_{\text{weight}}$

$\Sigma M_{\text{weight}}$ is the total multiplier for the material weight. For $\Sigma M_{\text{weight}} = 1$, the material weight as specified by the unit weights in the material data sets is applied. In general, $\Sigma M_{\text{weight}}$ remains at its default value of 1, but there are situations in which $\Sigma M_{\text{weight}}$ may be changed:

- In the case of modelling simplified soil tests by means of finite element models, self weight of the material may be disregarded since the stresses are dominated by external loads rather than material weight. This can either be achieved by using zero unit weights in the material data set or by using $\Sigma M_{\text{weight}} = 0$ during the calculations. Note that in the former case ($\gamma = 0$) the material has no mass, which has consequences for a dynamics calculation.

- In the case of overconsolidated material in situations where the $K_0$ procedure cannot be used (for example slopes), gravity loading can be used in the initial phase with an increased value of $\Sigma M_{\text{weight}}$ equal to the overconsolidation ratio. In this way, the preconsolidation stress is properly initialised, at least when using advanced soil models. In the subsequent phase, $\Sigma M_{\text{weight}}$ should be set back to 1.0 in order to have realistic initial soil stresses whilst the preconsolidation stress (in advanced models) will memorize the overconsolidated stress level.

- In the case of modelling a centrifuge test, $\Sigma M_{\text{weight}}$ may be used to simulate the increased amount of gravity. Hence, in order to simulate a centrifuge test at 100 g, $\Sigma M_{\text{weight}}$ should be set to 100.

7.9.1.6  Time interval

A non-zero value for the time-related parameters is only relevant when a transient groundwater flow calculation, a consolidation analysis, a fully coupled flow-deformation analysis or a dynamics analysis is performed or when using time-dependent material models (such as the Soft Soil Creep model).

<table>
<thead>
<tr>
<th>Time interval</th>
<th>To define the total time period considered in the current calculation phase, expressed in the unit of time as defined in the <strong>Project properties</strong> window.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic time interval</td>
<td>To define the total time period considered in the current dynamics calculation phase, expressed in seconds [s].</td>
</tr>
</tbody>
</table>

A dynamics analysis uses a different time parameter than other types of calculations. The time parameter in a dynamics analysis is the *Dynamic time*, which is always expressed in seconds [s], regardless of the unit of time as specified in the **Project properties** window. In a series of calculation phases in which some of them are dynamic, the *Dynamic time* is only increased in the dynamic phases (even non-successive), while the *Dynamic time* is kept constant in other types of calculations (whether before, in-between or after the dynamic phases).

The *Dynamic time* is not affected by the regular time parameter. Reversely, the regular time parameter includes the *Dynamic time*.

7.9.2  Deformation control parameters

7.9.2.1  Ignore undrained behaviour

*Ignore undrained behaviour* excludes temporarily the effects of undrained behaviour in situations where undrained material data sets (*Undrained (A)* or *Undrained (B)*) are used. The selection of this option is associated
with the selection of the Plastic calculation type. When the option is selected, the stiffness of water is not taken into account. As a result, all undrained material clusters (except for Undrained (C) materials) become temporarily drained. Existing excess pore pressures that were previously generated will remain, but no new excess pore pressures will be generated in that particular calculation phase.

![Deformation control parameters subtree in the Phases window](image)

*Figure 216: Deformation control parameters subtree in the Phases window*

Gravity loading of undrained materials will result in unrealistic excess pore pressures. Stresses due to the self-weight of the soil, for example, are based on a long-term process in which the development of excess pore pressures is irrelevant. The Ignore undrained behaviour option enables the user to specify the material type from the beginning as undrained for the main loading stages and to ignore the undrained behaviour during the Gravity loading stage, at least for data sets defined as Undrained A or Undrained B.

**Note:**

The Ignore undrained behaviour option is not available for a Consolidation analysis, Fully coupled flow-deformation analysis or a Dynamics with consolidation analysis, since these calculation types do not consider the Drainage type as specified in the material data sets, but use the material permeability instead.

### 7.9.2.2 Force fully drained behaviour of newly activated clusters

In order to use PLAXIS 2D properly for the application of consolidation of tailings and slurries in reservoirs, the user needs to be able to change the undrained/drained state of newly activated clusters (for fully coupled flow deformation or consolidation analysis).

By allowing clusters to act as undrained upon activation the user can model the gradual settlement of the tailing body correctly.

For the Consolidation and Fully Coupled calculation type, the parameter Force fully drained behaviour newly activated clusters is available to exclude temporarily the effects of undrained behaviour in situations where undrained material data sets (Undrained (A) or Undrained (B)) are used.
By default, this parameter is switched on, which means that newly activated clusters will essentially behave as
drained materials, irrespective of their drainage type setting.
This option does not affect already active clusters.

7.9.2.3 Reset displacements to zero
This option should be selected when irrelevant displacements of previous calculation steps are to be
disregarded at the beginning of the current calculation phase, so that the new calculation starts from a zero
displacement field. For example, deformations due to gravity loading are physically meaningless. Hence, this
option may be chosen after Gravity loading to remove these displacements. If the option is not selected, the
incremental displacements occurring in the current calculation phase will be added to those of the previous
phase. The selection of the Reset displacements to zero option does not influence the stress field.
The use of the Reset displacements to zero option may not be used in a sequence of calculations where the
Updated mesh option is used. However, if an Updated mesh analysis starts from a calculation where the Updated
mesh option is not used, then the Reset displacements to zero option MUST be used in this Updated mesh analysis.

Note:
When the parameter Reset displacements to zero is selected, then automatically the check box for Reset small
strain is selected. Hence if only the displacements is to be disregarded, then the box for Reset small strain should
be unchecked.

7.9.2.4 Reset small strain
This option should be selected when an existing state of the small-strain tensor in the Hardening Soil model with
small-strain stiffness, as reached at the end of the previous phase, is to be disregarded. As a result, the soil will
behave as a ‘virgin soil’ without strain history. Other state parameters are not affected by this option. If it is the
user’s intention to reset all state parameters, then the option Reset State Variables should be used.
7.9.2.5 Reset time

The Reset Time option can be used in calculation phases to reset the Time parameter to zero. This applies to the regular Time as well as to Dynamics Time. As a result, the new phase will start from t = 0 [days]. Resetting the time does not have consequences for existing stresses, deformations or dynamic motions, and it does not influence time-dependent processes like consolidation or creep. Resetting time mainly affects history curves where Time or Dynamics Time is used on one of the axes.

As an example of where this option might be used is if the Soft Soil Creep model is used to set up the initial stress state using Gravity Loading (with a non-zero time interval). Similar as for the option Reset displacements to zero, it might be desired to reset time to zero and to start the new project at t = 0 [days]. This will give a clear history curve that starts from zero.

7.9.2.6 Reset state variables

This option should be selected when the values of the state parameters in advanced soil models, as reached at the end of the previous phase, are to be disregarded. As a result, the soil will behave as 'virgin' soil. The reset parameters are given in Table 17 (on page 355).

Table 17: The material models and the corresponding reset parameters

<table>
<thead>
<tr>
<th>Material model</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model, Hardening Soil model with small-strain stiffness</td>
<td>( p_p ) reset to the OCR value from the Initial tab of the material set</td>
</tr>
<tr>
<td>Hardening Soil model with small-strain stiffness</td>
<td>Strain history tensor reset to zero</td>
</tr>
<tr>
<td>Hardening Soil model, Hardening Soil model with small-strain stiffness</td>
<td>Mobilised shear reset to current effective stress state</td>
</tr>
</tbody>
</table>

Note:

Note that resetting the OCR only adjust the preconsolidation pressure and not the current stresses. Therefore the user should be aware that, after resetting the OCR, the current stress state (particularly the ratio between horizontal and vertical stresses) may not be representative for the new OCR.

7.9.2.7 Updated mesh

This option must be selected when the calculation should be performed as a large deformation analysis according the Updated Lagrange formulation. For a more detailed information see Updated mesh analysis (on page 333).
7.9.2.8 Updated water pressure

This option can only be selected when the calculation is performed as a large deformation analysis according the Updated Lagrange formulation. It is used to recalculate the steady-state pore pressure at the updated position of the stress points. For more detailed information see Updated mesh analysis (on page 333).

7.9.2.9 Ignore suction

When steady-state pore pressures are generated by the phreatic level option or by a groundwater flow calculation, tensile pore water stresses (suction) will be generated above the phreatic level. Although suction is a realistic phenomenon, the use of suction in a deformation analysis may lead to an increased shear strength when effective strength parameters are used for the soil. In order to avoid this, suction can be cut off by selecting the Ignore suction option. Note that the Ignore suction option does not affect the excess pore pressures generated in undrained soil layers, except in the case of a fully coupled flow-deformation analysis. The default setting is such that Ignore suction is selected.

When Ignore suction is selected, soil below the phreatic level is considered to behave fully saturated, whereas soil above the phreatic level is considered to behave as dry soil, although excess pore pressures may still occur here. Positive values of steady-state pore stresses will be set to zero. However, any excess pore pressure above the phreatic level, both positive and negative, will be taken into account. This requires the effective degree of saturation, $S_{eff}$, to be set to 1. Hence, positive excess pore stresses will always be taken into account to their full extent until the cavitation cut-off is reached, except in the case of a consolidation analysis.

When Ignore suction is NOT selected, suction is allowed and included in the pore water stresses (both steady state and excess pore stresses). In this case the effective degree of saturation, $S_{eff}$, determines the proportion of the suction that is included in the active pore stresses. This depends on the soil-water retention curve as defined in the material data set of the soil layer.

7.9.2.10 Cavitation cut-off

In case of unloading of undrained materials (undrained A or B) tensile excess pore stresses may be generated. These excess pore stresses might give rise to tensile pore water stresses. In case the cavitation cut-off option is activated, excess pore pressures are limited so that the tensile pore water stress is never larger than the cavitation stress. By default, the cavitation cut-off option is not activated. If it is activated, the default cavitation stress is 100 kN/m$^2$. The Cavitation cut-off option is not available for a consolidation analysis or a fully coupled flow-deformation analysis.
### 7.9.3 Numerical control parameters

#### 7.9.3.1 Max cores to use

The number of cores to be used by the solvers in the calculation process can be defined in the Numerical control parameters subtree of the Phases window.

**Note:**
- For PLAXIS 2D - licence the max core usage is limited to 1.
- For PLAXIS 2D - [ADV] or [ULT] licence the max number of cores can be adjusted up to 256.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max cores to use</td>
<td>256</td>
</tr>
<tr>
<td>Max number of steps store</td>
<td>1</td>
</tr>
<tr>
<td>Use compression for result</td>
<td>Off</td>
</tr>
<tr>
<td>Use default iter parameters</td>
<td>Off</td>
</tr>
<tr>
<td>Max steps</td>
<td>1000</td>
</tr>
<tr>
<td>Tolerated error</td>
<td>0.0100</td>
</tr>
<tr>
<td>Max unloading steps</td>
<td>5</td>
</tr>
<tr>
<td>Max load fraction per step</td>
<td>0.5000</td>
</tr>
<tr>
<td>Over-relaxation factor</td>
<td>1.2000</td>
</tr>
<tr>
<td>Max number of iterations</td>
<td>60</td>
</tr>
<tr>
<td>Desired min number of iters</td>
<td>6</td>
</tr>
<tr>
<td>Desired max number of iters</td>
<td>15</td>
</tr>
<tr>
<td>Arc-length control type</td>
<td>On</td>
</tr>
<tr>
<td>Use subspace accelerator</td>
<td>Off</td>
</tr>
<tr>
<td>Subspace size</td>
<td>3</td>
</tr>
<tr>
<td>Use line search</td>
<td>Off</td>
</tr>
<tr>
<td>Use gradual error reducer</td>
<td>Off</td>
</tr>
</tbody>
</table>
7.9.3.2 Max number of steps stored

The Max number of steps stored parameter defines the number of steps of a calculation phase to be stored. In general, the final output step contains the most relevant result of the calculation phase, whereas intermediate steps are less important.

The final step of a calculation phase is always stored.

In case the Max number of steps stored is larger than 1, intermediate steps are stored when the corresponding calculation control parameter has passed another 'Interval' of the calculation phase. The 'Interval' is defined by the difference between the start value and the target value of the control parameter, divided by the number of steps stored.

The calculation control parameter and the 'Interval' depend on the type of calculation which is described in table below (Figure 219 (on page 358)).

### Table 18: Calculation control parameters

<table>
<thead>
<tr>
<th>Calculation type</th>
<th>Control parameter</th>
<th>'Interval'</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gravity loading</td>
<td>$\Sigma M_{weight}$</td>
<td>target $\Sigma M_{weight}$ / Max number of steps stored</td>
</tr>
<tr>
<td>Plastic calculation</td>
<td>$\Sigma M_{stage}$</td>
<td>target $\Sigma M_{stage}$ (usually 1) / Max number of steps stored</td>
</tr>
<tr>
<td>Consolidation (staged construction) and Fully coupled analysis</td>
<td>Time</td>
<td>Time interval / Max number of steps stored</td>
</tr>
<tr>
<td>Consolidation (min. pore pressure, degree of consolidation) and Safety analysis</td>
<td>Step number</td>
<td>Applied number of steps / Max number of steps stored</td>
</tr>
<tr>
<td>Safety analysis (target $\Sigma M_{sf}$)</td>
<td>$\Sigma M_{sf}$</td>
<td>($\Sigma M_{sf}$ - 1) / Max number of steps stored (in this case the last step - 1 is also stored)</td>
</tr>
<tr>
<td>Dynamics analysis</td>
<td>Dynamics time</td>
<td>Dynamics time interval / Max number of steps stored</td>
</tr>
</tbody>
</table>
If a calculation phase does not finish successfully, as indicated by a red cross in front of the phase, then up to 50 steps of that phase will be stored. This enables a stepwise evaluation of the cause of the problem.

**Note:**

When it is intended to create animations of the results (e.g. in the case of transient calculations), the *Max number of steps stored* parameter should be set to a higher value.

### 7.9.3.3 Use compression for result files

Enabling the *Use compression for result files* option. Compression reduces file size, but causes a small performance overhead when opening the project in Output.

### 7.9.3.4 Iterative procedure control parameters

The iterative procedures, in particular the load advancement procedures, are influenced by some control parameters. These parameters can be set in the *Numerical control parameters* subtree in the *Phases* window. PLAXIS 2D has an option to adopt a default iterative procedure, which in most cases leads to a good performance. Users who are not familiar with the influence of the control parameters on the iterative procedures are advised to select the *Use default iter parameters*.

In some situations, however, it might be desired or even necessary to change the standard setting. In this case the user should deselect the *Use default iter parameters* and change the desired parameters. A description of the parameters is given below.

### 7.9.3.5 Max steps

This parameter specifies the maximum number of calculation steps (load steps) that are performed in a particular calculation phase.

If *Plastic*, *Consolidation* or *Fully coupled flow-deformation* is selected as the calculation type, then the *Max steps* parameter should be set to an integer number representing the upper bound of the required number of steps for this calculation phase. In this case the defined value is an upper bound to the actual number of steps that will be executed. In general, it is desired that such a calculation is completed within the defined number of steps and stops when either the prescribed ultimate state is reached or the soil body collapses. If such a calculation reaches the maximum number of steps, it usually means that the ultimate level has not been reached. By default, the *Max steps* parameter is set to 1000, but this number can be changed within the range 1 to 10000.

If *Safety* or *Dynamics* is selected as the calculation type, then the number of steps is always exactly executed. In general, it is desired that such a calculation is completed within the defined number of steps and stops when either the prescribed ultimate state is reached or the soil body collapses. If such a calculation reaches the maximum number of steps, it usually means that the ultimate level has not been reached. By default, the *Max steps* parameter is set to 100 for both *Safety* and *Dynamics* calculations which is generally sufficient to complete the calculation phase. However, this number may be changed within the range 1 to 10000.

### 7.9.3.6 Time step determination

This parameter determines how the time step parameter is calculated in a *Consolidation*, a *Fully coupled flow-deformation* or a *Dynamics* analysis. The user can select either the automatic procedure or specify the parameters manually.
7.9.3.7  First time step

The First time step is the increment of time used in the first step of a consolidation analysis (Automatic time stepping (consolidation [ADV] and fully coupled analysis [ULT]) (on page 349) ). By default, the first time step is equal to the overall critical time step. The overall critical time step is calculated based on the material properties and the geometry of the model. For a more detailed description see the Scientific Manual - Consolidation theory - Critical Time Step. The Min time step and Max time step parameters are the minimum and maximum time step values.

![Figure 220: Dialog box displaying the retrieved value for the First time step parameter](image)

To retrieve the value suggested by the program click the cell next to the First time step parameter. The value is displayed when the Retrieve button is clicked. The value is used when the Apply button is clicked and the Time step determination.

7.9.3.8  Sub steps in Dynamics calculation [ULT]

The time step used in a Dynamics calculation is constant and equal to \( \Delta t \), where \( \Delta t \) is the duration of the dynamic loading (Dynamics time interval), \( m \) is the value of Max steps and \( n \) is the value of the Number of sub steps parameter. The result of the multiplication of the Max steps number (\( m \)) and the Number of sub steps number (\( n \)) gives the total number of steps to be used in the time discretisation. It is important to define a proper number of steps such that the dynamics signal used in dynamic loading is properly covered.

The Max steps parameter specifies the number of the steps that are stored which can be used in plots in the Output program. A higher value of the Max steps parameter provides more detailed plots and animations, however the processing time required by the Output program is increased as well.

In general, the total number of steps, which is the product of the values defined for the Max steps and Number of sub steps parameters, should be the same as the total number of data points used in the dynamics calculation. If the Time step determination is set to default option Automatic, PLAXIS 2D automatically calculates the proper number of steps and sub steps based on the material, mesh and number of data points in all active time history function (dynamics multipliers). In this case, the Number of sub steps parameter is automatically calculated in the kernel. When the option Semi-automatic is selected, the Number of sub steps will be automatically calculated inside the kernel, based on the Max steps as given by the user. When the Manual option is selected, both Max steps and Number of sub steps will not be automatically calculated inside the kernel but must be provided by the user.
To be able to see and change these two parameters, the user has the possibility to retrieve them by pressing the **Retrieve** button. By pressing the **Apply** button, these values will be applied and will be used by kernel without any change. It should be noted that PLAXIS 2D always tries to find the closest number of steps to the *Max steps* that the user specifies (in case of using the default option, the number of steps will be the closest number to 100 as shown in Figure 221 (on page 361)).

![Figure 221: Dialog box displaying the retrieved value for the Number of sub steps parameter](image)

**7.9.3.9 Tolerated error**

In any non-linear analysis where a finite number of calculation steps are used there will be some drift from the exact solution, as shown in Figure 222 (on page 362). The purpose of a solution algorithm is to ensure that the equilibrium errors, both locally and globally, remain within acceptable bounds ([Automatic error checks](#) (on page 401)). The error limits adopted in PLAXIS 2D are linked closely to the specified value of the *Tolerated error*.

Within each step, the calculation program continues to carry out iterations until the calculated errors are smaller than the specified value. If the tolerated error is set to a high value then the calculation will be relatively quick but may be inaccurate. If a low tolerated error is adopted then computer time may become excessive. In general, the standard setting of 0.01 is suitable for most calculations.
Note:
Be careful when using a tolerated error larger than the default value of 0.01, as this may give inaccurate results which are not in equilibrium.

If a calculation gives failure loads that tend to reduce unexpectedly with increasing displacement, then this is a possible indication of excessive drift of the finite element results from the exact solution. In these cases, the calculation should be repeated using a lower value of the tolerated error. For further details of the error checking procedures used in PLAXIS 2D see Automatic error checks (on page 401).

Most Validation examples have been performed with a tolerated error lower than the default settings.

7.9.3.10 Maximum unloading steps
This value gives the number of steps that PLAXIS 2D allows before declaring that the soil body has collapsed. The default value is 5. However, sometimes, in the case of a changing mechanism the load level may temporarily decrease in order to pick up another mechanism after which the load can still increase. For example in uplift problems there is a calculation stage when the top soil structure exhibits buckling behaviour (that lasts longer than 5 steps), which results in a small unloading. This small unloading is not a collapse of the whole model, as the final loading finally grows above the previous levels. Hence, the user might decide to set this value to a higher number and later judge on the presence of collapse based on the loading curve.

7.9.3.11 Max load fraction per step
This value controls the size of the load step in staged construction. Since this is a fraction, it determines what maximum part of the stage can be solved in one step. For instance, a value of 0.5 (default) means that the applied load or unbalance will be solved at least in $1/0.5 = 2$ steps. More steps are possible if convergence is slow, but not less. The user might want to use small values (like 0.02 to force at least 50 steps) in order to observe the
kinetics of the deformation process, prevent divergence in case of high nonlinearity or in combination with Gradual Error reduction.

7.9.3.12 Over-relaxation factor

To reduce the number of iterations needed for convergence, PLAXIS 2D makes use of an over-relaxation procedure as indicated in Figure 225 (on page 367). Over-relaxation is a deliberate over-estimation of the equilibrium error under the assumption that by just solving the exact unbalance, the next iteration is still far from equilibrium. The purpose of this is to reduce the number of the iterations in order to speed up the calculation. The parameter that controls the degree of over-relaxation is the over-relaxation factor. The theoretical upper bound value is 2.0, but this value should never be used. For low soil friction angles, for example \( \phi < 20^\circ \), an over-relaxation factor of about 1.5 tends to optimise the iterative procedure. If the problem contains soil with higher friction angles, however, then a lower value may be required. The standard setting of 1.2 is acceptable in most calculations.

![Figure 223: Influence of over-relaxation](image)

7.9.3.13 Maximum number of iterations

This value represents the maximum allowable number of iterations within any individual calculation step. In general, the solution procedure will restrict the number of iterations that take place. This parameter is required only to ensure that computer time does not become excessive due to errors in the specification of the calculation. The standard value of Maximum number of iterations is 60, but this number may be changed within the range 1 to 100.

If the maximum allowable number of iterations is reached in the final step of a calculation phase, then the final result may be inaccurate. If this is the case then the message 'Maximum iterations reached in final step' is displayed in the Log info for last calculation box of the Phases window. Such a situation occasionally occurs when the solution process does not converge. This may have various causes, but it mostly indicates an input error.

7.9.3.14 Desired min and desired max number of iterations

PLAXIS 2D makes use of an automatic step size algorithm (Automatic error checks (on page 401)). This procedure is controlled by the two parameters Desired min number of iterations and Desired max number of iterations, specifying the desired minimum and maximum number of iterations per step respectively. The default
values of these parameters are 6 and 15 respectively, but these numbers may be changed within the range 1 to 100. For details on the automatic step size procedures see Automatic step size procedure (on page 346).

It is occasionally necessary for the user to adjust the values of the desired minimum and maximum from their standard values. It is sometimes the case, for example, that the automatic step size procedure generates steps that are too large to give a smooth load-displacement curve. This is often the case where soils with very low friction angles are modelled. To generate a smoother load-displacement response in these cases, the calculations should be repeated with smaller values for these parameters, for example:

Desired minimum = 3  Desired maximum = 7

If the soil friction angles are relatively high, or if high-order soil models are used, then it may be appropriate to increase the desired minimum and maximum from their standard values to obtain a solution without the use of excessive computer time. In these cases the following values are suggested:

Desired minimum = 8  Desired maximum = 20

In this case it is recommended to increase the Maximum iterations to 80.

7.9.3.15  Arc-length control

The Arc-length control procedure is a method that is by default selected in PLAXIS 2D to obtain reliable collapse loads for load-controlled calculations. The iterative procedure adopted when arc-length control is not used is shown in Figure 224 (on page 364) for the case where a collapse load is being approached. In the case shown, the algorithm will not converge. If arc-length control is adopted, however, the program will automatically evaluate the portion of the external load that must be applied for collapse as shown below.

![Figure 224: Influence of Arc-length control](image)

Arc-length control is activated by selecting the corresponding check box in the Numerical control parameters subtree. The arc-length control procedure should be used for load-controlled calculations, but it may be deactivated, if desired, for displacement-controlled calculations.

Setting the Arc-length control type parameter to Auto enables the procedure only when the CSP (current stiffness parameter) is less than 0.5. In this way arc-length is only used when the material exhibits significant plastic behaviour.
7.9.3.16 Use subspace accelerator

A common way to solve the system of equations describing the relation between forces and displacement, \( Ku = F \), is through a Newton-Raphson iteration that finds the solution of the equation \( f(u) = F - Ku = 0 \). In case the stiffness matrix \( K \) is constant and the material behaviour is elastic, only 1 iteration is necessary. But generally material behaviour is not elastic and \( K \) is for instance stress dependent, in which multiple iterations are required.

For iteration \( i \) in a certain calculation step, the displacements are found using the Newton-Raphson iteration:

\[
u_i = u_{i-1} - \frac{f(u_{i-1})}{f'(u_{i-1})}\]

If the stiffness matrix \( K \) is stress dependent, it should be recalculated for every iteration in order to get the most accurate results and this is exactly what the traditional Newton-Raphson method does. However, making a new stiffness matrix is quite time consuming, which makes the traditional Newton-Raphson method quite slow.

The modified Newton-Raphson method on the other hand only determines a new stiffness matrix at the beginning of new calculation step without updating it per iteration. This considerably speeds up the calculation, but if during 1 calculation step the stress or strain state changes a lot due to strong non-linear behaviour, the solution reached in the iterations can deviated from the real solution which then will result in slower convergence and thus undoing the positive effect of the modified Newton-Raphson method.

Scott & Fenves (2010) describe a new accelerated Newton-Raphson algorithm that is based on the modified Newton-Raphson algorithm. In this accelerated algorithm, for every iteration the results are additionally improved by using the displacement increments from a limited number of previous iterations. The effect of the acceleration is the largest for those nodes that had the largest incremental displacements in the previous iterations, which are the nodes that had the highest non-linearity. Hence, the acceleration procedure has the most effect on those nodes that would have the largest deviation from the real solution in a modified Newton-Raphson iteration.

The calculation gathers the displacement increment vectors from previous iterations in a special matrix that is a so-called "Krylov subspace", hence the name Subspace acceleration.

The amount of previous iterations that is taken into account for the acceleration is the Subspace size parameter. Taking into account more results from previous iterations improves the accuracy of the results which then reduces the amount of iterations needed, but on the other hand the acceleration procedure itself also requires memory and calculation time and so there is a balance between how much the acceleration procedure can improve the convergence vs the calculation time for the acceleration procedure itself. In order to reduce the memory and calculation time needed, the Subspace size is usually chosen in the range of 3 - 6. Based on experience, PLAXIS uses a default value of 3, which means the displacements increments from the last 3 iterations are used to accelerate the current iteration.

In PLAXIS subspace acceleration can be successfully applied to solve nonlinear equations of geotechnical problems especially for computationally challenging situations when there are strong non-linearities involved such as drastic changes in the load-resisting characteristics of the geotechnical model components like development of local failure mechanisms, soil freezing/thawing, liquefaction and complex couplings among different physics.

**Note:** Subspace accelerator is not available for calculation types \( K_0 \) and field stress.

7.9.3.17 Use line search

This method aims to improve the convergence of non-linear problems in a relatively inexpensive way. It can also be seen as an improvement on the over-relaxation method that exists in PLAXIS 2D. In its essence line search
tries to scale the correction of the solution increment that is calculated every iteration but the scaling parameter is not fixed as in the over-relaxation method but calculated in a special way to bring the whole system closer to equilibrium. In general, whereas Subspace acceleration is best used in situations with major non-linearity, the usage of line search is advised for problems without severe non-linearity, like serviceability calculations. Critical state calculations, like footing failure or embankment failure generally do not benefit from line search with respect to calculation time.

7.9.3.18 Use gradual error reduction

Gradual error reduction is a simple numerical trick that aims to speed up the calculation in case of very slow convergence, as it happens sometimes for non-associated plastic flow. It works as follows: initially the tolerated error (the one that controls the convergence of the nonlinear calculations) is increased 10-fold and then, by the end of the phase, it linearly reduces to the error as defined by the Tolerated error parameters. Hence, when using the default error of 0.01, the calculation will start with 0.1 and end with 0.01. The rationale behind is that in case of non-associative plastic flow one can obtain an infinite number of alternative (but still correct) solutions with the same tight tolerance, but with, for instance, different step size. Hence, is it not really necessary to enforce a tight tolerance during the whole calculation, as a feasible solution is located in a certain band, defined by all alternative paths. When the gradual error reduction procedure is enabled, the solution does not follow one of the paths, but, possibly, jumps from one to another. However, in the end of the calculation the error is forced to reduce to the levels, as defined for the calculation phase.

Nonetheless, application of this procedure should be done with caution. If the initial tolerated error is too high, hypothetically, the solution can switch to a path that is not even connected to the current initial conditions (hence infeasible). One way to prevent this is to use much smaller allowable Max load fraction per step than the default value used in PLAXIS 2D. The default maximum step size is 50% of the whole stage load. The user might consider reducing the step size to something like 2% or less, hence requiring at least 50 steps (100% / 2%) to obtain the solution of the calculation phase.

7.9.3.19 Extrapolation

It is a numerical procedure, which is automatically used in PLAXIS 2D if applicable, when a certain loading that was applied in the previous calculation step is continued in the next step. In this case, the displacement solution to the previous load increment can be used as a first estimate of the solution to the new load increment. Although this first estimate is generally not exact (because of the non-linear soil behaviour), the solution is usually better than the solution according to the initial stress method (based on the use of the elastic stiffness matrix) (See Figure below).
After the first iteration, subsequent iterations are based on the elastic stiffness matrix, as in the initial stress method (Zienkiewicz, 1977 on page 588). Nevertheless, using Extrapolation the total number of iterations needed to reach equilibrium is less than without extrapolation. The extrapolation procedure is particularly useful when the soil is highly plastic.

### 7.9.4 Flow control parameters [ADV]

#### 7.9.4.1 Iterative procedure

Groundwater flow, optionally coupled with thermal flow, involves extra parameters to control the iterative procedure to solve the corresponding system of equations. For Steady state flow calculations two extra parameters are available, namely Tolerated error and Over-relaxation factor. For Transient flow a higher number of parameters are required to define the iterative procedure.

#### 7.9.4.2 Max steps

This parameter specifies the maximum number of calculation steps that are performed in a phase in which the Pore pressure calculation type is set to Steady state groundwater flow or Transient groundwater flow or the Thermal calculation type is set to Steady state thermal flow or Transient thermal flow. By default, the Max steps parameter is set to 1000.
7.9.4.3 Tolerated error
Similar to the Tolerated error option in deformation analyses (Numerical control parameters (on page 356)), the Tolerated error option in flow calculations is used to check if the result is accurate enough. In the case of unsaturated groundwater flow, checking the local error (error which occurs in a few elements) is also needed. In this case, due to the fact that the permeability can change significantly, it is possible to have isolated water in some elements in unsaturated zones. The specified Tolerated error is used for checking both the global flow error and local errors. PLAXIS 2D used higher Tolerated error to check the local flow errors (usually 10 times larger). If both global and local errors are less than the Tolerated error, the groundwater flow calculation is terminated.

7.9.4.4 Over-relaxation factor
Since the unsaturated flow analyses may be highly non-linear, PLAXIS 2D uses an over-relaxation factor to speed up the steady state calculations and to decrease the number of steps needed. This factor is by default 1.5. For confined flow analyses which are linear a factor of 1 is enough. In case of highly non-linear analyses for which PLAXIS 2D needs more steps, higher values than 1.5 might result in faster convergence. The maximum possible value is 2.0.

7.9.5 Dynamics control parameters [ULT]
The parameters controlling a Dynamics and Dynamics with consolidation analysis can be defined in the Dynamics control parameters subtree in the Phases window.

7.9.5.1 Newmark alpha and beta
The Newmark alpha and beta parameters determine the numerical time-integration according to the implicit Newmark scheme. In order to obtain an unconditionally stable solution, these parameters must satisfy the following conditions:

Newmark $\beta \geq 0.5$ and Newmark $\alpha \geq 0.25 \left(0.5 + \beta \right)^2$

![Dynamic control parameters](image)

Figure 227: Dynamics control parameters subtree in the Phases window

For an average acceleration scheme you can use the standard settings ($\alpha = 0.25$ and $\beta = 0.5$). Using a higher $\beta$-value and corresponding $\alpha$-value results in a damped Newmark scheme (e.g. $\alpha = 0.3025$ and $\beta = 0.6$).
7.9.5.2 Mass matrix

In dynamics calculations, PLAXIS 2D uses, by default, a lumped mass matrix, i.e. a mass matrix that contains only diagonal terms in which the contributions of the off-diagonal terms are incorporated. This provides an efficient dynamics calculation process, but it may lead to slightly inaccurate results. For example, results of block waves in soil columns may show small oscillations as well as some dispersion. This can be improved by using a consistent mass matrix instead of a lumped mass matrix.

The Mass matrix parameter can be used to distinguish between a lumped mass matrix (Mass matrix parameter = 0) and a consistent mass matrix (Mass matrix parameter = 1). In fact, any intermediate value between a lumped mass matrix and a fully consistent mass matrix can be entered for dynamics calculations (0 ≤ Mass matrix ≤ 1), allowing for a mixed matrix to be used.

7.9.6 Reached values

![Reached values subtree in the Phases window](image)

**Reached total time**

It is the actual accumulated time at the end of a finished calculation phase.

**CSP - Relative stiffness**

It is the relative stiffness parameter calculated at the end of the phase, which is a measure for the amount of plasticity that occurs during the calculation (Automatic error checks (on page 401)). A value of 1.0 means that the full model is elastic; a value close to zero indicates that failure is approached.

**Reached total force**

They are the component of the resulting reactions on the nodes where non-zero prescribed displacement is applied.

**Pmax - Reached max pp**

It is the value of the maximum pore pressure that has been actually reached at the end of a calculation phase. This value corresponds to the maximum excess pore pressure for a Consolidation analysis, the steady state pore pressure for a groundwater flow analysis and the maximum active pore pressure for a Fully coupled flow-deformation analysis.

**ΣM_{stage} - Reached phase proportion**

It is an indication of the proportion of the unbalance solved in a phase where the Staged construction loading type is applied (Staged construction (on page 335)).
7.10 Flow conditions

PLAXIS 2D is generally used for effective stress analysis in which total stresses are divided into effective stresses, $\sigma'$, and active pore pressures, $p_{\text{active}}$:

$$\sigma = \sigma' + p_{\text{active}} \quad \text{Eq. [89]}$$

Active pore pressure ($p_{\text{active}}$) is defined as the effective saturation, $S_{\text{eff}}$, times the pore water pressure, $p_{\text{water}}$:

$$p_{\text{active}} = S_{\text{eff}} \cdot p_{\text{water}} \quad \text{Eq. [90]}$$

Pore water pressure differs from active pore pressure when the degree of saturation is less than unity. PLAXIS 2D can deal with saturated soil below the phreatic level, as well as with partially saturated soil above the phreatic level. More details about partially saturated soil behaviour are provided in the Groundwater tabsheet (on page 236).

In the pore water pressure a further division is made between steady state pore pressure, $p_{\text{steady}}$, and excess pore pressure, $p_{\text{excess}}$:

$$p_{\text{water}} = p_{\text{steady}} + p_{\text{excess}} \quad \text{Eq. [91]}$$

Excess pore pressures are pore pressures that occur as a result of stress changes in undrained materials. In this respect, changes in stress may be a result of loading, unloading, a change in hydraulic conditions or consolidation. Hence, excess pore pressures are a result of a deformation analysis. In a Plastic calculation, a Safety analysis or a Dynamics analysis, excess pore pressures can occur in clusters for which the Drainage type is set to Undrained A or Undrained B. In Consolidation analysis, Dynamics with consolidation analysis and Fully coupled flow-deformation analysis, excess pore pressures can occur in any material (except Non-porous materials), depending on the permeability as defined in the corresponding material data set. In the case of a Fully coupled flow-deformation analysis, excess pore pressure is calculated by subtracting the steady-state pore pressure, $p_{\text{steady}}$, from the pore water pressure, $p_{\text{water}}$.

Steady-state pore pressures are pore pressures that represent a stable state. Since steady-state pore pressures are not supposed to change during a deformation analysis, they are considered input data. There are various ways to define and generate steady-state pore pressures. The way to indicate how pore pressures are generated for a particular calculation phase is indicated by means of the Pore pressure calculation type parameter in the Phases window. In contrast to other deformation calculation types, a Fully coupled flow-deformation analysis does not allow for the selection of the Pore pressure calculation type, because in this case total pore water pressures, $p_{\text{water}}$, are calculated together with displacements. To enable a division in steady-state pore pressures and excess pore pressures, the steady-state pore pressures, $p_{\text{steady}}$, are automatically calculated on the basis of a preliminary steady-state groundwater flow calculation using the hydraulic boundary conditions at the end of the calculation phase. This enables the calculation and output of excess pore pressures, $p_{\text{excess}}$, in all steps:

$$p_{\text{excess}} = p_{\text{water}} - p_{\text{steady}} \quad \text{Eq. [92]}$$
The definition of water conditions is needed to generate pore pressures in the soil and to generate external water pressures, if applicable. The definition of water conditions can be divided into the creation of water levels and assigning water conditions to polygon clusters. These features will be described in more detail below.

**Note:** Analysis involving consolidation analysis, steady-state groundwater flow or changes in hydraulic conditions the minimum required is an [ADV] licence. For dynamics analysis, transient flow or fully coupled calculations an [ULT] licence needs to be active.

### 7.10.1 Water levels

Water levels can either be generated according to the information specified in boreholes ([Defining water conditions](on page 53)) or can be defined in the [Flow conditions](mode. A water level can be used to generate external water pressures (for water levels outside the model) and to generate pore pressures in soil layers. In the latter case the water level can act as a phreatic level in partially saturated soil layers as well as a pressure head level in aquifer layers. Water levels created in the model are grouped under the Water levels subtree in the Attributes library in the Model explorer. Due to the global nature of the water levels, any change to an existing water level in the model will affect it in all the phases. If a water level in a time-dependent phase has the same geometry as previously defined but it varies with time, a flow function needs to be assigned to it. Moreover, it is required to create a copy of a water level with the same geometry. To create a copy of the water level, right-click the existing water level in the Model explorer and select the Duplicate option in the appearing menu ([Figure 229](on page 372)). A copy of the water level is created. Now a flow function can be created and assigned to this new water level. Note that copies of Borehole water levels are listed as User water levels rather than Generated water levels. No modifications, such as Time dependency are possible for Borehole water levels. For water levels consisting of different sections, time-dependent conditions can only be applied to the horizontal parts of such water levels.
The continuity of the flow functions assigned to water levels in consecutive phases can be maintained by using the options available in the pop up menu displayed when the water level is right-clicked. These options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create the reached water level</td>
<td>When this option is selected a new water level is created at the position reached at the end of the previous phase. The location of the water level will be constant in the current phase.</td>
</tr>
<tr>
<td>Create the reached water level and continue</td>
<td>When this option is selected a new water level is created at the position reached at the end of the previous phase. The location of the water level in the current phase will change from that point on according to the flow function assigned to the original water level in the previous phase. PLAXIS 2D ensures the continuity of the flow function, whereby the accumulated time from previous phases is used as an offset to enter the flow function for the current phase.</td>
</tr>
</tbody>
</table>

### 7.10.1.1 Borehole water levels

The easiest way to define a water level is in the **Soil** mode by specifying a **Head** in the boreholes (Defining water conditions (on page 53)). A single borehole can be used to create a horizontal water surface that extends to the model boundaries. When multiple boreholes are used, a non-horizontal water surface can be created by combining the heads in the various boreholes. The water level defined in this way is termed a 'Borehole water level'. This water level is, by default, used as the **Global water level** (see further). In principle, a pore pressure distribution underneath this generated water level is hydrostatic. However, a non-hydrostatic distribution in the soil may be specified in the **Water** tabsheet of the Modify soil layers window, which may lead to additional generated water levels representing the (virtual) level where the extrapolated pore pressure in a particular soil layer is zero. For more details about this feature, see Defining water conditions (on page 53).
7.10.1.2 User water levels - Water levels mode

As an alternative to the Generated water levels, the user may define 'User water levels' using the Create water level option, which is available in the Flow conditions mode.

After selecting this option, a first water level point can be created by clicking in the model at a position where the water pressure is supposed to be zero. If no other point is specified, a horizontal water level is created through this point, extending to the model boundaries.

A non-horizontal water level can be created by defining more points in the geometry, while the Create water level option is still active. A new user water level may also be created by duplicating an existing water level and modifying it afterwards. To duplicate an existing water level, right-click it and select Duplicate from the appearing menu. User water levels can be deleted by right-clicking them and selecting the Delete option from the appearing menu.

Time dependency can be specified for horizontal sections of User water levels. The time dependent behaviour can be specified by selecting the corresponding flow function.

Note:
- The Borehole water levels cannot be deleted.
- A time-dependent flow function cannot be assigned to water levels that are non-horizontal.

7.10.2 Assigning water conditions to soil polygons

Pore pressures in soil polygons are generated on the basis of the water conditions assigned to these polygons. By default, the water conditions as defined in the Modify soil layers window are assigned to all soil polygons clusters. This could be the Global water level, but (in case of non-hydrostatic pressures defined in the boreholes) it could also be a different generated water level or one of the other water conditions as defined for soil layers in Soil mode.

To change the water conditions in the calculation phase considered, polygons objects have to be selected and the desired option should be selected from the Water conditions feature in the Selection explorer. Similar options can be selected in the Model explorer or from the right-hand mouse menu. A summary of all available options is given below:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global level</td>
<td>Water conditions defined by the Global water level (default). The Global water level is defined in the General group in the Phases window.</td>
</tr>
<tr>
<td>Custom level</td>
<td>Another predefined water level is selected to set the water conditions.</td>
</tr>
<tr>
<td>Head</td>
<td>A new Head level is defined to set the water conditions.</td>
</tr>
<tr>
<td>User-defined</td>
<td>A reference level, reference pressure and pressure increment with depth are defined to set the water conditions.</td>
</tr>
<tr>
<td>Interpolate</td>
<td>Water pressures are linearly interpolated (in vertical direction) between the polygons cluster above and the polygons cluster below.</td>
</tr>
</tbody>
</table>
**Meshing and calculation**

**Flow conditions**

| Dry | Set water pressures to zero. |
| Unsaturated | A saturation level is defined to set the water conditions to partially saturated. The resulting pore stress (suction) will be calculated according to the hydraulic model as defined in the material data set. |

### 7.10.2.1 Global level

When the *Global level* option is selected, the pore pressure distribution in the soil layer is generated according to the global water level of the phase considered. The resulting pore pressure distribution in the soil layer is then hydrostatic. This does not mean that the pore pressure distribution in the soil as a whole is hydrostatic, since other soil layers may have other hydraulic conditions.

### 7.10.2.2 Custom level

When the *Custom level* option is selected in the *Water conditions* drop-down menu, a further selection should be made from the list of available water levels (Borehole water levels and User water levels). The resulting pore pressure distribution in the soil layer is then hydrostatic.

### 7.10.2.3 Head

The *Head* option is a quick alternative for the generation of hydrostatic pore pressures based on a horizontal water level. After selecting the *Head* option in the *Water conditions* drop-down menu, a reference level \( y_{ref} \) should be defined, indicating the level where the pore pressure will be zero.

**Note:**

- The multi-select option may be used to efficiently set water conditions for multiple soil layers at once.
- When a non-horizontal water level is used to generate a hydrostatic pore pressure distribution, this distribution may not be fully realistic, since in reality a non-horizontal water level would be the result of a groundwater flow process in which case the pore pressure distribution may be non-hydrostatic.

### 7.10.2.4 User-defined

If the pore pressure distribution is linear but not hydrostatic, the *User-defined* option should be selected in the *Water conditions* drop-down menu. Subsequently, values for the reference level \( y_{ref} \), the reference pressure \( p_{ref} \) and the pressure increment \( p_{inc} \) should be entered. Note that pressure is entered as a negative value.

### 7.10.2.5 Interpolate

It is possible to generate pore pressures in a soil polygons based on the pore pressures of the adjacent soil polygons (above and below) by selecting the *Interpolate* option in the *Water conditions* drop-down menu. This option is, for example, used if a relatively impermeable layer is located between two permeable layers with a different groundwater head. The pore pressure distribution in the relatively impermeable layer will not be hydrostatic, so it cannot be defined by means of a phreatic level.
On selecting the option Interpolate the pore pressure in that soil polygons is interpolated linearly in vertical direction, starting from the value at the bottom of the soil polygons above and ending at the value at the top of the soil polygon below. The Interpolate option can be used repetitively in two or more successive soil polygons (on top of each other). In the case that a starting value for the vertical interpolation of the pore pressure cannot be found, then the starting point will be based on the Global water level.

7.10.2.6 Dry

In addition to the global water pressure distribution it is possible to remove water pressures from individual groups of polygons in order to make them 'dry'. Deactivation of water can be done independent from the soil itself. Hence, if the soil is deactivated and the water level is above the excavation level, then there is still water in the excavated area. If it is the user's intention to simulate a dry excavation, then the water must be explicitly deactivated. Please note that the water pressure in adjacent soil polygons is not affected and may need to be changed manually.

**Note:**
The *Dry* clusters behave as non-porous materials. As a result, neither initial nor excess pore pressure is taken into account and flow is not possible through the cluster.

7.10.2.7 Unsaturated

It is possible to generate pore stresses (suction) based on an explicit value of initial saturation in a soil polygons, by selecting the *Unsaturated* option from the *Water conditions* drop-down menu. The *Saturation* value has to be in the range 0.1 and 0.99. The saturation is uniform throughout the soil cluster. The resulting pore stress (suction), will be calculated according to the hydraulic model and parameters as defined in the material data set. In order to be able to use this suction during calculations, the option 'ignore suction' must be de-selected.

7.10.3 Water pressure generation and previewing

Water pressures (i.e. pore pressures in finite element stress points and external water loads) are calculated on the basis of the water conditions as defined for a calculation phase as soon as the phase is previewed or when the calculation process is started.

It is recommended to preview the water pressures in order to check that the generated pressures are satisfactory. This can be done by clicking the *Preview phase* button in the side tool bar. After the water pressures have been generated and written to data files, the Output program is started, showing the active mesh for the phase considered. The various types of pore pressures can be previewed by selecting the desired option from the *Stress* menu. The phreatic level or external water level can be seen when the *Phreatic level* option is active in the *Geometry* menu. If the *Loads* option is also active and the water level is outside the active mesh, external water pressures can be seen.

Water pressures for phases that are selected for calculation are also generated at the start of the calculation process, just before the execution the finite element calculation itself. The results of the water pressure generation are also included in the output steps with computational results, and can be viewed after the calculation has finished.
7.10.4 Flow boundary conditions [ADV]

The flow boundary conditions of a phase (at least which boundaries are 'open' and which are 'closed') can be specified in the GroundwaterFlow subtree under Model conditions in the Model explorer. Such boundary conditions are required for a groundwater flow calculation, a consolidation analysis or a fully coupled flow-deformation analysis. By default the bottom boundary of the model is closed. The prescribed groundwater head on external geometry boundaries is, by default, derived from the position of the general phreatic level, at least when the general phreatic level is outside the active geometry. Also internal geometry lines that have become external boundaries due to a de-activation of soil clusters are considered to be external geometry boundaries and are therefore treated similarly.

In a consolidation analysis the flow boundary conditions define where excess pore pressures may dissipate through the model boundary, and hence, it affects the excess pore pressures only. In a groundwater flow or fully coupled analysis the flow boundary conditions define where pore water may flow into or out of the soil, and hence, it affects the total pore pressures in these cases. In the latter case, additional conditions may be required to define the hydraulic head at 'open' boundaries. By default, the hydraulic head is implicitly defined by the Global water level, but this can be overwritten by using the Create groundwater flow boundary conditions feature in the Structures mode (Groundwater flow boundary conditions (on page 143)). The parts of an 'open' boundary above the level defined by the hydraulic head are considered to be 'seepage' boundaries whereas the parts below are assigned the given hydraulic head as a boundary condition.

7.10.4.1 Boundary conditions - Phases

Besides the options described in Groundwater flow boundary conditions (on page 143) for groundwater flow boundary conditions, two other options are available in Calculation modes. These options are:

<table>
<thead>
<tr>
<th>Constant value from previous phase</th>
<th>The water level reached at the end of the previous phase will be kept constant during the current phase.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain function from previous phase</td>
<td>The water level in the current phase will continue to vary according to the flow function assigned to the boundary in the previous phase. The accumulated time from previous phases is used as an offset to enter the flow function for the current phase.</td>
</tr>
</tbody>
</table>

7.10.5 Precipitation [ADV]

The Precipitation option can be used to specify a general vertical recharge or infiltration ($q$) due to weather conditions. This condition is applied at all boundaries that represent the ground surface. This option can be selected in the Model conditions subtree in the Model explorer (Figure 230 (on page 377)).
Meshing and calculation
Flow conditions

Note:
• Note that when both *Precipitation* and a groundwater flow boundary conditions is created at the top boundary of the model, the condition specified for the boundary condition is taken into account ignoring *Precipitation*.
• The *Precipitation* model condition is displayed on the Model explorer for PLAXIS 2D licence, however, this feature is only useful for [ADV] and [ULT] licences.

Note:
The parameters used to define precipitation are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$q$</td>
<td>Recharge (infiltration), specified in the unit of length per unit of time. Negative values can be used to model evaporation.</td>
</tr>
<tr>
<td>$\psi_{\text{max}}$</td>
<td>Maximum pore pressure head, relative to the elevation of the boundary, specified in the unit of length (default 0.1 length units). When the groundwater head increases above this level, the infiltration discharge changes into the corresponding head to simulate run off.</td>
</tr>
<tr>
<td>$\psi_{\text{min}}$</td>
<td>Minimum pore pressure head, relative to the elevation of the boundary, specified in the unit of length (default -1.0 length units). When the groundwater head decreases below this level, the evaporation discharge changes into the corresponding head.</td>
</tr>
</tbody>
</table>

At horizontal ground surface boundaries, the full precipitation as specified by the value of $q$ is applied as a recharge. At inclined ground surface boundaries (slopes) under an angle $\alpha$ with respect to the horizon, a recharge is applied perpendicular to the inclined boundary with a magnitude $q \cos(\alpha)$.

If the resulting pore pressure head at a certain point of a boundary where a positive precipitation has been prescribed is increased such that it reaches the value $y + \psi_{\text{max}}$ (i.e. the water level comes above the ground surface at a depth of $\psi_{\text{max}}$) then the water is supposed to run-off. As a result, a constant head boundary condition equal to $y + \psi_{\text{max}}$ is applied instead.
If the resulting pore pressure head at a certain point of a boundary where a negative precipitation 
(evapotranspiration) has been prescribed is below a value \( y + \psi_{\text{min}} \) (i.e. the upper part of the ground has become unsaturated), then the evapotranspiration is supposed to stop. As a result, a constant head boundary condition 
equal to \( y + \psi_{\text{min}} \) is applied instead.

For transient groundwater flow calculations and fully coupled flow-deformation analysis, a variation of the 
precipitation in time can be specified resulting in time-dependent boundary conditions. This can be done by 
selecting the Time dependent option in the Precipitation subtree. The corresponding flow function describing the 
variation of the discharge with time can be selected from the drop-down menu. More information on Flow 
functions is available in Flow functions [ULT] (on page 150).

### 7.10.6 Climate [ADV]

The Climate option can be used for thermal calculations to specify a general convective condition due to weather 
conditions (air temperature). For details on Convection boundaries see Thermal flow boundary conditions [ADV] 
(on page 156). The Climate condition is applied at all boundaries that represent the ground surface. This option 
can be selected in the Model conditions subtree in the Model explorer (Figure 231 (on page 378)).

![Figure 231: The expanded Climate subtree in the Model explorer](image)

The parameters used to define climate conditions are:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air temperature</td>
<td>Temperature of the air, entered in the unit of temperature.</td>
</tr>
<tr>
<td>Surface transfer</td>
<td>Heat transfer coefficient (the inverse of thermal resistance), entered in the unit of power per unit of length per unit of width in the out-of-plane direction per unit of temperature.</td>
</tr>
<tr>
<td>Time dependency [ULT]</td>
<td>Indicator whether the air temperature is Constant or Time dependent. In the latter case, a Temperature function needs to be assigned as defined in the Thermal functions of the Attributes library of the model explorer.</td>
</tr>
</tbody>
</table>
**Note:** The climate model condition is displayed on the Model explorer for PLAXIS 2D licence, however, this feature is only useful for [ADV] and [ULT] licences.

### 7.11 Geometry configuration - Staged Construction mode

In PLAXIS 2D, it is possible to change the geometry and load configuration by activating or deactivating loads, soil polygon clusters or structural objects created in the geometry input for each calculation phase. The material data sets can be reassigned and the water pressure distribution in the geometry can be changed as well.

Changes to the geometry configuration generally cause substantial out-of-balance forces. These out-of-balance forces are stepwise applied to the finite element mesh using the automatic load stepping procedures ([Automatic step size procedure](on page 346))

#### 7.11.1 Changing geometry configuration

Loads, soil polygon clusters or structural objects may be activated or deactivated to simulate a process of construction or excavation in the **Staged construction** mode. Hence, it is possible, for example, to first make an excavation with soil retaining walls, then install a basement floor and subsequently constructing the building above. In this way, the effects around the excavation can be analysed realistically.

To activate/deactivate elements in a selected mode in **Phases explorer**, click the **Toggle activation** button and click the objects to be activated in the drawing area. All the elements assigned to the geometry selected after clicking **Toggle activation** will be activated/deactivate.

The right mouse button menu or the **Object explorers** can be used in cases where not all features should be deactivated. Note that in the right mouse button menu, besides the geometry entity, the features assigned to it are listed as well. To deactivate a feature, point that in the right mouse button menu and select the **Deactivate** option.

Entities and the features assigned to them can be activated or deactivated in **Object explorers** by clicking on the square in front of them (See [Figure 232](on page 380)).

- □ Not active object or group of objects.
- ✓ Active object or group of objects.
- □ Partly active group of objects.
The activation or deactivation of soil polygon clusters or structural objects or change of properties can introduce substantial out-of-balance forces. These out-of-balance forces are solved stepwise during the staged construction calculation process.

**Note:**
- The option to activate or deactivate objects should not be confused with the option to show or hide objects. A hidden object (invisible) may still be active.

### 7.11.2 Staged construction procedure in calculations

At the start of a calculation phase the information about active and inactive objects in the geometry model is transformed into information on an element level. Hence, deactivating a soil cluster results in 'switching off' the corresponding soil elements during calculation. The following rules apply to elements that have been switched off:

- Properties, such as weight, stiffness and strength, are not taken into account.
- All stresses are set to zero.
- All inactive nodes will have zero displacements.
- Boundaries that arise from the removal of elements are automatically taken to be free and permeable.
As a soil cluster is deactivated, the Water conditions are maintained. The water conditions of the deactivated soil cluster can be changed to model a dry excavation.

External loads that act on a part of the geometry that is inactive will not be taken into account.

For elements that have been inactive and that are (re)activated in a particular calculation, the following rules apply:

- Stiffness and strength will be fully taken into account from the beginning (i.e. the first step) of the calculation phase.
- Weight will, in principle, be fully taken into account from the beginning of the calculation phase. However, in general, a large out-of-balance force will occur at the beginning of a staged construction calculation since the initial stresses (if any) are not in equilibrium with the weight of the newly activated elements or loads. This out-of-balance force is stepwise solved in subsequent calculation steps.
- The stresses will develop from zero.
- When a node becomes active, an initial displacement is estimated by stressless pre-deforming the newly activated elements such that they fit within the deformed mesh as obtained from the previous step. Further increments of displacements are added to this initial value. As an example, one may consider the construction of a block in several layers, allowing only for vertical displacements (one-dimensional compression). Starting with a single layer and adding one layer on top of the first will give settlements of the top surface. If a third layer is subsequently added to the second layer, it will be given an initial deformation corresponding to the settlements of the surface.

The following rules apply for interfaces:

| Deactivated interfaces | The interfaces can be deactivated when modelling soil-structure interaction is not desired. Nodes generated for interfaces in mesh generation process are still there. They have stiff elastic behaviour; fully permeable (Consolidation analysis). |
| Activated interfaces | Elasto-plastic behaviour; fully impermeable (Consolidation analysis). |

7.11.3 Changing loads

During creation in the Geometry modes, a default value is given to a load which represents a unit load. These load values may be changed in each calculation phase to simulate changing loads in the various stages of construction. The change of loads can introduce substantial out-of-balance forces. These out-of-balance forces are solved during the staged construction calculation process.

7.11.4 Connections in Staged construction

Connections can be configured per phase. The active state of a connection does not affect the active state of the connecting plates. A warning message will be shown before calculation if a connection is active while one of its connected plates is inactive.
7.11.5 Reassigning material data sets

It is possible in a calculation phase to assign new material data sets to soil polygon or structural objects. This option may be used to simulate the change of material properties with time during the various stages of construction. The option may also be used to simulate soil improvement processes, e.g. removing poor quality soil and replacing it with soil of a better quality.

The change of certain properties, for example when replacing peat by dense sand, can introduce substantial out-of-balance forces due to a difference in unit weight. These out-of-balance forces are solved during the staged construction calculation process.

7.11.6 Applying volumetric strains in clusters

In addition to changing material properties for clusters, in PLAXIS 2D it is also possible to apply a Volumetric strain in individual soil clusters. This can be done in the Selection explorer by selecting the corresponding soil polygon and clicking the checkboxes corresponding to VolumetricStrain and to Apply (Figure 233 (on page 382)).

![Selection explorer](image)

Values can be defined for the two strain components in \(x\)- and \(y\)-direction and for volumetric strain. A positive value of the strain component represents an expansion, whereas a negative value represents a shrinkage in that direction.

In contrast to other types of loading, volumetric strains are not activated with a separate multiplier. Note that the imposed volumetric strain is not always fully applied, depending on the stiffness of the surrounding clusters and objects.
7.11.7  Prestressing of anchors and cable

Prestressing of Fixed-end anchors (on page 95) and Cables (on page 109) can be activated in the Object explorer for a selected phase. By default the Adjust prestress option is not selected. On selecting the Adjust prestress force check box it is possible to enter a value for the prestress force \( F_{\text{prestress}} \) in the corresponding edit box. A prestress force should be given in the unit of force. Note that tension is considered to be positive and compression is considered negative.

By default, in a calculation phase following a phase in which an anchor or a cable was prestressed, the prestress setting is NOT continued but the prestressing force is maintained. In this way, the existing anchor/cable force is used as a start condition and will develop 'naturally' based on changes of stresses and forces in the model. If you intend to again apply a prestress force, this has to be done explicitly following the same procedure as described above.

If a previously entered prestress force needs to be 'reset' to retain a standard active anchor/cable without prestressing but with an existing anchor/cable force, this should be done by de-selecting the Adjust prestress parameter in the Object explorer. It is generally NOT correct to set a prestress force to zero, since this will result in a zero anchor/cable force.

Different from anchors, cable CAN interact with the surrounding rock/soil. In practice, rock bolts, after installation, can be first tensioned to a certain level, before being grouted in a later stage of a construction project. This process can be simulated with the cable prestress facility (see Figure 76 (on page 115)). During the prestressing phases, PLAXIS automatically assumes that bond interaction is inactive, which is in line with engineering practice because during prestressing, the tensioning force is controlled and the element is normally left non-grouted. In this way, during the prestressing, cable elements work similarly as an anchor. Once the prestressing is finished, the user can deselect the prestress option, by doing so bond interaction with the surrounding rock mass will start to develop. Therefore, although prestress can be applied in multiple phases, these phases should be done successively after the element installation. Once bond interaction develops (by deselecting the prestress option), it is NOT recommended to prestress again in a later phase because this means that bond interaction is broken (reset to zero).

Another point is that, to be able to apply pretension to a cable element, the end part (embedded in the rock mass) should be practically bonded. Therefore, when a cable element is prestressed, the end node is fixed (tied) with the rock mass. During prestressing, this would create a local tensile force at that node. To avoid local failure, user should not forget to put a realistic rock tensile strength. A more realistic way to model the pretensioning process is that for each cable, users create 2 pieces to model explicitly a bonded part and a free part. As mentioned, the free part, after being prestressed, can also be bonded automatically by deselecting the prestress option. In this way, the pretensioning force can be transferred to the rock mass via an appropriate bonded length to avoid unrealistic localization.

7.11.8  Model conditions

The global boundary conditions for a selected phase can be defined in the Model conditions subtree in the Model explorer. Note that user-defined conditions always prevail over the ones defined in the Model conditions subtree.
7.11.8.1 Deformation

PLAXIS 2D automatically imposes a set of standard fixities to the boundaries of the geometry model. These conditions are generated according to the following rules.

**Soil polygon:**

- Vertical model boundaries with their normal in x-direction, are fixed in x-direction \((u_x=0)\) and free in y-direction.
- The model bottom boundary is fixed in all directions \((u_x = u_y = 0)\).
- The 'ground surface' is free in all directions.

The options available for the model boundaries are (defaults in square brackets):

<table>
<thead>
<tr>
<th>BoundaryXMin</th>
<th>Free, [Normally fixed], Horizontally fixed, Vertically fixed, Fully fixed</th>
</tr>
</thead>
<tbody>
<tr>
<td>BoundaryXMax</td>
<td>Free, [Normally fixed], Horizontally fixed, Vertically fixed, Fully fixed</td>
</tr>
<tr>
<td>BoundaryYMin</td>
<td>Free, Normally fixed, Horizontally fixed, Vertically fixed, [Fully fixed]</td>
</tr>
<tr>
<td>BoundaryYMax</td>
<td>[Free], Normally fixed, Horizontally fixed, Vertically fixed, Fully fixed</td>
</tr>
</tbody>
</table>

In the case that the model has no vertical model boundaries and/or no horizontal bottom boundary, prescribed displacements need to be defined in order to set the displacement boundary conditions.

*Figure 234: Boundary conditions*
**Structures:** Structures that extend to the model boundary, where at least one displacement direction is fixed, obtain a fixed rotation in the points at the boundary.

- At vertical model edges and at the bottom boundary: $\phi=0$.
- At the 'ground surface': $\phi=$ free.

**Note:**

- Note that the standard displacement fixities (Model conditions on page 383) apply to soil polygons and structures.
- User-defined prescribed displacements always prevail over the automatically defined fixities.

### 7.11.8.2 Dynamics boundary conditions [ULT]

For dynamics calculations, different boundary conditions than the standard fixities are required in order to represent the far-field behaviour of the medium. The reality is characterised by an infinite domain which has to be reduced to a finite domain when creating a geometry model. Appropriate boundary conditions can simulate the far-field behaviour by absorbing the increment of stresses caused by dynamic loading and avoiding spurious wave reflections inside the soil body. By default, PLAXIS 2D provides the option to use *Viscous* boundaries but other options are available as well.

When a *Dynamics* calculation is defined, the boundary conditions can be defined for the phase by selecting the proper options displayed when the *Dynamics* subtree is expanded under *Model conditions* in the *Model explorer* (Figure 235 on page 385).

![Figure 235: Boundary conditions for Dynamics calculations](image)

The options available for the model boundaries are (defaults in square brackets):

<table>
<thead>
<tr>
<th>BoundaryXMin</th>
<th>None, [Viscous], Free-field, Tied degrees of freedom</th>
</tr>
</thead>
</table>

**Meshing and calculation**

**Geometry configuration - Staged Construction mode**

---

*PLAXIS Reference Manual 2D*
### Meshing and calculation

Geometry configuration - Staged Construction mode

<table>
<thead>
<tr>
<th>BoundaryXMax</th>
<th>None, [Viscous], Free-field, Tied degrees of freedom</th>
</tr>
</thead>
<tbody>
<tr>
<td>BoundaryYMin</td>
<td>[None], Viscous, Compliant base</td>
</tr>
<tr>
<td>BoundaryYMax</td>
<td>[None], Viscous</td>
</tr>
<tr>
<td>All nodes fixities</td>
<td>[None], Fixed in x-direction, Fixed in y-direction</td>
</tr>
</tbody>
</table>

**Note:**
- Default *None* for XMin boundary in axi-symmetric models
- *Free-field* and *Tied degrees of freedom* conditions are ignored for axi-symmetric models

The meaning of these conditions is as follows:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Only the standard fixities are applied to this boundary. In earthquake analysis, this option can be used at the base of the geometry model in combination with a line prescribed displacement to simulate the boundary of two layers with a very high impedance contrast, for instance a soft soil layer over a rigid bedrock. This results in a full reflection of downward propagating waves.</td>
</tr>
<tr>
<td>Viscous</td>
<td><em>Viscous</em> boundaries absorb the outgoing wave energy. This boundary condition corresponds to a situation in which viscous dampers are applied in the x and y direction along the boundary providing a resistant force in the normal and tangential direction at the boundary that is proportional to the velocity in the near-boundary material. The <em>Viscous</em> boundary condition has been introduced by [Lysmer &amp; Kuhlmeyer (1969)](on page 587). This option is suitable for problems where the dynamic load source is inside the mesh. If a <em>Viscous boundary</em> is selected at the base of the model for a seismic analysis, the required input has to be a load history. The <em>Relaxation coefficients</em> $C_1$ and $C_2$ need to be considered (see Scientific Manual - Model Boundaries).</td>
</tr>
</tbody>
</table>
The *Free-field* boundary condition is only available for the lateral boundaries (i.e. $x_{\text{min}}$ and $x_{\text{max}}$) and simulates the propagation of waves into the far field with minimum reflection at the boundary. Free field elements can be modelled at both sides of the main domain and are characterised by the same properties as the soil layers inside the mesh. The free field motion is transferred from the free field elements to the main domain by applying equivalent normal and shear forces. Two dashpots are added, in the normal and shear direction, at each node of the lateral boundary, to adsorb the waves reflected from the internal structures (**Figure 236** (on page 387)). This option requires the creation of interface elements along the vertical model boundaries in the *Structures mode*. The interface elements must be added inside the model, else the *Free-field* boundary condition will be ignored. If this option is selected for one of the vertical model boundaries, it must also be selected for the opposite vertical model boundary. This option is preferred for earthquake analysis, where the dynamic load input is applied along the model bottom boundary. The input motion is then also applied at the base of the free-field elements.

**Figure 236: Free field boundary condition**
<table>
<thead>
<tr>
<th>Compliant base</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <em>Compliant base</em> boundary condition is only available for the base ($y_{\text{min}}$) of the model and simulates the continuation of waves into the deep soil with minimum reflection at the bottom boundary. The compliant base ([Joyner &amp; Chen (1975)](on page 587)) is made up of a combination of a line prescribed displacement and a viscous boundary. The input signal (i.e. a displacement, velocity or acceleration time history) is transferred to the main domain by applying equivalent normal and shear forces. The viscous boundary consists of a series of dashpots, in the normal and shear direction, at each node of the base, to adsorb downward propagating compressive and shear waves. Note that only upward propagating waves should be considered in the signal applied at a compliant base boundary. In the case of a bedrock layer, this can be defined by taking only half of the input value of the corresponding prescribed displacement (e.g. 0.5 m instead of 1.0 m), together with the bedrock outcropping motion as dynamics multiplier. The combination of a load history and a viscous boundary allows for input of an earthquake motion while still absorbing outgoing waves. In earthquake analysis, this option can be used for site response analysis as well as for dynamic soil-structure interaction analysis where the model bottom boundary is within a homogeneous layer of soil or bedrock with a high shear wave velocity. In the case of a bedrock layer, it is recommended to include 1 m (3 ft) of bedrock at the base of the model below which the compliant based boundary is applied. Downward propagating waves from the main domain are free to propagate to the underlying layer which is not included in the finite element mesh. The equivalent forces are calculated taking into account the soil layer at the base. This option requires the presence of interface elements along the bottom boundary in the <em>Structures mode</em>. The interface elements must be added inside the model, else the <em>Compliant base</em> boundary condition will be ignored.</td>
</tr>
</tbody>
</table>
The tied degree of freedom are only available for the lateral boundaries (i.e. $x_{\text{min}}$ and $x_{\text{max}}$). This option, proposed by References (on page 586), connects the nodes on the same elevation at the left and right model boundaries, such that they are characterised by the same vertical and horizontal displacement (Figure 237 (on page 389)). This option may be chosen to model a one dimensional soil column to perform a site response analysis. If this option is selected for one of the vertical model boundaries, it must also be selected for the other vertical model boundary. The Tied degrees of freedom only work when the boundaries are free to move, i.e. no fixities should be applied on the vertical boundaries. In most cases, this will mean that the default fixities should be switched off during the dynamic analysis and that the desired boundary condition at the bottom should be applied. The Tied degrees of freedom can only be applied if the distribution of nodes along the vertical model boundaries is identical. In other word, the corresponding nodes left and right should have the same y-coordinate.

**Figure 237: Tied degrees of freedom**

<table>
<thead>
<tr>
<th>Tied degrees of freedom</th>
<th>$\Delta x_i^L = \Delta x_i^R$</th>
<th>$\Delta y_i^L = \Delta y_i^R$</th>
<th>(i = 1, 2, \ldots N)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed in x-direction</td>
<td>All nodes at the boundary are fixed in x direction.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fixed in y-direction</td>
<td>All nodes at the boundary are fixed in y direction.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:**

- Viscous boundaries do not consider additional forces from structural elements. Hence when using viscous boundaries, do not use structural elements at these boundaries.
- Free field and compliant base boundaries can be used in both Dynamics and Dynamics with consolidation calculations. Note, however, that the formulation of these boundary conditions only considers displacement degrees of freedom, as in Dynamics calculations. This means that in a Dynamics with consolidation calculation, a proper selection of the type of drainage is required for the materials adjacent to the free field and/or compliant base boundaries to simulate either drained or undrained response at those locations. Indeed, for this particular type of calculation, this is different from what happens in the main model where both displacement and excess pore pressure degrees of freedom exist and, therefore, excess pore pressures are the result of the permeability of the materials, GW flow boundary conditions and mechanical response (i.e. a coupled formulation is employed).
Meshing and calculation
Geometry configuration - Staged Construction mode

- By default, *Free-field* or *Compliant base* elements are not displayed in the Output program. In order to be able to visualise the movement in the *Free-field* or *Compliant base*, a (inactive) geogrid or plate element can be added at these boundaries. Note that during calculations such a plate or geogrid must remain inactive.
- Tied degrees of freedom can only be applied if the distribution of nodes along the vertical model boundaries is identical. In other words, the corresponding nodes left and right should have the same y-coordinate.

The *Relaxation coefficients* $C_1$ and $C_2$ are used to improve the wave absorption on the viscous boundaries. $C_1$ corrects the dissipation in the direction normal to the boundary and $C_2$ does this in the tangential direction. If the boundaries are subjected only to waves that come in perpendicular to the boundary, relaxation is not necessary ($C_1 = C_2 = 1$). When there are waves in arbitrary direction (which is normally the case), $C_2$ has to be adjusted to improve the absorption. The standard values are $C_1 = 1$ and $C_2 = 1$.

Note that the *Compliant base* and *Free field* conditions requires the manual creation of interface elements along the full model boundary, which enable the creation of a so called node pair. Between the two nodes of a node pair a viscous damper is created which allows to transfer the input motion and absorb the incoming waves. In the *Output* program only the parameters related to one side of the node pair can be visualised, i.e. the motion in these nodes is not equal to the input motion. To be able to see and to explicitly check the input motion, it is possible to create a so called 'dummy plate', i.e. a plate at the bottom line of the model, characterised by very low stiffness parameters so that it does not influence the results. A node has to be selected on the plate to be able to compare the motion in this node with the input signal. There is no specific need to activate the dummy plate during the calculation.

### 7.11.8.3 Field stress

The *Field stress* conditions option can be used when using the calculation type *Field stress* for initial phase calculation. This is used to specify rotated principal stresses as the initial stress conditions. This option can be selected in the *Model conditions* subtree in the *Model explorer* (See Figure 238 (on page 391)).
The parameters used to define field stress are:

| \(\sigma_1\) | The principal stress in first direction |
| \(\sigma_2\) | The principal stress in second direction |
| \(\sigma_3\) | The principal stress in third direction |
| Axis 1       | Direction of the first principal stress |
| Axis 2       | Direction of the second principal stress |

**Note:**
- Note that the calculation is considered with \(\Sigma M_{\text{weight}}\) as zero.
- Water weight is not considered when performing this type of calculation, but external loads may be applied if necessary.
- All model boundaries must be set to *Fully fixed* to ensure shear stress condition is simulated.

Refer to Initial stress generation (on page 318) for a more elaborate description of the Field stress option.
7.11.8.4 Groundwater flow boundary conditions [ADV]

The flow boundary conditions of a phase (at least which boundaries are 'open' and which are 'closed') can be specified in the GroundwaterFlow subtree under Model conditions in the Model explorer (See Figure 239 (on page 392)).

![Figure 239: Boundary conditions for groundwater flow](image)

Such boundary conditions are required for a groundwater flow calculation, a consolidation analysis or a fully coupled flow-deformation analysis. More information regarding the flow boundary conditions is available in Flow boundary conditions [ADV] (on page 376).

7.11.8.5 Precipitation [ADV]

The Precipitation subtree in the Model explorer (Figure 240 (on page 393)) can be used to specify a general vertical recharge or infiltration \(q\) due to weather conditions. This condition is applied at all boundaries that represent the ground surface. More information on Precipitation is available in Precipitation [ADV] (on page 376).
Meshing and calculation
Geometry configuration - Staged Construction mode

7.11.8.6 Pseudo-Static [ADV]

Dynamic forces can be considered in a pseudo-static way by specifying a global acceleration (Figure 241 (on page 393)). A specified global acceleration is taken into consideration in Gravity loading, Plastic, Consolidation and Safety calculation type. Note that in a Safety analysis the settings of the parent phase are considered. It is possible to perform a safety analysis of a pseudo-static parent phase, however a change of global accelerations cannot be specified for the Safety phase itself.

When performing a groundwater flow calculation, the specified global accelerations are composed with the gravity affecting the unit weight of water used in the calculation of the pore water pressures.

Figure 240: The Precipitation subtree in the Model explorer

Figure 241: The PseudoStatic subtree in the Model explorer
7.11.8.7 Water
The global water level in a calculation phase can be defined in the Water subtree (Figure 242 (on page 394)). More information on Global water level is available in Assigning water conditions to soil polygons (on page 373).

![Figure 242: The Water subtree in the Model explorer](image)

7.12 Special option for User Defined Soil Models [ADV]
The General section of the calculation parameters allows setting a Special option parameter. This parameter may be used in user-defined soil models to trigger a particular event or action at the beginning of the calculation phase based on the value of this parameter. The Special option parameter does not affect standard PLAXIS functionality.

7.13 Starting a calculation
When a calculation phase has been defined, its calculation can be started.

7.13.1 Previewing a construction stage
When a construction stage is fully defined, a view of the situation can be presented by pressing the Preview phase button in the side toolbar. This enables a direct visual check before the calculation is started. The active part of the model is presented in the Output program.
See Output program - General overview (on page 405) for more details on the inspection of models in the Output program. After the preview, press the Close button to return to the Calculation mode.

7.13.2 Selecting points for curves

After the calculation phases have been defined and before the calculation process is started, some points may be selected by the user for the generation of load-displacement curves or stress paths by clicking the Select points for curves button or by selecting this option in the Tools menu.

Nodes should be selected to plot displacements, whereas stress points should be selected to plot stresses and strains. Selection of points is described in detail in Selecting points for curves (on page 474).

7.13.3 Execution of the calculation process

When calculation phases have been defined and points for curves have been selected, then the calculation process can be executed. Before starting the process, however, it is useful to check the list of calculation phases. In principle, all calculation phases indicated with a blue arrow (→) will be executed in the calculation process. By default, when defining a calculation phase, it is automatically selected for execution. A previously executed calculation phase is indicated by a green tick mark (✓) if the calculation was successful, otherwise it is indicated by a red cross (×). To select or deselect a calculation phase for execution, the button in front of the phase should be clicked in the Phases window.

Alternatively, right click the corresponding line and select Mark for calculation or Unmark for calculation in the appearing menu.

7.13.3.1 Starting the calculation process

The calculation process can be started by clicking the Calculate button in the tool bar. As a result, the program first performs a check on the ordering and consistency of the calculation phases. In addition, the first calculation phase to be executed is determined and all selected calculation phases in the list are subsequently executed, provided that failure does not occur.

7.13.4 Aborting a calculation

If, for some reason, the user decides to abort a calculation, this can be done by pressing the Stop button in the separate window that displays information about the iteration process of the current calculation phase.

If the Stop button is pressed, the total specified load will not be applied. In the Phases explorer the phase is preceded by a red cross and in the General subtree in the Phases window the following message is displayed in the Log info box: Cancelled.

In addition to aborting a calculation permanently, it is also possible to abort the calculation temporarily by clicking the Pause button. The calculation will be resumed after clicking the Resume button.
7.13.5 Output during calculations

During a 2D finite element deformation analysis, information about the calculation process is presented in a separate window (Figure 243 (on page 396)). The phase being calculated is indicated in the Phase tabs.

![Active tasks window](image)

*Figure 243: The Active tasks window*

**Note:**
Parallel calculation is possible on multi-core computers when phases have the same parent phase.
7.13.5.1 Kernel information

<table>
<thead>
<tr>
<th>Start time</th>
<th>The time indicating the start of the calculation is displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory used</td>
<td>The memory occupied by the calculation process is displayed.</td>
</tr>
</tbody>
</table>

7.13.5.2 Total multipliers at the end of the previous loading step

<table>
<thead>
<tr>
<th>$\Sigma M_{\text{dispX}} \Sigma M_{\text{dispY}}$</th>
<th>Indicates the portion of the defined prescribed displacement applied in the current phase.</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\Sigma M_{\text{loadA}}$</td>
<td>Indicates the portion of the defined load applied in the current phase. In PLAXIS 2D this value is always 1 since load is applied as a staged construction process changing the input value of the load rather than the multiplier.</td>
</tr>
<tr>
<td>$\Sigma M_{\text{weight}}$</td>
<td>Indicates the total proportion of the material weights applied in a calculation. Its value is 0 at the beginning of the calculation and changes to 1.000, indicating that all the materials weight is applied.</td>
</tr>
<tr>
<td>$\Sigma M_{\text{accel}}$</td>
<td>The value of this parameter is always 0.</td>
</tr>
<tr>
<td>$\Sigma M_{\text{sf}}$</td>
<td>This parameter is related to the Safety analysis. It is defined as the ratio of the original strength parameters and the reduced strength parameters at a given stage of analysis. Its value is 1.000 at the beginning of an analysis. The increment of the strength reduction of the first calculation step is described in Safety calculation (phi/c reduction) (on page 326).</td>
</tr>
<tr>
<td>$\Sigma M_{\text{stage}}$</td>
<td>It gives the completed proportion of a plastic calculation. Its value is always 0 at the start of the calculation and it will be 1.000 at the end of a successful calculation. For other analysis types (Consolidation and Safety) it is always 0.</td>
</tr>
<tr>
<td>$P_{\text{excess, max}}$</td>
<td>It represents the maximum excess pore pressure in the mesh, expressed in the units of stress. $P_{\text{excess, max}}$ is available in the deformation calculation tabsheet of the Active task window for the Plastic, Consolidation, Safety and Dynamic calculation types.</td>
</tr>
<tr>
<td>$P_{\text{active, max}}$</td>
<td>It represents the maximum active pore pressure in the mesh in Fully coupled flow-deformation analysis, expressed in the units of stress.</td>
</tr>
<tr>
<td>$P_{\text{steady, max}}$</td>
<td>It represents the maximum steady state pore pressure in the mesh, expressed in the units of stress. $P_{\text{steady, max}}$ is only available for Flow only calculation types.</td>
</tr>
<tr>
<td>$\Sigma M_{\text{area}}$</td>
<td>It indicates the proportion of the total area of soil clusters in the geometry model that is currently active.</td>
</tr>
<tr>
<td>$\Sigma F_x \Sigma F_y$</td>
<td>These parameters indicate the reaction forces corresponding to the non-zero prescribed displacements.</td>
</tr>
</tbody>
</table>
Meshing and calculation
Starting a calculation

| Stiffness | The Stiffness parameter gives an indication of the amount of plasticity that occurs in the calculation. The Stiffness is defined as:
|           | \[ \text{Stiffness} = \frac{\int \Delta \varepsilon \cdot \Delta \sigma}{\int \Delta \varepsilon D \Delta \varepsilon} \]
|           | When the solution is fully elastic, the Stiffness is equal to unity, whereas at failure the stiffness approaches zero. The Stiffness is used in determining the Global error. See [Automatic error checks](on page 401) for more details.
| Time      | The current time within the specified time interval of the loading input for the calculated phase, defined in the **General** subtree in the **Phases** window.
| Dyn. time | The current dynamic time within the specified time interval of the loading input for the calculated phase, defined in the **General** subtree of the **Phases** window.

7.13.5.3 Calculation progress
A small load-displacement curve for one of the pre-selected nodes for curves is shown in the Calculation progress group box. By default, the curve is shown for the first selected node. Curve for other pre-selected nodes is shown when the node is selected in the drop-down menu. The presented graph may be used to roughly evaluate the progress of the calculation.

| Plastic analysis | For a plastic analysis the development of the \( \Sigma M_{\text{stage}} \) parameter is plotted against the displacement.
| Consolidation analysis | In case of a Consolidation analysis, the maximum excess pore pressure, \( P_{\text{excess,max}} \), in case of a Consolidation analysis based on excess pore pressure or the maximum active pore pressure, \( P_{\text{active,max}} \), in case of a Consolidation analysis based on total pore pressure is plotted against the logarithm of time.
| Fully coupled flow-deformation analysis | In case of a Fully coupled flow-deformation analysis, the maximum active pore pressure, \( P_{\text{active,max}} \), is plotted against the logarithm of time.
| Safety analysis | In case of Safety analysis, the development of \( \Sigma M_f \) is plotted against the displacement.
| Dynamic analysis | In case of Dynamic analysis, the displacement is plotted against the dynamic time.
| Dynamic with consolidation analysis | In case of Dynamic with consolidation analysis, the displacement is plotted against the dynamic time.
| Steady state groundwater flow | In case of Steady state groundwater flow, the maximum steady pore pressure, \( P_{\text{steady,max}} \), at steady state is plotted.
| Transient groundwater flow | In case of Transient groundwater flow, the maximum steady pore pressure, \( P_{\text{steady,max}} \), is plotted against the logarithm of time.
### 7.13.5.4 Iteration process of current step

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current step</td>
<td>Indicates the number of the current calculation step.</td>
</tr>
<tr>
<td>Iteration</td>
<td>Indicates the number of the iterations in the current calculation step.</td>
</tr>
<tr>
<td>Global error</td>
<td>The value of this error is an indication of the global equilibrium error within the calculation step. As the number of iterations increases, its value tends to decrease. For further details on this parameter see [Automatic error checks](on page 401).</td>
</tr>
<tr>
<td>Max. local error in flow</td>
<td>The value of this error is an indication of possible entrapment of water in saturated regions in the current calculation step. The tolerated value is 0.05.</td>
</tr>
<tr>
<td>Relative change in saturation</td>
<td>The value is an indication of variation of saturation degree in consecutive calculation steps. The tolerated value is 0.1. When the relative change in saturation is higher than the tolerated value, the time step is automatically decreased. When the relative change in saturation is lower than the tolerated value, the time step is automatically increased. Note that the values of the time step are always in the range defined by Desired minimum and Desired maximum parameters.</td>
</tr>
<tr>
<td>Relative change in relative permeability</td>
<td>The value is an indication of variation of relative permeability in consecutive calculation steps. The tolerated value is 0.1. When the relative change in relative permeability is higher than the tolerated value, the time step is automatically decreased. When the relative change in relative permeability is lower than the tolerated value, the time step is automatically increased. Note that the values of the time step are always in the range defined by Desired minimum and Desired maximum parameters.</td>
</tr>
<tr>
<td>Max. step</td>
<td>Indicates the last step number of the current calculation phase according to the Max steps parameter defined in the Numerical control parameters subtree in the Phases window.</td>
</tr>
<tr>
<td>Max. iterations</td>
<td>The value of Maximum iteration steps for the calculated phase, defined for the Iterative procedure in the Numerical control parameters subtree in the Phases window.</td>
</tr>
<tr>
<td>Tolerance</td>
<td>This value indicates the maximum global equilibrium error that is allowed. The value of the tolerance corresponds to the value of the Tolerated error in the settings for the iterative procedure. The iteration process will at least continue as long as the Global error is larger than the Tolerance. For details see [Automatic error checks](on page 401).</td>
</tr>
<tr>
<td>Element</td>
<td>The number of soil elements in the calculated phase.</td>
</tr>
<tr>
<td>Decomposition</td>
<td>Progress of the decomposition of the phase being calculated.</td>
</tr>
<tr>
<td>Calc. time</td>
<td>Indicates the calculation time of the current calculation step.</td>
</tr>
</tbody>
</table>

### 7.13.5.5 Plastic points in current step

| Plastic stress points | The total number of stress points in soil elements that are in plastic state.                           |
### Plastic interface point

The total number of stress points in interface elements that are in plastic state.

### Inaccurate

This value indicates the number of plastic stress points in soil elements and interface elements respectively, for which the local error exceeds the tolerated error.

### Tolerated

This value indicates the maximum number of inaccurate stress points in soil elements and interface elements respectively that are allowed. The iteration process will at least continue as long as the number of inaccurate points is larger than the tolerated number.

### Tension points

A **Tension point** is a point that fails in tension. These points will develop when the Tension cut-off is used in any of the material sets in the model. This parameter indicates the total number of points that fail in tension.

### Cap/Hardening points

- **Cap point** occurs if the Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model or Soft Soil Creep model are used and the stress state in a point is equivalent to the preconsolidation stress, i.e. the maximum stress level that has previously been reached ($OCRs_{1.0}$). A **Hardening point** occurs if the Hardening Soil model or Hardening Soil model with small-strain stiffness is used and the stress state in a point corresponds to the maximum mobilised friction angle that has previously been reached.

### Apex points

These are special plastic points where the allowable shear stress is zero. The iterative procedure tends to become slow when the number of plastic apex points is large. Apex points can be avoided by selecting the Tension cut-off option in the material datasets for soil and interfaces.

### 7.13.5.6 Calculation status

The calculation status indicates what part of the calculation process is currently being executed. The following processes are indicated:

- **Decomposition...** Decomposing the global stiffness matrix.
- **Stresses...** Calculating the strain increments and constitutive stresses.
- **Write results...** Writing output data to disk.

### 7.13.5.7 Previewing intermediate results during calculation

The **Preview** button in the Active tasks window enables previewing the results of the intermediate calculation steps of the phase being calculated. The intermediate steps are listed in the drop-down menu (Selection of results (on page 422)) and the list is updated when the calculation of new intermediate steps is complete.

The results of the intermediate calculation steps can be used in curves as well. When a curve is created, the newly calculated steps can be included in the plot by using the Regenerate button available in the Settings window (Regeneration of curves (on page 500)).
Note that when the calculation of the phase is completed, a warning will appear indicating that the intermediate results are no longer available. A more detailed description on how to display the results of a calculated phase is given in Selecting calculation phases for output (on page 401).

7.13.6 Selecting calculation phases for output

After the calculation process has finished, the calculation list is updated. Calculation phases that have been successfully finished are indicated by a green tick mark (✓), whereas phases that did not finish successfully are indicated by a red cross (×). In addition, messages from the calculations are displayed in the Log info box of the General tabsheet.

When a calculation phase is selected that has been executed, the tool bar will show the View results button. Clicking this button will directly display the results of the selected phase in the Output program.

7.13.7 Adjustment to input data in between calculations

Be careful when changing the input data (in the Input program) in between calculation phases. In general, this should not be done since it causes the input to cease to be consistent with the calculation data. In most cases there are other ways to change data in between calculation phases instead of changing the input data itself.

7.13.7.1 Modification of geometry

When the geometry is slightly modified (small relocation of objects, slight modification of their geometry or deleting objects) in the Input program, the program will try to regenerate all data related to construction stages as soon as mesh regeneration is performed. However, in the Calculations program, the user has to check the construction stages carefully, since some settings may not have been generated properly. The calculation process must restart from the initial phase. If significant changes in the geometry are made then all settings need to be redefined, since PLAXIS 2D is not able to properly regenerate the settings automatically.

7.13.7.2 Modification of material parameters and feature properties

When changing material properties in existing data sets without changing the geometry, then all calculation information is retained as well. In this case, clusters refer to the same data sets, but the properties as defined in these data sets have changed. However, this procedure is not very useful, since PLAXIS 2D allows for a change of data sets within the Staged construction calculation option (Reassigning material data sets (on page 381)). Hence, it is better to create the data sets that will be used in later calculation phases beforehand and to use the Staged construction option to change data sets during calculations. The same applies to a change in water pressures and a change in input values of existing loads, since the latter is also possible using the Staged construction option (Geometry configuration - Staged Construction mode (on page 379) and Water pressure calculation (on page 340)).
7.13.8 Automatic error checks

During each calculation step, the PLAXIS 2D calculation kernel performs a series of iterations to reduce the out-of-balance errors in the solution. To terminate this iterative procedure when the errors are acceptable, it is necessary to establish the out-of-equilibrium errors at any stage during the iterative process automatically.

Two separate error indicators are used for this purpose, based on the measure of either the global equilibrium error or the local error. The values of both of these indicators must be below predetermined limits for the iterative procedure to terminate. These two error indicators and the associated error checking procedures are described below.

7.13.8.1 Global error check

The global error checking parameter used in the PLAXIS 2D calculation kernel is related to the sum of the magnitudes of the out-of-balance nodal forces. To obtain this parameter, the out-of-balance loads are non-dimensionalised as shown below:

\[
\text{Global error} = \frac{\sum \text{Out of balance nodal forces}}{\sum \text{Active loads} + \text{CSP} \cdot \sum \text{Inactive loads}}
\]

where the Out-of-balance nodal forces are the difference between the external loads and the forces that are in equilibrium with the current stresses, the Active loads are the load difference between the actual calculation and the previous calculation phase (when \(\sum M_{\text{stage}} = 0\) the Active loads are equal to the Out-of-balance nodal forces) and the Inactive loads are the active loads from the previous calculation phases.

In case of a flow calculation, the out-of-balance nodal flux will be used instead of the out-of-balance nodal forces.

CSP is the current value of the Stiffness parameter, defined as:

\[
\text{Stiffness} = \frac{\Delta e \cdot \Delta o}{\Delta e D \Delta e}
\]

which is a measure for the amount of plasticity that occurs during the calculation. See the Material Models Manual - Preliminaries on material modelling - Elastic strains for more information on the stiffness parameters. When the solution is fully elastic, the Stiffness is equal to unity, whereas at failure the Stiffness approaches zero. In the latter case the global error will be larger for the same out of balance force. Hence, it will take more iterations to fulfill the tolerance. This means that the solution becomes more accurate when more plasticity occurs.

7.13.8.2 Additional error check for structures

In case structures with rotational degree of freedom are included in the model, further checks are performed to ensure the robustness of the solution. The additional error check (AEC) for structures is defined as:

\[
\text{AEC for structures} = \frac{\max \| \text{Out of balance structure nodal moments} \|}{\max \| \text{Structures nodal moments} \|}
\]

where \(\max \| \text{Out of balance structure nodal moments} \|\) is the maximum out-of-balance moment of the structure nodes and \(\max \| \text{Structure nodal moments} \|\) is the maximum bending moment from the stress integration of all structures. In case of elastic structures, the \(\max \| \text{Out of balance structure nodal moments} \|\) is equal to 0.
7.13.8.3 Local error check

Local errors refer to the errors at each individual stress point. To understand the local error checking procedure used in PLAXIS 2D it is necessary to consider the stress changes that occur at a typical stress point during the iterative process. The variation of one of the stress components during the iteration procedure is shown in the figure below.

![Figure 244: Equilibrium and constitutive stresses](image)

At the end of each iteration, two important values of stress are calculated by PLAXIS 2D. The first of these, the 'equilibrium stress', is the stress calculated directly from the stiffness matrix (e.g. point A in Figure 244). The second important stress, the 'constitutive stress', is the value of stress on the material stress-strain curve at the same strain as the equilibrium stress, i.e. point B in Figure 244.

The dashed line in Figure 244 indicates the path of the equilibrium stress. In general, this equilibrium stress path depends on the nature of the stress field and the applied loading. For the case of a soil element obeying the Mohr-Coulomb criterion, the local error for the particular stress point at the end of the iteration is defined:

\[
\text{Local error} = \left\| \frac{\sigma^e - \sigma^c}{T_{\text{max}}} \right\|\quad \text{Eq. [96]}
\]

In this equation the numerator is a norm of the difference between the equilibrium stress tensor, \(\sigma^e\), and the constitutive stress tensor, \(\sigma^c\). This norm is defined by:

\[
\left\| \sigma^e - \sigma^c \right\| = \sqrt{(\sigma_{xx}^e - \sigma_{xx}^c)^2 + (\sigma_{yy}^e - \sigma_{yy}^c)^2 + (\sigma_{zz}^e - \sigma_{zz}^c)^2 + (\sigma_{xy}^e - \sigma_{xy}^c)^2 + (\sigma_{yx}^e - \sigma_{yx}^c)^2 + (\sigma_{zx}^e - \sigma_{zx}^c)^2}\quad \text{Eq. [97]}
\]

The denominator of the equation for the local error is the maximum value of the shear stress as defined by the Coulomb failure criterion. In case of the Mohr-Coulomb model, \(T_{\text{max}}\) is defined as:

\[
T_{\text{max}} = \max \left( \frac{1}{2} (\sigma_3 - \sigma_1), \ c \cdot \cos \phi \right)\quad \text{Eq. [98]}
\]

When the stress point is located in an interface element the following expression is used:
Local error = \( \frac{\sqrt{(\sigma_n^e - \sigma_n^c)^2 + (\tau^e - \tau^c)^2}}{c_i - \sigma_n^c \tan \varphi_i} \)  \hspace{1cm} \text{Eq. [99]}

where \( \sigma_n \) and \( \tau \) represent the normal and shear stresses respectively in the interface. To quantify the local accuracy, the concept of \textit{inaccurate plastic points} is used. A plastic point is defined to be inaccurate if the local error exceeds the value of the user specified \textit{tolerated error} (Numerical control parameters (on page 356)).

7.13.8.4 Termination of iterations

For PLAXIS 2D to terminate the iterations in the current load step, all of the following four error checks must be satisfied. For further details of these error-checking procedures, see Vermeer & van Langen (1989) (on page 588).

\[
\begin{align*}
\text{Maximum global error} & \leq \text{Tolerated error} \\
\text{No. of inaccurate soil points} & \leq 3 + \frac{\text{No. of plastic soil points}}{10} \\
\text{No. of inaccurate interface points} & \leq 3 + \frac{\text{No. of plastic interface points}}{10} \\
\text{No. of inaccurate structure points} & \leq 3 + \frac{\text{No. of plastic structure points}}{10}
\end{align*}
\]  \hspace{1cm} \text{Eq. [100]}

where \textit{Maximum global error} is the maximum between the \textit{Global error} and the \textit{Additional error check for structures}. The \textit{Maximum global error} is the only one displayed during calculations.
This icon represents the Output program.

The main output quantities of a finite element calculation are the displacements and the stresses. In addition, when a finite element model involves structural elements, the structural forces in these elements are calculated. An extensive range of facilities exists within the PLAXIS 2D Output program to display the results of a finite element analysis. This chapter gives a description of the features available in the program.

If the Output program is activated by running its executable file or by clicking the Output program button in the Input program, the user has to select the model and the appropriate calculation phase or step number for which the results are to be viewed. More options on how to activate the Output are given in Accessing the Output program (on page 416).

When a particular project is selected, the file requester displays the corresponding list of calculation phases from which a further selection should be made. If it is desired to select an intermediate calculation step, then a single mouse click should be given on the plus icon (+) at the left of the desired phase. As a result, the calculation list expands a list with all available step numbers for this phase, from which the desired step number can be selected.
8.1 Layout of the Output program

The layout of the Output program is shown below:

![Main window of the Output program](image)

**Figure 246: Main window of the Output program**

8.1.1 Title bar

The title bar gives information about the project name, the step number and the type of information/results displayed.

8.1.2 Menu bar

The menu bar contains all output items and operations facilities of the Output program ([Menus in the Menu bar](on page 407)).
8.1.3 Toolbars

Buttons for different features in the Output program are located above and at the left side of the plot area. A hint about the function of each tool is given as the cursor is located on it.

8.1.4 Plot area

The calculation results are displayed in the Plot area. The results can be displayed in graphical or tabular form. More information on how to handle the plot is given in Display area (on page 431).

8.1.5 Status bar

The status bar displays the locations of the cursor and the viewpoint and a hint about the object in the model and their element numbers.

8.1.6 Command line

PLAXIS 2D Output program enables to carry out certain actions using keyboard input by typing the corresponding commands in the command line.

More information about the available commands is provided when the Command reference option of the Help menu is selected.

8.1.7 Explorers

Information about the model and the project is given in the explorer.

| Model explorer | It displays the properties of all the geometry objects and the features assigned to them in the model and gives the possibility to hide/show, activate/deactivate these objects, see the Model explorer (on page 39). |

8.2 Menus in the Menu bar

The menu bar contains drop-down menus covering the options available in the Output program. The main results from a finite element calculation are deformations and stresses. Hence, these two aspects form the major part of the Output menu. When displaying a basic 2D geometry model, the menu consists of the File, View, Project, Geometry, Mesh, Deformations, Stresses, Tools, Window and Help menus. Note that the availability of the menus in the bar depends on the type of data that is presented on the output form.
### 8.2.1 File menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open project</td>
<td>To open the output of an existing project.</td>
</tr>
<tr>
<td>Close active project</td>
<td>To close all forms of the active project.</td>
</tr>
<tr>
<td>Close all projects</td>
<td>To close all forms of all opened projects.</td>
</tr>
<tr>
<td>Work directory</td>
<td>Set the default directory where PLAXIS 2D project files are stored.</td>
</tr>
<tr>
<td>Export to Paraview (Tech. Preview)</td>
<td>To export PLAXIS results to the visualization tool Paraview.</td>
</tr>
<tr>
<td>Export to file</td>
<td>To export the information displayed, depending on the information type, to a text file (for results in tables) or image file (for plot).</td>
</tr>
<tr>
<td>Report generator</td>
<td>To generate a report of the project.</td>
</tr>
<tr>
<td>Create animation</td>
<td>Create an animation from selected output steps. The Create animation window is presented.</td>
</tr>
<tr>
<td>Print...</td>
<td>To print the active output on a selected printer.</td>
</tr>
<tr>
<td>(List of recent projects)</td>
<td>A list of the five most recent projects.</td>
</tr>
<tr>
<td>Exit</td>
<td>To leave the output program.</td>
</tr>
</tbody>
</table>

### 8.2.2 View menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom out</td>
<td>To restore to view before the most recent zoom action.</td>
</tr>
<tr>
<td>Reset view</td>
<td>To restore the original plot.</td>
</tr>
<tr>
<td>Save view</td>
<td>To save the current view (image or table). The saved views can be included in a report of the project.</td>
</tr>
<tr>
<td>Show saved views</td>
<td>To open or delete saved views.</td>
</tr>
<tr>
<td>Scale</td>
<td>To modify the scale factor of the presented quantity.</td>
</tr>
<tr>
<td>Legend settings...</td>
<td>To modify the range of values of the presented quantity in contour line plots and plots with shadings.</td>
</tr>
</tbody>
</table>
# Output program - General overview
## Menus in the Menu bar

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan line</td>
<td>To change the scan line for displaying contour line labels. After selection, the scan line must be drawn using the mouse. Press the left mouse button at one end of the line; hold the mouse button down and move the mouse to the other end. A contour line label will appear at every intersection of the scan line with a contour line.</td>
</tr>
<tr>
<td>Use result smoothing</td>
<td>To reduce the numerical noise resulting from the extrapolation of the results obtained in stress points (e.g. stress, force) to nodes. This option is available for plots and tables. Note that the option is by default selected in plot presentation of the results.</td>
</tr>
<tr>
<td>Ignore transitions</td>
<td>To smoothen the results for stresses and strains for different structural elements if the nodes are at the same position irrespective of the axis, however, it does not smooth the elements if they have different material set.</td>
</tr>
<tr>
<td>Rulers</td>
<td>To toggle the display of the rulers along the active plot.</td>
</tr>
<tr>
<td>Title</td>
<td>To toggle the display of the title of the active plot in the caption.</td>
</tr>
<tr>
<td>Model explorer</td>
<td>To toggle the model explorer panel.</td>
</tr>
<tr>
<td>Legend settings...</td>
<td>To modify the range of values of the presented quantity in contour line plots and plots with shadings.</td>
</tr>
<tr>
<td>Axes</td>
<td>To toggle the display of the global $x$- and $y$-axes in the active plot (displayed in the lower right corner).</td>
</tr>
<tr>
<td>Command line</td>
<td>To toggle the command line situated the bottom of the window.</td>
</tr>
<tr>
<td>Hide panels</td>
<td>To hide all the panels in the Output program.</td>
</tr>
<tr>
<td>Settings</td>
<td>To set various graphical attributes, such as object and background colours, symbol size, font size and diffuse shading.</td>
</tr>
<tr>
<td>Arrows*</td>
<td>To display displacement results as arrows.</td>
</tr>
<tr>
<td>Contour lines*</td>
<td>To display the results as contour lines.</td>
</tr>
<tr>
<td>Shadings*</td>
<td>To display the results as shadings.</td>
</tr>
<tr>
<td>Node labels*</td>
<td>To display the results at nodes.</td>
</tr>
<tr>
<td>Principal directions*</td>
<td>To display the principal stress directions in each stress point of the soil element.</td>
</tr>
<tr>
<td>Stress point labels*</td>
<td>To display the results at stress points.</td>
</tr>
<tr>
<td>Distribution*</td>
<td>To project the results perpendicularly to the structure, creating a distribution line for beams, embedded beams and anchors.</td>
</tr>
<tr>
<td>Wireframe distribution*</td>
<td>To project the results perpendicularly to the structure, creating a wireframe distribution line for beams, embedded beams and anchors.</td>
</tr>
<tr>
<td>Distribution envelope*</td>
<td>To project the envelope of all the phases results perpendicularly to the structure, creating a distribution line for beams, embedded beams and anchors.</td>
</tr>
</tbody>
</table>
To project the envelope of all the phases results perpendicularly to the structure, creating a wireframe distribution line for beams, embedded beams and anchors.

To display the principal directions of stresses and strains at the center of each soil element.

To display the principal directions in each stress point of the soil element. Colours are used to distinguish the principal directions.

To display the principal directions of stresses and strains at the center of each soil element. Colours are used to distinguish the principal directions.

Note:
- Menu options indicated with an asterisk (*) are only available for specific plot types.
- Distribution envelope and Wireframe distribution envelope show the whole history of the selected structures but the results (e.g. maximum and minimum value) correspond to the current phase and active part of the structure.

8.2.3 Project menu

<table>
<thead>
<tr>
<th>Input nodes</th>
<th>View the table of the geometry input points.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node fixities</td>
<td>View the table of the node fixities.</td>
</tr>
<tr>
<td>Load information</td>
<td>View the table of the active loads and bending moments in the current step.</td>
</tr>
<tr>
<td>Water load information</td>
<td>View the table of the external water loads on the geometry boundaries in the current step.</td>
</tr>
<tr>
<td>Applied volume strain</td>
<td>View the table of the volume strain resulting at the end of the calculation phase.</td>
</tr>
<tr>
<td>Virtual interface thickness</td>
<td>View the table of the virtual interface thickness.</td>
</tr>
<tr>
<td>Volume information</td>
<td>View the boundaries of the soil polygon, the total area of soil and the area of each cluster in the project.</td>
</tr>
<tr>
<td>Material information (all load cases)</td>
<td>View the material data of all load cases.</td>
</tr>
<tr>
<td>Material information (current load case)</td>
<td>View the material data of the current load case.</td>
</tr>
<tr>
<td>Deconfinement table</td>
<td>View the table with all applied deconfinements in the current step.</td>
</tr>
</tbody>
</table>
### General information

<table>
<thead>
<tr>
<th>General information</th>
<th>View the general project information.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculation information</td>
<td>View the calculation information of the presented step.</td>
</tr>
<tr>
<td>Calculation info per phase</td>
<td>View the calculation information for each calculation phase.</td>
</tr>
<tr>
<td>Calculation info per step</td>
<td>View the calculation information for each calculation step.</td>
</tr>
<tr>
<td>Step info</td>
<td>View the step information of the presented step.</td>
</tr>
<tr>
<td>Structures per phase</td>
<td>View the active structures per calculation phase.</td>
</tr>
</tbody>
</table>

### 8.2.4 Geometry menu

<table>
<thead>
<tr>
<th>Phreatic level</th>
<th>Toggle the display of the phreatic level in the model.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frost line</td>
<td>Toggle the display of the frost line, i.e the boundary between frozen and unfrozen soil (T = 273.15 K = 0.0 °C = 32.0 °F)</td>
</tr>
<tr>
<td>Fixities</td>
<td>Toggle the display of the fixities in the model.</td>
</tr>
<tr>
<td>Connection axes</td>
<td>Toggle the display of the connection axes in the model.</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter the nodes displayed in the model according to a defined criteria.</td>
</tr>
</tbody>
</table>

### 8.2.5 Mesh menu

<table>
<thead>
<tr>
<th>Quality circles</th>
<th>The quality of the elements in the mesh is defined as inner circle divided by the outer circles of the soil or plate element where an equal sided triangle is normalised at 1.0.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table of quality</td>
<td>View the table of the quality of the soil or plate elements according to different criteria.</td>
</tr>
<tr>
<td>Area</td>
<td>View the distribution of the area of the soil elements.</td>
</tr>
<tr>
<td>Table of element areas</td>
<td>View the table of the distribution of the areas of the soil elements.</td>
</tr>
<tr>
<td>Connectivity plot</td>
<td>View the connectivity plot (Connectivity plot (on page 444)).</td>
</tr>
<tr>
<td>Cluster borders</td>
<td>Toggle the display of the cluster borders in the model.</td>
</tr>
<tr>
<td>Element contours</td>
<td>Toggle the display of the element contours in the model.</td>
</tr>
</tbody>
</table>
### Deformations menu

The **Deformations** menu contains various options to visualise the deformations (displacements, strains), the velocities and the accelerations (in the case of a dynamics analysis) in the finite element model ([Deformations](on page 445)). These quantities can be viewed for the whole analysis (total values), for the last phase (phase values) or for the last calculation step (incremental values). In principle, displacements are contained in the nodes of the finite element mesh, so displacement related output is presented on the basis of the nodes, whereas strains are usually presented in integration points (stress points).

### Stresses menu

The **Stresses** menu contains various options to visualise the stress state and other state parameters in the finite element model ([Stresses](on page 449)). Stresses are contained in the integration points of the finite elements mesh, so stress related output is presented on the basis of the integration points (stress points).
8.2.8  Forces menu

The Forces menu contains various options to visualise the resulting forces in structural elements (Structures and interfaces (on page 462)).

8.2.9  Interface stresses menu

The Interface stresses menu contains various options to visualise the resulting stresses in interface elements (Structures and interfaces (on page 462)).

8.2.10 Discontinuity stresses menu

The Discontinuity stresses menu contains various options to visualise the resulting stresses in discontinuity elements (Structures and interfaces (on page 462)).

8.2.11 Tools menu

<table>
<thead>
<tr>
<th>Copy</th>
<th>To copy the active output to the Windows clipboard.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select points for curves</td>
<td>To enable selection of nodes and stress points to be considered in curves. All the nodes and stress points in the project are displayed enabling selection by clicking on them. The Select points window is activated, where the location of interest can be defined and the appropriate nodes or stress points can be selected form the list.</td>
</tr>
<tr>
<td>Mesh point selection</td>
<td>To activate the Mesh selection window. This option is active when the Select points for curves has been previously selected and the Select points window is closed.</td>
</tr>
<tr>
<td>Curves manager</td>
<td>To activate the Curves manager (Curves (on page 474)).</td>
</tr>
<tr>
<td>Table</td>
<td>To open a new form with a table of numerical values of the presented quantity.</td>
</tr>
<tr>
<td>Cross section</td>
<td>To select a user-defined cross section with a distribution of the presented quantity. The cross section must be selected by the mouse or by defining two points. Press the left mouse button at one end of the cross section; hold the mouse button down and move the mouse to the other end of the line. The cross section is presented on a new form.</td>
</tr>
<tr>
<td>Forces view</td>
<td>To open a new form with the possibility to visualise contact stresses and resulting forces on an arbitrary configuration of elements.</td>
</tr>
</tbody>
</table>
### 8.2.12 Options

<table>
<thead>
<tr>
<th>Autocomplete [GSE]</th>
<th>To select the Significant digits for the project.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Licencing information</strong></td>
<td>To switch on or off showing the licence information at startup.</td>
</tr>
</tbody>
</table>

### 8.2.13 Expert menu [GSE]

<table>
<thead>
<tr>
<th>Run commands</th>
<th>To open the Commands runner window.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro library</td>
<td>To modify and run macros. Macros can be defined and indexed in the Macro library window, displayed as the corresponding option is selected in the sub-menu. To run a macro click the corresponding option in the sub-menu.</td>
</tr>
<tr>
<td>Python</td>
<td>To open and use Interpreter, Configure Python interpreter, Editor, Command prompt, Jupyter notebook and to run python scripts (Appendices Python HTTP REST API wrapper [GSE] (on page 615) and HTTP REST API [GSE] (on page 642)).</td>
</tr>
</tbody>
</table>
### Run Python script
To configure remote scripting server and open python script to run them (Appendices [Python HTTP REST API wrapper [GSE] (on page 615)](#) and [HTTP REST API [GSE] (on page 642))].

### Run Python tool
To configure remote scripting server and run python scripts (Appendices [Python HTTP REST API wrapper [GSE] (on page 615)](#) and [HTTP REST API [GSE] (on page 642))].

### Configure remote scripting server
To specify an available port and open it for connections by local or remote clients (Appendices [Python HTTP REST API wrapper [GSE] (on page 615)](#) and [HTTP REST API [GSE] (on page 642))].

---

## 8.2.14 Window menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project manager</td>
<td>To view the projects and forms currently displayed in Output.</td>
</tr>
<tr>
<td>Duplicate model view</td>
<td>To duplicate the active view.</td>
</tr>
<tr>
<td>Close window</td>
<td>To close the active output form.</td>
</tr>
<tr>
<td>Cascade</td>
<td>To cascade the displayed output forms.</td>
</tr>
<tr>
<td>Tile horizontally</td>
<td>To tile horizontally the displayed output forms.</td>
</tr>
<tr>
<td>Tile vertically</td>
<td>To tile vertically the displayed output forms.</td>
</tr>
<tr>
<td>(List of recent views)</td>
<td>A list of the output forms.</td>
</tr>
</tbody>
</table>

## 8.2.15 Help menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manuals</td>
<td>To display the manuals.</td>
</tr>
<tr>
<td>Command reference</td>
<td>To display information about commands in the program.</td>
</tr>
<tr>
<td>Instruction movies</td>
<td>To reach the Bentley communities website where instruction movies are displayed.</td>
</tr>
<tr>
<td>Request support</td>
<td>To send a request for support.</td>
</tr>
<tr>
<td>Licence configuration</td>
<td>To view and configure licences.</td>
</tr>
<tr>
<td>Visit website</td>
<td>To reach the PLAXIS 2D product page.</td>
</tr>
<tr>
<td>News feed</td>
<td>Latest news and events of PLAXIS products.</td>
</tr>
</tbody>
</table>
8.3 General information on command line

At the bottom of the Output application, a command line panel is available. The command line provides an alternative way of executing certain operations, by entering commands as text.

A feedback panel is situated above the command line panel. Here, the executed commands are shown, together with the feedback of the command. Successful commands return green coloured feedback, consisting of details on newly generated geometry or elements. Erroneous commands return red coloured feedback, containing an error report.

In the PLAXIS 2D Output program, a global command is included that shows information on the commands that can be executed: cms. This command lists the signatures of all commands available in the PLAXIS 2D Output program. An extended overview and description of all available commands is accessible via the Help menu in the user interface of the PLAXIS 2D Output program.

More information is available in General information on command line (on page 45).

8.3.1 Indexing in commands

Array indexing syntax can be used in the command line. This consists of square brackets behind an object name, followed by an integer and a matching closing bracket. Integer indexing is zero-based and works on any listable object, i.e. any object on which you can fire a filter or tabulate command. Both positive and negative numbering is used in indexing. The positive numbering begins at the start of the list, in which 0 is the first item from the table, while negative numbering starts from the end and goes backward through the list (see Indexing in commands (on page 47)).

8.4 Tools in the Output program

Besides displaying the calculation results, the Output program provides tools to handle the view and enable a better examination of the results. The buttons are grouped in the toolbar below the menu bar and in the side tool bar. The tools and their functionality is described in the following sections.
8.4.1 Accessing the Output program

All the results are displayed in the Output program. There are different ways to access the Output program. Besides the option of activating the program as described at the beginning of this chapter, the results can be displayed before or after the calculation of the phases is completed.

The results that can be displayed before calculating the phases are:

<table>
<thead>
<tr>
<th>The generated mesh</th>
<th>The generated mesh is automatically displayed in the Output program as it is generated in the Input program.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pore pressures</td>
<td>The generated pore pressures can be displayed when they are generated according to the phreatic level.</td>
</tr>
<tr>
<td>Connectivity plot</td>
<td>The Connectivity plot displays the distribution of the finite elements in the mesh and the nodes and stress points available. The Connectivity plot is displayed when the Select point for curves button is selected in the Calculations program. A more detailed description is given in Connectivity plot (on page 444).</td>
</tr>
</tbody>
</table>

Note:

Note that the groundwater calculations are performed when the phase is calculated. As a result, the pore pressure distribution is available only after the phase is calculated.

The calculation results of a project are displayed in the Output program by selecting a calculated phase in the Phases explorer and clicking the View calculation results button in the Calculation program.

While the Output program is already active, the results of other projects can be accessed either by clicking the Open project button or by selecting the corresponding option in the File menu (File menu (on page 407)).

8.4.2 Exporting output data

The PLAXIS 2D Output program enables exporting the displayed results such as plots or values. This is possible by clicking the corresponding button in the toolbar.

8.4.2.1 Copy to clipboard

Data as displayed in output forms may be exported to other programs using the Windows clipboard function. When clicking on the Copy to clipboard button, the Copy window appears in which selections can be made of the various plot components that are to be included in the copy (Figure 247 (on page 418)).
8.4.2.2 Print

Hardcopies of graphs and tables can be produced by sending the output to an external printer. When the Print button is clicked or the corresponding option is selected in the File menu, the Print window appears, in which various plot components that are to be included in the hardcopy can be selected (Figure 248 (on page 418)).

When pressing the Setup button, the standard printer setup window is presented in which specific printer settings can be changed. When the Print button is clicked, the plot is send to the printer. This process is fully carried out by the Windows® operating system.

**Note:**

When the *Copy to clipboard* option or the Print option is used on a plot that shows a zoomed part of the model, only the part that is currently visible will be exported to the clipboard or the printer.
8.4.2.3 Export

Data in output forms may be exported to files. When the Export to file button is clicked, the Export window appears. Note that a text scaling factor can be defined.

![Export window]

*Figure 249: Export window*

Instead of the PLAXIS 2D logo in the frame, it is also possible to insert a company logo. This logo has to be provided as a bitmap and can be selected in the Print window after clicking on the logo.

8.4.3 Curves manager

Clicking the Curves manager button activates the Curves manager window where curves can be generated to evaluate the results at specified locations in the model. Selection of points of interest and the generation of curves is described in detail in Curves (on page 474).

8.4.4 Store the view for reports

The views in the Output program can be saved to be used when reports are generated by clicking on the Store the view for reports button. The Save view window pops up as the button is clicked. Description can be given to the view in the Figure 250 (on page 420) window which can be beneficial when the report is generated. Report generation is described in detail in Report generation (on page 436).
8.4.5  Zooming the plot

It is possible to zoom in and out in the view of the plots by scrolling the mouse wheel. Other options for zooming are available by clicking the corresponding buttons in the toolbar.

- As this feature is selected, the mouse can be dragged on the model to define a local zooming rectangle. In the window, only the results in the defined rectangle will be displayed.
- Clicking the Zoom out button or selecting the corresponding option in the View menu (on page 408) restores the view of before the most recent zoom action.
- Clicking the Reset view or selecting the corresponding option in the View menu (on page 408) enables restoring the original plot.

8.4.6  Relocation of the plot

The plot can be moved using the mouse.

When this button is clicked, the plot will be relocated (moved) by clicking on the plot area and dragging it while keeping the left mouse button pressed.

8.4.7  Scaling the displayed results

Whenever the results are indicated by length entities such as Arrows, Distribution, Axis, etc. (Display type of results (on page 422)), the Scale factor button can be used to receive a better overview. When the button is clicked or the corresponding option in the View menu is selected, a window pops up where the factor can be defined. Note that this option is also available in the right mouse click pop-up menu.
8.4.8 Tables

The tabular form of the results given in the plot can be obtained by clicking on the Table button or by selecting the corresponding option in the menu. Note that this option is also available in the right mouse click pop-up menu.

Note:
The table of displacements may be used to view the global node numbers and corresponding coordinates of individual elements.

8.4.8.1 Displaying of tables

By default, a table is presented in ascending order according to the global element number and local node or stress point. However, a different ordering may be obtained by clicking on the small triangle in the column header of the desired quantity on which the ordering should be based. Another click on the same column header changes the ordering from ascending to descending.

The options available in the right click pop-up menu are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select for curves</td>
<td>To select the right clicked point in the table to be considered in curves.</td>
</tr>
<tr>
<td>Create chart</td>
<td>To create a chart from the values presented in the table.</td>
</tr>
</tbody>
</table>
Output program - General overview
Tools in the Output program

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align</td>
<td>To align the text in the selected part of the table.</td>
</tr>
<tr>
<td>Decimal</td>
<td>To display data in decimal representation.</td>
</tr>
<tr>
<td>Scientific</td>
<td>To display data in scientific representation.</td>
</tr>
<tr>
<td>Decimal digits</td>
<td>To define the number of decimal digits displayed.</td>
</tr>
<tr>
<td>View factor</td>
<td>To define a factor to the values in the table.</td>
</tr>
<tr>
<td>Copy</td>
<td>To copy the selected values in the table.</td>
</tr>
<tr>
<td>Find value</td>
<td>To find a value in the table.</td>
</tr>
<tr>
<td>Find soil element</td>
<td>To find a soil element with a specified ID in the table when the results are displayed for soil elements.</td>
</tr>
<tr>
<td>Find structural element</td>
<td>To find a structural element with a specified ID in the table when the results are displayed for structures.</td>
</tr>
<tr>
<td>Filter</td>
<td>To filter the results in the table.</td>
</tr>
</tbody>
</table>

**Note:**
The values in the tables contain the most accurate information, whereas information in plots can be influenced or be less accurate due to smoothing or extrapolation of information from stress points to nodes.

### 8.4.9 Selection of results

As the type of result is selected from the *Deformations, Stresses or Structures* menu, the results are displayed either in plots or tables according to the selection made.

While the Output program is running, other steps of the project can be selected from the drop-down menu in the toolbar. The button in front of the drop-down menu can be used to toggle between the end results of phases, or individual output steps:

- A list of the calculation phases and their final calculation steps is given. The results at the end of the final calculation steps can be shown for each phase.
- A list of the saved calculation steps and the calculation phase they belong to is given. The results of each calculation step can be shown.

In addition to the drop-down menu, the spinner at the right of the drop-down menu or using the *Ctrl-Up* and *Ctrl-Down* keys will select the end results of the previous or next calculation step or calculation phase.
8.4.10 Display type of results

The plot type options are located at the right of the drop-down menu:

- The results are displayed as contours.
- The results are displayed as shadings.
- The results for Displacements can be displayed as arrows. Scaling of the results is possible.
- The results are displayed at each stress point of the soil elements. The length of each line represents the magnitude of the principal quantity (stress or strain) and the direction indicates the principal direction. Positive direction is indicated by arrows. Scaling of the results is possible.
- The average results are displayed at the center of each soil element. The length of each line represents the magnitude of the principal quantity (stress or strain) and the direction indicates the principal direction. Positive direction is indicated by arrows. Scaling of the results is possible.
- The results are displayed in different colours at each stress point of the soil elements. The length of each line represents the magnitude of the principal quantity (stress or strain) and the direction indicates the principal direction. Positive direction is indicated by arrows. Scaling of the results is possible.
- The average results are displayed in different colours at the center of each soil element. The length of each line represents the magnitude of the principal quantity (stress or strain) and the direction indicates the principal direction. Positive direction is indicated by arrows. Scaling of the results is possible.
- The deformed shape of cross sections, plates, geogrids or interfaces is displayed. The relative deformation is indicated by arrows. Scaling of the results is possible.
- The distribution of the results in cross sections, plates, geogrids or interfaces is displayed. Scaling of the results is possible.
- The wireframe distribution of the results in cross sections, plates, geogrids or interfaces is displayed. Scaling of the results is possible.
- The distribution of the maximum and the minimum values of the resulting forces in plates, geogrids and node-to-node anchors up to the current calculation step is displayed. Scaling of the results is possible.
- The wireframe distribution of the maximum and the minimum values of the resulting forces in plates, geogrids and node-to-node anchors up to the current calculation step is displayed. Scaling of the results is possible.
- The Plastic points option shows the stress points that are in a plastic state, displayed in a plot of the undeformed geometry (Plastic points on page 460). Scaling of the results is possible. When scaling is used, it is possible to pull the interfaces out of the plates, however the stress points will remain at their physical locations.

Note:

For (enhanced) safety calculations, results are NOT shown in soil clusters that are excluded from the strength reduction procedure as long as the Hide items without strength reduction option in the View menu has been selected.
The availability of the display type buttons in the toolbar can be toggled on/off by selecting the corresponding options in the View menu.

8.4.11 Select structures

By default, all the active structures and interfaces in the selected phase are displayed in the plot. The disabled structures can be displayed by selecting the corresponding option in the Geometry menu.

Output for structures and interfaces can be obtained by clicking the Select structures button and then double clicking the desired object in the 2D model. As a result, a new form is opened on which the selected object appears. At the same time the menu changes to provide the particular type of output for the selected object.

Another option of selecting structural elements in the output is by clicking on the Select structures in a rectangle and drawing a rectangle in the model. As a result, the structures in the rectangle will be selected.

To clear the selection, press Esc. Only structural elements of the same type can be selected at the same time. For example, if a geogrid is selected, only other geogrids can be added to the selection and no embedded beam rows or plates.

8.4.12 Partial geometry

To enable the inspection of certain internal parts of the geometry (for example individual layers or volume clusters) it is possible to make other parts of the geometry invisible in the Model explorer by clicking the button in front of them as shown in Figure 252 (on page 424).

Visible model components are indicated by an open eye, whereas invisible ones are indicated by a closed eye. By clicking on the button, the view of the components (individual and/or groups) can be toggled from being visible to being invisible and vice versa. A group is expanded by clicking on the + sign in front of the group. Clusters that have been set inactive in the framework of staged construction are always invisible and cannot be made visible.
The user will be able to show/hide clusters in the Model explorer under the option of Soils based on the materials assigned to them.

**Note:**
The cluster numbers are activated by selecting the Cluster numbers option in the Mesh menu.

The information in the Model explorer can be narrowed according to the filtering criteria specified at the corresponding cell.

The Show all option will make all the object active in the selected phase visible. The Hide all will revert the action. The Invert selection option will toggle all visible elements invisible and all invisible elements visible. The Deselect all button will set all elements to invisible. On pressing the Close button the Partial geometry window is closed without further changes.

Apart from the Model explorer, individual volume elements or entire clusters of volume elements can be made invisible by holding down the Ctrl key, the Shift key or both keys at the same time, respectively, while clicking on an element in the 2D model. These elements can be visible again by clicking the corresponding check boxes in the Model explorer.

Clicking the Hide soil button in the side bar menu enables hiding parts of the soil. To hide soil elements, click the Hide soil button first and hold the Ctrl key pressed while clicking on the soil elements. To hide soil clusters, click the Hide soil button first and hold the Shift key pressed while clicking on the soil clusters.

Clicking on the Hide soil in the rectangle button enables hiding the soil in the rectangle drawn in the model. The drawing order of the rectangle effects the resulting hidden soil elements.

To hide only the soil elements that fall completely in the defined rectangle, first click the Hide soil in the rectangle button. In the model, click at the point defining the upper left corner of the rectangle, drag the mouse to the point defining the lower right corner of the rectangle and click again.

To hide all the soil elements that are intersected by the defined rectangle, first click the Hide soil in the rectangle button. In the model, click at the point defining the lower right corner of the rectangle, drag the mouse to the point defining the upper left corner of the rectangle and click again.

8.4.13 Viewing results in cross sections

To gain insight in the distribution of a certain quantity in the soil it is often useful to view the distribution of that quantity in a particular cross section of the model. This option is available in PLAXIS 2D for all types of stresses and displacements in soil elements.

A cross section can be defined by clicking the Cross section button in the side button bar or by selecting the Cross section option in the View menu. Note that this option is also available in the right mouse click pop-up menu. Upon selection of this option, the Cross section points window pops up in which the two cross section coordinates can be defined.

After the cross section has been selected, a new form is opened in which the distribution of a quantity is presented on the indicated cross section. At the same time, the menu changes to allow for the selection of all other quantities that may be viewed on the indicated cross section.
Note:
The distribution of quantities in cross sections is obtained from interpolation of nodal data and may be less accurate than data presented in the 2D model.

Multiple cross sections may be drawn in the same geometry. Each cross section will appear in a different output form. To identify different cross sections, the end points of a cross section are indicated with characters in alphabetical order. The points defining the cross section can be viewed by selecting the Cross section points option in the Tools menu.

In addition to the output quantities that are available for the 2D model, a cross section allows for the display of cross section stresses, i.e. effective normal stresses $\sigma'_N$, total normal stresses $\sigma_N$, vertical shear stresses $\tau_s$ and horizontal shear stresses $\tau_t$.

Note:
It is possible to move a cross section in the direction of its normal while the presentation of results is updated for the new location of the cross section.

- Using the Ctrl+- and Ctrl++ keys will move the cross section 1/100 times the diagonal of the geometry model.
- Using the Ctrl+Shift+- and Ctrl+Shift++ will move the cross section 1/1000 times the diagonal of the geometry model.

8.4.14 Plot annotations

PLAXIS 2D enables addition of user-defined information to the output plots. The buttons in the side toolbar provide different annotation options.

8.4.14.1 Label annotations in plots

PLAXIS 2D enables adding labels as annotations in plots. To add a label annotation to a plot:

- Click the Add label annotation button in the side toolbar.
- Double click the location on the plot where the label is to be located. The Annotation window for the label pops up (Figure 253 (on page 427)).
- Define the type by selecting the corresponding option in the Caption drop down menu. The options available for the Caption type are:

<table>
<thead>
<tr>
<th>user-defined</th>
<th>To enter a label defined by the user.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node ID</td>
<td>To display the ID of the double clicked node.</td>
</tr>
<tr>
<td>Result value</td>
<td>To display the result (i.e. the displacement, groundwater head or other result, depending on the selected Output plot) at the double clicked node.</td>
</tr>
</tbody>
</table>
The information available for the annotation depends on whether a node is double clicked or not. When a node is double clicked, besides *User-defined* text, information such as the node ID, result value at the node, the type of element to which the node corresponds and the number of that element is provided. If a random location is double-clicked in the plot the only option available for the *Caption* is *User-defined*.

**Figure 253: Annotation window for labels**

- If the *User-defined* option is selected, specify the label in the *Caption* cell.
- If either the *Node ID* or the *Result value* is selected from the *Caption* drop-down menu, in the *Context* box, select the element type to which the node belongs in the *Element type* drop down menu. Depending on the model, the options might be *Soil-element* or *Structural-element*.
- A node can be shared by multiple elements. To specify the element of interest select the corresponding option from the *Element ID* drop down menu in the *Context* box. Note that the *Context* box is only available if an annotation is assigned to a node (a node is double-clicked).
- Select one of the options available for the *Scope* box to prevent undesired display of the annotation in the plot. The defined annotations can be relevant for the whole project (*Project* option), only the current phase (*Phase* option) or only the current calculation step (*Step*).
- To limit the display of the annotation to the current view select the corresponding checkbox in the window. Note that if this option is selected, the current view should be saved to preserve the defined annotation.

### 8.4.14.2 Line annotations in plots

PLAXIS 2D enables adding lines or arrows as annotations in plots. To add a line annotation to a plot:

- Click the *Add line annotation* button in the side toolbar.
- Define the start and the end points of the line by clicking on the plot. When the end point is defined the *Annotation* window for lines pops up (Figure 253 (on page 427)).
- Use the *Style* options available in the drop down menus for the start and end point of the line and for the line itself to modify the style of the line.
• Specify the thickness of the line and the arrows in the corresponding cell.
• Select one of the options available for the Scope to prevent undesired display of the annotation in the plot. The defined annotations can be relevant for the whole project (Project option), only the current phase (Phase option) or only the current calculation step (Step).
• To limit the display of the annotation to the current view select the corresponding checkbox in the window. Note that if this option is selected, the current view should be saved to preserve the defined annotation.
• The Delete button is only available when editing the annotations (see below).

![Annotation window for editing]

Figure 254: Annotation window for editing

8.4.14.3 Measurement annotations in plots
PLAXIS 2D enables adding measurement annotations in plots displaying the distance between two locations in the model. To add a measurement annotation to a plot:

• Click the Add measurement annotation button in the side toolbar.
• Define the start and the end points of the line by clicking on the plot. The distance between the specified locations is displayed in the model.

8.4.14.4 Editing annotations
To modify or remove an annotation from the plot:

• Click the Edit annotation button in the side toolbar.
• Click the annotation to be modified. The Annotation window will appear displaying the modification options depending on the clicked annotation. Note that a new button (Delete) is available in the window, enabling the removal of the annotation (Figure 254 (on page 428)).

8.4.15 Miscellaneous tools
8.4.15.1 Distance measurement

The distance between two nodes in the model can be measured by either clicking on the Distance measurement button or by selecting the Distance measurement option in the Tools menu and by subsequently selecting the nodes in the model. The Distance information window pops up displaying the information about the distance (Figure 255 (on page 429)).

The distance can be given according to the original node position or in deformed shape (i.e. using shifted node positions according to their displacements).

![Distance information window](image)

*Figure 255: Distance information*

A description of the information available in the table is given as follows:

<table>
<thead>
<tr>
<th>Coordinates</th>
<th>The Original and Deformed coordinates for the first node/stress point and the second node/stress point.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Δ x</td>
<td>The Original and Deformed x-component of the distance between the nodes.</td>
</tr>
<tr>
<td>Δ y</td>
<td>The Original and Deformed y-component of the distance between the nodes.</td>
</tr>
</tbody>
</table>
### Output program - General overview
Tools in the Output program

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elongation</td>
<td>The difference between the original vector and the projection of the deformed vector onto the original vector ([Figure 256](on page 430)). Hence, Elongation does not consider the rotation of the line between the two points. If the Updated mesh analysis is performed, Elongation is the difference in distance between the original and deformed vectors.</td>
</tr>
<tr>
<td>Distance</td>
<td>The Original $(v)$ and Deformed $(v')$ distance between the points.</td>
</tr>
<tr>
<td>Orientation</td>
<td>The angle between the measurement line and the x-axis. Orientation is positive if the vector describing the line points upwards $(Y&gt;0)$ and negative if it points downwards $(Y&lt;0)$. The Orientation is calculated for the undeformed and deformed measurement line.</td>
</tr>
<tr>
<td>$</td>
<td>\Delta u</td>
</tr>
<tr>
<td>$\Delta u_{\text{perpendicular}},$</td>
<td>The deformation in the direction perpendicular to the original line between the selected points.</td>
</tr>
<tr>
<td>Rotation</td>
<td>The difference between the deformed orientation and the original orientation ([Figure 256](on page 430)). The sign of the rotation is determined using the right-hand rule (clockwise rotation is negative, counter-clockwise is positive).</td>
</tr>
</tbody>
</table>
| Tilt        | The ratio of the deformation in the direction perpendicular to the line between the selected points, $\Delta u_{\text{perpendicular}}$, to the original distance between the selected points, $v$, given both as ratio and percentage:  

$$Tilt = \tan (\alpha_{Tilt}) = \frac{\Delta u_{\text{perpendicular}}}{v}$$

| ![Figure 256: Deformation measurement](image) |
8.4.15.2 Draw scanline

When the Contour lines option is selected, a distribution of the values can be displayed by clicking on the Draw scanline button in the side toolbar and drawing a line on the regions of interest. Note that this option is also available in the right mouse click pop-up menu.

8.4.15.3 Hint box with node or stress point data

When nodes or stress points are displayed in the model using the corresponding option in the Tools menu, it is possible to view data of these points in a hint box. This can be done by clicking on the corresponding button in the side bar menu. If this option is active and the mouse is moved over a node, the hint box shows the global node number, the node coordinates and the current displacement components.

If the Hint box option is active and the mouse is moved over a stress point, the hint box shows the global stress point number, the current Young’s modulus $E$, the current cohesion $c$, the current overconsolidation ratio $OCR$, the current principal stresses and a sketch of Coulomb’s envelope and Mohr’s circles for that stress point.

8.4.15.4 Selecting nodes or stress points for curves

Nodes and stress points can be selected in the Output program by clicking the Select nodes and stress points button in the side toolbar. Make sure the Nodes and/or Stress points option has been selected in the Mesh menu. Nodes are generally used to draw displacements whereas stress points are generally used to draw stresses or strains.

Note that for the nodes and stress points selected after the calculation process information is only valid for the saved calculation steps. For a more detailed description see Selecting points for curves (on page 474).

8.4.15.5 Interactive ruler

The result value at a specific location in a structure or cross section can be displayed by clicking the Interactive ruler button in the side toolbar and by moving the cursor to the point of interest. The current value (corresponding to the point on the cross section line), a minimum value (based on the minimum value in the distribution), and a maximum value (based on the maximum value in the distribution) are shown along the ruler. The Interactive ruler is available in the Structure and Cross section views.

8.5 Display area

The distribution of the results in the model is shown in the display area.

The presence of the legend, title bar, and axes in the drawing area is arranged using the options in the View menu (View menu (on page 408)).
8.5.1 Legend

The Legend is available for the display options where a variation in colour describes the variation in the displayed result values. It is activated by selecting the corresponding option in the View menu.

When the Legend is double clicked, the Legend settings window pops up, where the scaling and the colouring can be defined (Figure 257 (on page 432)). Note that this option is also available in the right mouse click pop-up menu. Automatic, Manual or Logarithmic options are possible for scaling of results.

![Figure 257: Legend settings window](image)

The distribution of values in the legend can be locked by clicking the Lock the legend button. When the legend is locked, the value distribution will not change as the Ctrl++ or Ctrl+- keys are used to move the cross section through the model or when similar result of other calculation phases or projects are displayed.
### 8.5.2 Modifying the display settings

The view settings can be defined in the Settings window, that is activated when the corresponding option in the View menu is selected. Note that this option is also available in the right mouse click pop-up menu.

The visualization settings can be defined in the Visualization tabsheet of the Settings window (Figure 258 (on page 433)).

![Visualization tabsheet of the Settings window](image)

**Figure 258: Visualization tabsheet of the Settings window**

<table>
<thead>
<tr>
<th>Symbol size</th>
<th>To modify the size of the symbols in the display for nodes, forces, etc.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Diffuse shading</strong></td>
<td>To make the appearance of the model even more realistic, the <em>Diffuse shading</em> option may be used. Using this option, object surfaces that have the same colour by definition (such as soil elements with the same material data set) appear 'brighter' or 'darker', depending on their orientation with respect to the viewer. Object surfaces appear the brightest when the normal to the surface points in the direction of the viewer. The surfaces become darker the more the normal deviates from this direction. The contrast can be set to the desired magnitude using the slide bar.</td>
</tr>
<tr>
<td><strong>Anti aliasing</strong></td>
<td>To select a convenient anti aliasing method from the options available in the drop-down menu.</td>
</tr>
<tr>
<td><strong>Rendering method</strong></td>
<td>To select a convenient rendering method from the options available in the drop-down menu.</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>Toggle the display of the <em>Cluster borders</em>.</td>
</tr>
</tbody>
</table>

The displaying colours can be arranged in the Colours tabsheet of the Settings window (Figure 259 (on page 434)).
The function of the left and the middle mouse buttons can be defined in the Manipulation tabsheet of the Settings window (Figure 260 (on page 434)).

The display of particular results can be toggled on/off in the Results tabsheet of the Settings window (Figure 261 (on page 434)).
The default visibility of Nodes, Stress points and Disabled structures can be toggled on/off in the Default visibilities tabsheet of the Settings window (Figure 262 (on page 435)).

![Default visibilities tabsheet of the Settings window](image)

**Figure 262: Default visibilities tabsheet of the Settings window**

8.6 Views in Output

In the Output program the results are displayed in different views. The view type is indicated by the corresponding icon in the title bar. The available views are:

8.6.1 Model view

- In the Model view the results are displayed in the whole model. This is the default display of results.

8.6.2 Structures view

- When a structure (or multiple structures) is selected and double clicked, the variation of the result is displayed in the Structures view.

8.6.3 Cross section view

- In the Cross section the results in the defined cross section are displayed. A cross section can be moved perpendicular to the cross section using the Ctrl-[ and Ctrl-] keys. Simultaneously pressing the Shift key moves in small steps.

8.6.4 Forces view

- The Forces view enables a view of the mesh with contact stresses and (resulting) forces on the boundaries of the visible active parts of the mesh. This option can be selected from the Tools menu.

  For stresses:

| Water load | Only external water pressures and pore pressures are shown |
Normal stress | Only effective normal stresses are shown
---|---
Shear stress | Only shear stresses are shown
Total stress | Effective normal stresses (red) as well as external water pressures and pore pressures (blue) are shown

It can be selected whether external loads and resulting forces from prescribed displacements are taken into account. It can be selected whether resulting forces from water loads, effective soil stresses, forces from structures, gravity forces, external loads and forces from prescribed displacements are taken into account.

The *Partial geometry* option can be used to make parts of the mesh invisible, if necessary. In this way, all stresses and forces on sub-structures can be visualised.

The *Table* option may be used to view the actual values of stresses and forces. The table of forces also shows the resulting force below the table, both as an actual value and as a percentage of the total applied forces. The latter can be used to evaluate if there is a significant unbalance of the (sub-)structure. If necessary, the calculation may be repeated using a smaller tolerated error or a finer mesh.

### 8.7 Report generation

To document project input data and computational results, a *Report Generator* facility is available in the PLAXIS 2D Output program. The *Report generator* option can be selected from the *File* menu. The data files for the report are generated in the following eight steps.

**Step 1:** The report can be generated in a group of files or all the information can be combined in a single file (a RTF, PDF or HTML document). The directory where the report is stored should be defined ([Figure 263](#) on page 436)).

![Figure 263: Report generator - Setup](image)

**Step 2:** Select the phases for which results will be included in the report ([Figure 264](#) on page 437)).
Step 3: Select general information sets to be included in the report. Note that the selection can be saved as a new set besides All and None sets (Figure 265 (on page 437)).

Step 4: Select model view sets to be displayed in the report. Note that the selection can be saved as a new set besides All and None sets (Figure 266 (on page 438)).
Step 5: Select structure view sets to be displayed in the report are selected. Note that the selection can be saved as a new set besides All and None sets (Figure 267 (on page 438)).

Step 6: Select saved views to be included in the report (Figure 268 (on page 439)). For more details on saved views, see Store the view for reports (on page 419).
Output program - General overview
Report generation

**Figure 268: Report generator - Saved views**

**Step 7:** Select generated charts to be included in the report (Figure 269 (on page 439)).

**Figure 269: Report generator - Charts**

**Step 8:** A summary of the number of rows and the number of figures in the report is given (Figure 270 (on page 440)). The report is created as the Export button is clicked. A progress bar appears displaying the number of the remaining rows and images.
8.7.1 Configuration of the document

When the RTF, PDF or HTML document option is selected in the first step, after completing the steps required to generate the report another window pops up (Figure 271 (on page 441)) where the document type, name, the storage location and the display properties such as page setup (for RTF and PDF documents), the table configuration and the type and size of the used font can be defined.
8.8 Creating animations

The Create animation option is available in the File menu. If the option is selected, the Create animation window appears (see Figure 272 (on page 442)). The phases and calculation steps to be included in the animations can be selected. Note that the animation will include only available output steps. This depends on the Max number of steps stored parameter as defined for each phase in the Phases window. After selecting the phase(s), click OK to start the process. The progress of this process is indicated in a separate window.

If a large number of steps is to be included in the animation, the process may take some minutes after which the animation is presented. The result is stored in an animation file (*.AVI) in the project data directory.
8.9 Paraview Export [GSE]

The open source tool ParaView has been enabled to export the FEM model and the calculation results from PLAXIS. This tool allows to visualize and post-process large data from the calculations in PLAXIS 2D. The tool can be accessed in the Output Program and clicking the File menu (See Figure 273 (on page 443)).
After selecting the **Export ParaView** option a new window is displayed with the results that can be exported at level of nodes and stress points (See Figure 274 (on page 443)). Finalize the process by selecting the necessary results and click in **Export**.

**Note:** For more information visit [Bentley Communities/Paraview export](#).
9.1 Connectivity plot

A *Connectivity plot* is a plot of the mesh in which the element connections are clearly visualised. It is the result of the meshing process. It is available only in the representation of spatial variation of the results. This plot is particularly of interest when interface elements are included in the mesh. Interface elements are composed of pairs of nodes in which the nodes in a pair have the same coordinates. In the *Connectivity plot* however, the nodes in a pair are drawn with a certain distance in between so that it is made clear how nodes are connected to adjacent elements. This option is available from the *Mesh* menu.

In the *Connectivity plot* it can, for example, be seen that when an interface is present between two soil elements, that the soil elements do not have common nodes and that the connection is formed by the interface. In a situation where interfaces are placed along both sides of a plate (*Positive interface* and *Negative interface*), the plate and the adjacent soil elements do not have nodes in common. The connection between the plate and the soil is formed by the interface. An example of *Connectivity plot* is given in *Figure 275* (on page 444).

In the *Connectivity plot* it is possible to view soil clusters and structural chains that are excluded from the strength reduction procedure in a (enhanced) safety calculation (select *View > Hide items without strength reduction*). These clusters and structures are indicated by a custom colour; the default colour is grey, but this can be changed in the settings of *Modifying the display settings* (on page 432).

![Figure 275: Example of the Connectivity plot](image)

**Note:**

For (enhanced) safety calculations, results are NOT shown in soil clusters that are excluded from the strength reduction procedure as long as the *Hide items without strength reduction* option in the *View* menu has been selected.
9.2 Deformations

The Deformations menu contains various options to visualise the displacements and strains in the finite element model. By default, the displayed quantities are scaled automatically by a factor \((1, 2 \text{ or } 5) \cdot 10^n\) to give a diagram that may be read conveniently.

The scale factor may be changed by clicking the Scale factor button in the toolbar or by selecting the Scale option from the View menu. The scale factor for strains refers to a reference value of strain that is drawn as a certain percentage of the geometry dimensions. To be able to compare plots of different calculation phases or different projects, the scale factors in the different plots must be made equal.

9.2.1 Deformed mesh

The Deformed mesh is a plot of the finite element model in the deformed shape. By default, the deformations are scaled up to give a plot that may be read conveniently. If it is desired to view the deformations on the true scale (i.e. the geometry scale), then the Scale option (Scaling the displayed results (on page 420)) may be used. The deformed mesh plot may be selected from the Deformations menu.

9.2.2 Total displacements

The Total displacements option contains the different components of the accumulated displacements at the end of the current calculation step, displayed on a plot of the geometry. This option may be selected from the Deformations menu. A further selection can be made among the total displacement vectors, \(|u|\), and the individual total displacement components, \(u_x\) and \(u_y\). The total displacements may be presented as Arrows, Contour Lines or Shadings by clicking the appropriate button in the toolbar (Display type of results (on page 422)).

9.2.3 Phase displacements

The Phase Displacements option contains the different components of the accumulated displacement increments in the whole calculation phase as calculated at the end of the current calculation step, displayed on a plot of the geometry. In other words, the phase displacements are the differential displacements between the end of the current calculation phase and the end of the previous calculation phase. This option may be selected from the Deformations menu.

A further selection can be made among the phase displacement vectors, \(|Pu|\), and the individual phase displacement components, \(Pu_x\) and \(Pu_y\). The phase displacements may be presented as Arrows, Contour lines or Shadings by clicking the appropriate button in the toolbar (Display type of results (on page 422)).
9.2.4  *Sum phase displacements*

In *Staged construction* calculations elements that are switched from inactive to active are, by default, pre-deformed such that the displacement field across the boundary between the new elements and the existing elements is continuous. However, in some applications, such as the staged construction of dams and embankments, this leads to the undesired situation that the top of the embankment will show the largest settlements ([Figure 276](on page 446)(a)) and is lower than what has been designed, because of the accumulated settlements of the different construction layers. When the *Sum phase displacements* option is selected, the pre-deformation of newly activated elements is ignored. In this way, the settlement of the last construction layer will be limited and the largest settlement will most likely occur in the middle of the embankment, as expected. When plotting the settlements in a vertical cross section through the embankment, the results are somewhat discontinuous, but the overall settlement profile is more realistic than without choosing this option ([Figure 276](on page 446)(b)). The more construction layers are used, the smoother the settlement profile is ([Figure 276](on page 446)(b)).

![Figure 276: Settlement profile of an embankment on a stiff foundation layer: a. Phase displacement results; b. Sum phase displacements results (5 construction layers); c. Sum phase displacements results (10 construction layers)](image)

Note that, if displacements are set to zero in intermediate phases, the *Sum phase displacements* results may (at some point) be larger than the total displacements.

Considering structural elements, the *Sum phase displacements* retrieves the accumulated deformation of a structural element from the moment the nodes of this element have been activated.

9.2.5  *Incremental displacements*

The *Incremental displacements* option contains the different components of the displacement increments as calculated for the current calculation step, displayed on a plot of the geometry. This option may be selected from the *Deformations* menu. A further selection can be made among the displacement increment vectors, $|\Delta u|$, and the individual incremental displacement components, $\Delta u_x$ and $\Delta u_y$. The displacement increments may be presented as *Arrows*, *Contour lines* or *Shadings* by clicking the appropriate button in the toolbar ([Display type of results](on page 422)). The contours of displacement increment are particularly useful for the observation of localisation of deformations within the soil when failure occurs.
9.2.6 **Extreme total displacements**

The *Extreme total displacements* option contains the different components of the extreme values of the total displacements in the model, displayed on a plot of the geometry. This option may be selected from the *Deformations* menu. A further selection can be made among the maximum and the minimum of the total displacement components \((u_{x,\text{min}}, u_{x,\text{max}}, u_{y,\text{min}}, u_{y,\text{max}})\) and the maximum overall value \(|u|_{\text{max}}\). The extreme total displacements may be presented as *Contour lines* or *Shadings* by clicking the appropriate button in the toolbar ([Display type of results](on page 422)).

9.2.7 **Velocities [ULT]**

The option *Velocities* contains the different components of the velocities at the end of the current calculation step, displayed on a plot of the geometry. This option may be selected from the *Deformations* menu. A further selection can be made among the velocity vectors, \(|v|\), the individual velocity components, \(v_x\) and \(v_y\), as well as the extreme values of the total velocities in the calculation phase. The velocities may be presented as *Arrows*, *Contour lines* or *Shadings* by clicking the appropriate button in the toolbar ([Display type of results](on page 422)).

9.2.8 **Accelerations [ULT]**

The option *Accelerations* contains the different components of the accelerations at the end of the current calculation step, displayed on a plot of the geometry. This option may be selected from the *Deformations* menu. A further selection can be made among the acceleration vectors, \(|a|\), the individual acceleration components, \(a_x\) and \(a_y\), as well as the extreme values of the total accelerations in the calculation phase. The accelerations may be presented as *Arrows*, *Contour lines* or *Shadings* by clicking the appropriate button in the toolbar ([Display type of results](on page 422)).

9.2.9 **Accelerations in 'g' [ULT]**

The option *Accelerations in 'g'* contains the different components of the accelerations at the end of the current calculation step, displayed on a plot of the geometry as multiples of the gravity acceleration. This option may be selected from the *Deformations* menu. A further selection can be made among the acceleration vectors, \(|a('g')|\), the individual acceleration components, \(a_x('g')\) and \(a_y('g')\), as well as the extreme values of the total accelerations in the calculation phase. The accelerations may be presented as *Arrows*, *Contour lines* or *Shadings* by clicking the appropriate button in the toolbar ([Display type of results](on page 422)).
9.2.10  Total cartesian strains

The Total cartesian strains option contains the different components of the accumulated strains at the end of the current calculation step, displayed in a plot of the geometry. This option may be selected from the Deformations menu. A further selection can be made among the three or four individual Cartesian strain components $\varepsilon_{xx}$, $\varepsilon_{yy}$, $\varepsilon_{zz}$ (for axisymmetric models only) and $\gamma_{xy}$. In case of a plane strain model, $\varepsilon_{zz}$ will be zero. In case of an axisymmetric model, the value of the strain in this direction can be calculated as $\varepsilon_{zz} = \partial u_z / \partial z = u_x / R = u_x / x$. The individual strain components may be presented as Contour lines or Shadings by clicking the appropriate button in the toolbar (Display type of results (on page 422)).

9.2.11  Phase cartesian strains

The Phase cartesian strains option contains the different components of the accumulated strain increments in the whole calculation phase as calculated at the end of the current calculation step, displayed in a plot of the geometry. This option may be selected from the Deformations menu. A further selection can be made among the three or four individual Cartesian strain components $P\varepsilon_{xx}$, $P\varepsilon_{yy}$, $P\varepsilon_{zz}$ (for axisymmetric models only) and $P\gamma_{xy}$. In case of a plane strain model, $P\varepsilon_{zz}$ will be zero. In case of an axisymmetric model, the value of the strain in this direction can be calculated as $P\varepsilon_{zz} = \partial Pu_z / \partial z = Pu_x / R = Pu_x / x$.

The individual strain components may be presented as Contour lines or Shadings by clicking the appropriate button in the toolbar (Display type of results (on page 422)).

9.2.12  Incremental cartesian strains

The Incremental cartesian strains option contains the different components of the strain increments as calculated for the current calculation step, displayed in a plot of the geometry. This option may be selected from the Deformations menu. A further selection can be made among the three or four individual Cartesian strain components $\Delta \varepsilon_{xx}$, $\Delta \varepsilon_{yy}$, $\Delta \varepsilon_{zz}$ (for axisymmetric models only) and $\Delta \gamma_{xy}$. In case of a plane strain model, $\Delta \varepsilon_{zz}$ will be zero. In case of an axisymmetric model, the value of the strain in this direction can be calculated as $\Delta \varepsilon_{zz} = \partial \Delta u_z / \partial z = \Delta u_x / R = \partial \Delta u_x / x$.

The individual strain components may be presented as Contour lines or Shadings by clicking the appropriate button in the toolbar (Display type of results (on page 422)).

9.2.13  Total strains

The Total strains option contains various strain measures based on the accumulated strains in the geometry at the end of the current calculation step, displayed in a plot of the geometry. This option may be selected from the Deformations menu. A further selection can be made among the principal strain directions, the individual principal strain components $\varepsilon_1$, $\varepsilon_2$, $\varepsilon_3$ (for axisymmetric models only), $(\varepsilon_1 + \varepsilon_3)/2$, $(\varepsilon_1 - \varepsilon_3)/2$, the angle, the volumetric strain $\varepsilon_v$, the deviatoric strain $\varepsilon_q$ and the void ratio $e$.

- Note that the principal strain components are arranged in algebraic order:
$\varepsilon_1 > \varepsilon_2 > \varepsilon_3$

Hence, $\varepsilon_1$ is the largest compressive principal strain and $\varepsilon_3$ is the smallest compressive principal strain.

- The volumetric strain is calculated as:

  In normal calculations:

  $$\varepsilon_v = \varepsilon_{xx} + \varepsilon_{yy} + \varepsilon_{zz} \quad \text{Eq. [101]}$$

  In *Updated mesh* calculations:

  $$\varepsilon_v = \varepsilon_{xx} + \varepsilon_{yy} + \varepsilon_{zz} + \varepsilon_{xx}\varepsilon_{yy} + \varepsilon_{xx}\varepsilon_{zz} + \varepsilon_{yy}\varepsilon_{zz} + \varepsilon_{xx}\varepsilon_{yy}\varepsilon_{zz} \quad \text{Eq. [102]}$$

- The deviatoric strain is calculated as:

  $$\varepsilon_q = \sqrt{\frac{2}{3} \left( \left( \varepsilon_{xx} - \frac{\varepsilon_v}{3} \right)^2 + \left( \varepsilon_{yy} - \frac{\varepsilon_v}{3} \right)^2 + \left( \varepsilon_{zz} - \frac{\varepsilon_v}{3} \right)^2 + \frac{1}{2} (\gamma_{xy}^2 + \gamma_{yz}^2 + \gamma_{zx}^2) \right)} \quad \text{Eq. [103]}$$

- The void ratio is calculated as:

  $$e = e_0 + (1 + e_0)\varepsilon_v \quad \text{Eq. [104]}$$

### 9.2.14 Phase strains

The *Phase strains* option contains various strain measures based on the accumulated strain increments in the whole calculation phase as calculated at the end of the current calculation step, displayed in a plot of the geometry. This option may be selected from the *Deformations* menu. A further selection can be made among the volumetric strain ($P\varepsilon_v$) and the deviatoric strain ($P\varepsilon_q$).

### 9.2.15 Incremental strains

The *Incremental strains* option contains various strain measures based on the strain increments as calculated for the current calculation step, displayed in a plot of the geometry. This option may be selected from the *Deformations* menu. A further selection can be made among the volumetric strain ($\Delta\varepsilon_v$) and the deviatoric strain ($\Delta\varepsilon_q$).

### 9.3 Stresses

Various options are available to visualise the stress state in the finite element model. The *Stresses* menu also contains options to display the results of groundwater flow and thermal flow calculations.

**Note:**

By default, the stresses developed in non-porous materials are not displayed in the plot. To display them select the *Show stress for nonporous material* option in the *Results* tabsheet of the *Settings* window ([Modifying the display settings](on page 432)).
9.3.1  **Cartesian effective stresses**

The **Cartesian effective stresses** are different components of the effective stress tensor (i.e. the stresses in the soil skeleton). A further selection can be made among the three individual Cartesian stress components \( \sigma'_{xx}, \sigma'_{yy}, \sigma'_{zz} \) (for axisymmetric models only), and \( \sigma_{xy} \).

**Figure 277** (on page 450) shows the sign convention adopted for Cartesian stresses. Note that pressure is considered to be negative.

![Figure 277: Sign convention for stresses](image)

9.3.2  **Cartesian total stresses**

The **Cartesian total stresses** are different components of the total stress tensor (i.e. effective normal stresses + active pore pressures). A further selection can be made among the three individual Cartesian stress components \( \sigma_{xx}, \sigma_{yy}, \sigma_{zz} \) (for axisymmetric models only), and \( \sigma_{xy} \). The latter quantity is equal to the corresponding one in the Cartesian effective stress option, but are repeated here for convenience (Cartesian effective stresses (on page 450)). The individual stress components may be presented as **Contour lines** or **Shadings** by clicking the appropriate button in the toolbar.

9.3.3  **Principal effective stresses**

The **Principal effective stresses** are various stress measures based on the effective stresses \( \sigma' \) (i.e. the stresses in the soil skeleton). A further selection can be made among the effective principal stresses, the individual principal effective stress components \( \sigma'_1, \sigma'_2, \sigma'_3, (\sigma'_1+\sigma'_3)/2 \), the principal stress directions, the mean effective stress \( p' \), the deviatoric stress \( q \), the relative shear stress \( \tau_{rel} \), the maximum shear stress \( \tau_{max} \) and the mobilised shear strength \( \tau_{mob} \).

Note that the effective stress components are arranged in algebraic order:

\[
\sigma'_1 \leq \sigma'_2 \leq \sigma'_3 \quad \text{Eq. [105]}
\]

Hence, \( \sigma'_1 \) is the largest compressive (or smallest tension) principal stress and \( \sigma'_3 \) is the smallest compressive (or largest tension) principal stress.

The **Mobilised shear strength** \( \tau_{mob} \) is the maximum value of shear stress (i.e. the radius of the Mohr stress circle or half the maximum principal stress difference).
The *Relative shear stress* \( \tau_{rel} \) gives an indication of the proximity of the stress point to the failure envelope, and is defined as:

\[
\tau_{rel} = \frac{\tau_{mob}}{\tau_{max}} \quad \text{Eq. [106]}
\]

where \( \tau_{max} \) is the maximum value of shear stress for the case where the Mohr’s circle is expanded to touch the Coulomb failure envelope while keeping the center of Mohr’s circle constant.

\[
\tau_{max} = -\frac{\sigma’_1 + \sigma’_3}{2} \sin \varphi + c \cos \varphi \quad \text{Eq. [107]}
\]

**Note:**

Particularly when the soil strength has been defined by means of effective strength parameters - *Undrained (A)* - it is useful to plot the mobilised shear strength \( \tau_{mob} \) in a vertical cross section and to check this against a known shear strength profile.

When using the Hoek-Brown model to describe the behaviour of a rock section, the definition of the maximum shear stress \( \tau_{max} \) is slightly modified. Starting from the Hoek-Brown failure criterion:

\[
f_{HB} = \sigma’_1 - \sigma’_3 + \overline{f} (\sigma’_3) = 0 \quad \text{Eq. [108]}
\]

the maximum shear stress is defined by:

\[
\tau_{max} = \frac{1}{2} \overline{f} (\sigma’_3) \quad \text{where} \quad \overline{f} (\sigma’_3) = a_c\left(m_b - \frac{\sigma’_3}{c_i} + s\right)^a \quad \text{Eq. [109]}
\]

The relative shear stress is correspondingly defined by:

\[
\tau_{rel} = \frac{\tau_{mob}}{\tau_{max}} = \left| \frac{\sigma’_1 - \sigma’_3}{\overline{f} (\sigma’_3)} \right| \quad \text{Eq. [110]}
\]

The principal stress directions are defined by:

\[
\alpha = \frac{1}{2} \arctan \left( \frac{\sigma^{-}_y}{\sigma^{-}_x} \right) \quad (-90^\circ \leq \alpha \leq 90^\circ) \quad \text{Eq. [111]}
\]

For \( \alpha = 0 \), the major principal stress is vertical and the minor principal stress is horizontal. In this case, the cartesian shear stress is zero (for example initial stress generated by the *K0 procedure*). This situation corresponds to an active stress state.

A passive stress state is equivalent to \( \alpha = +90^\circ \) or \( \alpha = -90^\circ \). Zones of positive stress may show a jump from \( \alpha = +90^\circ \) to \( \alpha = -90^\circ \) and as a result discontinuous colour shadings are displayed.

A positive value of cartesian shear stress will lead to a clockwise rotation of the principal stress direction (\( \alpha > 0 \)), whereas a negative cartesian shear stress will rotate the principal stress counter-clockwise (\( \alpha < 0 \)). The plot of principal stress directions is only available in PLAXIS 2D. A graphical description of the principal stress directions is shown in *Figure 278* (on page 452).
9.3.4 Principal total stresses

The Principal total stresses are various stress measures based on the total stresses $\sigma$ (i.e. effective stresses + active pore pressures). A further selection can be made among the principal total stress directions, the individual principal total stress components $\sigma_1, \sigma_2, \sigma_3$, $(\sigma_1+\sigma_3)/2, (\sigma_1-\sigma_3)/2$, the principal stress directions, the mean total stress $p$, the deviatoric stress $q$, the relative shear stress $\tau_{rel}$ and the mobilised shear strength $\tau_{mob}$. The latter three quantities are equal to the corresponding ones in the Principal effective stress option, but are repeated here for convenience (Principal effective stresses (on page 450)).

Note that the total stress components are arranged in algebraic order:

$\sigma_1 \leq \sigma_2 \leq \sigma_3$

Hence, $\sigma_1$ is the largest compressive (or the smallest tension) principal stress and $\sigma_3$ is the smallest compressive (or the largest tension) principal stress.

9.3.5 Initial conditions

The Initial conditions sub-menu (Figure 279 (on page 453)) is only available in the initial phase. The spatial distribution of the Pre-Overburden Pressure (POP), as defined in the Preconsolidation tab in the Modify soil layers window, can be displayed and checked (Figure 280 (on page 453)).
Results available in Output program
Stresses

Figure 279: Initial conditions in the Stresses menu (Initial phase)

Figure 280: Example of POP distribution
9.3.6 State parameters

The State parameters are various additional quantities that relate to the state of the material in the current calculation step, taking into account the stress history. For more information regarding state parameters of each material model, see Material Models Manual.

9.3.6.1 The actual permeability

The actual permeability (\(\text{Permeability}_{\text{actual}}\)) is the relative permeability times the saturated permeability as defined in the flow parameters of the material set.

9.3.6.2 The strain history

The strain histories \(\varepsilon_{xx} - \varepsilon_{yy}, \varepsilon_{yy} - \varepsilon_{yy}, \varepsilon_{zz} - \varepsilon_{y} (\text{for axisymmetric models only}), \text{and } \varepsilon_{xy}\) are only available in the Hardening Soil model with small-strain stiffness.

9.3.6.3 The secant shear modulus

\(G_s\): The secant shear modulus \(G_s\) is only available in the Hardening Soil model with small-strain stiffness. This option may be used to check the actual secant shear modulus at the reference level, used in the current calculation step. More information about this parameter can be found in the Material Models Manual - The Hardening Soil model with small-strain stiffness - Describing small-strain stiffness with a simple hyperbolic law.

9.3.6.4 The ratio between the actual shear modulus and the unloading reloading stiffness

\(G/G_{ur}\): The ratio between the actual shear modulus \(G\) and the unloading reloading stiffness \(G_{ur}\) is only available in the Hardening Soil model with small-strain stiffness.

9.3.6.5 The equivalent isotropic stress

\(p_{eq}\): The equivalent isotropic stress \(p_{eq}\) is only available in the Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model and Sekiguchi-Ohta model. The equivalent isotropic stress is defined as the intersection point between the stress contour (with similar shape as the yield contour) through the current stress point and the isotropic stress axis. Depending on the type of model being used it is defined as:

<table>
<thead>
<tr>
<th>Model</th>
<th>Equation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardening Soil model and Hardening Soil model with small-strain stiffness.</td>
<td>(p_{eq} = \sqrt{p^2 + \frac{q^2}{a^2}})</td>
</tr>
<tr>
<td>Soft Soil model, Soft Soil Creep model and Modified Cam-Clay model. For the Modified Cam-Clay model, the cohesion (c) is defined as 0 kN/m².</td>
<td>(p_{eq} = p' - \frac{q^2}{M^2(p' - c\cot \phi)})</td>
</tr>
</tbody>
</table>

\(a\), \(M\), \(p'\), \(\phi\) are parameters specific to each model.
\[ p_{eq} = \frac{p'}{\exp\left(-\frac{q}{M_p}\right)} \]  
for the Sekiguchi-Ohta model.

More information about this parameter for each model can be found in the Material Models Manual.

9.3.6.6 The isotropic preconsolidation stress \( p_p \)

The isotropic preconsolidation stress \( p_p \) is only available in the Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model and Sekiguchi-Ohta model. The isotropic preconsolidation stress represents the maximum equivalent isotropic stress level that a stress point has experienced up to the current load step.

9.3.6.7 The isotropic overconsolidation ratio \( OCR \)

The isotropic overconsolidation ratio \( OCR \) is only available in the Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model and Sekiguchi-Ohta model. The isotropic overconsolidation ratio is the ratio between the isotropic preconsolidation stress \( p_p \) and the equivalent isotropic stress \( p_{eq} \).

9.3.6.8 The hardening parameter \( \gamma_p \)

The hardening parameter \( \gamma_p \) is only available for the Hardening Soil model and Hardening Soil model with small-strain stiffness. This option may be used to check the actual hardening during the current calculation step.

9.3.6.9 The maximum major effective principal stress \( \sigma'_{1,max} \)

The maximum major effective principal stress \( \sigma'_{1,max} \) is the maximum value of the major effective principal stress in the stress history up to the current results.

9.3.6.10 The overconsolidation ratio on major principal stress \( OCR_1 \)

The overconsolidation ratio on major principal stress \( OCR_1 = \sigma'_{1,max}/\sigma'_1 \), hence the maximum major effective principal stress in the stress history divided by the current major effective principal stress. Note that for the advanced models that include separate primary loading and unloading/reloading behaviour, the maximum major effective principal stress is also the principal preconsolidation pressure and so \( OCR_1 \) is a true overconsolidation ratio. However, for elastic and elastic-perfectly plastic models, such as the Linear Elastic, Mohr-Coulomb and Hoek-Brown models, there is no memory of preconsolidation and so the maximum major effective principal stress is just a maximum value that occurred and not a preconsolidation pressure. Hence, for these models \( OCR_1 \) is not a real overconsolidation ratio.

The overconsolidation ratio on major principal stress \( OCR_1 \) is mostly used for the SHANSEP models.

9.3.6.11 The actual stiffness \( E_{ur} \) for unloading and reloading

The actual Young's modulus \( E_{ur} \) for unloading and reloading is the unconstrained elastic stiffness modulus as used during the current calculation step. This option is only available in the Hardening Soil model, Hardening
Soil model with small-strain stiffness, Soft Soil model, Soft Soil Creep model, Modified Cam-Clay model and Sekiguchi-Ohta model.

The stiffness $E_{ur}$ depends on the stress level. In models with stress-dependency of stress, the actual stiffness $E_{ur}$ is calculated on the basis of the stresses at the beginning of the current step. The option may be used to check the actual stress-dependent stiffness used in the current calculation step.

### 9.3.6.12 The actual cohesion $c$

The actual cohesion $c$ is the cohesive strength as used during the current calculation step. This option is only available in the Mohr-Coulomb model, Hardening Soil model, Hardening Soil model with small-strain stiffness, Soft Soil model and Soft Soil Creep model.

When the Mohr-Coulomb model, Hardening Soil model or the Hardening Soil model with small-strain stiffness is utilised with an increasing cohesive strength with depth ($c_{\text{increment}} > 0$), this option may be used to check the actual cohesive strength profile used in the calculation.

### 9.3.7 Pore pressures

Pore pressures are the quantities that relate to the stress in the pores of the material. The pores in soil are usually filled with a mixture of water and air. In most cases, stresses and pore pressures in the soil are negative (pressure). However, due to capillary action or undrained unloading, pore pressures may become positive (tension), which is denoted as suction.

PLAXIS 2D distinguishes between different types of pore pressures and related quantities. It is important to understand the differences between these quantities in order to properly interpret the results from a PLAXIS 2D calculation.

Total stresses are divided into effective stresses, $\sigma'$, and active pore pressures, $p_{\text{active}}$.

$$\sigma = \sigma' + p_{\text{active}} \quad \text{Eq. [112]}$$

Note that all the effective and total stresses are tensorial quantities. Then pore pressure should be also understood as a diagonal tensor (pore pressure only applies to normal stress components).

Active pore pressures are defined as the effective saturation, $S_{\text{eff}}$, times the pore water pressures, $p_{\text{water}}$.

$$p_{\text{active}} = S_{\text{eff}} \cdot p_{\text{water}} \quad \text{Eq. [113]}$$

Pore water pressure differs from active pore pressure when the degree of saturation is less than unity, which is usually the case above the phreatic level. Below the phreatic level $p_{\text{active}}$ and $p_{\text{water}}$ are generally equal. For more details, refer Appendix D.

As an alternative to the pore water pressure, $p_{\text{water}}$, the groundwater head, $h$, can be viewed:

$$h = z - \frac{p_{\text{water}}}{\gamma_w} \quad \text{Eq. [114]}$$

where $z$ is the vertical coordinate and $\gamma_w$ is the unit weight of water. In the pore water pressure a further distinction is made between steady state pore pressure, $p_{\text{steady}}$, and excess pore pressure, $p_{\text{excess}}$.

$$p_{\text{water}} = p_{\text{steady}} + p_{\text{excess}} \quad \text{Eq. [115]}$$
where steady-state pore pressure is the steady-state or long term part of pore pressure, which is supposed to be input data for a deformation analysis.

Excess pore pressure is the result from undrained behaviour (Undrained (A) or (B), or low-permeable materials), and is affected by stress changes due to loading or unloading, a (sudden) change in hydraulic conditions and consolidation.

Below an overview is given of the various pore pressure related quantities that are available in the Stresses menu of the PLAXIS 2D Output program. Most quantities can be presented as Contour lines or Shadings. Although pore pressures do not have principal directions, the Principal stresses presentation can be useful to view pore pressures inside the model. In that case the colour of the lines represents the magnitude of the pore pressure and the directions coincide with the x-, y- and z-axis.

9.3.7.1 Groundwater head
The groundwater head is an alternative quantity for the pore water pressure, equivalent to the top level of a free water column.

9.3.7.2 Active pore pressure
The part of total stress in the pores of the soil. In saturated soil, active pore pressure is equal to the pore water pressure. In unsaturated soil, active pore pressure is the effective saturation times the pore water pressure.

9.3.7.3 Pore water pressure
The water pressure in the pores of the soil consisting of steady-state pore pressure and excess pore pressure. In most cases, pore water pressure is negative (pressure). However, due to capillary action or undrained unloading, pore water pressure may become positive (suction).

9.3.7.4 Steady-state pore pressures
Long-term part of pore water pressure which is supposed to be input data for a deformation analysis. Steady-state pore pressure is the result of a direct pore pressure generation based on phreatic levels and cluster-related pore pressure definition, or the result of a steady-state groundwater flow calculation. In the case of a fully coupled flow-deformation analysis, steady-state pore pressure is calculated from a steady-state groundwater flow calculation using the hydraulic boundary conditions at the end of the calculation phase. When the option ignore suction has been used, the steady-state pore pressure only includes negative values.

9.3.7.5 Excess pore pressure
Instationary part of pore water pressure that is a result of undrained behaviour (Undrained (A) or (B), or low-permeable materials), affected by stress changes due to loading or unloading, a (sudden) change in hydraulic conditions and consolidation. In the case of a fully coupled flow-deformation analysis, excess pore pressure is the difference between the calculated pore water pressure and the steady-state pore pressure. The latter is calculated from a steady-state groundwater flow calculation using the hydraulic boundary conditions at the end of the calculation phase. Excess pore pressure may show positive values (suction) as a result of undrained unloading, even when the option ignore suction has been selected.
Note: For Steady-state groundwater flow analysis a [ADV] licence is required (as minimum). For fully coupled calculations an [ULT] licence needs to be active.

9.3.7.6 Extreme excess pore pressure
Maximum and minimum values of excess pore pressure over the whole calculation phase up to the selected calculation step.

9.3.7.7 Change in pore pressure per phase
The change in active pore pressure from the beginning of a phase up to the selected calculation step.

9.3.7.8 Suction
Any positive value (tension) in the pore water pressure. Suction can be a result of capillary action (included in the steady-state pore pressure if the option Ignore suction has NOT been used) or undrained unloading (included in the excess pore pressure).

9.3.7.9 Effective suction
The net effect of suction on the soil stresses taking into account the degree of saturation. Hence, the effective suction is the suction times the effective degree of saturation. The occurrence of effective suction results into an increase of effective stresses, which may lead to an increased strength of the soil.

9.3.7.10 Pore pressure ratio
The ratio \( R_u \) of the excess pore pressure \( P_{\text{excess}} \) to the major principal effective stress \( \sigma'_1 \) at step 0 of the phase (initial stress).

9.3.8 Groundwater flow [ADV]
When a groundwater flow calculation has been performed to generate the pore pressure distribution, then the specific discharges at the element stress points are available in the Output program in addition to the pore pressure distribution. The specific discharges can be viewed by selecting the Groundwater flow option from the Stresses menu. A further selection can be made among the groundwater flow components, \( |q|, q_x, q_y \).

The flow field may be viewed as Arrows, Contour lines or Shadings by selecting the appropriate option from the presentation box in the tool bar. When the specific discharges are presented as arrows, then the length of the arrow indicates the magnitude of the specific discharge whereas the arrow direction indicates the flow direction.
9.3.8.1 Discharge ($|q|$, $q_x$, $q_y$)

The total discharge through a cross section can be obtained by drawing a cross section through the interface element and selecting Stresses $\rightarrow$ Groundwater flow $\rightarrow$ $|q|/q_x/q_y$. The value of total discharge is displayed below the plot in the unit of volume per unit of time, per unit of width in the out-of-plane direction.

9.3.8.2 Saturation

The PlaxFlow module within PLAXIS 2D may be used to calculate a pore pressure distribution for confined as well as for unconfined flow problems. The determination of the position of the free phreatic surface and the associated length of the seepage surface is one of the main objectives of an unconfined groundwater flow calculation. In this case a relationship is used between the pore pressure and the degree of saturation. Both quantities are calculated in a groundwater flow calculation and are made available in the Output program.

The degree of saturation is generally 100% below the phreatic level and it reduces to the residual saturation within a finite zone above the phreatic level. Note that the residual saturation value is equal to zero when suction is ignored. The saturation can only be presented as Contour lines or Shadings.

9.3.8.3 Hydraulic gradient ($i$)

The hydraulic gradient (also called groundwater head gradient or Darcy’s slope) between any two points is the rate of spatial variation of the hydraulic head measurements over the length of the flow path that links them. It is more generally expressed as the spatial derivative of the hydraulic head field, $i = \nabla h$. The hydraulic gradient together with the permeability tensor determines the flux of groundwater in the space. In isotropic media, the magnitude and direction of this parameter are proportional and opposite to the flow vector ($q$), as water flows from higher to lower hydraulic head locations. For the general evaluation of seepage problems in anisotropic media, it is crucial to consider both vectors independently.

The hydraulic gradient can be visualised by selecting the $|i|$ option or one of the available components $i_x$ and $i_y$. These can be presented as Contour lines, Shadings, and Arrows.

9.3.8.4 Effective saturation ($Saturation_{ef}$)

The effective saturation is used as the Bishop coefficient in the definition of Bishop stress and also to calculate the weight of soil. The effective saturation can only be presented as Contour lines or Shadings.

9.3.8.5 Relative permeability ($Permeability_{rel}$)

The relative permeability can be visualised by selecting the $Permeability_{rel}$ option. The relative permeability can only be presented as Contour lines or Shadings.

9.3.9 Heat flow [ADV]

When a Thermal flow calculation has been performed to generate the temperature distribution, then the heat fluxes at the element stress points are available in the Output program, in addition to the temperature distribution. The heat fluxes can be viewed by selecting the Heat flow option from the Stresses menu.
A further selection can be made among the heat flux components ($|q_t|$, $q_{tx}$, $q_{ty}$). Moreover, in case of partially saturated soils where part of the pore water is in the gas phase (vapour), the vapour flux can be selected. A further selection can be made among the vapour flux components ($|qv|$, $qv_x$, $qv_y$).

The heat flux and vapour flux may be viewed as Arrows, Contour lines or Shadings, by selecting the appropriate option from the presentation box in the tool bar. When the fluxes are presented as arrows, then the length of the arrow indicates the magnitude of the flux whereas the arrow direction indicates the flux direction.

### 9.3.10 Plastic points

- The Plastic points option shows the stress points that are in a plastic state, displayed in a plot of the undeformed geometry. Plastic points can be shown in the 2D mesh or in the elements around a cross section.

**Note:**

The Plastic point history option in the Stresses menu enables displaying in the model all the points that have been plastic in any step in the calculation history (depending on the specified criteria, Failure, Tension cut-off, etc.) generated up to the current calculation phase.

#### 9.3.10.1 Soil

The plastic stress points are indicated by small symbols that have different shapes and colours, depending on the type of plasticity that has occurred:

- A red cube (Failure point) indicates that the stresses lie on the surface of the failure envelope.
- A white cube (Tension cut-off point) indicates that the tension cut-off criterion was applied.
- A blue upside-down pyramid (Cap point) represents a state of normal consolidation (primary compression) where the preconsolidation stress is equivalent to the actual stress state. The latter type of plastic points only occurs if the Hardening Soil model, the Hardening Soil model with small-strain stiffness, the Soft Soil model, the Soft Soil Creep model or the Modified Cam-Clay model is used.
- A brown diamond (Cap+Hardening point) represents points that are on the shear hardening and cap hardening envelope. Such plastic points can only occur in the Hardening Soil model or the Hardening Soil model with small-strain stiffness.
- A green pyramid (Hardening point) represents points on the shear hardening envelope. Such plastic points can only occur in the Hardening Soil model, the Hardening Soil model with small-strain stiffness and the UBC3D-PLM model.
- A purple inverted triangle (Liquefaction point) represents a stress point which is liquefied, characterised by the pore pressure ratio $R_u > 0.95$. Such plastic points can occur only in the UBC3D-PLM model, the PM4Sand and User-defined Soil Model. When viewed in the Table view (Table of Cartesian effective stresses), the Status shows as 'Liquefied'.

In case the Concrete model is adopted, the symbols have different meanings:

- A red cube (Failure point) indicates that the stresses lie on the Mohr-Coulomb peak surface or the Mohr-Coulomb softening surface.
- A white cube (Tension cut-off point) indicates that the stresses lie on the failure envelope in tension, including the intersection between the Rankine surface and the Mohr-Coulomb surface.
- A green pyramid (Hardening point) represents points on the Mohr-Coulomb shear hardening envelope.
The failure points are particularly useful to check whether the size of the mesh is sufficient. If the zone of plasticity reaches a mesh boundary (excluding the centre-line in a symmetric model) then this suggests that the size of the mesh may be too small. In this case the calculation should be repeated with a larger model.

![Plastic points window](image)

*Figure 281: Plastic points window*

When *Plastic points* is selected in the *Stresses* menu the *Plastic points* dialog is shown (Figure 281). Here the user can select which types of plastic points are displayed. When the *Stress points* option is selected, all other stress points are indicated by a purple diamond shape. For details of the use of advanced soil models, the user is referred to the Material Models Manual.

By default both accurate and inaccurate plastic points are displayed in the model. Only the inaccurate plastic points are displayed as the corresponding check box is selected in the *Plastic points* window. Inaccurate plastic points are points where the local error is larger than the tolerated error (Automatic error checks). When the results are displayed with the *Table* option, an asterisk appears on the status column to identify the inaccurate plastic points.

### 9.3.10.2 Conventions used for Plastic point information with Paraview Export [GSE]

If *plastic point information* is exported from PLAXIS 2D to ParaView (see Paraview Export [GSE]), the point information will have associated different status described in Conventions used for Plastic point information with Paraview Export [GSE].

**Table 19: Conventions for plastic point results on Paraview**

<table>
<thead>
<tr>
<th>Value</th>
<th>Plastic point status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 or -1</td>
<td>MC accurate</td>
</tr>
<tr>
<td>2</td>
<td>Tension cut-off accurate</td>
</tr>
<tr>
<td>3</td>
<td>Cap Hardening accurate</td>
</tr>
<tr>
<td>4</td>
<td>Cap + Shear hardening accurate</td>
</tr>
<tr>
<td>5</td>
<td>Shear hardening accurate</td>
</tr>
<tr>
<td>Value</td>
<td>Plastic point status</td>
</tr>
<tr>
<td>-------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>6</td>
<td>Liquefaction accurate</td>
</tr>
<tr>
<td>11 or -11</td>
<td>MC inaccurate</td>
</tr>
<tr>
<td>12</td>
<td>Tension cut-off inaccurate</td>
</tr>
<tr>
<td>13</td>
<td>Cap Hardening inaccurate</td>
</tr>
<tr>
<td>14</td>
<td>Cap + Shear hardening inaccurate</td>
</tr>
<tr>
<td>15</td>
<td>Shear hardening inaccurate</td>
</tr>
<tr>
<td>16</td>
<td>Liquefaction inaccurate</td>
</tr>
</tbody>
</table>

9.3.11 Fixed end anchors

When *Fixed end anchors* is selected in the *Stresses* menu a table appears displaying the fixed end anchors available in the model, their location, the resulting axial force, the rotation angle and the equivalent length.

9.3.12 Node to node anchors

When *Node to node anchors* is selected in the *Stresses* menu a table appears displaying the node to node anchors available in the model, the location of the nodes and the resulting axial forces.

9.3.13 Wells [ADV]

When *Wells* is selected in the *Stresses* menu a table appears displaying the wells available in the model, the nodes representing the well and their location, the discharge of the entire well and the defined minimum groundwater head.

9.3.14 Drains [ADV]

When *Drains* is selected in the *Stresses* menu a table appears displaying the drains available in the model, the nodes representing the drain and their location, the total discharge and the defined groundwater head of the drain.
9.4 Structures and interfaces

By default, the structures active in the current phase are displayed in the model. Otherwise, these objects may be displayed in by switching the view on in the explorer.

Output for structures and interfaces can be obtained by clicking the Select structures button and then double-clicking the desired object in the 2D model. As a result, a new form is opened on which the selected object appears. At the same time the menu changes to provide the particular type of output for the selected object.

All objects of the same type with the same local coordinate system are automatically selected. When multiple objects or multiple groups of objects of the same type need to be selected, the Shift key should be used while selecting the objects. The last object to be included in the plot should then be double clicked. When all objects of the same type are to be selected, select one of the objects while pressing Ctrl-A simultaneously. If it is desired to select one or more individual elements from a group, the Ctrl key should be used while selecting the desired element.

Another option of selecting structural elements in the output is by clicking the Drag a window to select structures button and drawing a rectangle in the model. As a result, the structures in the rectangle will be selected.

9.4.1 Deformation in structures and interfaces

The deformation options for the structural elements are given in the Deformations menu. The user may select the Total displacements, the Phase displacements or the Incremental displacements (Deformations on page 445). For each item a further selection can be made among the displacement vectors $|u|$, and the individual total displacement components, $u_x$ and $u_y$.

The deformation options in the direction of local axis of the structures are available as well. The user may select the Total local displacements, the Phase local displacements or the Incremental local displacements. For each item a further selection can be made among the individual displacement components $u_1$ and $u_2$.

The Rotation option is available for Plates displaying the total rotation (Rotation) and the incremental rotation ($\Delta$Rotation) of the selected plates with respect to the global axes.

Note:

The Total Rotation and Incremental rotation for plates is positive in counter clockwise direction with respect to the global axis system.

Options such as Relative total displacements, Relative phase displacements and Relative increments are available for interfaces. Relative displacements are differential displacements between node pairs. These options may be used to view if plastic shearing has occurred in the interface.

Only in the case of semi-permeable interfaces, the output program shows the resulting specific discharge through the interface elements. This output is not available in the case of fully impermeable or fully permeable interface elements.

In the case of fully permeable interfaces, the resulting discharge through the interfaces can be obtained by drawing a cross section just outside the wall or tunnel lining, and plotting the flow through this cross section. The title of the cross section plot will indicate the total discharge through the cross section.
9.4.2 Resulting contraction in plates and geogrids

When a Line contraction is used in the calculation and the correspondent plate or geogrid is displayed, the realised contractions are available from the Deformations menu. The contraction can be positive (e.g. concrete shrinkage) or negative (e.g. thermal expansion of geogrids).

The realised contraction outputs are $C_{\text{tunnel}}$ and $C_{\text{planar}}$. The realised tunnel contraction, $C_{\text{tunnel}}$, returns the value as used in the calculation. The realised planar contraction, $C_{\text{planar}}$, is equal to $C_{\text{tunnel}}/2$. Assuming a case of line (circumference) contraction ($C_{\text{refline}}$) from an initial length $L_0$ to a final length $L$, against circular surface contraction ($C_{\text{refsurf}}$) from an initial area $A_0$ (with radius $R_0 = L_0/(2 \pi)$) to a final area $A$ (with radius $R = L/(2 \pi)$), the factor 2 is derived as such:

$$C_{\text{ref}} = \frac{\Delta L}{L_0} = \frac{L - L_0}{L_0} \quad \text{Eq. [116]}$$

$$C_{\text{ref}} = \frac{\Delta A}{A_0} = \frac{A - A_0}{A_0} \frac{(R_0 + \Delta R)^2 - R_0^2}{R_0^2} \cong 2 \frac{R - R_0}{R_0} = 2 \frac{L - L_0}{L_0} \quad \text{Eq. [117]}$$

The formulation above does not only apply to a circular surface but to all closed surfaces.

9.4.3 Resulting stresses in interfaces

Interface elements are formed by node pairs, i.e. two nodes at each node position: one at the 'soil' side and one at the 'structure' side or the other 'soil' side. Interfaces can be visualised by activating the corresponding option in the explorer at the left of the output window. Output for interfaces can be obtained by double clicking on the interface elements in the two-dimensional model. The output for interfaces comprises deformations (Deformations (on page 445)) and stresses.

When an interface is displayed, the options Effective $\sigma_N'$, Total $\sigma_N$, Shear $\tau$, Relative Shear $\tau_{\text{rel}}$, Groundwater flow, steady-state pore pressure $p_{\text{steady}}$, excess pore pressure $p_{\text{excess}}$, active pore pressure $p_{\text{active}}$, pore water pressures $p_{\text{water}}$, effective degree of saturation $S_{\text{eff}}$, suction, effective suction and Groundwater head are available from the Interface stresses menu. The effective normal stress is the effective stress perpendicular to the interface. Note that pressure is considered to be negative. The relative shear stress $\tau_{\text{rel}}$ gives an indication of the proximity of the stress point to the failure envelope, and is defined as:

$$\tau_{\text{rel}} = \frac{\tau}{\tau_{\text{max}}} \quad \text{Eq. [118]}$$

where $\tau_{\text{max}}$ is the maximum value of shear stress according to the Coulomb failure envelope for the current value of the effective normal stress.

9.4.3.1 Total discharge through an interface [ADV]

In the case of semi-permeable interfaces, the total discharge through an interface can be obtained by selecting the Interface stresses $\rightarrow$ Groundwater flow $\rightarrow q_n/Q_p$. Beneath the interface plot, the value of total discharge is displayed in the unit of volume per unit of time per unit of length in the out of plane direction. This option is
useful in scenarios where it is required to know the groundwater discharge through a tunnel lining or a retaining wall.

**Note:**
- It is strongly recommended to select only one interface, to view discharge results. If double interfaces (for example, in the case of interfaces on both sides of a retaining wall) are selected, the results for discharge through these interfaces can be misleading.
- This option is not viable in case of fully permeable interface elements as Darcy’s law cannot compute discharge for these scenarios. A workaround in such a case can be to use a semi-permeable interface and assign a very low hydraulic resistance \((d/k)\) in case of fully permeable interfaces.

### 9.4.4 Resulting stresses in discontinuities

Discontinuity elements are, like Interface elements, formed by node pairs, i.e. two nodes at each node position separating the rock mass on either side of the discontinuity. Discontinuities can be visualised by activating the corresponding option in explorer on the left side of the Output window. Output for discontinuities can be obtained by double clicking on the discontinuity elements in the two-dimensional model. The output for discontinuities comprises deformations (Deformations (on page 445)) and stresses.

When an discontinuity is displayed, the options Effective \(\sigma'_{N}\), Total \(\sigma_{N}\), Shear \(\tau\), Relative Shear \(\tau_{rel}\), Groundwater flow, pore water pressures \(p_{\text{water}}\) steady-state pore pressure \(p_{\text{steady}}\), excess pore pressure \(p_{\text{excess}}\) and Plastic points are available from the Discontinuity stresses menu. The effective normal stress is the effective stress perpendicular to the discontinuity. Note that pressure is considered to be negative. The relative shear stress \(\tau_{rel}\) gives an indication of the proximity of the stress point to the failure envelope, and is defined as:

\[
\tau_{rel} = \frac{\tau}{\tau_{\max}} \quad \text{Eq. [119]}
\]

where \(\tau_{\max}\) is the maximum value of shear stress according to the Coulomb failure envelope for the current value of the effective normal stress.

### 9.4.5 Resulting forces in plates

When a plate is displayed, the options Axial Forces \(N\), Shear Forces \(Q\) and Bending Moment \(M\) are available from the Forces menu. For axisymmetric models the Forces menu also includes the forces in the out-of-plane direction (Hoop Forces \(N_{z}\)). Hoop forces are expressed in unit of force per unit of length. The values are constant over the circumference. Integration of the hoop forces over the in-plane length of the plate will give the total hoop force. All of these forces represent the actual forces at the end of the calculation step.

In addition to the actual forces, PLAXIS 2D keeps track of the historical maximum and minimum forces in all calculation phases. These maximum and minimum values up to the current calculation step may be viewed after clicking the Distribution envelope button in the top toolbar.

Note that axial forces or hoop forces are positive when they generate tensile stresses, as indicated in Figure 282 (on page 466).
The Axial force N is the axial force along the element axis. The Shear force Q is the in-plane (XY) shear force. The Bending moment M is the bending moment due to bending over the out-of-plane axis (Z).

9.4.6 Resulting forces in geogrids

When a geogrid is displayed, the option Axial force is available. Forces in geogrids are always positive (tension). Compressive forces are not allowed in these elements.

In addition to the actual forces, PLAXIS 2D keeps track of the historical maximum and minimum forces in all calculation phases. These maximum and minimum values up to the current calculation step may be viewed after clicking the Distribution envelope button in the top toolbar.

9.4.7 Resulting forces in embedded beams

When an embedded beam is displayed, the options Axial force N, Shear force Q, Bending moment M, Skin force T_{\text{skin}} (in axial pile direction) the lateral force T_{\text{lat}} the maximum shear stress T_{\text{skin, max}} and the relative shear stress T_{\text{skin, rel}} are available from the Forces menu. The latter four options relate to the pile-soil interaction (see below).

Note:
The Axes option from the View menu may be used to display the pile’s local system of axes.

The pile-soil interaction forces are obtained from the special interface that is automatically applied between the embedded beam elements and the surrounding soil volume elements. The Skin force T_{\text{skin}} expressed in the unit of force per unit of pile length per unit of width in the out-of-plane direction, is the force related to the relative displacement in the pile's first direction (axial direction). This force is limited by the skin resistance as defined in the embedded beam material data set (General properties (on page 288)).

The interaction force T_{\text{lat}} relates to the relative displacement perpendicular to the pile in the pile’s second direction. These quantities are expressed in the unit of force per unit of pile length per unit of width in the out-of-plane direction.

The maximum shear stress T_{\text{skin, max}} is the limit defined for the material dataset. The relative shear stress T_{\text{skin, rel}} gives an indication of the proximity of the stress point to the failure envelope.

The pile foot force F_{\text{foot}} expressed in the unit of force per unit of width in the out-of-plane direction, is obtained from the relative displacement in the axial pile direction between the foot or tip of the pile and the surrounding soil. The foot force is shown in the plot of the Axial force N. The foot force is limited by the base resistance as defined in the embedded beam material data set (General properties (on page 288)).
In addition to the actual forces, PLAXIS 2D keeps track of the historical maximum and minimum forces in all calculation phases. These maximum and minimum values up to the current calculation step may be viewed after clicking the Distribution envelope button in the top toolbar.

**Note:** From PLAXIS 2023.2 resulting forces in embedded beams (and rock bolts) are calculated in output per embedded. Hence, the spacing between elements in the out-of-plane space is already taken into account.

### 9.4.8 Resulting forces in cables

When a cable is displayed, from the Forces menu the options available are Axial forces $N$, Shear force in bond $T_{s,bond}$ (in axial direction of the cable), Maximum shear force in bond $T_{s,bond,max}$ Relative shear force in bond $T_{s,bond,rel}$, and Normal force in bond $T_{n,bond}$.

**Note:**
The Axes option from the View menu may be used to display the pile's local system of axes.

The cable-rock/soil interaction forces are obtained from a special bond(interface) element that is automatically applied between the cable elements and the surrounding rock/soil volume elements.

The $T_{s,bond}$ expressed in the unit of force per unit of cable length per unit of width in the out-of-plane direction, is the skin friction force developed by the cable is related to the relative displacement in the axial direction. This force is limited by the bond strength limit, $T_{s,bond,max}$ defined by the strength parameters in Mechanical properties (on page 299).

The $T_{s,bond,max}$ is the shear stress limit value of the cohesive strength as defined in the material dataset. The relative shear stress, $T_{s,bond,rel}$ gives an indication of the proximity of the stress point to the failure envelope. It can be expressed as:

$$T_{s,bond,rel} = \frac{T_{s,bond}}{T_{s,bond,max}} \quad \text{Eq. [120]}$$

The $T_{n,bond}$ corresponds to the relative displacement in the direction perpendicular to the cable’s axis, as a force per unit of cable’s length per unit of width in the out-of-plane direction.

In addition to the actual forces, PLAXIS keeps track of the historical maximum and minimum forces in all calculation phases. These maximum and minimum values up to the current calculation step may be viewed after clicking the Distribution envelope button in the top toolbar.

**Note:** From PLAXIS 2023.2 resulting forces in the cables are calculated in output per cable element. Hence, the spacing between elements in the out-of-plane space is already taken into account.

### 9.4.9 Resulting force in anchors

Output for anchors (fixed-end anchors as well as node-to-node anchors) involves only the anchor force expressed in the unit of force on the anchor (on the nodes in node-to-node anchor). The anchor force appears in
a table after double clicking the anchor in the model. The program displays the values of the historical maximum and minimum forces in all calculation phases in node-to-node anchors.

### 9.4.10 Results in connections

The results in the connections available in the model are displayed when the *Connections information* option is selected in the *Project* menu. An example of the appearing information window is given in Figure 283 (on page 468).

![Figure 283: Resulting bending moment in a rotation spring](image)

### 9.4.11 Structural forces in volume plates

The *Structural forces in volume plates* feature is available in the toolbar or as an option in the *Tools* menu in the Output program (Tools menu (on page 413)). Using this feature, it is possible to visualise structural forces (bending moments M, shear forces Q and axial forces N) in a regular structure (rectangular or tapered) that is composed of volume elements in which only stresses have been calculated. In this way it is possible, for example, to display the structural forces in a wall structure that is composed of volume elements with an assigned data set with concrete properties.

**Note:**

- Note that the structural forces are calculated by integrating the results in the stress points along the region perpendicular to the cross section line. Special care is required when the structural forces in the region of connection of the subparts are evaluated.

#### 9.4.11.1 Creating a cross section line

When the feature is selected the *Draw a centerline* button in the side toolbar is automatically selected and the *Center line points* window pops up (Figure 284 (on page 469)).
The cross section line may consist of several line sections. The points defining the segments composing the centerline can be defined either by directly clicking on the model or by defining the coordinates of the location in the Center line points window. The process of center line definition can be quit by either clicking the OK button in the Centerline points window or by right clicking and selecting the Finish option in the appearing menu. The structural forces are then computed on-the-fly and visualised along the created line.

**From tunnel designer:** It is also possible to define the Center line points using the option From tunnel designer, by clicking on the dropdown menu using Add. To be able to use this option, a thick lining must be present in the tunnel. This can be done in Input using the Tunnel designer (for more detailed information, refer Create polycurve). When the thick lining is added to a tunnel, PLAXIS 2D automatically generates a data.otnl, which is stored in the folder of the current project. This file contains all the information about the center line.

Click OK to view the Forces.

**Note:**

Note that when more than one thick lining is defined, the data.otnl is overwritten in the project folder. To save both files, the user must manually rename the existing data.otnl before saving the new thick lining.

**Import:** Center line points can also be imported using the Import option, by clicking on the dropdown menu using Add. The *.otnl, *.tnl or *.json files are located in the project folders.

Click OK to view the Forces.

At the drawn cross section line, the selected structural force is calculated on the basis of the integral of the stresses perpendicular to the cross section line. The extent of the area that is used to integrate the stresses is limited by a radius. The default radius, for each point of the cross section, is defined by the elements that contain the same material data set as the element in which the cross section point is drawn. However, this radius may be redefined by the user.

9.4.11.2 Automatic center lines wizard [GSE]

As an alternative to the manual creation of a centerline, the centerline can be automatically generated using the Generate centerlines wizard.

The automatic center lines wizard can be used in two situations as described below.
Criteria

In this blue tabsheet, it is possible to select the materials whose centerline is required for calculation of structural forces. In addition, individual volume clusters can be specified in the righthand panel. Click Detect button to generate the center lines.

Center lines

In this orange tabsheet, the results for the centerlines are shown. Here it is possible to select the specific centerline of interest. Each centerline can easily be toggled to show or hide it.
The structural forces are computed by integrating the stresses along the cross-sections which are perpendicular to the centerlines which have been generated in the previous step.

9.4.11.3 Changing the extent of the stress range

The range of the stress to be taken into account can be modified by specifying the radius of the extension from the centerline. The initial radius is determined by the distance, across the cross section line (centerline), to the nearest cluster which has a different material assigned.

When the Edit radii button is clicked in the side toolbar, the extent of the stress range is indicated in the plot by a transparent green colour (Figure 288 (on page 472)).
It is possible to modify the stress range by clicking on the highlighted area and dragging this area by the mouse (Figure 288 (on page 472)).

Note that the dragging location affects the way how the radii are modified. If the area is dragged near the start or near the end of the centerline, only the radius for that location (start radius or end radius) will be modified. This option may be used for tapered structures. However if the dragging location is approximately in the middle of both ends of the centerline, both radii will be modified.

Alternatively, if the segment is double-clicked, a dialog will be opened in which the radii can be specified precisely (Figure 289 (on page 473)). The defined cross section lines (center lines) can be removed from the plot by right clicking on the plot and by selecting the *Clear all* option appearing when the *Lines* option is pointed in the appearing menu.

**Note:**

The *Create animation* feature can be used to view the evolution of the structural forces in volumes in calculation phases.
Results available in Output program

Structures and interfaces

Figure 289: Edit radii window
The development of quantities over multiple calculation steps at a specified location in the model can be viewed using the Curve manager facility. This facility allows for the generation of load-displacement curves, force-displacement curves, stress-paths, strain paths, stress-strain curves and time-related curves.

10.1 Selecting points for curves

The location in the model where the variation of results through calculation steps is to be analysed is specified by selecting nodes or stress points in the model. The selection of points should be done preferably before but may also be done after calculating the project.

In order to specify points to be considered in curves, the Select points for curves option should be selected. This option is available as a button in the toolbar of the Staged Construction mode in PLAXIS input and as an option in the Tools menu of the Staged Construction mode. Selecting this option will open the Output program displaying the Connectivity plot and the Select points window.

Nodes and stress points can be selected in the Output program either by clicking the Select points for curves button in the side toolbar or by selecting the corresponding option in the Tools menu. More information on selecting procedure is given in Mesh point selection (on page 474).

It is important to consider the differences in selecting the points before or after starting the calculation process. A more detailed description is given in Pre-calculation points (on page 475) and Post-calculation points (on page 476).

10.1.1 Mesh point selection

Nodes and stress points can directly be selected by clicking them in the 2D model. Make sure that the Nodes numbers and/or Stress point numbers option has been selected in the Mesh menu.

The amount of visible nodes and stress points can be decreased using the Partial geometry option in the Geometry menu or by clicking the Hide soil button in the side toolbar.

In the Select points window (Figure 290 (on page 475)), the coordinates of the location of interest can be specified. The program lists the number of the nearest node and stress points at the lower part of the window when the Search closest button is clicked. The nodes and stress points can be selected by defining their ID as well. The displayed nodes or stress points are selected as the corresponding button at the right of the cell is checked. The selections are listed in the upper part of the window.
Selected nodes can be deselected by selecting the point in the list and pressing *Delete* or by clicking the point in the model.

**Note:**
When the *Select points for curves* option is selected but the *Select points* window is closed, it can be displayed by selecting the *Mesh point selection* option in the *Tools* menu.

If the finite element mesh is regenerated (after being refined or modified), the position of nodes and stress points will change. As a result, previously selected nodes and stress points may appear in completely different positions. Therefore nodes and stress points should be reselected after regeneration of the mesh.

### 10.1.2 Pre-calculation points

After the calculation phases have been defined and before the calculation process is started, some points may be selected by the user for the generation of load-displacement curves or stress paths. During the calculation, information for these selected points for all the calculation steps is stored in a separate file. The precalculation points provide more detailed curves.
10.1.3 Post-calculation points

When the calculations are started without the selection of nodes and stress points for curves, the user will be prompted to select such points. The user can then decide to select points or, alternatively, to start the calculations without pre-selected points. In this case, it is still possible to generate load-displacement curves or stress-strain curves after the calculation, but such curves may be less detailed.

When a node or stress point is selected after calculating the project, only the information for the saved calculation steps is available. For more detailed curves the value of the Max number of steps stored should be increased.

Note:
In generating curves, the user can use pre-calculation selected points and post-calculation selected points. However, with structural forces, this can be done only using post-calculation selected structural nodes.

The information available for selected points (nodes or stress point) depends on the view in which they have been selected in the Output program.

The points selected in the Model view, can be used to generate curves related to displacements, stresses, strains and state parameters in soil elements. The Model view is the default view in the Output program.

The points selected in the Structure view, can be used to generate curves related to resulting structural forces. The points should be selected after selecting the structure first (Select structures (on page 424)). The Structure view is displayed when structures are selected and double clicked.

Note:
The type of the active view is indicated by the corresponding icon under the plot.

10.2 Generating curves

To generate curves, the Curves manager option should be selected from the Tools menu or the corresponding button in the toolbar should be clicked. As a result, the Curves manager window appears with three tabsheets named Charts, Curve points and Select points.

The Charts tabsheet contains the saved charts that were previously generated for the current project. The Curve points tabsheet gives an overview of the nodes and stress points that were selected for the generation of curves, with an indication of their coordinates. The list includes the points selected before the calculation (pre-calc) as well as the points selected after the calculation (post-calc) (Figure 291 (on page 477)). For points that are part of a structure further information is given in the list about the type of structure and the corresponding structure element number. The Select points window is described in Mesh point selection (on page 474).
As a next step to generate curves, the New button should be pressed while the Charts tabsheet is active. As a result, the Curve generation window appears, as presented in Figure 292 (on page 478).

Two similar groups with various items are shown, one for the x-axis and one for the y-axis of the curve. The x-axis corresponds to the horizontal axis and the y-axis corresponds to the vertical axis. For each axis, a combination of selections should be made to define which quantity is plotted on that axis. First, for each axis a selection should be made whether the data to be shown is related to the general project (Project) or a particular selected node or stress point. The tree in the Curve generation window will then show all quantities which are available depending for this type of data. The tree can be expanded by clicking the + sign in front of a group. The Invert sign option may be selected to multiply all values of the x-quantity or the y-quantity by -1. When both quantities have been defined and the OK button is pressed, the curve is generated and presented in a chart window.

The combination of the step-dependent values of the x-quantity and the y-quantity forms the points of the curve to be plotted. The number of curve points corresponds to the available calculation step numbers plus one. The first curve point (corresponding to step 0) is numbered as 1.
Curves
Generating curves

Figure 292: Curve generation window

Note:

- When curves are generated from points selected after the calculation, only information of saved steps can be considered. The number of the saved steps for each calculation phase is defined by the Maximum number of steps stored option in the Numerical control parameters subtree in the Phases window (Numerical control parameters (on page 356)).
- All the calculation results are available for the pre-selected points.

10.2.1 Load-displacement curves

Load-displacement curves can be used to visualise the relationship between the applied loading and the resulting displacement of a certain point in the geometry. In general, the $x$-axis relates to the displacement of a particular node (Deformations), and the $y$-axis contains data relating to load level. The latter is related with the value of $\Sigma M_{stage}$ in the following way: Applied load = Total load applied in previous phase + $\Sigma M_{stage}$ · (Total load applied in current phase - Total load applied in previous phase). Also other types of curves can be generated.

The selection of Displacement must be completed with the selection of a node in the drop-down menu and the selection of a displacement component in the Deformations subtree. The type of displacement can be either the length of the displacement vector ($|\mathbf{u}|$) or one of the individual displacement components ($u_x$, $u_y$). The displacements are expressed in the unit of length, as specified in the Project properties window of the Input program.

To define a multiplier on the $y$-axis, first the Project option should be selected as the activation of a load system is not related to a particular point in the geometry. The selection must be completed with the selection of the desired load system, represented by the corresponding multiplier in the Multiplier subtree. Note that the 'load' is
not expressed in units of stress or force but in a multiplier value without unit. To obtain the actual load, the presented value should be multiplied by the input load as specified by means of staged construction.

Another quantity that can be presented in a curve is the Pore pressure. This quantity is available for selected nodes as well as stress points. In the Pore pressures subtree of the Stresses tree $p_{\text{active}}$, $p_{\text{steady}}$ or $p_{\text{excess}}$ can be selected. Pore pressures are expressed in the unit of stress.

When non-zero prescribed displacements are activated in a calculation, the reaction forces against the prescribed displacements in the $x$- and $y$-direction are calculated and stored as output parameters. These force components can also be used in the load-displacement curves by selecting the option Project and then selecting one of the forces in the Forces subtree. In plane strain models the Force is expressed in the units of width in the out-of-plane direction. In axisymmetric models the Force is expressed in the unit of force per radian. Hence, to calculate the total reaction force under a circular footing that is simulated by means of prescribed displacements, the $F_y$ value should be multiplied by $2\pi$.

### 10.2.2 Force-displacement curves

Force-displacement curves can be used to visualise the relationship between the development of a structural force quantity and a displacement component of a certain point in the geometry. A structural force quantity can only be selected for nodes being selected after the calculation. In general, the $x$-axis relates to the displacement of a particular node (Displacement), and the $y$-axis relates to the corresponding structural force of a node of a structural element.

To define a displacement on the $x$-axis, first the desired node should be selected. The selection must be completed with the selection of the type of displacement. This displacement can be either the length of the displacement vector ($|u|$) or one of the individual displacement components ($u_x$, $u_y$). The displacements are expressed in the unit of length, as specified in the General settings window of the Input program.

To define a structural force on the $y$-axis, first the desired node of the structural element should be selected. The selection of Structural force must be completed with the selection of type of force. Depending on the type of structural element, a selection can be made among axial forces $N$, shear forces $Q$ or bending moments $M$. In case of interfaces, a selection can be made among the interface stresses (Structures and interfaces (on page 462)).

### 10.2.3 Displacement-time or force-time curves

Time-dependent curves can be useful to interpret the results of calculations in which the time-dependent behaviour of the soil plays an important role (e.g. consolidation and creep). In this case, the Time option is generally selected for the $x$-axis, and the $y$-axis contains data for a displacement component, a stress component, a structural force quantity, or the temperature of a particular node or stress point. The selection of Time requires the Project option to be selected. Time is expressed in the unit of time, as specified in the Project properties window of the Input program.

Instead of selecting time for the horizontal axis, it is also possible to select the calculation step number (Step). This may also give useful curves for time independent calculations. When interpreting such a curve it should be noted that during the calculation the step size might change as a result of the automatic load stepping procedures.
10.2.4 Stress and strain diagrams

Stress and strain diagrams can be used to visualise the development of stresses (stress paths) or strains (strain paths) or the stress-strain behaviour of the soil in a particular stress point. These types of curves are useful to analyse the local behaviour of the soil. Stress-strain diagrams represent the idealised behaviour of the soil according to the selected soil model. Since soil behaviour is stress-dependent and soil models do not take all aspects of stress-dependency into account, stress paths are useful to validate previously selected model parameters.

First a stress point should be selected before the desired quantity can be selected in the Stress or Strain tree. The selection must be completed with the selection of the type of stress or strain. As a stress quantity all scalar quantities available in the Stresses menu can be selected ([Stresses](on page 449)). However, the State parameters option is only available for stress points selected after the calculation ([Post-calculation points](on page 476)). As a strain quantity all scalar strain quantities available in the Deformations menu can be selected ([Deformations](on page 445)).

See the Scientific Manual for a definition of the stress and strain components. The phrase 'in absolute sense' in the description of the principal components is added because, in general, the normal stress and strain components are negative (compression is negative). Stress components are expressed in the units of stress; strains are dimensionless. A definition of the stress and strain components is given in the Material Models Manual.

10.2.5 Curves in Dynamics calculations [ULT]

The Curve generation window differs when dynamics calculations are executed in the project. The normal tabsheet is similar to the tabsheet when no dynamics calculations are performed. However, the Dynamics time option is available in the tree when Project is selected in the axis parameter drop down menu. When a node is selected, the Velocities, Accelerations and Acceleration ('g') options are available under Deformation ([Figure 293](on page 481)).

Note:

In generating curves, the user can use pre-calculation selected points and post-calculation selected points. However, with structural forces, this can be done only using post-calculation selected structural nodes. For more information, see [Post-calculation points](on page 476).
10.2.5.1 PSA spectrum

During an earthquake, the soil vibration causes forced vibrations on the overlying structure. The structure can be idealised as a single degree of freedom (SDOF) system, i.e. a simple model characterized by a mass $m$, concentrated in a point, a stiffness $k$ and a damping ratio $\xi$. The dissipation, due to structural elements, is simulated through viscous actions depending on the velocity (See Figure below).

![Figure 294: Single Degree Of Freedom System](image)

The dynamics equation of motion is given by:

$$m\ddot{u} + c\dot{u} + ku = -m\ddot{u}_g \quad \text{Eq. [121]}$$

where $\dot{u}$, $u$ and $\ddot{u}$ represent the displacement, velocity and acceleration of the mass with respect to the base, respectively, $c$ is a damping coefficient and $\ddot{u}_g$ is the input motion. The relationship between $c$ and $\xi$ is expressed by the following equation:
The solution $u(t)$ of a SDOF system subjected to an earthquake is given by Duhamel’s integral and its maximum value is used to plot the relative displacement response spectrum. In general, the response spectrum is the locus of the maximum response of SDOF systems characterised by different $k$ and subjected to the same earthquake, for a given damping ratio. The maximum response can be calculated in terms of displacements, velocities or accelerations. The relative displacement response spectrum $S_D$ is given by:

$$S_D = |u|_{\max} \quad \text{Eq. [123]}$$

The relative pseudospectral velocity PSV and the absolute pseudospectral acceleration PSA are related to the relative displacement response spectrum according to the following equations:

$$PSV = \omega_0 \cdot S_D \quad \text{Eq. [124]}$$

$$PSA = \omega_0^2 \cdot S_D \quad \text{Eq. [125]}$$

where $\omega_0$ represents the natural angular frequency of the structure, $\omega_0 = \sqrt{k/m}$. PSV and PSA are indicated as pseudo quantities because, in a damped system, they do not coincide exactly with the maximum relative velocity ($|\dot{u}|_{\max}$) and the maximum absolute acceleration ($|\ddot{u} + \ddot{g}|_{\max}$).

The maximum response is plotted on the y-axis of the response spectrum, while the natural period $T$ is represented on the x-axis, which contains the information about the structure stiffness $k$ and mass $m$, as shown in the following equation:

$$T = \frac{2\pi}{\omega_0} = 2\pi \sqrt{\frac{m}{k}} \quad \text{Eq. [126]}$$

By varying $k$, it is possible to obtain the response of all the possible SDOF systems for that specific seismic signal for a given damping ratio $\xi$. For typical structures in reinforced concrete where the damping is mainly due to non-structural elements such as partition walls, $\xi$ is generally set equal to 5%. Higher values may be used in other specific cases, for instance when the structure is isolated at the base with dampers, which results in lower y-values in the response spectrum.

Considering the PSA spectrum, the value that can be read on the Y-axis corresponding to the natural period of vibration of the overlying structure allows to calculate the maximum shear stress at the base of the structure, equal to the maximum inertial force of a structure with mass $m$ subjected to an acceleration given by the selected PSA value (Figure 295 (on page 483)):

$$F_{\max} = m \cdot PSA = \frac{PSA}{g}w \quad \text{Eq. [127]}$$

where $g$ is the gravity acceleration and $w$ is the weight of the structure.

To generate the response spectrum, select the PSA tab from the Curve generation window when selecting New in the Curve manager (Figure 295 (on page 483)). In the PSA tab, a selection has to be made among horizontal acceleration ($a_x$), vertical acceleration ($a_y$) or absolute value of the acceleration (vectorial length). Subsequently, the structural damping ratio, $\xi$, has to be specified, together with the maximum natural period of the structure, $T$. 

---

**Curves**

Generating curves

\[ \xi = \frac{c}{2\sqrt{km}} \quad \text{Eq. [122]} \]

\[ S_D = |u|_{\max} \quad \text{Eq. [123]} \]
An example of a pseudo-acceleration response spectrum determined at the foundation level at the end of a site response analysis is shown in the figure below.
Figure 296: PSA

Based on the PSA diagram, it is possible to determine the predominant period, i.e. the period related to the peak PSA value. In the PSA diagram in Figure 296 (on page 484), this is equal to 0.4 s. If the natural period of the structure corresponds to the predominant period, the structure, subjected to the selected earthquake and in that specific soil condition, is in resonance, i.e. the system oscillates with very high amplitudes which can cause great damages in the building.

Once the PSA spectrum has been generated, it is possible to display the relative displacement response spectrum by selecting Settings under the Format menu. The Settings window opens and it is possible to select the Chart tabsheet and the Relative displacement response spectrum option (Figure 297 (on page 485)).
The corresponding chart (Figure 298 (on page 485)) shows the maximum relative displacement that can occur in the structure, characterised by a natural period of vibration $T$ and subjected to an earthquake, for a given damping ratio $\xi$. 

![Figure 297: Generate Relative displacement response spectrum](image)

![Figure 298: Relative displacement response spectrum](image)
The product of the maximum relative displacement and the stiffness $k$ represents the maximum equivalent static force, i.e. the static force that causes the same maximum deformation induced by the earthquake:

$$F_{\text{max}} = k \cdot S_D \quad \text{Eq. [128]}$$

By comparing the PSA spectrum with the Relative displacement response spectrum, it can be seen that at low periods, that characterize rigid structures, the displacement is close to zero. Ideally, in an undamped perfectly rigid structure ($T = 0$) subjected at the base to an acceleration $\ddot{u}_g(t)$, the mass moves together with the soil, i.e. there is no relative displacement of the mass ($|u|_{\text{max}} = 0$) and the pseudo spectral acceleration coincides with the maximum absolute acceleration at that level and so, with the maximum acceleration of the soil ($|\ddot{u} + \ddot{u}_g|_{\text{max}} = |\ddot{u}_g|_{\text{max}}$).

By increasing the period, both the PSA and the relative displacement increase. For very high periods, the maximum response in terms of acceleration tends to decrease and reaches values even lower than the maximum acceleration at the selected level. The relative displacement tends to the absolute displacement of the soil. Ideally, in an undamped highly flexible structure ($T = \infty$) subjected at the base to an earthquake, the relative displacement of the mass coincides with the absolute displacement of the soil.

Reinforced concrete structures are generally characterised by periods of vibration corresponding to an amplification of the acceleration of the soil.

### 10.2.5.2 Amplification

The Amplification tabsheet enables obtaining the plot which shows the ratio of the acceleration response of any point (Top) to the acceleration response of another point (Bottom) which is preferably the point where input load is applied ("Figure 299 (on page 487)"). This gives the magnification of the response at one point with respect to given excitation.
10.2.5.3 Fourier

A quantity plotted in the time domain can be transformed into the frequency domain through the Fast-Fourier Transform (FFT), which contains both the amplitude and the phase information of the signal. From the computed FFT, the user can plot the *Power Spectrum* and the *Fourier Amplitude Spectrum (FAS)* for each acceleration component.
10.2.5.4 Arias intensity

The Arias intensity, $I_a$ (length/dyn. time) is used to determine the strength of a ground motion (intensity of shaking). It is calculated based on the time history acceleration, $a(t)$, in a node:

$$I_a = \frac{a}{2g} \int_0^{T_d} [a(t)]^2 \, dt \quad \text{Eq. [129]}$$

where $g$ is the gravity acceleration and $T_d$ is the duration of the motion (i.e. maximum dynamics time in the time history acceleration).

In the Chart tabsheet, the user can choose to represent $I_a$, Arias intensity in percentage as shown in Figure 301 (on page 489). The Arias Intensity has the dimension of velocity (Figure 302 (on page 490)).
Figure 301: Arias intensity for input accelerograms
Curves
Generating curves

Figure 302: Arias curve generation

The Arias intensity curve is shown in Figure 303 (on page 491).
10.2.5.5 Transformation of curves from time to frequency domain

Once a time curve has been generated, it is possible to transform this curve into a frequency spectrum using the Fast Fourier Transform (FFT). This can be done in the Chart tabsheet of the Settings window (Figure 304 (on page 492)).

For curves created in the Normal and Amplifications tabsheets of the Curve generation window, you can select the option Use frequency representation (spectrum) and one of the three types of spectrum (Standard frequency (Hz), Angular frequency ([rad/s]) or Wave period(s)).

The three optional quantities on the horizontal axis are related as follows:

\[
\omega = 2\pi f = \frac{2\pi}{T} \quad \text{Eq. [130]}
\]

where \(\omega\) is the Angular Frequency, \(f\) is the Standard Frequency, \(T\) is the Wave Period.

Upon clicking on the OK button the existing time curve will be transformed into a spectrum. The original curve can be reconstructed by de-selecting the frequency representation in the Chart tabsheet.

Figure 303: Plot for Arias intensity curve
10.3 Formatting curves

Once a curve has been generated, a new chart window is opened in which the generated curve is presented. The quantities used to generate the curve are plotted along the x- and y-axis. By default, a legend is presented at the right hand side of the chart. For all curves in a chart, the legend contains the Curve title, which is automatically generated with the curve. An example of curves in Output program is given Figure 305 (on page 493).
10.3.1 Menus for curves

The menus in menu bar when curves are displayed vary slightly from the ones in the Output program. A description of the menus and the options available in them is given as follows.

10.3.1.1 File menu

The File menu is basically the same with the one available in the Output program. For a more detailed description see File menu (on page 407).

10.3.1.2 Edit menu

Note that Edit menu is only available when the curves are displayed. The options available can be used to include curves in the current chart. These options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>To export the chart to other programs using the Windows clipboard function. This feature is described in detail in Exporting output data (on page 417).</td>
</tr>
<tr>
<td>Add curve from current project</td>
<td>To add a new curve to the active chart from the current project.</td>
</tr>
<tr>
<td>Add curve from another project</td>
<td>To add a new curve to the active chart from another project.</td>
</tr>
<tr>
<td>Add curve from clipboard</td>
<td>To add a new curve to the active chart from clipboard.</td>
</tr>
</tbody>
</table>
Curves
Formatting curves

Note:

- The added curves are redefined using the data from either the current project, another project or clipboard. It is not possible to mount a generated curve to the current chart.
- It is possible to add a curve to the active chart using the Add curve option in the corresponding option in the right mouse click pop-up menu.

10.3.1.3 View menu

The display of the results in the window is arranged using the options available in the View menu. These options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset view</td>
<td>To reset a zoomed view.</td>
</tr>
<tr>
<td>Table</td>
<td>To display the data series in a table. More information on tables is given</td>
</tr>
<tr>
<td></td>
<td>in the Editing curve data in table (on page 494).</td>
</tr>
<tr>
<td>Legend</td>
<td>To toggle the display of the legend in the chart.</td>
</tr>
<tr>
<td>Legend in chart</td>
<td>To locate the legend in the chart.</td>
</tr>
<tr>
<td>Value indication</td>
<td>To toggle the display of information about the points in the curves when the</td>
</tr>
<tr>
<td></td>
<td>mouse pointer is located on them.</td>
</tr>
</tbody>
</table>

Note:

- For a more detailed view of particular regions in curves, press the left mouse button at a corner of the zoom area; hold the mouse button down and move the mouse to the opposite corner of the zoom area; then release the button. The program will zoom into the selected area. The zoom option may be used repetitively.
- The zoomed view can be reset by clicking the corresponding button in the toolbar as well.

10.3.1.4 Format menu

The Format menu contains the Settings option, selecting which displays the corresponding window where the layout of the chart and curves can be modified.

10.3.1.5 Window and Help menus

These menus contain the same options as defined in Window menu (on page 415) and Help menu (on page 415).

10.3.2 Editing curve data in table

In contrast to the general Output program, the Curves part allows for editing of the table by the user using the options in the menu appearing as the table is right clicked.
Editing load-displacement curves is often needed when gravity loading is used to generate the initial stresses for a project. As an example of the procedures involved, consider the embankment project indicated in Figure 306 (on page 495).

In this example project soil is to be added to an existing embankment to increase its height. The purpose of this example analysis is to calculate the displacement of point A as the embankment is raised. One approach to this problem is to generate a mesh for the final embankment and then deactivate the clusters corresponding to the additional soil layer by using the Initial geometry configuration item of the input program.

An alternative procedure would be to generate the initial stresses for the project, i.e. the stresses for the case where the original embankment has been constructed but the new material has not yet been placed. This should be done using the gravity loading procedure. In this procedure the soil self-weight is applied by increasing $\Sigma M_{\text{weight}}$ from zero to 1.0 in a Plastic calculation using Total multipliers as Loading input.

---

### Formatting curves

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete rows</td>
<td>To delete selected rows in the table.</td>
</tr>
<tr>
<td>Update chart</td>
<td>To update chart according to the modifications made in the table.</td>
</tr>
<tr>
<td>Align</td>
<td>To align the text in the selected part of the table.</td>
</tr>
<tr>
<td>Decimal</td>
<td>To display data in decimal representation.</td>
</tr>
<tr>
<td>Scientific</td>
<td>To display data in scientific representation.</td>
</tr>
<tr>
<td>Decimal digits</td>
<td>To define the number of decimal digits displayed.</td>
</tr>
<tr>
<td>View factor</td>
<td>To define a factor to the values in the table.</td>
</tr>
<tr>
<td>Copy</td>
<td>To copy the selected values in the table.</td>
</tr>
<tr>
<td>Find value</td>
<td>To find a value in the table.</td>
</tr>
<tr>
<td>Filter</td>
<td>To filter the results in the table.</td>
</tr>
</tbody>
</table>
The settlement behaviour of point A when gravity loading is applied is shown by the initial horizontal line in Figure 307 (on page 496) a). This line will, in general, consist of several plastic calculation steps, all with the same value of $\Sigma M_{\text{area}}$.

To model the behaviour of the soil structure as a whole as the additional material is placed, then the cluster of the additional material should be activated using a staged construction calculation. At the start of this staged construction calculation, all displacements should be reset to zero by the user. This removes the effect of the physically meaningless displacements that occur during gravity loading.

![Figure 307: Load-displacement curves of the embankment project. a) Before editing; b) After editing](image)

The load-displacement curve obtained at the end of the complete calculation for point A is shown in Figure 307 (on page 496) a). To display the settlement behaviour without the initial gravity loading response it is necessary to edit the corresponding load-displacement data. The unwanted initial portion, with the exception of point 1, should be deleted. The displacement value for point 1 should then be set to zero. The resulting curve is shown in Figure 307 (on page 496) b).

As an alternative to the above editing procedure, the gravity loading phase can be excluded from the list of calculation phases that are included in the curve (Formatting curves (on page 492)).

10.3.3 Value indication

If the Value indication option in the View menu is active and the mouse is moved over a data point in a curve, the hint box shows the precise value of the $x$- and $y$-quantities at that point. In addition, it shows the curve point number and the step and phase numbers corresponding with that curve point.

10.4 Formatting options

The layout and presentation of charts can be modified by clicking the Settings button available in the toolbar or by selecting the corresponding option in the Format menu. Alternatively, the Settings option can be selected from the Format menu of the right mouse button menu. As a result, the Settings window will appear. Distinction is made between the chart settings displayed on the first tabsheet and the curve settings displayed on a separate...
tabsheet for each curve. The options available in the Chart tabsheet can be used to customize the frame and axes of the chart (Chart settings (on page 497)). The options available in the tabsheets of the curves can be used to customize the plot (Curve settings (on page 498)).

If the correct settings are defined, the OK button may be pressed to activate the settings and to close the window. Alternatively, the Apply button may be pressed to activate the settings, keeping the Settings window active. The changes to the settings can be ignored by pressing the Cancel button.

### 10.4.1 Chart settings

The Settings window contains a tabsheet with options to customise the layout and presentations of the chart (see Figure 308 (on page 497)).

![Chart settings tabsheet](Figure 308: Chart settings tabsheet)
### Titles

By default, a title is given to the x-axis and the y-axis, based on the quantity that is selected for the curve generation. However, this title may be changed in the Title edit boxes of the corresponding axis group. In addition, a title may be given to the full chart, which can be entered in the Chart name edit box. This title should not be confused with the Curve title as described in above.

### Scaling of x- and y-axis

By default, the range of values indicated on the x- and y-axis is scaled automatically, but the user can select the Manual option and enter the desired range in the Minimum and Maximum edit boxes. As a result, data outside this range will not appear in the plot. In addition, it is possible to plot the x- and/or y-axis on a logarithmic scale using the Logarithmic check box. The use of a logarithmic scale is only valid if the full range of values along an axis is strictly positive.

### Grid

Grid lines can be added to the plot by selecting items Horizontal grid or Vertical grid. The grid lines may be customised by means of the Style and Colour options.

### Orthonormal axes

The option Orthonormal axes can be used to ensure that the scale used for the x-axis and the y-axis is the same. This option is particularly useful when values of similar quantities are plotted on the x-axis and y-axis, for example when making diagrams of different displacement components.

### Exchange axes

The option Exchange axes can be used to interchange the x-axis and the y-axis and their corresponding quantities. As a result of this setting, the x-axis will become the vertical axis and the y-axis will become the horizontal axis.

### Flip horizontal or vertical

Selecting the option Flip horizontal or Flip vertical will respectively reverse the horizontal or the vertical axis.
10.4.2 Curve settings

The Settings window contains for each of the curves in the current chart a tabsheet with the same options (Figure 309 (on page 499)).

<table>
<thead>
<tr>
<th>Title</th>
<th>A default title is given to any curve during its generation. This title may be changed in the Curve title edit box. When a legend is presented for the active chart in the main window, the Curve title appears in the legend.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>When multiple curves are present within one chart, it may be useful to hide temporarily one or more curves to focus attention on the others. The Show curve option may be deselected for this purpose. It is possible to select the check boxes for Min values and Max values to display the minimum and maximum values in the chart with an orange circle.</td>
</tr>
<tr>
<td>Phases</td>
<td>The Phases button may be used to select for which calculation phases the curve has to be generated. This option is useful when not all calculation phases should be included in the curve.</td>
</tr>
</tbody>
</table>
### Curves

#### Regeneration of curves

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fitting</strong></td>
<td>To draw a smooth curve, the user can select the <em>Fitting</em> item. When doing so, the type of fitting can be selected from the <em>Type</em> combo box. The <em>Spline</em> fitting generally gives the most satisfactory results, but, as an alternative, a curve can be fitted to a polynomial using the least squares method.</td>
</tr>
<tr>
<td><strong>Line and marker presentation</strong></td>
<td>Various options are available to customise the appearance of the curve lines and markers. It is possible to <em>Mark start of phase</em> by clicking on the checkbox, which shows a distinction for the start of a new phase in the chart.</td>
</tr>
<tr>
<td><strong>Arrow buttons</strong></td>
<td>The arrow buttons can be used to change the order of the curves in the legend.</td>
</tr>
<tr>
<td><strong>Regenerate</strong></td>
<td>The <em>Regenerate</em> button may be used to regenerate a previously generated curve to comply with new data ([Regeneration of curves](on page 500)).</td>
</tr>
<tr>
<td><strong>Add curve</strong></td>
<td>The <em>Add curve</em> button may be used to add new curves to the current chart ([Multiple curves in one chart](on page 500)).</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>When multiple curves are present within one chart, the <em>Delete</em> button may be used to erase a curve.</td>
</tr>
</tbody>
</table>

#### 10.5 Regeneration of curves

If, for any reason, a calculation process is repeated or extended with new calculation phases, it is generally desirable to update existing curves to comply with the new data. This can be done by means of the *Regenerate* facility. This facility is available in the *Settings* tabsheet ([Figure 308](on page 497)), which can be opened by selecting the *Settings* option from the *Format* menu. When clicking on the *Regenerate* button, the *Curve generation* window appears, showing the existing setting for *x*- and *y*-axis. Pressing the *OK* button is sufficient to regenerate the curve to include the new data. Another *OK* closes the *Settings* window and displays the newly generated curve.

When multiple curves are used in one chart, the *Regenerate* facility should be used for each curve individually. The *Regenerate* facility may also be used to change the quantity that is plotted on the *x*- or *y*-axis.

#### 10.6 Multiple curves in one chart

It is often useful to compare similar curves for different points in a geometry, or even in different geometries or projects. Therefore PLAXIS 2D allows for the generation of more than one curve in the same chart. Once a single curve has been generated, the *Add curve* options in the *Edit* menu can be used to generate a new curve in the current chart. As an alternative, the *Add curve* option from the *Settings* window or from the right mouse button menu can be used. Distinction is made between a new curve from the current project, a new curve from another project or curves available on the clipboard.

The *Add curve* procedure is similar to the generation of a new curve ([Generating curves](on page 476)). However, when it comes to the actual generation of the curve, the program imposes some restrictions on the selection of data to be presented on the *x*- and the *y*-axis. This is to ensure that the new data are consistent with the data of the existing curve.
Curves
Multiple curves in one chart

When the Add curve option is used, the current chart is modified. In order to preserve the current chart, a copy of it can be created by selecting it first in the list and then by clicking the Copy button in the Curves manager window.
11.1 Bentley Cloud Services [GSE]

Bentley Cloud Services can be accessed from the File menu, or from the icons in the menu bar. This menu contains the following four options:

- **Associate project**: this opens a separate window listing the available Bentley projects. The user can select any of them. This will store into "Project.ConnectedProjectInfo" (available from the command line as read-only properties) the GUID and the name of this cloud project. This property is not reset when using "Save as", i.e. a "saved as" project will also carry this project association.

- **Disassociate project**: when there is a project association, this item removes the association between the current PLAXIS project and the Bentley project (i.e. it resets the content of "Project.ConnectedProjectInfo").

- **Personal portal**: This can be used at any time to open the personal Bentley portal of the user in the default web browser.

- **Project portal**: When a Bentley project is associated to the current PLAXIS project, this opens the project portal in the default web browser.

Except the **Disassociate project** functionality, the other three requires the user to be logged in with the **Connection Client**.

11.2 ProjectWise Integration Commands [GSE]

PLAXIS enables the integration with ProjectWise software for BIM collaboration. When ProjectWise has been installed, four specific Integration commands are available in PLAXIS 2D.

- **Open**...
- **Add**...
- **Save**...
- **Properties**...

These commands are accessible through the **File > ProjectWise** menu and the toolbar.
11.2.1 Add File to ProjectWise

To add the current PLAXIS 2D to a ProjectWise repository, use the following procedure:

You must have a PLAXIS project open.

Either select File > ProjectWise > Add to ProjectWise or select the Add File to ProjectWise icon in the toolbar.

If you have not previously logged into a ProjectWise datasource, then the ProjectWise Log in dialog opens. Provide the Datasource and required user credentials and then click Log in.

![Figure 310: ProjectWise Log in dialog](image)

Select a Wizard dialog appears, as shown in Figure 311 (on page 503). Select any of the options - No Wizard or Advanced Wizard.

![Figure 311: Select a Wizard dialog](image)

Selecting No Wizard opens Save Document As window (Figure 312 (on page 504)). Select the target folder. Fill in Document name and Description. Format type should be Packed PLAXIS 2D Project.
On selecting Advanced Wizard, Advanced document creation window appears. Click Next, Select Target folder dialog appears. Select folder, and click Next. Document Properties window appears. Fill in Document name, Description, Version. Save as Type format should be Packed PLAXIS 2D Project. Click Next, Create a Document window appears. Confirm the document properties and click Next. Provide the Datasource and required user credentials and then click Log in. In the next dialog enter comments describing the document or later the changes you have made.

**Note:** These comments will be visible in the Audit Trail tab in the ProjectWise Properties window.

A progress bar is displayed during the data transfer indicating the file content transfer status.

Add to ProjectWise dialog appears (Figure 313 (on page 505)), where the user can choose the corresponding files in the project to be compressed and uploaded to ProjectWise.
The uploaded PLAXIS project is now checked out from the ProjectWise datasource. This means that you have exclusive access to the project. Others can only open it as 'read-only'. PLAXIS now recognizes that the current model is linked to ProjectWise with a '[PW:Checked Out]' text appearing in the project title, and allows the File > ProjectWise > Properties commands to become active.

### 11.2.2 Open File stored in ProjectWise

To open a PLAXIS file stored in a ProjectWise repository, use the following procedure:

1. Either select File > ProjectWise > Open from ProjectWise or select the Open from ProjectWise tool from the toolbar. If you have not previously logged into a ProjectWise datasource, then the ProjectWise Log in dialog opens, allowing you to log into a ProjectWise datasource. After logging in to the datasource, the Open from ProjectWise dialog (Figure 314 (on page 506)) is displayed, allowing the user to browse/search the datasource contents and select the document to open.
2. Select a project within the ProjectWise datasource.

3. Click Open.
   a. If the project has never been opened before, then PLAXIS asks to specify a local folder where the project can be downloaded.
   b. If the project has been opened before, PLAXIS will check if the local version is up-to-date, and if not, it will be updated. If there are local changes then, there is an option to overwrite them or select a different folder.

The ProjectWise project is checked out from the ProjectWise datasource, copied to local disk, and opened by PLAXIS. If the project is checked out by another user then it can only be opened on 'read-only' mode. This means that if changes are made to the local model it cannot be uploaded to the server. If the other user finishes working on the model and checks in the project, your local copy will have conflicts with the server copy. The next time when you open the project you will get a notification about this conflict. Then you can either overwrite your local changes with the server copy or you can open the project from the server into a new folder.

PLAXIS recognizes that the current model is linked to ProjectWise and allows the File > ProjectWise > Save to ProjectWise and the File > ProjectWise > Properties commands to become active.

11.2.3 Save to ProjectWise
To update the ProjectWise server copy of the file with the latest changes that have been made to the local copy of the file, use the following procedure.

When a PLAXIS model is either opened from a ProjectWise datasource or has been added to a ProjectWise datasource, this functionality is active.

1. Select File > ProjectWise > Save to ProjectWise or the Save to ProjectWise icon from the toolbar.

   The model that is currently open in PLAXIS is checked for changes. If the model has been edited since the last save, a message is displayed asking if these changes should be saved before updating the file server copy.

   ![Figure 315: Save project dialog](image)

2. Click Save.

3. Refer to Add File to ProjectWise (on page 503) for further steps.

   A Progress bar is displayed during the data transfer indicating file content transfer status.

11.2.4 To View ProjectWise properties

To review or edit the ProjectWise properties and metadata associated with the current PLAXIS model, use the following procedure.


   The ProjectWise Document Properties dialog opens.

2. Edit the ProjectWise properties and metadata as necessary.

   **Note**: The 'Audit Trail' tab shows the edit history and the comments entered while saving changes.

3. Click Save.
A Progress bar is displayed during the data transfer indicating file content transfer status.
11.3 Packing a project

The created project can be compressed using the Pack project application (Figure 317 (on page 509)), which is available in the File menu of the Input program. This application can be executed directly from the PLAXIS 2D AE installation folder by double clicking the corresponding file (PackProject.exe). A shortcut to the application can be created as well.

Figure 317: Pack project window

The project to be compressed and the archive can be located using the Browse button. The options available in the Purpose box are:

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Backup</strong></td>
<td>All the files in the project are included in the compressed project as well as the mesh information, phase specification and the results of all the saved calculation steps. The extension of the project file, indicating in which program it was created, and the archiving date are included in the archive name.</td>
</tr>
<tr>
<td><strong>Support</strong></td>
<td>Selecting this option enables including all the information required to give support for the project at hand. Note that support is only provided to GSE users.</td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td>The user can define the information to be included in the archive.</td>
</tr>
</tbody>
</table>

The options for compression and volume size are available in the Archive options window (Figure 318 (on page 510)), displayed by clicking the button in the Purpose box.
The **Content** box displays the options for the information to be included in the archive is shown. The options available are:

<table>
<thead>
<tr>
<th><strong>Mesh</strong></th>
<th>The information related to geometry is included when the <em>Mesh</em> option is selected.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Phases</strong></td>
<td>The options available are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Smart</strong>: When a phase is selected in the tree, the parent phase is selected automatically in order to provide a consistent chain of phases.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All</strong>: All the phases available in the project are selected.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manual</strong>: Specific phases can be selected by the user.</td>
</tr>
<tr>
<td><strong>Results</strong></td>
<td>The results to be included in the archive can be selected. The options available are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>All steps</strong>: The results of all the calculation steps are included in the archive.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Last step only</strong>: The results of only the last calculation step of each phase are included in the archive.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Manual</strong>: The results of specific calculation steps can be selected by the user.</td>
</tr>
</tbody>
</table>

Note that when the *Backup* or the *Support* option is selected, the *Content* options are automatically selected by the program.

### 11.4 Exporting geometry [GSE]

#### 11.4.1 *STEP and DXF format*

PLAXIS 2D allows to export the geometry of the model in different formats. This is available in the **File** menu of the input program ([Figure 319](on page 511)) in the **Geometry** modes (**Soil** and **Structures**).
The file can be saved as a *.step (Standard for the Exchange of Product model data) or *.dxf (Drawing Interchange Format) file. The file contains the entire generated geometry in one file (not the cut geometry). This means items such as boreholes, top soil surface and tunnel designer data are excluded, only the entities generated from those are included (e.g. generated soil volumes, generated tunnel slices, lining, rock bolts lines). The data is purely geometric, not annotated with features, and not divided in layers.

### 11.5 PLAXIS 2D to 3D Converter [GSE]

The PLAXIS 2D to 3D Converter tool converts a PLAXIS 2D geometry and its soil properties into an extruded model in PLAXIS 3D.

In general in this conversion:

- Points are extruded as lines, lines as surfaces and polygons become volumes.
- Depending on its type, a structural element will be extruded or not (e.g. plates get converted into surfaces while anchors remain as line objects after the conversion to PLAXIS 3D).

**Note:** Some components of the PLAXIS 2D might be excluded, in those occasions the user needs to pay attention to the warning messages displayed by the software (see Results (on page 516)).
11.5.1 Remote scripting server configuration [GSE]

Before using the PLAXIS 2D to 3D convertor is necessary to setup the connection between the PLAXIS 2D and PLAXIS 3D products through the Remote scripting server feature. This can be done as follows:

1. Open the PLAXIS 2D model to be converted and created as a new project within PLAXIS 3D.
2. While in PLAXIS 2D Input program click on Expert menu > Configure remote scripting server...
3. From the emerging window, after configuring communication Port and Password, press on Start Server and the port will be activated. See Figure 320 (on page 512).

![Figure 320: Configuration of Remote scripting server for PLAXIS 2D](image)

4. On PLAXIS 3D Input program repeat similar process as in step 2.
5. Once the remote scripting server emerging window appears go to Configure port > Find available > Start server as shown in Figure 321 (on page 513).
Note: In the most recent PLAXIS versions, only the configuration of the remote scripting server within PLAXIS 2D is required (steps 1 to 3). As a consequence, by starting the converter (see Running the PLAXIS 2D to 3D converter tool (on page 513)) PLAXIS 3D and the remote scripting server are automatically launched and set, respectively.

11.5.2 Running the PLAXIS 2D to 3D converter tool

After ensuring that a PLAXIS 2D model is in place (inside the PLAXIS 2D Input program), the converter can be started by clicking on Expert menu > PLAXIS 2D to 3D Converter. After that, the tool window will be displayed (see Figure 322 (on page 514)).
The conversion tool will appear just if the Remote scripting server configuration [GSE] (on page 511) was executed on PLAXIS 2D.

The PLAXIS 2D to 3D converter contains the following modules for the extrusion process: Connection, Conversion and Results.

11.5.2.1 Connection

The Connection module allows to create the link between PLAXIS 2D and PLAXIS 3D.

To establish the connection, in this module by default most of the information is filled (as shown in Figure 322 (on page 514)). However, the Password for PLAXIS 3D needs to be completed. This password can be retrieved from PLAXIS 3D - Input program > Expert menu > Configure remote remote scripting server. A successful connection will be displayed as shown in Figure 323 (on page 515).

Note: If different Address, Port or Password are defined, the users need to fill the information that matches their own servers configuration.

Note: Alternatively, especially for the latest PLAXIS versions, the converter tool in PLAXIS 2D will launch automatically PLAXIS 3D and it will fill the required parameters for the connection.
11.5.2.2 Conversion

The Conversion module allows to define the general extrusion settings (see Figure 324 (on page 516)). In particular, it is necessary that users select the reference axes for the project (Base Plane in 3D) and the extrusion depth.

To start the conversion please click on Run conversion.
11.5.2.3 Results

Once the conversion is run, the Results module displays the progress of the conversion using the Status and Remarks sections. Status shows the objects that are getting extruded into PLAXIS 3D. Remarks presents different warnings about the objects and properties that, respectively, were not extruded or assigned to the 3D model (e.g. see Figure 325 on page 517). Each warning displays a possible way to address it manually on PLAXIS 3D.
11.5.3 PLAXIS 3D model outcome

After the conversion of the PLAXIS 2D model (e.g. see Figure 326 (on page 518)), the transformed elements will be displayed into PLAXIS 3D (e.g. see Figure 327 (on page 518)). As mentioned in Results (on page 516), the non-processed elements will require manual editing on PLAXIS 3D Input program both in the Ground modelling - Soil mode (on page 49) and Modelling loads and structures - Structures mode (on page 68).
Tip:

- One example of elements that will need manual editing on PLAXIS 3D Input program are structural elements such as anchors (see Figure 327 (on page 518)). As expected, anchors will remain as linear elements (not extruded as surfaces) and also they will be placed only in front the plane. In this circumstance, the user is advised to edit the model using Assisting tools such as Copy object - Array (on page 69) to replicate those elements into the model.

- For more information on how to edit a PLAXIS 3D model after using the PLAXIS 2D to 3D converter tool please check Bentley communities.
11.6 Model Importer/Exporter

11.6.1 Model Importer GeoStudio 2D

The GeoStudio 2D Model Importer tool allows the user to select a GeoStudio project (*.gsz) and import any of the 2D geometries contained inside the GeoStudio project file. This may be a Slope/W, Seep/W or Sigma/W project to an equivalent PLAXIS 2D model. This tool transfers the geometry and assigned soil or rock materials from a GeoStudio 2D analysis to PLAXIS 2D. It is available in the File menu of the Input program in all the modes as shown in Figure 328 (on page 519).

File > Import GeoStudio 2D (Tech. Preview) prompts the user to configure the remote scripting server: the user is prompted to set a password and configure an available port (see Starting the remote scripting server (on page 615)). This opens the PLAXIS 2D Limit Equilibrium model converter as shown in Figure 329 (on page 520), where the user can select the GeoStudio model to be imported and click on the Convert to PLAXIS button. The tool will warn when a model is still open in PLAXIS 2D to prevent any data loss.
11.6.2 Model Importer PLAXIS 2D LE

The PLAXIS 2D LE Model Importer tool allows to import PLAXIS LE (.svm), SVSLOPE and SVSOLID model geometry, material definitions and their supported parameters to an equivalent PLAXIS 2D model. This is available in the File menu of the input program in the Geometry modes (Soil and Structures) (Figure 330 (on page 521)).
Go to File > Import PLAXIS 2D LE prompts the user to configure the remote scripting server: the user is prompted to set a password and configure an available port (see Starting the remote scripting server (on page 615)). This opens the PLAXIS 2D LE model importer (Figure 331 (on page 522)), where the user can select the PLAXIS LE model to be imported and click on the Import button.
Note: After the import the new PLAXIS 2D model will inherit the units of the original PLAXIS 2D LE model.

11.6.3 Model Exporter GeoStudio 2D

The tool "Export GeoStudio 2D" is available in the **File** menu of the input program which can be accessed *only* in the **Staged construction mode** as shown in **Figure 332** (on page 523). The user can select one of the defined construction stages in PLAXIS 2D, select the intended slip surface direction and export that as a single GeoStudio 2D *.gsz* file. By default, the geometry, material assignments and available parameters, distributed loads and the water table will be converted. This allows users to continue in GeoStudio 2D for further limit equilibrium analysis on each exported phase.
Go to **File > Export GeoStudio 2D (Tech. Preview)** prompts the user to configure the remote scripting server: the user is prompted to set a password and configure an available port (see *Starting the remote scripting server* (on page 615)). This opens the **PLAXIS 2D Limit Equilibrium model converter** as shown in *Figure 333* (on page 524), where the user can select the slip surface direction and click on the *Convert* button.
Note: The following limitations apply during the conversion of a PLAXIS 2D to a LEM model:

- All the soil models in PLAXIS 2D does not have an equivalent soil model in GeoStudio or PLAXIS LE. The supported soil models include Mohr-Coulomb, Hardening soil, HS small, Soft Soil, Soft Soil Creep and Hoek-Brown.
- Only PLAXIS 2D Plane strain models are supported.

The PLAXIS 2D to Limit Equilibrium model converter will indicate the limitations in the conversion log for the users to continue further in GeoStudio or PLAXIS LE.

For more details about limitations refer to Bentley Communities.
11.7 Importing geometry [GSE]

In the Soil and Structures mode, the geometry can be imported by clicking the Import soil/Import structures button available in the side toolbar under the Import... button or by selecting the option available in the Soil or Structures menu.

A list of possible supported file extensions is shown in Table 20 (on page 525).

**Table 20: Supported file types**

<table>
<thead>
<tr>
<th>Extension</th>
<th>File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.dxf</td>
<td>AutoCAD interchange files.</td>
</tr>
<tr>
<td>*.csv</td>
<td>Comma-separated value files. An example for csv files is given in Importing soil layers [GSE] (on page 62).</td>
</tr>
<tr>
<td>*.geo, *.sti</td>
<td>D-series files.</td>
</tr>
<tr>
<td>*.txt</td>
<td>Tab-separated txt files. An example for txt files is given in Importing soil layers [GSE] (on page 62).</td>
</tr>
<tr>
<td>*.brep</td>
<td>OpenCascade shape files.</td>
</tr>
<tr>
<td>*.step, *.stp</td>
<td>STEP files.</td>
</tr>
</tbody>
</table>

**Note:**

- It is recommended that users check the external file units before starting the importing process. For file formats such as DXF and STEP, PLAXIS takes into consideration the units defined there.
  
  In case the units are not defined in the file, or the file format doesn't support any units (e.g. BRep), PLAXIS will consider that the geometry is defined in the current PLAXIS project length unit.

- Detailed description of how a soil geometry can be imported is given in Importing soil layers [GSE] (on page 62).
11.7.1 Advanced options

11.7.1.1 Importing closed polylines as polygons

The Import geometry tool in PLAXIS 2D (see Figure 334 (on page 526)) supports the importing of polylines (or polycurves with straight edges, so no arcs) as polygons taking into account the following conditions:

- The polyline should not intersect itself.
- The polyline needs to be closed.

If the Import closed polylines as polygons checkbox is enabled, the following considerations need to be taken into account:

1. If the polyline is closed it will be imported as a PLAXIS polygon, otherwise, it will be imported as a normal PLAXIS polycurve.

Note: Polylines and polygons are editable in the Model explorer by selecting Geometry > Polylines/Polygons.
2. If a closed polyline is NOT directly imported as a polygon, but as a polycurve, the user can still create a polygon after importing:

   - In the drawing area of the Soil or Structures mode, Right click on the closed polycurve and select Create > Create Polygon.

   **Note:** This action can be performed for individual or multiple polycurve objects.

3.

### 11.7.1.2 Reduce point density of polylines and polygons

Imported polyline and polygon geometries can be composed of an excessive number of smaller segments. This can induce the generation of unnecessarily fine meshes inside PLAXIS, which can significantly increase the calculation time. To provide better support for external geometries containing an excessive number of (small) segments, such as ground model cross-sections from Leapfrog, users can take advantage of the **Reduce point density of polylines and polygons** option.

The **Reduce point density of polylines and polygons** (see Figure 334 (on page 526)) allows the simplification of imported geometries by removing intermediate points of the polyline (as displayed in Figure 337) taking into account a user-specified **Projection distance tolerance**. This tolerance defines the maximum distance from a deleted vertex to the simplified polyline.

![Figure 335: Reduction of point density](image)

The **Projection distance tolerance** can be defined in the interface in one of the following ways:

1. **Absolute value**: Measured in the current project length units (m, ft, or others).
2. **Relative value**: As fraction between the absolute value and the length of the diagonal of the geometry’s bounding box.

**Note:**

- The checkbox **Reduce point density of polylines and polygons** is automatically enabled if a polyline or polygon with a large number of internal vertices is detected. It is recommended not to disable this feature otherwise the model will be imported with an unnecessary amount of vertices, which may lead to an unnecessarily dense mesh.
It is important to remark that the **Reduce point density of polylines and polygons** feature also:

1. Detects neighboring polylines when they overlap through "matching vertices" within a tolerance distance of 1E-7 m.

**Note:**
- If "matching vertices" of shared boundaries are not within the tolerance distance, gaps might be introduced into PLAXIS in the importing process. Users are advised to check and modify the geometry in their external software (Leapfrog, CAD solution or other) to avoid the importing of undesired geometries.
- PLAXIS will display a warning in two occasions: a) if polylines of neighboring boundaries intersect through a not existing vertex, therefore, a new point in the intersection will be created. b) if an edge of a polyline is close to another polyline within the defined tolerance distance for "matching vertices" (1E-7 m).

2. Preserves the original shape and adjacency of geometries. This ensures that thin clusters such as thin layers in a soil/rock mass are kept after importing.

**Cross-section simplification and import**

To simplify an imported cross-section (for instance a *.dxf third-party file from Leapfrog) inside PLAXIS, the next steps can be followed:

1. In the **Soil** or **Structures** mode, select **Import geometry...** from the vertical tool bar.
2. In the appearing window, select the cross-section file to be imported and click **open**. Then the **Importing geometry** tool and window will appear displaying the target geometry (see [Figure 338](#) (on page 531)).
3. To simplify the geometry go to the **Advanced options** and click on the **Reduce point density of polylines and polygons** checkbox. Subsequently, define a value for the **Absolute** or **Relative Projection distance tolerance**.

**Note:**
- After the point density reduction procedure is executed different **Hints** and **Warnings** will be displayed in the **Right-side Feedback panel**. It is advised to read them carefully and either continuing with the import, or modifying the geometry in the original third-party software package.
Figure 336: Reduce point density of polylines and polygons feature

Tip: In Figure 338 (on page 531), in the Right-side Feedback panel, notice how the number of vertices of the original geometry gets reduced considerably depending on the defined Projection distance tolerance.

4. Alternatively, the user can also convert polylines into polygons. To execute this, please read the requirements on Importing closed polylines as polygons (on page 526) section and activate the feature in the Advanced options. Figure 339 (on page 532) displays the activation of the Import closed polylines as polygons checkbox. The green hatched lines indicate a successful transformation from polylines to polygons.
Figure 337: Import closed polylines as polygons feature

5. Optionally, the user can consult more detailed information on the importing process that is going to be executed by clicking on the Show import log button.

6. In the Import geometry window press OK. The import will be finished and displayed in the Drawing area.

11.7.1.3 Cross-section simplification and import

To simplify an imported cross-section (for instance a *.dxf third-party file from Leapfrog) inside PLAXIS, the next steps can be followed:

1. In the Soil or Structures mode, select Import geometry... from the vertical tool bar.
2. In the appearing window, select the cross-section file to be imported and click open. Then the Importing geometry tool and window will appear displaying the target geometry (see Figure 338 (on page 531)).
3. To simplify the geometry go to the Advanced options and click on the Reduce point density of polylines and polygons checkbox. Subsequently, define a value for the Absolute or Relative Projection distance tolerance.

Note:

- After the point density reduction procedure is executed different Hints and Warnings will be displayed in the Right-side Feedback panel. It is advised to read them carefully and either continuing with the import, or modifying the geometry in the original third-party software package.
Figure 338: Reduce point density of polylines and polygons feature

**Tip:** In Figure 338 (on page 531), in the Right-side Feedback panel, notice how the number of vertices of the original geometry gets reduced considerably depending on the defined *Projection distance tolerance*.

4. Alternatively, the user can also convert polylines into polygons. To execute this, please read the requirements on **Importing closed polylines as polygons** (on page 526) section and activate the feature in the **Advanced options**. Figure 339 (on page 532) displays the activation of the **Import closed polylines as polygons** checkbox. The green hatched lines indicate a successful transformation from polylines to polygons.
5. Optionally, the user can consult more detailed information on the importing process that is going to be executed by clicking on the Show import log button.

6. In the Import geometry window press OK. The import will be finished and displayed in the Drawing area.

**Note:** Cross-sections that previous to the import are out of the x-y plane, will be automatically rotated by the importing tool to make them coincide with the x-y plane of PLAXIS 2D. This guarantees that the original dimensions of the cross-sections are not modified with the importing. It is importing to remark:

- If the source geometry contains already some objects in the x-y plane and other objects out of that plane only the elements in the x-y plane will be imported.
- If a geometry contains different elements out of the x-y plane, the reference element for the import will be the largest polygon. Therefore smaller elements in other planes will be ignored.

### 11.7.2 Visualization options

#### 11.7.2.1 Show internal vertices

When the Show internal vertices feature is enabled, the internal vertices of imported polygons and polylines are displayed. This allows the users to have an overview of the complexity of imported geometries.
11.8 Central Importer [GSE]

PLAXIS 2D enables the connection with Central (Seequent geoscience data management platform for connected workflows, shared 3D-visualization and team collaboration) to import different entities hosted on this collaborative platform. These entities (e.g. cross-sections) can be generated on platforms for geological modelling such as Leapfrog.

**Note:** For more information about Central please visit the Seequent website.

### 11.8.1 Importing cross-sections and materials from Central [GSE] to PLAXIS 2D

PLAXIS 2D allows to import cross-sections and their associated materials that are hosted in collaborative environments such as Central into by taking the following steps:

1. Contact the organization’s Central Administrator to obtain access to a project server of interest.
2. Open PLAXIS 2D input program.
3. In the **Soil** or **Structures** mode follow one of the following approaches:
   - Click on the **Soil or Structures menus > Import Geometry from Central** as displayed in Figure 340 (on page 534) a).
   - In the **Side toolbar** click on the icon **Import Geometry > Import Geometry from Central** > as displayed in Figure 340 (on page 534) b).
4. From the pop-up window called **Import Cross-section from Central** (see Figure 341 (on page 535)) please select:

- The **Central server** of the project.
- The **Project name** that contains one or more cross-sections.
- The **Branch** of interest. If there is only one Branch the default will be chosen.
- The **Publish event** indicating the list of available versions/updates for the current project.
5. Once the connection to the Central server is established, one or more groups of cross-sections models (depending on the structure of the project) will be displayed. Please select the specific location for the cross-section of interest (see Figure 342 (on page 536)) and press OK.
Figure 342: Selection of cross-section to be imported

**Note:**
- With the *Import cross section from Central* tool only one geometry at a time can be imported.

6. If successful, the geometry and its materials will be loaded in the PLAXIS *Importing geometry [GSE]* (on page 524) tool as displayed in Figure 343 (on page 537).

**Note:** Please check the warnings of the process. If they do not provide enough information it is recommended to explore the *Show import log.*
Note:

- Cross-section geometries with a substantial number of vertices are reduced to improve model meshing. For detailed information please go to Cross-section simplification and import (on page 530).

During the importing process PLAXIS 2D reads the material properties from Central (Generated in Leapfrog) and subsequently creates and assigns the materials to the imported polygons that made up the cross-section. These polygons appear colored in the Import Geometry tool as displayed in Figure 343 (on page 537).

Note:

- Materials generated in Leapfrog only contain the properties Identification and Colour. For this reason, the materials created and assigned by PLAXIS 2D in the importing process will require further parametrisation based on the particular characteristics of the soil units of the cross-section. As displayed in Figure 344 (on page 538), PLAXIS 2D will warn the user that a material is "[invalid]" (inside the Materials sets window) when remaining soil properties have not been assigned.

7. Press OK to end the importing process. The 2D cross-section and its materials will appear in the drawing area of the PLAXIS 2D input program as displayed in Figure 344 (on page 538).
PLAXIS 2D allows to track the changes of imported Central elements (i.e. Cross-sections and materials) when those changes are done in Central.

To determine the occurrence of a change in an element stored in Central PLAXIS 2D verifies the elements on the latest Publish event of the project.

To verify if an imported elements in PLAXIS 2D were changed respect to the origin (i.e. Central) please take the following steps:

1. Ensure, beforehand, to have imported into PLAXIS 2D a cross-section geometry with its materials (if available) from the Central server.

2. Go to the Soil or the Structures mode.

3. In the General tab bar click on the icon Show objects imported from Central. Then a new window will be displayed as shown in Figure 345 (on page 539).

Note:

- When the Show objects imported from Central icon contains a clock indicator this means that there is a new Publish event available.
In Figure 345 (on page 539), polygons marked with the clock icon indicate that an update might be available for the imported elements.

Note:
- When there is a new Publish event available PLAXIS 2D will mark the Geometry objects and the Materials tabsheets with an asterisk (*) as displayed in Figure 345 (on page 539).
- If a new publish event is available this does not automatically mean that previously imported entities have also changed in it (for example another cross-section might have been modified inside the same Publish event). It is recommended to verify the nature of the change.

11.8.2.1 Managing versions of imported cross-sections

If updates to cross-section geometries are available after selecting the Show objects imported from Central (as shown in Managing versions from Central imported elements (on page 538)), please take the following steps:

1. In the Objects imported from Central window click on the Geometric Objects* tabsheet.
2. Select the Check for changes option (see Managing versions from Central imported elements (on page 538)). PLAXIS 2D PLAXIS 3D will compare the originally imported entity with the one in the new Publish event and update the Publish event and the 'Is latest' fields accordingly.

Note:
- In case that no geometrical updates are available PLAXIS 2D will only update the Publish event.
- After checking the availability of geometric changes PLAXIS 2D will automatically check for updates of polygon materials. The user can chose if updating materials in this stage or rejecting the update to perform it in a later stage as shown in Managing versions of imported materials (on page 540).
- Changes made locally to imported geometries will not be considered during the comparison.
If the process is successful the updated objects will be indicated with a green checkmark as displayed in Figure 338.

Figure 346: Updated of objects imported from Central

11.8.2.2 Managing versions of imported materials

In PLAXIS 2D to be able to update imported polygon materials according subsequent modifications in the Central server take the following steps:

1. Ensure that geometric objects are already updated as shown in Managing versions of imported cross-sections (on page 539).

2. In the Objects imported from Central window click on the Materials* tabsheet. The field column Is latest will be displayed with a green check mark if the material of polygon is up to date or a red cross if it is not (see Figure 347 (on page 540)).

Figure 347: PLAXIS-Central - Materials update status
Note: Material updates are performed based on a comparison of the changes made in Central, therefore local changes to materials in PLAXIS are not considered as a change.

3. Select the **Update materials from Central** option. This action will automatically update the **Published event** and the available materials. If the process is successful, the updated materials will be displayed with a green check mark in the column **Is latest** of the **Objects imported from Central** window.

11.9 Calculation using design approaches [ADV]

A design approach can be applied to a calculation phase by selecting the appropriate design approach of the phase in the **General** subtree in the **Phases** window (Figure 348 (on page 541)).

![Figure 348: Selection of design approach in the Phases window](image)

The partial factors for materials and loads are already defined in the Input program. However, in the **Staged construction** window, besides the activations of the loads, the corresponding labels should be assigned as well by selecting the corresponding option in the **Object explorers** (Figure 349 (on page 542)).
11.10 Convergence log for PLAXIS calculations

Due to the high non-linearity of soil related problems, obtaining accurate solutions in PLAXIS requires the consideration of different error criteria to define if a phase calculation converges or not. These criteria will be discussed in the sections Convergence criteria for deformation analysis (on page 546) and Convergence criteria for flow analysis (on page 547).

Based on the convergence criteria PLAXIS also provides an in-build feature called the Convergence log to help users to inspect the progress of each calculation phase, understand the convergence process and debug the model if necessary. This diagnostic information is recorded in a text file known as the Convergence log file.

11.10.1 Convergence log file

The Convergence log file provides a summary of all convergence criteria for each step, attempt, and iteration for a given phase of the analysis. This file can be accessed during or after the calculation in the following ways:

1. During the calculation phase:
On the **calculation progress window** click on the **View log** button as displayed in Figure 350 (on page 543).

![Active tasks](image)

**Figure 350: Accessing the log information from the Calculation progress window**

2. **After the calculation:**

   a. In the **Staged construction** or **Flow conditions** modes go to the Phases explorer of each phase run and click on as displayed in Figure 351 (on page 544).
In the corresponding project folder, under the file name `data.conv.drr#` (where # is the phase number). This is especially useful when the analysis takes longer than expected or stops prematurely.

**Note:**
- The Convergence log file is generated per calculation phase. Each generated file can be read with any text editor.

### 11.10.2 Structure of the convergence log file

The Convergence log file contains the following set of data:

a. Information regarding the calculated phase:
   - Phase Name
   - Number of active nodes
   - Number of active soil elements
   - Number of active structural elements (per type)
   - Number of active degrees of freedom (dof)

b. Calculation type and convergence criteria
c. Step size control parameters

d. List of steps

| List of steps | Step size re-evaluation | - |
| List of attempts | Current step size | |
| | Total number of iterations | |
| | Relevant convergence indicator values (varies per phase) | |
| | Check against relevant convergence criteria | |
| Step summary | Total time or relevant total multiplier value | |
| | Step convergence status | |
| | Location of relevant maxima | |

**Note:**
- In PLAXIS a calculation step might need to be rerun multiple times to try reaching convergence. Each time this process takes place it can be considered as an attempt. For more information, on the iteration process please visit Load stepping procedures (on page 345) and the Numerical control parameters (on page 356).
- A sample of a Convergence log file can be found in Appendix: Example - Convergence log file (on page 660)

### 11.10.3 Evaluating the accuracy of the solution

In PLAXIS non-linear calculations follow an iterative convergence process where the solutions can be considered sufficiently accurate if they fulfill different criteria. One of these is that is necessary that the residual global error is less than the tolerated error. Moreover, depending on the type of problem modelled, additional criteria are also considered by PLAXIS to enforce that both globally and locally the out-of-balance forces are close to zero.

This chapter presents an overview of all convergence criteria presented in the Convergence log file for both Deformation analysis and Flow analysis.

**Note:**
- For a brief familiarization on the iterative convergence process please visit the Scientific manual in Appendices: 1- Calculation process and 2- Understanding the iterative convergence process.
- Residual global error can be defined as the ratio between 1- the difference of the external load and the internal reaction force in the system, and 2- the external load.

---

1 It does not apply for dynamics. Sub-steps are used instead of attempts.
2 Optional value
11.10.4 Convergence criteria for deformation analysis

The convergence criteria for deformation analysis are applicable for the following PLAXIS analysis:

- Plastic analysis
- Consolidation analysis
- Dynamics analysis
- Dynamics with consolidation analysis
- Safety analysis
- Fully coupled analysis (deformation part)

PLAXIS calculation kernel reports in the Convergence log file the different indicators corresponding to the convergence criteria for the deformation analysis. The indicators are presented for the different steps and iterations during the calculation, and they are presented as follows:

1. Global error criteria
   - Check on force residuals
   - Check on moment residuals

2. Local error checking criteria
   - Inaccurate plastic points for soil elements
   - Inaccurate plastic points for interface elements

3. Total (integrated) local error
   - Accuracy for embedded beams

In general, the deformation convergence criteria are obtained by comparing a calculated error with a tolerated error. In PLAXIS the tolerated error is automatically set as 0.01. This default value can be changed per phase in the Staged construction and Flow conditions modes under the Numerical control parameters > Tolerated error as displayed in Figure 352 (on page 547)).
Convergence criteria for flow analysis

The convergence criteria for the flow analysis are applicable to the following PLAXIS analyses:

- Steady state flow (groundwater and/or thermal)
- Transient flow (groundwater (groundwater and/or thermal))
- Fully coupled analysis (groundwater and/or thermal)

PLAXIS calculation kernel reports in the Convergence log file the different indicators corresponding to the convergence criteria for the flow analysis. The indicators are presented for the different steps and iterations during the calculation, and they are presented as follows:

1. Global error criteria
   - Flow error check
   - Change of heat storage for thermal flow calculation check
   - Unsaturated behaviour convergence checks for groundwater flow analysis

2. Local error indicators for groundwater flow calculation

Note: If a user requires to manually define the **Tolerated error** please ensure that the **Use default iter parameters** is unselected.
- Inaccurate nodes for boundary conditions
  - Inaccurate seepage nodes
  - Inaccurate well (extraction) nodes
  - Inaccurate drain nodes
  - Inaccurate ponding nodes
- Maximum allowable number of iterations for checking status change.

3. Special case: Steady-state calculation criteria
   - Local groundwater flow error
   - Average pore pressure change
   - Maximum pore pressure change
   - Inaccurate nodes for specific boundary conditions

### 11.11 Sensitivity Analysis and Parameter variation [GSE]

The *Sensitivity Analysis and Parameter Variation* facility can be used to evaluate the influence of model parameters on calculation results. This might be useful in the case that parameters cannot be determined accurately. In such a case, a sensitivity analysis can be performed in which parameters are varied individually in order to evaluate the so-called sensitivity score against certain criteria. The sensitivity score can be used to evaluate which of the parameters have a major influence and which have a minor influence. Next, a parameter variation analysis can be performed with the parameters having a major influence in order to evaluate the range of results that can be expected when these parameters are varied all together within their specified range.

Before starting the *Sensitivity Analysis and Parameter Variation* facility, it is necessary to completely create a PLAXIS 2D model, define calculate phases, select points for curves and perform the calculations with the values as defined in the material data sets.

To start the process it is required to first configure the remote server. This can be done in both *Input* and *Output* by clicking on *Configure remote scripting server* from the drop-down menu in *Expert* menu. Next, click the *Start server* to establish a remote scripting server connection. This window can now be closed. To end the connection the button *Stop server* can be clicked.
To start the tool, the Sensitivity analysis and parameter variation is clicked from the Expert drop-down menu. This now automatically starts both Output and Sensitivity and parameter variation windows. This window has two blue tabs and two orange tabs.

The first blue Settings tabsheet, gives information regarding the input and output connection and also the option to reconnect. It is recommended to test the Input and Output connections.
11.11.1 Select parameters

The **Select parameters** tabsheet, gives information about all the parameters that can be changed in order to perform the sensitivity analysis. Available parameters are most model parameters of the data sets for soil and interfaces as well as parameters of the data sets of structural elements if applicable.

![Select parameters tabsheet](image)

*Figure 355: Select parameters tabsheet*

Data sets maybe expanded by clicking on the + box in front of the data set. It is possible to add parameters to the analysis by right-clicking the parameter in the left panel and selecting **Use**. It is also possible to simply drag and drop the parameter from the left panel to the right side. In the right panel, there are six columns namely **Type**, **Material**, **Parameter**, **Min**, **Ref** and **Max**. The **Ref** value of the model parameter as specified in the material data base. The user is supposed to enter minimum and maximum values of the parameters in the **Min** and **Max** columns. The **Ref** value does not necessarily need to be in the range of **Min** and **Max** values. For every parameter specified, the Sensitivity Analysis is performed for the minimum and maximum values as entered by the user, while reference values are used for the other parameters. Hence, for N parameters, 2N variations are calculated in addition to the reference calculation with all reference values. All variations are listed in the lower panel of the Sensitivity Analysis tab sheet. They are stored as separate projects in the sub-folder ‘Sensi’ of the corresponding PLAXIS 2D project under the corresponding project name added by _##, where ## is the variation number corresponding to the list of variations. For every parameter specified, the Sensitivity analysis is performed based on the minimum and maximum values as entered by the user.

To remove a parameter from the analysis, right-click and select **Don’t use**.

11.11.2 Sensitivity analysis

The orange calculation tabsheet Sensitivity Analysis allows the user to add one or more criteria on the basis of which the sensitivity score is calculated. A criterion can be, for example, the absolute displacement of a particular point in the geometry, $|u|$, or the safety factor at the end of a safety analysis, $\Sigma M_{sf}$. It can be argued that
a stiffness parameter, such as Young's modulus, has a major sensitivity in a Serviceability Limit State (SLS) analysis when a criterion is defined based on the displacement of a particular point. A strength parameter, such as the friction angle, may have a minor sensitivity in this case. Reversely, it can be argued that a strength parameter has a major sensitivity in an Ultimate Limit State (ULS) analysis when a criterion is defined based on $\Sigma M_{sf}$, whilst a stiffness parameter has a minor sensitivity in this case.

- The first step is to add a criterion on which the sensitivity score is calculated. This can be done in the left panel by clicking the **Add criterion** button. It is possible to add multiple criteria for different phases.
- To remove any criterion, click **Remove criterion** button.

11.11.2.1 Criterion

| Displacement | The calculation of the sensitivity score is based on the displacements. The calculations can be specified if it should be done with **Total displacement** $|U|$, displacements in x direction $U_x$ or displacements in y direction $U_y$. |
|--------------|-------------------------------------------------------------------------------------------------|
| StressStrain | The calculation of the sensitivity score is based on stress or strain criteria. Here it is possible to specify which criterion under **Value type** such as **Cartesian effective stresses**, **Excess pore pressure** or **Total cartesian strains**. |
| Reached values | The calculation of sensitivity score should be based on the reached values for each phase. The different options for **Value type** are **Reached force** in x or y direction, $\Sigma M_{sf}$, $\Sigma M_{Stage}$, **Reached total time** or **Reached maximum pore pressure**. |

![Figure 356: Sensitivity analysis tabsheet](image)

After selecting the different criteria, the next step is to perform the sensitivity analysis by clicking the **Run analysis**. After the calculation is completed, an overview is available in the lower panel regarding all the parameters and whether each step has been successful.
Next step is to calculate the SensiScore for the project by clicking the Recalculate SensiScore button (Figure 356 (on page 551)). When multiple criteria have been defined, the sensitivity score is based on a weighted average of the scores of all criteria.

For more information, please see Scientific Manual - Theory of sensitivity analysis.

11.11.3 Parameter variation

The orange calculation tabsheet Parameter Variation allows the user to calculate the upper bound and lower bound results of all combinations of upper bound and lower bound values of the parameters considered in the Parameter Variation analysis. For N parameters $2^N$ (= 2 to the power N) variations are calculated. Hence, the number of calculations required for a Parameter Variation analysis is generally larger than the number of calculations required for a Sensitivity Analysis. Therefore, it is recommended to first perform a Sensitivity Analysis in order to evaluate which parameters have a major influence on the results and then perform a Parameter Variation analysis (with a reduced number of parameters compared to the Sensitivity Analysis). All variations are listed in the lower panel of the Parameter Variation tab sheet. They are stored as separate projects in the sub-folder 'ParVar' of the corresponding PLAXIS 2D project under the corresponding project name added by _##_, where ## is the variation number corresponding to the list of variations.

![Figure 357: Parameter variation tabsheet](image)

Click on the Run analysis, to start the calculation. PLAXIS 2D then starts to recalculate all the modifications. It is then possible to view the results of the calculation.

The results of a Parameter Variation analysis are stored in two separate projects in the sub-folder 'ParVar' of the corresponding PLAXIS 2D project: a <ProjectName>_Max project containing the maximum values of all numerical results and a <ProjectName>_Min project with the minimum values of all numerical results.

**Note:**

Note that the Min and Max project contain a collection of results from different parameter variations and do not form a consistent set of results for one particular set of parameters.
The Min and Max project may be used to evaluate the range of results that can be expected based on the parameter variations considered.

**Note:**
Note that the range of results depends on the selected Min and Max values of the parameters considered in the Parameter Variation analysis.

### 11.12 Simulation of soil lab tests [GSE]

The SoilTest option is a quick and convenient procedure to simulate basic soil lab tests on the basis of a single point algorithm, i.e. without the need to create a complete finite element model. This option can be used to compare the behaviour as defined by the soil model and the parameters of a soil data set with the results of laboratory test data obtained from a site investigation. It also offers the possibility to optimise model parameters such that a best fit is obtained between the model results and the lab test data. The SoilTest facility works for any soil model, both standard soil models as well as user-defined models.

The SoilTest option is available from the Material sets window if a soil data set is selected (see Figure 358 (on page 553)). Alternatively, the SoilTest option can be reached from the Soil dialog.

![Material sets window showing the project and the global database](image)

*Figure 358: Material sets window showing the project and the global database*

Once the SoilTest option has been selected, a separate window will open (Figure 359 (on page 554)). This window contains a menu, a toolbar and several smaller sections. The various items are described in more detail below.
### 1. Main menu

The menus available in the main window are:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>To open, save and close a soil test data file (*.vlt).</td>
</tr>
<tr>
<td>Test</td>
<td>To select the test that will be simulated. The options available are Triaxial, CycTriaxial, Oedometer, CRS, DSS, CDSS, and General.</td>
</tr>
<tr>
<td>Results</td>
<td>To select the configuration of diagrams to display.</td>
</tr>
<tr>
<td>Kernel</td>
<td>Kernel used for calculation (3D always for PLAXIS 3D and 2D for PLAXIS 2D).</td>
</tr>
<tr>
<td>Options</td>
<td>To enable the options for the <strong>Thermal</strong> and <strong>Suction</strong> calculation. These options are used to calibrate model parameters for the more advanced material models in PLAXIS that may be derived from suction or temperature-controlled lab tests. These options are available in the Advanced and Ultimate tiers with a valid Geotechnical Select Entitlement.</td>
</tr>
</tbody>
</table>

### 2. Toolbar

**Figure 359: SoilTest window showing drained triaxial test input**
The toolbar allows for loading, saving and running of soil test results and opening the PLAXIS SoilTest - Settings window to set the configuration of the results. It also contains the parameter optimisation feature (Parameter optimisation (on page 569)). The soil test calculation kernel is a reduced version of the finite element kernel. They, however, share the same constitutive model implementations, i.e. the same stress calculations.

3. Material properties

The Material properties box displays the name, material model and parameters of the currently selected data set. Transferring of material parameters to and from the material database is possible. To copy the modified parameters to the material database:

- Click the Copy material button in the Material properties box.
- In the program open the Material sets window and either select the corresponding material set or click New.
- In the Soil window click Paste material button. The parameters will be copied in the material database. In the same way it is also possible to copy material from material database to soil test.

4. Test area

The type of test and the testing conditions are defined in the test area. The test options available are Triaxial, CycTriaxial, Oedometer, CRS, DSS, CDSS, and General. As one of these options is selected by clicking the corresponding tab, the testing conditions can be defined in the tabsheet. A more detailed description of the tests is given in the following sections.

5. Run

The Run button starts the currently selected test.

6. Test configurations

The Test configurations button can be used to add and manage different soil test configurations. A test configuration contains information about the test type and the values of test input parameters. To save a test configuration select the Save option in the menu displayed as the Test configuration button is clicked. The Manage option can be used to manage the test configurations available. When the Manage option is selected, the Manage configuration window pops up. Note that the name of the window indicates the test to which the configuration belongs (Figure 360 (on page 556)).
7. Set as default

The Set as default button saves the current input parameters as the default parameters. These will be initialised as such the next time the SoilTest window is opened.

8. Loaded tests

When previously saved tests of the current type have been opened from the File menu, the Loaded tests window lists all these tests within each tabsheet. The results of all loaded tests are shown together with the results of the current test. The Delete button can be used to remove the selected test from the list of loaded tests. It does not remove the soil test file (*.vlt) from disk.

9. Results

The results of the test are displayed in the predefined diagrams in the results area.

11.12.1 Triaxial test

The Triaxial tabsheet contains facilities to define different types of triaxial tests. Before specifying the test conditions, a selection can be made between different triaxial tests options.

11.12.1.1 Triaxial test - Options

| Drained / undrained triaxial test | In the latter case, undrained soil conditions and zero drainage are assumed (similar as when the Drainage type has been set to Undrained (A) or Undrained (B), see Modelling undrained behaviour (on page 267)), irrespective of the drainage type setting in the material data set. |

Figure 360: Manage configurations window for triaxial tests

The name and the location of the configuration file is indicated in the Filename and Path respectively in the Manage configurations window.

The Set as default button saves the current input parameters as the default parameters. These will be initialised as such the next time the SoilTest window is opened.

When previously saved tests of the current type have been opened from the File menu, the Loaded tests window lists all these tests within each tabsheet. The results of all loaded tests are shown together with the results of the current test. The Delete button can be used to remove the selected test from the list of loaded tests. It does not remove the soil test file (*.vlt) from disk.

The results of the test are displayed in the predefined diagrams in the results area.

11.12.1 Triaxial test

The Triaxial tabsheet contains facilities to define different types of triaxial tests. Before specifying the test conditions, a selection can be made between different triaxial tests options.

11.12.1.1 Triaxial test - Options

| Drained / undrained triaxial test | In the latter case, undrained soil conditions and zero drainage are assumed (similar as when the Drainage type has been set to Undrained (A) or Undrained (B), see Modelling undrained behaviour (on page 267)), irrespective of the drainage type setting in the material data set. |

Figure 360: Manage configurations window for triaxial tests

The name and the location of the configuration file is indicated in the Filename and Path respectively in the Manage configurations window.

The Set as default button saves the current input parameters as the default parameters. These will be initialised as such the next time the SoilTest window is opened.

When previously saved tests of the current type have been opened from the File menu, the Loaded tests window lists all these tests within each tabsheet. The results of all loaded tests are shown together with the results of the current test. The Delete button can be used to remove the selected test from the list of loaded tests. It does not remove the soil test file (*.vlt) from disk.

The results of the test are displayed in the predefined diagrams in the results area.

11.12.1 Triaxial test

The Triaxial tabsheet contains facilities to define different types of triaxial tests. Before specifying the test conditions, a selection can be made between different triaxial tests options.

11.12.1.1 Triaxial test - Options

| Drained / undrained triaxial test | In the latter case, undrained soil conditions and zero drainage are assumed (similar as when the Drainage type has been set to Undrained (A) or Undrained (B), see Modelling undrained behaviour (on page 267)), irrespective of the drainage type setting in the material data set. |

Figure 360: Manage configurations window for triaxial tests

The name and the location of the configuration file is indicated in the Filename and Path respectively in the Manage configurations window.

The Set as default button saves the current input parameters as the default parameters. These will be initialised as such the next time the SoilTest window is opened.

When previously saved tests of the current type have been opened from the File menu, the Loaded tests window lists all these tests within each tabsheet. The results of all loaded tests are shown together with the results of the current test. The Delete button can be used to remove the selected test from the list of loaded tests. It does not remove the soil test file (*.vlt) from disk.

The results of the test are displayed in the predefined diagrams in the results area.
### 11.12.1.2 Triaxial test - Conditions

The following test conditions can be defined:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Initial effective stress</strong> (</td>
<td>\sigma'_{xx}</td>
</tr>
<tr>
<td><strong>Initial total cell pressure</strong> (</td>
<td>\sigma_{xx}</td>
</tr>
<tr>
<td><strong>Maximum strain</strong> (</td>
<td>\varepsilon_{yy}</td>
</tr>
<tr>
<td><strong>Number of steps</strong></td>
<td>The number of steps that will be used in the calculation.</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>Time increment (only relevant for time-dependent models; consolidation is not considered).</td>
</tr>
<tr>
<td><strong>[vertical precons. stress]</strong></td>
<td>The vertical preconsolidation pressure to which the soil has been subjected. If the soil is normally consolidated, this value should be set equal to the initial stress state, i.e. zero. From the vertical preconsolidation stress, the program calculates the isotropic preconsolidation stress based on the (K_0^{nc}) loading path (see the Material Models Manual - Preliminaries on material modelling - The initial preconsolidation stress in advanced models). This option is only available for the advanced soil models.</td>
</tr>
<tr>
<td><strong>Mobilized relative shear strength</strong></td>
<td>The option to activate the mobilized relative shear strength is only available for the Hardening Soil model and Hardening Soil model with small-strain stiffness to set the initial shear hardening contour. This option can be deactivated (isotropic stress state) or deactivated (failure state).</td>
</tr>
<tr>
<td><strong>Initial suction s</strong></td>
<td>Initial suction is the water retention energy created by the soil matrix. When the <em>Suction</em> option is activated in the <em>Options</em> menu, the initial total cell pressure (</td>
</tr>
<tr>
<td><strong>Initial effective saturation (S_e)</strong></td>
<td>It is calculated based on the input from initial suction (s), however the default value is considered as (s=0, S_e=1). (See Material model Chapter 19, equation 383).</td>
</tr>
</tbody>
</table>
Initial temperature $T$

This option is available when the **Thermal** option is activated in the **Options** menu. The default value is set as 293.15 K.

**Note:**

- During a laboratory consolidated undrained triaxial test (CU test) a back pressure is applied to make sure that the sample is fully saturated. Then the sample is consolidated by using a constant cell pressure and back pressure. Note that the value assigned to the **Initial effective stress** in the SoilTest should be the effective stress at the start of the test, which is equal to the cell pressure minus the back pressure at the start of the test.
- Suction is considered to be positive and compression is negative.

### 11.12.2 Cyclic triaxial test

The **CycTriaxial** tabsheet contains facilities to define different types of cyclic triaxial tests. Before specifying the test conditions, a selection can be made between different cyclic triaxial tests options.

### 11.12.2.1 Cyclic triaxial test - Options

<table>
<thead>
<tr>
<th>Drained / undrained triaxial test</th>
<th>In the latter case, undrained soil conditions and zero drainage are assumed (similar as when the <strong>Drainage type</strong> has been set to <strong>Undrained (A)</strong> or <strong>Undrained (B)</strong>, see Modelling undrained behaviour (on page 267)), irrespective of the drainage type setting in the material data set.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isotropically consolidated / $K_0$-consolidated test</td>
<td>In the latter case the $K_0$-value (ratio of lateral stress over axial stress) can be specified to set the initial stress state.</td>
</tr>
</tbody>
</table>

### 11.12.2.2 Cyclic triaxial test - Conditions

The following test conditions can be defined:

<p>| Initial effective cell pressure $|\sigma'<em>{xx}|$ | The absolute value of the isotropic cell pressure at which the sample is consolidated, entered in units of stress. This sets the initial stress state. In the case of a $K_0$-consolidated test, this value represents the initial lateral stress, $\sigma'</em>{xx}$; the initial vertical stress, $\sigma'<em>{yy}$, is defined as $\sigma'</em>{xx} / K_0$. |
|----------------------------------|--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|
| Initial total cell pressure $|\sigma_{xx}|$ | This is only available when the <strong>Suction</strong> option is selected. When the <strong>Suction</strong> is activated in the <strong>Options</strong> menu, the initial total cell pressure $|\sigma_{xx}|$ is to be entered. However the initial effective stress will be calculated as $(Total\ stress+S_e.s)$ and is sent to the kernel. (Note that the initial total cell pressure and initial effective stress are considered to be same when the suction is zero.) |</p>
<table>
<thead>
<tr>
<th>Initial axial stress increment $\Delta\sigma_{yy}$</th>
<th>After applying the initial cell pressure, it is possible to use an axial stress increment (negative for compression or positive for extension) before performing the cycles (Figure 361 (on page 560)). This is applied in one calculation phase.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of cycles</td>
<td>This defines the number of load cycles for the test. Each cycle gives a total of 3 calculation phases (applying $+1 \times$ amplitude, $-2 \times$ amplitude, $+1 \times$ amplitude).</td>
</tr>
<tr>
<td>Number of steps per quarter cycle</td>
<td>This defines the number of steps per quarter cycle. The total number of steps applied in the whole calculation process is: $(1 + 4 \times$ number of cycles) $\times$ number of steps per quarter cycle.</td>
</tr>
<tr>
<td>Duration per cycle</td>
<td>Time increment (only relevant for time-dependent models; consolidation is not considered).</td>
</tr>
<tr>
<td>Test control</td>
<td>This option allows the user to define whether the test is stress-controlled or strain-controlled. In the case of strain-control (which is the default), the user needs to specify a strain amplitude, whereas in the case of stress-control, the input of a stress amplitude is required.</td>
</tr>
<tr>
<td>Axial strain $\Delta\varepsilon_{yy}$ / Axial stress $\Delta\sigma_{yy}$ amplitude</td>
<td>The user needs to specify a value for the axial strain or axial stress amplitude (Figure 361 (on page 560)), depending on the test control.</td>
</tr>
<tr>
<td></td>
<td>The vertical preconsolidation pressure to which the soil has been subjected. If the soil is normally consolidated this value should be set equal to the initial stress state, i.e. zero. From the vertical preconsolidation stress the program calculates the isotropic preconsolidation stress based on the $K_{0nc}$ loading path (see the Material Models Manual - Preliminaries on material modelling - The initial preconsolidation stress in advanced models). This option is only available for the advanced soil models.</td>
</tr>
<tr>
<td>Mobilized relative shear strength</td>
<td>This option is only available for the Hardening Soil model and Hardening Soil model with small-strain stiffness to set the initial shear hardening contour. This value must be between 0 (isotropic stress state) and 1 (failure state).</td>
</tr>
<tr>
<td>Initial suction $s$</td>
<td>Initial suction is the water retention energy created by the soil matrix. When the Suction is activated in the Options menu, the initial total cell pressure $</td>
</tr>
<tr>
<td>Initial effective saturation $S_e$</td>
<td>It is calculated based on the input from initial suction $s$, however the default value is considered as $s=0$, $S_e=1.$ (Material model Chapter 19, equation 383).</td>
</tr>
<tr>
<td>Initial temperature $T$</td>
<td>This option is available when the Thermal is activated in the Options menu. The default value is set as 293.15 K.</td>
</tr>
</tbody>
</table>

**Note:**
- During a consolidated undrained triaxial test (CU test) in a laboratory, a backpressure is applied to make sure that the sample is fully saturated. Then the sample is consolidated by using a constant cell pressure and back pressure. Note that the value assigned to the Initial effective stress in the SoilTest should be the effective stress at the start of the test, which is equal to the cell pressure minus the back pressure at the start of the test.
**11.12.3 Oedometer test**

The **Oedometer** tabsheet contains facilities to define a one-dimensional compression (oedometer) test. The following settings can be defined:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Vertical precons. stress]</td>
<td>The vertical preconsolidation pressure to which the soil has been subjected. If the soil is normally consolidated this value should be set equal to the initial stress state, i.e. zero. From the vertical preconsolidation stress the program calculates the isotropic preconsolidation stress based on the $K_{0}^{nc}$ loading path (see the Material Models Manual - Preliminaries on material modelling - The initial preconsolidation stress in advanced models). This option is only available for the advanced soil models.</td>
<td></td>
</tr>
<tr>
<td>Mobilized relative shear strength</td>
<td>This option is only available for the Hardening Soil model and Hardening Soil model with small-strain stiffness to set the initial shear hardening contour. This value must be between 0 (isotropic stress state) and 1 (failure state).</td>
<td></td>
</tr>
<tr>
<td>Initial suction, s</td>
<td>Initial suction is the water retention energy created by the soil matrix. This option is only available when the <strong>Suction</strong> option is activated in the <strong>Options</strong> menu.</td>
<td></td>
</tr>
<tr>
<td>Initial effective saturation $S_e$</td>
<td>It is calculated based on the input from Initial suction s, however the default value is considered as $s=0$, $S_e=1$. (Material model Chapter 19, equation 383).</td>
<td></td>
</tr>
<tr>
<td>Initial temperature T</td>
<td>This option is available when the <strong>Thermal</strong> is activated in the <strong>Options</strong> menu. The default value is set as 293.15 K.</td>
<td></td>
</tr>
</tbody>
</table>

*Figure 361: Cyclic triaxial test conditions*
### Phases

Lists the different phases of the oedometer test. Each phase is defined by a **Duration** (in units of time), a **vertical Stress increment** (in units of stress) and a **Number of steps**. The initial state is always assumed to be stress free. The given stress increment will be reached at the end of the given duration in the given number of steps. The input values can be changed by clicking in the table. A negative stress increment implies additional compression, whereas a positive stress increment implies unloading or tension. If a period of constant load is desired, enter the desired duration with a zero stress increment.

<table>
<thead>
<tr>
<th>Add</th>
<th>Adds a new phase to the end of the Phases list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Inserts a new phase before the currently selected phase.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the currently selected phase from the Phases list.</td>
</tr>
</tbody>
</table>

**Note:** In this test, the initial effective stresses are zero. However, when suction is larger than zero, the initial total stresses are equal to zero and the corresponding effective stresses are calculated as \((\text{Total stress} + S_e)\).

### 11.12.4 CRS

The **CRS** tabsheet contains facilities to define a constant rate-of-strain compression test. The following settings can be defined:

<table>
<thead>
<tr>
<th>[Vertical precons. stress]</th>
<th>The vertical preconsolidation pressure to which the soil has been subjected. If the soil is normally consolidated this value should be set equal to the initial stress state, i.e. zero. From the vertical preconsolidation stress the program calculates the isotropic preconsolidation stress based on the (K_{0}^{nc}) loading path (see the Material Models Manual - Preliminaries on material modelling - The initial preconsolidation stress in advanced models). This option is only available for the advanced soil models.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobilized relative shear strength</td>
<td>This option is only available for the Hardening Soil model and Hardening Soil model with small-strain stiffness to set the initial shear hardening contour. This value must be between 0 (isotropic stress state) and 1 (failure state).</td>
</tr>
<tr>
<td>Initial suction (s)</td>
<td>Initial suction is the water retention energy created by the soil matrix. When the <strong>Suction</strong> option is activated in the Options menu, then Initial suction is to be entered as input accordingly.</td>
</tr>
<tr>
<td>Initial effective saturation (S_e)</td>
<td>It is calculated based on the input from initial suction (s), however the default value is considered as (s=0, S_e=1). (Material model Chapter 19, equation 383).</td>
</tr>
<tr>
<td>Initial temperature (T)</td>
<td>This option is available when the <strong>Thermal</strong> is activated in the Options menu. The default value is set as 293.15 K.</td>
</tr>
</tbody>
</table>
Phases

Lists the different phases of the CRS test. Each phase is defined by a Duration (in units of time), a vertical Strain increment (in %) and a Number of steps. The initial state is always assumed to be stress free. The given strain increment will be reached at the end of the given duration in the given number of steps. The input values can be changed by clicking in the table. A negative strain increment implies additional compression, whereas a positive strain increment implies unloading or tension. If a period of zero strain is desired, enter the desired duration with a zero strain increment.

Add

Adds a new phase to the end of the Phases list.

Insert

Inserts a new phase before the currently selected phase.

Remove

Removes the currently selected phase from the Phases list.

Note: In this test, the initial effective stresses are zero. However, when suction is larger than zero, the initial total stresses are equal to zero and the corresponding effective stresses are calculated as (Total stress + S_e.s).

11.12.5 DSS

The DSS tabsheet contains facilities to define a direct simple-shear test. Before specifying the test conditions, a selection can be made between different test options.

11.12.5.1 DSS - Options

Drained / undrained triaxial test

In the latter case, undrained soil conditions and zero drainage are assumed (similar as when the Drainage type has been set to Undrained (A) or Undrained (B), see Modelling undrained behaviour (on page 267)), irrespective of the drainage type setting in the material data set.

Isotropically consolidated / $K_0$-consolidated test

In the latter case the $K_0$-value (ratio of lateral stress over axial stress) can be specified to set the initial stress state.

11.12.5.2 DSS - Conditions

The following settings can be defined:

Initial effective stress $|\sigma_{yy}'|$

The absolute value of the initial vertical stress at which the sample is consolidated, entered in units of stress. In the case of an isotropically consolidated test, the initial lateral stress is equal to the initial vertical stress. In the case of a $K_0$-consolidated test, the initial lateral stress is equal to $K_0\sigma_{yy}'$. 
| Table 11.12.6.1 | CDSS - Options | **Drained / undrained triaxial test** | In the latter case, undrained soil conditions and zero drainage are assumed (similar as when the Drainage type has been set to Undrained (A) or Undrained (B), see Modelling undrained behaviour (on page 267)), irrespective of the drainage type setting in the material data set.

---

**Initial total stress | \( \sigma_{yy} \)|** This is only available when the Suction option is selected. When the Suction is activated in the Options menu, the initial total stress | \( \sigma_{yy} \) | is to be entered. However the initial effective stress will be calculated as (Total stress+ \( S_e \cdot s \)) and is sent to the kernel. (Note that the initial total cell pressure and initial effective stress are considered to be equal when the suction is zero.)

**Maximum shear strain | \( \gamma_{yy} \)|** The maximum value of shear strain (entered in reached in the last calculation step).

**Number of steps** The number of steps that will be used in the calculation.

| Table 11.12.6 | CDSS | **Vertical precons. stress** | The vertical preconsolidation pressure to which the soil has been subjected. If the soil is normally consolidated this value should be set equal to the initial stress state, i.e. zero. From the vertical preconsolidation stress the program calculates the isotropic preconsolidation stress based on the \( K_0 \) loading path (see the Material Models Manual - Preliminaries on material modelling - The initial preconsolidation stress in advanced models). This option is only available for the advanced soil models.

**Mobilized relative shear strength** This option is only available for the Hardening Soil model and Hardening Soil model with small-strain stiffness to set the initial shear hardening contour. This value must be between 0 (isotropic stress state) and 1 (failure state).

**Duration** Time increment (only relevant for time-dependent models; consolidation is not considered).

**Initial suction s** Initial suction is the water retention energy created by the soil matrix. When the Suction is activated in the Options menu, the initial total stress | \( \sigma_{yy} \) | is to be entered accordingly.

**Initial effective saturation \( S_e \)** It is calculated based on the input from initial suction s, however the default value is considered as s=0, \( S_e=1 \). (Material model Chapter 19, equation 383)

**Initial temperature T** This option is available when the Thermal is activated in the Options menu.

**11.12.6 CDSS**

The CDSS tabsheet contains facilities to define a cyclic direct simple-shear test. Before specifying the test conditions, a selection can be made between different test options.
Isotropically consolidated / $K_0$-consolidated test

In the latter case the $K_0$-value (ratio of lateral stress over axial stress) can be specified to set the initial stress state.

<table>
<thead>
<tr>
<th>11.12.6.2 CDSS - Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The following settings can be defined:</td>
</tr>
</tbody>
</table>

| Initial effective stress $|\sigma'_{yy}|$ | The absolute value of the initial vertical stress at which the sample is consolidated, entered in units of stress. In the case of an isotropically consolidated test, the initial lateral stress is equal to the initial vertical stress. In the case of a $K_0$-consolidated test, the initial lateral stress is equal to $K_0 \sigma_{yy}$. |
| Initial total stress $|\sigma_{yy}|$ | This is only available when the Suction option is selected. When the Suction is activated in the Options menu, the initial total stress $|\sigma_{yy}|$ is to be entered. However, the initial effective stress will be calculated as $(Total\ stress+ S_{e, s})$ and is sent to the kernel. (Note that the initial total stress and initial effective stress are same when suction is zero.) |
| Initial static shear $\sigma_{xy}$ | The initial static shear defines an initial shear stress component, leading to an initial principal stress rotation, which will form an offset to the shear stress increments that result from cyclic loading. The initial static shear is applied as a first calculation phase in the test. Irrespective of the test option (drained or undrained), this first phase is always applied under drained conditions. |
| Duration | Time increment $\Delta t$ as indicated in Figure 362 (on page 565) (only relevant for time-dependent models; consolidation is not considered). |
| Number of cycles | This defines the number of load cycles for the test. Each cycle gives a total of 3 calculation phases (applying $+1 \times$ amplitude, $-2 \times$ amplitude, $+1 \times$ amplitude, Figure 362 (on page 565)). |
| Number of steps per quarter cycle | This defines the number of steps per quarter cycle. The total number of steps applied in the whole calculation process is: $(1 + 4 \times$ number of cycles) $\times$ number of steps per quarter cycle. |
| Duration per cycle | The duration per cycle expressed in days. |
| Test control | This option allows the user to define whether the test is stress-controlled or strain-controlled. In the case of strain-control (which is the default), the user needs to specify a strain amplitude, whereas in the case of stress-control, the input of a stress amplitude is required. |
| Shear strain $\Delta \gamma_{xy}$ / Shear stress $\Delta \sigma_{xy}$ amplitude | The user needs to specify a value for the shear strain or shear stress amplitude, depending on the test control. In order to apply a particular cyclic stress ratio, CSR = $\Delta \sigma_{xy} / \sigma_{yy}$, the user needs to define the appropriate Initial stress $\sigma_{yy}$, set the Test control to Stress, and input the Shear stress amplitude as $\Delta \sigma_{xy} = CSR \sigma_{yy}$. |
### Vertical preconsolidation stress

The vertical preconsolidation pressure to which the soil has been subjected. If the soil is normally consolidated this value should be set equal to the initial stress state, i.e. zero. From the vertical preconsolidation stress the program calculates the isotropic preconsolidation stress based on the $K_0^{nc}$ loading path (see the Material Models Manual - Preliminaries on material modelling - The initial preconsolidation stress in advanced models). This option is only available for the advanced soil models.

### Mobilized relative shear strength

This option is only available for the Hardening Soil model and Hardening Soil model with small-strain stiffness to set the initial shear hardening contour. This value must be between 0 (isotropic stress state) and 1 (failure state).

### Initial suction $s$

Initial suction is the water retention energy created by the soil matrix. When the **Suction** is activated in the **Options** menu, the initial total stress $|\sigma_{yy}|$ is to be entered accordingly.

### Initial effective saturation $S_e$

It is calculated based on the input from initial suction $s$, however the default value is considered as $s=0, S_e=1$ (Material model Chapter 19, equation 383).

### Initial temperature $T$

This option is available when the **Thermal** is activated in the **Options** menu.

---

**Figure 362: Cyclic DSS test conditions**

**Note:**

Note that cycle boundaries and phase boundaries do not match except when $t = 0$ and $t = \Delta t$

---

#### 11.12.7 PMT

The **PMT** tabsheet contains facilities to define a Pressuremeter test. Rather than simulating a ‘real’ pressuremeter test using a full finite element model, the **SoilTest** kernel performs a one-dimensional (1D) cylindrical cavity
expansion simulation, and the results are transformed as if they were obtained from a finite element Pressuremeter test simulation. The calculation is based on an updated mesh (large deformations) analysis.

**Note:**

- The Pressuremeter test is only available for the Hardening Soil model in drained conditions.
- The test may be used to simulate the pressuremeter response considering volumetric strain up to 40%.
- The options for Suction and Thermal are not available in PMT.

Before specifying the test conditions, a selection can be made between different test options.

### 11.12.7.1 PMT - Options

<table>
<thead>
<tr>
<th>Isotropic initial stress</th>
<th>In this case, isotropic initial stress conditions are assumed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>$K_0$ initial stress</td>
<td>In this case, the $K_0$-value (ratio of lateral stress over axial stress) can be specified to set the initial stress state.</td>
</tr>
</tbody>
</table>

### 11.12.7.2 PMT - Options

The following settings can be defined:

| Initial effective stress $|\sigma'_{yy}|$ | This defines the initial radius of the pressuremeter device. |
|--------------------------|------------------------------------------------------------|
| Number of steps          | This defines the number of steps for the test. |
| Test control             | This option allows the user to define whether the test is stress-controlled or strain-controlled. In the case of strain-control (which is the default), the user needs to specify a strain amplitude, whereas in the case of stress-control, the input of a stress amplitude is required. |
| Maximum radial strain $|\varepsilon_{xx}|$ | The maximum value of radial strain (entered in %) that will be reached in the last calculation step. |
| [Vertical precons. stress] | The vertical preconsolidation pressure to which the soil has been subjected. If the soil is normally consolidated this value should be set equal to the initial stress state, i.e. zero. From the vertical preconsolidation stress the program calculates the isotropic preconsolidation stress based on the $K_0^{nc}$ loading path (see the Material Models Manual - Preliminaries on material modelling - The initial preconsolidation stress in advanced models). This option is only available for the advanced soil models. |
| Apply Mobilized relative shear strength | This option is only available for the Hardening Soil model and Hardening Soil model with small-strain stiffness to set the initial shear hardening contour. This value must be between 0 (isotropic stress state) and 1 (failure state). |
| Duration                 | Time increment (only relevant for time-dependent models; consolidation is not considered). |
11.12.7.3 PMT - Transformation formulae

The cylindrical cavity expansion is simulated by means of an axisymmetric 1D finite element modelling approach. The obtained results are post-processed in the SoilTest calculation kernel and transformed to Pressuremeter test results. The adopted approach reads:

- The 1D cylindrical cavity expansion calculation is performed.
- The cavity secant stiffness is calculated as:
  \[ K_{sec,cav} = \frac{(P_{cav} - P_{cav,0})}{(\Delta V / V_0)} \]  \[ Eq. \ [131] \]
  where
  - \( p_{cav,0} \) = Initial lateral stress, equal to \( K_0 \sigma_y' \)
  - \( p_{cav} \) = Cavity pressure at each calculation step and \( \Delta V/V_0 \) is the volumetric strain.
- The PMT pressure is calculated as:
  \[ P_{PMT} = P_{cav,0} + (P_{cav} - P_{cav,0})[A(\Delta V / V_0) + B] \]  \[ Eq. \ [132] \]
- The coefficients \( A \) and \( B \) are derived as follows:
  \[ A = 0.1575537(Z^{0.4905724}) \]  \[ Eq. \ [133] \]
  \[ B = 0.0008217Z + 0.9702063 \]  \[ where \ 1.0 \leq B \leq 1.25 \]
- The parameter \( Z \) is defined as:
  \[ Z = E_{oed} \cdot m / (p_{cav} + c' / \tan(\phi)) \]  \[ Eq. \ [134] \]
  where
  - \( E_{oed} \) = Oedometer Young's modulus at a stress level equal to \( p_{cav} \) and \( m, c', \phi \) are model parameters of the Hardening Soil model.

11.12.7.4 PMT - Results

The Pressuremeter test results are presented in two graphs:

- The first graph shows the PMT pressure \( P_{PMT} \) as a function of the radial strain \( \varepsilon_{xx} = u_x / R_0 \)
- The second graph illustrates the PMT pressure \( P_{PMT} \) as a function of the volumetric strain \( \Delta V/V_0 = (R^2 - R_0^2) / R_0^2 \), where \( \Delta V = h \pi (R^2 - R_0^2) \), \( V_0 = h \pi R_0^2 \), and \( R \) is the increased radius of the pressuremeter device when the pressure is applied.

11.12.8 General

The General tabsheet contains facilities to define arbitrary stress and strain conditions. The following settings can be defined:

<table>
<thead>
<tr>
<th>Type of test</th>
<th>The type of the test, whether Drained or Undrained can be specified.</th>
</tr>
</thead>
</table>
[Vertical precons. stress] The vertical preconsolidation pressure to which the soil has been subjected. If the soil is normally consolidated this value should be set equal to the initial stress state, i.e. zero. From the vertical preconsolidation stress the program calculates the isotropic preconsolidation stress based on the $K_0^{nc}$ loading path of the Material Models Manual - Preliminaries on material modelling - The initial pre-consolidation stress in advanced models. This option is only available for the advanced soil models.

Mobilized relative shear strength This option is only available for the Hardening Soil model and Hardening Soil model with small-strain stiffness to set the initial shear hardening contour. This value must be between 0 (isotropic stress state) and 1 (failure state).

Phases Lists the initial stress conditions and the stress/strain conditions in the subsequent phases of the test. In the initial phase it should be indicated for each direction whether a stress increment or a strain increment is defined for that direction (applies to all phases). Each phase is defined by a Duration (in units of time) and a Number of steps, followed by the applied stress or strain increments. The given stress or strain increment will be reached at the end of the given duration in the given number of steps. When Suction and Drained option are selected, for every phase increment in suction $\Delta s$ is to be defined. If Thermal is selected, in input for every phase an increment of temperature $\Delta T$ is to be defined. The input values can be changed by clicking in the table. A negative stress or strain increment implies additional compression, whereas a positive stress or strain increment implies unloading or tension.

Add Adds a new phase to the end of the Phases list.

Insert Inserts a new phase before the currently selected phase.

Remove Removes the currently selected phase from the Phases list.

### 11.12.9 Results

The Results window shows several predefined typical diagrams to display the results of the current test in terms of stress and strain quantities. Results for a PMT test are different than for other tests (see PMT - Results). Double-clicking one of the graphs opens the selected diagram in a larger window (Figure 363 (on page 569)). This window shows the selected diagram, the table of the data points that are used to plot this diagram as well as the tangent and the secant values of the plot. Note that, the point to be taken into consideration for the calculation of the tangent and the secant values can be determined by clicking on the plot. The diagram or the data can be copied to the clipboard by selecting the corresponding option in the drop-down menu displayed when the Copy button is clicked.

**Note:**
- The failure line is indicated by a dashed line in the plot.
- In plots where deviatoric stress $q$ is considered, the failure line is always shown for the compression point.
The diagram can be zoomed in or out using the mouse by first clicking and holding the left mouse button in the diagram area and then moving the mouse to a second location and releasing the mouse button. Moving the mouse from the left upper corner to the right lower corner zooms the diagram to the selected area, whereas moving the mouse from the right lower corner to the left upper corner resets the view. The zoom action can also be undone using the **Zoom out** option on the toolbar. The wheel button of the mouse can be used for panning: click and hold the mouse wheel down and move the diagram to the desired position.

The secant and the tangent are useful for the back-calculation of stiffness parameters from stress-strain diagrams. The corresponding secant and tangent values are indicated below the table. The secant and the tangent can be computed interactively on the chart:

- By clicking one point, a line is drawn from the origin of the curve to the point.
- By pressing **Ctrl** and clicking a second point: a line is drawn between the first and second point. The secant determines the inclination of the line. The tangent is determined with respect to the second point.

  - By keeping **Ctrl** pressed, the user clicks the third point: the first point is deselected and a new line is drawn between the second and the third point.
  - By pressing **Shift** and clicking the third point: the second point is deselected and a new line is drawn between the first and the third point.
  - By clicking any point in the proximity of the curve without pressing **Ctrl**, any selected point is deselected and a new line is drawn according to the current behaviour (from the origin to the point).

### 11.12.10 Parameter optimisation

The soil test facility can be used to optimise model parameters such that a best fit is obtained between the model results and the results of real soil lab tests. This option can be selected from the toolbar.
Click the *Parameter optimisation* button in the toolbar. The *Parameter optimisation* window will appear, showing different colour tabs according to the various steps to follow in the parameter optimisation process (*Figure 364* (on page 570)). The first tab (*Select parameters*) is active.

*Figure 364: Parameter optimisation window*

**Note:**
- It is possible to optimise parameters for both native and User-defined Soil Model.
- *Suction* and *Thermal* options are not supported in Parameter optimisation tool.

### 11.12.10.1 Select parameters

The *Select parameters* tab shows the parameters of the selected material data set that could participate in the optimisation process. Click on the square in front of the parameter(s) that need(s) to be optimised (*Figure 365* (on page 571)). The more parameters are selected, the more time the optimisation process will take. For the selected parameters, minimum and maximum values need to be specified. The optimisation algorithm will search for optimum values within this range. If the optimised value turns out to be equal to the minimum or maximum value, it might be that the best value lies outside the specified range.

Note that parameters may influence only specific parts of a test. For example, consider an oedometer test with a loading and unloading part, modelled with the Hardening Soil model. The loading part will be dominated by the parameter $E_{oed}^{ref}$, whereas the unloading part will be dominated by the parameter $E_{u}^{ref}$. In order to obtain a best fit, the optimisation may be performed in separate runs; one to optimise $E_{oed}^{ref}$ based on the loading part and one to optimise $E_{u}^{ref}$ based on the unloading part of the test.
11.12.10.2 Select curves

The Select curves tab enables selection and uploading of real soil lab test data and corresponding test conditions. Alternatively, synthetic test data may be used in the form of other PLAXIS 2D soil test results. In this way it is possible to optimise, for example, parameters of the Mohr-Coulomb model against simulated tests using the Hardening Soil model.

Initially, the window shows a tree with the five standard test types (Triaxial, CycTriaxial, Oedometer, CRS, DSS, CDSS, and General). For each test type, different test conditions can be defined, which can be taken into account in the optimisation process. By default, the Current model test is available as test conditions for each test type. The Current model test contains the test conditions as previously defined for that test (Figure 366 on page 571).
• New test conditions can be defined by selecting the *New test configuration* option from the tool bar. This will introduce a new test under the selected test, for which the test conditions can be defined in the right-hand panel (Figure 367 (on page 572)).

• All test data can be saved, by clicking on *Save to file* button. The test data will be saved to an XML file with a default file extension of *.vlo.xml.

• In both cases (*Current model test* and a new test) corresponding test data need to be selected and uploaded using the *Import curve* option. Another possibility is to upload test conditions together with the test data in case it is stored in the format of a PLAXIS 2D soil test project (<test>.vlt).

Hence, there are different ways to define test conditions and to select the external test data. The possibilities are summarized below:

• If the test data corresponds to one of the *Current model test* conditions, the corresponding line should be selected in the tree and the *Import curve* option should be used to upload the test data (Figure 368 (on page 573)). The test data are assumed to be stored in a text file (<data>.txt) and should contain two columns, separated by a Space, Tab, Comma, Colon (:), Semicolon (;) or arbitrary character. The separator is to be indicated at the top of the *Import test data* window. The meaning of the values in each column has to be selected from the drop down list below the column. Here, a selection can be made amongst various stress and strain quantities. Moreover, the basic units of the test data quantities need to be selected from the drop down lists in the *Units* group. By pressing *OK* the data is read and visualised in a diagram, and the curve is listed in the tree under the *Current model* (test) conditions.
If the test data corresponds to other than one of the current model test conditions, first new test conditions need to be defined. Select the appropriate test type and click the **New test configuration** button. The test conditions of the data to be uploaded can be defined in the right-hand panel. Subsequently, the **Import curve** option should be used to upload the test data. The test data are assumed to be stored in a text file (<data>.txt) and should contain two columns (see explanation before). The meaning of the values in each column has to be selected from the drop down list below the column. Moreover, the basic units of the test quantities need to be selected from the drop down lists in the **Units** group. By pressing **OK** the data is read and a visualised in a diagram, and the curve is listed in the tree under the **Custom (test) conditions** (**Figure 369** (on page 573)).

If the test data together with the test conditions are stored in the format of a PLAXIS soil test project (<test>.vlt), the **Open file** option should be used. After selection of a valid PLAXIS soil test project, the test conditions are listed under the corresponding test type in the tree, and the available test data curves are listed under the test conditions (**Figure 370** (on page 574)). This option should typically be used to fit
current model parameters to synthetic data previously produced in the PLAXIS soil test facility and stored in <test>.vlt format.

![Figure 370: Importing data from SoilTest](image)

**Note:**

- When a line representing test conditions is selected in the tree, the corresponding test conditions are shown on the panel at the right-hand side.
- When a line representing test data is selected in the tree, the corresponding curve is visualised in the diagram, and a table of corresponding data points is shown at the right-hand side of the diagram.
- A sub-set of test data to be used in the optimisation process can be selected in the table at the right-hand side by clicking on the corresponding cells, using the standard multi-select convention (using Shift for ranges and Ctrl for individual values). The selected values are indicated as 'thick' lines in the curve whereas non-selected values are indicated as 'thin' lines.
- Always select all data corresponding to a complete phase of the test (for example, if it is the user's intention to optimise parameters based on the unloading phase in an oedometer test that involves both loading and unloading, select the full range of unloading test data).
- A line in the tree (either test conditions or test data) can be removed by selecting that line and clicking the red cross in the toolbar.

All test data to be used in the optimisation process need to be selected in the tree by clicking the square in front of the corresponding line (if not already selected). The corresponding test conditions are automatically selected.

### 11.12.10.3 Multiple phases

In the case of an Oedometer, CRS or General test, the SoilTest facility allows for multiple phases. However, the parameter optimisation facility can only deal with one complete phase at a time. Therefore, after importing the test data, the desired calculation phase needs to be selected from the drop down list above the test data curve, together with the corresponding part of the test data in the column at the right-hand side. Note that the full range of data corresponding to this test phase is selected. In this way it is possible, for example, to optimise a
primary loading stiffness against the first (loading) phase in an oedometer test and the unloading stiffness against the second (unloading) phase. Note that the test data needs to be selected for each phase.

11.12.10.4 Settings
The *Settings* tab enables the accuracy selection of the optimisation process ([Figure 371](#) on page 575)). Three levels of search intensity are available: *Coarse and quick, Moderate, Thorough*. In addition, the relative tolerance of the search algorithm can be selected. The default value is 1E-3. Note that a more rigorous optimisation may give more accurate results, but also requires more calculation time. The calculation time also depends on the number of parameters to be optimised, as selected in the first tab. The optimisation process is based on a 'particle swarm' algorithm. This algorithm can overcome local minima in the optimisation process.

![Figure 371: Settings window](image)

11.12.10.5 Resulting parameters
The *Resulting parameters* tab shows the optimum values of the parameters used to obtain the best fit to the selected test data in addition to the minimum and maximum values and the reference values in the material data set ([Figure 372](#) on page 576)). If the optimum value is equal to the minimum or maximum value, it might be that the best value lies outside the specified range. Finally, the table shows the sensitivity of the selected parameters. A sensitivity of 100% means that the parameter has a high influence on the simulated test results, whereas a low sensitivity means that the parameter has a low influence on the simulated test results. Note that a low sensitivity also means that the test may not be suitable to optimise that parameter and, as a result, the suggested optimum value may not be accurate. Therefore it is better to do separate optimisations for different parameters based on relevant sections of test data curves rather than one optimisation with multiple parameters based on the full data curves.
A button is available to copy the optimised parameters to the material data set. This should only be done after it has been properly validated that the optimised parameters are indeed better than the original parameters, considering the use of the material data set in the finite element model.

Note that the parameters optimised for soil lab tests may not be the best parameters for the practical application as considered in the finite element model.

### 11.12.10.6 Resulting charts

The *Resulting charts* tab shows the results of the selected tests (Figure 373 (on page 577)).

For each test, three curves are visible:

<table>
<thead>
<tr>
<th>Optimisation target</th>
<th>This curve represents the uploaded test data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimisation results</td>
<td>This curve represents the simulated test with optimised parameters.</td>
</tr>
<tr>
<td>Reference simulation</td>
<td>This curve represents the simulated test with original parameters. It has no meaning in the optimisation process, but just shows how good or bad the existing material data set would fit the uploaded test data for the selected test conditions without optimisation.</td>
</tr>
</tbody>
</table>
11.12.10.7 Limitations

The Parameter optimisation facility should be used with care. Note that parameters optimised for soil lab tests may not be the best parameters for the practical application as considered in the finite element model. This is because the application may involve stress levels, stress paths and strain levels which might be significantly different from the ones that occur in the soil lab tests.

Furthermore, the parameter optimisation facility has the following limitations:

• The experimental curve should be given in the order where the first column is a prescribed value, and the second is the computed one.
• It is not possible to automatically optimise test data curves that consist of multiple phases (for example loading and unloading phases). Such curves need to be uploaded for each phase and the corresponding part of the curves (phase) needs to be selected in order to perform the optimisation.
• The optimisation process itself is a numerical procedure which may involve numerical errors. The user remains responsible for validating the outcome of the optimisation process and the use of optimised model parameters in applications. The parameter optimisation is based on curve fitting. It is not possible to fit envelopes such as the failure line in a p-q diagram. As a consequence, it is not possible to find the optimised friction angle or cohesion from a p-q diagram.

Note:

11.13 Plaxis Remote Scripting Interface [GSE]

In PLAXIS 2D it is possible to design the model using Python scripting. This approach allows saving time when many calculations of similar applications are needed. The user can use command line available in Input and
Output to run multiple commands in the Command runner, but it is also possible to use the remote scripting interface and its Python wrapper. Both command runner and remote scripting allow the user to use commands that are not exposed by the UI tools, as well as store and run macros using the extensive help (manuals and references). The full list of commands with parameters information is available in PLAXIS software under Help > Command Reference.

11.13.1 Anatomy of a command

Each command has a name and a target. Some commands may also require a parameter.

```
rename Point_1 "My Point"
```

**Figure 374: PLAXIS command**

```
g_i.Point_1.rename("MyPoint")
```

**Figure 375: Python equivalent in PLAXIS**

A few examples of PLAXIS commands and their equivalents in Python:

Command: well Line_1
Python: g_i.well(g_i.line_1)

Command: tabulate (Line_1 Line_2) "First Second" "First=Point_1" }
Python: g_i.tabulate(g_i.Line_1, g_i.Line_2, "First Second", "First=Point_1")

Command: beam Line_1 "Material" BeamMat_1
Python: g_i.beam((g_i.Line_1, g_i.Line_2), "Material", g_i.Beammat_1)

Command: activate (Plate_1 Plate_2) (Phase_4 Phase_5)
Python: g_i.activate((g_i.Plate_1, g_i.Plate_2), (g_i.Phase_4, g_i.Phase_5))

Command: soil (Volume_2 Volume_3) "Material" SoilMat_1
Python: g_i.soil((g_i.Volume_2, g_i.Volume_3), "Material", g_i.SoilMat_1)

Command: rotateline (Point_1 Points[-2]) Line_1 45
Python: g_i.rotateline((g_1.Point_1, g_i.Points[-2]), g_i.Line_1, 45)
• **Command name**

A command represents the name of an action that is to be executed, and it is given as first word in the command line as a global command (e.g. after `g_i.`) or as a specific target command (after some object) in the scripting. It is a method that is to be implemented.

**Python examples:**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>g_i.gotomesh()</code></td>
<td><code>gotomesh</code> is the command name</td>
</tr>
<tr>
<td><code>g_i.borehole(0, 0)</code></td>
<td><code>borehole</code> is the command name</td>
</tr>
<tr>
<td><code>Point_1.echo()</code></td>
<td><code>echo</code> is the command name</td>
</tr>
</tbody>
</table>

• **Target**

The target is the object for which the method is to be implemented. It can be an object (group of objects, list), global object, etc.

**Python examples:**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>g_i.gotomesh()</code></td>
<td>the target is a global environment object</td>
</tr>
<tr>
<td><code>g_i.Point_1.setproperties(&quot;x&quot;, 1, &quot;y&quot;, 2)</code></td>
<td>the target is a global environment object</td>
</tr>
<tr>
<td><code>polycurve_g.close()</code></td>
<td>the target is <code>polycurve_g</code></td>
</tr>
</tbody>
</table>

• **Parameter**

Parameters represent the extra information passed to a command when it is called. In programming terms, they are arguments to a method. In the Command line the parameters are listed after the target. In Python scripting, parameters are supplied between the parentheses after the command's name. Some commands may not need a parameter, and some may require one or more parameters.

**Python examples:**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>g_i.gotoflow()</code></td>
<td><code>gotoflow</code> command called without parameters</td>
</tr>
<tr>
<td><code>g_i.pointload(1, 0, &quot;Fx&quot;, 10)</code></td>
<td><code>pointload</code> command uses several parameters to create a point load on the point (1 0 2) and sets its force to 10</td>
</tr>
</tbody>
</table>

11.13.2 **Geometry and calculation modes objects differences**

Each object (line, line load, plate, etc.) created in the **Geometry** mode (**Soil, Structures**) is named and stored according to the general indexing rule (for more information see Indexing in commands (on page 47)). However, when the mode is changed to the **Calculation** mode (**Mesh, Water conditions, Staged construction**), the entity gets replaced by a different entity which may have fewer or more other properties and is stored differently. For
example, the line with name Polycurve_1 will get a new name in Calculation modes, which will now be Polycurve_1_1, Polycurve_1_2, etc. This is done due to intersection: when changing the modes, the geometric entity might be intersected by other objects, so the program will automatically intersect this entity, splitting it into sub-objects.
12.1 Modelling ground anchors

Ground anchors are used to restrain soil retaining walls to prevent excessive forward movement or to restrain excavation bottom plates to prevent uplift under high pore pressure conditions or to restrain other foundation structures that are subjected to tensile forces. This section explains how ground anchors can be modelled in PLAXIS 2D.

There are various ways to create ground anchors in the real world, but they can be all modelled in a similar way in PLAXIS 2D. Most methods in reality are using a steel tube or anchor bar or a bunch of steel wires that are drilled into the ground through an opening in the structure to be restrained. At the end part of the anchor in the ground, grout (cement) is injected at high pressure, forming a grout body around the anchor bar with a diameter that is significantly larger than the diameter of the anchor bar. This grout body has a strong interaction with the surrounding soil, whereas the non-grouted part in between the grouted part and the wall (the 'free length') has hardly any interaction with the soil. When the anchor is installed, it is usually pre-stressed up to 60-80% of its designed working load. After that, the anchor force will further evolve as a result of the construction process.

12.1.1 Geometric modelling of ground anchors

The stress state around the grouted part of a ground anchor is highly three-dimensional. This makes it difficult to model a ground anchor realistically in a 2D model. Nevertheless, an approximation is possible that enables a realistic analysis of deformation and overall stability of soil retaining structures, both in 2D and 3D.

A ground anchor can be created by a combination of a node-to-node anchor and an embedded beam row, in which the embedded beam row represents the grouted part of the anchor and the node-to-node anchor represents the anchor free length. The behaviour of the embedded beam row is set to 'Grout body'. The connection type is internally set to 'Free'. This is required since otherwise the embedded beam row will also be directly connected to the corresponding soil element, which will lead to an unrealistic loss of axial force in the connection point. Setting the connection to 'Free' will ensure that the axial force in the node-to-node anchor is more or less equal to the axial force at the top of the embedded beam row.
12.1.2 Properties of ground anchors

The stiffness of a ground anchor (i.e., the resistance against elongation) is formed by the axial stiffness of the anchor bar, $EA$. This applies to the anchor free length as well as the grouted part of the anchor, since upon loading of the anchor, tensile cracks will occur in the grout body, and hence, the grout body itself will not contribute to the axial stiffness.

The axial stiffness, $EA$, can be specified directly as input parameter in a material data set for anchors, as used for the node-to-node anchor. In 2D, the anchor spacing in out-of-plane direction, $l_s$, required. Internally, will divide the axial stiffness by the spacing in order to calculate the axial stiffness per unit of width in a plane strain model. Optionally, a maximum anchor tensile force $F_{\text{max,tens}}$ force $F_{\text{max,comp}}$ should be set to 0). It is also possible to specify the Material type as Elastoplastic with residual strength, which enables the modelling of anchor breakage ($F_{\text{residual,tens}} = 0$).

The properties of the embedded beam row, as used for the grouted part of the anchor, involve the stiffness properties as well as the interaction properties with the surrounding soil. Rather than specifying $EA$ directly as the axial stiffness, there is a separate input of Young’s modulus, $E$, and the anchor cross section geometry. Here, it should be considered that the anchor geometry is dominated by the diameter of the grout body, $D_g$, whereas the axial stiffness is dominated by $EA$ of the anchor bar. Hence, when selecting Predefined as Pile type and Massive circular pile as Predefined pile type (it is a ground anchor rather than a pile here), the Diameter should be set to the approximate diameter of the grout body, $D_g$. It is important to select the diameter of the grout body (and not the diameter of the anchor bar) to set the right size of the elastic zone around the embedded beam such that the specified anchor bearing capacity can be obtained. Now, Young’s modulus must be selected such that the product of $E$ and $A (= \pi D_g^2/4)$ is equal to $EA$ of the anchor bar, as used in the material data set for the node-to-node anchor. Note that this leads to a fictitious value of Young’s modulus which is different than a realistic Young’s modulus of steel. In 2D, the stiffness properties also involve the out-of-plane anchor spacing, $l_s$, which is the same value as entered for the node-to-node anchor.

The interaction properties involve only skin friction. Here, the distribution can be assumed uniform by setting $T_{\text{skin,start,max}} = T_{\text{skin,end,max}}$ equal to the total designed ground anchor bearing capacity (in the unit of force) divided by the length of the embedded beam row. Ground anchors do not have a base resistance, so $F_{\max} = 0$. The interface stiffness factors can be left to their default values.

12.1.3 Activation and pre-stressing of ground anchors

The activation of ground anchors in a calculation phase as part of the staged construction settings is done by activating both the node-to-node anchor part and the embedded beam row part. Usually, when ground anchors are installed, they are pre-stressed. The pre-stress force can be specified by selecting the node-to-node anchor part and checking the Adjust prestress option in the Selection explorer and specifying the right pre-stress force $F_{\text{prestress}}$. Note that in all models (2D and 3D) this is a force PER ANCHOR (not per unit of width out-of-plane).

In the calculation phase in which the ground anchor is pre-stressed, the resulting anchor force will be exactly equal to the pre-stress force. In subsequent calculation phases, however, the anchor force is supposed to further evolve as a result of the construction process. Therefore, the anchor should NOT be pre-stressed again in subsequent calculation phases, unless this is also done in reality (‘post tensioning’ of ground anchors).
12.2 Transverse forces in embedded beams

In addition to displacement differences and shear forces in the axial direction, a pile can undergo transverse forces, $t_{\perp}$, due to lateral displacements. The lateral displacements can be induced by a transverse force applied at the top of the pile or as a consequence of the transverse distributed load caused by the lateral displacement field of the soil surrounding the pile. In the first case, the overall behaviour may not show realistic results. In the second case, although embedded beam row elements are not meant to be used as laterally loaded piles, they show reasonable results and the overall behaviour is realistic. The second case, moreover, represents a lot of engineering cases and this section explains the most common applications in PLAXIS 2D.

12.2.1 Abutment pile

An abutment is a structure at the ends of an arch (e.g. dams) or span (e.g. bridges) meant to transfer vertical or horizontal loads to the ground or other foundation elements. The abutment is a crucial substructure in a lot of geotechnical applications: dams, bridges, slope stability, embankments and retaining walls. When the abutment structure is not sufficient to bear the external loads or guarantee compatible displacements, piles could be added to improve the performance.

The abutment piles are subjected to axial as well as transverse forces through the displacement field of the soil. $t_{\perp}$ forces can be induced by: arching effect (dams), landslides and ground flow (slope stability). The embedded beam row elements of PLAXIS 2D can realistically model the piles in these engineering applications.

The user should refer to Embedded Beams (on page 97) and General properties (on page 288). No further information is required for the modelling techniques embedded beam row elements in abutment pile applications.

12.2.2 Quay wall with relieving platform

A quay wall is an earth retaining structure used to moor ships. It bears vertical loads caused by storage and handling equipment and horizontal loads from the wind, soil pressure and ship impacts. Quay walls might differ in type and magnitude of the terminal. The key requirement for ships is the retaining height; when handling the freight, it is necessary to provide sufficient area and bearing capacity. For larger quay walls, using relieve platforms frees the quay walls from the high soil pressure brought by the high retaining height and the vertical loads induced by massive storage. The presence of the relieving platform, generally coupled with bearing piles, reduces the horizontal loads on the quay wall and, consequently, the bending moments. The structure could comprise an anchorage at the connection point of the quay wall and the relieving platform.

The bearing piles of the relieving platform take a part of the horizontal load that is typically taken by the retaining wall. For this reason, these piles are subjected to transverse forces induced by the lateral displacement field of the soil. The embedded beam row elements of PLAXIS 2D can realistically deal with this application. Furthermore, if the quay has a bulk-storage load, there are horizontal components difficult to model with other approaches (e.g. sub-grade reaction models). PLAXIS 2D can easily deal with this complex loading conditions.

The user should refer to Embedded beams and General properties (on page 288). No further information is required for the modelling techniques embedded beam row elements in quay wall with relieving platform applications.
12.3 Modelling vacuum consolidation [ADV]

Vacuum consolidation is a technique to apply preloading on a construction site by creating an 'under-pressure' in the ground and thus using the external atmospheric pressure as preloading. In this way, the stability of the sub-soil is increased and settlements during and after the construction are reduced. This technique is usually applied on near-saturated soils with a high water table. This section explains the details of modelling vacuum consolidation in PLAXIS 2D.

There are various methods of vacuum consolidation in the real world, but they are all modelled in a similar way in PLAXIS 2D. Most methods in reality are using vertical drains, which are somehow connected at the top to an air pump that reduces the air pressure in the drains until a near-vacuum exists. In practice, a complete vacuum (100 kN/m$^2$ pressure) is not achievable, but an effective under-pressure of 60 - 90 kN/m$^2$ is feasible.

Since PLAXIS 2D does not take air pressure into account (atmospheric pressure is assumed to be the zero reference pressure level), a reduction of the groundwater head is used instead to simulate vacuum consolidation. This means that the way vacuum consolidation is modelled leads to negative pore stresses (suction), which are not there in reality.

12.3.1 Vacuum consolidation in a one-dimensional soil column

In the simplified case of a one-dimensional soil column, vacuum consolidation can be modelled by performing a groundwater flow calculation or a fully coupled flow-deformation analysis with hydraulic conditions at the model boundaries such that in the vacuum area the groundwater head is prescribed at a level that is 10 m (or less) lower than the vertical coordinate of the global phreatic level. A reduction of the groundwater head of 10 m is equivalent to an under-pressure of 100 kN/m$^2$ (i.e. complete vacuum).

12.3.2 Vacuum consolidation in a 2D or 3D model

In a 2D or 3D numerical model of a realistic project, vacuum consolidation can be modelled by performing a groundwater flow calculation or a fully coupled flow-deformation analysis with vacuum drains (Drain (on page 142)) in which the head specified in those drains is 10 m (or less) lower than the vertical coordinate of the global phreatic level. A reduction of the groundwater head of 10 m is equivalent to an under-pressure of 100 kN/m$^2$ (i.e. complete vacuum). The distance between the vacuum drains in the model is arbitrary, but should be selected such that the difference in groundwater head in the vacuum area is limited. In general, a distance between the drains less than a quarter of the drain length seems appropriate.

12.3.3 Other requirements

A reduction of the groundwater head implies that the soil in the vacuum area becomes unsaturated, whilst this soil volume is supposed to be fully saturated. The user must arrange additionally that saturated conditions apply to this volume. This requires the following settings to be made in the corresponding material data sets:
• The unsaturated unit weight, \( \gamma_{\text{unsat}} \) (General tabsheet of the Material data set), must be set equal to the saturated unit weight, \( \gamma_{\text{sat}} \).

• The hydraulic model must be set to Saturated after selecting User-defined as hydraulic data set (Model group in Groundwater tabsheet).

If these settings are not made, the unit weight of the soil will change from saturated to unsaturated as soon as the phreatic level drops as a result of the reduction of the groundwater head in the vacuum drains. Moreover, the soil permeability will reduce according to the reduced relative permeability in the unsaturated zone, depending on the selected hydraulic data set (by default Fine material). Both effects are not realistic and can be overcome by making the aforementioned changes in the corresponding material data sets.

### 12.3.4 Calculation options

Vacuum consolidation (using reduced groundwater head boundary conditions or reduced heads in vacuum drains) can be applied in the following calculation types:

- Plastic (select Steady-state groundwater flow as Pore pressure calculation type)
- Consolidation (select Steady-state groundwater flow as Pore pressure calculation type)
- Fully-coupled flow-deformation analysis

This means that all input requirements for a groundwater flow calculation have to be met, i.e:

- All material data sets must have non-zero permeabilities
- Hydraulic boundary conditions (groundwater head and closed flow boundaries, if applicable) must have been specified

Moreover, it is required to de-select the Ignore suction option in the Deformation control parameters section of the Phases window.

Note that only vacuum drains allow a groundwater head to be specified below the actual drain level, which leads to tensile pore stresses (suction). Normal drains do not allow for suction. Also note that, if vacuum drains are used in a Consolidation calculation whilst the pore pressure calculation type is set to Phreatic, the drains will work as normal drains rather than vacuum drains. This means that they only affect the consolidation of excess pore pressures, whilst the steady-state pore pressure is fully determined by the global water level and local cluster settings.

### 12.3.5 Switching-off vacuum

If the vacuum is to be ‘switched-off’ in subsequent calculations while the drains are still supposed to be active for consolidation purposes, the corresponding head in the drains needs to be changed from the reduced head level to the original global water level. This leads to the situation that the new pressure head in the drain is higher than the groundwater head in the area around the drain. As a result, one might expect that water will be flowing from the drain into the ground, which is an artefact of the numerical modelling of vacuum consolidation.


References


A.1 ASCII files

PLAXIS supports CPT data in CPT format CUR (2004) (on page 587). In case the data is not provided in CPT format, PLAXIS enables importing them with the condition that they are saved in properly formatted ASCII files.

The file must contain a small header specifying the contained data. If it is not available, the field data cannot be recognised and the importing of the file will be aborted. The header must be the first content in the file in order to prevent that arbitrary data of the file is misinterpreted. The header must have the following format:

```
X[m] # optional comment
Y # optional comment
Z # optional comment
d[m] q f x x u # optional comment
```

X, Y, Z denote a number specifying the location and elevation of the starting point of the CPT. Missing coordinates are set automatically to zero. Note that PLAXIS does not use this information for modelling purposes.

Following the coordinate specification, specifiers for the column content must be specified. The following specifiers are supported:

<table>
<thead>
<tr>
<th>Specifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>penetration depth</td>
</tr>
<tr>
<td>q</td>
<td>tip resistance</td>
</tr>
<tr>
<td>f</td>
<td>sleeve friction</td>
</tr>
<tr>
<td>u</td>
<td>pore pressure</td>
</tr>
<tr>
<td>x</td>
<td>columns of data to be skipped</td>
</tr>
</tbody>
</table>

**Note:**

- Except for the 'x' character, column specifiers can occur only once. If a column specifier occurs more than once, the double specifier and all successive specifiers are skipped.
- Units can be introduced inside square brackets ([<unit>]) next to the column specifier. The user can use any combination of units as displayed in Unit conventions (on page 591).
- If units of specifiers are not inserted in the header, PLAXIS will assume that the input units are the same as project units.
- The delimiter used to separate the data columns should be consistent with the one used in the header.
Import CPT data: required file format [GSE]

- The first number containing a decimal separator determines which decimal separator is used throughout the import.
  1. 1. or .23 or 1.23 or 1.23E-5 renders using the decimal point for decimal separator.
  2. 1, or ,23 or 1,23 or 1,23E-5 renders using the comma as decimal separator.
  3. 1E-5 or 125 assumes the decimal point for decimal separator, the next number containing a decimal separator decides on the format settings.
  4. Thousand separators are not recognised.
- Comments can be added after ‘#’

A.2 Unit conventions

If the user define the units of specifiers using brackets (as mentioned in ASCII files (on page 590)), the following units can be adopted:

1. For Pressure: [Pa], [kPa], [MPa], [psi], or
2. Any combination of force/length$^2$, where force can be [N, kN, MN, lbf, kip] and length can be [mm, cc, m, km, in, ft, yd].

**Note:** For combined units, the text file must have the following units format: [force/length$^2$]. For instance, [kN/m$^2$].

After the file is loaded PLAXIS will automatically convert the input units into the project units.

A.3 CPT format sample

Based on the specifications showed in the previous sections, a sample of the file format is presented below:

```
200  [m]  
500  
100  
# some comments

d[m]  q[MPa]  f[MPa]  u[MPa]  #Header
0.01  0.24   0   0.001  
0.02  0.53   0   0.001  
0.03  0.53   0   0.001  
0.04  0.63   0   0.001  
0.05  0.68   0   0.001  
0.06  0.64   0.009  0.001  
0.07  0.74   0.013  0.001  
...
```

When using the Cyclic accumulation and optimisation tool, custom contours may be uploaded for the contour diagram data. This is the case for both the *Cyclic accumulation* and *Stress-strain curves* (two tabsheets in the tool).

The files that are loaded need to have the format as described below. A number of conditions apply.

### B.1 Cyclic accumulation

In the first tabsheet of the *Cyclic accumulation* tool it is required to load contour diagrams, either from the example files provided by NGI or from user-defined files.

The cyclic contours are charts with $N_{\text{cycles}}$ on the x-axis and $\tau_{cy} / s_u^c$ on the y-axis. The chart consists of a certain number of curves. Each contour line represents the locus of points characterized by the same shear deformation $\gamma$.

1. The first row is always disregarded. It is usually a title.
2. The minimum number of contours is 2. One is always defined at $\gamma = 0 \%$ for $\tau_{cy} / s_u^c = 0$ and the other one is defined for another shear strain level $\gamma$ (which corresponds to the shear strain at failure).
3. The maximum number of contours is 150.
4. The minimum number of points for each contour is 2.
5. The maximum value of $N_{\text{cycles}}$ is 10,000.
6. Each contour is determined by a series of data points that are interpolated using linear interpolation.
7. The contours should be digitized along constant $N_{\text{cycles}}$ values.
8. The contours data should be presented with increasing $N_{\text{cycles}}$ values, decreasing $\tau_{cy} / s_u^c$ ratios and for increasing cyclic shear strain levels.
9. The contours are limited by four curves:
   a. The lower limit is given by the horizontal contour at the base for $\tau_{cy} / s_u^c = 0$ and $\gamma = 0 \%$
   b. The upper limit is given by the contour for $\gamma$ equal to the shear deformation at failure.
   c. All the contours start with a point for $N_{\text{cycles}} = 1$ and an ending point for $N_{\text{cycles}}$ equal to the number of cycles above which all the contours become horizontal (i.e. $\tau$ is constant). This leads to two vertical boundaries for $N_{\text{cycles}} = 1$ and $N_{\text{cycles}} = N_{\text{max}}$

An example of a custom contour file is shown below.
B.2 Stress - Strain Curves

In the second tab of the Cyclic accumulation and optimisation tool, it is required to load a contour diagram. If custom contours are loaded, the conditions below need to be met.

Each diagram has the following characteristics:
1. The contours data should be presented with increasing cyclic contour number.

2. The values are given as stress ratio, i.e. the cyclic and average shear strength \( \tau_{cyc} \) and \( \tau_{av} \) are divided by \( s_u \) both for triaxial and DSS tests.

3. The contours are defined by at least 4 curves for DSS and 5 for TX:
   
   a. The first cyclic contours should always be given at \( \gamma_{cyc} = 0 \% \) and \( \tau_{cyc} / s_u = 0 \) for both triaxial and DSS diagrams.
   
   b. For a DSS diagram, the first average contours is given at \( \gamma_{av} = 0 \% \) and \( \tau_{cyc} / s_u = 0 \)
   
   c. For a DSS diagram, the maximum cyclic and the maximum average contours should be defined for the maximum shear deformation at failure.
   
   d. For a triaxial diagram, the maximum cyclic contour is defined for \( \gamma \) equal to the cyclic shear deformation at failure, while for the average contours the maximum is defined for the maximum shear deformation at failure for triaxial compression test, and the minimum (negative value) for the maximum shear deformation at failure for triaxial extension.
   
   e. For TX, the contour corresponding to \( \gamma_{av} = 0 \% \) should always be given (as the starting point of the path line is at the intersection between \( \gamma_{cyc} = 0 \% \) and \( \gamma_{av} = 0 \% \) )

4. If the behaviour is Anisotropic, define at least 4 contour diagrams:
   
   a. One TX and one DSS for \( N < N_{eq} \)
   
   b. One TX and one DSS for \( N > N_{eq} \)

5. If the behaviour is Isotropic, the TX contours can be neglected and at least 2 contour diagrams should be given:
   
   a. One DSS with \( N < N_{eq} \)
   
   b. One DSS with \( N > N_{eq} \)

The structure of the file for the given Drammen clay contours is the following and example charts for DSS and TX tests are shown:

**Table 21: File structure of 3D custom contours (Stress-strain curves tab). Example based on Drammen clay.**

<table>
<thead>
<tr>
<th>Line</th>
<th>Column 1</th>
<th>Column 2</th>
<th>Column 3</th>
<th>Column 4</th>
<th>Column 5</th>
<th>Column 6</th>
<th>Example</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Number of contour diagrams</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>8</td>
<td>8 diagrams are defined</td>
</tr>
<tr>
<td>2</td>
<td>N-cross section</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>1</td>
<td>The following diagram is defined at the cross section of ( N_{cycle} = 1 )</td>
</tr>
</tbody>
</table>
### Cyclic accumulation Tool - Contour File Formats [ADV]

<table>
<thead>
<tr>
<th>Line</th>
<th>Column 1</th>
<th>Column 2</th>
<th>Column 3</th>
<th>Column 4</th>
<th>Column 5</th>
<th>Column 6</th>
<th>Example</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Contour number</td>
<td>Number of average shear strain contours</td>
<td>Number of cyclic shear strain contours</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>1 1 1</td>
<td>If an odd number is assigned to the contour number, it describes a triaxial diagram, otherwise it refers to a DSS diagram. 11 contour lines are defined for different gamma average values. 7 contour lines are defined for different cyclic shear strains.</td>
</tr>
<tr>
<td>4</td>
<td>Number of cyclic shear strain contours</td>
<td>Number of the average shear contour</td>
<td>Cyclic shear strain (%)</td>
<td>Average shear strain (%)</td>
<td>$\tau_a / s_u^c$</td>
<td>$\tau_{cyc} / s_u^c$</td>
<td>1 1 0 -15 -0.5362 0.0000</td>
<td>1 is the number of the cyclic contour and is constant for the next 11 lines. 1 is the number of the average contour and it progresses from 1 to 11. For this block -0.5362 represents the value of $\tau_a / s_u^c$ at the intersection with the cyclic contour at $\gamma_{cyc} = 0 %$.</td>
</tr>
<tr>
<td>5</td>
<td>\text{. . . . . . . . . .}</td>
<td>\text{. . . . . . . . .}</td>
<td>\text{. . . . . . . . .}</td>
<td>\text{. . . . . . . . .}</td>
<td>\text{1 2 0 -5 -0.43312 0.0000}</td>
<td>\text{. . . . . . . . .}</td>
<td>Lines from 6 to 13</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1 1 1 0 1 5 1.0000 0.0000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>This is the last line for the cyclic contour at $\gamma_{cyc} = 0 %$. For the triaxial diagram, the maximum $\tau_a / s_u^c$ is always 1 (since it represents the static strength, i.e. $\tau_a = s_u^c$).</td>
<td></td>
</tr>
</tbody>
</table>
### Cyclic accumulation Tool - Contour File Formats [ADV]

<table>
<thead>
<tr>
<th>Line</th>
<th>Column 1</th>
<th>Column 2</th>
<th>Column 3</th>
<th>Column 4</th>
<th>Column 5</th>
<th>Column 6</th>
<th>Example</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Number of the cyclic shear contour</td>
<td>Number of the average shear contour</td>
<td>Cyclic shear strain (%)</td>
<td>Average shear strain (%)</td>
<td>( \tau_a / s_u^c )</td>
<td>( \tau_{cyclic} / s_{u}^c )</td>
<td>2 1 0.1 -15 -0.49731 0.13065</td>
<td>This is the first line of the second cyclic contour at ( \gamma_{cyclic} = 0 % )</td>
</tr>
</tbody>
</table>

after 3 + 11x7 lines, a new block starts to define the DSS test

| 81   | N-cross section | - | - | - | - | - | 1 | The following diagram is defined at the cross section of \( N_{cycle} = 1 \) as before but the following lines contain an even contour number so it describes a DSS chart |
|------|----------------|---|---|---|---|---|---|-----------------------------|--------------------------------------------------------------------------------|
|      | Contour number | Number of average shear strain contours | Number of cyclic shear strain contours | \( \tau_a / s_u^c \) | \( \tau_{cyclic} / s_{u}^c \) | 2 7 7 | The first item indicates that it is a DSS chart (even number). The second and third item indicate the number of average and cyclic shear strain contours, respectively. |
|      | Number of the cyclic shear contour | Number of the average shear contour | Cyclic shear strain (%) | Average shear strain (%) | \( \tau_a / s_u^c \) | \( \tau_{cyclic} / s_{u}^c \) | 1 1 0 0 0.0000 0.0000 | |

The following diagram is defined at the cross section of \( N_{cycle} = 1 \) as before but the following lines contain an even contour number so it describes a DSS chart.
## Summary of the creation of General Water Levels

<table>
<thead>
<tr>
<th>No. of boreholes</th>
<th>Head in boreholes</th>
<th>No. of layers</th>
<th>Layer condition</th>
<th>No. of water levels</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Value specified</td>
<td>1</td>
<td>Head</td>
<td>1</td>
<td>horizontal water level at the level defined by Head</td>
</tr>
<tr>
<td>1</td>
<td>Value specified</td>
<td>1</td>
<td>Hydrostatic(^a)</td>
<td>2</td>
<td>horizontal water level; 1 at the level defined by Head; 1 at the level resulting from (p_{\text{top}})</td>
</tr>
<tr>
<td>1</td>
<td>Value specified</td>
<td>1</td>
<td>Interpolate</td>
<td>1</td>
<td>horizontal water level at the level defined by Head</td>
</tr>
<tr>
<td>1</td>
<td>Value specified</td>
<td>1</td>
<td>Dry</td>
<td>1</td>
<td>horizontal water level at the level defined by Head</td>
</tr>
<tr>
<td>1</td>
<td>Value specified</td>
<td>1</td>
<td>User-defined</td>
<td>2</td>
<td>horizontal water level; 1 at the level defined by Head; 1 at the level resulting from (p_{\text{top}}) and (p_{\text{bottom}})</td>
</tr>
<tr>
<td>&gt;1</td>
<td>Different values per borehole</td>
<td>1</td>
<td>Head</td>
<td>1</td>
<td>non-horizontal water level</td>
</tr>
<tr>
<td>&gt;1</td>
<td>Different values per borehole</td>
<td>1</td>
<td>Hydrostatic</td>
<td>2</td>
<td>1 non-horizontal water level due to specified heads; 1 horizontal layer due to the hydrostatic condition of the soil layer</td>
</tr>
<tr>
<td>&gt;1</td>
<td>Different values per borehole</td>
<td>1</td>
<td>Interpolate</td>
<td>1</td>
<td>non-horizontal water level</td>
</tr>
<tr>
<td>&gt;1</td>
<td>Different values per borehole</td>
<td>1</td>
<td>Dry</td>
<td>1</td>
<td>non-horizontal water level</td>
</tr>
<tr>
<td>&gt;1</td>
<td>Different values per borehole</td>
<td>1(^b)</td>
<td>User-defined</td>
<td>2</td>
<td>1 non-horizontal water level due to specified heads, the water level due to soil layer condition can be either horizontal or non-horizontal depending on the defined conditions.</td>
</tr>
</tbody>
</table>

\(^a\) For hydrostatic cases, the situations different from the Head are considered. If the phreatic level in hydrostatic condition is equal to Head, no extra water level will be generated.

\(^b\)
Summary of the creation of General Water Levels

b) The number of generated water levels for cases where more than one soil layer is available can be derived accordingly.
Conventional and unsaturated soil behaviour in PLAXIS

PLAXIS handles soil as a two-phase material. The classical way of doing this is by considering Terzaghi's definition of effective stress, simply being the total stress minor the pore pressure. The phreatic level separates the saturated soil below from the unsaturated (or 'dry') soil above it. In the classical approach, neither suction nor the degree of saturation are considered in the unsaturated zone. This classical approach can be used in PLAXIS by selecting the calculation option 'Ignore suction', which is by default selected in all calculation types (except in a fully coupled flow-deformation analysis).

Alternatively, PLAXIS may be used to deal with most features of unsaturated soil mechanics. In that case, the option 'Ignore suction' must be disabled. PLAXIS will then consider Bishop's definition of effective stress and it will include suction (negative pore stress) and the degree of saturation in the calculation. In this case, the selection of appropriate hydraulic models for the relationship between suction and saturation as well as the relationship between suction and relative permeability becomes essential.

Before defining the possibilities and limitations of both options, a definition is given of the various stresses and related quantities involved. Note that compression is negative and tension (or suction) is positive.

D.1 Definition of stresses and related quantities

Total stresses are divided into effective stresses and pore pressures. Pore pressures are composed of steady-state pore pressures and excess pore pressures. Since decades, PLAXIS 2D uses the term 'active pore pressure' to denote the contribution of the pore stresses in the total stresses. In the context of unsaturated soil behaviour, active pore pressure is defined as:

**Active pore pressure:**  
\[ p_{\text{active}} = S_{\text{eff}}(p_{\text{steady}} + p_{\text{excess}}) = S_{\text{eff}}p_{\text{water}} \]

**Pore water pressure:**  
\[ p_{\text{water}} = p_{\text{steady}} + p_{\text{excess}} \]

Note that for fully saturated soil the 'active pore pressure' is equal to the 'pore water pressure', but there is a clear difference in unsaturated zone.

**Steady-state pore pressure:**  
\( p_{\text{steady}} \)

- Input for a deformation analysis
- Direct generation based on phreatic levels and cluster-related pore pressure distribution
- Or, calculated from steady-state groundwater flow calculation

**Excess pore pressure:**  
\( p_{\text{excess}} \)

- Result from undrained behaviour (Undrained (A) or (B)) and \( K_w / n \) from Table 22 (on page 607) and Table 23 (on page 608)
Conventional and unsaturated soil behaviour in PLAXIS

- Affected by loading, a (sudden) change in hydraulic conditions and consolidation.
- In the case of a fully coupled flow-deformation analysis, \( p_{\text{steady}} \) is calculated from a preliminary steady-state groundwater flow calculation using the hydraulic boundary conditions at the end of the calculation phase. This enables the calculation and output of \( p_{\text{excess}} \) for a fully coupled analysis in all steps. \( p_{\text{excess}} = p_{\text{water}} - p_{\text{steady}} \)

**Effective degree of saturation**: \( S_{\text{eff}} = (S - S_{\text{res}}) / (S_{\text{sat}} - S_{\text{res}}) \)

**Degree of saturation**: \( S \)

**Residual degree of saturation**: \( S_{\text{res}} \)

**Saturated degree of saturation**: \( S_{\text{sat}} \) (usually 1.0)

- There is a relationship between the (effective) degree of saturation (\( S \) or \( S_{\text{eff}} \)) and the suction in the unsaturated zone, which depends on the selected soil-water retention curve in the material data set.

The term 'suction' is used to denote any positive value the difference between pore air and water pressures: \( p_a - p_{\text{water}} \).

In PLAXIS, a widely accepted hypothesis of constant atmospheric air pressure is assumed. The air pressure is therefore taken zero since the atmospheric pressure can be taken as a reference value.

Suction is the tension component in \( p_{\text{water}} \): \( \text{Suction} = \max(p_{\text{water}}, 0) \)

**Atmospheric pressure**: \( p_a \) (100 kPa, but in PLAXIS 2D taken as the zero reference level)

**Effective suction**: \( S_{\text{eff}} \cdot \text{Suction} \)

- When multiplied by the tangent of the friction angle, this quantity gives a kind of 'artificial cohesion' in the soil.

**Effective stress**: \( \sigma' \) (stress in the soil skeleton)

**Total stress**: \( \sigma = \sigma' + p_{\text{active}} \)

**Terzaghi's effective stress**: \( \sigma' = \sigma - p_{\text{active}} \)

- Terzaghi's definition of effective stress applies to saturated soils

**Bishop's stress**: \( \sigma' = \sigma - p_a + \chi (p_a - p_{\text{water}}) \)

**Effective stress coefficient**: \( \chi \)

In PLAXIS 2D, \( \chi \) is supposed to be equal to \( S_{\text{eff}} \) so Bishop's stress in PLAXIS 2D:

\[
\sigma' = \sigma - S_{\text{eff}} \cdot (p_{\text{steady}} + p_{\text{excess}}) = \sigma - p_{\text{active}}
\]

- When the soil reaches full saturation (\( S_{\text{eff}} = 1 \)), Bishop's stress coincides with Terzaghi's effective stress.
- Using Bishop's effective stress as a basis for all calculations, distinction can still be made between conventional calculations (fully saturated or dry materials) and calculations in which unsaturated soil behaviour is taken into account.
- The aforementioned distinction can be made by ignoring suction or allowing suction.

In the following, the consequences of ignoring or allowing suction are described.

### D.2 Ignore suction

When the calculation option *Ignore suction* is selected, soil below the phreatic level is considered to be fully saturated (\( S = 1 \)), whereas soil above the phreatic level is considered to be ideally unsaturated (\( S = 0 \)).
phreatic level itself is defined directly by the user or calculated as a result of a groundwater flow calculation or a fully coupled flow-deformation analysis. Positive steady-state pore stresses will be set to zero. However, any excess pore pressure above and below the phreatic level, both positive and negative, will be taken into account. This requires $S_{\text{eff}}$ to be set to 1, regardless of $S$, $S_{\text{res}}$, and $S_{\text{sat}}$.

When selecting the calculation option Ignore suction, the following conditions apply:

- Any positive value of $p_{\text{steady}}$ is cut at 0.
- On or below the phreatic level ($p_{\text{steady}} \leq 0$): $S = 1$
- In drained and undrained (A, B) materials: $S_{\text{eff}} = 1$ (over-rules previous value)

With this, the stresses and related quantities as defined previously fully apply. In principle, almost all calculation types (Plastic, Consolidation, Dynamic, Safety, except Fully coupled flow-deformation), are available, but some specific features or combinations are not available. Limitations are described below:

Note that it is still possible to have suction (pore water tension) as a result of unloading in Undrained (A,B) materials. Hence, the option Ignore suction will NOT ignore suction as a result of excess pore tension.

As mentioned in Undrained behaviour for unsaturated soil (on page 270), IgnoreSuction, in some cases, may underestimate shear strength and overestimate volume change behaviour. In general, it is difficult to conclude whether this leads to a more or less conservative design. Obviously, the use of Ignoresuction may require less material parameters (especially Soil water-retention curve parameters), but on the other hand, the analysis is less realistic than when suction is considered. The user is advised to keep this in mind with utmost care.

D.3 Allow suction (i.e. Ignore suction not selected)

When the calculation option Ignore suction is NOT selected, suction is allowed and included in the active pore pressure and pore water pressure. The saturation of the soil depends on the soil-water retention curve as defined in the corresponding material data sets.

With this, the stresses and related quantities as defined previously fully apply. In principle, all calculation types (Plastic, Consolidation, Fully coupled flow-deformation, Dynamics, Safety) are available, but some specific features or combinations are not available. Limitations are described below. (see Possibilities and limitations (on page 602)).

D.4 Cavitation cut-off

Positive pore stresses may also occur as a result of unloading in undrained materials. However, there is a limit to the amount of positive pore stresses (pore water tension) that can occur, which is the cavitation stress. This limit can be taken into account in PLAXIS 2D by selecting the Cavitation cut-off option and setting the cavitation stress. As a result, the pore water pressure, $p_{\text{water}}$, cannot be higher than the cavitation stress, $p_{\text{cavitation}}$. As soon as the cavitation stress is reached, the excess pore pressure is manipulated:

At cavitation: $p_{\text{excess}} = p_{\text{cavitation}} - p_{\text{steady}}$

D.5 Unit weight of soil

Although a proper definition of the unit weight of soil would involve the degree of saturation, PLAXIS 2D applies a unit weight based on the current position of the phreatic level in all types of calculations.

- On or below the phreatic level ($p_{\text{steady}} \leq 0$): $\gamma = \gamma_{\text{sat}}$
• Above the phreatic level \( (p_{steady} > 0): \gamma = \gamma_{unsat} \)

For a fully coupled flow-deformation analysis the evaluation of the unit weight is based on \( p_{water} \) instead of \( p_{steady} \). This means that during a fully coupled flow-deformation analysis the position of the phreatic level and hence the material weight can change.

D.6 Possibilities and limitations

There are limitations in the use of specific features in the various calculations types in PLAXIS 2D depending on whether suction is ignored or allowed. An overview of the limitations is given below.

D.7 Steady-state groundwater flow [ADV]

• To generate steady-state pore pressures as input for Gravity loading, Plastic calculation, Consolidation analysis or without deformation analysis.

<table>
<thead>
<tr>
<th>Drainage type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suction</td>
<td>Possible when suction is allowed or in the case of large excess pore tension. Included in active pore pressures, pore water pressures, saturation and relative permeability.</td>
</tr>
<tr>
<td>Cavitation cut-off</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

The following warning will appear when starting the calculation:

| Zero permeabilities in some soil clusters | Material set with zero permeability found, but not allowed in this type of calculation. |

D.8 Transient groundwater flow [ULT]

• To calculate time-dependent pore pressures without deformation analysis.

<table>
<thead>
<tr>
<th>Drainage type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suction</td>
<td>Possible when suction is allowed or in the case of large excess pore tension. Included in active pore pressures, pore water pressures, saturation and relative permeability.</td>
</tr>
<tr>
<td>Cavitation cut-off</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

The following warning will appear when starting the calculation:

| Zero permeability in some soil clusters | Material set with zero permeability found, but not allowed in this type of calculation. |
Conventional and unsaturated soil behaviour in PLAXIS

| Zero time interval | Zero time interval |

**Note:** Transient groundwater flow is ONLY possible in case of Flow only calculation.

**D.9 KO-procedure**
- Only possible as first (initial) calculation phase
- Does not consider external loads; only material weight
- Recommended for situations involving a horizontal ground surface and horizontal soil layering without excavations or structures.

<table>
<thead>
<tr>
<th>Drainage type</th>
<th>No pore pressures generated in soil clusters of the types Undrained (C) and Non-porous; no generation of excess pore pressures.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady-state groundwater flow [ADV]</td>
<td>Possible, but not recommended since non-hydrostatic pore pressures may lead to non-equilibrium.</td>
</tr>
<tr>
<td>Suction</td>
<td>Included in steady-state pore pressures when suction is allowed</td>
</tr>
<tr>
<td>Cavitation cut-off</td>
<td>Not possible, but also not relevant; undrained behaviour is ignored</td>
</tr>
<tr>
<td>Updated mesh</td>
<td>Not possible (deformations are not considered)</td>
</tr>
<tr>
<td>Updated water pressures</td>
<td>Not possible (deformations are not considered)</td>
</tr>
</tbody>
</table>

**D.10 Gravity loading**
- Only possible as first (initial) calculation phase.
- Does not consider OCR or POP. Initial overconsolidation needs to be 'simulated' using external loads (apply and remove in next phase) or increased $\Sigma M_{weight}$ (reset to 1 in next phase).

<table>
<thead>
<tr>
<th>Drainage type</th>
<th>No pore pressures generated in soil clusters of the types Undrained (C) and Non-porous; no generation of excess pore pressures.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady-state groundwater flow [ADV]</td>
<td>Possible</td>
</tr>
<tr>
<td>Suction</td>
<td>Included in steady-state pore pressures when suction is allowed</td>
</tr>
<tr>
<td>Cavitation cut-off</td>
<td>Not possible, but also not relevant; undrained behaviour is ignored</td>
</tr>
<tr>
<td>Updated mesh</td>
<td>Not possible</td>
</tr>
<tr>
<td>Updated water pressures</td>
<td>Not possible</td>
</tr>
</tbody>
</table>
Conventional and unsaturated soil behaviour in PLAXIS

D.11 Plastic calculation

Not possible as first (initial) calculation phase.

<table>
<thead>
<tr>
<th>Drainage type</th>
<th>No pore pressures generated in soil clusters of the types Undrained (C) and Non-porous. Excess pore pressures generated in soil clusters of the types Undrained (A) and (B), except when using Ignore undrained behaviour (A,B)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady-state groundwater flow [ADV]</td>
<td>Possible (semi-coupled analysis). Note that in Undrained (A,B) soil clusters a change in steady-state pore pressures gives an opposite change in excess pore pressures.</td>
</tr>
<tr>
<td>Suction</td>
<td>Possible when suction is allowed or in case of large excess pore tension. Included in active pore pressures and pore water pressures.</td>
</tr>
<tr>
<td>Cavitation cut-off</td>
<td>Possible</td>
</tr>
<tr>
<td>Updated mesh</td>
<td>Possible when starting from initial phase or when parent phase is also Updated mesh</td>
</tr>
<tr>
<td>Updated water pressures</td>
<td>Possible when Updated mesh selected (only in 2D)</td>
</tr>
</tbody>
</table>

The following warning will appear when starting the calculation:

| Pore pressures are changed and undrained materials are present while Ignore undrained behaviour (A,B) is NOT selected | Note that a change in steady-state pore pressures will introduce extra excess pore pressures in Undrained (A,B) materials |

D.12 Safety analysis

Not possible as first (initial) calculation phase.

<table>
<thead>
<tr>
<th>Drainage type</th>
<th>No pore pressures generated in soil clusters of the types Undrained (C) and Non-porous. Excess pore pressures generated in soil clusters of the types Undrained (A) and (B), except when using Ignore undrained behaviour (A,B)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady-state groundwater flow [ADV]</td>
<td>Not possible (steady-state pore pressures taken from parent phase)</td>
</tr>
<tr>
<td>Suction</td>
<td>Possible when suction is allowed or in case of large excess pore tension. Included in active pore pressures and pore water pressures.</td>
</tr>
<tr>
<td>Cavitation cut-off</td>
<td>Possible</td>
</tr>
</tbody>
</table>
### Updated mesh

Possible when parent phase is also *Updated mesh*. Note that only deformations from the parent phase are considered and that the mesh is not further updated during the *Safety* analysis.

**Considerations:**

- The Safety calculation with selected Updated Mesh option will start from the deformed geometry resulting from the Plastic calculation (even if this was not an Updated Mesh calculation).
- An initial unbalance force is introduced (because of the difference between the previous non-updated mesh and the current updated mesh calculation). This may affect the resulting safety factor.
- During the Safety calculation, the geometry is not further updated.
- For the Safety phase, the output correctly shows the deformed mesh at the start of the Safety phase, since this is the geometry as considered for the safety factor calculation.

### Updated water pressures

Possible when *Updated mesh* selected. Note that only updated water pressures from the parent phase are considered and that water pressures are not further updated during the *Safety* analysis.

The following warning will appear when starting the calculation:

| Using *Updated mesh* | Note that the mesh is NOT further updated during a *Safety* analysis |

### D.13 Consolidation analysis [ADV]

- Not possible as first (initial) calculation phase.
- Considers only consolidation of excess pore pressures.
- Requires non-zero permeabilities.
- Requires non-zero time interval.
- Suction is included in active and pore water pressures but not in permeability, namely relative permeability is always equal to unity.

<table>
<thead>
<tr>
<th>Drainage type</th>
<th>No consolidation in clusters of the type <em>Non-porous</em>; other drainage types have no effect on consolidation; drainage properties are defined by permeabilities, stiffness and time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady-state groundwater flow</td>
<td>Possible (redefines steady-state pore pressures). Note that a change in steady-state pore pressures may initially lead to an opposite change in excess pore pressures, depending on the drainage properties.</td>
</tr>
<tr>
<td>Suction</td>
<td>Possible when suction is allowed or in case of large excess pore tension. Included in active pore pressures, pore water pressures, saturation but not in relative permeability. In other words, relative permeability is always taken as unity in Consolidation Analysis. This may induce a quicker dissipation of pore pressure. Numerical convergence is also expected to be faster.</td>
</tr>
<tr>
<td>Cavitation cut-off</td>
<td>Not possible</td>
</tr>
</tbody>
</table>
Conventional and unsaturated soil behaviour in PLAXIS

<table>
<thead>
<tr>
<th>Updated mesh</th>
<th>Possible when parent phase is also Updated mesh</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updated water pressures</td>
<td>Possible when Updated mesh selected</td>
</tr>
</tbody>
</table>

The following warnings will appear when starting the calculation:

<table>
<thead>
<tr>
<th>Steady-state pore pressures are changed</th>
<th>Note that a change in steady-state pore pressures will introduce extra excess pore pressures in Undrained (A,B) materials</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero time interval</td>
<td>Zero time interval</td>
</tr>
<tr>
<td>Some permeability zero</td>
<td>Zero permeability in some soil clusters</td>
</tr>
</tbody>
</table>

D.14  **Fully coupled flow-deformation analysis [ULT]**

- Not possible as first (initial) calculation phase.
- Considers full coupling between flow and deformation, i.e. 'consolidation' based on total pore water pressures
- Requires non-zero time interval
- Requires non-zero permeabilities
- Requires hydraulic boundary conditions (groundwater head, closed flow)

<table>
<thead>
<tr>
<th>Drainage type</th>
<th>No flow in clusters of the type Non-porous; other drainage types have no effect on flow; drainage properties are defined by permeabilities, stiffness and time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady-state groundwater flow</td>
<td>Not possible (groundwater flow is automatically included). Steady-state pore pressures at the end of the phase are automatically calculated based on the hydraulic boundary conditions.</td>
</tr>
<tr>
<td>Suction</td>
<td>Suction is always allowed. Included in active pore pressures, pore water pressures, water saturation as well as relative permeability. The dissipation of water pressure is expected to be slower than in Consolidation Analysis.</td>
</tr>
<tr>
<td>Cavitation cut-off</td>
<td>Not possible</td>
</tr>
<tr>
<td>Updated mesh</td>
<td>Not possible. Note that parent phase should NOT be Updated mesh</td>
</tr>
<tr>
<td>Updated water pressures</td>
<td>Not possible</td>
</tr>
</tbody>
</table>

The following warnings will appear when starting the calculation:

<table>
<thead>
<tr>
<th>Zero time interval</th>
<th>Zero time interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some permeability zero</td>
<td>Zero permeability in some soil clusters</td>
</tr>
</tbody>
</table>
D.15  **Dynamics analysis [ULT]**

- Not possible as first (initial) calculation phase.
- Requires non-zero time interval.

<table>
<thead>
<tr>
<th>Drainage type</th>
<th>No pore pressures generated in soil clusters of the types Undrained (C) and Non-porous. Excess pore pressures generated in soil clusters of the types Undrained (A) and (B), except when using Ignore undrained behaviour (A,B)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady-state groundwater flow</td>
<td>Not possible (steady-state pore pressures taken from parent phase)</td>
</tr>
<tr>
<td>Suction</td>
<td>Included in steady-state pore pressures when suction is allowed</td>
</tr>
<tr>
<td>Cavitation cut-off</td>
<td>Possible</td>
</tr>
<tr>
<td>Updated mesh</td>
<td>Possible</td>
</tr>
<tr>
<td>Updated water pressures</td>
<td>Not possible</td>
</tr>
</tbody>
</table>

D.16  **Dynamics analysis with Consolidation [ULT]**

**Table 22: Bulk modulus of water in Deformation analysis**

<table>
<thead>
<tr>
<th>Type of material</th>
<th>Plastic (ignore undrained)</th>
<th>Plastic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undrained (p_{water} \leq 0)</td>
<td>(K_w = 0)</td>
<td>(\frac{K_w^{sat}}{n} = \frac{2 \cdot G}{3} \left( \frac{1 + \nu_u}{1 - 2\nu_u} - \frac{1 + \nu'}{1 - 2\nu'} \right))</td>
</tr>
<tr>
<td>Undrained (p_{water} &gt; 0)</td>
<td>(K_w = 0)</td>
<td>(K_w^{unsat} = \frac{K_w}{1 + \frac{K_w}{S_w} - \frac{\partial}{\partial p_{water}} S_w} \star)</td>
</tr>
<tr>
<td>Drained (p_{water} \leq 0)</td>
<td>(K_w = 0)</td>
<td>(K_w = 0)</td>
</tr>
<tr>
<td>Drained (p_{water} &gt; 0)</td>
<td>(K_w = 0)</td>
<td>(K_w = 0)</td>
</tr>
<tr>
<td>Cluster just been activated</td>
<td>(K_w = 0)</td>
<td>(K_w = 0)</td>
</tr>
<tr>
<td>Non-porous or dry cluster</td>
<td>(K_w = 0)</td>
<td>(K_w = 0)</td>
</tr>
</tbody>
</table>

\(\star\) \(\frac{\partial}{\partial p_{water}} S_w\) is the derivative of saturation w.r.t pore water pressure (suction) i.e. the slope of water retention curve. As saturation decreases when suction increases, this slope is always negative and equal to zero at full saturation.
Table 23: Bulk modulus of water in Deformation analysis

<table>
<thead>
<tr>
<th>Type of Material</th>
<th>Consolidation and FC ($\theta &lt; S &lt; 1$)</th>
<th>Safety or dynamics (drained)</th>
<th>Safety or dynamics (undrained)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undrained ($p_{\text{water}} \leq 0$)</td>
<td>$\frac{K_{w}^{\text{sat}}}{n} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$</td>
<td>$K_{w} = 0$</td>
<td>$K_{w}^{\text{sat}} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$</td>
</tr>
</tbody>
</table>
| Undrained ($p_{\text{water}} > 0$) | $\frac{K_{w}^{\text{sat}}}{n} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$ | $K_{w} = 0$ | $K_{w}^{\text{unsat}} = \frac{K_{w}}{1 + \frac{\partial}{\partial p_{\text{water}}} S_{w}}$ *
| Drained ($p_{\text{water}} \leq 0$) | $\frac{K_{w}^{\text{sat}}}{n} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$ | $K_{w} = 0$ | $K_{w}^{\text{sat}} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$ |
| Drained ($p_{\text{water}} > 0$) | $\frac{K_{w}^{\text{sat}}}{n} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$ | $K_{w} = 0$ | $K_{w} = 0$ |
| Cluster just activated and option 'force drained behaviour newly activated clusters' selected | FE Formulation $K_{w} = K_{w}^{\text{sat}} \cdot 10^{-8}$ | Not relevant | Not relevant |
| Non-porous or dry cluster | Not relevant | $K_{w} = 0$ | $K_{w} = 0$ |

(**)Effect of $S$ taken into account directly in the FE Formulation ([Galavi (2010)](on page 587)).

**Table 23: Bulk modulus of water in Deformation analysis**

<table>
<thead>
<tr>
<th>Type of Material</th>
<th>Steady - state</th>
<th>Transient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undrained ($p_{\text{water}} \leq 0$)</td>
<td>$\frac{K_{w}^{\text{sat}}}{n} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$</td>
<td>$\frac{K_{w}^{\text{sat}}}{n} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$</td>
</tr>
<tr>
<td>Undrained ($p_{\text{water}} &gt; 0$)</td>
<td>$\frac{K_{w}^{\text{sat}}}{n} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$</td>
<td>$\frac{K_{w}^{\text{sat}}}{n} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$</td>
</tr>
<tr>
<td>Drained ($p_{\text{water}} \leq 0$)</td>
<td>$\frac{K_{w}^{\text{sat}}}{n} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$</td>
<td>$\frac{K_{w}^{\text{sat}}}{n} = \frac{2}{3} \left( \frac{1 + v_{u}}{1 - 2v_{u}} - \frac{1 + v'}{1 - 2v'} \right)$</td>
</tr>
<tr>
<td>Type of Material</td>
<td>Steady - state</td>
<td>Transient</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drained ((p_{\text{water}} &gt; 0))</td>
<td>[ \frac{K^{\text{sat}}_w}{n} = \frac{2 \cdot G}{3} \left( \frac{1 + \nu_u}{1 - 2\nu_u} - \frac{1 + \nu'}{1 - 2\nu'} \right) ]</td>
<td>[ \frac{K^{\text{sat}}_w}{n} = \frac{2 \cdot G}{3} \left( \frac{1 + \nu_u}{1 - 2\nu_u} - \frac{1 + \nu'}{1 - 2\nu'} \right) ]</td>
</tr>
<tr>
<td>Cluster just been activated</td>
<td>[ \frac{K^{\text{sat}}_w}{n} = \frac{2 \cdot G}{3} \left( \frac{1 + \nu_u}{1 - 2\nu_u} - \frac{1 + \nu'}{1 - 2\nu'} \right) ]</td>
<td>[ K_w = K^{\text{sat}}_w \cdot 10^{-8} ]</td>
</tr>
<tr>
<td>Non-porous or dry cluster</td>
<td>[ K_w = 0 ]</td>
<td>[ K_w = 0 ]</td>
</tr>
<tr>
<td>Key</td>
<td>Action</td>
<td></td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Ctrl - A</td>
<td>Select all</td>
<td></td>
</tr>
<tr>
<td>Ctrl - E</td>
<td>Explode</td>
<td></td>
</tr>
<tr>
<td>Ctrl - L</td>
<td>Modify soil layers (only in Soil mode)</td>
<td></td>
</tr>
<tr>
<td>Ctrl - M</td>
<td>Show materials</td>
<td></td>
</tr>
<tr>
<td>Ctrl - N</td>
<td>New Project</td>
<td></td>
</tr>
<tr>
<td>Ctrl - O</td>
<td>Open Project</td>
<td></td>
</tr>
<tr>
<td>Ctrl - R</td>
<td>Snap to grid</td>
<td></td>
</tr>
<tr>
<td>Ctrl - S</td>
<td>Save Project</td>
<td></td>
</tr>
<tr>
<td>Ctrl - Y</td>
<td>Redo</td>
<td></td>
</tr>
<tr>
<td>Ctrl - Z</td>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>Ctrl - F9</td>
<td>Run commands (GSE)</td>
<td></td>
</tr>
<tr>
<td>Shift - Alt - C</td>
<td>Change soil colour intensity</td>
<td></td>
</tr>
<tr>
<td>Shift - Ctrl - E</td>
<td>Implode</td>
<td></td>
</tr>
<tr>
<td>Shift - Ctrl - S</td>
<td>Save project as</td>
<td></td>
</tr>
<tr>
<td>Shift + Ctrl + F9</td>
<td>Opens Command runner, pastes Windows clipboard in commands runner and executes them directly</td>
<td></td>
</tr>
<tr>
<td>Shift + Ctrl + N</td>
<td>Starts a new project, opens Command runner, pastes Windows clipboard in command runner and executes them directly</td>
<td></td>
</tr>
<tr>
<td>Shift +Ctrl + &lt;number&gt;</td>
<td>Run an added Macros</td>
<td></td>
</tr>
<tr>
<td>Tab</td>
<td>Snap to object while drawing</td>
<td></td>
</tr>
</tbody>
</table>
## Shortcuts Input program

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Delete selection</td>
</tr>
<tr>
<td>F1</td>
<td>Manuals</td>
</tr>
<tr>
<td>F10</td>
<td>Visualisation settings</td>
</tr>
<tr>
<td>F12</td>
<td>Toggle the display in the <strong>Phases</strong> window</td>
</tr>
</tbody>
</table>
## Shortcuts Output Program

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + A</td>
<td>Select all structures of selected type</td>
<td>Model, Structure, Cross section</td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Display prescribed displacements</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + E</td>
<td>Explode</td>
<td>Model</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Display fixities</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + H</td>
<td>Display phreatic level</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Stress points</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + L</td>
<td>Display loads</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + M</td>
<td>Materials</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>Nodes</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open project</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Print</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Reset view</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save view</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + T</td>
<td>Table</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>Shrink</td>
<td>Model</td>
</tr>
<tr>
<td>Ctrl + F4</td>
<td>Close window</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + 0</td>
<td>Connectivity plot</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + 1</td>
<td>Deformed mesh</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + 2</td>
<td>Total displacements</td>
<td>All</td>
</tr>
</tbody>
</table>
## Shortcuts Output Program

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + 3</td>
<td>Incremental displacements</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + 4</td>
<td>Total strains</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + 5</td>
<td>Incremental strains</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + 6</td>
<td>Plastic points</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + 7</td>
<td>Pore pressures</td>
<td>All</td>
</tr>
<tr>
<td>Ctrl + (+)</td>
<td>Move Cross section forward 1/100</td>
<td>Cross section</td>
</tr>
<tr>
<td>Ctrl + (-)</td>
<td>Move Cross section backward 1/100 of the model size</td>
<td>Cross section</td>
</tr>
<tr>
<td>Ctrl + Alt + C</td>
<td>Change soil colour intensity</td>
<td>Model, Cross section</td>
</tr>
<tr>
<td>Ctrl + Shift + A</td>
<td>Show all soil elements</td>
<td>Model</td>
</tr>
<tr>
<td>Ctrl + Shift + M</td>
<td>Create animation</td>
<td>Model, Cross section, Structure</td>
</tr>
<tr>
<td>Ctrl + Shift + N</td>
<td>Hide all soil elements</td>
<td>Model</td>
</tr>
<tr>
<td>Ctrl + Shift + Enter</td>
<td>Goes to structure view with selected materials</td>
<td>Model, Cross section, Structure</td>
</tr>
<tr>
<td>Ctrl + Shift + (+)</td>
<td>Move Cross section 1/1000 of the model size</td>
<td>Cross section</td>
</tr>
<tr>
<td>Ctrl + Shift + (-)</td>
<td>Move Cross section 1/1000 of the model size</td>
<td>Cross section</td>
</tr>
<tr>
<td>Escape</td>
<td>Clear selected structures</td>
<td>Model, Cross section, Structure</td>
</tr>
<tr>
<td>Shift + Ctrl + E</td>
<td>Implode</td>
<td>Model</td>
</tr>
<tr>
<td>Shift + Ctrl + W</td>
<td>Expand</td>
<td>Model</td>
</tr>
<tr>
<td>F1</td>
<td>Manuals</td>
<td>All</td>
</tr>
<tr>
<td>F2</td>
<td>Curves manager</td>
<td>All</td>
</tr>
<tr>
<td>F3</td>
<td>Settings</td>
<td>Curves manager, Cross-section curves</td>
</tr>
<tr>
<td>F10</td>
<td>Settings</td>
<td>All</td>
</tr>
</tbody>
</table>
## Shortcuts Output Program

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + A</td>
<td>Select all</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Find value</td>
</tr>
<tr>
<td>Ctrl + M</td>
<td>Jump to maximum value in column</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>Jump to minimum value in column</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wheel move</td>
<td>Zoom in/out</td>
<td>All</td>
</tr>
<tr>
<td>Press Select structures + Click on structure</td>
<td>Select small group the structure belongs to</td>
<td>Model, Cross section, Structure - Resets current selection</td>
</tr>
<tr>
<td>Press Select structures + Shift + Click on structure</td>
<td>Toggles selection of small group the structure belongs to</td>
<td>Model, Cross section, Structure - Selection of other structure type will be cleared.</td>
</tr>
<tr>
<td>Press Select structures + Ctrl + Click on structure</td>
<td>Toggles selection of structure</td>
<td>Model, Cross section, Structure - Selection of other structure type will be cleared.</td>
</tr>
<tr>
<td>Press Select structures + Alt + Click on structure</td>
<td>Toggles selection of large group the structure belongs to</td>
<td>Model, Cross section, Structure - Selection of other structure type will be cleared.</td>
</tr>
<tr>
<td>Press Hide soil + Ctrl + Click on soil</td>
<td>Hides soil element</td>
<td>Model, Forces - Won't work if structure is selected</td>
</tr>
<tr>
<td>Press Hide soil + Ctrl + Shift + Click on soil</td>
<td>Hides soil cluster</td>
<td>Model, Forces - Won't work if structure is selected</td>
</tr>
</tbody>
</table>
The Python wrapper for the PLAXIS HTTP REST API hides the technicalities of dealing with the HTTP communications behind a comfortable object-oriented wrapper.

**G.1 Python HTTP REST API wrapper**

**G.1.1 Prerequisites**

1. An editor for writing Python scripts in. This documentation assumes that the SciTE editor will be used that comes with the PLAXIS installation.
2. At least a very rudimentary knowledge of the Python language is recommended, as this document makes no attempt to teach it. Good resources for this purpose are:
   a. Dive Into Python 3 ([See](http://diveintopython3.problemsolving.io/))
3. Your firewall must not block the PLAXIS application from accessing the internet, nor must it block other applications (in particular the python.exe executable) from talking to the remote scripting server embedded inside the PLAXIS application.

**Note:** Note that when using Python and other modules, users must do so under the licensing conditions of those modules. The user can check the Python version delivered by PLAXIS by launching the interactive interpreter from the Expert menu.

**G.2 Starting the remote scripting server**

1. Start your PLAXIS application.
2. Start a new project.
3. Go to the **Expert** menu and select the Configure remote scripting server option. The corresponding window pops up. Depending on your machine, the window may look slightly different.

![Configure remote scripting server](image)

4. Ensure you find an available port and then start the server.

5. A default password will have been generated to ensure a secure connection between the server and the remote scripting interface. You can change this password if you want to, just be aware that leaving the text box empty disables the encryption.

6. Information about ports currently in use can be retrieved in a Windows Command Prompt, with the following commands (the second one may require administrator privileges):

   ```
   netstat -a
   netstat -ab
   ```

   When using the remote scripting in an automated process, you can start the server without manual interaction by launching your PLAXIS application with the `AppServerPort` command line parameter. For example in order to start the server in PLAXIS 2D on port 21403:

   ```
   C:\Program Files\Seequent\PLAXIS 2D 2023.2\PLAXIS2DInput.exe --AppServerPassword=mypassword --AppServerPort=21403
   ```

   Changing the password can be done by using the `AppServerPassword` command line parameter. Passing the password this way is optional and it will default to the generated one.

   When the server is running, the main window of your PLAXIS application will reflect this information:

   ![PLAXIS 2D --- SERVER ACTIVE on port 21403](image)

---

G.3 Connecting to a scripting server

G.3.1 Local server (using SciTE)

- Start SciTE from the Windows Start menu. It will be called 'Python editor for PLAXIS 2D'. This will present you with an empty document. Let us write a script that will start a new project.
First we must import the scripting library:

    from plxscripting.easy import*

Connect to the PLAXIS application (21403 is the port number, substitute yours as applicable):

    s_i, g_i = new_server('localhost', 21403, password='yourpassword')

The variable s_i is bound to an object representing the PLAXIS application. It is now possible to control that
from the interactive Python prompt.

Start a new project as follows:

    >>> s_i.new()

Save this script somewhere on your hard drive. Make sure it ends with .py so SciTE correctly identifies it as a
Python script. Now we are able to run this script by going to Tools and then clicking on Go or by pressing F5

A new project should now be visible in the PLAXIS application. If instead an error is returned, check the
following for the PLAXIS application you are trying to control:

- Is the application running?
- Does its title bar indicate that the server is active?
- Is the server active on the port you have specified when calling new_server? You can also try a different
  port.
- Is your firewall blocking communications to the application?
- Is the password given to new_server the same as the one in the 'configure remote scripting server'
  dialog?

G.3.2 Remote PLAXIS application

Connecting to a PLAXIS application running on a computer other than your own requires you to know the name
or IP address of that machine. The IP address can be found by typing in a Windows command prompt the
following:

    ipconfig | find "IPv4"

The result will give a set of four numbers separated by dots. Example:

    IPv4 Address. . . . . . . . . . . : 10.4.2.178

In order to connect to this machine from within the same network, you can simply replace 'localhost' in the
boilerplate

    connection code with the IP address you found, such as '10.4.2.178'. For example:

    >>> s_i, g_i = new_server('10.4.2.178', 21403, password='yourpassword')

If you want to connect to the same machine over the internet, you will need to set up appropriate port
forwarding rules in your router. Note that opening up your computer to access from the network or even the
internet carries significant security risks - do so only if you have considered these risks.

G.4 Creating standalone scripts
In the examples above, we have looked at possibilities for using the API interactively from a Python prompt. While this is very useful for testing and finding out how things work, soon you will need the ability to save code and run it again without having to retype it.

In the SciTE editor make a new text file by going to File > New or by pressing Ctrl+N. After that, you can type the code, save and run it using Tools > Go. A Python script equivalent to the interactive session presented above looks as follows:

```python
from plxscripting.easy import *

s_i, g_i = new_server('localhost', 21403, password='yourpassword')
s_i.new()

x = g_i.SoilContour.initializerectangular(0, 0, 10, 10)
g_i.borehole(0)
g_i.soillayer(10)
material = g_i.soilmat()
material.setproperties("SoilModel", 1, "gammaUnsat", 16, "gammaSat", 20, "Gref", 10000)
g_i.Soils[0].Material = material

g_i.gotostructures()
g_i.lineload((3, 0), (7, 0))

g_i.gotomesh()
g_i.mesh(0.2)

output_port = g_i.selectmeshpoints()
s_o, g_o = new_server('localhost', output_port, password='yourpassword')
g_o.addcurvepoint('node', g_o.Soil_1_1, (5, 0))
g_o.update()

g_i.gotostages()
phase1 = g_i.phase(g_i.Phases[0])
g_i.LineLoads[0].Active[phase1] = True
g_i.calculate()

output_port = g_i.view(phase1)
s_o, g_o = new_server('localhost', output_port, password='yourpassword')
#In newer versions of the scripting layer it is possible to just write:
g_o.CurvePoints.Nodes[0]
utot = g_o.getcurveresults(g_o.CurvePoints.Nodes.value[0], g_o.Phases[1], g_o.ResultTypes.Soil.Utot)
print(utot)

g_i.save(r'c:\data\scripting_sample')
```

### G.5 Calling new_server without arguments

It is possible to call new_server without any arguments, but in that case a script can only be executed from the Expert menu in PLAXIS. Either choose Expert > Python > Run Script > Open to run your script or put it in one of the pytools folders and choose Expert > Python > Run Script > Tools.
G.6 Disabling the user interface

For some projects the overhead of updating the user interface may slow down the execution of the script quite significantly. If you want maximum execution speed, launch your PLAXIS application with the command parameter `--NO_CONTROLLERS`. For example:

```
Plaxis2DXInput.exe --AppServerPort=21403 --NO_CONTROLLERS
```

The downside of this approach is that you will be unable to monitor progress or diagnose problems visually. Instead, you will have to:

1. Stop the running script
2. Save the current project
3. Restart the application and open the saved project

G.7 Identifying the type and version of PLAXIS

If there is a need to write codes that are usable under both programs PLAXIS 2D and PLAXIS 3D, it is possible to check the type and version of PLAXIS software. With `s` being a server-type object as returned by the `new_server(...)` method, the following code must be valid:

```
>>> print(s.name, s.major_version, s.minor_version, s.is_2d, s.is_3d)
PLAXIS 2D 2018 0 True False
>>> if s.major_version + s.minor_version / 10 > 2020: # i.e. both are numbers
    ...   print('We come from the future')
We come from the future
>>> from .const import PLAXIS_2D, PLAXIS_3D
>>> if s.name == PLAXIS_2D:
    ...     print('This is PLAXIS 2D')
    ... elif s.is_3d: # indicates whether the application is 2D or 3D *capable* # (not whether it's the 2D or 3D *product*; 2D MPM will have
    ...     if 2d=True!)
    ...     print('This is 3D or 3D MPM')
    ... else:
    ...     print('Unknown application!')
This is PLAXIS 2D
```

The following also work:

```
from easy import * # must implicitly import the app type constants
s_i, g_i = new_server('localhost', 10000)
if s_i.name == PLAXIS_3D:
    print('Is PLAXIS 3D')
```

Drawing a rectangular/prismatic soil cluster in either 2D or 3D

```
from plxscripting.easy import new_server
from math import isnan, nan
```
s_i, g_i = new_server() # works when launched from Expert menu

def get_number(msg):
    nr = nan
    while isnan(nr):
        try:
            nr = float(input(msg + ': '))
        except:
            pass
    return nr

width = get_number('Width')
height = get_number('Height')

if s_i.is_3d:
    # get the depth of the cluster
    depth = get_number('Depth')
    make_coords = lambda x, z: (x, 0, z)
else:
    make_coords = lambda x, y: (x, y)

cords = [(0, 0), (width, 0), (width, height), (0, height)]
result = g_i.polygon(*[make_coords(*pos) for pos in coords])[0]

if s_i.is_3d: # perform the extrusion and remove original polygon
    volume = g_i.extrude(result, (0, depth, 0))[0]
    g_i.delete(result)
    result = volume

print('Created cluster: {}'.format(result.Name))

G.8  Creating a simple project

All commands that are available in the PLAXIS command line are also available via the Python wrapper. For more information, see the commands reference provided with your PLAXIS application. Note that private commands in the application (i.e. commands starting with a double underscore, __) are spelled without the double underscore when used from Python. Commands that conflict with Python keywords should be spelled with an extra trailing underscore in Python (e.g. import becomes import__). Identifiers containing characters that are not part of the ASCII character set will be stripped of those characters (e.g. °C becomes C).

- Start by connecting from Python to PLAXIS 2D as described above.
- Make sure that the folder where the scripting sample will be saved does exist (c:\data\).
- Execute the code displayed below. For the sake of completeness, the replies returned by the different statements are included, but some of them are session-specific and will be different for you. It is helpful while executing the Python code to keep an eye on the command line in the PLAXIS application, in order to gain an understanding of how Python code maps to commands. Keep also in mind that Python, unlike the PLAXIS command line, is case sensitive.

```python
>>> s_i.new()
'OK'
>>> g_i.SoilContour.initializerectangular(0, 0, 10, 10)
'OK'
```
```python
>>> g_i.borehole(0)
<Borehole {BB449552-2ABF-408D-8293-897B5939D764}>
>>> g_i.soillayer(10)
<GeneratedSoilVolume {859D7DB5-585E-4452-8C38-E700C398EF9C}>
>>> material = g_i.soilmat()
>>> material.setproperties("SoilModel", 1, "gammaUnsat", 16,
"gammaSat", 20, "Gref", 10000)
'Edited SoilMat_1'
>>> g_i.Sools[0].Material = material
>>> g_i.gotostructures()
'OK'
>>> g_i.lineload((3, 0), (7, 0))
[<Point {AD9DB344-A82E-4ACD-93BB-A3C02369556B}>, <Point {9E140226-A968-46A1-A2EA-5125EE83968F}>, <Line {F1E1AE01-C72A-44CD-A647-8EC39CA024D7}>, <LineLoad {B3A5244F-3097-44CC-8E3E-2290AC4508B0}>]
>>> g_i.gotomesh()
'OK'
>>> g_i.mesh(0.2)
Generated 181 elements, 374 nodes
>>> output_port = g_i.selectmeshpoints()
>>> s_o, g_o = new_server('localhost', output_port, password="yourpassword")
>>> g_o.addcurvepoint('node', g_o.Soil_1_1, (5, 0))
'OK'
>>> g_o.update()
'OK'
>>> g_i.gotostages()
'OK'
>>> phase1 = g_i.phase(g_i.Phases[0])
'OK'
>>> g_i.LineLoads[0].Active[phase1] = True
>>> g_i.calculate()
'OK'
>>> output_port = g_i.view(phase1)
>>> s_o, g_o = new_server ('localhost', output_port, password="yourpassword")
>>> utot = g_o.getcurveresults(g_o.Curvepoints.Nodes.value[0],
g_o.Phases[1],g_o.ResultTypes.Soil.Utot)
>>> print(utot)
8.76955286493468E-5
>>> g_i.save(r'c:\data\scripting_sample')
'Project saved as: c:\data\scripting_sample.p2dx'
```

- The command line history on the application side looks as follows (excluding the commands sent to Output):

```
0001> initializerectangular SoilContour 0 0 10 10
0002> borehole 0
0003> soillayer 10
0004> soilmat
0005> setproperties SoilMat_1 "SoilModel" 1 "gammaUnsat" 16
"gammaSat" 20 "Gref" 10000
0006> set Soil_1.Material SoilMat_1
0007> gotostructures
0008> lineload (3 0) (7 0)
0009> gotomesh
0010> mesh 0.2
0011> selectmeshpoints
0012> gotostages
0013> phase InitialPhase
0014> set Lineload_1_1.Active Phase_1 True
0015> calculate
```
G.9 Performance and logging

By default the server object (typically referred to as s in these examples) implements a caching system to reduce the number of calls by the script to the PLAXIS application, thereby improving the overall performance of the system. It can be switched off using:

```
s_i.allow_caching = False
```

Additionally, a logging system is available in order to monitor the communications between the Python script and the PLAXIS application. It can be toggled on or off using the `enable_logging()` and `disable_logging()` methods of the server object:

```
s_i.enable_logging()  # will write to TEMP\PlaxisScriptLogs\n```

G.10 External manipulations during script execution

While using Python scripts to manipulate the state of your PLAXIS application, it is technically possible to interact with the same application in other ways as well (e.g. by changing a project manually, or firing commands separately in an interpreter while the main script is paused). This is very useful for troubleshooting.

In particular situations it may however lead to problems, in that internal data structures built on the Python side have become obsolete due to actions outside of the script. The main culprit is (re)opening a project while the script already has some internal state/variables. Errors can look like this:

```
plxscripting.plx_scripting_exceptions.PlxScriptingError: Unsuccessful command: GUID does not refer to object in registry: {F00F9FB0-B903-42BE-AE1F-C7B8E200885D}
```

If you encounter such an error, simply stop the execution of your script and restart it.

G.11 Error handling mode

When the server is started, it is possible to optionally set an error handling mode by using the `error_mode` option. The `error_mode` consists of a behaviour and optionally one or more modifiers.

The `error_mode` option influences the behaviour of in-request exceptions, as well as out-of-request exceptions. In-request exceptions are raised during execution of a request and out-of-request exceptions occur outside an HTTP request. An example of the latter is if repainting the UI leads to a crash after the command has been executed and returned to the scripting client.

The `error_mode` is always a tuple consisting of none, one or more of:

1. Behaviour **RAISE** [default; empty `error_mode` means RAISE]: raises an exception.
2. Behaviour **INTERPRETER**: upon exception, fires an interactive Python interpreter for troubleshooting, if the server is not currently in an interactive interpreter mode already.
3. Modifier **RETRY**: tries the same API call again with a delay of 200 ms.
4. Modifier **PRECONDITION**: checks (and clears) the exception stack prior to making another API call.
5. Modifier **NOCLEAR**: ensures that when an out-of-request exception is retrieved, it is not cleared from the server.

If the user specifies **RAISE**, **INTERPRETER** as combo behaviour in the `new_server` call, **INTERPRETER** wins.

### G.11.1 Examples

1. Setting the error handling mode:
   ```python
   s_i, g_i = new_server('localhost', 10000,
                        error_mode=(INTERPRETER, RETRY))
   ```

2. Manual API calls
   It's useful to be able to manually request information about out-of-request failure state, particularly when using **NOCLEAR** or using the interactive interpreter to troubleshoot issues.
   ```python
   # raise a Python exception including the cleaned madExcept info, because this is an
   # in-request failure
   s_i.raise()
   
   # triggers out-of-request exception, retrievable using get_error, but does
   # not crash immediately
   s.raiseasync()
   
   # give the raiseasync time to work
   import time; time.sleep(0.5)
   
   # None if no exception, exception string otherwise
   s.get_error(clear=False)
   
   # as above, but does clear the exception information from the server
   s.get_error(clear=True)
   
   # equivalent to clear=True
   s.get_error()
   ```

### G.12 Installing third-party Python modules

When the user wants to install a third-party package that is not already available in the PLAXIS Python distribution we deliver, then you can do so by opening the command prompt from **Expert > Python > Command prompt** in PLAXIS Input or Output program.

As this requires administrator rights on your PC, you first need to launch PLAXIS Input or Output as Administrator. This can be done by click with RMB on the PLAXIS shortcut and selecting Run as Administrator.

In the Command prompt, you can install new packages by using pip. For example, if you want to install the Dropbox package you would type:

```bash
python -m pip install dropbox
```
If you want to install the cffi (C foreign function interface) package you would type:

```
python -m pip install cffi
```

### G.13 Tokenizer

The Python API allows parsing a command line string into the separate tokens.

- The server object has a `tokenize` method. This method returns a `Tokenizer` object. This object may be in a fully valid state, or a partially valid state. It always contains one list of Token objects, but depending on the success of the action, this list may be available only as `Tokenizer.partial_tokens` or as both `Tokenizer.tokens` and `Tokenizer.partial_tokens` simultaneously - see the example below for more information.

The list of tokens contains `Token` objects.

- `partial_tokens` contains the successfully parsed tokens, which may or may not be all tokens in the string.

- There are subclasses of the `Token` class to match the types of tokens from the HTTP REST API, see [HTTP REST API [GSE]](on page 642)

- The `Token` classes have properties as specified for the HTTP REST API (see [HTTP REST API [GSE]](on page 642)). The only exception is the type property: this one will be absent in Python, since it is implicitly encoded in the `Token` subclass.

#### G.13.1 Examples

```python
from plxscripting.easy import *
s, g = new_server("localhost", 10000)

tokenizer = s.tokenize("addpoint Polygon_2 0 4 0 # comment")
print(tokenizer.success) # prints True
print(tokenizer.error_position) # prints -1
print(tokenizer.tokens == tokenizer.partial_tokens) # prints True

tokens = tokenizer.tokens
print(len(tokens)) # prints 6

token = tokens[0]
print(token.position) # prints 0
print(token.length) # prints 8
print(token.end_position) # prints 7

print(token.__class__) # prints <class 'plxscripting.tokenizer.TokenIdentifier'>
# The various Token classes mirror the ones of HTTP REST API
print(token.value) # prints 'addpoint' (w/o quotes)
print(token) # prints plxscripting.tokenizer.TokenIdentifier
    # ({'type': 'identifier', 'value': 'addpoint', 'length': 8, 'position': 1})

print(tokens[2].__class__) # prints <class plxscripting.tokenizer.TokenInteger'>
print(tokens[2].Value) # prints 0
```
print(tokens[-1].value) # prints '# comment'
print(tokens[-1].content) # prints ' comment' (with leading space, w/o quotes)

for token in tokens:
    print(token) # prints all the tokens

# error conditions
tokenizer = s.tokenize("abc ?")
tokens = tokenizer.tokens # raises an exception about Unrecognized token
print(tokenizer.success) # prints False
print(tokenizer.error) # prints 'Unrecognized token' (w/o quotes)
print(tokenizer.error_position) # prints 4
print(len(tokenizer.partial_tokens)) # prints 1, since the first token is OK

G.14 Sample Applications

This section contains a few simple tasks that highlight different aspects of the Python scripting wrapper. It is assumed PLAXIS 2D is running and the necessary connection boilerplate code has been executed already.

G.14.1 Opening a project, removing all lines containing plates and saving again

```python
s_i.open(r'c:\data\lines_with_plates.p2dx')
lines = [b.Parent for b in g_i.Plates]
g_i.delete(*lines)
# alternatively (look at the difference in the command line):
# g_i.delete(lines)
g_i.save()
```

G.14.2 Reporting all points that are not used by lines and that have no features

```python
points_in_lines = set()
for line in g_i.Lines[:]:
    for point in line:
        points_in_lines.add(point)
points = set(g_i.Points)
points_no_lines = points - points_in_lines
points_to_report = []
for p in points_no_lines:
    if len(p.UserFeatures.value) == 0:
        points_to_report.append(p)
for p in points_to_report:
    print(p.Name)
```
G.14.3 Creating an array, storing the results and performing actions on the diagonal

```python
# Code will work in any project, as it operates only on its own local results, regardless of what else is present in the project.
g_i.gotostructures()
point = g_i.point(0, 0)
added_points = g_i.arrayr(point, 6, (1, 0), 6, (0, 1))

diagonal_points = []
for p in added_points:
    if abs(p.x - p.y) < 1E-4:
        diagonal_points.append(p)

g_i.pointload(diagonal_points)
```

G.14.4 Lengthening all the embedded beam rows in a model

```python
# Code below can be used to quickly generate a test model
res = g_i.embeddedbeam((0, 0), (0, -15))
line = [item for item in res if item._plx_type=='Line'][0]

get_bottom_point = lambda line: get_bottom_point(line)
get_bottom_point = get_bottom_point

def get_bottom_point(line):
    first, second = line.First, line.Second
    delta = second.y - first.y
    if abs(delta) < 1E-4: # horizontal line
        return None
    if delta > 0: # Second point is higher -> move First down
        return first
    else: # First point is higher -> move Second down
        return second

def lengthen_embedded_beams(extra_depth):
    # start by selecting the lines which have embedded beam rows
    pile_lines = [pile.Parent for pile in g_i.EmbeddedBeams[:]]

    # we don't know whether the line is drawn top-to-bottom
    # or bottom-to-top, so find out which point is lowest
    points_to_move = []
    for line in pile_lines:
        bottom_point = get_bottom_point(line)
        if bottom_point:
            points_to_move.append(bottom_point)

    g_i.move(points_to_move, (0, -extra_depth))

lengthen_embedded_beams(2.5)
```
G.14.5  Making all plates in all phases have identical settings in staged construction

```python
refplate = g_i.Plates[0]
otherplates = g_i.Plates[1:]
for phase in g_i.Phases:
    if refplate.Active[phase] is None:  # phase not yet initialized
        continue
    for otherplate in otherplates:
        otherplate.Active[phase] = refplate.Active[phase]
```

G.14.6  Create safety phase after every consolidation phase

```python
for phase in g_i.Phases[:]:
    if phase.DeformCalcType == phase.DeformCalcType.consolidation:
        newphase = g_i.phase(phase)
        newphase.DeformCalcType = newphase.DeformCalcType.safety
```

G.14.7  Send an email using Gmail after calculations are finished

```
'''A Gmail account is needed for this. Google Apps for Business accounts
should work as well.''

import smtplib
from email.mime.multipart import MIMEMultipart
from email.mime.text import MIMEText
def opensession_gmail(username, password):
    # Courtesy of http://segfault.in/2010/12/sending-gmail-from-python/
    # Other email providers may require a different way of connecting.
    # It may be necessary to enable access for less secure apps when
    # using GMail, see https://www.google.com/settings/security/lesssecureapps
    session = smtplib.SMTP('smtp.gmail.com', 587)
    session.ehlo()
    session.starttls()
    session.ehlo()
    session.login(username, password)
    return session
def sendmail(smtp_session, sender_address,
             to_address, subject, body):
    msg = MIMEMultipart()  
    msg['From'] = sender_address
    msg['To'] = to_address
    msg['Subject'] = subject
    part = MIMEText('text', 'plain')
    part.set_payload(body)
    msg.attach(part)
    smtp_session.sendmail(sender_address, to_address, msg.as_string())
```
def report_phases_by_kind(target_report, phases, kind, report_func):
    if phases:
        target_report.append(kind)
        target_report.append('=' * len(kind))
        for phase in phases:
            target_report.append(report_func(phase))
        target_report.append('
')

def phase_to_string(phase):
    return '{0} [ {1} ]'.format(phase.Identification, phase.Name)

def phase_to_string_with_error_code(phase):
    return '{0} [ {1} ]. LogInfo: {2}'.format(
        phase.Identification, phase.Name, phase.LogInfo)

def report_phases(phases_list):
    successful_phases = []
    failed_phases = []
    uncalculated_phases = []
    for phase in phases_list:
        if phase.ShouldCalculate:
            uncalculated_phases.append(phase)
        elif phase.LogInfo == '0':
            successful_phases.append(phase)
        else:
            failed_phases.append(phase)
    report_lines = []
    report_phases_by_kind(report_lines, successful_phases, 'Successful', phase_to_string)
    report_phases_by_kind(report_lines, failed_phases, 'Failed', phase_to_string_with_error_code)
    report_phases_by_kind(report_lines, uncalculated_phases, 'Skipped', phase_to_string)
    return '
'.join(report_lines)

def calculate_with_report():
    phases_to_calculate = []
    for phase in g_i.Phases[:]:
        if phase.ShouldCalculate:
            phases_to_calculate.append(phase)
    res = g_i.calculate()
    report = [
        'Title: {}'.format(g_i.Project.Title),
        'Location: {}'.format(g_i.Project.Filename),
        '
        report_phases(phases_to_calculate),
        ',',
        'Command feedback:',
        res]
    return '
'.join(report)

message = calculate_with_report()
G.14.8 Executing commands specified in a file

'''For debugging particular problems it may be interesting to execute commands directly (effectively bypassing the Python object wrapper) and parse feedback on demand. It may also have some performance benefits as the communication with the server is reduced. This way of communicating with the application also allows you to do your own error handling. The code below demonstrates several approaches to this task, examine the data that's printed out to better understand the differences.''

# Code below can be used to quickly generate a test model
## from tempfile import NamedTemporaryFile
## import os
## f = NamedTemporaryFile(mode='w', delete=False)
## f.write('n'.join(['bh 0', 'sl 2', 'plate 0 0 1 1']))
## filename = f.name

f = open(filename, 'r') # filename should be defined in advance
commands = [line.rstrip() for line in f.readlines()]
f.close()

# If you used the quickly generated test model, also enable
# the cleaning below:
## os.remove(filename)

# Run one command at a time and have the wrapper handle the response
# for you - not much extra control.
for command in commands:
    print(s_i.call_and_handle_command(command))

# Run multiple commands at a time and have the wrapper handle
# the responses for you. There is less communication with the
# server than when executing one command at a time so it's
# potentially faster.
print(s_i.call_and_handle_commands(*commands))

# Run one command at a time and handle the response yourself. The
# response now consists of Python primitives representing the
# JSON communication rather than comfortable objects.
for command in commands:
    print(s_i.call_commands(command))

# Run multiple commands at a time and handle the responses yourself.
print(s_i.call_commands(*commands))

# call_commands will not lead to an exception in case of invalid
# commands, unlike the other method calls presented.
print(s_i.call_commands('this is an invalid command'))

G.14.9 Creating a polar array of inclined piles

from math import radians, sin, cos

# input parameters
nr_pilerows = 4 # must be > 1
total_angle_deg = 180 # over which to distribute the piles, must be > 0 and <= 360
pilerow_length = 10
pilerow_inclination_deg = 15
array_center = (5, 0)
array_radius = 10

# calculations
def rel_coords_to_absolute(rel_coords, radius, offset):
    coords = [radius * coord for coord in rel_coords]
    return [p[0] + p[1] for p in zip(coords, offset)]

if total_angle_deg == 360: # fencepost problem -> decrease angle
    total_angle_deg = total_angle_deg / (nr_pilerows) * (nr_pilerows - 1)

pilerow_inclination_rad = radians(pilerow_inclination_deg)
array_bottom_radius = array_radius + 
    pilerow_length * sin(pilerow_inclination_rad)
array_bottom_center = (array_center[0], array_center[1] - pilerow_length * 
    cos(pilerow_inclination_rad))
pilerow_coords = []
for i in range(nr_pilerows):
    angle = radians(total_angle_deg * i / (nr_pilerows - 1))
    rel_coords = [cos(angle), sin(angle), 0]
    top_coords = rel_coords_to_absolute(
        rel_coords, array_radius, array_center)
    bottom_coords = rel_coords_to_absolute(
        rel_coords, array_bottom_radius, array_bottom_center)
    pilerow_coords.append((top_coords, bottom_coords))

    for coords_pair in pilerow_coords:
        g_i.embeddedbeam(*coords_pair)

G.14.10 Convert 2D to 3D

'''This is a limited converter that will only work for a small subset of potential 2D geometry configurations. We need to be careful about which environment variables live in (3D will not be able to accept as input objects that live in the 2D environment and the other way around). For this reason we will append a 2 or 3 to each variable in order to indicate where
the object lives. Keep in mind that for this case both 2D and 3D need to be running simultaneously, and they must open different ports for the scripting engine. Depending on which versions are in use, it may also happen that the scripting API is incompatible between the two, so additional effort will need to be undertaken to load different versions of the API for 2D and 3D.

```python
# connect to 2D
s2, g2 = new_server('localhost', 10002, password='yourpassword')

# Code below can be used to quickly build a 2D project that
# we can use for conversion
## s2.new()
## g2.gotostructures()
## g2.plate((2, 5), (2, 2))
## g2.plate((6, 5), (6, 2))
## g2.polygon((0, 0), (8, 0), (8, 5), (0, 5))

# connect to 3D
s3, g3 = new_server('localhost', 10003, password='yourpassword')

# In 3D we need to specify a particular slice thickness
while True:
    try:
        depth = float(input('Specify non-zero 3D slice thickness> '))
        if depth != 0.0:
            break
    except:
        print('Invalid input, try again!')
# Limitations
# - not all 2D line features become surface
# - features may depend on normal orientation
for uf2 in line2.UserFeatures.value:
    # shorthand: assume that the command == type name,
    # which is not necessarily true for all user features
    ufconstructor 3 = g3.__getattr__(
        uf2._plx_type.lower())
```
# add the feature
ufconstructor3(surface3)

# convert each polygon to a volume
for polygon2 in g2.Polygons:
    # the addition operation on numerical intrinsic properties
    # automatically dereferences their value
    pointcoords = [(polygon2.x + p2.x, 0.0, polygon2.y + p2.y)
                   for p2 in polygon2.Points.value]
    surface3 = g3.surface(*pointcoords)
# use extrusion to create a volume
volume3 = g3.extrude(surface3, (0.0, depth, 0.0))
# remove the original surface
    g3.delete(surface3)

Note: A fully working 2D to 3D converter is delivered as a feature in PLAXIS 2D Input. This example code is added as an example to show a combination of PLAXIS 2D and PLAXIS 3D in one Python script.

G.14.11 Using both Input and Output at the same time

# Sometimes you also want to automate the selection of history points
# or the retrieval of results in Output.
s_i, g_i = new_server('localhost', 10000, password='yourpassword')
s_i.open(r'C:\Users\x\Document\PlaxisProjects\some_existing_project.p2dx')

# Calling the view command while Input has a running server will also start
# Output with a server and return the port that the new server uses.
# The commands preview, view and viewmesh will behave similarly.
output_port = g_i.selectmeshpoints()

# Connect to the Output server the same way we connect to the Input one.
s_o, g_o = new_server('localhost', output_port, password='yourpassword')

# Select a history point and close Output with the update command.
g_o.addcurvepoint('node', g_o.Soil_1_1, 0, 0)
g_o.update()

G.14.12 Computing a derived result from existing result types

This example shows how to compute a derived result starting from standard result types. This code requires existing results to be processed.

import math
from plxscripting.easy import new_server

s_i, g_i = new_server('localhost', 10000, password='yourpassword')

last_phase = g_i.Phases[-1]
ux = g_i.getresults(last_phase, g_i.ResultTypes.Soil.Ux, 'node')
uy = g_i.getresults(last_phase, g_i.ResultTypes.Soil.Uy, 'node')
displacement_angles = [math.atan2(y, x) for x, y in zip(ux, uy)]
print(displacement_angles)

G.14.13 Finding the local maximum displacement from existing result types

This example shows how to find the local maximum displacement using the `getsingleresult` command. This code requires existing results to be processed.

```python
import math
from plxscripting.easy import new_server

s_i, g_i = new_server('localhost', 10000, password='yourpassword')

step = 0.1
last_phase = g_i.Phases[-1]
result_type = g_i.ResultTypes.Soil.Utot

def get_displacement(coordinate):
    result = g_i.getsingleresult(last_phase, result_type, *coordinate)
    if result == 'not found':
        return float('nan')
    else:
        return float(result)

# Use simple hill climbing to get to the coordinate with the highest displacement.

def get_walk_direction(coordinate, utot):
    coordinate_dx = (coordinate[0] + step, coordinate[1])
    result_dx = get_displacement(coordinate_dx)
    if math.isnan(result_dx):
        return (0.0, 0.0, True)

    coordinate_dy = (coordinate[0], coordinate[1] + step)
    result_dy = get_displacement(coordinate_dy)
    if math.isnan(result_dy):
        return (0.0, 0.0, True)

    max_utot = 0.0
    coordinate_at_max = (0.0, 0.0)
    coordinate = (0.0, 0.0)
    done = False
    while not done:
        utot = get_displacement(coordinate)
        if math.isnan(utot):
            break

        max_utot = max(utot, max_utot)
        coordinate_at_max = coordinate

        dutot_dx, dutot_dy, done = get_walk_direction(coordinate, utot)
```

#Get new coordinate with sign of partial derivatives.
coordinate = (
    coordinate[0] + math.copysign(step, dutot_dx),
    coordinate[1] + math.copysign(step, dutot_dy))

unit_length = g_i.GeneralInfo.UnitLength
print("Found coordinate ({0} {3}, {1} {3}). "
    "With a displacement of: {2} {3}".format(
    coordinate_at_max[0], coordinate_at_max[1], max_utot, unit_length))

G.14.14 Receiving an image in the scripting layer created by Output

from plxscripting.easy import new_server
s_o, g_o = new_server('localhost', 10000, password='yourpassword')

newest_plot = g_o.Plots[-1]
newest_plot.ResultType = g_o.ResultTypes.Soil.Utot
newest_plot.PlotType = 'shadings'
newest_plot.Phase = g_o.Phases[-1]

#image_wrapper is an object that can save the created
#image or, if Pillow is installed, you can get the internal
#Pillow.Image object and use that.
image_wrapper = newest_plot.export(1600, 1200)

try:
    from PIL import ImageFilter
    pil_image = image_wrapper.image
    new_image = pil_image.filter(ImageFilter.BLUR)
    new_image.save("test.png")
except ImportError:
    #Just save if we don't have Pillow
    image_wrapper.save("test.png")

G.14.15 A class that can be used to quickly create simple projects

The following code demonstrates a possible approach to building a model template class, that can be tweaked in subclasses in order to create model variants without duplicating large amounts of code. Other examples in this document will build upon this class. Make sure you save it as "simple\_project.py" in the same directory where you save the examples that need it.

import os
import subprocess

INPUT_SERVER_PORT = 10000
PLAXIS_PATH = r"C:\Program Files\Plaxis\PLAXIS 2D"

class SimpleProject(object):
    ...
Class that provides a way to quickly set up a project for example purposes.

```python
def __init__(self, g_i):
    from plxscripting.easy import new_server
    self._new_server = new_server

    args = [os.path.join(plaxis_path, "Plaxis2DXInput.exe"),
            "--AppServerPort={}".format(INPUT_SERVER_PORT)]
    self._input_process = subprocess.Popen(args)

    self._s_i, self._g_i = self._new_server(
        'localhost', 10000, password='yourpassword', timeout=10.0)

def gather_results(self):
    raise NotImplementedError("Override gather_results in subclass.")

def output_results(self):
    raise NotImplementedError("Override output_results in subclass.")

def close_input(self):
    self._input_process.kill()

@property
def g_i(self):
    return self._g_i

def add_soil_layers(self):
    raise NotImplementedError("Override add_soil_layers in subclass.")

def apply_soil_material(self):
    SAND_PARAMETERS = [
        ('MaterialName', 'Sand'),
        ('Colour', 10676870),
        ('SoilModel', 3), # Hardening soil
        ('DrainageType', 'Drained'),
        ('gammaUnsat', 17),
        ('gammaSat', 20),
        ('E50ref', 43000),
        ('EoedRef', 28000),
        ('EurRef', 129000),
        ('powerm', 0.5),
        ('cref', 1),
        ('phi', 34.0),
        ('psi', 4.0),
        ('nu', 0.2),
        ('Rinter', 0.7),
        ('KONC', 0.5),
        ('OCR', 1.0),
        ('POP', 0.0)
    ]
    sand = self._g_i.soilmat(*SAND_PARAMETERS)

    for soil_layer in self._g_i.SoilLayers:
        self._g_i.setmaterial(soil_layer, sand)

def add_structures(self):
    pass # Not adding any plates is fine too.
```

Python HTTP REST API wrapper [GSE]
def apply_plate_materials(self):
    DIAPHRAGM_WALL_PARAMETERS = [
        ('MaterialName', 'Wall'),
        ('Colour', 16711680),
        ('Elasticity', 0), # Elastic
        ('IsIsotropic', True),
        ('IsEndBearing', True),
        ('EA', 12000000),
        ('EI', 120000),
        ('nu', 0.15),
        ('d', 0.34641),
        ('w', 8.3),
        ('Mp', 10000000000000.0),
        ('Np', 10000000000000.0),
        ('Np2', 10000000000000.0),
        ('RayleighAlpha', 0),
        ('RayleighBeta', 0),
        ('Gref', 15061311)
    ]
    diaphragm_wall_material = self._g_i.platemat(*DIAPHRAGM_WALL_PARAMETERS)
    for plate in self._g_i.Plates:
        self._g_i.setmaterial(plate, diaphragm_wall_material)

def mesh(self):
    self._g_i.gotomesh()
    self._g_i.mesh(0.06)

def select_curve_points(self):
    pass # Not selecting any curve-points is fine too.

def configure_phases(self):
    raise NotImplementedError("Override configure_phases in subclass.")

def make_project(self):
    self.add_soil_layers()
    self.apply_soil_material()
    self.add_structures()
    self.apply_plate_material()
    self.mesh()
    self.select_curve_points()
    self.configure_phases()
    self._g_i.calculate()

def run(project_class):
    # Replace with the path to your PLAXIS installation.
    project = project_class(r"c:\Program Files (x86)\Plaxis\PLAXIS 2DX")
    project.make_project()
    project.gather_results()
    project.output_results()
    project.close_input()
import sys
import csv
from simple_project import SimpleProject, run

class ExportCSVProject(SimpleProject):
    def add_soil_layers(self):
        self._g_i.SoilContour.initializerectangular(0, 0, 100, 30)
        borehole = self._g_i.borehole(0)
        self._g_i.soillayer(0)
        self._g_i.setsoillayerlevel(borehole, 0, 30)
        self._g_i.setsoillayerlevel(borehole, 1, 27)
        self._g_i.soillayer(0)
        self._g_i.setsoillayerlevel(borehole, 2, 15)
        self._g_i.soillayer(0)
        self._g_i.setsoillayerlevel(borehole, 3, 0)
        borehole.Head = 23

    def add_structures(self):
        self._g_i.gotostructures()
        self._g_i.plate(40, 30, 40, 14)
        self._g_i.plate(60, 30, 60, 14)
        for plate in self._g_i.Plates:
            self._g_i.posinterface(plate.Parent)
            self._g_i.neginterface(plate.Parent)

        self._g_i.lineload(28, 30, 38, 30)

    def select_curve_points(self):
        output_port = self._g_i.selectmeshpoints()
        s_o, g_o = self._new_server('localhost', output_port, password='yourpassword')
        g_o.addcurvepoint('node', 40, 30, -1, 0)
        g_o.update()

    def configure_phases(self):
        self._g_i.gotostages()
        self._g_i.activate(self._g_i.LineLoads, self._g_i.InitialPhase)
        self._g_i.activate(self._g_i.Plates, self._g_i.InitialPhase)
        self._g_i.activate(self._g_i.Interfaces, self._g_i.InitialPhase)
        self._g_i.deactivate(self._g_i.SoilPolygons[1], self._g_i.InitialPhase)

        line_load = self._g_i.LineLoads[0]

        current_phase = self._g_i.InitialPhase
        line_load.qy_start[current_phase] = 0.0

        for i in range(1, 10):
            current_phase = self._g_i.phase(current_phase)
            self._g_i.setcurrentphase(current_phase)
            line_load.qy_start[current_phase] = -10.0 * i
```python
def gather_results(self):
    output_port = self._g_i.view(self._g_i.InitialPhase)
    s_o, g_o = self._new_server('localhost', output_port, password='yourpassword')
    self._results = []
    # phaseID is only correct because we know the phases are in order!
    for phaseID, phase in enumerate(g_o.Phases):
        if phaseID == 0:
            # Skip the initial phase and just write 0, because getcurveresults
            # won't return any results for it.
            self._results.append({
                'phaseID': 0,
                'displacement': 0
            })
        else:
            displacement_string = g_o.getcurveresults(g_o.Nodes[0],
                                                     phase, g_o.ResultTypes.Soil.Utot)
            self._results.append({
                'phaseID': phaseID,
                'displacement': displacement_string
            })
    g_o.update()

def output_results(self):
    # Prevent excess newlines.
    if sys.version_info.major == 2:
        file_kwargs = { 'mode': 'wb' }
    else:
        file_kwargs = { 'mode': 'w', 'newline': '' }
    # By default the csv writers will separate values with a comma and the
    # period will be used as the decimal separator.
    # However, this might be problematic when trying to import a csv file
    # on a system that uses comma as the decimal separator.
    # In these cases do the following:
    # - import the locale modules and call: locale.setlocale(locale.LC_ALL, '')
    # - get the correct separator with: locale.localeconv()['decimal_point']
    # - replace the period in the output results with the correct separator
    # - use a different csv dialect (see Python docs) so the comma isn't used
    #   as the column separator.
    with open("results.csv", **file_kwargs) as csv_file:
        writer = csv.DictWriter(csv_file, fieldnames=['phaseID', 'displacement'])
        for row in self._results:
            writer.writerow(row)

if __name__ == '__main__':
    run(ExportCSVProject)
```

G.14.17  Create a combined image of the mesh for two different phases
This example must be saved in the same directory as the simple\_project.py module created in a previous paragraph.

```python
from simple_project import SimpleProject, run

from PIL import Image, ImageFont, ImageDraw

class ExportPlotProject(SimpleProject):
    def add_soil_layers(self):
        self._g_i.borehole(0)
        self._g_i.soillayer(4)

    def add_structures(self):
        self._g_i.gotostructures()
        self._g_i.plate(6, 0, 6, -2)

        self._g_i.pointload(self._g_i.Points[0])
        self._g_i.PointLoads[0].Fy = -10

    def configure_phases(self):
        self._g_i.gotostages()
        self._g_i.activate(self._g_i.Plates, self._g_i.InitialPhase)

        next_phase = self._g_i.phase(self._g_i.InitialPhase)
        self._g_i.activate(self._g_i.PointLoads, next_phase)

    def gather_results(self):
        width, height = 800, 600

        output_port = self._g_i.view(self._g_i.InitialPhase)
        s_o, g_o = self._new_server('localhost', output_port, password='yourpassword')

        # Hide everything except the mesh itself.
        g_o.Plots[0].DrawFrame = False
        g_o.Plots[0].DrawTitle = False
        g_o.Plots[0].DrawLegend = False
        g_o.Plots[0].DrawAxes = False
        g_o.Plots[0].Phase = g_o.InitialPhase

        self._initial_phase_image = g_o.Plots[0].export(width, height)

        g_o.Plots[0].Phase = g_o.Phase_1
        self._phase_1_image = g_o.Plots[0].export(width, height)

        g_o.close()

    def output_results(self):
        # Get Pillow.Image objects.
        inner_initial_image = self._initial_phase_image.image
        inner_phase_1_image = self._phase_1_image.image

        assert inner_initial_image.size == inner_phase_1_image.size

        cropping_left = (0, 0,
                         inner_initial_image.width // 2, inner_initial_image.height)
        left_image = inner_initial_image.crop(cropping_left)
```

---

**PLAXIS** 639  **Reference Manual 2D**
cropping_right = (inner_phase_1_image.width // 2, 0, inner_phase_1_image.width, inner_phase_1_image.height)
right_image = inner_phase_1_image.crop(cropping_right)

result_image = Image.new(inner_initial_image.mode, inner_initial_image.size)
result_image.paste(left_image, cropping_left)
result_image.paste(right_image, cropping_right)

default_font = ImageFont.load_default()
drawing_context = ImageDraw.Draw(result_image)

initial_phase_ID = self._g_i.Phases[0].Identification.value
drawing_context.text((200, 160), initial_phase_ID, font=default_font, fill=(0, 0, 0, 255))

phase_1_ID = self._g_i.Phases[1].Identification.value
after_text_size = default_font.getsize(phase_1_ID)
drawing_context.text((600 - after_text_size[0], 160), phase_1_ID, font=default_font, fill=(0, 0, 0, 255))

result_image.save("plot_initial_vs_phase_1.png")

if __name__ == '__main__':
    run(ExportPlotProject)

G.14.18 Create a matplotlib plot from a line cross-section

This example must be saved in the same directory as the simple_project.py module created in a previous paragraph.

from simple_project import SimpleProject, run
from matplotlib import pyplot

SAMPLE_COUNT = 16

class CrossSectionProject(SimpleProject):
    def add_soil_layers(self):
        self._g_i.borehole(0)
        self._g_i.soillayer(4)

    def add_structures(self):
        self._g_i.gotostructures()
        self._g_i.lineload(5, 0, 7, 0)

    def configure_phases(self):
        self._g_i.gotostages()
        self._g_i.activate(self._g_i.Plates, self._g_i.InitialPhase)

        next_phase = self._g_i.phase(self._g_i.InitialPhase)
```python
self._g_i.activate(self._g_i.PointLoads, next_phase)

def gather_results(self):
    start = (0.0, -4.0)
    end = (6.0, 0.0)

    output_port = self._g_i.view(self._g_i.Phases[-1])
    s_o, g_o = self._new_server('localhost', output_port, password='yourpassword')

    # Assumes that start and end contain floats, will not work correctly
    # with integers in Python 2.
    step = [(e - s) / (SAMPLE_COUNT - 1) for e, s in zip(end, start)]

    self._results = []
    for i in range(SAMPLE_COUNT):
        position = (start[0] + i * step[0], start[1] + i * step[1])
        result_string = g_o.getsingleresult(g_o.Phases[-1],
            g_o.ResultTypes.Soil.Utot, position)

        # Check if position lies outside the mesh, it might make more sense
        # to use 0 as the result for other result types.
        if result_string == "not found":
            raise Exception("Used getSingleresult for point outside mesh.")

        self._results.append(float(result_string))

    g_o.update()

    def output_results(self):
        pyplot.plot(range(len(self._results)), self._results, 'r')
        pyplot.grid(True)
        pyplot.show()

if __name__ == '__main__':
    run(CrossSectionProject)
```

H.1 Overview

PLAXIS provides an HTTP based API. This API allows a developer or user to do normal PLAXIS tasks such as creating projects, firing regular commands as found on the existing command line, performing meshing and calculations. In addition, unique representations of Plaxis objects can be retrieved, kept, and then used in later operations, such as the fetching of their properties and methods, as well as calling methods. This provides additional flexibility and power to the existing command line.

There are several categories of actions that can be performed via the HTTP API. Each of these have their own URL path, as follows:

<table>
<thead>
<tr>
<th>URL Path</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/environment</td>
<td>Start, close, recover or open projects</td>
</tr>
<tr>
<td>/commands</td>
<td>Fire regular PLAXIS command line commands and fetch any created objects</td>
</tr>
<tr>
<td>/members</td>
<td>Fetch the members of objects</td>
</tr>
<tr>
<td>/propertyvalues</td>
<td>Fetch the property values of objects</td>
</tr>
<tr>
<td>/namedobjects</td>
<td>Fetch existing objects by their command line names</td>
</tr>
<tr>
<td>/list</td>
<td>Fetch items from listable objects</td>
</tr>
<tr>
<td>/enumeration</td>
<td>Fetch all possible values of enumeration objects</td>
</tr>
<tr>
<td>/exceptions</td>
<td>Get information about exceptions that occurred outside the server requests</td>
</tr>
<tr>
<td>/tokenizer</td>
<td>Offers tokenization services</td>
</tr>
</tbody>
</table>

All request data must be encoded using UTF-8.

H.2 Object representations

Resources which create or retrieve objects return representations of those objects. These representations comprise a Globally Unique Identifier (GUID), a type name, and a flag indicating whether the object is listable or not. The JSON structure for this representation is as follows:

```json
"guid": <string>
"islistable": <boolean>
```
The server can recognise and retrieve information about objects contained within the PLAXIS project based on that object’s GUID. This means that, for example, a particular PLAXIS object can be created using the /commands resource, and then later the values of that object’s properties can be retrieved by sending that object’s GUID in a request to the /propertyvalues resource. The same GUID can be used in the creation of additional objects by sending it in a request to the /commands resource. If the object is listable, sending the guid as part of a request to the /list resource will enable access to the object’s properties by index, and so on. The ownerguid is only returned for objects that are intrinsic properties. It is the guid of the owning object.

H.3 Using a web browser to access the API

It is possible to perform a subset of the actions that are described below by using a browser address bar. This can be useful for quickly viewing the data representations that are returned from the API.

There is a limitation to the complexity of queries that can be made in this mode, which means that certain resources and actions are not possible. This includes the /list resource, and also the querying of specific named properties in the /propertyvalues resource (however it is still possible to query all properties for an object using a browser address bar).

Each resource description below includes an example action using the address bar.

H.4 HTTP API Resources

/environment

This resource is for managing projects. Creating, restoring, closing or opening a project are permitted. If a project is opened, then a filename string is supplied for locating an existing project locally, or otherwise becomes the name of a new project.

Note that it is not possible to save projects via this resource. Instead, fire a save command using the /commands resource.

Method: POST

Data parameters

```

"action": {
  "name": *1 <string> from {"new", "open", "close", "restore"}*,
  "filename": *1 <string>*
}
```

Data parameters example

```

{ "action": {
  "name": "open",
  "filename": "my_plaxis_project.p2dx" 
}}

```
"action": {
  "name": "close",
  "filename": ""
}

Success responses

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>OK</td>
</tr>
<tr>
<td>404 STATUS NOT FOUND</td>
<td>&quot;Incorrect or unspecified action: [action-name]&quot;</td>
</tr>
<tr>
<td>404 STATUS NOT FOUND</td>
<td>&quot;Incorrect or unspecified file name, or not a valid project: [filename]&quot;</td>
</tr>
<tr>
<td>400 BAD REQUEST</td>
<td>&quot;Syntax of request could not be understood by the server.&quot;</td>
</tr>
<tr>
<td>415 UNSUPPORTED MEDIA TYPE</td>
<td>&quot;Unsupported content-encoding of [encoding type]&quot;</td>
</tr>
</tbody>
</table>

Example JSON request

```python
payload = {"action": {"name": "new", "filename": ""}}
headers = {"content-type": "application/json"}
response = requests.post("/environment", data=json.dumps(payload), headers=headers)
```

Example browser request

http://localhost:8001/environment?action.name=new
http://localhost:8001/environment?
action.name=open&action.filename=my_plaxis_project.p2dx

/commands

This resource allows all standard commands (see command reference pages) to be run on an active PLAXIS project. Any objects created as the result of commands are represented in the response.

The server can recognise and "translate" GUIDs that refer to existing objects, as part of the command string. This means that it is possible to use GUIDs in the place of regular command line names to refer to other objects. This is beneficial, because the names of objects may be changed over the lifetime of a project (e.g. using the rename command), but the GUID remains fixed.

For example, it is possible to create a line between two existing points by referring to the GUIDs of those points in the command string of a request:

```
line <guid1> <guid2>
```

Note that a command that fails on the command line will not result in an error response from the server. These are treated as successful requests to the API. The server response indicates whether a command failed or not in the 'success' field. (See example below.) Whether the command succeeded or not, the 'additionalinfo' field indicates the response from that action as seen on the regular command line.

**Method:** POST
HTTP REST API [GSE]

Data parameters

```json
{
    "action": {
        "commands": {
            "*{1, ...}[<string>]*"  
        }
    }
}
```

Data parameters example

```json
{
    "action": {
        "commands": {
            "point 1 2"
        }
    },
    "action": {
        "commands": {
            "embeddedbeam 4 4 {860C1FC5-BDE1-4887-98A2-8FE20B61FCD5}"
        }
    },
    "action": {
        "commands": {
            "bad"
        }
    }
}
```

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>OK</td>
</tr>
</tbody>
</table>

Data

```json
{
    "commands": {
        "feedback": {
            "extrainfo": "Added Point_1",
            "returnedobjects": {
                "islistable": true,
            }
        }
    }
}
```

PLAXIS 645 Reference Manual 2D
HTTP REST API [GSE]

Data

{  
  "commands": [
    {
      "feedback": {
        "extrainfo": "Command \"bad\" is not recognized as a global command. Check the spelling or try specifying a target object.\",  
        "debuginfo": \"\",  
        "success": false,  
        "errorpos": 1  
      },  
      "command": "bad"
    }
  ]
}
Here the command returned an associative dictionary containing the 'ContentType'field. This will indicate what the rest of the dictionary will contain. In this particular case where the 'ContentType'is 'image/png' the dictionary will contain an additional 'data'field whose value is a base64 encoded PNG image.

The 'json'field does not necessarily have to be a dictionary, it can also be an integer or any other type allowed in JSON.

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 BAD REQUEST</td>
<td>&quot;Syntax of request could not be understood by the server.&quot;</td>
</tr>
<tr>
<td>404 STATUS NOT FOUND</td>
<td>&quot;Commands not specified&quot;</td>
</tr>
<tr>
<td>405 METHOD NOT ALLOWED</td>
<td>&quot;No active project&quot;</td>
</tr>
<tr>
<td>415 UNSUPPORTED MEDIA TYPE</td>
<td>&quot;Unsupported content-encoding of [encoding type]&quot;</td>
</tr>
</tbody>
</table>

Example JSON request

```python
payload = {"action": {"commands": ["point 1 2"]}
headers = {"content-type": "application/json"}
response = requests.post("/commands", data=json.dumps(payload), headers=headers)
```

Example browser request


/members

This resource fetches the members (properties and methods) of an existing object within PLAXIS, identified by its GUID.

Property members are represented as objects. The type names of these objects are simplified in comparison to their type names within PLAXIS 2D. This means that all 'Text' subtypes for instance will be simply described as having a type of 'Text'. The same principle applies to numerical, boolean, enumeration and object types.

Method members are represented as names only.

**Method:** POST

**Data parameters**

```json
{
    "action":
    {
        "members":
        [*
        *[1,...][GUID string]*
        ]
    }
}
```
Data parameters example

```
{
  "action": {
    "members": [
      "{68A2C1A7-924B-46C3-89DF-F597DAADC359}
    ]
  }
}
```

```
{
  "action": {
    "members": [
      "bad"
    ]
  }
}
```

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>OK</td>
</tr>
</tbody>
</table>

Data

```
{
  "queries": {
    "{68A2C1A7-924B-46C3-89DF-F597DAADC359}": {
      "extrainfo": "",
      "success": true,
      "properties": {
        "z": {
          "islistable": false,
          "ownerguid": "{68A2C1A7-924B-46C3-89DF-F597DAADC359}",
          "type": "Number",
          "guid": "{5FCCF1CC-7576-4565-B931-DE54241EA21B}"n},
        "y": {
          "islistable": false,
          "ownerguid": "{68A2C1A7-924B-46C3-89DF-F597DAADC359}",
          "type": "Number",
          "guid": "{D52CBED3-8C59-4967-A5BA-89ECE6E9BD94}"n},
        "x": {
          "islistable": false,
          "ownerguid": "{68A2C1A7-924B-46C3-89DF-F597DAADC359}",
          "type": "Number",
          "guid": "{25DA6A75-4F25-42F3-9654-3672A93FCE1F}"n},
        "Name": {
          "islistable": false,
          "ownerguid": "{68A2C1A7-924B-46C3-89DF-F597DAADC359}",
          "type": "Text",
          "guid": "{A4209590-9487-4B98-9966-34A6A58DBE2D}"n},
        "Comments": {
```
```
"islistable": false,
"ownerguid": "{68A2C1A7-924B-46C3-89DF-F597DAADC359}",
"type": "Text",
"guid": "{9430592C-7D5D-4735-B572-2B29C87F8BF1F}"
},
"commands": [
"echo","__dump","commands","rename","set","info","__observers","setproperties","move","rotate","rotateline"],
"commandlinename": "Point_1"
}
}
}

"queries": {
"{0D04D0CB-86BF-4430-882C-FA56E45DF7AB}": {
"extrainfo": "GUID does not refer to object in registry: {0D04D0CB-86BF-4430-882C-FA56E45DF7AB}",
"success": false
}
}
}

"queries": {
"bad": {
"extrainfo": "Supplied string is not a valid GUID: bad",
"success": false
}
}
}

Error responses

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 BAD REQUEST</td>
<td>&quot;Syntax of request could not be understood by the server.&quot;</td>
</tr>
<tr>
<td>404 STATUS NOT FOUND</td>
<td>&quot;No GUIDs specified&quot;</td>
</tr>
<tr>
<td>405 METHOD NOT ALLOWED</td>
<td>&quot;No active project&quot;</td>
</tr>
<tr>
<td>415 UNSUPPORTED MEDIA TYPE</td>
<td>&quot;Unsupported content-encoding of [encoding type]&quot;</td>
</tr>
</tbody>
</table>

Example JSON request

```
payload = {"action": {"members": ["{9C5875EE-ABA4-4DC2-9E81-1FF839215232}"]}}
headers = {"content-type": "application/json"}
response = requests.post("/members", data=json.dumps(payload), headers=headers)
```

Example browser request

```
http://localhost:8001/members?action.members={0D04D0CB-86BF-4430-882C-FA56E45DF7AB} /propertyvalues
```
This resource provides the current values of particular properties of PLAXIS objects. If a property is itself an object (such as the point properties of a line), then it is represented as a full object. If a property is a primitive value type, then the relevant primitive value is returned.

There are two ways of calling this resource. One is to supply just a guid of the owner object, in which case all properties of this object are represented in the response. The other way is to supply not just the owner guid, but also a property name and an optional phase parameter. Such a structure is treated as a request for one single property. If that property is staged, and the supplied phase guid is valid, then the value for that property and phase is returned.

**Method**: POST

**Data parameters**

```json
{
  "action": {
    "propertyvalues": ["{1} GUID string"]
  }
}
```

**Data parameters example**

```json
{
  "action": {
    "propertyvalues": ["{D4981EA8-EC07-471D-A8C3-7510B4F74F25}"
  }
}
```

**Success responses**

```json
{
  "queries": {
    "{D4981EA8-EC07-471D-A8C3-7510B4F74F25}": {
      "extrainfo": "",
      "success": true,
      "properties": {
```
Error responses

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 BAD REQUEST</td>
<td>&quot;Syntax of request could not be understood by the server.&quot;</td>
</tr>
<tr>
<td>404 STATUS NOT FOUND</td>
<td>&quot;No GUIDs specified&quot;</td>
</tr>
<tr>
<td>405 METHOD NOT ALLOWED</td>
<td>&quot;No active project&quot;</td>
</tr>
<tr>
<td>415 UNSUPPORTED MEDIA TYPE</td>
<td>&quot;Unsupported content-encoding of [encoding type]&quot;</td>
</tr>
</tbody>
</table>

Sample JSON request

```python
payload = {"action": {"propertyvalues": ["{9C5875EE-ABA4-4DC2-9E81-1FF839215232}"]}}
headers = {"content-type": "application/json"}
response = requests.post("/propertyvalues", data=json.dumps(payload), headers=headers)
```

Sample browser request

```
http://localhost:8001/propertyvalues?action.propertyvalues={0D04D0CB-86BF-4430-882C-FA56E45DF7AB}
```

/namedobjects

Supplies a representation of objects within PLAXIS 2D which are identified by their command line name. This is useful when accessing internal lists of objects within Plaxis with known names, such as lists of particular user
features or geometric objects. This resource can also be used to retrieve unique representations of objects for which the command line name is known, such as 'Point1'.

**Method:** POST

**Data parameters**

Example Request:

```
{
  "action": {
    "namedobjects": {
      "namedobjects": ["Points"]
    }
  }
}
```

```
{
  "action": {
    "namedobjects": {
      "namedobjects": ["Plate_1"]
    }
  }
}
```

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>OK</td>
</tr>
</tbody>
</table>

**Data**

```
{
  "namedobjects": {
    "Points": {
      "extrainfo": "",
      "success": true,
      "returnedobject": {
        "islistable": true,
        "type": "ModelGroup",
        "guid": "{32871FF1-809C-470A-94B0-4B56B28BC67B}"  
      }
    }
  }
}
```

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>OK</td>
</tr>
</tbody>
</table>

**Data**

```
{
  "namedobjects": {
    "Plate_1": {
```
### HTTP REST API [GSE]

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 BAD REQUEST</td>
<td>&quot;Syntax of request could not be understood by the server.&quot;</td>
</tr>
<tr>
<td>404 STATUS NOT FOUND</td>
<td>&quot;No object names specified&quot;</td>
</tr>
<tr>
<td>405 METHOD NOT ALLOWED</td>
<td>&quot;No active project&quot;</td>
</tr>
<tr>
<td>415 UNSUPPORTED MEDIA TYPE</td>
<td>&quot;Unsupported content-encoding of [encoding type]&quot;</td>
</tr>
</tbody>
</table>

#### Sample browser request

```
http://localhost:8001/namedobjects?action.namedobjects=Lines
```

/\list

Provides the ability to perform read operations on lists within PLAXIS 2D, such as getting values at particular indices, finding the number of objects in the list, and filtering.

**Method:** POST

#### Data parameters

Example request:

```json
{"action": {"listqueries": [{"guid": "{CF1DECEB-A28D-4609-B38C-8D3FF5E573A1}\", "method": "sublist", "startindex": 0, "stopindex": 1}]}}
{"action": {"listqueries": [{"guid": "{CF1DECEB-A28D-4609-B38C-8D3FF5E573A1}\", "method": "count"]}}
{"action": {"listqueries": [{"guid": "{CF1DECEB-A28D-4609-B38C-8D3FF5E573A1}\", "method": "index", "startindex": 0}]}}
```

Success responses

```json
{"listqueries": [{"extrainfo": "", "guid": "{CF1DECEB-A28D-4609-B38C-8D3FF5E573A1}\", "methodname": "sublist", "outputdata": [{"guid": "{81A754C8-1393-48BA-AD6E-5F6953F9FBE7}\", "islistable": true, "type": "Point"}], "startindex": 0, "stopindex": 1, "success": true}]}
{"listqueries": [{"extrainfo": "", ...
```
Error responses

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 BAD REQUEST</td>
<td>&quot;Syntax of request could not be understood by the server.&quot;</td>
</tr>
<tr>
<td>405 METHOD NOT ALLOWED</td>
<td>&quot;No active project&quot;</td>
</tr>
<tr>
<td>415 UNSUPPORTED MEDIA TYPE</td>
<td>&quot;Unsupported content-encoding of [encoding type]&quot;</td>
</tr>
</tbody>
</table>

Sample browser request

Not currently possible to call this resource via the browser address bar.

/enumeration

Provides a list of all possible enumeration values of one or more enumeration objects, when supplied with their GUIDs.

Success responses

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>OK</td>
</tr>
</tbody>
</table>

Data

```json
{
  "queries": {
    "{31AFFD41-0EB4-4A67-94F4-298642E17507}": {
      "extra-info": "",
      "success": true,
      "enum-values": {
        "hinged": 1,
        "free": 2,
        "rigid": 0
      }
    }
  }
}
```

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>OK</td>
</tr>
</tbody>
</table>
HTTP REST API [GSE]

Data

```json
{
"queries": {
"{0B4774CE-3307-4B86-B644-BFDE82CF3AAA}": {
"extrainfo": "GUID does not refer to object in registry: {0B4774CE-3307-4B86-B644-BFDE82CF3AAA}",
"success": false
}
}
}
```

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>OK</td>
</tr>
</tbody>
</table>

Data

```json
{
"queries": {
"{C896C54E-1CBA-4B0F-9987-E1FF57A9131E}": {
"extrainfo": "Guid {C896C54E-1CBA-4B0F-9987-E1FF57A9131E} does not refer to an enumeration intrinsic property type.",
"success": false
}
}
}
```

Error responses

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 BAD REQUEST</td>
<td>&quot;Syntax of request could not be understood by the server.&quot;</td>
</tr>
<tr>
<td>405 METHOD NOT ALLOWED</td>
<td>&quot;No active project&quot;</td>
</tr>
<tr>
<td>415 UNSUPPORTED MEDIA TYPE</td>
<td>&quot;Unsupported content-encoding of [encoding type]&quot;</td>
</tr>
</tbody>
</table>

/exceptions

Exceptions that occur during execution of a server request are automatically caught and returned as error result in the response of that request. Exceptions however may also happen independently of the requests, e.g. because a problem during repainting. In such situations, an exception message box may be displayed by the application. This resource allows access to information about this type of exceptions.

The getlast variant will clear the last exception message on the server, while the peeklast variant will leave it in place.

**Method:** POST

**Data parameters**

```json
{
"action": {
"name": *1 <string> from {"getlast", "peeklast"}*
}
```
Data parameters example

```json
{
  "action": {
    "name": "getlast"
  },
  "action": {
    "name": "peeklast"
  }
}
```

Success responses

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>OK</td>
</tr>
</tbody>
</table>

Data

```json
{
  "exceptions": [
    "date/time : 2015-04-17, 16:09:46, 750ms\n\ncomputer name : PC075\n\nwts client name : ...etc..."
  ]
}
```

Error responses

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 BAD REQUEST</td>
<td>&quot;Syntax of request could not be understood by the server.&quot;</td>
</tr>
<tr>
<td>415 UNSUPPORTED MEDIA TYPE</td>
<td>&quot;Unsupported content-encoding of [encoding type]&quot;</td>
</tr>
</tbody>
</table>

payload

```
"action": "name": "getlast"
```

headers

```
"content-type": "application/json"
```

response

```
requests.post("/exceptions", data=json.dumps(payload)
```

headers

```
headers
```

Example browser request

```
http://localhost:8001/exceptions?action.name=getlast
```

/tokenizer
Allows parsing a command line string into the separate tokens according to the PLAXIS command line language. A token is a sequence of one or more characters that together form a basic indivisible entity of source code.

Each token has the following properties:

- **type**: indicates what type of token it is (see list below)
- **value**: which is the parsed representation of the item (e.g. the token consisting of the characters 10 will resolve to be of integer type with value 10).
- **position**: indicates the start position of the token in the original string (0-based)
- **length**: the number of characters the token consumed from the original string

The following types of tokens exist:

- **identifier**: something that will act either as command or as object identifier
- **comment**: a piece of comment, i.e. a sequence of characters starting with # up to the end of the string. The value of the token includes the starting # sign.
- **external interpreter**: a line that should be executed by an external interpreter, e.g. /output echo Points. The value of the token includes the starting / sign. It has three additional properties:
  - **interpreter name**: e.g. output in the case of /output echo Points
  - **external command**: e.g. echo Points in the same case
  - **content**: e.g. output echo Points in the case of output echo Points
- **operand tokens**:
  - **bracket**: identifies a bracket type. Bracket tokens have additional properties:
    - **bracket type**: can be round, square, curly for (, [), {)} respectively
    - **bracket state**: can be open or close for ([{respectively ]})
  - **member**: used to separate an object from its members (e.g. the . in Line\_1.Beam)
  - comma, plus, minus, multiplier, divider, assign: currently unused, but they are the ,, +,-,*,/='=operands respectively
- **numerical tokens**:
  - **integer**: represents a number that can be represented by a 32-bit signed integer
  - **float**: represents a number that can be represented as a floating point value

**Method**: POST

**Data parameters**

```json
{
  "action":
  {
    "tokenize":
    [
      *{1,...}[string]*
    ]
  }
}
```

**Data parameters example**

```json
{
  "action":
  {
```
HTTP REST API [GSE]

"tokenize":
[
 "point 10"
]

"action":
{
 "tokenize":
[
 "point 10", "point 8"
]

"action":
{
 "tokenize":
[
 "a ?"
]

Success responses

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>OK</td>
</tr>
</tbody>
</table>

{ "tokenize":
[
{ "tokens": [
{"position": 0,  
"length": 5,  
"type": "identifier", 
"value": "point"}, 
{"position": 6,  
"length": 2,  
"type": "integer", 
"value": 10}, 
],  
"success": true,  
"extrainfo": "",  
"errorpos": -1
},  
"tokenize": "point 10"
]  

Data

{"tokenize":}
HTTP REST API [GSE]

```
[
  {
    "tokens": [
    {
      "position": 0,
      "length": 1,
      "type": "identifier",
      "value": "a"},
    ],
    "success": false,
    "extrainfo": "Unrecognized token",
    "errorpos": 2
    },
    "tokenize": "a ?"
  }
]
```

Error responses

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 BAD REQUEST</td>
<td>&quot;Syntax of request could not be understood by the server.&quot;</td>
</tr>
<tr>
<td>415 UNSUPPORTED MEDIA TYPE</td>
<td>&quot;Unsupported content-encoding of [encoding type]&quot;</td>
</tr>
</tbody>
</table>

Example JSON request

```python
payload = {
    "action": {
        "name": "getlast"
    },
    "content-type": "application/json"
}
response = requests.post("/exceptions", data=json.dumps(payload), headers=headers)
```

Example browser request

http://localhost:8001/tokenizer?action.tokenize=point%201
A sample of a typical Convergence log file can be seen in below:

data.convd.rr

Reference project: ...

... Lines skipped ...

========================================================================
========================================================================
PHASE 1: "Diaphragm wall construction"

17124 active of 17124 nodes
2049 active of 2049 soil elements
141 active of 141 interface elements
65 active of 65 plate elements
22279 active of 22279 dofs

========================================================================
========================================================================
CALCULATION TYPE

CONVERGENCE CRITERIA

Global force error tolerance 1.000E-02
Global moment error tolerance 1.000E-03
Inaccurate soil plastic point tolerance 1.000E-01
Integrated interface local error tolerance 1.000E-01
Inaccurate interface plastic point tolerance 1.000E-01

STEP SIZE CONTROL PARAMETERS

Maximum iterations per step 60
Desired minimum iterations per step 6
Desired maximum iterations per step 15
Maximum consecutive negative steps 5
Arc-length control On

========================================================================
STEP 1
========================================================================

STEP 1 - ATTEMPT 1 - ITERATION 1

Current step size 5.000E-01
Total number of iterations in current step 1
Global force error 8.814E-04
Integrated soil local error 7.134E-04
**Example - Convergence log file**

<table>
<thead>
<tr>
<th>Global moment error</th>
<th>1.258E-11</th>
</tr>
</thead>
<tbody>
<tr>
<td>Soil plastic points</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>18065</td>
</tr>
<tr>
<td>Inaccurate</td>
<td>541</td>
</tr>
<tr>
<td>Check convergence</td>
<td></td>
</tr>
<tr>
<td>Minimum of 2 iterations per attempt not reached</td>
<td>NO</td>
</tr>
</tbody>
</table>

**STEP 1 - ATTEMPT 1 - ITERATION 2**

<table>
<thead>
<tr>
<th>Current step size</th>
<th>4.265E-01</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global force error</td>
<td>4.733E-04</td>
</tr>
<tr>
<td>Integrated soil local error</td>
<td>1.643E-04</td>
</tr>
<tr>
<td>Global moment error</td>
<td>8.774E-12</td>
</tr>
<tr>
<td>Soil plastic points</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>18109</td>
</tr>
<tr>
<td>Inaccurate</td>
<td>29</td>
</tr>
<tr>
<td>Check convergence</td>
<td></td>
</tr>
<tr>
<td>Converged attempt:</td>
<td>YES</td>
</tr>
</tbody>
</table>

**STEP 1 - SUMMARY**

<table>
<thead>
<tr>
<th>Reached sum-MStage</th>
<th>4.265E-01</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step convergence achieved</td>
<td>YES</td>
</tr>
<tr>
<td>Relative stiffness</td>
<td>8.649E-01</td>
</tr>
<tr>
<td>Maximum out-of-balance force</td>
<td>-3.617E+00</td>
</tr>
<tr>
<td>At node 6782, dof 2</td>
<td></td>
</tr>
<tr>
<td>Location (8.525E+00,-3.000E+01,0.000E+00)</td>
<td></td>
</tr>
<tr>
<td>Maximum incremental displacement</td>
<td>-5.878E-04</td>
</tr>
<tr>
<td>At node 16037, dof 2</td>
<td></td>
</tr>
<tr>
<td>Location (8.600E+00,-5.597E-01,0.000E+00)</td>
<td></td>
</tr>
</tbody>
</table>

... Lines skipped ...

===================================

**PHASE SUMMARY**

Prescribed ultimate state reached
The errors that may occur while using PLAXIS.

Table 24: Warnings

<table>
<thead>
<tr>
<th>Warning code</th>
<th>Message</th>
<th>Hint</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>PICOS solver was used instead of PARDISO due to lack of memory.</td>
<td>Install more RAM in your computer</td>
</tr>
<tr>
<td>9</td>
<td>Different stress type was used in the previous phase.</td>
<td>In the previous phase, a different stress type (Terzaghi stress or Bishop stress) was used. Please check your input.</td>
</tr>
<tr>
<td>8</td>
<td>Internally changes in setting: Updated mesh is selected.</td>
<td>Due to settings of previous phase(s), the updated mesh option was selected in the calculation.</td>
</tr>
<tr>
<td>7</td>
<td>Free field cannot be used in an axisymmetric geometry</td>
<td>Free field boundaries cannot be used in axisymmetric models (2D).</td>
</tr>
<tr>
<td>6</td>
<td>Dynamic loads applied on free field base elements are moved to main domain by kernel</td>
<td>Dynamic loads that where applied on a free field boundary will be applied directly on the elements inside the model.</td>
</tr>
<tr>
<td>5</td>
<td>One or more Tension of Mohr-Coulomb points found</td>
<td>Inspect Output for the Initial phase (K0 procedure) and check the K0 values for the materials in which the plastic points occur as well</td>
</tr>
<tr>
<td>4</td>
<td>Static loads have been changed in a dynamics analysis</td>
<td>The value for a static load has been changed in a dynamics analysis. Please re-check your load values if this was unintentional.</td>
</tr>
<tr>
<td>3</td>
<td>Prescribed ultimate state fully reached. Non-zero static prescribed displacements are ignored</td>
<td>Non-zero static prescribed displacements were ignored.</td>
</tr>
</tbody>
</table>
### Calculation warning and errors in PLAXIS

<table>
<thead>
<tr>
<th>Warning code</th>
<th>Message</th>
<th>Hint</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Prescribed ultimate state fully reached. Unfinished construction stage. Next calculation must be staged construction.</td>
<td>For this phase a $\Sigma M_{stage} &lt; 1$ was defined. The next phase should be staged construction.</td>
</tr>
</tbody>
</table>

Table 25: Errors

<table>
<thead>
<tr>
<th>Error code</th>
<th>Message</th>
<th>Hint</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>OK.</td>
<td>Calculation succeeded and converged</td>
</tr>
<tr>
<td>1, 8, 9</td>
<td>Stiffness matrix too big for reserved RAM memory</td>
<td>Decrease model size. If the problem persists, install more RAM in your computer</td>
</tr>
<tr>
<td>2, ..., 7</td>
<td>Problem too big for reserved RAM memory</td>
<td>Decrease model size. If the problem persists, install more RAM in your computer</td>
</tr>
<tr>
<td>10</td>
<td>Deformation not compatible in STRESBL</td>
<td>Sometimes in Updated mesh calculations it may happen that elements are turned 'inside out'. Inspect the results. It might help to increase the stiffness in the problem area.</td>
</tr>
<tr>
<td>11, 16</td>
<td>Determinant is zero or nearly zero.</td>
<td>The determinant is zero or nearly zero. Causes for this could be:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Bad mesh quality. (elements with low quality). This can be reviewed in the generated mesh (Mesh $\rightarrow$Quality)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Missing boundary conditions. Review the boundary conditions for this phase</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Floating (unconnected) clusters/volumes</td>
</tr>
<tr>
<td>12</td>
<td>Material set not found.</td>
<td>Check if all assigned materials (soils and structural elements) are available and defined</td>
</tr>
<tr>
<td>13</td>
<td>Water weight is zero</td>
<td>Check the project's water weight</td>
</tr>
<tr>
<td>14</td>
<td>Deformation not compatible in GLBMB.</td>
<td>A (very) large deformation occurred in a (2D) beam, resulting in a too large curvature. Try to force smaller steps by using smaller load increments and/or a tighter tolerance (or use smaller DSC max value)</td>
</tr>
</tbody>
</table>
## Calculation warning and errors in PLAXIS

<table>
<thead>
<tr>
<th>Error code</th>
<th>Message</th>
<th>Hint</th>
</tr>
</thead>
</table>
| 15         | Jacobian matrix is less than or nearly zero. | This is usually the result of one of these two causes (or a combination):  
- Badly shaped elements: good elements are those with the same size for width, length and height of the element. Please inspect the mesh quality.  
- Large stiffness differences. For numerical reasons, the stiffness values in the model may not differ too much (e.g. a ratio larger than $10^6$ between the lowest stiffness and the highest stiffness should be avoided). |
| 17, 19, 20 | Stiffness matrix is nearly singular and cannot be solved. | Stiffness matrix is nearly singular and cannot be solved. & Causes for this could be:  
- Bad mesh quality. (elements with low quality). This can be reviewed in the generated mesh (`Mesh -> Quality`).  
- Large stiffness differences. For numerical reasons, the stiffness values in the model may not differ too much (e.g. a ratio larger than $10^6$ between the lowest stiffness and the highest stiffness) should be avoided.  
- A combination of the two above.  
- Missing boundary conditions. Review the boundary conditions for this phase.  
- Floating/unconnected clusters/volumes. |
| 24         | Material set with zero permeability found, but not allowed in this type of calculation. | Groundwater flow and consolidation calculations require non-zero permeability in all elements. Check materials and add permeability value: $k_i > 0$. |
| 25         | Groundwater weight is zero. | Check the project's water weight |
| 26         | Unable to load dll. `<param1>` | Check the presence of user defined soil models dll files in the program folder. `<param1>` is the name of the file. |
| 27         | File not found. `<param1>` | A file needed for the calculation was not found. Regenerating the mesh could solve it. If not, please send it to support. `<param1>` is the name of the missing file. |
## Calculation warning and errors in PLAXIS

<table>
<thead>
<tr>
<th>Error code</th>
<th>Message</th>
<th>Hint</th>
</tr>
</thead>
<tbody>
<tr>
<td>28</td>
<td>Peak plastic shear strain is too low.</td>
<td>NGI-ADP model, UDCAM-S model: $\gamma_{\text{peak}}$ value(s) nearly zero. Please check the input values. Note that the value is expressed in percent (%)</td>
</tr>
<tr>
<td>29</td>
<td>Error factorization matrix</td>
<td>Check for floating clusters or insufficient boundary conditions.</td>
</tr>
<tr>
<td>30</td>
<td>Number of dynamic sub-steps is ZERO.</td>
<td>The defined value for dynamic substeps is zero. To solve it, increase the number of dynamic substeps (see iterative settings).</td>
</tr>
<tr>
<td>31</td>
<td>Error backsub matrix.</td>
<td>Internal error. Please send the PLAXIS project to support.</td>
</tr>
<tr>
<td>32</td>
<td>Memory allocation error.</td>
<td>There is not enough memory available.</td>
</tr>
<tr>
<td>33</td>
<td>Internal error. Please, pack this project using Pack project and send to support</td>
<td>An internal error occurred. It could be one of these causes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Zero length of embedded beam row in 2D. Update version and remesh.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• An error with free field boundaries. Please check the input</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For any other cause, please send the PLAXIS 2D project to support</td>
</tr>
<tr>
<td>34</td>
<td>Ultimate state not reached in GW-Flow analysis.</td>
<td>The groundwater flow calculation did not converge. Please check the input parameters and the phase settings.</td>
</tr>
<tr>
<td>35</td>
<td>No critical time step found; no draining boundaries</td>
<td>Check boundary conditions. It could be that all boundaries are closed.</td>
</tr>
<tr>
<td>36</td>
<td>NaN found in an element stiffness matrix.</td>
<td>(NaN = Not a Number) Causes could be elements with a zero area or bad material parameters</td>
</tr>
<tr>
<td>37</td>
<td>DeAllocation memory error.</td>
<td>Internal error. Please send the PLAXIS project to support.</td>
</tr>
<tr>
<td>38</td>
<td>Invalid plate material table.</td>
<td>Check non-linear structural materials datasets.</td>
</tr>
<tr>
<td>39</td>
<td>NaN found during calculation, probably severe divergence.</td>
<td>(NaN = Not a Number). This could be caused by bad input parameters. If the problem persists, please send the PLAXIS project to support.</td>
</tr>
</tbody>
</table>
## Calculation warning and errors in PLAXIS

<table>
<thead>
<tr>
<th>Error code</th>
<th>Message</th>
<th>Hint</th>
</tr>
</thead>
<tbody>
<tr>
<td>40</td>
<td>Severe divergence.</td>
<td>The global error grew too large in the calculation ($&gt;(10^6)$). This could be related to bad input for soil parameters. Please check the model in the last step to identify the problem area. Otherwise, please send the PLAXIS project to support.</td>
</tr>
<tr>
<td>41</td>
<td>$K_{nc}^0 \simeq 0$ in Sekiguchi-Ohta model, please correct.</td>
<td>Re-evaluate Sekiguchi-Ohta model material datasets.</td>
</tr>
<tr>
<td>42</td>
<td>Water file does not exist. &lt;param1&gt;</td>
<td>2D2011/2D2012: Please regenerate water conditions file by opening staged construction, generate water pressures and then press update. If more than one phase has this problem, regenerating the mesh might solve it faster for all phases.</td>
</tr>
<tr>
<td>43</td>
<td>Not proper Newmark coefficients.</td>
<td>Re-evaluate Newmark coefficients.</td>
</tr>
<tr>
<td>44</td>
<td>No drift correction for unequal time steps.</td>
<td>Drift correction is based on equal time steps. Create a table of equal time steps or switch off drift correction.</td>
</tr>
<tr>
<td>45</td>
<td>At least 2 data points are needed for drift correction.</td>
<td>Drift correction needs at least 2 data points. Increase the number of data points or switch off drift correction.</td>
</tr>
<tr>
<td>46</td>
<td>Time must be increasing in a tabular multiplier function.</td>
<td>Re-evaluate dynamic multiplier tables: time must be increasing each time step.</td>
</tr>
<tr>
<td>47</td>
<td>Invalid material parameter set. &lt;param1&gt;</td>
<td>Re-evaluate the mentioned material parameter set.</td>
</tr>
<tr>
<td>48</td>
<td>Error in reading flow communication file. &lt;param1&gt;</td>
<td>File &lt;param1&gt; not found, probably something went wrong in flow calculation or flow calculation is very slow. Usually this is solved by decreasing differences in permeabilities.</td>
</tr>
<tr>
<td>49</td>
<td>non-zero dynamic load without multiplier.</td>
<td>Please assign a dynamic multiplier function to all dynamic loads.</td>
</tr>
<tr>
<td>50</td>
<td>non-zero dynamic displacement without multiplier.</td>
<td>Please assign a dynamic multiplier function to all dynamic loads.</td>
</tr>
<tr>
<td>51</td>
<td>Gravitational acceleration ($g$) is zero.</td>
<td>Re-evaluate the gravitational acceleration in the project properties.</td>
</tr>
</tbody>
</table>
### Calculation warning and errors in PLAXIS

<table>
<thead>
<tr>
<th>Error code</th>
<th>Message</th>
<th>Hint</th>
</tr>
</thead>
<tbody>
<tr>
<td>52</td>
<td>Both left and right hand side free field boundaries must be active.</td>
<td>Activate both sides of the free field boundaries</td>
</tr>
<tr>
<td>53</td>
<td>Number of nodes on lateral boundaries must be equal to tie their degrees of freedom.</td>
<td>Regenerate the mesh to match this criterion. Make sure the left and right side of the geometry are identical.</td>
</tr>
<tr>
<td>54</td>
<td>Parent phase uses updated mesh while this type of calculation does not support updated mesh.</td>
<td>Redefine an Updated mesh state for prior phases, or reset displacements to zero for this phase. Note that displacements cannot be reset to zero after an updated mesh analysis.</td>
</tr>
<tr>
<td>101</td>
<td>Soil body collapses</td>
<td>The program has detected soil failure. Please evaluate the calculation results in Output to show why it fails</td>
</tr>
<tr>
<td>102</td>
<td>Not enough load steps.</td>
<td>Increase the value assigned to the Max steps parameter.</td>
</tr>
<tr>
<td>103</td>
<td>Load advancement procedure fails.</td>
<td>The program has detected numerical problems. Please inspect the input data and the calculation results in Output to evaluate why it fails.</td>
</tr>
<tr>
<td>104</td>
<td>Prescribed ultimate time not reached.</td>
<td>Prescribed time interval in a consolidation analysis is not reached. Probably due to soil failure. Please inspect the input data and the calculation results in Output to evaluate why it fails.</td>
</tr>
<tr>
<td>105</td>
<td>Prescribed minimum excess pore pressure not reached.</td>
<td>Prescribed minimum excess pore pressure in a consolidation analysis is not reached. Probably due to soil failure. Please inspect the input data and the calculation results in Output to evaluate why it fails.</td>
</tr>
<tr>
<td>107</td>
<td>Prescribed ultimate level $\Sigma Msf$ not reached.</td>
<td>Increase the value assigned to the Max steps parameter.</td>
</tr>
<tr>
<td>110</td>
<td>Accuracy condition not reached in last step.</td>
<td>This could be solved by increasing the value assigned to Max steps.</td>
</tr>
<tr>
<td>111</td>
<td>Soil body collapses. Accuracy condition not reached in last step.</td>
<td>Combination of 101 and 110.</td>
</tr>
<tr>
<td>112</td>
<td>Not enough load steps. Accuracy condition not reached in last step.</td>
<td>Combination of 102 and 110.</td>
</tr>
</tbody>
</table>
## Calculation warning and errors in PLAXIS

<table>
<thead>
<tr>
<th>Error code</th>
<th>Message</th>
<th>Hint</th>
</tr>
</thead>
<tbody>
<tr>
<td>113</td>
<td>Not enough load steps. Load advancement procedure fails.</td>
<td>Combination of 103 and 110.</td>
</tr>
<tr>
<td></td>
<td>Accuracy condition not reached in last step.</td>
<td></td>
</tr>
<tr>
<td>114</td>
<td>Prescribed ultimate time not reached.</td>
<td>Combination of 104 and 110.</td>
</tr>
<tr>
<td></td>
<td>Accuracy condition not reached in last step.</td>
<td></td>
</tr>
<tr>
<td>115</td>
<td>Prescribed minimum excess pore pressure not reached.</td>
<td>Combination of 105 and 110.</td>
</tr>
<tr>
<td></td>
<td>Accuracy condition not reached in last step.</td>
<td></td>
</tr>
<tr>
<td>117</td>
<td>Prescribed ultimate level $\Sigma M_{sf}$ not reached.</td>
<td>Combination of 107 and 110.</td>
</tr>
<tr>
<td></td>
<td>Accuracy condition not reached in last step.</td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>Picos_Dec: matrix type differs from initial type.</td>
<td>Internal error. Please send the PLAXIS project to support.</td>
</tr>
<tr>
<td>202</td>
<td>Picos_Back: matrix type differs from initial type.</td>
<td>Internal error. Please send the PLAXIS project to support.</td>
</tr>
<tr>
<td>203</td>
<td>Picos_Prep: iDof &gt; nDof.</td>
<td>Internal error. Please send the PLAXIS project to support.</td>
</tr>
<tr>
<td>241</td>
<td>Unexpected problem. Please contact Plaxis.</td>
<td>Internal error. Please send your project to support.</td>
</tr>
<tr>
<td>244</td>
<td>Unexpected problem. Please contact Plaxis.</td>
<td>Internal error. Please send your project to support.</td>
</tr>
<tr>
<td>245</td>
<td>Unexpected problem. Please contact Plaxis.</td>
<td>Internal error. Please send your project to support.</td>
</tr>
<tr>
<td>246</td>
<td>Programmer abort request. For more details see the .lxx or .Dxx file.</td>
<td>See the details in these files, or send your project to support.</td>
</tr>
<tr>
<td></td>
<td>&lt;Params&gt;</td>
<td></td>
</tr>
<tr>
<td>247</td>
<td>Complex error. For more details see the .lxx or .Dxx file.</td>
<td>See the details in these files, or send to support.</td>
</tr>
<tr>
<td></td>
<td>&lt;Params&gt;</td>
<td></td>
</tr>
<tr>
<td>248</td>
<td>Reference to non-existing material set.</td>
<td>Redefine staged construction for this phase and check material assignments.</td>
</tr>
<tr>
<td></td>
<td>Redefined staged construction phase.</td>
<td></td>
</tr>
<tr>
<td>249</td>
<td>Not enough (virtual) memory</td>
<td>Decrease model size. If the problem persists, install more RAM in your computer</td>
</tr>
<tr>
<td>250</td>
<td>Mesh files does not exist.</td>
<td>Missing mesh data. Regenerate the mesh.</td>
</tr>
</tbody>
</table>
### Calculation warning and errors in PLAXIS

<table>
<thead>
<tr>
<th>Error code</th>
<th>Message</th>
<th>Hint</th>
</tr>
</thead>
<tbody>
<tr>
<td>251</td>
<td>Use ( dt &gt; 0 ) for dynamics.</td>
<td>Make sure that the time interval is larger than 0: ( dt &gt; 0 )</td>
</tr>
<tr>
<td>252</td>
<td>Calculation results of previous phase do not match the current mesh. Recalculate the previous phase.</td>
<td>Recalculate the previous phase(s) to solve it.</td>
</tr>
<tr>
<td>253</td>
<td>Disk (nearly) full.</td>
<td>Disk is full: clear some disk space or move the calculation to a larger disk. Note: since 2012, all calculations are performed in the Windows TEMP folder. That means that there should be enough space available on the drive where your TEMP folder is installed.</td>
</tr>
<tr>
<td>254</td>
<td>Cancelled by user.</td>
<td>The user stopped the calculation.</td>
</tr>
<tr>
<td>255</td>
<td>Abort request from USER-subroutine.</td>
<td>This is caused by a programmer error in the UDSM (user-defined soil model) code.</td>
</tr>
<tr>
<td>256</td>
<td>Run-time-error in kernel.</td>
<td>This is caused by an undetermined error/crash of the kernel (in the newer versions). Please send the PLAXIS project to support.</td>
</tr>
<tr>
<td>501</td>
<td>Beam material set: ratio ( I_3/I_2 ) too large</td>
<td>Check beam material datasets for the ratio ( I_3/I_2 ).</td>
</tr>
<tr>
<td>501</td>
<td>Beam material set: ratio ( I_2/I_3 ) too large</td>
<td>check beam material datasets for the ratio ( I_2/I_3 )</td>
</tr>
<tr>
<td>1000</td>
<td>The results from the previous phase are missing. Please recalculate the previous phase.</td>
<td>Recalculate the previous phase.</td>
</tr>
</tbody>
</table>

#### J.1 Meshing errors

Errors such as invalid surface mesh or invalid element(s) found etc, that may occur during meshing can be solved by taking into account the hint/solution provided in the command line.

#### J.2 Cyclic accumulation and optimization tool errors

The errors that may occur in the *Cyclic accumulation* tab:
### Calculation warning and errors in PLAXIS

#### Table 26: Errors that may occur in the Stress-strain curves tab

<table>
<thead>
<tr>
<th>Error message</th>
<th>Hint</th>
</tr>
</thead>
<tbody>
<tr>
<td>Too many strain contours, maximum is 150</td>
<td>It may occur when the user uploads custom contour data for a number of contour lines larger than 150</td>
</tr>
<tr>
<td>The contour diagrams should be defined up to the same maximum number of cycles</td>
<td>It indicates that the last point of each line of a custom contour data should be defined at the same number of cycles.</td>
</tr>
<tr>
<td>Interpolation problem, shear stress level =</td>
<td>The cyclic accumulation procedure could not be successfully performed for a combination of wrong load parcels data or custom contours.</td>
</tr>
<tr>
<td>Infinite slope, cannot interpolate</td>
<td>The cyclic accumulation procedure could not be successfully performed for a combination of wrong load parcels data or custom contours.</td>
</tr>
</tbody>
</table>

The errors that may occur in the Parameter optimisation tab:

#### Table 27: Exit codes, message printed in Optimization_results.txt and message shown in the GUI

<table>
<thead>
<tr>
<th>Exit code</th>
<th>Error message</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Internal error, model is invalid</td>
</tr>
<tr>
<td>2</td>
<td>Optimisation file not indicated</td>
</tr>
<tr>
<td>3</td>
<td>Cannot load &quot;hscapitr.dll&quot;</td>
</tr>
<tr>
<td>4</td>
<td>&quot;hscapitr.dll&quot; is corrupt</td>
</tr>
<tr>
<td>5</td>
<td>Unknown search intensity is given</td>
</tr>
<tr>
<td>6</td>
<td>Cannot allocate memory</td>
</tr>
<tr>
<td>7</td>
<td>Internal error, PSWARM</td>
</tr>
<tr>
<td>8</td>
<td>Could not start optimisation. Check parameter ranges</td>
</tr>
<tr>
<td>9</td>
<td>Cannot find feasible points</td>
</tr>
<tr>
<td>10</td>
<td>Cannot find curve file</td>
</tr>
<tr>
<td>11</td>
<td>The curve phase information is incompatible with the test configuration</td>
</tr>
<tr>
<td>12</td>
<td>Cannot find optimisation input file</td>
</tr>
<tr>
<td>13</td>
<td>Material parameter index is outside of the range</td>
</tr>
<tr>
<td>14</td>
<td>Material parameter bounds are outside of the range</td>
</tr>
</tbody>
</table>
## Calculation warning and errors in PLAXIS

<table>
<thead>
<tr>
<th>Exit code</th>
<th>Error message</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Cannot find VLC input file</td>
</tr>
<tr>
<td>16</td>
<td>Error in VLC input file</td>
</tr>
<tr>
<td>17</td>
<td>Wrong material parameter in curve file</td>
</tr>
<tr>
<td>18</td>
<td>Aborted by user</td>
</tr>
<tr>
<td>19</td>
<td>Small overlap curves</td>
</tr>
</tbody>
</table>

For the errors mentioned in table above, please send your project to support.
PLAXIS 2D offer an extensive number of features for the modelling of diverse geotechnical problems; for this reason, according to our user needs these features are offered under different licencing levels (see General Information Manual for more information about licencing).

In the following table an overview of some of the offered software features is included. Users can use this table to have an initial idea of the capabilities at each licencing level. Since not all PLAXIS 2D features can be listed in the table, users are encouraged to review in detail the present manual where the features are identified according their licence level group (please check Features and Licence levels (on page 11)).

<table>
<thead>
<tr>
<th>Feature/Tool</th>
<th>Licence Level</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PLAXIS 2D</td>
</tr>
<tr>
<td>Feature</td>
<td></td>
</tr>
<tr>
<td>Soil, structures, mesh, flow, staged construction calculation modes</td>
<td>✓</td>
</tr>
<tr>
<td>Initial stress from K0, Field stress, gravity loading calculation type</td>
<td>✓</td>
</tr>
<tr>
<td>General deformation analysis (Plastic calculation type)</td>
<td>✓</td>
</tr>
<tr>
<td>Factor of Safety (Safety calculation type)</td>
<td>✓</td>
</tr>
<tr>
<td>Pore pressures from phreatic levels</td>
<td>✓</td>
</tr>
<tr>
<td>Blend surfaces and Loft polycurve</td>
<td>✓</td>
</tr>
<tr>
<td>Polar and rectangular array</td>
<td>✓</td>
</tr>
<tr>
<td>Automatic centerline extraction tools</td>
<td>✓</td>
</tr>
</tbody>
</table>
## Overview Features and Licence levels -

<table>
<thead>
<tr>
<th>Feature/Tool</th>
<th>Licence Level</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PLAXIS 2D</td>
</tr>
<tr>
<td>Tunnel designer</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>Consolidation analysis</td>
<td>-</td>
</tr>
<tr>
<td>(Consolidation calculation type)</td>
<td></td>
</tr>
<tr>
<td>Pseudostatic analysis</td>
<td>-</td>
</tr>
<tr>
<td>Steady-state groundwater flow</td>
<td>-</td>
</tr>
<tr>
<td>Steady-state thermal flow</td>
<td>-</td>
</tr>
<tr>
<td>Multicore calculation (no limit of cores)</td>
<td>-</td>
</tr>
<tr>
<td>Flow only analysis</td>
<td>-</td>
</tr>
<tr>
<td>Transient groundwater flow</td>
<td>-</td>
</tr>
<tr>
<td>Dynamics and seismic analysis</td>
<td>-</td>
</tr>
<tr>
<td>Transient thermal flow</td>
<td>-</td>
</tr>
<tr>
<td>Fully coupled flow deformation analysis</td>
<td>-</td>
</tr>
<tr>
<td>Site response analysis</td>
<td>-</td>
</tr>
</tbody>
</table>

### Tools

<table>
<thead>
<tr>
<th>Tools</th>
<th>PLAXIS 2D</th>
<th>PLAXIS 2D Advanced [ADV]</th>
<th>PLAXIS 2D Ultimate [ULT]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sensitivity analysis and parameter analysis</td>
<td>✓ + [GSE]</td>
<td>✓ + [GSE]</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>Design approaches</td>
<td>-</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Soil test and inverse analysis</td>
<td>✓ + [GSE]</td>
<td>✓ + [GSE]</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>Generate Stratigraphy from imported CPT Logs</td>
<td>✓ + [GSE]</td>
<td>✓ + [GSE]</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>Remote scripting (Input, output, macros and Soiltest)</td>
<td>✓ + [GSE]</td>
<td>✓ + [GSE]</td>
<td>✓ + [GSE]</td>
</tr>
</tbody>
</table>
### Overview Features and Licence levels -

<table>
<thead>
<tr>
<th>Feature/Tool</th>
<th>Licence Level</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PLAXIS 2D</td>
</tr>
<tr>
<td>Scripting reference</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>CAD importer and exporter</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>PLAXIS 2D LE importer</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>GeoStudio 2D importer</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>GeoStudio 2D exporter</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>2D to 3D converter</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>Read 2D cross-sections and materials from Central</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>Calculation manager</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>Autocomplete</td>
<td>✓ + [GSE]</td>
</tr>
<tr>
<td>Export to Paraview</td>
<td>✓ + [GSE]</td>
</tr>
</tbody>
</table>

**Note:** Soil models available in PLAXIS and their relation with licencing levels can be seen in the Appendices of the Material Models Manual.